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Preface

This preface provides information about the objectives, organization, and conventions of 
the ShoreTel System Administration Guide.

Objectives of this Book
This guide explains how to use ShoreTel Director to configure, administer, and maintain 
the ShoreTel system. 

The planning and installation procedures are described in the ShoreTel Planning and 
Installation Guide.

Audience for this Book
This guide is written for the person who uses ShoreTel Director to administer and maintain 
the ShoreTel system.

Organization of this Book
This guide’s organization reflects the order in which a ShoreTel system initially is 
configured.

The “Getting Started” section in the next chapter provides an ordered checklist to be used 
the first time you configure your system.

Documentation Overview
The ShoreTel system is documented as described in the following sections.

System Documentation
The following system documents are in the documentation folder on the ShoreTel DVD and 
can also be accessed from ShoreTel Director:

• ShoreTel Planning and Installation Guide provides information on how to plan the 
implementation of the ShoreTel system, as well as how to install the necessary 
hardware, data communications, and telecommunications elements. The ShoreTel 
Planning and Installation Guide can be used in conjunction with the ShoreCare 
ControlPoint project management tool.

• ShoreTel System Administration Guide (this guide) provides detailed information 
on how to administer and maintain the ShoreTel system using ShoreTel Director. 
This includes task-based information, as well as screen-by-screen information 
regarding ShoreTel Director.
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Hardware Documentation
The following hardware installation documents are packaged with their associated ShoreTel 
voice switch or ShoreTel IP phone and appliances:

• ShoreTel Voice Switch Quick Install Guide

• ShoreTel IP Phone Quick Install Guide

• Service Appliance 100 Planning, Installation and Administration Guide

If the system includes the ShoreTel Enterprise Contact Center Solution, refer to the 
ShoreTel Enterprise Contact Center Solution Administration Guide and the ShoreTel Enterprise 
Contact Center Solution Planning and Installation Guide.

User Documentation
End-user documentation is installed during the ShoreTel Communicator installation. To 
access it, choose the Help -> Contents and Index menu item within the ShoreTel 
Communicator application.

The Telephone User Interface Analog Quick Reference and the Telephone User Interface IP 
Phone Quick Reference are available from the ShoreTel web site at www.shoretel.com, as 
well as from ShoreTel Director.

Release Notes
The ShoreTel Server Software Release Notes provide information about new releases and new 
features as well as issues that relate to new installations and upgrades. This document 
resides in the documentation folder on the associated DVD and can also be accessed from 
ShoreTel Director.

Online Knowledge Base
To access additional information or to resolve issues on ShoreTel Director, you can use the 
ShoreTel Technical Knowledgebase, accessible from the ShoreTel web site at 
www.shoretel.com. 

Document Conventions
The following conventions are used in this guide:

• Data-entry fields, hypertext links, control buttons, keywords, and other items 
within the system management interface are in a boldface font.

• Information that you enter in data fields are in a data_entry font.
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C H A P T E R 1

Using ShoreTel Director

This chapter describes how to use ShoreTel Director. The topics in this chapter are:

• "Overview of ShoreTel Director" on page 17

• "Starting ShoreTel Director" on page 21

• "Product Registration" on page 23

• "Director Components" on page 27

• "Getting Started" on page 30

1.1 Overview of ShoreTel Director
ShoreTel Director is a web-based administration and maintenance tool that lets you manage 
your ShoreTel system from anywhere on your IP network. The ShoreTel system has a 
unique distributed call control architecture as well as a suite of voice applications that 
provides a single image system for all users across all sites. Gone are the days of having 
PBXs, voice mail systems, automated attendants, or ACD systems, each with their own 
dedicated management interface. ShoreTel Director lets you manage, from a single web 
management interface, all your users and trunks, including the call control features, and all 
the voice applications (voice mail, automated attendant, workgroups, call detail recording, 
unified messaging, and desktop call control).

1.1.1 Architectural Overview
The main ShoreTel server hosts the web site for ShoreTel Director using Microsoft Internet 
Information Server. When you launch a web browser and navigate to the ShoreTel Director 
web site, the server provides HTML web pages from which you can add to, delete from, and 
edit the configuration of the system (see Figure 1-1). When you click Save, your change is 
sent to the server and saved in the ShoreTel database. All other system components are 
automatically and immediately notified and updated.

In addition to the configuration panels, ShoreTel Director has a maintenance interface for 
the ShoreTel system. When you navigate to a maintenance panel in ShoreTel Director, 
system status is displayed, and you can issue maintenance commands. The commands are 
passed to and executed by the server. If you have distributed ShoreTel application servers, 
you can navigate from the main server to each distributed server through ShoreTel Director 
to view status and issue commands to the distributed server.

ShoreTel Director is supported by the following:

• MS Internet Explorer 8.0 - ShoreTel Director and ShoreTel Communicator for Web

• Safari 4.0 - (On Apple Corporation's Macintosh computers)

• Firefox 3.6 - (On Microsoft Corporation’s Windows-based computers and Mac OS)
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If you are running ShoreTel Director under a Windows operating system (such as XP SP2), 
the Director site (URL) must be added to Internet Explorer’s list of trusted sites.

1.1.2 Multi-level Management
The ShoreTel system provides in-depth access levels to ShoreTel Director. System 
parameters for administrative permissions allow many administrative roles to be defined so 
as to provide only as much access to the system as each user requires. By default, the initial 
system administrator has access to everything on the system. However, by using the 
administrative permissions pages, you can define site administrators, directory list 
managers, read-only users, and more. Each user who needs to access Director can be 
assigned a level of permission tailored for his needs.

1.1.3 Multi-user Management
ShoreTel Director allows simultaneous access to ShoreTel Director by multiple users. To 
ensure data integrity, the database is locked during save transactions in ShoreTel Director. If 
another user tries to save changes while the database is locked, ShoreTel Director advises 
the user that the changes were not saved; the user simply needs to save the changes again.

Most changes to the database are completed within one second, so the probability of 
attempting to save while the database is locked is low.

If two users open the same record at the same time, the user who saves last “wins,” since 
changes are processed in serial order. If two users open the same record at the same time 
and the first user deletes the record, the second user receives an error message upon trying 
to save.

1.1.4 External Telephone Number Formatting
Unlike the ShoreTel Communicator, which has a location as a reference point, ShoreTel 
Director is global and has no inherent location; it has no inherent relationship to local 
exchanges or countries. The following is a list of number entry rules:

All external numbers in ShoreTel Director – must be entered in canonical format, as 
follows:

• +C… (A…) S…

“+” = International designation
“C” = Country code
“A” = Area code (also known as a city code)
“S” = Subscriber number

DID Numbers – Must be entered in canonical format.

• +1 (408) 331-3300 (U.S., Canada)

Message Notification Destinations – Must be entered in canonical format and must not 
include a trunk access code. The number is presented back to the user in canonical format.

• +1 (408) 331-3300 (U.S., Canada)

System Directory Entries – Must be entered in canonical format. The number is presented 
back to the user in canonical format.

• +1 (408) 331-3300 (U.S., Canada)
18
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Call Forward Destinations – Must be entered in canonical format and must include a trunk 
access code. The number is presented back to the user in canonical format with the trunk 
access code in front of the number.

• 9+1 (408) 331-3300 (U.S., Canada)

Off-system extensions can be used as call forward destinations. You must enter the off-
system extension without a trunk access code (for example, 8 or 9) for proper operation.

Table 1-1 gives examples for all the countries supported by ShoreTel Director.

1.1.5 Preferences
ShoreTel Director saves certain preferences in cookies on the client PC for ease of use. The 
Preference page shown in Figure 1-1 lets you configure some of these preferences, 
including the way to record auto-attendant prompts and certain default settings. To view 
this page, click Preferences under the Administration link in the ShoreTel Director 
application (described later in this chapter).

Table 1-1 International Phone Number Examples

Phone Number Country

+1(408) 331-3300 U.S., Canada

+31 70 348 6486 Netherlands

+33 8 36 68 31 12 France

+34 91 845 6078 Spain

+44 20 7634 8700 UK

+49 69 571903 Germany

+55 61 429 7777 Brazil 

+60 3 2693 5188 Malaysia

+61 2 9360 1111 Australia

+65 736 6622 Singapore

+852 2508 1234 Hong Kong
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Figure 1-1 Preference Edit Page

The selectable parameters in the Administrator’s Preference window are as follows:

• Play and Record Using: This area lets you specify one of the following methods for 
recording and playing an auto-attendant prompt.

— PC – This selection is for recording and playing a greeting through a microphone 
and PC loudspeaker. A sound card must exist in the computer for this option.

— Telephone – Select to play and record by use of a telephone handset. For this 
option, the Call Number field must have the telephone number or extension that 
you want the system to use to call you.

• Sorting Order: Lets you specify the default column used to sort users on the 
Individual Users page.

• “Add New” Defaults: This section lets you set default values that are used 
throughout the system for creating new profiles. The parameters for which you can 
set values include:

— User Group

— Trunk Group

— Trunk Group Type

— Switch Type

For each parameter, click the field and select the value that you want to use from 
the drop-down menu.

In addition to the preferences that are explicitly exposed, ShoreTel Director keeps other 
preferences as cookies and uses them to predict good defaults when it adds new records. 
The following information is also stored locally in cookies:

• Extension numbers
• DID numbers
• Sort order for every list page
20
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1.1.6 Prompts
Prompts on the ShoreTel system can be imported into the system by using μ-law, WAV file 
format (CCITT μ-law, 8KHz, 8 bit, mono). If you want your prompts to match the voice of 
the ShoreTel system, contact Worldly Voices at the web site www.worldlyvoices.com. 
Request that “Connie” record your prompts. Worldly Voices provides this service for a 
nominal fee and provides rapid turnaround.

1.2 Starting ShoreTel Director
ShoreTel Director is a web application hosted on a ShoreTel server and accessed over the 
network. Before starting ShoreTel Director, you must have obtained the ShoreTel Director 
Uniform Resource Locator (URL), your user ID, and password from a system administrator. 

Browser Requirements for ShoreTel 12, 12.1, and 12.2

• Microsoft Internet Exporer (IE) 8 or later.

Browser Requirements for ShoreTel 11, 11.1 and 11.2

• MS Internet Explorer 7.0 - ShoreWare Director

• MS Internet Explorer 8.0 - ShoreWare Director and ShoreTel Communicator for 
Web

• Safari 4.0 - (On Apple Corproation’s Macintosh computers)

• Firefox 3.6 - (On Microsoft Corporation’s Windows-based computers and Mac OS)

To start ShoreTel Director, do the following:

Step 1 Launch a browser.

Step 2 In the URL field, enter the following:

http://<ShoreTel server name> | <IP address>/ShoreWareDirector

Click Go or press Enter. The login screen appears as shown in Figure 1-2. Also, 
the build number for the ShoreTel software appears above the copyright 
number in the lower-left corner of the window.
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Figure 1-2 Login Page

Step 3 In the User ID field, type your user ID or the default User ID (“admin”).

Step 4 In the Password field, type your password or the default password 
(“changeme”).

You must create a user with administrator privilege to gain full access to 
ShoreTel Director features. The admin and changeme defaults must be changed 
after you assign full System Administrator permission to a user. See the 
"Administrative Permissions" on page 59 for additional information and for 
information about giving users administrative permission.

Step 5 Click Login. Upon first-time login to a new system, the ShoreTel Director 
Welcome screen appears as shown in Figure 1-3. Upon subsequent logins, 
unregistered systems skip the Welcome screen and display the registration 
window shown in Figure 1-4.
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Figure 1-3 Product Registration Page

1.3 Product Registration
After you install or upgrade to ShoreTel 12.2 and launch ShoreTel Director for the first 
time, a Welcome screen requests you to register the ShoreTel software and requests your 
ShoreTel software system keys. It provides you with the following registration options:

ShoreTel encourages you to register ShoreTel Director promptly so that we have the most 
up-to-date information concerning your ShoreTel products and installation.

NOTE For continued use of ShoreTel Director, the system administrator must register 
ShoreTel software within 45 days. You can request a new license during 
registration.

To register ShoreTel Director, take one of the following actions:

• Select Now to register immediately. ShoreTel Director opens the Contact 
Information page for entering registration information, as described in the "Contact 
Information" on page 24.

• Select Later to register at another convenient time. With this selection, ShoreTel 
Director opens at the Quick Look page. 

The registration data goes to ShoreTel over a secure connection to ensure integrity and 
privacy. For systems that are not online, an email transmission option is available

If an installation does not have adequate or current licenses, ShoreTel Director opens at the 
License Preview page when you have completed or skipped registration. See the 
"Requesting the ShoreTel Software License Key" on page 25 for information.
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1.3.1 Contact Information
When you select the Now option from the Welcome screen, the ShoreTel software 
registration starts. The Contact Information screen, appears as shown in Figure 1-4.

Figure 1-4 User Contact Information

To specify contact information:

Step 1 Type the requested information in the applicable fields.

The Server MAC Address field is automatically populated with information from 
the ShoreTel Server. You should change this information only if you want a license 
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for a server other than the one to which you are currently connected. If you have 
changed this information but instead want the defaults, click Refresh this page.

The Sales Order Number is on the ShoreTel packing slip. (Supplying this 
information is optional for system upgrades.)

Step 2 Click Save.

Step 3 Click Now to register immediately. 

The contact information goes to ShoreTel, and the License Preview page appears. 
See the "Requesting the ShoreTel Software License Key" on page 25 for information 
about requesting the ShoreTel license key.

Step 4 Click Print to print out and send in the contact information at a later time.

The contact information is displayed. Save this information as a text file. Later, 
when you are ready to complete the registration process, send the file to 
shorecare_admin@shoretel.com.

1.3.2 Requesting the ShoreTel Software License Key
After completing and registering the Contact Information form, the License Preview page 
appears as shown in Figure 1-5. You must request a license key. 

Figure 1-5 License Preview Page

To request a license key, do the following:

Step 1 Review the information in the License Preview page.

Step 2 Do any of the following:
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• Click the Print button at the top of the page to print the information.

• Click the Submit button to send the request immediately to ShoreTel, Inc. 
After verifying the information, ShoreTel emails the license key within 
three business days.

• Click the Save to File button to save the request for later submission.

After you have registered ShoreTel Director, the Quick Look page appears 
shown in Figure 1-6.

Figure 1-6 Quick Look Page

You can use ShoreTel Director to configure and monitor a ShoreTel system. We recommend 
you first create a unique user with system administration privileges and a unique password, 
and then change the default login and password. See the "Administrative Permissions" on 
page 59 for information about creating users and assigning administration 
permission.ShoreTel Director sessions terminate after 60 minutes of inactivity. 

Until the license key arrives, you can click on Later in the ShoreTel Director Welcome 
screen to enter ShoreTel Director. You have up to 45 days to install the license key.

NOTE Installation of any release after ShoreTel 12 prompts for re-registration.

1.3.3 Installing the License
When you receive your licence keys, you must install them in ShoreTel Director. To install 
the license, do the following:

Step 1 View the license packet that you received from ShoreTel.

Step 2 Launch ShoreTel Director.

Step 3 In the ShoreTel Director menu click Administration > System Parameters 
>Licenses > Keys. The License Key page appears.

Step 4 Click the New button at the top of the page. The License Key Info dialog box 
appears.

Step 5 In the Key field, enter the license key that you received from ShoreTel.

Step 6 In the Comment field, enter a description of the license.
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Step 7 Click Save.

Step 8 Repeat Steps 4 through 7 for each license key that you have to install.

1.4 Director Components
ShoreTel Director is the administration interface for the ShoreTel system. This section 
provides a brief discussion about how to navigate and use ShoreTel Director. To access 
ShoreTel Director, do the following:

Step 1 Launch a browser. ShoreTel Director supports Microsoft Internet Explorer (IE) 
8 or later.

Step 2 In the URL field, enter the following:

http://<ShoreTel server name or IP address>/ShoreWareDirector

Click Go or press Enter. If you have installed a license key, the ShoreTel 
Director interface appears as shown in Figure 1-7. If the registration page 
appears, click Later to move on.

Figure 1-7 ShoreTel Director Interface

The interface includes two columns. The column on the left is the Navigation Frame. The 
column on the right is the Data page. Both are discussed below.
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1.4.1 Navigation Frame
The navigation frame is located on the left side of the Director page and provides access to 
the following links:

• Build: Indicates the version of the ShoreTel system that you are running.

• Logoff: Lets you log out of the ShoreTel Director as the current user.

NOTE You are automatically logged off after 60 minutes of inactivity unless you are 
viewing the Quick Look page or a Switch maintenance page.

• Administration: Lets you configure the ShoreTel system.

• Maintenance: Lets you view status information about the components installed in 
your system.

• Reporting: Lets you run ShoreTel reports.

• Documentation: Lets you download ShoreTel product documentation.

1.4.2 Data Pages
Data pages display on the right side of the ShoreTel Director page. These pages let you add, 
delete, or edit system configuration parameters, view status, and issue commands. These 
pages are designed as list pages, edit pages, and maintenance pages.

1.4.2.1 List Pages
List pages identify objects that are created in the system in the category that you have 
selected. These pages generally provide categorical information about the objects. 

Adding to Objects

New, Add new, and Go links and New buttons allow you to add objects to the system 
configuration. Clicking the prompt may display a configuration page or a dialog box.

Editing Objects

To display for viewing or editing the profile of an object in a List page, click on the object. 
Principal list objects are shown in bold characters. Values used to define the principal 
object that are themselves configurable are underlined. You can click such values to view 
and edit their parameters. 

Sorting

The records on each list page are presented in a default sort order. Most pages allow you to 
change the sort order by clicking a column heading. Elements in the column are rearranged 
in ascending order only. 

List Paging

To assist enterprises with large amounts of data, several configuration screens offer 
searching and sorting of the data used in a pertinent field. For example, when selecting 
members of a hunt group, you can search for last names, extensions, and more. If more 
data is returned than fits the window, you can page up and down through the results. Hunt 
groups, extension lists, workgroup agents, and call handing delegation offer paging.
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1.4.2.2 Edit Pages
Edit pages let you to view and edit object profiles. Edit pages have up to five control 
buttons at the top of the page. Table 1-2 on page 30 provides information about the 
buttons. You must enter a value in any field to activate these buttons. Some edit pages also 
have a tab bar as shown in the Figure 1-8. The tabs open additional configuration pages for 
the object. You must click the Save button to save your changes.

Figure 1-8 Edit User Page
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NOTE Individual data-entry fields, drop-down lists, and option buttons are described in 
the appropriate sections throughout each chapter.

ShoreTel Director saves certain parameters on your computer locally (using cookies) to 
help present the most relevant default configuration when you click New or Copy. This 
includes extension numbers and DID numbers.

1.4.3 Getting Help
To get help that pertains to the page you are working on, you can press the F1 key or click 
the Help link in the data-entry frame, which provides access to the relevant chapter from 
this guide. From the navigation frame, you can access this complete guide, or other system 
documentation, by clicking the Documentation link to expand the list of guides. The 
following documentation is provided:

• ShoreTel 12: System Administration Guide

• ShoreTel Planning and Installation Guide

• Telephone User Interface Guide IP Phone

• Telephone User Interface Guide Analog Phone

• Server Release Notes

• Client Release Notes

Clicking any of the titles invokes a Portable Document Format (PDF) copy of the 
corresponding document.

1.5 Getting Started
This section lists a summary of tasks to perform to configure your system for the first time. 
This ordered list also follows the order in which this guide is organized. Before you begin 
configuring the system, make sure it has been properly installed as described in the 
ShoreTel Planning and Installation Guide.

❑ Launch ShoreTel Director. See the "Starting ShoreTel Director" on page 21 for 
information about launching ShoreTel Director.

❑ Register the ShoreTel software and request a license key or keys. See 
"Requesting the ShoreTel Software License Key" on page 25 for information 
about registering ShoreTel software and requesting license keys.

Table 1-2 Control Buttons

Button Function
New Creates a new object profile by using default values.
Copy Create a copy of the current object profile that you can use 

to create a new object profile. Some values, such as 
extension numbers, are automatically generated for the 
new profile.

Save Saves the changes you make to the profile.
:Delete Removes the current profile from the system.
Reset Reverts to the last saved profile.
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We encourage prompt register ShoreTel Director so that we have the current 
information about your ShoreTel products and installation.

❑ Install your license key or license keys if you have them. You have up to 45 
days to install the licenses after which you cannot continue to use the ShoreTel 
software. See the "Installing the License" on page 26 for information about 
installing license keys.

Until you have updated all required licenses, ShoreTel Director will continue to 
open to the License Requirements page after login.

❑ Configure system parameters using the System Parameters link:

• Install any new licenses your installation requires from the Licenses page.

• Specify the dialing conventions to use throughout the system in the Dialing 
Plan page. See the "Setting Dial Plan Parameters" on page 35 for more 
information about dialing plans. The dialing conventions include extension 
length as well as the dialing plan reservations for extensions and trunk 
access codes.

• Configure the system’s extensions from the System Extensions page. See 
the "System Extensions" on page 41 for more information about system 
extensions. Review the default system extensions and change the defaults if 
you need to use these extensions for other purposes.

• Specify the languages you want to make available for the system. (Be sure 
you have appropriate licenses for the languages.)

• Review password and log file settings on the Other page. See the "Other" 
on page 45 for more information about other configurable parameters. You 
should be able to accept all the defaults.

❑ Create and configure the sites that you want your ShoreTel system to have 
using the Sites navigation link. Chapter 3: ShoreTel Sites on page 65.

• Review the following default Headquarters site parameters. Click the 
Headquarters link on the Site list page.

— Country location for the site
— Local area codes for 7- and 10-digit dialing
— Emergency call back number (if using ISDN PRI)
— Time zone (for correct date and time for caller ID telephones)
— Admission control bandwidth (for multiple-site configurations)

You cannot configure Night Bell Switch or Paging Extension until the 
proper switch is configured, nor can you configure Operator Extension or 
Fax Redirect Extension until the proper users are configured. You will need 
to return to this page later.

• Set the IP address range for the IP phones at any remote sites. You define IP 
address ranges so that IP phones are assigned to the correct site. IP phones 
not assigned to a remote site are associated with Headquarters.

• Configure additional sites if desired. 

❑ Configure additional ShoreTel servers by using the Application Servers page. 
See Chapter 4: Configuring Application Servers on page 73.

• Name the server and assign it to a site.
• Create the ShoreTel server.
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• Set the voice mail and auto-attendant extensions.
• Assign a user group to the server.

❑ If you are using the ShoreTel Enterprise Contact Center Solution, you need to 
configure it. Refer to the ShoreTel Enterprise Contact Center Administration 
Guide and the ShoreTel Enterprise Contact Center Installation Guide for more 
information.

❑ Configure ShoreTel voice switches using the Switches page. “Configuring 
Switches” on page -89 for more information.

• Select the role that you want to switch to perform for the site.

• Identify the site where you want to use the switch.

• Select the switch model you want to use.

• Create the switch profile.

• Provide a name and description and use the Find Switches button to 
discover each voice switch on the network.

• Specify the ShoreTel server that you want to manage the switch.

Your ShoreTel voice switches must have a valid IP address from a DHCP server 
or from the BOOTP server on the ShoreTel server, or an address statically 
configured from the maintenance port (24, T1, and E1 only).

❑ Configure IP phones using the IP Phones link. See Chapter 8: Configuring IP 
Phones on page 191 for more information.

• Add IP phone ports to ShoreTel voice switch-120/24, ShoreTel voice switch 
90, ShoreTel voice switch-60/12, ShoreTel voice switch 50, ShoreTel voice 
switch-40/8, ShoreTel voice switch 220T1/T1A/E1 and ShoreTel voice 
switch-T1/E1 voice switches supporting IP phones. For each port you 
assign to IP phones, the switch supports five IP phones. For more 
information, Chapter 8: Configuring IP Phones on page 191.

• Set the boot parameters of the IP phones. ShoreTel IP phones are set to find 
boot information from a DHCP server. If your installation has other 
requirements, use the IP phone set-up menu to set server and boot 
configuration parameters. For more information, see the ShoreTel Planning 
and Installation Guide.

You can speed up the installation by using the Extension Assignment feature. 
See the "Using Extension Assignment" on page 410 for information.

❑ Configure the following users before you add general users to the system:

• During installation, a system administrator is set up. Assign a person at 
your site to this role. When you assign a system administrator, the default 
user ID and password must be changed. Make a note of the new user ID 
and password, since the defaults (admin and changeme) will no longer be 
available.

• Configure an operator for each site. See the "Administrative Permissions" 
on page 59 for more information.

This is the extension reached when 0 is dialed from the telephone. Note 
that operators can span sites.

Configure a “user” as the Fax Redirect extension for each site.
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• Configure a user as the default Personal Assistant for all other users. This is 
the user that calling parties are routed to when they dial “0” in a user’s 
mailbox. It is important that you configure the default Personal Assistant 
before adding the bulk of the users so that appropriate defaults can be 
assigned. If you omit this step, you may have to spend time reconfiguring 
the users later.

• Configure the Call Handling Modes Defaults and assign the Personal 
Assistant.

❑ Complete configuration of sites:

• Return to each site and complete the configuration for Night Bell, Paging, 
Operator, and Fax Redirect.

• If you have added additional servers, return to each Site edit page and 
reconfigure as appropriate.

❑ Configure all trunk groups and trunks:

• Configure trunk groups from the Trunk Groups page. You can modify the 
default trunk groups, add new trunk groups, and assign individual trunks 
for Make Me conferencing.

• Configure the trunks from the Individual Trunks page. For the ShoreTel 
voice switch-T1, return to the Switch edit page and assign all the channels 
on the T1 to the proper trunk group.

❑ Configure the users from the Users pages:

• Configure the user groups, including all the Class of Service (CoS) 
permissions from the User Group edit page. You can modify the default 
user groups or add new trunk groups. Be sure to grant access to any new 
trunk groups you have added.

• Configure all the users from the Individual Users edit page.

• Configure any anonymous telephones from the Anonymous Telephone edit 
page.

❑ Configure call control parameters from the Call Control link. Set up hunt 
groups and paging groups, as needed.

❑ Configure voicemail parameters and system distribution lists from the Voice 
Mail Options and System Distribution Lists pages.

❑ Configure the auto-attendant parameters from the Auto-Attendant edit pages:

• Configure each auto-attendant menu from the Menus page.

❑ Set schedules from the Schedules link. These may be used by the auto-attendant 
or paging groups.

• Configure the workgroups from the Workgroups edit page:
• Configure the workgroup.
• Configure the call handling modes.
• Configure the queue, including prompts.

❑ Configure the system directory from the System Directory edit page:

If you use Microsoft Exchange and Microsoft Outlook, you can leverage 
Contacts on the Exchange Server for common contact information.
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Setting Up System Parameters

This chapter describes how to set system-wide parameters by using ShoreTel Director. The 
topic sections in this chapter are as follows:

• "Setting Dial Plan Parameters" on page 35

• "Digit Translation Tables" on page 39

• "Security" on page 41

• "System Extensions" on page 41

• "SNMP" on page 44

• "BOOTP Server" on page 44

• "Other" on page 45

• "Client Compatibility" on page 48

• "Languages" on page 49

• "Licenses" on page 50

• "Administrative Permissions" on page 59

2.1 Setting Dial Plan Parameters
The dial plan defines the numbering convention your ShoreTel system uses to route calls. 
The system uses the dial plan to parse dialed numbers—whether from internal users or the 
Public Switched Telephone Network (PSTN)—and to direct calls appropriately. The dial 
plan can include extensions, site codes (pre-extensions), access codes for trunks, and 
permission codes.

This section describes how to set the parameters used to create number strings in your dial 
plan. These parameters are set using the Dial Plan page in ShoreTel Director. This page 
allows you to do the following:

• Specify the lead digit used in a string.

• Specify the number of digits included in a string.

NOTE You cannot reduce the number of digits included in an extension after the 
parameter is set.

• Specify how the sting is used in the system.

Before you begin, review your ShoreTel system deployment and topology, and the local 
Telco dial plan and dial rules for each ShoreTel site that you deploy.
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To set the string parameters used in your dial plan, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Dial Plan. The Edit Dialing Plan 
page appears as shown in Figure 2-1. See Table 2-1 on page 37 for information 
about the configuration elements that appear on the page.

Figure 2-1 Edit Dialing Plan Page

Step 3 In the Digit column, identify the number or character that you want to use for 
the leading digit in this string.

NOTE All available digits are preconfigured as lead dial strings. Reconfigure 
only those dial strings that you want to use for special purposes. 

Step 4 In the Reservation field next to the digit, select the parameter that you want to 
use for this digit string. See Table 2-2 on page 37 for information about the 
available parameters.

IMPORTANT Extensions must not conflict with the leading digits of emergency 
telephone numbers, since the ShoreTel system allows users to dial 
emergency numbers with or without a trunk access code. If you are 
deploying a global voice network, this must be considered for all 
emergency numbers. 

Step 5 Repeat Step 3 and Step 4 for all of the digits that you want to change the 
configuration.

Step 6 Click Save to save your changes.
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IMPORTANT Once you set and save the Reservation parameter, it cannot be changed. 
The field is unselectable after the change is saved.

Table 2-1 System Parameters Page: Dial Plan Elements

Element Description
Number of Extension Digits Shows the number of digits currently uses in ShoreTel 

extensions. The default is 3 digits.
Increase Extension Length Allows you to increase the number of digits used in 

ShoreTel extensions. 
Dialing Plan This section allows you to set parameters used for 

extension numbers. You must specify how you want 
the ShoreTel system to interpret each dialable, leading 
digit.

Digit The numeric and ASCII characters used as leading 
digits.

Reservation Allows you to set the extension parameters that you 
want to use with each leading digit. See Table 2-2 for 
information about extension options.

Table 2-2 Reservation Options

Option Description

Extension Prefix (n digits) Lets you specify the number of digit used in extension 
prefixes that have this leading digit. Extension prefixes 
can be up to 7 digits in length. 

NOTE The Configure Extension Prefix Warning 
window appears with a list of each of the 
sites in your system. Next to the list of sites 
you will find a blank field that requires you 
to enter the desired extension prefix. This 
prefix will be appended to every dialed 
number at that particular site. Make sure to 
back up the system before clicking Save.

Extensions Reserve this digit as the leading digit in an extension. 

NOTE The digit “0” cannot be reserved as the lead 
digit in extensions.

Not Used Does not allow this digit to be used as a lead digit.
Operator Reserve this digit for use as the extension used to 

access the ShoreTel operator. The default value is zero 
(0). In international applications, zero is often used as 
the access code for trunks. This sets a potential for 
conflict. ShoreTel recommends that international 
customers standardize globally on a single trunk 
access code for the purposes of network call routing 
(for example, use “9” for all trunk groups)
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2.1.1 Increasing the Extension Length
The ShoreTel system lets you increase the number of digits the systems use for phone 
extensions from the default number of three digits to five digits. To match the new number 
when you increase the number of extension digits, you must also add one or more numbers 
to the beginning of that extension for existing numbers, including mailboxes, menus, and 
distribution lists. Be sure that the added number or numbers do not conflict with other 
access codes in the system’s dial plan.

To increase the number of digits for phone extensions, do the following:

Step 1 Launch ShoreTel Director.

Step 2 In the ShoreTel Director menu, click Administration >System Parameters > 
Dial Plan. The System Parameters: Edit Dial Plan page appears.

Step 3 Click the Increase Extension Length button. The Increase Extension Length 
Warning dialog appears as shown in Figure 2-2.

Figure 2-2 Warning Dialog Box

Trunk Access Codes [1 Digit] Reserves this digit for use as a trunk access code.

NOTE When you make a number the leading digit 
in a trunk access code, using the same 
number as the leading digit in extensions can 
cause the system to misroute calls. 

Trunk Access Codes [2 Digit] Reserves this digit as the lead digit in two-digit trunk 
access codes.

NOTE When you make a number the leading digit 
in a trunk access code, using the same 
number as the leading digit in extensions can 
cause the system to misroute calls. 

Trunk Access Codes [3 Digit] Reserves this digit as the lead digit in three-digit trunk 
access codes.

NOTE When you make a number the leading digit 
in a trunk access code, using the same 
number as the leading digit in extensions can 
cause the system to misroute calls. 

Table 2-2 Reservation Options (Continued)

Option Description
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Step 4 Click Yes to increase the extension length. The Increase Extension Length 
dialog appears as shown in Figure 2-3

Figure 2-3 Specifying New Extension Digits

Step 5 In the Select your new extension length field, select the number of digits that 
you want to use for ShoreTel extensions.

Step 6 In the Enter the number(s) to pre-pend to your current extension field, enter 
the number or numbers that you want to appear at the beginning of extensions.

IMPORTANT Make sure that the numbers that you pre-pend to the extension are not 
used elsewhere in your dial plan in such a way that they conflict with 
other strings such as trunk access codes, the operator extension, and 
emergency numbers.

Step 7 Click OK to apply the change.

2.2 Digit Translation Tables
Digit translation tables let you convert numbers from other dial plans to ShoreTel numbers.

When designing and creating a ShoreTel system, you might plan to integrate the system 
with another phone system that uses a different dial plan. To make the transition between 
systems invisible to users, you can create digital translation tables in ShoreTel Director. 
These tables allow you to compensate for a difference in the number of digits in each plan. 
The ShoreTel system applies the adjustment when it passes calls between the two systems. 
You can then associate the digital translation table with a trunk bridging systems or the 
Simplified Message Desk Interface (SMDI) module in an application server allowing users 
to access their legacy voice mailbox. In either case, users do not have to change their 
dialing habits.

This section describes how to create digit translation tables. Information about applying 
digital translation tables appears in the sections about trunks and application servers.

Digital translation tables let you adjust the extension format used in your ShoreTel dial 
plan to the format used in another dial plan of another phone system. You can specify the 
number of digits and the lead digit used by each system. When applied, the ShoreTel 
system adds or deletes the digits you specify depending on the direction of the call route.
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2.2.1 Creating Digit Translation Tables
To create a digit translation table in ShoreWare, do the following:

Step 1 Launch ShoreTel Director.

Step 2 In the ShoreTel Director menu, click Administration > System Parameters > 
Digital Translation Tables. The Digital Translation List page appears as shown 
in Figure 2-4.

Figure 2-4 Digit Translation List Page

Step 3 Create a new translation profile as follows:

Step a Click the New button to add a new entry. The Table Entries page appears as 
shown in Figure 2-5.

Figure 2-5 Digital Translation Table Entries Page

Step b In the Name field, enter the name that you want to use to identify this 
translation profile and click Save. The New button is activated.

Step c Click the New button. The Digit Translation Info dialog box appears as 
shown in Figure 2-6.

Figure 2-6 Digit Translation Page and Entry Dialog Box
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Step d In the Original Digits field, enter the string that you want translated.

Step e In the Replacement Digits field, enter the string that you want to use to 
replace the original string.

Step f Click Save.

Translation table lists appear in profiles for trunk groups and application servers when 
Simplified Message Desk Interface (SMDI) is selected as the voice mail interface.

2.2.2 Deleting Translation Tables
To delete a digit translation table, do the following:

Step 1 Launch ShoreTel Director.

Step 2 In the ShoreTel Director menu, click Administration > System Parameters > 
Digital Translation Tables. The Digital Translation List page appears as shown 
in Figure 2-4 on page 40.

Step 3 Check the box next to the digit translation table that you want to delete.

Step 4 Click the Delete button.

2.3 Security

2.4 System Extensions
Services such as voicemail, account codes, auto-attendant, Make-me conferences, and 
ShoreTel conferences associated with the ShoreTel HQ site have system-wide application. 
These services, when enabled on the HQ site, are automatically assigned an extension on 
the HQ server. That extension can be used by any user anywhere on the system to access 
the service though the service may be executed at the server site that is local for the user.

You can view and modify extensions assigned to these system-wide services using the 
System Extensions page. To access the System Extension page, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Select Administrator > System Parameters > System Extension. The Edit 
System Extensions page appears as shown in Figure 2-7. Table 2-3 describes 
the elements that appear in System Extensions page.
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Figure 2-7 System Extensions Edit Page

Table 2-3 System Extension Elements

Element Description
Voice Mail This section provides information about system-wide 

voicemail extensions.
Voice Mail Extension  The extension the system uses for forwarding calls to 

voicemail.
Voice Mail Login Extension This is the extension that users use to log into their 

voice mailbox.

It is recommended that users be allowed to dial in 
from outside the company to retrieve their voicemail. 
Typically, you direct this number to an auto-attendant 
menu and configure the menu with a single-digit 
action of “Transfer to Extension” using the Voice Mail 
Login Extension parameter. 

Voice Mail Broadcast Mailbox The extension users use to broadcast a voicemail 
message to all users.

Account Codes This section provides information about system-wide 
account code extensions.
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Account Code Extension This is the extension on the headquarters SoftSwitch 
associated with the account codes application. When 
account code collection is optional or forced, calls are 
routed to this extension for an account code prompt. 
See also the "Account Codes" on page 237.

Auto-Attendant This section provides information about system-wide 
auto-attendant extensions.

Auto-Attendant Extension The extension used for the system-wide auto-
attendant.

Backup Auto-Attendant Extension The extension you want to use as an auto-attendant 
backup in case the Headquarters server fails.

The backup auto-attendant provides basic inbound 
call routing in case the auto-attendant on the ShoreTel 
server is unavailable. In addition, it answers calls 
routed to voice mail in case voice mail on the ShoreTel 
server is unavailable.

The backup auto-attendant is also used when 
extensions are not reachable during a network or 
switch outage and the Admissions Control Bandwidth 
is exceeded.

Callers who are accessing the ShoreTel system over a 
SIP trunk can access the Backup Auto-Attendant in the 
same manner as users who are accessing the system via 
all other trunk types. ShoreTel supports RFC2833 
(DTMF), so if the voice-mail server is down, external 
callers can enter an extension using DTMF to ring the 
extension of the user they are trying to reach.

Make Me Conference
Make Me Conference Extension This extension allows users to create conferences on a 

ShoreTel voice switch. Conferences can have up to six 
participants depending on how the conference 
capability is configured.

ShoreTel Conference This section provides information for conferences 
conducted using the ShoreTel Service Appliance 100 
(SA-100).

Extension The system-wide extension internal users use to 
initiate a conference using the SA-100.

External Number Main external telephone number users can dial to 
access an SA-100 conference.

Additional Calling Information Allows you to specify other external telephone 
numbers users can use to access SA-100s conferences. 
These numbers may be local to remote sites.

Table 2-3 System Extension Elements (Continued)

Element Description
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2.5 SNMP
The ShoreTel voice switches support Simple Network Management Protocol (SNMP) 
agents for the Ethernet interface. These agents provide Management Information Base II 
(MIB-II) statistics and allow the ShoreTel voice switches to be integrated into standard 
network management applications. 

ShoreTel has tested and supports the HP OpenView network management console. 

ShoreTel recommends that you configure your SNMP management station to launch 
ShoreTel Director automatically when you click a ShoreTel device.

To enable SNMP for your ShoreTel system, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > SNMP. The Edit SNMP page 
appears as shown in Figure 2-8.

Figure 2-8 SNMP Edit Page

Step 3 In the Read-Only (Get) field, enter the SNMP community string your network 
uses for read-only SNMP messages.

Step 4 In the Read/Write (Get/Set), enter the SNMP community string your network 
uses for read and write SNMP messages.

Step 5 In the IP Address of Trap Receivers section, type the IP address of each 
destination that should receive SNMP traps. Up to five locations can receive 
traps. The destination IP address must have an SNMP trap listener (UDP Port 
162) installed.

2.6 BOOTP Server
The BOOTP Server option lets you assign static IP addresses to ShoreTel voice switches. 
This section describes how you can use the BOOTP option to assign static IP addresses to 
voice switches.
44



Chapter 2: Setting Up System Parameters System Administration Guide
The requirements for this task are as follows:

• Valid IP address for the location where the switch is to be installed.

• MAC address located on the label on the back panel of the switch.

To use BOOTP Server to assign a voice switch an IP address, do the following:

Step 1 Connect the voice switch to the network.

NOTE For best results when assigning the IP address, we recommend that 
you connect the switch to the network segment that the server is on.

Step 2 Launch ShoreTel Director.

Step 3 Click Administration > System Parameters > BOOTP Server. The Edit SNMP 
page appears as shown in Figure 2-8. The Edit BOOTP Server page appears as 
shown in Figure 2-9.

Figure 2-9 BOOTP Server Edit Page

Step 4 In the field under Ethernet Address, enter the MAC address of the switch to 
which you want to assign the IP address.

Step 5 In the field under IP Address, enter the IP address that you want to assign to 
the switch.

Step 6 In the field under Subnet Mask, enter the subnet mask that you want to use for 
the switch.

Step 7 In the field under Default Gateway, enter the IP address of the router or 
gateway that you want the switch to use to access the network.

Step 8 Click Save to save this profile. 

The BOOTP server sends the IP address information when the ShoreTel voice switch sends 
a request. 

2.7 Other
A mix of system-wide site parameters are configured using the Other option in the System 
Parameters menu. System parameters you can configure address passwords, server storage, 
Instant messaging, ShoreTel upgrades, Active Directory and more. 

To access the Other page, do the following.

Step 1 Launch ShoreTel Director.
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Step 2 Click Administration > System Parameters > Other. The Edit Other 
Parameters page appears as shown in Figure 2-10. Table 2-4 provides 
information about the elements that appear in the page.

Figure 2-10Other Parameters Edit Page

Table 2-4 Elements in Edit Other Parameters Page

Element Description
General
Max Voice Mail Errors (2-50) Lets you specify how many times a caller can make an 

error when using the telephone to log into voicemail. 
When the user exceeds the number of errors, the 
system informs the user of the error and hangs up.

Min Voice Mail Password Length 
(4-26) 

Lets you specify the minimum number of digits 
required for voicemail passwords.
46



Chapter 2: Setting Up System Parameters System Administration Guide
Min Client Password Length (4-
26) 

These parameters specify the minimum number of 
characters for the client password needed for a user to 
log into the ShoreTel Communicator application or 
ShoreTel Director.

 Max Client Password Length (4-
26)

Lets you specify the maximum number of characters 
that users can have in their passwords.

ShoreTel Voice Switch:
“admin” Password Lets you change the password use to access the admin 

account for ShoreTel voice switches.
“root” Password Lets you change the password used to access the root 

account for ShoreTel voice switches.
Log File Storage Lets you set universal parameters ShoreTel servers use 

for storing log files.
Max Days (1-30) Lets you specify the number of days servers keep a log 

file before deleting it.
Max Size (10-500) Lets you specify the maximum number of megabytes 

that a server can use to store log files.
ShoreGear Voice Switch Log File 
Storage

Lets you set universal parameters ShoreTel voice 
switches use for storing log files.

Max Days (1-30) Lets you specify the number of days voice switches 
keep a log file before deleting it.

Max Size (10-600) Lets you specify the maximum number of megabytes 
that a switch can use to store log files.

Service Appliance Log File Storage Lets you set universal parameters service appliances 
use for storing log files.

Max Days (1-30) Lets you specify the number of days Service 
Appliances keep a log file before deleting it.

Max Size (10-60000) Lets you specify the maximum number of megabytes 
that a Service Appliance can use to store log files.

IM Lets you set system-wide parameters that are used for 
instant messaging.

Domain Name The domain name (FQDN) that is used for IM.
Enable Offline Messaging Check to retain messages to users who are off-line. 

Users will be able to view these messages when they 
come on-line. When unchecked, messages are dropped 
when there is no user on-line to receive them.

Enable TLS Check to allows encryption using transport layer 
security (TLS).

Session Timeout (10-600) Lets you specify the duration in minutes that the 
system allows a message to remain open without a 
response before timing out.

Client Compatibility and Upgrades

Table 2-4 Elements in Edit Other Parameters Page (Continued)

Element Description
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2.8 Client Compatibility
The Client Compatibility feature provides a way for organizations to have greater control 
over which versions of Communicator should be deployed during a ShoreTel system 
upgrade. This feature is designed to lessen the impact of system upgrades for customers. 
Client Compatibility allows you to upgrade your servers first then your clients. Spreading 
the upgrade out over time is less demanding on the IT staff and allows users to upgrade at 
their own convenience.

The Client Compatibility feature lets you specify the earliest version of Communicator that 
the system supports and suggests an earliest version that clients can use without 
upgrading. System Administrators can implement the V Minus 1 Compatibility 
functionality through ShoreTel Director by configuring two system-wide settings.

2.8.1 Implementing Client Compatibility
To implement Client Compatibility, follow these steps: 

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Other. The System Parameters 
Edit Other Parameters page appears as shown in Figure 2-10 on page 46.

Step 3 Scroll down to the Client Compatibility and Upgrade section and do the 
following:

Prevent Users from Initiating 
Client Upgrades

Check the check box to disallow clients to upgrade 
their Communicator application without receiving an 
upgrade notification.

NOTE We recommend setting this parameter when 
you use the Silent Client Upgrade feature in 
tandem with Microsoft Active Directory to 
install client software on remote machines.

Minimum Allowed Client Versions Enter the earliest version number of Communicator 
that you will allow users to use. Users are notified 
when their Communicator software is out of date and 
are required to upgrade. The default value is the 
earliest version of Communicator the system software 
will accept.

Minimum Suggested Clint Version Enter the earliest version number of Communicator 
that you want users to use. Users are notified once 
when their Communicator software is out of date but 
are not required to update. The default value is the 
earliest version the installed software will accept. 

Active Directory Integration
Enable AD Integration Check to allow the system to use Active Directory for 

authentication.
AD Path Enter the path that your system uses for the Active 

Directory.

Table 2-4 Elements in Edit Other Parameters Page (Continued)

Element Description
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• Check the Prevent Users from Initiating Client Upgrades checkbox to 
hide the client upgrade option in Communicator. User are only able to 
upgrade when a notification is sent.

• In the Minimum Allowed Client Version field, enter the version number of 
the earliest version of Communicator that you want to allow clients to use. 
The default value is the earliest version your system software will support.

NOTE The earliest and latest versions of Communicator that your ShoreTel 
system software will support are listed in the parenthesis.

• In the Minimum Suggested Client Version field, enter the build number of 
the earliest version of Communicator that you want to allow clients to use. 
The user is sent an upgrade message when their version of Communicator 
falls out of compliance.

NOTE Minimum Suggested Client Version is disabled when the Prevent 
Users from Initiating Upgrades option is checked.

NOTE The earliest and latest versions of Communicator that your ShoreTel 
system software will support are listed in the parenthesis.

Step 4 Click the Save button to save your changes.

The user is notified once when their version of Communicator falls below the minimum 
suggested version but is later than the minimum allowed version. A dialog box appears 
with the upgrade notification allowing them to upgrade immediately. If users chooses to 
upgrade later, they must use the Upgrade function found in the Communicator Help menu.

2.9 Languages
ShoreTel supports multiple languages and allows you to choose the languages that ShoreTel 
uses. Languages can be configured for the following:

• Sites

• Auto-Attendant Menus

• Users

• Workgroups

• Route Points

• Trunk Groups

To specify the languages that you want to make available for the system to use, do the 
following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Languages. The Languages page 
appears as shown in Figure 2-11.
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Figure 2-11Languages List Page

Step 3 Check the checkbox in the Enable column for each language that you want to 
make available on the system.

NOTE You must have a license for each language that use.

2.10 Licenses
This section describes ShoreTel licenses.

2.10.1 Supported Licenses in ShoreTel 12
ShoreTel 12 supports the following ShoreTel licenses:

• ShoreWare System License (Enterprise and Small Business Editions)

• ShoreWare Additional Site License 

• ShoreWare Extension License

• ShoreWare Mailbox License

• ShoreWare SoftPhone License

• ShoreWare Additional Language License

• Mobile Access License

• ShoreWare SIP Trunk License 

• ShoreWare SIP Phone License 

• ShoreWare Standard Resolution Video License

• ShoreWare High Resolution Video License 

• Professional Access License 

• Operator Access License 

• Workgroup Agent Access License 

• Workgroup Supervisor Access License 

• ShoreWare External Unified Messaging SIP Link License

• Audio Conference License

• Web Conference License

Self-audited Licenses:

• Personal Access License
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• ShoreWare Remote Server Software

• ShoreWare TAPI Application Server

• ShoreWare Phone API License

2.10.2 Viewing Your ShoreTel Licenses
To view the installed ShoreTel licenses in ShoreTel Director:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Licenses > Requirements. The 
License Requirements page shown in Figure 2-12 appears.

Figure 2-12License Requirements Page

The License Requirements page lists licenses that are available for the ShoreTel system and 
the quantity of licenses you have acquired. You can use this page to track and manage all 
licenses. 

The licenses are divided into keyed and self-audited licenses. Self-audited licenses do not 
have a key associated with them. They are tracked on the license page as a tool to assist 
system administrators in tracking the number required based on the current configuration 
versus the number that have been purchased, which they enter manually.

Five Communicator licenses, each of which corresponds to a Communicator type, span the 
Communicator feature set. ShoreTel defines four of these licenses as Keyed Licenses.
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2.10.3 Compliance
If your system is out of compliance, ShoreTel Director offers 45-days to comply with the 
license requirements by either removing unneeded configurations and/or by ordering 
additional licenses. The 45-day grace period allows you to make ad hoc, unplanned 
changes that could temporarily exceed your license limits, but gives you time to get back 
into compliance.

WARNING Do not upgrade unless you are already in license compliance. If you upgrade 
and you are out of compliance, you will only have 45 days before being locked 
out of ShoreTel Director. Contact your ShoreTel Partner or ShoreTel Installed 
Base Business Services Team at Shorecare_admin@shoretel.com if you have 
any outstanding license issues.

2.10.4 Registering the ShoreTel Software
You must register your ShoreTel system software and obtain a system key before you can 
use the system. This is done using ShoreTel Director. After you registered and apply for 
licenses, ShoreTel acknowledges your submission in an email and mails your system key 
within 3-5 days. You have 45 days to install your system key.

IMPORTANT After upgrading to a new version, you will have 45 days to ensure the new 
key is installed. If it is not installed, you will be locked out of ShoreTel 
Director.

To request a register the software and request a system key:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Licenses > Requirements. The 
License Requirements page shown in Figure 2-12 on page 51 appears.

Step 3 Click the Request System License Key button. The Edit Contact page appears 
as shown in Figure 2-13. 
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Figure 2-13System Parameters Edit Contacts Page

Step 4 As a minimum, enter the information requested in the “Register and request 
system key” and Primary Contact sections. Be sure to include the sales order 
number for your purchase. Figure 2-5 describes the elements that appear on 
the Edit Contact page.

Step 5 Click the Now button at the top of the form to send in your request.

Table 2-5 Elements on the Edit Contact Page 

Element Description
Partner Name Name of the partner or reseller from whom the system 

was purchased. This field is required.
Customer Name Name of the customer. This field is required.
Address Address of the customer. This field is required.
City City where the customer is located. This field is 

required.
State/Province State or province where the customer is located. This 

field is required.
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2.10.5 Installing License Keys
To install license keys, do the following:

Step 1 View the license packet that you received from ShoreTel.

Step 2 Launch ShoreTel Director and in the ShoreTel Director menu click 
Administration > System Parameters >Licenses > Keys. The License Key Info 
dialog box appears.

Step 3 Click the New button at the top of the page. The License Key Info dialog box 
appears as shown in Figure 2-14.

Postal Code Postal code for the customer. This field is required.
Country Country where the customer is located. This field is 

required.
Main Phone # Main telephone number of the customer.
Main E-mail Main e-mail address of the customer.
Primary Contact 
Name Name of the administrator responsible for the ShoreTel 

system. This field is required.
Title Job title of the administrator responsible for the 

ShoreTel system. This field is required.
Phone Phone number of the administrator responsible for the 

ShoreTel system. This field is required.
Pager Pager number of the administrator responsible for the 

ShoreTel system. This field is required.
E-mail E-mail address of the administrator responsible for the 

ShoreTel system. This field is required.
Secondary Contact 
Name Name of the back up administrator ShoreTel can 

contact regarding the ShoreTel system.
Title Job title of the aback up administrator ShoreTel can 

contact regarding the ShoreTel system.
Phone Phone number of the back up administrator ShoreTel 

can contact regarding the ShoreTel system.
Pager Pager number of the back up administrator ShoreTel 

can contact regarding the ShoreTel system.
E-mail E-mail address of the back up administrator ShoreTel 

can contact regarding the ShoreTel system.

Table 2-5 Elements on the Edit Contact Page  (Continued)

Element Description
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Figure 2-14License Key Info Dialog Box

Step 4 In the Key field, enter the license key that you received from ShoreTel.

Step 5 In the Comment field, enter a description of the license.

Step 6 Click Save. The license activates and the information appears in the License 
Key page.

2.10.6 Keyed License Types
Keyed licenses are added by entering a license key string obtained from the reseller or 
vendor. Embedded in the license key are the type and number of licenses associated with 
that key. Once a valid key is entered, the system decodes it and details the type and number 
of licenses added. Keyed licenses are additive and more than one can be entered into 
ShoreTel Director over time.

These licenses are counted on the License Requirements page in Director, the Keyed 
Licenses section. The licenses are grouped according to the following categories:

• ShoreWare System License: This count includes licenses required on a per-system 
basis.

• ShoreWare Additional Site License: This count includes licenses required for each 
site beyond the main headquarter location. For installed base customers, when you 
upgrade and request your new system key, you will automatically receive additional 
site licenses for all configured sites.

• ShoreWare Extension License: This count includes all extensions licensed by both 
Extension Only and Extension and Mailbox licenses.

• ShoreWare Mailbox License: This count includes all mailboxes licensed by both 
Mailbox Only and Extension and Mailbox licenses.

• ShoreWare SoftPhone License: This count includes SoftPhone licenses, which are 
issued on a per-user basis. Obtain and install one licence for each SoftPhone user.
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• ShoreWare Additional Language Licenses: This count includes licenses if more 
than one language is enabled.

• ShoreWare Communicator for Mobile License: This count includes licenses 
required for each client that is enabled for Communicator for Mobile.

• ShoreWare Personal Communicator License is the default client configuration. It 
does not require a special license. This provides the following access level to all 
users:

— Desktop call control.
— Visual voice mail. 
— Call history. 
— Directory services.
— Options to control call handling and message notification. 

• ShoreWare Professional Communicator License is a keyed license provides access 
to the following:

— All functions available through Personal Communicator.
— Instant Messaging Presence
— Contact Viewer

• ShoreWare Workgroup Agent Communicator License is keyed license that 
provides access to the following:

— All functions available through Professional Communicator.
— Ability to transfer calls by dragging and dropping call cells into the buddy list.
— Workgroup access utilities, including login, log out, and wrap up.
— Workgroup Queue Monitor.

• ShoreWare Workgroup Supervisor Communicator License is a keyed license 
provides access to the following:

— All functions available through Workgroup Agent Communicator.
— Workgroup Agent Monitor.

• ShoreWare Operator Communicator License is a keyed license that provides 
access to the following:

— All functions available through Workgroup Supervisor Communicator.
— Advanced Buddy List functions, including pickup, unpark, edit buddies’ active 

call properties, and edit call notes of buddies.
— Bridge Call Appearance Monitor.

• ShoreWare SIP Phone License is a keyed license that enables the system to support 
one SIP device through a SIP proxy.

• ShoreWare Standard Resolution Video License is a keyed license that enables 
Communicator to support one point to point video session at VGA resolution 
(640x480).

• ShoreWare High Resolution Video License is a keyed license that enables 
Communicator to support one point to point video session at XGA resolution 
(1024x768).
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2.10.7 Extension and Mailbox Licenses
Systems require one extension license for each configured extension-only user. If more 
than one key is installed, the number purchased is the sum of all valid keys. Extension-only 
users have an extension but no ShoreTel mailbox. They may have external mailboxes that 
can accessed using Simplified Message Desk Interface (SMDI).

Systems require one Mailbox license for each configured Mailbox-only user. If more than 
one key is installed, the number purchased is the sum of valid keys. Mailbox-only users are 
only those users with ShoreTel mailboxes that may use SMDI.

Systems require one Combo license for each user configured for Extensions and Mailboxes. 
If more than one key is installed, the number purchased is the sum of all valid keys. 

Table 2-6 lists the features are available through Extension, Mailbox, and Combo licenses.

Table 2-6 Licensed Extension and Mailbox Feature Availability

Feature

Combo Extension Only Mailbox Only

Includes 3rd-party 
SMDI-based VM to 

ST PBX

Includes ST SMDI-
Based VM to 3rd-

party PBX

PBX features

Use SoftPhone (requires SoftPhone 
license)

Yes Yes No

Make call, take call, etc. Yes Yes No

Voicemail features

Configure call handling modes Yes Yes Yes

Forward calls to configured 
destination

Yes Yes Noa

Create and play greetings Yes No Yes

Use the Personal Assistant Yes No Yes

Notification escalation Yes No Yes

Configure Find Me Yes No Yes

System call handling schedule Yes No Yes

Create call handling notes Yes Yes Yes

Assign Extension Yes No Yes

Record name Yes No Yes

Automated attendant features

Dial by number, name Yes Yes Yesb

Transfer to / Go to extension Yes Yes YesTable b

Message by number, name Yes Yes Yes

Advanced features

Extension Assignment Yes Yes No

Member of a hunt group Yes Yes No
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2.10.8 Self-Audited Licenses
The licenses listed below are self-audited. If the usage exceeds the current licences, you will 
be notified until licensed capacities meet or exceed usage. 

• ShoreTel Personal Communicator Software: This count includes the number of 
ShoreWare Personal Communicator licenses needed.

• ShoreWare Remote Server Software: This count includes licenses that correspond 
to additional ShoreWare servers, defined in Director, that correspond to additional 
voicemail servers. Up to 20 additional ShoreWare remote servers can be configured 
beyond the initial or headquarters server.

• ShoreWare SIP Trunk: This count includes licenses necessary for the 
implementation of SIP trunks.

• TAPI Application Server: This count includes licenses for remote TAPI Application 
Servers that have the “Allow Voice Mailboxes” check box deselected. The number 
purchased should match the number of deprioritized servers that exist at a 
particular site.

Member of a workgroup Yes Yes No

Communicator features

Communicator: Standard, 
Professional, Workgroup Agent, 
Workgroup Supervisor, Operator

Yes No Mailbox Features No extension features

Extension monitor Yes Operator only features No

Agent monitor Yes No mailbox features No

Queue monitor Yes No mailbox features No

voicemail viewer Yes No Yes

Call history Yes Yes No

System directory Yes No mailbox features No extension features

Outlook features

Fwd voicemail as wav attachment Yes No Yes

voicemail form integration Yes No Yes

Outlook Contact/Quick Dialer Yes Yes No

Outlook Contact/Screen Pop Yes Yes No

Outlook Calendar integration Yes Yes Yes

a. Although call forwarding is handled by the 3rd party PBX, calls arriving at the ShoreTel voicemail system are
routed as specified by ShoreTel voicemail forwarding conditions.

b. Calls will be directed to mailbox only.

Table 2-6 Licensed Extension and Mailbox Feature Availability (Continued)

Feature

Combo Extension Only Mailbox Only

Includes 3rd-party 
SMDI-based VM to 

ST PBX

Includes ST SMDI-
Based VM to 3rd-

party PBX
58



Chapter 2: Setting Up System Parameters System Administration Guide
• ShoreWare Phone API License: This count includes licenses for the Phone API. 
(For more information, contact ShoreTel Professional Services for the appropriate 
SDK document.)

The license status page has been enhanced to easily be printed or sent via e-mail for 
purposes of license compliance verification. No license status will be transmitted without 
explicit action on the part of the administrator.

2.10.9 Sending Contact Information
After providing the required information on the System Parameters Edit Contacts page, you 
can send it to ShoreTel, Inc. in one of two ways—by email or by regular mail.

• To send the registration information by email, click Send. This generates an e-mail 
message to registration@shoretel.com. It also requires that the SMTP service on the 
server be properly configured and that the server be connected for email. You can 
resend the contact information at any time by updating the page and clicking Send. 

The MAC address for each ShoreTel voice switch is also included in the registration 
e-mail.

• To print the registration information for mailing via regular mail, click Print. Mail 
the registration information to the following address:

Global Support Services — Product Registration
ShoreTel, Inc.
960 Stewart Drive
Sunnyvale, CA 94085

2.11 Administrative Permissions
The Administrator Permissions pages allow the System Administrator to assign and 
delegate administrative roles to users at one or more sites. Expand the Administrative 
Permissions link to see all the administrative links. They include:

• Roles
• Administrators

Click the Roles link to see the Administrative Roles list page. This page shows each 
Administrative Roles that have been created and summarize their permissions.

Figure 2-15The Administrative Roles List Page
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Clicking the New button or an administrative title from the Role column invokes the Edit 
Administrative Roles page (see Figure 2-16). From here, you can define a new 
administrative role or change the permissions for an existing role. 

To delete a role, select the check box to the left of the entry and then click Delete. Note that 
if the last role with Administrative Permissions Management enabled is removed, then the 
default admin account (as created during initial installation) is re-activated and given 
complete administrative permissions.

Figure 2-16Adding or Editing Administrative Roles
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2.11.1 Parameters
Click parameters to enable permissions. Permissions are additive; that is, the more 
selections, the greater the permissions. Select as many or as few as are needed for the 
administrative role being defined. For example, a company with one system administrator 
may have all parameters turned on. As another example, an administrative assistant may 
have permission to change Distribution Lists at one site.

• Name: This is the name of the Administrative Role.

• Administrative Permissions Management: This check box assigns permission to 
create new administrative roles and to assign them to any and all levels of user. This 
is a powerful permission and should be limited to your lead administrator(s).

• Account Code Management: This check box assigns permission to add, change, 
and delete Account Codes for all sites. As an example of specialized use, very often 
a department other than Information Technology wants to manage account codes 
and needs no other permissions. This permission is granted for all sites.

• System Directory Management: This check box assigns permission to add, change, 
and delete entries in the System Directory. This permission is granted for all sites.

• Report Generation Management: This check box assigns permission to generate 
Call Detail Record (CDR) reports via Director from a local host or a remote server. 

• All Other System Management: This check box controls permission to set dialing 
plans, system-wide extensions, including route point and workgroup extensions, 
sites, IP phone options, digit translation tables, voicemail options, auto-attendant 
options and schedules, user groups, trunk groups, local prefixes, DNIS digit maps, 
BOOTP server, classes of service, call control, system parameters such as password 
length, AMIS options, call handling defaults, event filters, licenses, extension lists, 
hunt groups, paging groups, and contact information. This permission is granted 
for all sites.

• User Management: Permission to add, change, and delete users may be granted for 
all sites or for a set of selected sites. Click All Sites to grant permission system-
wide. Click Selected Sites to limit permissions, then highlight the sites to be 
permitted, and click Add to move them to the permitted list.

Users whose home ports are at the site(s) selected can be managed by an 
authorized administrator. This permission allows changes only to users who have 
no administrative role (that is, for whom none of the four administrative check 
boxes is checked). Also, changes cannot be made to a user’s administrative role. 
Only Administrative Permissions Management grants permission to change 
administrative roles.

Deny permission by clicking None.

• User Group Assignment: Permission to add users to or move users between user 
groups may be granted for all sites or for a set of selected sites. Click All User 
Groups to grant permission system-wide. Click Selected User Groups to limit 
permissions, then highlight the user groups to be permitted, and click Add to move 
them to the permitted list. Be sure to select all groups you may be moving users to 
or from. 

Permission is not extended to adding, changing, or deleting User Group options 
and Class of Service settings (an administrator would need All Other System 
Management permission). 

Note that checking the All User Groups includes all user groups currently existing 
as well as those created after permission is first granted.
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Deny permission by checking None. 

• Distribution List Membership Assignment: Permission to add or remove users on 
existing Distribution Lists may be granted for all lists or for a set of selected lists. 
Click All Distribution Lists to grant permission system-wide. Click Selected 
Distribution Lists to limit permissions, then highlight the lists to be permitted, and 
click Add to move them to the permitted list. 

Note that permission to create or delete lists is not granted here (an administrator 
would need All Other System Management permission). 

Deny permission by checking None. 

• Basic Workgroup Management: Permission to add or change options for 
workgroups may be granted for all workgroups or for a set of selected workgroups. 
Click All Workgroups to grant permission system-wide. Click Selected Workgroups 
to limit permissions, then highlight the workgroups to be permitted, and click Add 
to move them to the permitted list.

Workgroup attributes not given change permission with this option include 
workgroup Name, Extension, Backup Extension, DID, DNIS, User Group, Mailbox, 
Accept Broadcast Messages, Include in Dial By Name, and Make Number Private 
(an administrator would need All Other System Management permission). 

Note that checking the All Workgroups includes all workgroups currently existing 
as well as those created after permission is first granted.

Deny permission by checking None. 

• Site Management: Permission to add and alter sites and their related switches, 
trunks, IP phones, and servers may be granted for all sites or for a set of selected 
sites. Permission includes access to Quick Look at permitted sites. Permission 
includes adding and deleting anonymous phones at permitted sites. 

Attributes excluded from permission include Trunk Groups (an administrator 
would need All Other System Management permission).

Deny permission by checking None. Click All Sites to enable changes to all sites in 
the system. Click Selected Sites and Add sites from the list to enable access to less 
than all sites in the system.

The initial administrator set up during installation has full permissions. When upgrading 
the ShoreTel system, current System Administrators are granted full permissions. Current 
Technical Support users have no permission to change parameters but are allowed to read 
all pages. 

For some Director pages where read-only permission is given to some parameters because 
all parameters on the page may not be changed, the read-only fields will be grayed out. 

ShoreTel Director is delivered with the following default Administrative Roles:

• Accounts and Directories
• Call Center
• Everything Except 
• HQ Site
• Reporting
• System Administrator
• Technical Support
• Test Admin Role
• Test Role

The various default roles, along with their permissions, are shown below.
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Figure 2-17The Administrative Roles List Page

2.11.2 Assigning an Administrative Role to a User
From Administrative Permissions, click the Administrators link to reach the Administrator 
List page.

Figure 2-18The Administrator List Page

The Administrator List page (Figure 2-19) shows the administrative role assigned to each 
user. A user may have only one administrative role assigned. New users are created with no 
administrative role assigned to them.
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Figure 2-19Assigning an Administrative Role to a User

After defining the various Administrative Roles, you select which users will be assigned 
which roles. 

To assign an administrative role to a user, click New from the Administrators List page. The 
pop-up lets you type a User name or click Search to select from a list of users. Then assign 
a Role from the drop-down list. 

Users with no administrative role may not log in to Director. 

If desired, you can assign users to the “Reporting” administrative role, which will allow 
them to run web-based CDR reports while preventing them from doing anything else to 
modify the configurations in ShoreTel Director.

Click Delete on the Administrator List page to delete users from the list.

You may delete a user by checking the box to the left of a name and clicking the Delete 
button. Note that you cannot delete all users. At least one user must remain on the list to 
preclude the occurrence of no one being left to administer the system.
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C H A P T E R 3

ShoreTel Sites

This chapter explains how sites are implemented and configured in a ShoreTel system. The 
topics discussed include: 

• "Overview" on page 65

• "Creating a Site" on page 65

• "Parameters" on page 67

3.1 Overview
The ShoreTel site is an architectural concept designed to help you effectively and efficiently 
organize your internal telephone environment. Sites allow you to evaluate how your system 
will be used and then to deploy and setup your equipment accordingly. Sites can be created 
to accommodate geographical requirements where the external environment affects 
outbound calls or logical requirements such as a need to separate users given advanced 
functions from standard users. After a site is created, you can assign to it servers, switches, 
appliances, users, other sites and so on. Configuring sites lets you assign features to the 
associated site. For example, a site has a country, a local area code, and a site operator, as 
well as an admission control setting. 

ShoreTel, by default, is configured with one site called “Headquarters.”

3.2 Creating a Site
This section describes how to create a site. To create a site, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Site. The Sites page appears as shown in Figure 3-1.
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Figure 3-1 Sites Page

Step 3 In the “Add new site in” field, select the country where you want to create the 
site.

Step 4 Click Go. The Edit Site page appears as shown in Figure 3-2.
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Figure 3-2 Site Edit Page

3.3 Parameters
The parameters on the Sites edit page are as follows:

• Name: This is the name of a new or existing site. It must be unique.

• Country: This is the name of the country in which the site is located.

• Language: This is the default language for the site. You must obtain a license to 
enable more than one language. For more information see the "Licenses" on page 50. 

• Parent: The default parent site is Headquarters. Headquarters does not display the 
drop-down list of sites. Sites other than Headquarters must select a parent. This 
server is used for two purposes:

— By ShoreTel Director to provide a default server when new users are added

— By the call control software in the ShoreTel voice switches so that it knows 
where to route calls that request voice mail service

Only valid parent sites appear in the drop-down list. Child sites and the site 
currently being edited do not appear.
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• Use Parent As Proxy: This allows the child site to use the parent site trunk for non-
routable calls (911, 611, 011, etc.) if no trunks are available at the child site. The 
proxy site must be in the same country as the child site.

• Extension Prefix: The On-Net Dialing feature enables the division of phone numbers 
into two separately managed parts, an extension prefix (and similar in concept to a 
site code) and a user extension. This division offers greater flexibility and facilitates 
integration with legacy phone systems.

The Extension Prefix field will not appear in this window until after you have 
modified the Dialing Plan window, thus enabling the On Net Dialing feature. 

• Local Area Code: This defines the local area code of the site so that users can dial 
local numbers without an area code. In the United States, this is the area code used 
for 7-digit dialing. For example, when the user dials an access code followed by 
seven digits at the site, this is the area code they are dialing.

This also defines the area code that is considered “local” from a call permissions 
point of view.

• Additional Local Area Codes: In the United States, this defines area codes that can 
be dialed using 10-digit dialing instead of 1+10-digit dialing. For example, if the site 
is in an overlay area with multiple local area codes that require 10-digit dialing, you 
can be consistent with the dialing plan in your region by entering the additional area 
codes in this parameter.

This also defines additional area codes that are considered “local” from a call 
permissions point of view.

• Caller’s Emergency Service Identification (CESID): The Caller’s Emergency Service 
ID (CESID) is the telephone number sent to the service provider when a user dials 
an emergency services number (e.g., 911 in the U.S.). This feature is only applicable 
to T1 PRI trunks. See Appendix A for more information. 

• Time Zone: This is the site’s time zone that is associated with the ShoreTel switches. 
It is used to deliver the correct time and date to caller ID telephones.

• Night Bell Extension: This is the extension that is used to ring the site’s night bell. 
This extension must be associated with a ShoreTel switch audio output port that you 
specify as the next parameter. This extension is unique. 

You must configure the appropriate switch before assigning the night bell extension.

• Night Bell Switch: This is the ShoreTel switch associated with the night bell 
extension. The night bell extension can share the same switch port as the paging 
extension.

• Paging Extension: This is the extension used for your overhead paging system. This 
extension must be associated with a ShoreTel switch audio output port that you 
specify as the next parameter. There is only one paging extension per site.

You must assign switches to the site and select the switch that will support the 
paging extension before you can save a paging extension.

• Paging Switch: This is the ShoreTel switch associated with the paging extension. The 
paging extension can share the same switch port as the night bell extension.

• Operator Extension This is the extension to which the user is transferred when 
dialing the operator digit for the site (typically “0”). 

You must configure the appropriate user before assigning the operator extension.
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This extension must not be confused with the Personal Assistant extension defined 
in the user’s personal options. The Personal Assistant lets the user define the 
destination to which the caller is transferred when dialing “0” from the user’s voice 
mail prompt. This might be an administrative assistant or a colleague, rather than the 
operator.

• FaxRedirect Extension: When a fax tone is detected, incoming calls are 
automatically transferred to this extension. Each site may have its own fax 
redirection number. Which fax redirection number is used depends on how the call 
is answered.

— If the user answers the call, the fax redirection extension of the user’s site will 
be used.

— If the call is answered by voice mail, the Auto-Attendant or other menu, or a 
workgroup’s queue step menu, the fax redirection extension at the site where 
the call originated is used. This is the site with the trunk that handled the 
inbound external call.

The fax redirection extension must be an existing user.

Bandwidth parameters:

• Admission Control Bandwidth: This defines the bandwidth that voice streams can 
consume between the local site and all other sites. The caller hears a “network busy” 
prompt if this value is exceeded. To compute the admission control value for the site, 
see Chapter 9, “Network Requirements and Preparation” in the ShoreTel 12: 
Planning and Installation Guide.

• Intra-Site Calls (calls within a site): This drop-down list has the types of encoding 
available for making calls within a site.

• Inter-Site Calls (calls between sites): This drop-down list has the types of encoding 
used for calls between ShoreTel sites.

• Fax and Modem Calls: This drop-down list has the types of encoding used for faxing 
or for calls made from a modem.

SIP Proxy parameters: SIP Proxy parameters support the ShoreTel SIP extensions. Refer to 
Section 18.1 for more information about SIP network elements.

• Virtual IP Address: This parameter defines the IP address of the site’s SIP Proxy 
Server and Registrar server. The IP address is independent of the switch that 
performs the server functions. SIP extensions require that this parameter is set to a 
valid address.

• Proxy Switch 1: This setting designates the switch that performs the site’s SIP server 
functions. The drop down menu lists all switches assigned to the site. SIP extensions 
require a setting for this parameter.

• Proxy Switch 2: This setting designates the switch that performs the site’s SIP server 
functions when the switch specified by Proxy Switch 1 is not available. This 
parameter is optional.

• Emergency Number List: This is the list of numbers that can be dialed at the site 
with or without a trunk access code for emergency services. Note that this number 
must not conflict with any extensions.

— Trunk Access Code Required – When this checkbox is selected, a caller must 
dial the Trunk Access Code before dialing the specified emergency number. If 
not selected, entering the Trunk Access Code before the Emergency number is 
permitted, but not required, to complete the call.
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— Data Entry Field – Enter the exact emergency number required to contact the 
associated Emergency Service Provider. If Trunk Access Code Required is 
selected, you can also enter a number in canonical format.

— Add More – Click this button to create addition data entry fields for entering 
additional emergency numbers. Each site is permitted to have a maximum of 
ten emergency numbers to accommodate locations where multiple emergency 
service numbers are required.

• Edit IP Phone Address Map: This link opens the IP Phone Address Map Info edit 
page where you set the IP address range for sites other than Headquarters (see Figure 
3-3).

Figure 3-3 IP Phone Address Map Edit Page

All IP phones are assigned to Headquarters by default. If Headquarters is your only 
site, you do not need to set IP address ranges. If you have more than one site with IP 
phones, you must set an IP address range for each site (other than Headquarters). 

This page is also accessible from the IP Phone Address edit page. For more 
information, see Chapter 8.

• Site: If you are setting the IP address range for a site other than the one shown in the 
Site drop-down list, select it from the list.

• Low IP Address: This is the lowest IP address in the range of addresses.

• High IP Address: This is the highest IP address in the range of addresses.

• Caller’s Emergency Service Identification (CESID): Enter the Caller’s Emergency 
Service ID to be used for IP phones in this IP address range. Enter, for example, +1 
(408) 555-5555. This is the telephone number sent to the service provider when a 
user dials an emergency services number (e.g., 911 in the U.S.) and does not have a 
DID number or is in a user group for which the DID number is not to be used as 
CESID. This feature is only applicable to ISDN PRI trunks.
70



Chapter 3: ShoreTel Sites System Administration Guide
• Teleworkers: This call is an intersite call by the use of intersite codecs. The receiving 
site adjusts the bandwidth of the teleworker’s call (at the receiving end).
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C H A P T E R 4

Configuring Application Servers

This chapter explains how to set up servers in a ShoreTel system. The topics discussed 
include:

• "Overview" on page 73

• "Distributed Voice Mail" on page 74

• "Legacy Voice Mail Integration" on page 75

• "Configuring Application Servers" on page 78

• "ShoreTel Distributed Database" on page 84

• "Fax Servers" on page 87

4.1 Overview
The ShoreTel system supports not only distributed call control, but also distributed voice 
application servers. Distributed servers are extremely valuable for two purposes: 

• Reducing WAN bandwidth by providing local voice mail and auto-attendant services

• Increasing the scale of the system

Even though there are multiple servers, the ShoreTel system provides a single image of your 
entire network. The system is currently certified to support up to 21 servers, one main 
server and up to 20 distributed servers. Consider adding a server at a site when the site 
exceeds 100 users. Add a new server for every 1,000 users.

The distributed servers run the following voice applications:

• Voice Mail – Each server supports 254 simultaneous voice mail or auto-attendant 
connections. The voice mail system uses SMTP to transport composed messages 
between the distributed servers. The ShoreTel system also supports linking to legacy 
voice mail systems using AMIS protocols. 

• Auto-Attendant – The system supports up to 1000 menus that are hosted on every 
server, and each server provides 64 voice mail/auto-attendant connections.

• Configuration – The system enables users to log in and make configuration changes 
(call handling modes, etc.) from their ShoreTel Communicators client or from the 
Communicator for Mobile call handling mode client (if supported).

• Maintenance – The system provides a web site accessible through ShoreTel Director 
for maintenance of all the remote servers.
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The distributed voice applications use a Remote TAPI Service Provider that relies on the 
call control information from the main server. Using redundant network paths to the main 
server can improve reliability of the remote server.

4.2 Distributed Voice Mail
The ShoreTel system uses Distributed Voice Mail (DVM) to provide greater voice mail 
availability. Each ShoreTel remote server has an instance of the telephony platform 
included, allowing voice mail and auto-attendant services to maintain full functionality 
during WAN short-term outages. The enhanced DVM included with the ShoreTel remote 
server allows users with mailboxes on the remote server to receive and pickup voice mail 
messages without depending on WAN connectivity to the headquarters server. The 
message waiting indicator (MWI) lights will correctly update with or without WAN 
connectivity. 

Additionally, incoming calls can still reach the automated attendant, access the dial-by-
name directory, and reach their intended local party during a WAN outage. If a party cannot 
be reached directly due to a WAN outage and his or her call handling would send 
unanswered calls to voice mail, the call is handled by the local voice mail server. The caller 
hears a generic greeting including the intended party’s recorded name and can leave a 
message. This message will be forwarded at a later time to the home voice mail server for 
the addressee via SMTP.

Similarly, the enhanced DVM provides greater Communicator availability during WAN 
outages. If the WAN loses connectivity, users will retain full Communicator functionality as 
long as there is a DVM server at the same site as the users, the users voice mailboxes are on 
that server, and the DVM server is managing the switch that manages the users’ phones.

Although each voice mail server is autonomous in delivering voice services, it still must 
have connectivity to the configuration data stored on the headquarters server in order to 
make configuration changes. Specifically, users on an isolated remote server would not be 
able to change call handling modes or make other changes that require modification to the 
configuration data on the headquarters server.

4.2.1 IP Phone Limitations/Requirements
Connectivity is required between the phone and the switch that is controlling the phone 
(this will be referred to as “basic connectivity”). All aspects of the phone's operation are 
functional when this basic connectivity exists, with the following exceptions:

• Directory feature: In addition to basic connectivity, the directory feature also 
requires connectivity between the switch and a headquarters (HQ) server or 
distributed voice mail (DVM) server that controls that switch.

• Options features, Changes to Call Handling Mode (CHM), Wrap-Up: In addition to 
basic connectivity, these features require either connectivity between the switch and 
an HQ server or DVM server that controls that switch. In addition, if the 
aforementioned switch is a DVM server, connectivity is required between that server 
and the HQ server or Distributed Database (DDB) services must be enabled for the 
DVM. Further, connectivity between the DVM server and the HQ server is required 
for successful synchronization between the Replication Master and Slave databases.

• Switch-to-switch extension monitoring: This condition exists when a programmed 
button requires monitoring activity on an extension that is serviced by a different 
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switch than the one that controls the phone. For example, if switch A (the phone’s 
switch) is controlled by server X, and switch B (the monitored extension’s switch) is 
controlled by server Y., then servers X and Y may be a DVM or the HQ server. For 
proper functionality of the switch-to-switch extension monitoring, the following 
conditions must exist:

— Switch A must be able to talk to server X.
— Server X must be able to talk to server Y.
— Server Y must be able to talk to switch B.
— If X and Y are the same, connectivity is, of course, assumed to exist.

• Auxiliary information on incoming calls, such as trunk information and called 
workgroup (WG) information, requires connectivity between the switch and a 
headquarters (HQ) server or distributed voice mail (DVM) server that controls that 
switch.

4.2.2 Communicator Limitations/Requirements
• Communicator: Communicator utilizes two communications channels, TAPI and 

CSIS. TAPI is used to communicate with the server that manages the switch that 
manages the user's phone (regardless of whether the phone is an analog or IP 
phone). CSIS is used to communicate with the user's voice mail server. (These two 
servers are often the same device.) As long as the client can reach these two servers, 
Communicator is fully functional.

• First-time Communicator users: When a user logs into Communicator for the first 
time, CSIS and TAPI both communicate with the HQ server in order to find out 
which server they need to use. Thus, for first-time users, a connection is required 
between the client and the HQ server regardless of where their VM and extensions 
are being serviced.

• Workgroup functionality: If users are configured to have workgroup functionality, 
they can access the mailboxes of all workgroups to which they belong. This requires 
connectivity to the server(s) on which those mailboxes reside.

4.3 Legacy Voice Mail Integration

4.3.1 Integration through Simplified Message Desk Interface
ShoreTel integrates with legacy phone systems for customers who would like to have the 
freedom and flexibility to continue to use their legacy systems while migrating toward a 
newer IP telephony solution. The legacy system must continue to work flawlessly 
regardless of whether calls are traversing the ShoreTel PBX on their way to the legacy voice 
mail system, or they are traversing the legacy PBX on their way to ShoreTel voice mail.

To address these needs, ShoreTel uses the Simplified Message Desk Interface (SMDI) 
protocol. SMDI allows dissimilar voice mail and PBX systems to work together. The 
protocol evolved at a time when voice mail services and PBX services were provided by 
separate physical devices, and enabled the disparate devices to share information over an 
out-of-band serial cable connection.
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There are two modes of operation with respect to integrating a ShoreTel system and a 
legacy system using SMDI:

• External voice mail – In this configuration, the legacy system provides voice mail 
services while the ShoreTel system acts as the PBX for users.

• ShoreTel voice mail – In this configuration, the ShoreTel system provides voice mail 
services while the legacy system acts as a the PBX for users.

Voice mail extension lengths for the legacy voice mail system may be different from the 
ShoreTel voice mail extension lengths. In this case, digit translation information is 
required. For more information on digit translation tables, see the "Digit Translation 
Tables" on page 39.

For more information about integration to legacy voice mail systems using SMDI, see the 
ShoreTel 12: Planning and Installation Guide.

4.3.2 Integration through Q Signaling Protocols
ShoreTel supports integrating the ShoreTel Unified Communications solution with other 
PBX platforms (see Section 5.5 for details about configuring basic QSIG services), and, as 
of ShoreTel 11, the Q-Signaling protocol’s (QSIG) supplemental services for call diversion 
and message waiting indication. This integration allows a voicemail system located on 
either side of the QSIG link to be used by other system administrators to configure a 
ShoreTel user for voicemail that is hosted on a legacy PBX system using the same QSIG 
trunks on the same system.

QSIG is a Common Channel Signaling (CCS) protocol that runs over the ISDN D-channel 
for signaling between nodes in a Private Integrated Services Network (PISN). QSIG 
supports call setup, call tear down, and transparency of features such as message waiting, 
camp-on, and callback. 

ShoreTel 11 and later support both ECMA and ISO versions of QSIG.

4.3.2.1 Configuring ShoreTel Users for External Voicemail with QSIG
The process for configuring QSIG External Voice Mail involves the following activities:

• Configuring a QSIG Tie Trunk to integrate with the external system (refer to the 
Configuring Trunks chapter for details about configuring tie trunks.)

• Defining QSIG Server integration

• Configuring a User Group for use of external QSIG Voice Mail

• Creating an Extension-Only user in the User Group

Use the following steps to configure QSIG External Voice Mail:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Voice Mail > External Voice Mail (QSIG) menu. The 
External Voice Mail Servers (QSIG) page appears as shown in Figure 4-1.
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Figure 4-1 External Voice Mail QSIG Page

Step 3 Select a site and click on the name to display the External Voice Mail Edit page 
as shown in Figure 4-2.

Figure 4-2 External Voice Mail QSIG Edit Record

Step 4 Type the name of the integration and the Pilot number for the voice mail. The 
pilot number is typically the OSE number for voicemail login or redirection.

Figure 4-3 External Voice Mail QSIG Server Configuration

Step 5 Configure a User Group for using external QSIG voicemail by selecting 
External Voice Mail, QSIG in the drop-down scroll list for Voice Mail Interface 
Mode.
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Figure 4-4 Voice Mail Interface Mode

See the ShoreTel 12: Planning and Installation Guide for sample Use Cases for 
implementing ShoreTel users with External Voice Mail QSIG.

4.3.2.2 Configuring Legacy Users for ShoreTel Voicemail via QSIG
The following steps describe the procedures necessary to configure an external user with 
ShoreTel voicemail service with QSIG External Voicemail.

Step 1 Launch ShoreWare Director.

Step 2 Click Administration > Voice Mail > External Voice Mail (QSIG). The 
External Voice Mail Servers page is displayed.

Step 3 Configure a Mailbox-Only account for the external user. The external user is 
now configured for ShoreTel voicemail on the ShoreTel system.

See the ShoreTel Planning and Installation Guide for sample use cases for implementing 
legacy users with ShoreTel Voice Mail QSIG.

4.3.2.3 Important Considerations

• The diversion implementation on both sides is not limited to voicemail service. 
Diversion due to call-forwarding, for example, is signaled using the same methods. 

• ShoreTel features, such as “Find-Me,” can result in multiple trunks being used to host a 
call. 

• No QSIG channel usage is available for secondary calls. Refer to ShoreTel’s Norton 
Option 11C QSIG application note for more details on configuring this feature.

4.4 Configuring Application Servers

4.4.1 Adding Application Servers
The Application Servers > HQ/DVS link in the ShoreTel Director navigation frame provides 
access to the Application Servers list (Figure 4-5). The Application Servers list page is 
presented in alphabetical order.

By default, a ShoreTel system is configured with one server at the Headquarters site. 
Additional sites must have been configured before the steps in this section become 
available. For more information on adding remote sites, see Chapter 3: ShoreTel Sites, 
starting on page 65.
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Figure 4-5 Application Servers List

To add a new server:

Step 1 In the “Add new application server at site” field, select the site.

Step 2 Click Go. The Application Servers edit page appears as shown in Figure 4-6.

Figure 4-6 Application Servers Edit Page

Step 3 Enter parameters for the new server as described in the "Configuring 
Application Servers" on page 80.

Step 4 Click Save.
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To edit an existing server:

Step 1 Select a server from the list in the Name column. The Application Servers edit 
page appears as shown in Figure 4-6 on page 79.

Step 2 Change parameters as needed for the new server.

Step 3 Click Save.

4.4.2 Configuring Application Servers
Figure 4-6 displays the Application Servers Edit page. The following is a list of parameters 
configured on this page:

Base Parameters

• Name: This is the name of a new or existing server.

• Host IP Address: This is the IP address of the server. If you enter the server host 
name, Director resolves the IP address when you click Ping this Server. You can also 
use the Ping this Server button to test the connectivity between your client PC and 
the new server.

In system configurations that support Failover, this parameter specifies the Primary 
Server IP address. Refer to Section 20.3 for Failover information.

• Secondary IP Address: This is the IP address of the backup server that can assume 
controls when a system error results in a failover condition. Section 20.3describes 
ShoreTel system failover.

• Site: This is the physical location of the server. The location of the server is used to 
calculate bandwidth consumption for the purposes of admission control.

• SoftSwitch Name: This is the name of the SoftSwitch on the server you are editing. 
ShoreTel automatically creates a SoftSwitch for each server on the system.

• Maximum Trunks for Voice Mail Notification (1 - 200): This is the maximum 
number of trunks that can be used in the event of a voice mail notification. If many 
escalation profiles have been configured, it may be desirable to set this to a relatively 
low number to prevent notifications from overwhelming the system and making it 
impossible for users to make an outbound call.

• Allow Voice Mailboxes: Select this checkbox to allow voice mailboxes on this server. 
Clear this checkbox to prevent voice mailboxes to exist on this server.

When the checkbox is disabled, voice mail configuration fields are still available 
because the server may still act as a backup VM server. However, SMDI is not 
available and the drop-down menu is disabled.

If the server is being used as a VM server and mailboxes have been configured on 
that server, Director does not allow you to clear this checkbox.

By default, this checkbox is selected.

Voice Mail and Auto-Attendant

• Voice Mail Extension: This extension is used by the voice mail server.

• Voice Mail Login Extension: This extension is used to log in to the voice mail server.

• Auto-Attendant Extension: This extension is used by the auto-attendant server.
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• Assigned User Group: This is the assigned user group for the server. Because voice 
mail places outbound calls, the server must have assigned permissions.

• Default Auto-Attendant Menu: Each server can have a different default auto-
attendant menu. This is the menu reached when none is specified - for instance, 
when a caller dials “9” to escape from voice mail and return to the auto-attendant.

Database

• Specifies whether the MySQL database is to be distributed and stored locally on the 
HQ system. See the "ShoreTel Distributed Database" on page 84 for information on 
ShoreTel Distributed Database service.

4.4.2.1 External Voice Mail Parameters
Figure 4-7 shows the Application Servers Edit page when Simplified Message Desk 
Interface is set to External Voice Mail. The configurable parameters in this window are 
described in this section.

Figure 4-7 Application Servers Edit Page – SMDI set for External Voice Mail

• External Voice Mail: If this application server is to function as a PBX for a legacy 
voice mail system, check this box. 

• COM Port (1-10): This is the COM port used by SMDI.

• Message Desk Number (1-999): The Message Desk default is 1. Valid values are 1 
through 999. Set the number that the voice mail system expects. This parameter is 
most often set to one, since only one system will be using the SMDI link. In some 
configurations, however, a number of SMDI links can be daisy-chained together and 
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the Message Desk Number value is used to allow each system to know which data 
belongs to it. 

• Number of Digits (2-32): This field sets the number of digits the ShoreTel system 
sends in the SMDI extension fields. Set this number to the value the voice mail 
system expects, most commonly 7 or 10. If the number of digits and the ShoreTel 
system extension value differ, the extension number is padded. For example, if 
ShoreTel needs to send extension 456 and the Number of Digits field is equal to 7, 
extension 0000456 is sent. If no padding is desired, the Number of Digits field would 
be set to 2 in this example. Then, only 456 is sent. 

• Translation Table Use for Call Data: This check box indicates that the digit 
translation table is to be used for call data, when checked. Both Translation Table 
boxes may be checked at the same time.

• Translation Table Use for MWI Data: This check box indicates that the digit 
translation table is to be used for Message Waiting Indicator data, when checked. 
Both Translation Table boxes may be checked at the same time.

• Extension List (extension - port - logical terminal number): The SMDI message 
must contain the user extension, port number, and logical terminal number (exact 
trunk number). Note that these extensions forward to the Backup Auto-Attendant on 
No Answer or Busy.

4.4.2.2 External Voice Mail parameters
Figure 4-8 displays the Application Servers Edit page when Simplified Message Desk 
Interface is set to ShoreTel Voice Mail. The following parameters are configured on this 
page.

Figure 4-8 Application Servers Edit Page – SMDI set for ShoreTel Voice Mail

• ShoreTel Voice Mail: If this application server is to function as a voice mail server for 
a legacy PBX, check this box. 
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• Trunk Group: Select the trunk group to be used by the legacy PBX for voice mail 
traffic.

• COM Port (1-10): This is the COM port used by SMDI.

• Message Desk Number (1-999): The Message Desk default is 1. Valid values are 1 
through 999. Set the number that the voice mail system expects. This parameter is 
most often set to one, since only one system will be using the SMDI link. In some 
configurations, however, a number of SMDI links can be daisy-chained together and 
the Message Desk Number value is used to allow each system to know which data 
belongs to it. 

• Number of Digits (2-32): This field sets the number of digits the ShoreTel system 
sends in the SMDI extension fields. Set this number to the value the voice mail 
system expects, most commonly 7 or 10. If the number of digits and the ShoreTel 
system extension value differ, the extension number is padded. For example, if 
ShoreTel needs to send extension 456 and the Number of Digits field is equal to 7, 
extension 0000456 is sent. If no padding is desired, the Number of Digits field would 
be set to 2 in this example. Then, only 456 is sent. 

• Translation Table: Select a translation table from the drop-down list. For 
information on creating translation tables, see “Digit Translation Tables” on page -
39.

• Use for Call Data: This check box indicates that the digit translation table is to be 
used for call data, when checked. Both Translation Table boxes may be checked at 
the same time.

• Use for MWI Data: This check box indicates that the digit translation table is to be 
used for Message Waiting Indicator data, when checked. Both Translation Table 
boxes may be checked at the same time.

• Use Flash to Route Calls: Select this checkbox to use flash (i.e. a short hang-up to 
provide signaling instructions to a PBX) to route calls between the ShoreTel 
voicemail system and the legacy PBX. Enabling this feature may result in a more 
efficient trunk allocation.

Note that analog trunks support the use of flash for this purpose, but other types of 
trunks (e.g. T1) do not.

Clear this checkbox to prevent the system from attempting to use flash to route calls.

4.4.3 Extension List Mapping
To add extension list mapping to an application server configured for external voice mail, 
click Add found near the bottom of the Application Servers edit page. The External Voice 
Mail dialog box appears as shown in Figure 4-9.

Figure 4-9 External Voice Mail Dialog Box
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Enter the Extension to be used to access the legacy voice mail system. Also enter the 
physical Port to be assigned to the extension. And finally, include the Logical Terminal 
Number for the extension. Trunks in the trunk group that sends calls to external voice mail 
use a Logical Terminal Number. Make as many entries as are necessary.

For application servers configured for ShoreTel voice mail, select a translation table from 
the Translation Table drop-down list. For more information on creating a digit translation 
table, see "Digit Translation Tables" on page 39.

4.5 ShoreTel Distributed Database

4.5.1 Introduction
Organizations with remote locations often rely on the main or headquarters location to 
house and maintain the database for the entire company. Locating the database at the 
headquarters allows IT groups convenient access for upgrades and real-time maintenance 
activities. Organizations may also choose to distribute a read-only copy of the ShoreTel 
database on ShoreTel’s Distributed Application Servers. Applications on these distributed 
servers (DVS), typically connect to a copy of the database running on the local server. 
However all write operations must still access the headquarters database. ShoreTel 11 
introduces support for a distributed ShoreTel database that allows some actions previously 
requiring access to the HQ server. Prior to ShoreTel 11, users of ShoreTel Call Manager 
(now Communicator) could only change their call handling mode (CHM) if the HQ server 
was available. With ShoreTel 11 and later, user changes to their CHM are handled by the 
local ShoreTel server, even if the HQ server is not available. Using a distributed database 
also allows faster local queries and can reduce network traffic. Scalability is also improved 
because the headquarters server is no longer a bottleneck for database accesses.

4.5.2 Benefits of a Distributed Database
Availability – A remote server with DDB can run without disruption when HQ is down. 
Additionally, servers running a DDB can be rebooted and will operate properly, even when 
the HQ server is not available.

Scalability – Implementing a DDB on remote servers can reduce the workload on the HQ 
by handling queries locally, thus reducing the number of queries processed by the HQ 
system.

The following benefits are also realized by deploying a distributed database:

• ShoreTel Communicator users no longer need access to the HQ server in order to 
modify their CHM

• No action is normally required by the administrator after initial configuration The 
database on the HQ server acts as the replication master and remote

• servers are replication slaves.

• Updates from the remote server are automatically sent to the HQ database once it is 
available. All applications will continue working without changes while the HQ 
system is down and continue to function as the HQ database is updated.
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4.5.3 Important Considerations and Warnings
Voice Mailbox Server switches (VMBs) do not support copies of the database.

Distributed workgroups and the distributed database features can not be configured on the 
same ShoreTel system. ShoreTel Director does not allow configuration of both of these 
features on the same ShoreTel system.

When DDB is activated, changing the name of the remote application server (DVM) will 
break the replication. A manual synchronization will be required to re-establish the DDB 
replication between the HQ and DVM servers.

4.5.4 Configuration of Distributed Database Service

4.5.4.1 Configuring the Replication Master and Slave
The ShoreTel installer will configure the HQ database as the replication master by enabling 
replication in for both new installs and upgrades.

The ShoreTel installer installs a MySQL instance on every remote server by default. 
However, this MySQL instance is not a writable copy of the ShoreTel database. All 
applications on the remote server will normally point back to HQ database by default. 
Specific configuration must be performed to enable applications to use the local copy of the 
MySQL database.

4.5.4.2 Configuring Distributed Application Servers to Host the ShoreTel 
Database
The ShoreTel “Application Servers” menu page contains a new section to configure the 
location of the database server as shown in Figure 4-10. 

Figure 4-10Specifying the Distributed Database Usage
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Administrators can create a local database by selecting the appropriate check box. The 
database instance can be created on the remote server as needed.

For example, a Distributed Voice Server can use the HQ database when initially installed. 
As the demands on the HQ server increase, the administrator may decide to add a local 
database instance on the DVS and configure the applications on the DVS to use the local 
database. ShoreTel provides a drop down list that will allow the DVS to switch to other 
databases, thus allowing for local or default database operation. For DVS’s not configured 
with a local database, including VMBs, the administrator needs to select a proper database, 
usually a database server on the same site. Otherwise, the default action is to use the HQ 
database.

When the “Create Local Database” box is unchecked, the local database instance will be 
removed. If the local database is referenced by other DVS’s, the operation will fail. If the 
DVS that hosts the database is the only one that references the database, deletion of the 
local database will be allowed. The DVS will then be switched to use the HQ database.

NOTE Distributed Voice Servers are not automatically setup to use a local database, even 
if another DVS on the same site has a local database configured. To use the 
database instance other than the HQ system, manual configuration is required.

4.5.4.3 Steps for Configuration of Replication Servers
After the Remote Application Server or DVS is configured to use a local database, the 
following steps need to be completed to start the replication process.

Step 1 Backup the database on the HQ system with the replication log position and 
transfer the dump file from the HQ system to the DVS system. 

NOTE To reduce network traffic, it is recommended that the database dump file 
be compressed before transferring.

Step 2 Modify the my.ini file to enable the replication slave on the local DVS

Step 3 Restore the dump file on the DVS to create the local database instance and set 
the replication log position.

Step 4 Setup the replication master and start replication services using the SQL 
command.

Step 5 Restart the MySQL service to complete the configuration process.

NOTE These steps involve operations on both the HQ and the DVM systems and must be 
coordinated to ensure proper operation.

4.5.5 Distributed Database Status

4.5.5.1 DDB in QuickLook
ShoreTel Director Quicklook page show the database replication status in the Servers 
section. A small icon next to each server indicates whether the server has a database 
instance and uses color coding (Green or Red) to indicate the status of replication. To 
obtain details, click the server page to show more information.
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4.5.5.2 DDB on Main Server Maintenance Menu
A new database section has been added to the main server maintenance page. It shows the 
master status, which include master log file name and master log position. Administrators 
can compare this information with the slave database information on the DVS maintenance 
page to determine how out-of-sync the remote instance may be with the HQ system. If 
connection to the HQ server is long-term, the systems may be synchronized manually. The 
synchronization point used is the last snapshot performed on the master database. The 
Snapshot button is used to generate an instant snapshot of the database which is used for 
synchronization or installation purposes.

4.6 Fax Servers
ShoreTel switches support direct connection to fax servers. Users can receive faxes sent to 
their voice number. When a call is answered (either by targeted user or through call 
forwarding) it is redirected to the fax redirection extension. The fax redirection extension is 
the first port allocated to the fax server. With multiple switch ports dedicated to the fax 
server, fax calls to user voice extensions are redirected to the first port connected to the fax 
server. If the first port is in a call, the fax is forwarded to the next port.

The ShoreTel switch sends original user’s extension as DTMF immediately after call is 
answered. Fax server recognizes call is finished by loop current off. Once the fax call is 
complete, the fax server looks up user extension in its configuration. Fax server then routes 
the fax to correct end user. Depending upon the fax server’s configuration, fax may be 
delivered as an email attachment.

For more information on fax server integration, see the ShoreTel 12: Planning and 
Installation Guide.
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C H A P T E R 5

Configuring Switches

This chapter provides a general overview of the ShoreTel Voice Switches as well as 
information on how to configure them through ShoreTel Director. This chapter provides 
information on configuring ShoreTel Voice Switch:

The ShoreTel Voice Switches provide a highly reliable, highly scalable platform for the 
distributed call control software. Each ShoreTel Voice Switch connects to the IP network 
using a 10/100/1000M Ethernet port.

If more ports are required, you simply connect additional ShoreTel Voice Switches to your 
IP network. The system is inherently scalable, unlike legacy PBX systems that have 
hardware breakpoints with line cards, shelves, cabinets, and systems.

For more information about the features supported outside the U.S. and Canada, refer to 
the ShoreTel 12: Planning and Installation Guide, Appendix A, “International Planning and 
Installation.”

Topics discussed include:

• "Switch Models" on page 89

• "Switch Resources" on page 90

• "Configuration Parameters" on page 92

• "ShoreTel Director Windows for Voice Switches" on page 93

• "Failover for IP Phones: Spare Switch" on page 103

• "SoftSwitch" on page 113

• "T.38 Support on ShoreTel Switches" on page 114

5.1 Switch Models
ShoreTel Voice Switches are divided into two switch families that are based on chassis type:

• 1-rack unit (RU or just U) Half Width Switches (1 U is 1 3/4 inches)
• 1-U Full Width Switches

The sections that follow briefly introduce each switch family. Appendix C describes each 
ShoreTel Voice Switch. It includes LED behavior, interface details, capacity, and front panel 
illustrations.
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5.1.1 ShoreTel 1-U Half-Width Voice Switches
The ShoreTel 1-U Half-Width Switch family is the most recent ShoreTel Voice Switch 
design. 1-U Half Width have a smaller footprint, use less power, and have lower heat 
dissipation requirements than earlier ShoreTel Voice Switches. These switches offer higher 
granularity in the number of IP users supported, allowing customers to precisely program 
the switch to satisfy their requirements.

The switches can be stacked or mounted in a standard 19-inch rack. Rack mounting 1-U 
Half Width Switches requires the ShoreTel Dual Tray. One or two switches are inserted into 
the Dual Tray, which is then mounted into the 19-inch rack. Two switches are mounted side 
by side Rack mounting the switches require the ShoreTel Dual Tray

ShoreTel 1-U Half Width Voice Switch models include:

• ShoreTel Voice Switch 30

• ShoreTel Voice Switch 50

• ShoreTel Voice Switch 90

• ShoreTel Voice Switch 90BRI

• ShoreTel Voice Switch 220T1

• ShoreTel Voice Switch 220T1A

• ShoreTel Voice Switch T1k

• ShoreTel Voice Switch 220E1

5.1.2 ShoreTel 1-U Full Width Voice Switches
The ShoreTel 1-U Full Width Switch family includes five models that support analog, IP, 
Session Initiation Protocol (SIP), T1, and E1 voice and data streams. Full width switch 
models can be stacked or mounted in a standard 19-inch equipment rack. These switches 
have a height of 1 U and an RJ21X connector for connection to analog phones and trunks. 
They also have redundant Ethernet LAN connections to ensure availability.

The ShoreTel 1-U Full Width Voice Switch models include:

• ShoreTel Voice Switch 120 – also called ShoreTel Voice Switch 120/24

• ShoreTel Voice Switch 60 – also called ShoreTel Voice Switch 60/12

• ShoreTel Voice Switch 40 – also called ShoreTel Voice Switch 40/8

• ShoreTel Voice Switch T1

• ShoreTel Voice Switch E1

• ShoreTel Voice Switch 24A

5.2 Switch Resources
ShoreTel Voice Switches provide telephony, IP phone, and SIP phone resources to ShoreTel 
users. Each voice switch offers a combination of resources that can be customized to 
support specific, individual configurations.

Forthcoming sections describe the resources available on ShoreTel Voice Switches. The 
description for each model enumerate the features available on the switch.
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5.2.1 Analog Circuits
Voice switches offer three analog circuits: Extensions, DID trunks, and Loop Start trunks.

• Extensions: Extensions are telephony foreign exchange station (FXS) circuits that:

— Transmit and receive voice signals

— Supply power to phones

— Provide the ring signals and dial tone

— Indicate on-hook or off-hook state

Director shows extensions as analog ports. They are assigned to user extensions.

• DID Trunks: DID trunks support inbound the Loop Reversal trunks that provide 
DID service from the central office. DID trunks are assigned to trunk groups.

• Loop Start Trunks: Loop start trunks are foreign exchange office (FXO) circuits 
that support inbound and outbound calls on ShoreTel IP Phones. These trunks 
accept ring signals, go on-hook and off-hook, and transmit and receive voice 
signals. Extensions (shown in Director as analog ports) are assigned to trunk 
groups.

NOTE: Director windows show analog extensions as ports. For example, the 
heading under which extensions are displayed in Director is labeled “Port.”

5.2.2 Digital Circuits
ShoreTel offers T1, E1, and BRI digital circuits that support Channel Associated Signaling 
(CAS) and Integrated Digital Service Network (ISDN) signaling through various 1-U Half 
Width and 1-U Full Width switches. Circuit channels are configured in Director Switch 
Edit windows.

5.2.3 IP Phone Ports
ShoreTel Voice Switches support varying numbers of ShoreTel IP Phones, as specified by 
the Switch’s Edit panel. IP phone resources are allocated as follows:

• Port Allocation: Switch processing resources that support Digital and Analog ports on 
most ShoreTel Voice Switches can be reallocated to support five IP phone ports. For 
example, resources on a switch that supports 12 analog ports can be reallocated to 
support 60 IP phone ports.

• Built-in Capacity: Many switches provide processor resources that support IP phones 
without disabling telephony ports. Resources allocated to support IP phones cannot 
support SIP trunks or SIP proxies.

5.2.4 SIP Trunks
ShoreTel Voice Switches support varying numbers of SIP trunks, as specified by the Switch’s 
Edit panel. SIP trunk resources are allocated as follows:

• Port Allocation: Switch processing resources that support Digital and Analog ports 
on most ShoreTel Voice Switches can be reallocated to support five SIP trunks. For 
example, resources on a switch that supports 12 analog ports can be reallocated to 
support 60 SIP trunks.
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• Built-in Capacity: Many switches provide processor resources that support IP 
phones without disabling telephony ports. Resources allocated to support IP phones 
cannot support SIP Trunks or SIP Proxies.

5.2.5 SIP Proxies
ShoreTel switches support varying numbers of SIP trunks, as specified by the ShoreTel 
Director > Administration > Voice Switches/Service Appliances > Primary > Voice Switches 
page. SIP proxies resources are allocated as follows:

• Port Allocation. Switch processing resources that support Digital and Analog ports 
on most ShoreTel switches can be reallocated to support 100 SIP proxies. For 
example, resources on a switch that supports 12 analog ports can be reallocated to 
support 1200 SIP proxies.

• Built-in Capacity. Many switches provide processor resources that support IP phones 
without disabling telephony ports. Resources allocated to support SIP proxies cannot 
support SIP Trunks or SIP Proxies.

5.3 Configuration Parameters
Before configuring your switches in ShoreTel Director, you must determine the IP and MAC 
address assignments for each voice switch. Refer to the ShoreTel 12: Planning and 
Installation Guide for more information about getting an IP address for each voice switch. 

The items that you need before you begin configuring your switches are:

• Name of each voice switch you are configuring.

• Internet Protocol (IP) address of each switch.

• Ethernet address (MAC address) of each switch.

The Ethernet address (MAC address) is printed on the ShoreTel voice switch rear panel.

5.3.1 IP Phone, SIP, and Make Me Conference Support
If you system is using IP phones, SIP devices, or SIP trunks you must allocate ports on 
ShoreTel Voice Switches. Each allocated port supports the following:

• Five IP phones

• Five SIP trunks

• 100 SIP devices

Make Me conference is used when a SIP trunk is involved in a conference call with three or 
more participants. All the Make Me conference settings are valid in this situation. Although 
only three parties are involved in a conference call involving a SIP trunk, four Make Me 
conference ports are reserved as this is an enforced rule for all Make Me calls.

If you do not reserve sufficient ports for IP phones on the switches, some or all IP phones 
will not be recognized or supported by the ShoreTel system. For more information in 
ShoreTel system requirements, see the ShoreTel 12: Planning and Installation Guide.
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5.3.2 Backup Operator
ShoreTel Voice Switches feature a backup operator in case the site operator is unreachable 
due to a network outage. For most switches, the backup operator is on the same port as the 
Power Fail Transfer port. To use this feature, select the port to match the switch model:

• Port 5 on the ShoreTel Voice Switch 40

• Port 9 on the ShoreTel Voice Switch 60 or the ShoreTel Voice Switch 120

• Port 12 on the ShoreTel Voice Switch 30, ShoreTel Voice Switch 50, ShoreTel Voice 
Switch 90, ShoreTel Voice Switch 220T1A

5.4 ShoreTel Director Windows for Voice Switches
Once a ShoreTel Voice Switch has been installed, its parameters can be configured through 
ShoreTel Director windows. This section describes the Director windows for configuring 
and monitoring ShoreTel Voice Switches. Subsequent sections provide details about the 
switch parameters.

5.4.1 Primary Voice Switches/Service Appliance
The Primary Voice Switches/Service Appliances page lists the ShoreTel switches installed in 
the ShoreTel network. To access the page:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliance page 
shown in Figure 5-1 appears.

Figure 5-1 Primary Voice Switch/Service Appliance Page

5.4.1.1 Parameters in the Primary Voice Switch/Service Appliance Page
Each row corresponds to one switch installed in the ShoreTel network. Each column on the 
page lists a switch parameter as follows:

• Name. The name of the switch. Clicking a name takes you to the Voice Switches 
page, where you can modify the switch configuration.

• Quick Launch. Provides a link that you can use to open the Conference 
Administration page for the SA-100s installed on the system.

• Description. Describes the switch. It is an optional entry that typically tells where 
the switch is located or describes how it is used. For example, the switch’s 
description might indicate the wiring closet where the switch is located.
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• Site. The name of the site where the switch is located.

• Server. The name of server configured to manage the switch.

• Database Server. Shows the database server the device uses for backup.

• Type. The type of switch.

• IP Address. The switch’s IP address.

• MAC Address. The switch’s Ethernet MAC address.

• Serial Number. The serial number of the device.

• IP Phones In Use. The number of IP phones connected through the switch.

• IP Phones Capacity. The number of IP phones the switch can support based on the 
number of ports reserved for IP phones.

• SIP Trunks In Use. The number of SIP trunks connected through the switch.

• SIP Trunks Capacity. The number of SIP trunks the switch can support based on the 
number of ports reserved.

• Conference Capacity. The number of ports reserved for Make Me conferences.

• Hunt Groups. Shows the number of hunt groups the switch is hosting.

• Music Source. Indicates whether there is a music source for music-on-hold.

5.4.1.2 Adding a New Switch at a Site
To add a new switch at a site:

Step 1 Choose the site from the Add new site/appliance at site drop-down menu.

Step 2 Choose the type of switch from the of type drop-down menu.

Step 3 Click Go. The Voice Switches page for the specified switch is displayed.

5.4.2 Voice Switches Page
On the Voice Switches page, you can configure the identification and operating parameters 
of switches installed in the ShoreTel network. ShoreTel Director provides a specific page for 
each available ShoreTel switch to list only the relevant parameters for that switch.

The Voice Switches page typically consists of three sections:

• Area to configure identification and signaling settings. The list of parameters in this 
section depends on the type of switch being added to the ShoreTel network.

• Switch graphic (only on a Voice Switches page for existing switches) displays the 
switches front panel between the parameter section and the port table. The name of 
the switch is listed below the left side of the graphic. The port popout section 
provides port configuration information as follows:

— The color block specifies the port type assignment through the corresponding 
color blocks. Figure 5-3 provides the code for interpreting these blocks.

— Hovering the cursor on the LED graphic displays the Port Type setting and the 
Trunk Group, when appropriate, to which the port is assigned below the left 
side of the graphic.
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The switch port graphical view appears at the bottom of the edit pages. The port, IP 
phone, Conference, SIP trunks, description, jack number, and location are 
displayed. Clicking a telephone or trunk port link takes you to the Port edit page 
for the associated port.

• Port table. Configures each port or channel on the switch. 

Figure 5-2 Voice Switches Page

Figure 5-3 Port Type Assignment
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5.4.2.1 Voice Switch Parameters
The Voice Switches page parameters depend upon and can vary with the model of switch 
that is being edited. These parameters are:

• Name. The name of the voice switch.

• Description. Describes the switch. It is an optional entry that typically tells where 
the switch is located or describes how it is used. For example, the switch’s 
description might indicate the wiring closet where the switch is located.

• Site. Describes the site where the switch resides. This is a read-only parameter. If you 
want to move the switch to another site, you must move all the associated users and 
trunks, delete the switch from the current site, and add the switch to the new site.

• IP Address. The switch IP address.

If your DHCP/ BOOTP server is running, click Find Switches and use the resulting 
dialog box to select an IP address. This also adds the switch’s MAC address in the 
Ethernet Address field. If the DHCP/ BOOTP server is not running, you must enter the 
switch’s IP address and MAC address manually in the field.

• Ethernet Address. The switch’s Ethernet address is the MAC address printed on the 
switch’s back panel. 

If the DHCP/ BOOTP server is running and you clicked Find Switches to select an IP 
address, the switch’s MAC address was added at the same time in the Ethernet Address 
field. If the DHCP/ BOOTP server is not running, you must enter the switch MAC 
address manually in the field.

• Server to Manage Switch. The server that manages this switch. Select from the drop-
down list.

• Caller’s Emergency Service Identification (CESID). The telephone number sent to 
the service provider when an emergency services number is dialed from a user 
extension number. This parameter is not present on switches that do not contain 
ports that can be assigned to a user extension – SG T1, SG E1, SG T1k, and SG E1k.

Refer to “Emergency Dialing Operations” on page -595 for more information.

• Built-in Capacity. Built-in capacity allocates switch resources to support IP phones, 
SIP trunks, and SIP proxies on the ShoreTel network. Resource availability varies for 
each ShoreTel model.

— To allocate IP Phone and SIP Trunk resources, enter the desired number of 
resources in the data entry boxes. 

— To determine the allocated SIP Proxy resources, subtract the number of 
available resources from the sum of the entered numbers, then multiply the 
difference by 20.

Example. The SG 90 provides 30 resources. If 5 resources are allocated for IP Phones 
and 5 resources are allocated for SIP trunks, then 400 SIP proxy resources are available: 
(30 - (5+5))*20.

• Music On Hold Source. Enables the music-on-hold port. Check this box to enable or 
disable this feature. This parameter enables and disables music on hold for all 
trunks, including SIP trunks, and cannot be applied to a specific trunk type.

Each site requires a separate music-on-hold source. Music is not available between sites 
across the WAN to save bandwidth. Enabling or disabling MOH for a switch only 
affects the local region associated with that switch. If MOH is enabled for a remote site 
but the headquarters switch has MOH disabled, then people calling into the 
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headquarters switch will not hear music when placed on hold. Callers who dial into the 
remote site will, or course, hear music when placed on hold.

A music source, such as a CD player, must be connected to the Music On Hold jack on 
the front panel of the switch.

• Use Analog Extension Ports as DID Trunks. 1-U Half Width analog extension ports 
cannot be individually configured as DID trunks. Selecting this parameter configures 
all analog extensions as analog DID trunks. When this parameter is selected, analog 
ports on the switch cannot be assigned to a user extension port.

This parameter is not available on 1-U Full Width switches. Analog extensions these 
switches may be individually configured as Analog DID trunks from the Director Edit 
Trunk page. 

T1 Signalling Parameters. Configures T1 circuit Layer 3 and Layer 1 parameters. These 
parameters are displayed for the SG T1, SG 220 T1, and SG 220T1A switches.

Figure 5-4 T1 Signalling Parameters

• Layer 3. Configures the network layer settings.

— Protocol Type: Determines the type of signaling the ShoreTel-T1 will facilitate:

❋ CAS uses in-band signaling where a portion of the bearer channel is used 
for A/B bit signaling, emulating on-hook and off-hook conditions.

❋ ISDN User and ISDN Network is used in conjunction with ISDN signaling 
configurations. It provides a single D-channel for controlling 23 bearer 
channels. You can designate the T1 trunk as being User or Network side.
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❋ QSIG Protocol handles the signaling between digital PBXs for ISDN, 
handling the basic signaling functions of call setup, handshaking, and call 
teardown, and thus allowing PBXs from different third-party vendors to 
communicate and interoperate.

❋ QSIG Master or QSIG Slave, depending on which type of signaling the 
ShoreTel-T1 will facilitate.

Whereas PRI employs the concept of a “user” and a “network” to determine 
which network entity is controlling the D-link channel, QSIG uses a similar 
“master” and “slave” concept to determine the relationship between network 
elements.

• Central Office Type: Provides support for the Central Offices (COs). The default is 
4ESS.

— 4ESS

— 5ESS

— DMS-100

— National ISDN-2 (NI-2)

• Call by Call Service. Call by Call Service is a 4ESS feature that allows a user to 
access different services, such as an 800 line or WATS line, on a per call basis. This 
parameter is available only when Central Office Type is set to 4ESS.

Parameter options (SDN or MEGACOM) are AT&T outbound service types.

• Enable Outbound Calling Name. Sends the caller name with the caller ID for 
outbound calls. The default is disabled.

• Layer 1. Configure the physical layer settings.

— Clock Source. The ShoreTel-T1 switch’s clock source. Depending on the type of 
T1 service provided by your telephone company’s CO, select either Slave or 
Master from the drop-down list. Typically the ShoreTel-T1 is slave to the 
central office. The system default is Slave.

— Framing Format. The ShoreTel-T1 switch’s framing format. Depending on the 
type of T1 service provided by your telephone company’s CO, select either ESF 
or D4 from the drop-down menu. The system default is ESF.

— Line Code. The ShoreTel-T1 switch’s line code. Depending on the type of T1 
service provided by your telephone company’s CO, select either B8ZS or AMI. 
The system default is B8ZS from the drop-down menu.

— Line Build Out. Provides a list of T1 trunk line distances, specified in decibels 
(dB) and in feet. Select the appropriate line code from the drop-down list.

E1 Signalling Parameters. configure E1 circuit Layer 3 and Layer 1 parameters. These 
parameters are displayed for the SG E1 and SG 220E1 switches.

• Layer 3. Configures the network layer settings.

— Protocol Type. Specifies the signalling protocol. 

❋ ISDN User and ISDN Network are ISDN signalling protocols.

❋ QSIG is an ISDN based signalling protocol used for signalling between 
PBXs in a private network.
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— Central Office Type. The ShoreTel-E1 supports a single signaling type per 
country, which is typically Euro-ISDN(TBR4). This parameter is active only if 
Protocol Type is set to ISDN User or ISDN Network.

— Enable Outbound Calling Name. When this parameter is selected, the caller 
name is sent with the caller ID for outbound calls. The parameter is disabled by 
default.

Figure 5-5 E1 Signalling Parameters

• Layer 1. Configures the physical layer settings.

— Clock Source. Specifies the clock source. This parameter is typically set for 
compatibility with the service provided by the telephone company’s CO. The 
default setting is Slave.

— Framing Format. The ShoreTel-E1 supports CRC-4.

BRI Signalling Parameters. Configures BRI circuit Layer 1, Layer 2, and Layer 3 
parameters. These parameters are displayed for the four BRI spans; the ShoreTel 30 BRI 
supports one BRI span.

• Enable Span as BRI. Activates the corresponding Digital Channels as a BRI span. 
When this parameter is not selected, the Channel resources are available for 
reallocation to support IP phones, SIP trunks, or SIP proxies.
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• Layer 3 

— Protocol Type. Specifies the signalling protocol. 

❋ ISDN User and ISDN Network are ISDN signalling protocols.

❋ QSIG is an ISDN based signalling protocol used for signalling between 
PBXs in a private network.

— Central Office Type. The ShoreTel-E1 supports a single signaling type per 
country, which is typically Euro-ISDN(TBR4). This parameter is active only if 
Protocol Type is set to ISDN User or ISDN Network.

Figure 5-6 BRI Signalling Parameters

• Layer 2

— Signaling. Select either Point-to-Point or Point-to-Multipoint.

• Layer 1

— Clock Source. Specifies the clock source. This parameter is typically set for 
compatibility with the service provided by the telephone company’s CO. The 
default setting is Slave.

— Clock Priority. Configures the clock recovery priority for the BRI voice 
channels. 

❋ When the Clock Source for the ShoreTel 90BRI is set to Master, the Clock 
Priority is set to Never. 

❋ When the Clock Source is set to Slave, this parameter configure the priority 
level: High, Medium, Low, or Lower. This parameter has no significance 
for the SG 30BRI, regardless of the Clock Source setting.
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• Analog Port Table. For switches that provide analog circuit resources. Figure 5-7 
displays an analog port table for an SG 90 switch.

Figure 5-7 Analog Port Table 

— Port Type. Configures the port resources.

❋ Available configures the port resources to support either an extension port 
or DID trunk. Port capabilities depend on the ShoreTel switch model.

❋ Conference configures the port resources for Make Me conferencing.

Reserve as many ports as you need to support the maximum number of 
conferences you will permit to occur simultaneously. For example, if you will 
allow two three-way calls at the same time, reserve 6 ports. The minimum 
number of ports that can be reserved for Make Me conferencing is four.

❋ Trunk configures the port as an analog trunk assigned to the Trunk Group 
specified by the Trunk Group parameter.

❋ 5 IP Phones configures the resource to support 5 IP phones. 

❋ 5 SIP Trunks configures the resource to support 5 SIP trunks. 

❋ 100 SIP Proxy configures the resource to support 100 SIP proxies.

— Trunk Group. Specifies the Trunk Group to which the port is assigned. This 
parameter is available only when Port Type is set to Trunk.

Port tables do not include the Trunk Group column for switches that do provide 
Loop Start Trunks.
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— Description. Optional field that lists a descriptive name for the switch port.

— Jack Number. Optional comment field for entering the patch-panel jack 
number to which the port is connected.

— Location. Optional comment field for entering location information about the 
port.

• Digital Channel Table. For switches that provide digital analog circuit resources. 

Figure 5-8 Digital Channel Table 

— Port Type. Configures the port resources.

❋ Available indicates that the channel resources is available for assignment.

❋ Trunk configures the port as an digital trunk assigned to the Trunk Group 
specified by the Trunk Group parameter.

❋ 5 IP Phones configures the resource to support 5 IP phones. 
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❋ 5 SIP Trunks configures the resource to support 5 SIP trunks. 

❋ 100 SIP Proxy configures the resource to support 100 SIP proxies.

❋ Unavailable indicates that digital channel is not available, such as in the 
case of a fractional T1 circuit.

— Trunk Group. Specifies the Trunk Group to which the port is assigned. This 
parameter is available only when Port Type is set to Trunk.

— Description. Optional comment field that lists a descriptive name for the 
switch port.

— Jack Number. Optional comment field for entering the patch-panel jack 
number to which the port is connected.

— Tx Gain (db). Specifies the gain added to received digital signals. The default is 
0db.

— Rx Gain (db). Specifies the gain added to transmitted digital signals. The 
default is 0db.

— Fill Down. Duplicates first row data entry field contents in all other rows. The 
channel number, in parenthesis, is appended to the contents of the Description 
field.

5.5 Failover for IP Phones: Spare Switch 
To ensure high availability of IP phones, ShoreTel provides a mechanism whereby IP 
phones maintain regular contact with most ShoreGear switches and contact the ShoreTel 
HQ server for immediate reassignment when the switch they are assigned to does not 
respond. When the system is properly setup and the IP phone failover function is enabled, 
IP phones send a pulse to the switch to which they are assigned every 60 seconds. If the 
switch fails to reply after four consecutive attempts, the IP phone sends a request to the HQ 
server for reassignment. If the HQ server determines that the switch is not available and 
other switches at the site can support additional phones, then the IP phones assigned to the 
down switch are redistributed among the remaining site switches on a first-come-first-serve 
basis. If resources are still insufficient and a spare switch is available for the site, the HQ 
server activates the spare server as a site resource and reassign to it the remaining IP 
phones. The HQ server records these failover transaction in such a way as to facilitate 
restoration. If HQ determines that resources are not available, then the phones are not 
reassigned to a switch and the user is unable to use it.

Failover for ShoreTel IP phones is invisible to the end user. A keep alive function means 
that failover can occur without users touching their phones and during active phone calls. 
If the user does try to use the phone before failover takes place, the phone automatically 
queries the HQ server for reassignment when the assigned switch does not respond. When 
implemented, the failover transaction occurs within seconds. However, if resources are not 
available, failover cannot occur and the user is unable to use the phone.

ShoreTel IP phone failover occurs on a first-come-first-server basis. If a switch goes down, 
the phones assigned to it are reassigned in the order that they contact the HQ server until 
all of the available resources are used. Provided the resources are available, the whole 
failover process from initial detection through failover transaction takes about four 
minutes.

The ShoreTel system provides for two levels of switch failover to assure high availability of 
IP phones. The first level involves setting aside capacity on site switches to handle failover 
situations. This method is referred to as N+1. In N+1 applications, you deploy more 
switches (hence ports) than your absolute need. The ShoreTel system automatically 
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implements load balancing when it assigns IP phones to switches so that the load is always 
evenly distributed. An example of an N+1 application is the following: 

You have 99 users at a site. You deploy three ShoreGear 50 switches. The ShoreTel 
system assigns 33 IP phones to each switch leaving 17 ports in reserve on each switch. 
If one of the switches goes down, then the HQ server will reassign the 33 IP phones of 
the down switch to the two functioning switches without a hitch in the user 
experience.

The second level of failover involves installing a spare switch on the site for the purpose of 
providing failover protection. The switch is configure as a spare and the ShoreTel system 
does not assign IP phones to it under normal operating conditions. However, if a switch 
goes down and the HQ cannot reassign all of the IP phones to the remaining switches at the 
site, then the HQ server will activate the spare switch at the affected site and reassign to it 
remaining IP phones from the failed switch. However, the reassignment is intended to be 
temporary. The spare switch provides basic telephony functionality. You cannot configure 
the spare to provide such functions as hunt groups, trunk access, backup auto-attendant, 
analog extensions, trunks, media proxy, make-me conference ports etc. (Extension 
assignment are supported.)

Spare switch failover support is hierarchical. Spare switches provide failover support for IP 
phones installed on the same site only. Moreover, spare switches provide failover support 
for IP phones at or below the level where the switch is installed. This means that a switch 
installed on a child site cannot be used to provide failover for IP phones installed on the 
parent site or any site connecting through the parent site. It can be used to provide failover 
for child sites below it in the hierarchy. Indeed, when necessary, the system searches the 
entire, relevant hierarchy until it finds an available spare switch it can use for failover. You 
can also install spare switches on the HQ sites to provide universally accessible failover for 
all sites on the system. 

This section describes how to set up and use spare switches in your system.

5.5.1 ShoreGear Switches that You Can Deploy as Spares
ShoreTel Voice Switches that can be configured as spares include:

• ShoreTel Voice Switch 120/24

• ShoreTel Voice Switch 40/8

• ShoreTel Voice Switch 60/12

• ShoreTel Voice Switch 50

• ShoreTel Voice Switch 90

• ShoreTel Voice Switch 220T1

• ShoreTel Voice Switch 220E1

• ShoreTel Voice Switch 90BRI

• ShoreTel Voice Switch 220T1A

• ShoreTel Voice Switch 30

• ShoreTel Voice Switch 30BRI

NOTE ShoreTel Voicemail switches cannot be used as spare switches.
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NOTE Spare switches cannot change languages when they are activated. Language 
incompatibilities are denoted with an Firmware upgrade available message when 
configured into a site with a different language.

5.5.2 Physical Installation
The physical installation of a spare switch is the same as the installation of a primary 
switch. Refer to the documentation of the ShoreGear switch you want to deploy and the 
ShoreTel 12: Planning and Installation Guide for instructions about installing the switch on 
your network.

5.5.3 Adding a Spare Switch to the System
This section describes how to add a spare switch to the system.

Requirements

• IP address to assigned to switch.

• Ethernet address of switch (see label on the back of the switch).

• Name of the server that you want to use to manage the switch.

To configure a ShoreGear Switch as a Spare, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform > Voice Switches/Service Appliances > 
Spare. The Spare Voice Switches page appears as shown in Figure 5-9.

Figure 5-9 Spare Voice Switches Page

Step 3 In the “Add new spare switch at site” field, select the site where you want to 
add the spare switch.

Step 4 In the “of type” field, select the switch model that you want to add as a spare.

Step 5 The Edit Switch page appears as shown in Figure 5-10.
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Figure 5-10Edit Switch Page

Step 6 In the Name field, enter the name that you want to use to identify this switch in 
the system.

Step 7 In the Description field, enter a description for this switch.

Step 8 In the IP Address field, enter the IP address assigned to the switch. If the switch 
is located on the same network segment as the HQ server, you can use the Find 
Switch function to locate the IP address.

Step 9 In the Ethernet Address field, enter the Ethernet address for the switch.

Step 10In the Server to Manage Switch field, select the server that you want to manage 
the switch.

NOTE We recommend that you do not select a server that has Music On Hold 
enabled to manage the spare switch. Doing so could mean sending MOH 
across the WAN which ShoreTel does not support.

NOTE We recommend that you do not select a server with CESID configured. 
The spare switch can be temporarily deployed in a remote location.

Step 11Click Save.

NOTE Home Site is the location where the switch is configured. Current Site is 
the site where the switch is currently being used to provide failover. If the 
switch is not currently being used, this field is empty.

5.5.4 Enabling IP Phone Failover
You must configure the system to allow IP phones to failover. To set the parameter to allow 
IP phone to failover, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Options. The IP Phone Options page 
appears as shown in Figure 5-11.
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Figure 5-11IP Phone Options Page

Step 3 Check the Enable IP Phone Failover check box.

Step 4 Click Save.

5.5.5 Disabling IP Phone Failover Temporarily
There are times you when you will want to temporarily disable IP phone failover such 
system wide maintenance where switches are brought down. To disable IP phone failover 
temporarily, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Quick Look. The Quick Look page appears as shown in 
Figure 5-16.

Figure 5-12Quick Look page
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Step 3 Check the Temporary Disable IP Phone Failover Across Sites check box. 
When this option is selected, spare switches do not failover throughout the 
entire system.

NOTE Be sure to reverse this process to enable IP phone failover when your 
operation is complete.

5.5.5.1 Maintenance – Switches Summary
The Maintenance – Switches Summary page displays a section listing the Spare Switches 
located on the specified site. This section indicates the activity level of the switch and, 
when active, the site upon which the switch is deployed.

Manual failbacks are performed from this page by accessing the drop down menu for the 
desired switch and selecting Fail Back.

Figure 5-13Switches Summary Page

5.5.6 Restoration
The spare switch is designed as a temporary measure to ensure that IP phone users have 
basic phone connectivity if their primary switch fails. To ensure that users have their full 
connectivity, you must repair or replace the failed primary switch as soon as possible. This 
section describes how to restore normal operation after a failover occurs. This section 
describes the following:

• How to re-assign the original primary switch profile to a new switch.

• How to move IP phones from the spare switch to the restored primary switch.

• How to failback the spare switch to the spare state.
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5.5.6.1 Re-assigning the Primary Switch Profile to a Replacement Switch
If you must physically replace a primary switch that fails, you can re-assign the original 
switch profile to the new physical switch rather than create a new profile. This section 
describes how to re-assign the switch profile. 

Requirements:

• Obtain a replacement switch that has the same capabilities as the failed switch.

• Physically install the replacement switch on the same network as the old switch.

• Assign the new switch an IP address. Refer to the x for more information about.

• Unplug the port connections (telephones, trunks) from the existing voice switch and 
plug them into the new voice switch.

To re-assign the switch profile, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears.

Step 3 Select the voice switch that is being replaced. The Edit Switch page for the 
switch appears.

Step 4 In the IP Address field, enter the IP address (or Ethernet address) of the new 
switch that you want to use to replace the downed switch. 

NOTE You can also use the Find Switch button.

Step 5 Select the new voice switch and click Save. It can take up to two minutes for 
the switch to come on line.

NOTE You can use Quick Look to confirm that the new voice switch is on line. 

5.5.6.2 Moving IP Phones to Primary Switch
To move IP phones from the spare switch to the primary switch, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Individual IP Phones. The IP Phones page 
appears as shown in Figure 5-14.
ShoreTel 12.2 109



System Administration Guide Chapter 5: Configuring Switches
Figure 5-14IP Phone Page

Step 3 In the By Sites field, select the site where the failover has occurred and you 
want to perform restoration.

Step 4 In the Use the Switches field, select All Switches.

Step 5 In the Show Pages field, select the page that contains the IP phones that you 
want to move. The first name and the last name of the phones listed on the 
page are shown in the field along with the page number.

Step 6 Use the Site column to identify phones that have failed over to the spare switch 
that you want to move to the primary switch and check the check box to the 
left of the phone names (the MAC or IP address are often used as name).

NOTE You can select multiple phones to move at one time. The phones do not 
have to be registered to the same switch.

Step 7 In the field to the left of the Move button, select the switch to which you want 
to move the IP phones. 

Step 8 Click Move. The phones are moved to the target primary switch.

NOTE Calls that are currently in progress are dropped during the move.

5.5.6.3 Failing Back the Spare Switch
After you move the IP phones to the primary switch on the site, you must manually 
failback the spare switch. To failback the spare switch, do the following:
110



Chapter 5: Configuring Switches System Administration Guide
Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Quick Look. The Quick Look page appears.

Step 3 Select the site where the failover occurred and to which the spare switch is 
currently assigned. The Voice Switches and Service Appliances Summary page 
appears similar to Maintenance Summary page shown in Figure 5-15.

Figure 5-15Maintenance Summary Page

Step 4 In the Spare Switches section, identify the spare switch to fail back, and in the 
Command column field, select Failback. The failback process starts.

NOTE Make sure that there are zero (0) IP phones connected to the switch. (The 
listing in the IP Phones column should be 0/N, where 0 is the number of 
phone currently registered with the switch and N is the switch capacity.)

The process takes a few minutes to complete and includes rebooting the spare switch. 
When the process is complete and successful, the spare switch returns to the spare state. To 
verify that the switch has returned to the spare state, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform > Voice Switches/Service Appliances > 
Spare. The Spare Voice Switches page appears.

Step 3 Verify the following columns:

• The Current Site column is empty.

• The IP Phones in Use column lists zero (0).
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5.5.7 Disabling IP Phone Failover Temporarily
There are times you when you will want to temporarily disable IP phone failover such 
system wide maintenance where switches are brought down. To disable IP phone failover 
temporarily, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Quick Look. The Quick Look page appears as shown in 
Figure 5-16.

Figure 5-16Quick Look page

Step 3 Check the Temporary Disable IP Phone Failover Across Sites check box. 
When this option is selected, spare switches do not failover throughout the 
entire system.

NOTE Be sure to reverse this process to enable IP phone failover when your 
operation is complete.

5.5.7.1 Maintenance – Switches Summary
The Maintenance – Switches Summary page displays a section listing the Spare Switches 
located on the specified site. This section indicates the activity level of the switch and, 
when active, the site upon which the switch is deployed.

Manual failbacks are performed from this page by accessing the drop down menu for the 
desired switch and selecting Fail Back.
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Figure 5-17Switches Summary Page

5.6 SoftSwitch
SoftSwitch is used to host virtual users who are not assigned a physical telephone port on 
any ShoreTel voice switch. The SoftSwitch is used to host all voice mail, auto-attendant, 
and workgroup extensions as well as route points. A SoftSwitch is automatically created for 
every server added to the ShoreTel system. The server will be listed as a SoftSwitch on the 
Switches list page.

To configure SoftSwitch, do the following:

Step 1 Launch ShoreTel Director. 

Step 2 Click Administration > Voice Switches/Service Appliances > Primary. The 
Primary Voice Switches/Service Appliances page appears. 

Step 3 In the Name column, select the SoftSwitch that you want to configure. You can 
use the Type column to identify softswitches. Softswitches are labeled SW in 
the Type column. The Edit SoftSwitch page appears as shown in Figure 5-18.
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Figure 5-18Voice Switches Page for SoftSwitch

The parameters that appear on this page are:

• Name. The name of the SoftSwitch. The default name is SoftSwitch, but you can 
change the name to suit your system.

• Description. A descriptive name of the SoftSwitch.

• Site. The location of the SoftSwitch. This is a read-only parameter, and cannot be 
changed. The SoftSwitch is always located at the main site. 

The name of the main site is defaulted to “Headquarters,” but can be changed via the 
Edit Site page.

• IP Address. This read-only field is the IP address of the switch supporting the 
SoftSwitch. Change the IP address from the Server page.

5.7 T.38 Support on ShoreTel Switches
Online FAXing has become a very popular trend for many enterprise organizations. The 
ability to quickly fax important documents or papers is vital to maintaining the type of 
business communications expected by most companies. Some ShoreTel switches support 
T.38 to provide improved reliability for fax calls. T.38 support is implemented as a fax 
codec on ShoreTel switches and performs as a gateway. 

T.38 support is implemented on both ShoreSIP and SIP. Translation between SIP and 
ShoreSIP is implemented so that ShoreTel based switches can talk with SIP based T.38 
switches. Figure 5-19 shows how T.38 works.
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Figure 5-19T.38 Over IP Network Connecting to Fax Machines

5.7.1 Usage
T.38 fax feature is enabled by default on each ShoreTel switch. Only the UDPTL format is 
supported, with fixed redundancy configurable for all calls. If a secondary fallback 
extension is necessary, it will be configured as well. 

T.38 is implemented through a gateway on the ShoreTel switches. T.38 UDPTL packets 
parameters are negotiated in the SDP following the offer/answer exchange model via 
ShoreSIP/SIP between ShoreTel switches, SIP trunk or a SIP based third party devices, such 
as IP fax extension.

In order to connect a T.38 fax server into the ShoreTel system, one of the two requirement 
must be met: 
1. The T.38 fax server can fall back to G.711 clear channel. 

2. If the fax server is T.38 only, all the switches within the system have to be upgraded to 
one of the supported voice switches, otherwise, fax call from those switches will never 
be successful. Please refer to the list of supported voice switches listed under the 
ShoreTel Switches section in the System Specification chapter.

NOTE In order for fax machines to work properly, the administrator should make sure 
that only fax machines are connected to extensions with one of the following 
labels:

• Fax machine 

• Fax server

• Non-T.38 fax server

• Non-T.38 data terminal 

Extensions that are labeled as a fax machine can also be used as a site specific fax 
redirection machine. It is also necessary to make sure that extensions designated as fax 
extensions are not fowarded to other phones or trunks using the Anyphone feature. Under 
these circumstances, fax operation is impacted.
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5.7.2 Important Considerations
T.38 support is subject to the following considerations:

• The following ShoreTel Voice Switches do not support T.38. For these and older 
switches, G711/L16 clear channel is used for fax purposes. 

— ShoreTel - 8

— ShoreTel -12

— ShoreTel 120

— ShoreTel -T1

— ShoreTel -E1

— ShoreTel -TW

— ShoreTel -24 and ShoreTel 24a

• Fax machine/Fax server behind ShoreTel PBX should disable V34 feature to avoid 
Fax using G711/Linear clear channel.

• V.34 Faxes are not supported.

• ShoreTel only supports T.38 in udptl form. T.38 calls in RTP or TCP form are not 
supported.

• ShoreTel does not support either IP media or RFC2833 based fax tone detection (in 
RFC2833, ShoreTel only supports DTMF, no named telephony events), therefore 
ShoreTel can not detect Fax tone coming from an SIP end-point with the exception 
of a SIP connection that is established with a physical port on the ShoreTel switch. In 
this case, the ShoreTel switch can detect a fax tone from the SIP endpoint and either 
switch to fax mode or redirect the call.

• ShoreTel depends on fax CNG tone detection or T.38 invite to redirect an incoming 
fax call. If the fax connection is established with one SIP based endpoint (such as SIP 
extension or SIP trunk), ShoreTel depends on SIP invite to either establish a fax 
connection or redirect the call to a pre-configured fax device. 

• T.38 support is not supported on SIP-BRI.

5.7.3 Enabling T.38 On a ShoreTel Switch
To enable T.38 support on a ShoreTel switch:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Call Control > Codec Lists. The Codec Lists page 
appears as shown ing Figure 5-20.
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Figure 5-20Codec Lists Page

Step 3 In the Description column, select the fax codec profile for which you want to 
enable T.38 support or click New to create a new codec profile. The Edit Codec 
Lists page appears as shown in Figure 5-21.

Figure 5-21Edit Codecs List Page

Step 4 Make sure that T.38 is listed in the Codec List Members field and that it is 
positioned in the order of preference that you want the switch to use it for fax 
calls. 

Step 5 Click Save.

Step 6 Click Administration > Sites. The Sites page appears.
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Step 7 Select the site on which you want to enable the T.38 codec. The Edit Site page 
appears as shown in Figure 5-22

Figure 5-22Edit Site Page

Step 8 In the Fax and Modems Calls field, select a Fax profile in which the T.38 codec 
is enabled.

Step 9 Click Save. 
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5.7.4 Third-Party T.38 Configuration Support
ShoreTel T.38 implementation also supports GFI Software/Brooktrout SR140. For the 
configuration procedure, see the following ShoreTel application note:

• ST-10238: How to configure GFI Software/Brooktrout SR140 with the ShoreTel 
System

Contact ShoreTel Technology Partners Program at http://www.shoretel.com/partners/
technology/certified_partners.html for more information on configuring additional 
ShoreTel supported third-party solutions.
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C H A P T E R 6

Voicemail Model Switches

This chapter discusses ShoreTel voicemail model switches. The topics include:

• "Introduction" on page 121

• "Functional Description" on page 122

• "Utilities" on page 125

• "V Model Switch Implementation" on page 130

• "Booting and Restarting" on page 139

• "Monitoring a Voicemail Model Switch" on page 141

• "Creating a System Extension for SA-100 Conferences" on page 144

• "Configuring the SA-100 for Conferencing and IM" on page 145

6.1 Introduction
Voicemail Model Switches are ShoreTel switches that provide voicemail services and access 
to auto attendant menus for extensions hosted by the switch. Voicemail Model (V Model) 
switches provide local access to voicemail while being controlled by a Distributed server at 
a different location.

Voicemail Model switches store voicemail in Compact Flash (CF) cards. Auto Attendant 
menus, greetings, and prompts, are stored in permanent flash memory. Voicemail backup 
and restore routines are available through Director for protecting voice mail on a regular 
basis. If a switch is disabled, information on the Compact Flash is retained and can be 
moved to another switch of the same model.

V Model switches are deployed in the same manner as other ShoreTel 1-U Half Width 
switches and managed similarly to other switches and servers. Director windows configure 
switch, voicemail, and server settings. Device status is also monitored through Director 
maintenance windows.

The following ShoreTel switches operate as both a ShoreTel Voice Switch and as a voice 
mail server:

• ShoreTel Voice Switch 90V

• ShoreTel Voice Switch 90BRIV

• ShoreTel Voice Switch 50V

A ShoreTel site is an organizational concept to which voice switches and users are assigned. 
ShoreTel Director supports configuration parameters for each site, including time zone, 
area codes, emergency numbers, voice mail, and local system extensions. Users assigned to 
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a site are associated with the parameter settings for that site. Ports and phones on a switch 
at a site are available for assignment as the home port of a user assigned to that site.

ShoreTel provides automated attendant and voice mail services through application servers. 
Although each application server is assigned to a ShoreTel site, an application server can 
provide services to any ShoreTel user within the ShoreTel network regardless of the site 
assignments of the user and the server. Therefore, ShoreTel does not require the installation 
of application servers at each site to provide Auto-Attendant and voice mail services to all 
system users.

Although users can access voice mail and automated attendants through servers at remote 
locations, service availability can be subject to time delays and outages inherent in 
extended networks. Conversely, installing application servers at every site is an inefficient 
solution for ShoreTel implementations that have several sites configured with a small 
number of users.

6.2 Functional Description

6.2.1 Physical Description
Voicemail Model switches are similar to other 1-U Half Width Switches, with the addition 
of permanent flash and Compact Flash memory for providing local access to voicemail, 
automated scripts, and other services normally provided by Distributed Servers.

6.2.1.1 Capacity
The following are V Model switch capacities:

System

• Maximum Voicemail Enabled Switches in System: 50

• Number of Simultaneous Calls to Voicemail boxes on a V Model switch: 9

ShoreTel 90V

• Analog Telephony: 12 ports

— 8 ports support trunks, 

— 4 ports configurable as extensions or DID trunks

• IP and SIP resources

— 90 IP phones, 90 SIP trunks, or 1800 SIP proxies maximum – requires 
reallocation of telephony resources.

— 30 IP phones, 30 SIP trunks, or 600 SIP proxies independent of telephony 
support

• 90 voice mailboxes

ShoreTel 90BRIV

• Analog Telephony: 4 extension ports

• Digital Telephony: 4 BRI ports – 8 channels

— Each port supports one BRI span that comprises two channels
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• IP and SIP resources

— 90 IP phones, 90 SIP trunks, or 1800 SIP proxies maximum – requires 
reallocation of telephony resources.

— 30 IP phones, 30 SIP trunks, or 600 SIP proxies independent of telephony 
support

• 90 voice mailboxes

ShoreTel 50V

• Analog Telephony: 6 ports

— 4 ports support trunks, 

— 2 ports configurable as extensions or DID trunks

• IP and SIP resources

— 50 IP phones, 50 SIP trunks, or 1000 SIP proxies maximum – requires 
reallocation of telephony resources.

— 20 IP phones, 20 SIP trunks, or 400 SIP proxies independent of telephony 
support

• 50 voice mailboxes

6.2.1.2 Differences from other Switches
V Model Switches differ from other 1-U Half Width Switches as follows:

• V Model switches have a slot on the left side of the chassis for accessing the CF card.

• V Model switches provide Voicemail and auto attendant services normally provided 
by the Main Server or a Distributed Server.

• V Model switch and server functions run on Linux.

The OS on other ShoreTel switches is VxWorks. Other ShoreTel Servers run under 
Microsoft Windows.

• V Model switches do not support Simplified Message Desk Interface (SMDI).

6.2.2 Voice Switch Functions
V Model switches provide the same voice switch services as other 1-U Half Width Switches.

V Model switches store voicemail and Auto-Attendant information in 8-bit .wav (μ-law) 
format received through G.711 and G.729 codecs. The switches can negotiate ADPCM 
(DVI4/8000) and Linear (L16/8000) codecs. Each switch supports G.729 on trunks and 
extensions.

Each V Model switch utilize only the codecs residing on that switch. As with other 1-U Half 
Width Switches, V Model switch codecs cannot serve as a G.729 proxy. 

6.2.3 Server Functions
V Model switches support a reduced set of the server features available in ShoreTel Main 
and Distributed Servers. The following sections describe V Model Switch server features.
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6.2.3.1 Voicemail
V Model Switches provide voicemail access to local users under normal operation 
conditions. Application servers at remote locations can provide services to V Model switch 
users when switch resource utilization is at capacity.

Switch functions and Server routines run under Linux. Voicemail Model Switches use 
Qmail, instead of SMTP server used by other Application Servers. V Model Switches do not 
support SMDI.

Voicemail box capacity varies by switch model:

• SG 90V: 90 mail boxes

• SG 90 BRIV: 90 mail boxes

• SG 50: 50 mail boxes

Voicemail file capacity depends on Compact Flash card size. 1-GByte cards can store up to 
1500 minutes of audio data, translating into an average of more than 15 minutes for each 
SG 90V user.

Voicemail services are provided directly to users from the switch through the IP Phone 
connected to the V Model switch. When users access voicemail through their computers, 
the V Model switch sends the file to a Main or Distributed Server, which then transmits the 
message to the PC. 

When the Compact Flash is full, callers attempting to leave voice messages are told the 
mailbox is full. 

6.2.3.2 Auto Attendant Menus
All auto attendant menus defined for the system are loaded onto each V model switch.

6.2.3.3 Recorded Name Storage
When configuring their voicemail boxes, users record their names to audio files for system 
usage when introducing their mailbox or messages to inbound callers or other users. 

V Model switches stores Recorded Name files only for users whose mailbox is hosted on 
the switch, whereas Main and Distributed Servers retain all Recorded Name files. V Model 
Switches retrieve Recorded Name files from the Main or Distributed Server when it requires 
a file that does not reside on the switch.

6.2.3.4 Voicemail Prompts
All voicemail prompts, for languages supported by the system, are stored on the Main 
Server and each Distributed Server. V Model Switches store prompts for four languages, 
including the default language of the site to which the switch is assigned.

6.2.4 Connectivity Requirements
Voice mail and auto attendant availability requires connectivity to the boot time server for 
reading the configuration database on the HQ server. Voicemail and the auto attendant are 
not active until initial connectivity to the HQ server is established. V Model switches do 
not require restarting to enable Voicemail and auto attendant if initial connectivity is 
established after the initial boot.

Voicemail and auto attendant services require that the V model switch has connectivity 
with a Network Time Protocol (NTP) server. Backup requires FTP server connectivity. As 
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data is backed up, it goes to the Main Server or to any computer with FTP server 
capabilities that supports RFC 959, the MDTM command, and the SIZE command.

While Distributed servers can manage the V model switch, switch applications depend on 
access to the database maintained on the Main server. Applications that run on these voice 
switches include voicemail and Telephone Management Server (TMS).

Personal Communicator connects only to the Main Server or a Distributed Server, even for 
users whose host port is on a V Model switch.

6.3 Utilities

6.3.1 Accessing Voicemail Model Switch Utilities
ShoreTel switch utilities are accessible through the Maintenance port, an SSH client, or an 
MS windows program executed from a command prompt on the Main or a Distributed 
server. The following sections describe utility access methods.

The switch accepts requests from MS Windows CLIs only when they run on the local host, 
the controlling Distributed server, or the Main ShoreTel server. The switch accepts requests 
from remote CLIs run from an SSH client.

6.3.1.1 Accessing Utilities from the Serial Port
Switch utilities and the UBOOT command interface are accessible through the maintenance 
port located on the faceplate. The state of the switch at the time of Maintenance port access 
determines the available utility.

• During normal switch operation, the maintenance port accesses a specified Linux 
shell. The default shell is the ShoreTel command line interface (STCLI).

• During a switch boot, the maintenance port accesses UBOOT.

To access ShoreTel utilities through the maintenance port:

Step 1 Connect one end of a serial cable to a computer with a terminal emulator 
program installed.

Step 2 Connect the male end of the serial cable to the maintenance port on the front 
panel of the ShoreTel switch.

Step 3 Launch the terminal emulation using the following settings:

• Speed: 19.2 Kbs
• Data bit: 8 bits
• Stop bit: 1
• Parity: No parity
• Flow Control: None

Click OK. The ShoreTel command line interface appears.

Step 4 Do one of the following:

• If the interface shows that the switch has a Linux operating system, do as 
follows

— At the command line, type STCLI. The STCLI interface appears.
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— Type the user ID and password as required. The default values are 
“admin” and “root” respectively.

• If the interface shows that UBOOT is being used, user ID and password are 
not required.

Refer to the "STCLI" on page 127 for a description of STCLI. UBOOT is described in the 
ShoreTel Maintenance Guide.

6.3.1.2 Accessing Utilities from SSH
ShoreTel provides access to several Voicemail Model utilities through a Linux BASH 
command line. Voicemail Model switches define two accounts:

• Admin: The admin account provides access to selected ShoreTel and Linux utilities, 
including all Voicemail Model command line interfaces. ShoreTel recommends that 
user log into the Admin account when accessing Linux utilities.

Logging into the Admin account immediately opens the STCLI interface.

• Root: The root account provides access to all ShoreTel and Linux utilities. Access to 
this account should be restricted because of the potential for creating unintended 
switch problems.

Logging into the Root account immediately opens a Linux BASH shell.

Access to the Linux BASH command line through an SSH client. Free SSH clients, such as 
PuTTY, are available through the internet.

To access a Linux BASH Shell account:

Step 1 Open a SSH client access page. The PuTTY Configuration page appears as 
shown in Figure 6-1.

Figure 6-1 PuTTY Configuration Page

Step 2 Open the command prompt window by performing the following:

• Enter the IP address of the switch in the Host Name field

• Enter 22 in the Port field; SSH client communicates on port 22. 

• Press the Open button.
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Step 3 Enter the username of the desired account on the command line, then press 
Enter. The Putty command prompt appears as shown in Figure 6-2. 

Figure 6-2 PuTTY Command Prompt Window

Where admin is the entered account.

The command line response depends on the account to which you log into. When 
logging into admin, the CLI open STCLI. When logging into the Root account, the CLI 
displays a prompt that displays root as the account.

6.3.2 STCLI
The STCLI is the ShoreTel command line interface (CLI) that allows you to view switch 
configuration information, manually set the IP address, reboot or shutdown the switch, 
and archive log files.

When you launch the STCLI as described in "Accessing Utilities from the Serial Port" on 
page 125 and "Accessing Utilities from SSH" on page 126, the main STCLI menu appears as 
shown in Figure 6-3.

Figure 6-3 STCLI Login and Main Menu

Exiting STCLI returns the user to the Admin account BASH shell. To close the window, 
type Exit on the Linux command line.

The following describes the STCLI commands.
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• Option 0 – Exit

This command logs out of STCLI and returns control to the program from where 
STCLI was entered. 

A user must exit STCLI before starting svccli. 

• Option 1 – Show Version

This command displays the system software version running on the V model switch.

• Option 2 – Show System Configuration

This command displays current values for system parameters that are viewable 
through STCLI, a user enters a 2 at the STCLI prompt. Figure 6-4 displays an 
example of the parameters. Option 3 – Change System Configuration provides access 
to editable parameters.

Figure 6-4 Current System Configuration

• Option 3 – Change System Configuration

The command accesses a list of options for modifying the system configuration. 
When option 3 is selected, the cursor displays ShoreTel Config to indicate that 
subsequent commands my alter the system configuration. Figure 6-5 displays the 
system configuration menu.

Figure 6-5 Configurable System Parameters
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The IP addressing mode is selected from this menu. To specify the addressing mode, 
select 6 from the ShoreTel Config menu. If static IP addressing is selected, all other 
Option 3 parameters must be configured. The static addressing configuration persists 
across upgrades.

The configuration file is cleared if the svccli burnflash command is executed. 

If DHCP is enabled, the DHCP server must provide the IP address of the network 
time protocol (NTP) server.

Pressing 0 from the ShoreTel Config prompt returns the system to the main STCLI 
menu. When exiting the STCLI main menu, the user is prompted to confirm all 
configuration changes made in the Option 3 menu.

• Option 4 – Reboot

Option 4 reboots the switch. The switch requests a confirmation of the command 
before rebooting.

• Option 5 – Shutdown

Option 5 performs a graceful shutdown of the switch. This command is accessible 
only through the Maintenance port.

Perform this command before removing power from the switch.

• Option 6 – Archive logs

Option 6 archives all switch logs and uploads them to the Logs directory in the 
ftproot of the Headquarters server.

• Option ? – Help

Entering ? lists the main menu items.

6.3.3 Specifying a Static IP Address
The default configuration of new ShoreTel voice switches is to use DHCP to obtain an IP 
address. To ensure that a DHCP lease is not lost, ShoreTel recommends that you assign a 
permanent or static IP address to voice switches. You can use DHCP reservations to assign 
a permanent IP address to a unit or yu can manually assign a static IP address. This section 
describes how to set a static IP address using the ShoreTel command line interface (STCLI).

To configure a switch with a static IP address using STCLI, do the following:

Step 1 Access the STCLI command line interface, as described in "STCLI" on page 
127.

Step 2 Type 3 on the command line to select Change System Configuration. The 
STCLI window displays the Change System Configuration options.

Step 3 Type 6 on the command line to select Enable/Disable DHCP. The STCLI 
window displays the DHCP options.

Step 4 Type 0 on the command line to select Manual Configuration.

Step 5 Change the network parameters as required to support the fixed address from 
the Change System Configuration entry line.

Step 6 After completing changes to the configuration, type exit to close the STCLI.

Step 7 Reboot the switch.
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6.4 V Model Switch Implementation
For a V model switch, Director supports the following tasks through the listed windows:

• Adding a new V model switch to a ShoreTel server, described in "Configuring a 
Switch" on page 130

• Configuring voice mail, described in "Configuring Voice Mail" on page 132

• Specifying Linux root and administrator passwords, described in "Specifying Root 
and Administrator Passwords" on page 134

• Specifying maximum size and age of log files stored on the CF card, described in 
"Log File Size and Age" on page 141

• Configuring backup of voice mail and enabling its automatic activation, described in 
"Configuring Automatic Backup for a Switch" on page 135.

Monitoring memory usage on the CF card, described in "Monitoring CF Memory Usage" 
on page 141.

6.4.1 Configuring a Switch
After physically connecting a V Model Switch into the system, the switch is added to the 
system through Director.

To add and configure a V Model switch to a ShoreTel system:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears as shown in Figure 6-6.

Figure 6-6 Primary Voice Switches/ Service Appliances Page

Step 3 In the “Add new switch/appliance at site” field, select the site where you want 
to add the switch.

Step 4 In the “of type” field, select the model of the switch that you want to add to the 
site.

Step 5 Click Go. The Edit Switch page appears as shown in Figure 6-7. 
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Figure 6-7 Edit Switch Page

Step 6 Complete each field according to the plan for this switch and network.

Refer to "ShoreTel Director Windows for Voice Switches" on page 93 for instructions 
on configuring a ShoreTel Voice Switch.

The switch configuration window for Voice Model Switches contains voice mail and back-
up options in addition to voice switch options available for other switches. Refer to 
"Configuring Voice Mail" on page 132 for instructions on configuring voice mail. Refer to 
"Configuring Automatic Backup for a Switch" on page 135 for instructions on configuring 
system back-up.

6.4.2 Replacing a Switch
When replacing a V Model switch, you can retain the voicemail contents on a CF card if the 
replacement switch is the same model as the original.

To replace a V Model switch and retain the voicemail on the original switch:

Step 1 Remove the original switch from the ShoreTel network.

Step 2 Remove the plate covering the memory slot on the left side of the original 
switch.
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Step 3 Remove the CF card from the memory slot.

Step 4 Remove the plate covering the memory slot on the left side of the replacement 
switch.

Step 5 Insert the CF card into the memory slot and replace the memory slot cover.

Step 6 Connect the replacement switch into the network.

Step 7 In ShoreTel Director, open the Switches window by selecting Administration-> 
Switches.

Step 8 Open the Edit ShoreTel Switch page by clicking the name of the replaced 
switch.

Step 9 Enter the MAC address of the new switch in the Ethernet Address field and 
press the Save button at the top of the page.

6.4.3 Upgrading a Switch
Upgrading a switch uploads new switch firmware and server software to the device. Switch 
upgrades are necessary when to maintain compatibility with the remainder of the system 
when the ShoreTel system is upgraded. V Model switches provide the following upgrade 
methods: 

• Restart and Reboot operations

Restart and reboot options that also upgrades switch software and firmware when a 
new version is available in the system. Restart and Reboot are initiated through 
Director Switch Maintenance pages.

Upgrading the firmware of a V Model switch located at a remote site requires a minimum 
bandwidth of 384 kbps between the V Model switch and the FTP server providing the 
firmware upgrade. A remote upgrade may not be possible if the minimum required 
bandwidth is not available. The firmware upgrade requires 45 minutes at the minimum 
bandwidth; higher bandwidth reduces the upgrade time.

Existing voice switches cannot be upgraded to become a V model switch.

6.4.4 Configuring Voice Mail
Voicemail is configured through one of the following Director pages:

• Edit Application Servers, accessed by selecting Administration > Application 
Servers > HQ/DVS, then selecting the desired V Model Switch.

The V model features in the Application Servers window are the same as on other 
platforms except that on a V model switch:

— The V model includes the enable and configuration of automatic daily backup.

— Simplified Message Desk Interface (SMDI) is disabled.

Figure 6-8 displays the Application Servers window for the V Model switch named 
HQVMB-50 
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Figure 6-8 Configuring Voice Mail through Application Servers Window

• Edit Switches, accessed by selecting Administration > Application Servers > HQ/
DVS, then selecting the desired V Model switch.

Figure 6-9 displays the Voicemail parameters on the Switches window for the V 
model switch named HQVMB-50.

Figure 6-9 Configuring Voice Mail through the Switches Window
ShoreTel 12.2 133



System Administration Guide Chapter 6: Voicemail Model Switches
Director paths that open voice mail on the Main and Distributed Servers also access pages 
that configure V model switches. For details on voice mail configuration, see Chapter 6: 
Voicemail Model Switches, starting on page 121. 

6.4.5 Specifying Root and Administrator Passwords
V Model switches provide access to command line interfaces (CLIs) for diagnostics and 
advanced configuration tasks. Other than specifying a fixed IP Address, CLI access is not 
required for typical switch operation and maintenance.

ShoreTel provides two default accounts for accessing V Model Switch CLIs:

• Admin: This account is used for configuration tasks that require CLI access.

• Root: The root account accesses all internal Linux commands. 

IMPORTANT Important: ShoreTel recommends using the Root command only under 
direct supervision of ShoreTel Technical Support personnel. The root 
admin does not restrict command scenarios that can render the switch 
unusable.

You can use ShoreTel Director to change the passwords for logging into these accounts. To 
change the passwords required to log into the Voicemail Switch CLI accounts:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Other. The Edit Other 
Parameters page appears as shown in Figure 6-10.

Figure 6-10Edit Other Parameters Page

Step 3 In the first “admin” Password field, enter the password that you want to use for 
the “admin” account.

The password must have four ASCII characters minimum and up to 26 ASCII 
characters maximum.
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Step 4 In the second “admin” Password field, enter the same password that you 
entered into the first field.

Step 5 In the first “root” Password field, enter the password that you want to use for 
the “admin” account.

The password must have four ASCII characters minimum and up to 26 ASCII 
characters maximum.

Step 6 In the second “root” Password field, enter the same password that you entered 
into the first field.

Step 7 Click Save.

6.4.6 Configuring Automatic Backup for a Switch
Due to the CF card capacity, daily backup of voice mail and Auto-Attendant data is advised. 
When automatic backup is enabled in the ShoreTel Director, it begins immediately after the 
server completes its daily house-keeping operation. (The house-keeping utilities are built-
in and remove log files and old voice mails based on the configuration data in the Director.) 
In addition:

Automatic backup stores voicemail, auto attendant data, and switch log files to an FTP 
server. After completion of the daily file-system cleanup tasks, the switch begins automatic 
backup. A timestamp is appended to the name of files copied to the target server. 

Automatic backup provides a source for the most recent day’s voice mail and other data in 
the event of a system failure. It is not intended to be an archive of voice messages or a 
source for retrieving deleted voice mail.

NOTE V model switches rely on the ftpsync facility to synchronize its local (or source) 
directory to the back-up server (or target) directory. Therefore, the server must 
support ftpsync as described in RFC 959. The server must also support the MDTM 
and SIZE commands. FTP servers in Win2003 and WIN XP meet these 
requirements.

To configure automatic backup for a switch, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Primary. The Primary Voice 
Switch/Service Appliances page appears.

Step 3 Select the switch that you want to configure for automatic backup. The Edit 
page for that switch appears.

Step 4 Scroll down to the Backup section and do the following:

Step a Check the Enable Daily Backup checkbox.

Step b In the IP address field, enter IP address of the FTP server to which you want 
to back the switch files up.

Step c In the FTP Port field, enter the port number that the switch is to use to 
communicate with the recipient FTP server.

Step d In the Directory field, enter the path to the file on the FTP server to which 
you want to back the switch files up.
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Step e In the User ID field, enter the user name that the switch is to use to access 
the FTP server files for backup.

Step f In the first Password field, enter the password that the switch is to use to 
access the FTP server files for backup.

Step g In the second Password field, enter the same password that the switch is to 
use to access the FTP server files for backup.

Step h Click Save.

6.4.7 Configuring a Target Server for Backup
Backing up V model switch voice mail requires a target FTP server. A ShoreTel Main Server 
or a third-party server can function as the recipient of V Model Switch backup files.

This section describes an FTP server configuration, using a Windows server as the 
recipient. (Detailed instructions on configuring Windows servers are available in the article 
How To Set Up Isolated FTP Site at http://support.microsoft.com/kb/555018.) The section 
first lists the configuration data entered into Director. The subsequent list shows the 
information entered at the server, including configuration data from the V model switch.

On the server, perform the following:

Step 1 Using the Win2003 Computer Management dialog, add a new FTP site

In Figure 6-11, an FTP site named “ShoreTelBackup” is added.

Figure 6-11The New Target Server is Identified

Step 2 For the new server, specify the IP address and port number

In Figure 6-12, the IP address is 10.1.1.42. and port is 5555.
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Figure 6-12Specify IP Address and Port Number for “ShoreTelBackup

Step 3 In the ShoreTel Backup Properties page, specify the local path

In Figure 6-13, the local path is C:\ShoreTelBackup.

Figure 6-13Specifying the Local Path for the Backed-up Data

Step 4 In the FTP Site Creation Wizard, specify that the user is isolated.

Figure 6-14 displays a properly configured Site Creation Wizard.
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Figure 6-14Isolating the User (Directory)

Step 5 Enter a name and description of the FTP server in the General page, as shown 
in Figure 6-15.

Figure 6-15Specifying the and Password Details

Step 6 Enable the following options:

• User cannot change password

• Password never expires.

Step 7 Verify the resultant path of the configured server, as shown in Figure 6-16.
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Figure 6-16After Configuring the FTP Server is Finished

6.5 Booting and Restarting

6.5.1 Description
Rebooting and restarting V model switches have different scopes. 

• Rebooting a V model switch also reboots the Linux kernel and everything that a 
kernel reboot entails. 

A reboot takes much longer than a restart.

• Restarting a V model switch only the reboots the ShoreTel application layer. 

On ShoreTel switches running on VxWorks, rebooting and restarting are identical. 

Under certain conditions, initiating a restart will reboot the switch. One example is when a 
switch upgrade is available.

When a ShoreTel voice switch boots, it requires an IP address to connect to the network 
and an application program. ShoreTel voice switches are set to use a DHCP server for an IP 
address and to retrieve the application from the switch’s flash memory.

If a DHCP request receives no response, the switch tries a BootP request as a backup. 
ShoreTel recommends using static IP parameters configured via the serial port, as this is 
much more reliable. When using DHCP, ShoreTel recommends using DHCP reservations 
for each switch to ensure that DHCP leases are not lost.

If a DHCP server is not available, you can set the IP address manually from the switch’s 
maintenance port from STCLI.

If the switch fails to load the application from flash and does not have the IP address of the 
ShoreTel server, you can set the IP address and boot parameters by connecting to the 
maintenance port and using the configuration menu. The configuration menu allows you 
to set the IP address of the switch and enter the ShoreTel server (boot host) IP address. 

A V model switch can be brought up by a regular (flash memory-sourced) boot or by a 
software upgrade boot. 
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6.5.2 Specifying a Time Source
ShoreTel servers maintain an internal time of day clock, which is initialized by input 
received at boot time from an NTP server. ShoreTel servers use the time of day clock to 
mark voicemail and track other transactions.

V model switches do not begin server operations until after they receive an initial time of 
day input. If the time is not available from a designated source at boot time, the V Model 
switch supports all switch operations and will periodically poll for the time of day setting. 
After receiving the a time of day setting, the V model switch begins server operations. 

The NTP server can be specified through DHCP or as a static address. If no address is 
specified, the V Model switch polls NTP servers at addresses specified by an internal 
configuration list. The internal configuration list includes the HQ Server and Internet 
based NTP servers.

• If an IP address is listed that does not point at an NTP server, the V Model switch will 
not begin server processes until the address is corrected.

• If the IP address points at a server that is not available, the V Model switch 
periodically polls the IP address for the NTP server. When the server becomes 
available, the V Model switch begins performing server operations after it polls the 
server and receives the time of day setting.

After the server becomes available, rebooting the V model switch may be faster than 
waiting for it to poll the NTP server.

6.5.3 Reboot Methods

6.5.3.1 Flash Boot
The standard method for booting a ShoreTel voice switch is to boot from the switch’s flash 
memory. When a ShoreTel switch is first powered on, it reads the boot parameters stored on 
the non volatile memory, which instructs the switch to load software from flash memory. 
When the software starts, it loads its configuration, which is also stored in flash memory.

6.5.3.2 Default Button
The Default Button is the small “paperclip” button on the left side of the switch. Pressing 
this button replaces the two configuration files with their default variants. The Compact 
Flash is not affected.

Pressing this button and holding for 10 seconds, in addition to replacing the configuration 
files, removes all files from the Compact Flash.

6.5.3.3 FTP Boot
Booting from FTP is available when you cannot boot the switch from internal memory. 
When booting a switch from FTP, the operating system and software are loaded from the 
FTP site identified in the boot parameters. The loaded files define a default configuration.

Voicemail services on the switch are disabled after booting from FTP and are restarted only 
by booting from Flash. After an FTP boot, the switch can perform telephony functions as 
those available through other ShoreTel switches. V model switches started with an FTP 
boot can operate only as a voice switch – (controlling phones, trunks, and call routing.

FTP boot is typically used for troubleshooting and also supports maintenance tasks and the 
backup and restore facilities.FTP boot supports certain maintenance functions, such as an 
emergency boot if the flash becomes damaged.
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6.6 Monitoring a Voicemail Model Switch

6.6.1 Monitoring Switch Functions
Quick Look exists in ShoreTel Director to provide an overview of the ShoreTel system 
status. It includes information about each site and the corresponding switches, ports, 
servers, and service. This is the first place to look to determine the status of the system.

6.6.2 Log File Size and Age
The Other Parameters window under Administration > System Parameters contains fields 
that show the maximum size and age of log files. These values must be set on a server, not 
in the V-model Director’s switch area.

Due to the constraints on CF memory space, log files should not be allowed to consume 
too much memory. Thereafter, after the V-model switch has been added, change the values 
for the maximum size and age of log files from a server.

6.6.2.1 Event Logs
The ShoreTel system uses the Windows Event Log, viewed using the Event Viewer, to 
report information and errors that are of interest to system administrators. You can use the 
event logs in conjunction with Quick Look to determine the overall health of the system. 
You can also use the event log to gather information about an event that is no longer a 
problem. For example, the event log may provide information about an overnight T1 
outage that was corrected is no longer evident.

Each system task reports when it starts and stops. These messages can be helpful in 
determining whether the system has started correctly. Events, such as switches losing 
connection to the server or rebooting, are also reported. 

6.6.2.2 System Logs
A ShoreTel system stores engineering-level log files that record transaction information 
about every event in the ShoreTel system. The logs help ShoreTel with debugging problems 
that can arise during system operation. In most cases, these logs are difficult to interpret 
and require help from ShoreTel Customer Support to understand.

6.6.3 Monitoring CF Memory Usage
A V model switch provides CF usage data to the ShoreTel Director and a CLI command. If 
the CF card becomes full, it cannot accept new voice mail. This section describes four 
Director windows that provide different views of memory usage on a CF card. Certain 
Director windows variously show the CF’s used space, free space, percent of usage, and 
color-coded alerts. Also, the administrator can create an event filter to send notification of 
high memory usage.

Typical CF capacities are 1 Gbyte, 2 Gbytes, and 4 Gbytes. The proper planning of voice 
mail usage and aging can help prevent excessive buildup of voice mail on the CF card.

6.6.3.1 Using Quick Look
The Quick Look page in ShoreTel Director lets you see how much of the CF card is 
currently being used. To view CF card usage in the Quick Look page, do the following:

Step 1 Launch ShoreTel Director. The Quick Look page appears as in Figure 6-17.
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Figure 6-17Percent of Disk Usage in the Quick Look Window

Step 2 Locate the voice switch for which you want to monitor the CF card usage.

Step 3 Check the value in the Disk used column to see how much of the CF card is 
currently being used.

In Quick Look, the colored alerts are yellow (1–10 messages left) and red (mailbox is full).

6.6.3.2 Using the Maintenance Page for the Switch
The maintenance page for the switch lets you view information about usage by switch 
users. To view the information on the maintenance page:

Step 1 Launch ShoreTel Director. The Quick Look page appears.

Step 2 Select the switch for which you want to view information. The Maintenance 
page for the switch appears as shown in Figure 6-18.

Figure 6-18Specific Voice Mail Availability through the Quick Look Window
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In Quick Look, an administrator can select a particular V model switch and see the 
configuration and usage numbers for individual voice mailboxes (). In other windows, 
these colors can mean other thresholds.

For the amounts of free and used disk space in Mbytes and any alerts, the administrator can 
go to the Voice Mail Servers Maintenance - Summary window. This window (Figure 6-19) 
shows the amount of free and used space in Mbytes for each voice mail server. For memory 
usage warnings, an alarm indicator appears in the Free Space (MB) column next a specific 
switch’s value. In Figure 6-19, the small circle next to the HQVMB-50V Free Space value is 
a yellow alert. The legend at the bottom of the screen shows that yellow means CF free 
space is at 25-50% of capacity. Red means free space is at or below 25% of capacity.

Figure 6-19Disk Usage for Each Server in Voice Mail Servers Maintenance

The next degree of more granularity is information for each user. In Figure 6-20, the screen 
for voice mail server HQVMB-50V shows the current number of Kbytes of voice mail for 
each user and the configuration details for each user. The alerts in this window are yellow 
for 1–10 messages left and red for mailbox full.

Figure 6-20CF Card Usage per User on HQVMB-50V

ShoreTel Director displays the CF memory usage as a disk usage value.
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6.7 Creating a System Extension for SA-100 
Conferences
The ShoreTel system automatically creates a system-wide conference number that it assigns 
an internal ShoreTel extension. This is a number that all ShoreTel users can use to initiate 
or join a ShoreTel conference. You can change extension manually and even use an external 
phone number for the conference extension.

Each SA-100 that you install is also automatically assigned a ShoreTel extension. This 
number can be used by local users to access the unit to initiate conference calls. You can 
also change the extension number assigned to the unit.

This section describes how to change the extension and assign an external number.

Requirement

• A valid external phone number properly mapped in ShoreWare Director

To change the internal extension and assign an external number, do the following:

Step 1 Launch ShoreWare Director.

Step 2 Click Administration > System Parameters >System Extensions. The Systems 
Parameters page as shown in Figure 6-21 appears.

Figure 6-21Systems Parameters Page

Step 3 In the Extension field, enter the available extension number that you want to 
use for ShoreTel Conference to change the internal extension assigned to 
ShoreTel Conference.

Step 4 In the External Number field, enter the valid phone number that you want to 
use for ShoreTel Conference. 
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NOTE Make sure that the number that you use is properly mapped to a 
telephony trunk. Refer to the ShoreTel 12: System Administration 
Guide for information about setting up trunks.

Step 5 In the Additional Calling Information field, enter any additional information 
that you want to use with the extension. The text will be included in all 
conference invites including Outlook invite as well as in the dial in window in 
the ShoreTel Viewer.

6.8 Configuring the SA-100 for Conferencing and IM
This section describes how to set up the ShoreTel system to use the SA-100 to provide 
conferencing and IM services. For more information about setting up and configuring the 
SA-100, refer to the ShoreTel Service Appliance 100 Planning, Installation, and Administration 
Guide.

NOTE If after you install and configure the SA-100 you use a Windows server machine to 
access the conferencing Web page, make sure that your browser allows JavaScript 
to download. JavaScript is required to render the conference Web page.

6.8.1 Creating SA-100 Users
Anyone can participate in or initate ad hoc SA-100-managed conference calls. However, the 
SA-100 users referred to here are ShoreTel system users who are granted accounts that 
allow them to schedule and host conferences on SA-100s. To configure these SA-100 users, 
do the following:

Step 1 Launch ShoreWare Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 Select the user for whom you want to enable the service. The Users page 
containing the profile of the user you select appears.

Step 4 Scroll down to Conference Setting section near the bottom of the page.

Step 5 In the Appliance field, select the SA-100 that you want the user to use for 
conference calls.

Step 6 Click Save.

Note If you are not running proxy services on your network, we recommend that you 
disable the Microsoft Internet Explorer Internet Option setting “Automatically 
detect settings” on the machines of conference users. This setting can cause the Web 
Presenter on user machines using a WiFi connection to take up to 30 seconds to 
load during conferences.
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6.8.2 Migrating IM and Presence Users to the SA-100 Server
To migrate IM and Presence users from a legacy ShoreTel IM Server to the SA-100, do the 
following:

Step 1 Launch ShoreWare Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 Select the user that you want to move to the SA-100. The Users page appears.

Step 4 Locate the Instant Messaging Settings section and in the Server/Appliance field, 
select the SA-100 unit that you want the user to use for IM and Presence.

Step 5 Click Save.

Step 6 Notify the end-user to uninstall, then install Outlook calendar integration in 
ShoreTel Communicator for Windows if they are using Outlook calendar-
integration. Refer to ShoreTel 12:1 Communicator for Windows User Guide for 
instruction on how to configure Outlook calendar integration.

6.8.3 Configuring the Conference Web Page
A ShoreWare Director user with administration privilege can customize the Web page that 
the current SA-100 generates for conferences. The administrator can change the logo that 
appears, place a link behind the logo that redirects the user to another site, and change the 
name that appears on the page. To customize the conference Web page for the SA-100, do 
the following:

Step 1 Log in to ShoreWare Director as a user with administration privilege.

NOTE The default user ID and password are not supported for this 
application.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/ Service Appliance page 
appears as shown in Figure 6-22.

Figure 6-22Primary Voice Switches/Service Appliance Page for SA-100

Step 3 Locate the SA-100 for which you want to modify the conference Web page and 
click Launch in the Quick Launch column. The Service Appliance Conference 
Administration page appears as shown in Figure 6-23.
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Figure 6-23Service Appliance Conference Administration Page

Step 4 Click Website. The Website page appears as shown in Figure 6-24.

Figure 6-24Website Page

Step 5 In the Web Site Logo field, enter the path to the logo that you want to appear 
on Web conference pages.

Step 6 To specify the link that you want to associate with the Web site logo:

• Select the Link to the Home page radio button to connect users to the 
conference home page when they click on the logo.

• Select the Custom link radio button and enter the path to the destination 
that you want users to go to when they click on the logo. 
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Step 7 In the Window Title field, enter the name that you want to use as the identifier 
for conferences managed by this SA-100. The name will appear on the browser 
tab of active conferences. The default name is ShoreTel Conference.

Step 8 To create footers that appears at the bottom of the conference Web page, do the 
following:

Step a In a Footer Label field, enter the name that you want to appear as a footer at 
the bottom of conference Web pages.

Step b Click Submit to create the footer. The page refreshes.

Step c Click Edit page next to the footer label for which you want to provide text. 
The “Edit footer name” page appears.

Step d Enter the text that you want to appear when a user clicks the footer. You can 
use an HTML text to populate the field.

Step e Click Submit. The page refreshes.

The footer will appear on the bar at the bottom of the conference Web page. 
User access the message by clicking the footer label.

NOTE To remove a footer, erase the footer label and click Submit.

Step 9 Click Submit to save your changes.

NOTE The remaining fields are not used.

6.8.4 Configuring the Parameters for the Client Interface
You can set interface parameters that affect conference participants. You can insert a logo 
on the viewer Web page, activate a tone that signals a user joining a conference, and you 
can set up a link that directs participants to a Web page at the completion of their 
conference. To configure these parameters for the client interface, do the following:

Step 1 Log in to ShoreWare Director as a user with administration privilege.

NOTE The default user ID and password are not supported for this 
application.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/ Service Appliance page 
appears.

Step 3 Locate the SA-100 for which you want to modify the conference interface and 
in the Quick Launch column click Launch. The Service Appliance Conference 
Administration page appears as shown in Figure 6-23 on page 147.

Step 4 Click Conference Viewer. The Conference Viewer page appears as shown in 
Figure 6-25.
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Figure 6-25Conference Viewer Page

Step 5 In the Logo field, enter the path to the logo that you want to appear on the 
conference viewer page.

Step 6 To have conference sound a tone when a new participant enters, do either of 
the following in the Alert Sound section:

• Click the Yes radio button to activate the tone.

• Click the No radio button to deactivate the tone. 

Step 7 In the Exit Page field, enter the path to the page that you want to direct 
participants to when the conference ends.

Step 8 Click Submit.

6.8.5 Configuring HTTPS
ShoreTel support HTTPS for secure conference calls. Secure ShoreTel Web conferencing 
uses 2048-bit encryption. To provide HTTPS security to conference users, you must upload 
Secure Socket Layer (SSL) certificates or Unified Communication Certificates (UCC) on 
each SA-100 that you want to provide HTTPS security. This section describes how to obtain 
an SSL certificate and how to install the certificate on SA-100 units.

6.8.5.1 Obtaining an SSL Certificate
If you already have an SSL certificate, you can install it on your SA-100. See "Uploading an 
HTTPS Certificate" on page 152 for instructions about installing an SSL certificate. If you 
do not have an SSL certificate, ShoreTel recommends that you purchase an SSL certificate 
from a reputable Certificate Authority (CA). To purchase such a certificate, you must first 
create a Certificate Signing Request (CSR) to present to the CA. You can create a CSR in 
ShoreWare Director as follows:

Step 1 Launch ShoreWare Director as a user with administrator privilege. (The default 
administrator, admin, cannot be used.)
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Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears.

Step 3 Select an SA-100 listing and in the Quick Launch column click Launch. The 
Service Appliance Conference Administration Conferences page appears as 
shown in Figure 6-26.

Figure 6-26Service Appliance Conference Administration Conferences Page

Step 4 Click the HTTPS tab. The HTTPS tab appears as shown in Figure 6-27.
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Figure 6-27HTTPS Tab

Step 5 In the respective fields, enter the information listed below. An asterisk (*) 
indicate that this information is required.

• Country: Enter the two-character country code for the country where the 
system is installed. Refer to ISO 3166 for information about country codes.

• State or Province: Enter the name of the state or province where the system 
is installed.

• Locality: Enter the name of the city where the system is installed.
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• Organization: Enter the legal name of the company or organization or the 
person that is requesting the certificate.

• Organizational Unit: Enter the name of the department that is requesting 
the certificate.

• *Common Name: Enter the Fully Qualified Domain Name (FQDN) for 
which you want the SSL certificate.

Note If the CSR is for a wildcard certificate, you must prepend “*.” to the 
common name (e.g. *.domain.com).

Note If the CSR is for a UCC, enter one only of the domain names for 
which you want the certification. You will provide additional 
domain names when you order the certificate.

• Email Address: Enter an email address of the administrator who is to 
handle the certificate.

Step 6 Click Create CRS. The ShoreTel system creates a CSR and a private key. 

The system generates links that you can use to download the CSR and private 
key. Download the CSR and private key--if required---and send them to the CA.

6.8.5.2 Uploading an HTTPS Certificate
This section describes how to upload HTTPS certificates. You can upload certificates for a 
single SA-100 or for all of the SA-100 currently installed on your system depending upon 
your certificate agreement. To upload HTTPS certificates, do the following:

Note Wildcard certificates that you upload are automatically transferred to all appliances 
including units that you add to the system later.

Step 1 Launch ShoreWare Director as a user with administrator privilege. (The default 
administrator, admin, cannot be used.)

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears.

Step 3 Select an SA-100 listing and in the Quick Launch column click Launch. The 
Service Appliance Conference Administration Conferences page appears as 
shown in Figure 6-26 on page 150.

Step 4 Click the HTTPS tab. The HTTPS tab appears as shown in Figure 6-27 on page 
151.

Step 5 Scroll to the Upload CA-Authorize SSL Certificate section and do the following:

Step a Check the This is a wildcard certificate check box to use the certificate and 
private key you are about to upload on all SA-100s on your ShoreTel system.

Step b In the SSL Certificate field, enter or browse to the path to the file that 
contains the SSL certificate that you want to use. This field is required.

Step c In the Intermediate CA Certificate field, enter or browse to the path to the 
file that contains the intermediate SSL certificate that you want to use.
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Step d In the Private Key field, enter or browse to the path to the file that contains 
the Private Key that you want to use.

Step e Click Upload.

Step 6 Click Restart Web Server. This reboots the SA-100 and activates all certificates 
when the unit restarts.

6.8.5.3 Enabling HTTPS
You must have a certificate to run HTTPS. If you already have a certificate, use the process 
described in "Uploading an HTTPS Certificate" on page 152 to upload it to the appliance. 
(Wildcard certificates need be uploaded once only. These certificates are automatically 
transferred to SA-100s already installed on the system and to new SA-100s after they are 
installed.) If you do not have a certificate, you can obtain one (see "Obtaining an SSL 
Certificate" on page 149 for instruction about obtaining a certificate) or the system will 
automatically create a self-signing SSL certificate and private key. A self-signing certificate 
will allow an SA-100 to create and participate in HTTPS conferences, but as the certificate 
is not issued by a third party HTTPS security is not optimized. When a self-signing 
certificate is used, users trying to access the secure conference site will receive a warning 
message that the security provided is not guarantied.

You can also enable HTTPS on selected SA-100 or on all SA-100 in your system. Because 
the ShoreTel system uses a distributed approach, we recommends that you enable HTTPS 
on all of your SA-100s. The distributed approach ShoreTel uses means that multiple SA-
100s can be used in a single conference. In conferences where HTTPS is used, SA-100s that 
are not configured to use HTTPS cannot communicate with SA-100s that are using HTTPS 
and are not allowed to join.

ShoreTel recommends that if you enable HTTPS on one SA-100 in your environment, that 
you enable it on all SA-100s in your environment. Mixing HTTPS-enabled SA-100s with 
SA-100s that do not have HTTPS enabled can cause problems. Users assigned to appliances 
without HTTPS get an error when they try to access library files stored on an HTTPS-
enabled SA-100. The user is able to view the files, but a horizontal blue stripe appears on 
the right hand side of the pane when they access the files. 

This section describes how to enable HTTPS on an SA-100. To enable HTTPS on an SA-
100, do the following:

Step 1 Launch ShoreWare Director as a user with administrator privilege. (The default 
administrator, admin, cannot be used.)

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears.

Step 3 Select an SA-100 listing and in the Quick Launch column click Launch. The 
Service Appliance Conference Administration Conferences page appears as 
shown in Figure 6-26 on page 150.

Step 4 Click the HTTPS tab. The HTTPS tab appears as shown in Figure 6-27 on page 
151.

Step 5 In the Enable HTTPS section, make sure that HTTPS is enabled. The function 
is enabled when the first line in the says the following:

HTTPS is currently enabled on this service appliance.
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If the service appliance is disabled, do the following:

Step a In the Enable HTTPS on the following Service Appliance field, select the 
option that indicates the device on which you want to enable HTTPS.

Note Selecting All enables HTTPS only on the SA-100s that are currently 
online. The enabling process must be repeated when units that are 
currently offline are brought online and when new units are added.

Step b Click Go to enable HTTPS.

Note When using a self-signed certificate, user uploads to Personal or Shared Library may 
fail if using the FireFox web browser to access the Conference Web Portal.

Note User’s who access the Conference Web Portal on appliances with HTTPS enabled 
and who use the FireFox web browser must disable Transport Layer Security (TLS) 
to properly render web pages. To disable TLS in Firefox:

— Select Tools > Options.
— Click the Advanced tab
— Click the Encryption tab.
— Uncheck "Use TLS 1.0".
— Click OK.
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C H A P T E R 7

Configuring Trunks

This chapter describes how to configure trunks and trunk groups in ShoreTel Director. The 
topics in this chapter are:

• "Overview" on page 155

• "Setting Up Trunks" on page 155

• "Individual Trunks" on page 172

• "Forwarding Original Caller ID Outside a ShoreTel Network" on page 174

• "Introduction to ISDN Profiles" on page 178

• "Caller ID Name on T1-PRI Trunks" on page 178

• "Specifying a 20-Digit SETUP Message for PRI or BRI" on page 185

• "ISDN Profile for RNIE" on page 187

The expanded Trunks link in the navigation frame appears in Figure 7-1.

7.1 Overview
Before beginning, you should understand the different trunk types and trunk features that 
the ShoreTel system supports.

• A very thorough description of the types of trunks and their associated features is 
included in the ShoreTel 12: Planning and Installation Guide, Chapter 5, “Trunk 
Planning and Ordering.”

• A detailed description of how the dialing plan, network call routing, and digit 
manipulation operate is included in the ShoreTel 12: Planning and Installation 
Guide.”

For more information about the features supported outside the U.S. and Canada, refer to 
the ShoreTel 12: Planning and Installation Guide.”

For an overview of the various trunk types and trunk features, refer to the “Trunk Planning 
and Ordering” chapter in the ShoreTel 12: Planning and Installation Guide.

7.2 Setting Up Trunks
Click Trunk Groups under the Trunks link in the navigation frame to open the Trunk 
Groups window, as shown in Figure 7-1.
ShoreTel 12.2 155



System Administration Guide Chapter 7: Configuring Trunks
Figure 7-1 Trunk Groups List Page

The columns in the Trunk Groups list page follow: 

• Name: This is the name of an existing trunk group. Clicking a name invokes the 
Trunk Group edit page, where you can edit the trunk group configuration.

• Type: This is the type of trunk group.

• Site: This is the site of the trunk group. Note that a trunk group cannot span sites. 
For information about configuring sites, refer to Chapter 3: ShoreTel Sites starting on 
page 65.

• Trunks: This is the number of trunks in the trunk group.

• DID: This column shows whether the trunk supports DID. The trunk group 
supports at least one of the following:

— DID

— DNIS

— Extension

• Destination: This is the destination where incoming calls are routed. This may be the 
auto-attendant, the operator, or an individual user’s extension. According to the 
options you have set, incoming calls are routed, in the order they are listed, to:

— DNIS

— DID

— Extension

— Destination

Destination is always available as the last choice for routing.

• Access Code: This displays the access code for the trunk group.

7.2.1 Add or Edit a Trunk Group
To add a new trunk group, on the Trunk Groups list page, specify a site from the Add new 
Trunk Group at site drop-down list, select a trunk group type from the “of type” drop-
down list, and click Go. To edit an existing trunk group, click a trunk group from the list of 
trunk groups in the Name column on the Trunk Groups list page. 

When you add a new trunk group or click the name of an existing trunk group in the 
Trunk Groups list, the applicable Trunk Group edit window appears. Figure 7-2 shows the 
T1 PRI Trunk Group edit page, which is a superset of all the other Trunk Group edit pages 
except the E1 Trunk Group edit page and the SIP Trunk Group edit page.
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Figure 7-2 Trunk Group Edit Page
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The parameters are defined as follows:

• Name: This is the name of the new or existing trunk group.

• Site: The Name of the site of the trunk group is displayed.

• Language: Select the language for the trunk group from the drop-down list.

• Teleworkers: This SIP trunk parameter is not used.

NOTE Third-party SIP devices use the public network for transmitting audio on 
intersite calls. Intersite bandwidth is used for signaling and call audio.

• Enable SIP Info for G.711 DTMF Signaling: This parameter only appears when 
editing SIP trunk groups.

• Profile: Select the desired SIP Trunk Profile. Refer to Section 10.1 for more 
information.

Enable this check box when using third-party SIP devices that do not support DTMF 
negotiation via RFC 2833. If the device does not support RFC 2833 and this check 
box is not enabled, DTMF negotiation will fail.

• Enable Digest Authentication: This parameter only appears when editing SIP trunk 
groups.

Enable this check box when using dynamic SIP trunks to provide enhanced security 
via User ID and Password authentication.

— User ID—This is the user ID associated with the third-party SIP device.

— Password—This is the password associated with the third-party SIP device.

7.2.1.1 Inbound Settings
The Inbound settings let you route inbound calls to a single destination, or route calls to a 
specific destination using DID and DNIS digits.

• Number of Digits from the CO: This specifies the maximum number of digits 
expected from the central office (for User PRI configured trunks).Digit collection 
terminates when the maximum number of digits are received, when the digit 
collection time-out is reached, or when an exact match is found.
Network PRI trunks connected to legacy PBXs collect digits from the legacy PBX 
side. When the ShoreTel system detects a trunk access code, it ignores the Number of 
Digits from the CO parameter and routes the call according to the dialing plan.

• DNIS: When DNIS is checked, click Edit DNIS Map to add or delete entries in the 
DNIS Map.

• DID: When DID is checked, click Edit DID Range to add or edit the DID Range as 
well as view the DID Digit Map.

• Extension: If you check this option, calls will route directly to the extension based 
on the digits received from the central office without any additional configuration. 
This is very useful when configuring a tie trunk connected to a legacy PBX. Note that 
the extension length must match the number of digits from the CO.

— Translation Table—When using the On-Net Dialing feature, this parameter 
allows you to specify a digit translation table that is used to strip one or more 
digits from calls between two systems with extensions of different lengths.
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— Prepend Dial In Prefix—When using the On-Net Dialing feature, this 
parameter allows you to add one or more digits to calls between two systems 
with extensions of different lengths.

— Use Site Extension Prefix—When using the On-Net Dialing feature, this 
parameter allows you to specify a site extension prefix that will be added to 
calls from a system that does not have a prefix to another system that does have 
a prefix.

• Tandem Trunking: Tandem trunking allows legacy voice systems to utilize a 
ShoreTel system for outbound dialing. The ShoreTel system supports network-side 
PRI, allowing ShoreTel systems to flexibly support digital tie trunks to other systems.

— User Group—Tandem calls are associated with a user group for outbound 
trunk selection. Inbound calls that are recognized as tandem calls are then 
redirected to an outbound trunk based on the call permissions and trunk group 
access associated with the user group set in Director.

— Prepend Dial In Prefix—When needed, you can specify a “dial in prefix” 
which is pre-pended to digits collected on tandem calls. The concatenated set 
of digits is then be used in outbound trunk selection for the tandem call.

• Destination: The Destination number is mandatory. All inbound calls are routed to a 
destination, such as an extension (user, workgroup, or route point) or a specific 
menu. If other destination options have been configured, this destination parameter 
is the last-choice destination.

Inbound calls first try to match a DNIS entry, then a DID entry, followed by an 
Extension entry, and finally Tandem Trunking. If no match is found, the inbound call 
is routed to the destination you set. If you create a trunk group, the destination is the 
default auto-attendant.

An individual trunk group cannot have the overlapping DID or DNIS numbers 
(received digits).

Users, Menus, Workgroups, and Route Points can have one DID number but 
multiple DNIS entries.

7.2.1.2 Outbound Settings
The settings in the Outbound area of the trunk editing window fall into multiple logical 
groupings. The groups of outbound settings that are defined in this section are Network 
Call Routing, Trunk Services, Trunk Digit Manipulation, and Local Prefixes. The options 
for outbound calling are activated by placing a check in the Outbound check box.

• Network Call Routing: The Network Call Routing options are as follows:

— Access Code—Enter the appropriate trunk access code for this trunk group. 
Typically the access code in the U.S. and Canada is 9.

— Local Area Code—Enter the local area code for this trunk group. This area code is 
used for Network Call Routing and Digit Manipulation.

— Additional Local Area Codes—Click Edit to enter any additional area codes that 
are typically associated with overlay area codes. These additional local area codes 
are used for Network Call Routing and Digit Manipulation.

— Nearby Area Codes—Click Edit to enter area codes that are considered nearby (or 
“free of cost”) for this trunk group. The nearby area codes are used for Network 
Call Routing.
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— Billing Telephone Number (BTN)—This function enables the switch to forward an 
original caller’s ID when a received call is redirected by one of ShoreTel’s forwarding 
features. For example, if an outside caller dials a ShoreTel user whose Find-Me 
setup specifies a cell phone, the cell phone can show who dialed the ShoreTel 
number. The applicable forwarding features are Find Me, some of the Call 
Handling Modes, PSTN Failover, Office Anywhere, Allow Additional Phones to 
Ring Simultaneously, and Extension Reassignment. This role for BTN is described 
under the next heading, Trunk Services, and in the "Purpose of the Billing 
Telephone Number for Caller ID" on page 175.

• Trunk Services: This area of the Outbound settings in the Trunk Groups editing 
window lets the system administrator configure the trunk group for the outbound 
trunk services described in subsequent bullet items. If an option is not enabled, the 
trunk group does not provide that service (unless the text states otherwise).

— Local—Select this check box to enable local calls.

— Long Distance—Select this check box to enable long-distance calls.

— National Mobile (not shown)— This check box only appears for PRI trunks in 
countries with “caller pays” billing plans (e.g. Ireland). Select this check box to 
allow users to call mobile numbers. Clear the checkbox if you do not want to incur 
the associated costs of allowing users to call mobile phones in “caller pays” 
environments.

— International—Select this check box to enable international calls.

— Enable Original Caller Information—This function enables the switch to forward 
an original caller’s ID when a received call is redirected by one of ShoreTel’s 
forwarding features. For example, if an outside caller dials a ShoreTel user whose 
Find-Me setup specifies a cell phone, the cell phone can show who dialed the 
ShoreTel number. The applicable forwarding features are Find Me, some of the Call 
Handling Modes, PSTN Failover, Office Anywhere, Allow Additional Phones to 
Ring Simultaneously, and Extension Reassignment.

This enable is a starting point for other steps that are necessary to transmit the 
original caller ID. For descriptions of the tasks that follow after Enable Original 
Caller Information is enabled, see the following:

• For details about forwarding the original caller ID, see the "Forwarding 
Original Caller ID Outside a ShoreTel Network" on page 174.

• For the class of service (COS) that a user must have to ensure that the 
forwarding of an outside call is permitted, see the "Classes of Service" on 
page 314.

• The function Send Incoming Caller ID must be enabled for call forwarding 
features such as Find-Me, External Assignment, and Allow Additional 
Phones. This enable is illustrated in Chapter 12, Configuring User 
Features. Refer to the description in Find Me and External Assignment 
subsection of the "Forwarding Original Caller ID Outside a ShoreTel 
Network" on page 174.

• To respond to carriers who do not validate the caller ID in a SETUP 
message for an original caller ID, see the "ISDN Profile for RNIE" on page 
187. This advanced (and rarely needed) task follows the tasks described in 
the "Forwarding Original Caller ID Outside a ShoreTel Network" on page 
174.

IMPORTANT: In ShoreTel Releases 11, 10.2, 10.1, and 10, the forwarding of the 
original caller ID to an outside device relied on custom dial plan elements from 
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ShoreTel TAC. If TAC implemented such a custom dial plan, TAC must remove the 
elements related to this function before the current capability can work. (This issue 
does not exist for customers whose new installation contains the present 
implementation described in this book.) If a system with such a dial plan is 
upgraded, problem behaviors related to call forwarding or original caller ID can 
show up. Some possible behaviors are:

• Forwarded calls go to the user’s voicemail instead of out the trunk.

• Forwarded calls are rejected by the carrier.

Upgraded customers who know or suspect that such a plan has been used should 
contact TAC for help. However, some customers might not know that a custom dial 
plan has been used for original caller ID and should, therefore, monitor the call 
forwarding and caller ID performance after an upgrade.

— n11 (for example, 411 or 611, but not 911—Select this check box to enable 
telephone service calls (for services such as directory assistance or repair service).

— 911—Select this check box to enable emergency 911 calls. To support 911 in the 
U.S., at least one trunk group per site must allow 911 calls. For a detailed 
description of 911 support, see Appendix , starting on page 595.

— Easy Recognizable Codes (ERC)—Click this check box to enable services such as 
toll-free dialing for easily recognized codes like 800, 888, or 900.

— Explicit Carrier Selection—Click this check box to specify a particular long-
distance carrier. The format of the access code is 1010xxx. An example is 1010811.

— Operator Assisted (for example, 0+)—Click this check box to enable the trunk 
group to dial the operator.

— Caller ID not blocked by default—Click this check box to pass Caller ID 
information by default on outbound calls. To block all calls, clear this option. In 
the United States, the user can override this option with Vertical Service Codes.

• Trunk Digit Manipulation: This parameter lets you control how the trunk group 
manipulates the telephone number before outpulsing the digits to the central office.

All North American numbers are converted into 1+10-digit format internally before 
being passed to the trunk group for digit manipulation.

— Remove leading 1 from 1+10D—Click this check box to drop the leading “1”. 
Dialing only ten digits is required by some long-distance service providers.

— Remove leading 1 for Local Area Codes (for all prefixes unless a specific local 
prefix list is provided below)—Click this check box to drop the leading “1” for the 
local area codes (Local and Additional Local). Dialing only ten digits for local area 
codes, particularly with overlay area codes, is required by some local service 
providers. If a local prefix list provided, the leading “1” is removed for the all 
entries in the list.

— Dial 7 digits for Local Area Code (for all prefixes unless a specific local prefix list 
is provided below)—Click this box to enable the trunk to dial numbers in the local 
area code with seven digits. Some local service providers require this enable.

If a local prefix list provided, seven digits are dialed for all entries in the list (Local 
Area Code only, not Additional Local Area Codes).

• Local Prefixes: Click the Go to Local Prefixes List link to view, add, or edit the local 
prefixes for the site. When a local prefix list is used, prefixes that are not in the prefix 
list are considered “long distance” and require a long distance trunk service. Local 
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prefixes can be importaed from a CSV file. For more information, see "Importing Local 
Prefixes" on page 162.

• Prepend this Dial Out Prefix: Select a prefix from the drop-down list. It is pre-pended 
to the dial-out string that results from the other rules. (The Dial Out Prefix is not 
applied to Off-System Extension calls.) A dial-out prefix is typically required when 
connecting to, and leveraging the trunks on, a legacy PBX.

• Off-System Extensions: Click Edit to add or edit extensions ranges that can be 
accessed through this trunk group. This is typically used for setting up a tie trunk to a 
legacy PBX and configuring coordinated extension dialing. See also "Escalation Profiles 
and Other Mailbox Options" on page 448.

The Dial Out Prefix and Digit Manipulation rules are not applied to Off-System 
Extensions.

• Translation Table: Specify the digit translation table that is used to strip one or more 
digits from calls between two systems with extensions of different lengths.

ShoreTel does not apply inbound digit treatment to digit strings beginning with a trunk 
access code (such as 9) as would occur in tie trunk configurations. Digit strings 
beginning with a trunk access code are routed according to the dial plan.

A user group named Account Codes Service is created for use by the Account Codes 
Service. It is not available for assignment to users but it may be edited.

7.2.2 Importing Local Prefixes
You can import or export local prefixes in CSV format. Local prefix lists can be purchased 
or obtained free from various web sites. 

To import local prefixes from a CSV file:

Step 1 Navigate to the Trunk Group profile for which you want to import local 
prefixes.

Step 2 Scroll to the Local Prefix section at the bottom of the page and click Go to 
Local Prefixes List. The Local Prefix page appears.

Step 3 Click Add New List. The Edit Local Prefix page appears as shown in Figure 7-
3.

Figure 7-3 Local Prefixes Edit Page
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Step 4 Click the Import button. The Import Local Prefixes dialog box appears as 
shown in Figure 7-4.

Figure 7-4 Local Prefixes Import Dialog Box

Step 5 In the field, enter the path and name of the CSV file that you want to import or 
click Browse to search for the file.

Step 6 Click Upload. The Local Prefixes edit page appears as shown in Figure 7-5.

Figure 7-5 Local Prefixes Edit Page, Populate

Step 7 Edit the list as needed. You can re-name the list and add, edit, or remove 
prefixes.

Step 8 Click Save. The list you created is now available from the Local Prefix drop-
down list.

7.2.3 Exporting a Local Prefix List
To export a local prefix list:

Step 1 Navigate to the Trunk Group profile that contains the list that you want to 
export.

Step 2 Scroll to the Local Prefix section at the bottom of the page and click Go to 
Local Prefixes List. The Local Prefix page appears as shown Figure 7-6.
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Figure 7-6 Populated Local Prefix List

Step 3 Click the list you want to export. The Local Prefixes edit page appears as 
shown in Figure 7-7.

Figure 7-7 Populate Edit Local Prefix Dialog Box

Step 4 Click the Export button. Your web browser opens the file in a new window. 

Step 5 Specify where you want the file and save it as a text file.

7.2.4 DID Ranges
Direct Inward Dialing (DID) is a feature offered by telephone companies for use with their 
customers' PBX systems, where the telephone company allocates a range of numbers to a 
customer's PBX. As calls are presented to the PBX, the number that the caller dialed is also 
given, allowing the PBX to route the call to the intended party.

A DID range is a list of consecutive (non-overlapping) DID numbers assigned to a Trunk 
Group. A DID number can be assigned to multiple trunk groups. 

Available DID numbers are DID numbers within a range that are not assigned to a user or 
entity within the context of that range. DID number availability within a range does not 
consider DNIS assignments. Numbers assigned as a DNIS number are still enumerated as 
available within a DID range; attempts to assign these DID numbers will be unsuccessful.

DID assignment field and range indication fields are listed on the User, Workgroup, Route 
Point, Menu, Hunt Group, and Bridged Call Appearance pages.
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7.2.4.1 Creating a DID Range
To set a DID range, click Edit DID Range from the appropriate Edit Trunk Group page to 
invoke the DID Range page as shown in Figure 7-8.

Figure 7-8 DID Range Page

For each block of DID numbers, enter the base phone number and the number of phone 
numbers supplied by that block in the appropriate fields, and click “Add this record.” 
When finished, click Save. You can configure multiple ranges per trunk group.

To view the currently configured DID Digit Map (Figure 7-9), click View DID Digit Map. 
From here, you can view pertinent information about each DID number in the ShoreTel 
system.

Figure 7-9 DID Digit Map

7.2.4.2 Assigning DID Numbers from a Range
DID assignment sections on Director pages consist of two parameters: DID Range and DID 
Number. Figure 7-10 displays these parameters on the Edit User page. Other affected pages 
are constructed similarly.
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Figure 7-10DID Parameters on Edit User Page

• The DID Range parameter displays the complete base phone number and trunk 
group name. 

— To authorize the user to use a DID number, select the checkbox located left of 
the DID Range text.

— Access the drop-down menu to specify the DID Range from which the entity’s 
DID number will be selected. Each DID Range corresponds to a trunk group 
and lists the number of available numbers, as shown in Figure 7-11.

Figure 7-11DID Range parameter – drop-down menu

• A link to the System Directory page is located right of the DID Range data entry field.

Administrators can assign a DID number by viewing the System Directory page to 
find an available DID number, then selecting the number from the drop-down list. 
Unassigned numbers within a DID range may not be available if the number is 
assigned as a DNIS in the same trunk group.
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• The DID Number parameter assigns the specified DID number to the entity. The 
prefix located left of the data entry field and the range located right of the data entry 
field are based on the selected DID Range.

7.2.5 Edit DNIS Digit Map
To edit the DNIS Digit Map, do the following:

Step 1 Navigate to the Trunk Group that you want to support DNIS.

Step 2 Click the Edit DNIS Map button. The DNIS Digit Map page appears (Figure 7-
12).

Figure 7-12DNIS Digit Map Edit Page

Step 3 In the Add this record field in the Received Digits column, type the DNIS 
number that the Telco sends.

Step 4 Do one of the following to specify the extension to which the DNIS is routed:

• To map the DNIS to an internal extension, click the Extension radio button 
and enter the extension you want to use in the Destination field. (You can 
click the Search button to view the list of available extensions.)

• To map the DNIS to an off-system extension, click the Off-System radio 
button, select the extension range that includes the extension you want to 
use, and enter the extension you want to use in the Destination field.

Step 5 To create an identifier for the map, type a description in the field in the Dialed 
Number column. The description can include up to 26 alpha and numeric 
characters. This description appears to call recipients and in call detailed 
reports (CDRs).

Step 6 Select a Destination extension by using the Search button and then click Add 
this record.

7.2.6 Additional Local Area Codes
To configure additional local area codes, click the associated button on the Trunk Group 
edit page. The Addition Local Area Codes dialog box appears (Figure 7-13).
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Figure 7-13Additional Local Area Codes Dialog

Click New to add a new additional local area code and Remove to delete one.

7.2.7 Nearby Area Codes
To configure nearby area codes, click the associated button on the Trunk Group edit page 
(see Figure 7-2 on page 157). The Nearby Area Codes dialog box appears as shown in 
Figure 7-14.

Figure 7-14Nearby Area Codes Dialog

Click New to add a nearby area code or Remove to delete one.

7.2.8 Prefix Exceptions
To configure the local prefixes list, click the link Go to Local Prefixes List located near the 
bottom of the Trunk Group edit page. The Local Prefixes dialog box is presented. 

If you click Delete, changes take place immediately.

To configure local prefixes, click “add new list” or an existing list to bring up the Local 
Prefixes dialog box as shown in Figure 7-15.
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Figure 7-15Local Prefixes Dialog Box

Changes take place when you click OK within the Local Prefixes dialog.

7.2.9 Off-System Extensions
If you are using off-system extensions, you can list them by clicking the Edit button on the 
Trunk Group edit page. Off-system extensions are typically used when setting up a tie 
trunk to a legacy PBX and configuring coordinated extension dialing. Also refer to Section 
13.3.1. Figure 7-16 shows the dialog boxes used to define ranges of extensions.
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Figure 7-16Configuring Off-System Extensions

7.2.10 Tandem Trunking
Tandem trunking treats digits on an incoming trunk call as a PSTN number. Received digits 
are tested against DNIS, DID, Extension, and Tandem Trunking, in that order. When 
Tandem Trunking is enabled, the number of digits from the CO may have no effect if the 
first digit(s) matches a Trunk Access Code. To define trunk access and call permissions, 
associate a user group with the tandem trunk group.

Any Dial In Prefix is pre-pended to each set of inbound digits. You can use DNIS/DID/
Extension matching with a Dial In Prefix.

When using NI-2 signaling on PRI trunks—for example in a tie trunk scenario—Caller ID 
name is also captured, when available, on all inbound calls. For outbound calls, the Caller 
ID name is delivered for calls that are made to off-system extensions, but not generally for 
all outbound calls.

Tandem calls are reported in the Trunk Detail and Trunk Summary reports, with incoming 
and outgoing legs reported according to the reports’ formats.

7.2.11 Centrex Flash
Centrex Flash can be programmed on a custom button so that a user can transfer a call to 
another number. When the user presses the custom button, a flash is generated on the 
current call, the central office presents dial tone, and the user can dial any PSTN number. 
When ring-back is heard, the user can hang up the handset to complete the transfer.

Note that the user is connected directly to the central office, so no access code is required, 
no permissions are checked, no account code is supported, and no CDR logging of the 
second call occurs.
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Centrex Flash is useful in branch offices or small office environments with a limited 
number of analog Centrex lines. If an external caller needs to be transferred to an external 
number, the two trunks will be cleared, instead of quickly busying out the trunks after a 
few transfers. In this manner, the feature reduces the number of physical trunks needed to 
transfer calls, since no trunks are in use after the transfer is completed.

Centrex transfer is supported only on analog loop-start trunks. If the call is not on an 
analog loop-start trunk, the operation will have no effect. The trunk on which the call 
exists must be configured on one of the following switches:

• ShoreTel Voice Switch 40/8

• ShoreTel Voice Switch 60/12

• ShoreTel Voice Switch 120/24

• ShoreTel Voice Switch-E1

• ShoreTel Voice Switch-T1

The feature replaces a trunk-to-trunk transfer in which two trunks are tied up for the 
duration of the call. The current call must be connected and also must be a two-party call.

For information on configuring Centrex Flash, please see the "Programmable IP Phone 
Buttons" on page 211.

7.2.12 Pause in Dialing – Trunk Access
The Pause in Dialing – Trunk Access feature allows the insertion of commas (,) into 
Prepend Dial Out prefix of a trunk group to specify one-second pause periods during the 
transmission of pulse digits. Pause periods are permitted in the following trunk group types 
that send digits as pulses:

• Analog Loop Start

• Digital Loop Start

• Digital Wink Start

Example: Assume the prepend dial-out prefix of an analog trunk group is “9,,”. When a 
user dials “914085551111”, the following pulse-digit sequence is transmitted on the trunk: 
“9<silence for two seconds>14085551111”.

Commas are permitted anywhere within the Prepend Dial Out Prefix.

Feature restrictions include:

• The pause cannot be used to insert account codes.

• Commas in Communicator dial strings are ignored,.

• Commas in dial strings sent by other TAPI applications are ignored.

To enter a dial pause for a specific trunk group, perform the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration -> Trunks -> Trunk Groups.

Step 3 Select the trunk group for which you want to introduce a dial pause. The Trunk 
Groups Edit page for the selected group opens, as shown in Figure 7-17.
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Figure 7-17Modifying the Prepend Dial Out Prefix Setting

Step 4 Enter the code in the Prepend Dial Out Prefix data entry field located near the 
bottom of the page.

Step 5 Press the Save button at the top of the page.

7.3 Individual Trunks
This section explains how to configure individual trunks once you have created the 
associated trunk groups as described in "Setting Up Trunks" on page 155. To create a trunk 
profile, do the following:

To invoke the Trunks by Group page, click Trunks from the navigation frame, and then 
click Individual Trunks. The Trunks by Group page appears, as shown in 
Figure 7-18.

Figure 7-18Trunks by Group Page
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To select a trunk group, select a site from the “Add new trunk at site” drop-down list, then 
select a trunk group from the “In trunk group” drop-down list, and click Go. The trunks 
belonging to the selected trunk group appear. The columns in the Trunks by Group page 
are as follows:

• Name: This is the name of an individual trunk in the group. Click an entry in the 
Name column to invoke the Trunks edit page to edit the individual trunk’s 
parameters.

• Group: This is the trunk group name. Click a group name to invoke the Trunk 
Group edit page and edit the trunk group’s parameters.

• Type: This ID can range from 1 - 6 and corresponds to the trunk type (e.g. analog 
DID, analog loop start, SIP, etc.)

• Site: This is the location of the trunk and can be the Headquarters location or one of 
the remote locations.

• Switch: This is the IP host name of the ShoreTel voice switch to which the individual 
trunk is connected.

• Port/Channel: This is the port number or channel to which the individual trunk is 
connected.

• SIP IP Address: This IP address only applies to SIP trunks and corresponds to the 
SIP end point device.

7.3.1 Add or Edit a Trunk
Whether you choose to add a new trunk or edit an existing trunk, the Trunks edit page 
appears.

7.3.1.1 Non SIP Trunk Parameters
The parameters on the Trunks edit page for non-SIP trunk shown in Figure 7-19 are 
described below.

Figure 7-19Trunks Edit Page

• Site: This is the name of the site at which the trunk and trunk group are located.

• Trunk Group: This is the name of the trunk group to which the trunk group belongs. 
You cannot change the name of the trunk group on this page.

• Name: This text-entry field lets you enter the name of the individual trunk.
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• Switch Channel: This drop-down list selects the channel to which this trunk 
connects.

• Jack #: This is the patch-panel jack number that is associated with the trunk’s switch 
port. This is an optional parameter.

7.3.1.2 SIP Trunk Parameters
This section describes the parameters in the Trunks edit page for SIP trunks (Figure 7-20).

Figure 7-20SIP Trunks Edit Page

• Site: This is the name of the site at which the trunk and trunk group are located.

• Trunk Group: This is the name of the trunk group to which the trunk group belongs. 
This field is informational and cannot be changed on this page.

• Name: This text-entry field lets you enter the name of the individual trunk.

• Switch: This drop-down list lets you select the switch to which this trunk connects.

• IP Address: The IP address of the switch.

7.4 Forwarding Original Caller ID Outside a ShoreTel 
Network
This section describes the configuration tasks for ensuring that the original caller ID goes 
out an ISDN trunk when a call to a ShoreTel phone is forwarded outside the ShoreTel 
deployment. This section applies to a trunk group regardless of the way that carriers and 
service providers (carriers for short) validate caller ID, but it also describes some of the 
operational behaviors related to forwarding the original caller ID and the different ways 
that carriers validate caller ID.

When a ShoreTel switch forwards a call out a trunk, the Q.931 SETUP message contains 
information about the original caller. However, the carriers are not uniform in the way they 
validate caller IDs and might not be clear to the ShoreTel customer. ShoreTel’s response to 
these differences are described in this section.

In general, this section focuses on:

• Enabling the Enable Original Caller Information function.
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• After Enable Original Caller Information is enabled on a trunk group, other capabilities 
are enabled or requirements activated (such as “Send Incoming Caller ID” in an 
individual user’s configuration).

• Reasons for using the Billing Telephone Number field for a trunk group.

7.4.1 When Carriers Validate the Caller ID
Many carriers validate the caller ID to ensure that the number is within the range of DID 
numbers that they have on record for the ShoreTel customer. If the number is outside the 
range, a carrier could reject the call but usually checks the redirecting number field to find 
a number within the DID range.

If a call enters a ShoreTel network and is then forwarded out an ISDN trunk to a remote 
device, the number of the forwarded caller can be outside the DID range on record. If the 
caller ID is outside the DID range, the carrier can check the content of the Redirecting 
Number Information Element (RNIE) to see if the number that forwarded the call is within 
the DID range. The redirecting number belongs to ShoreTel user whose phone forwarded 
(redirected) the original call. Therefore, the contents of the RNIE field can match the 
carrier’s records. The result is that the call is forwarded, and the far end device can display 
the ID of the original caller.

Although most carriers that verify the RNIE inevitably send the intended caller ID, some 
carriers automatically forward the RNIE contents instead of the original caller ID. In this 
situation, the original caller ID does not reach the outside terminating device.

7.4.2 When a Carrier Does Not Validate the Caller ID
Some carriers and service providers do not validate the caller ID, so they do not determine 
what to provide at the destination phone. Therefore, a ShoreTel user who is remote and 
wants to see the original caller ID might not see the caller ID even with the correct 
configuration on the ShoreTel Voice Switch. To address this uncertainty, ShoreTel supports 
an RNIE ISDN profile that determines what the carrier should display (even though the 
provider does not validate the caller ID). For a description of this mechanism, see the ISDN 
Profile for Redirecting Number Information Element section.

7.4.3 Purpose of the Billing Telephone Number for Caller ID
In general, the billing telephone number (BTN) is used by carriers for billing a ShoreTel 
customer. In contrast, a different role exists for the Billing Telephone Number field in the 
Trunk Group configuration. This field is not for billing purposes but rather for supporting 
an alternative to individual user DIDs when an alternate is needed. For example, for a 
switch to forward the original caller ID, the ShoreTel user who redirects the call outside 
must have a DID and a Caller ID entry (in the Individual Users edit window) that fit within 
the trunk group’s DID range. However, for a variety of reasons, a user might not have a DID 
or a number within the trunk’s DID range. For example, a ShoreTel user at a remote site 
would have a telephone number that is outside the range at the location of the server. In 
this case, the contents of the Billing Telephone Number field go in the RNIE space instead 
of that user’s DID number.

The Enable Original Caller Information checkbox and the Billing Telephone Number field 
are in the Trunk Groups page shown in Figure 7-21. The Billing Telephone Number field 
becomes active and is auto-filled with the base number of the trunk group’s DID range by 
default when the Enable Original Caller Information checkbox is marked.
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Figure 7-21Trunk Groups Editing Window

A Q.931 SETUP message contains information elements for the caller ID and a redirecting 
number. The carrier normally finds the caller ID to be within the DID range for the trunk. 
If the caller ID is outside the range, the provider checks the RNIE field to determine 
whether the number that redirected the call is within the DID range. If the ShoreTel user 
does not have a DID to serve as the caller ID, the Billing Telephone Number field in the 
Trunk Groups window can provide the redirecting number. This field can contain one of 
several types of phone numbers.
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The preferable order of values to have in the Billing Telephone Number field is as follows:

1. The first number in the trunk group’s DID range (the default).

2. The actual billing telephone number of the ShoreTel customer (and used by the 
carrier for billing purposes), typed into the field by the system administrator.

3. The CESID (if the trunk group is configure to support CESID).

The Billing Telephone Number field is activated and populated with the base number of the 
DID range when the Enable Original Caller Information function is enabled.

NOTE In Release 11.1, the Billing Telephone Number field was added to the Trunk 
Groups editing window. Some customers who upgrade might not know about this 
field. Regardless, the field is automatically populated with the base number of the 
DID range when the original caller ID function is enabled.

7.4.4 Important Issue with Early Implementations of Original 
Caller ID
This section can be skipped for new installations of Release 11.2, 12.1, 12.2, and so on, 
because the issue does not exist for new installations.

Before the current release, implementation of Original Called Information relied on a 
custom dial plan. When a ShoreTel deployment with this custom dial plan is upgraded to 
Release 11.2, 12.1, 12.2, and so on, the ShoreTel TAC must remove such a custom dial plan 
because it interferes with the current function.

Upgraded customers who know or suspect that such a plan has been used should contact 
TAC for help. However, some customers might not know that a custom dial plan has been 
used for original caller ID and should, therefore, monitor the call forwarding and caller ID 
performance after an upgrade.

If a system with such a dial plan is upgraded, problem behaviors related to call forwarding 
or original caller ID can show up. Some possible behaviors are:

• Forwarded calls go to the ShoreTel user’s voicemail instead of out the trunk.

• Forwarded calls are rejected by the carrier.

7.4.5 Enabling the Original Caller Information 
When the Enable Originating Caller Information box for a trunk group is marked, the 
function is enabled. To enable the function for forwarding original caller ID:

Step 1 Navigate to Administration–>Trunks–>Trunk Groups.

Step 2 Select an existing trunk group or create a new trunk group.

Step 3 Check the Enable Originating Caller Informatio check box under the Trunk 
Services heading ( Figure 7-21 on page 176). After this enable, the Billing 
Telephone Number text entry box becomes active and shows the base number 
of the DID range by default (if DID range has been configured).

Step 4 If necessary, type a value in the Billing Telephone Number field.

Step 5 Click Save as needed when other trunk group configuration steps are done.
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NOTE Users who should receive forwarded calls must belong to a user group 
with a class of service (COS) that supports the call forwarding features. 
Trunk-to-Trunk transfers and Allow External Call Forwarding and Find 
Me Destinations should be enabled for the COS the user has. For details, 
see the "Telephony Features Permissions" on page 315.

7.5 Introduction to ISDN Profiles
ISDN profiles let the system administrator specify functions that extend the normal 
capabilities of ShoreTel trunks. The additional capabilities are enabled in the ISDN profile 
by the specification of information elements (IEs). After its creation, the purpose-specific 
ISDN profile is applied as needed to one or more PRI T1, BRI, or PRI E1 trunk groups. 
ISDN profiles are advanced tools because their purpose is outside the normal use of a 
ShoreTel Voice Switch.

In the two-stage implementation process, a function-specific ISDN profile with one or more 
manually typed parameters first is created and subsequently applied to a trunk group.

Example applications of ISDN profiles are as follows:

• For WANs in which a carrier or service provider does not automatically add the CID 
name, a caller ID (CID) name can be added to outbound calls. For the detailed 
description of this function, see "Caller ID Name on T1-PRI Trunks" on page 178.

• In Europe, up to 25 digits for a SETUP can be required for ISDN BRI and PRI. To 
provide these digits, the ShoreTel switch normally passes 20 digits in the SETUP 
message but can add 5 digits when necessary. For a description of this capability, see 
"Specifying a 20-Digit SETUP Message for PRI or BRI" on page 185.

• To meet a requirement of compliance testing in Europe, an outbound call can carry the 
progress indicator value 8. This ISDN profile for this function should be applied on a 
trunk only during a period of compliance testing.

• In Europe, an ISDN profile can direct the switch to support ISDN channel negotiation 
by the central office (only for outbound calls from a ShoreTel switch in the current 
release).

7.6 Caller ID Name on T1-PRI Trunks
The function Caller ID Name on T1-PRI lets a ShoreTel Voice Switch add the user name to 
caller ID (CID) information in an outbound call. The new function is available on T1-PRI 
trunks but not BRI or E1-PRI trunks. 

Before Release 11.2, ShoreTel Voice Switch did not send the user’s name to carriers or 
service providers. Nevertheless, in the U.S., carriers and service providers could add the 
caller number and caller name (if the call originates on a ShoreTel Voice Switch).

NOTE Caller ID Name on T1-PRI is optional because most ShoreTel installations utilize 
the default state of ShoreTel’s underlying CID mechanism. Therefore, only certain 
installations need the functionality of Caller ID Name on T1-PRI. ShoreTel created 
this function specifically for non-U.S. customers whose carrier or service provider 
needs the support of Caller ID Name on T1-PRI. Whether this function is really 
needed can be determined through consultation with the carrier or service 
provider if the actual need is unclear.
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7.6.1 Caller ID Name with the Public Network
This section gives an overview of the current handling of Caller ID names in outbound and 
inbound calls.

7.6.1.1 Inbound
In North America, some carriers can provide a Caller ID (CID) name in addition to the CID 
number. In the current release, ShoreTel voice switches support CID name on T1 PRI 
trunks. A carrier or service provider can deliver the CID name by using either a display 
message or facility message method. The method depends on the protocol used, as follows:

• In a display message over NI-1 

• In a facility message over NI-2 

For CID name in an inbound call, ShoreTel switches support both methods at the same 
time, so no special configuration is required on a ShoreTel switch to accommodate the 
arrival of CID names.

7.6.1.2 Outbound
ShoreTel T1 voice switches can send a CID name in an outbound call by using either a 
display message or a facility message. However, in contrast to inbound calls with a CID 
name, all outbound calls are configured to use either the display message or facility 
message method. The choice of method for outbound calls must be specified in Director. 
Even as ShoreTel T1 voice switches support only NI-2 protocol, it is possible to create an 
ISDN profile for using NI-2 protocol and then specify either the display message or facility 
message method for outbound CID name delivery. The ISDN profile for this purpose is 
described in the ISDN Profiles section.

The message method must match the method expected by the carrier or service provider. 
For example, if a carrier uses NI-1, it might be possible to program NI-2 with the display 
method such that the carrier accepts the outbound CID name from the ShoreTel Voice 
Switch. 

The steps for selecting the message method and protocol are in the “Implementation” 
section. The implementation steps are for outbound calls only.

7.6.2 Caller ID Name on T1-PRI Background Details
This section contains additional details that readers should understand before going into 
the Implementation section.

Outside the U.S.—as in Canada, for example—the carrier or service provider might insert 
the geographic or metropolitan origin of the call as the CID name (“Coquitlam,” for 
example). However, to send the actual user name of the caller, some carriers or service 
providers outside the U.S. require the information provided by Caller ID Name on T1-PRI. 
Therefore, for customers in Canada and elsewhere who want a CID name to accompany the 
call, this function enables a ShoreTel Voice Switch to provide the CID name information.

7.6.2.1 Enabling the Outbound Caller ID
Some configuration steps for CID are common regardless of the carrier or service provider. 
These steps are independent of the Caller ID Name on T1-PRI function but are nevertheless 
included in the implementation steps. An example of such a mandatory step is the enable 
for sending CID on an outbound call. This enable is called Enable Outbound Calling Name 
and is located in the editing window for Switches > Primary. This enable is mandatory for 
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sending a name in the CID, but in some countries a carrier or service provider might 
require the additional configuration that is supplied by an ISDN profile configured 
specifically for the purpose of facilitating Caller ID Name on T1-PRI.

7.6.2.2 ISDN Profiles
For Caller ID Name on T1-PRI, a critical element is defined in an ISDN profile. Thereafter, 
the ISDN profile is applied to a trunk group. ISDN profiles are advanced tools that can be 
used to specify important information for a variety of features. In the case of Caller ID 
Name on T1-PRI, the ISDN profile specifies the means for sending the user name (if the 
carrier or service provider requires this support). The ISDN profile that might be needed 
for sending a user name is described in the implementation steps.

As has been emphasized, the customer must know what the carrier or service provider 
expects for the ISDN message method. However, even when the expected method is 
known, an administrator might have to perform a simple experiment to determine which of 
the two possible categories of each method is required. The following list shows the 
possible methods related to CID (see implementation steps for actual use):

CallerIDSendMethod=display

CallerIDSendMethod=displaypcc

CallerIDSendMethod=facility

CallerIDSendMethod=facilitypcc

The choice for using the “pcc” version of a method is not based on information that the 
carrier provides. For example, if a customer has settled on the display method 
(CallerIDSendMethod=display) in the ISDN profile and correctly applied the profile to the 
pertinent trunk group but the CID name is not received at the far end, then an alternative 
ISDN profile (with CallerIDSendMethod=displaypcc) must be applied to the trunk group. 
(After an ISDN profile is created, it must also be applied to the appropriate trunk groups, as 
described in the "Implementing Caller ID Name on T1-PRI" on page 180.)

7.6.2.3 Character Limit and Name Masking
The maximum number of characters that a CID name can support is 34. Although ShoreTel 
supports up to 34 characters, a carrier or service provider might truncate the CID name. It 
might, for example, pass only 16 or even 12 characters. This possibility is one of the 
reasons that customers must know the support provided across the cloud and consult as 
needed with the carrier or service provider. 

NOTE For reasons of privacy, the actual name can be masked by insertion of a generic 
label, as described in the Implementation section.

7.6.3 Implementing Caller ID Name on T1-PRI
In the configuration descriptions that follow, the first (and mandatory) step for enabling 
CID name is described. Actually, this step is necessary to enable CID name transmission 
from any ShoreTel environment. Subsequent sections describe how to specify and apply the 
ISDN profile with the display method in an environment that requires it for Caller ID Name 
on T1-PRI.

NOTE Before enabling the Caller ID Name on T1-PRI function, the administrator should 
have prior knowledge or else consult the customer’s carrier or service provider to 
determine how it delivers the CID name end-to-end and, therefore, whether the 
display method is required. (See also Creating and Applying an ISDN Profile for 
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CID Name.) Furthermore, although the ShoreTel Voice Switch sends the CID name 
when configured to do so, ShoreTel cannot guarantee the results at the far end. 
ShoreTel cannot guarantee that carriers or service providers deliver CID names at 
the far end or that they support overwriting of the user name with a user-specified 
word (described in the configuration steps). Also, in some cases, parameters on 
3rd-party gateways might require modification before the CID name can be 
delivered.

7.6.3.1 Enabling Outbound Calling Name
The first step for enabling the CID name is to enable the trunk for outbound calling name 
regardless of whether the network calls for an ISDN profile to activate Caller ID Name on 
T1-PRI:

Step 1 Navigate to Administration –> Switches –> Primary. The list of primary 
switches appears. Note the list of switches in the Name column.

Step 2 Click the name of the T1 ShoreTel Voice Switch with the PRI trunk that is to 
send the CID name. The Edit ShoreGear T1 Switch window opens (Figure 7-
22). The switch in this example is Canada PRI T1 - B.

Figure 7-22Enabling Outbound Calling Name

Step 3 Select ISDN User in the Protocol Type drop-down list.

Step 4 Select NI-2 in the Central Office Type drop-down list.

Step 5 Mark the Enable Outbound Calling Name checkbox. This checkbox is just 
above the area labeled Layer 1.
ShoreTel 12.2 181



System Administration Guide Chapter 7: Configuring Trunks
7.6.4 Creating and Applying an ISDN Profile for CID Name
This section defines the ISDN profile for Caller ID Name on T1-PRI and describes how to 
apply the ISDN profile to a T1-PRI trunk.

7.6.4.1 Synopsis
In most deployments, the default ISDN system profile is already part of the configuration, 
and the default ISDN system profile has already been associated with the trunk group. If a 
new ISDN profile is required, the following tasks are involved and are described in their 
own subsection:

• Creating an ISDN profile for Caller ID Name on T1-PRI

• Associating the ISDN profile with a trunk group

The ISDN profile for Caller ID Name on T1-PRI specifies a method for delivering a CID 
name to the carrier or service provider. In all deployments, the default facility method is 
enabled, but for some WANs, the display, displaypcc, or facilitypss method is required. To 
use one of these latter message methods, a new ISDN profile must be created.

7.6.4.2 Specifying the Display Method in the ISDN Profile
To meet the interoperability requirements for CID name as needed in some environments, 
the system administrator creates an ISDN profile that specifies one of two display methods 
for sending CID names. (If the need for the display method is not a certainty, readers 
should refer to ISDN Profiles and other conceptual descriptions of the CID Name on T1-
PRI function in this section.)

The name for a new ISDN profile must differ from the default profile name 
SystemISDNTrunk. (Figure 2 shows the default ISDN system profile.)

The system administrator subsequently associates the new profile with a trunk group in the 
Edit PRI Trunk Group window, as described in the section Enabling Caller ID Name and 
the ISDN Profile on a Trunk Group.

7.6.4.3 Specifying an ISDN Profile for the Display Method
To specify a new ISDN profile for CID name:

Step 1 Log into ShoreTel Director.

Step 2 Click Administration > Trunks > ISDN Profiles to open the ISDN Profiles page 
shown in Figure 7-23.

Figure 7-23ISDN Profiles Window in Director
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Step 3 Click New to open Edit ISDN Trunk Profile, as shown in Figure 7-24.

Figure 7-24Default ISDN Profile

Step 4 In the Name field, type the name that you want to use for this ISDN profile. You 
cannot use the name “SystemISDNTrunk.”

Step 5 Check the Enable checkbox.

Step 6 In the Custom Parameters area, type the following:

CallerIDSendMethod=display (or displaypcc, as needed)

Step 7 Click Save.

The next task is to associate the ISDN profile with one or more T1-PRI trunks.

7.6.4.4 Enabling Caller ID Name and the ISDN Profile on a Trunk Group
If an ISDN profile with the facilitypcc, display, or displaypcc method exists, the system 
administrator associates it with a correct T1-PRI trunk, as described in this section. Not 
shown here is how the system administrator configures the PRI trunk group in a manner 
that is similar to other PRI trunk groups (but in this case, an ISDN profile is associated with 
the trunk).

At the bottom of the Edit PRI Trunk Group window, the administrator enables (or disables) 
the caller ID function by checking (or unchecking) the Enable Caller ID box. 

Many companies might choose to hide the personal name of the caller and instead insert 
the company name. As the following steps show, a text box associated with CID name lets 
the system administrator specify a label to overwrite all outbound CID names (and thus 
mask the call initiator’s name). The behavior is as follows:

• If the administrator checks the Enable Caller ID box and leaves the ‘Overwrite Caller 
ID with’ field empty, the caller’s name goes to the carrier or service provider.
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• If the administrator checks the Enable Caller ID box and types text in the ‘Overwrite 
Caller ID with’ field, that text is presented to the carrier or service provider. 

To configure a PRI trunk group to present the CID to the service provider:

Step 1 Log onto ShoreTel Director.

Step 2 Click Administration > Trunk Groups. The Trunk Group pages shown in 
Figure 7-25.

Figure 7-25Trunk Groups

Step 3 Select a PRI trunk group by clicking on the trunk group name. The Edit PRI 
Trunk Group page shown in Figure 7-26 opens.

Figure 7-26Selecting the ISDN Profile for CID in the Trunk Group Edit Page

Step 4 Select the appropriate ISDN Profile by using the Profile pull-down menu.

Step 5 At the bottom of the Outbound section of the Edit PRI Trunk Group, put a 
check in the Enable Caller ID checkbox. See Figure 7-27.
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Figure 7-27Enabling the Caller ID Feature

Step 6 (Optional) As needed, type a label for overwriting all individual caller names 
with this label in the CID display at the far end.

Step 7 Click the Save button at the top of the Edit PRI Trunk Group window.

7.7 Specifying a 20-Digit SETUP Message for PRI or 
BRI
In Europe, a SETUP message with up to 25 digits can be required for ISDN BRI and PRI 
trunks. To provide 25 digits when necessary, a ShoreTel Voice Switch adds 5 digits to the 20 
digits it normally sends in the U.S.

After the terminal equipment (TE) initially receives the SETUP ACK message from the 
network terminal (NT), the ShoreTel TE can send five digits to the network terminal in the 
subsequent INFO message if the situation requires those digits.

For the implementation of this messaging, the ShoreTel switch indicates when the extra 5 
digits are not needed (thus, a 25-digit SETUP message is the default). As the configuration 
steps illustrate, a message named Sending Complete indicates that the additional 5 digits 
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are not needed. Note that, by itself, the Sending Complete message does not directly pertain 
to the European requirement for 25-digits in a SETUP message. It just says that, for no 
specific reason, more digits are not required. This message is delivered in 1 of 2 ways:

• The Setup Complete message can go out after the SETUP ACK message arrives. This 
behavior is the default and does not involve an ISDN profile at all.

• The administrator can specify that Sending Complete goes inside the SETUP message.

To create an ISDN profile in Director that specifies the Sending Complete transmission:

Step 1 Click Administration > Trunks > ISDN Profiles in Director. As Figure 7-28 
shows, the ISDN Profiles window lists all existing ISDN profiles by name, the 
enable status of each profile, and a checkbox for selecting a profile.

Figure 7-28List of Existing ISDN Profiles

Step 2 Click the New button to start a new profile. The Edit ISDN Trunk Profile 
window opens, as shown in Figure 7-29.
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Figure 7-29Creating a New Profile for Sending Complete Message after SETUP ACK

Step 3 In the Name field, type a name for the profile.

NOTE The name of the default profile SystemISDNTrunk is reserved and cannot 
be used for new profiles. Put another way, the default ISDN profile cannot 
be modified.

Step 4 In the Custom Parameters area, type one of the following two strings:

OVLSendCmpWithSetup=yes

OVLSendCmpWithSetup=no

where yes means the Sending Complete message is carried in the SETUP message, 
and no means the Sending Complete message is transmitted by the ShoreTel Voice 
Switch after the switch receives the Setup Acknowledge message.

Step 5 Put a mark in the Enable checkbox to enable this profile.

Step 6 Click Save.

When ready to apply the ISDN profile to a trunk group, select the profile in the drop-down 
scroll list in the Trunk Group editing window for the targeted trunk group. After you click 
the Save button (after completing any other configuration steps), the ISDN profile applies 
to the trunk group.

7.8 ISDN Profile for RNIE
This section defines the ISDN profile for the Redirecting Number Information Element 
(RNIE) and describes how to apply it to a trunk group. This profile’s purpose is to ensure 
delivery of an original caller ID to a remote device when the carrier or service provider does 
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not validate the caller ID fields and, therefore, has no strategy for delivering the caller ID. 
Specifying RNIE ISDN profiles is an advanced task for a network scenario where the default 
state of the trunk group is not appropriate after original caller ID is enabled (as described in 
"Forwarding Original Caller ID Outside a ShoreTel Network" on page 174).

NOTE No consultation with the carrier is necessary for the use of an RNIE ISDN profile 
even though, in general, knowledge of how the carrier or service provider 
communicates at the trunk level is helpful.

7.8.1 Number Sequence in the Q.931 SETUP Message
The RNIE ISDN profile determines which of two possible sequences the ShoreTel Voice 
Switch places the caller ID and the RNIE in the outbound Q.931 SETUP message. The two 
sequences are simply the reverse of each other. The correct sequence depends on how the 
carrier processes the SETUP message. Rather than depending on operational information 
from the provider, the customer decides on which ISDN profile to use based on whether the 
original caller IDs are reaching the far-end destination after a call-forwarding feature sends 
the calls out an ISDN trunk.

After trying both sequences in the ISDN profiles, if the original caller ID does not reach the 
far-end device, the customer should ensure that the other configuration requirements of 
caller ID are correct. As described later in this section, even if the ShoreTel Voice Switch is 
correctly performing its task of forwarding the original caller ID outside the local network, 
conditions in the WAN might obstruct the successful arrival of caller ID at the destination.

The outbound Q.931 SETUP message has two caller ID fields, as follows:

• One number is the caller ID. This number is either of the following:

— The ShoreTel user’s DID or the contents of the Billing Telephone Number field 
when the user has dialed out

— The number of the outside caller who called the ShoreTel user and whose call was 
subsequently forwarded out the trunk

• The other number is the redirecting number—the ShoreTel number that forwarded the 
original call if call-forwarding was performed. (If the call is not forwarded, there is no 
redirecting information.) The redirecting number can be one of the following:

— The DID of the ShoreTel user who forwarded the call (if the user has a DID).

— When necessary, the contents of the Billing Telephone Number: this redirecting 
number can be the base number in a trunk’s DID range, the ShoreTel customer’s 
BTN, or the CESID. These alternatives to the DID are described in "Purpose of the 
Billing Telephone Number for Caller ID" on page 175.

NOTE If a carrier forwards an original caller ID to yet another provider, such as a 
CLEC, the subsequent provider might reject the call. This call rejection 
could be due to the subsequent provider utilizing the caller ID and RNIE 
in the opposite sequence of the first provider to transport the call. In this 
case, when the customer has determined that forwarded calls are being 
rejected at the far end and has consulted with ShoreTel TAC, an ISDN 
profile cannot help. The way to re-establish delivery of the forwarded 
calls through the CLEC—but without original caller ID—is to disable the 
Enable Original Caller Information until carriers and service providers 
find a way to interoperate in a way that ensures delivery of caller ID.
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NOTE Different carriers or carrier regions can use different call parameters. 
Therefore, we recommend that a unique ISDN profile be created for each 
trunk group.

7.8.2 Creating an RNIE ISDN Profile
An RNIE ISDN profile can have one of two lines that specify its effect. The line must be 
typed according to the following syntax:

SEND_BTN_AS_RNIE=<yes|no>

Default: SEND_BTN_AS_RNIE=yes

The meaning of the Yes/No selection is as follows:

SEND_BTN_AS_RNIE=no: The calling party number is presented with Billing 
Telephone Number (BTN). The caller ID is sent as the redirecting number (if “Enable 
Original Caller Information” is checked).

SEND_BTN_AS_RNIE=yes: The calling party number is presented with the caller ID. 
The contents of the Billing Telephone Number field is sent as the redirecting number (if 
“Enable Original Caller Information” is checked).

To create an RNIE ISDN profile:

Step 1 Click Administration >Trunks > ISDN Profiles (or SIP Profiles for the same 
functionality on SIP trunks).

Step 2 Click New at the top of the window (or the name of an existing profile as 
needed). See Figure 7-30.

Figure 7-30RNIE ISDN Profile
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Step 3 Type a name for a new RNIE ISDN profile, such as RNIE2. The name of the 
default profile (SystemISDNTrunk) cannot be used.

Step 4 Put a check in the Enable checkbox.

Step 5 Do one of the following:

• To specify that the switch presents the contents of the Billing Telephone 
Number field from the trunk group’s configuration, type the following string 
in the Custom Parameters field:

SEND_BTN_AS_RNIE=no

• To specify that the switch presents the caller ID, type the following string in 
the Custom Parameters field:

SEND_BTN_AS_RNIE=yes

NOTE This setting is also the default state of the trunk group.

Step 6 Click Save when each profile is done.

When the time comes to apply the profile to a trunk group, select the profile’s name 
in the Trunk Groups editing window (near the top of the window) for the selected 
trunk group.
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C H A P T E R 8

Configuring IP Phones

This chapter describes configuring IP phones. The topics include:

• "Overview" on page 191

• "System Settings – IP Phones" on page 191

• "Viewing and Editing IP Phones on the System" on page 201

• "Feature Settings – IP Phones" on page 204

• "Malicious Call Trace" on page 218

• "VPN Phone" on page 221

• "Simultaneous Ringing and Call Move" on page 229

8.1 Overview
ShoreTel supports IP phones connected through ShoreTel Voice Switches. Before you can 
add IP phone users through ShoreTel Director, you must:

• Set the boot parameters in the individual IP phones if you are using static IP 
addresses. For more information, see your ShoreTel 12: Planning and Installation 
Guide.

• Add and configure all ShoreTel Voice Switches that will be supporting IP phones. For 
information on allocating switch ports to IP phone support, see Chapter 5: 
Configuring Switches starting on page 89.

For more information on these steps, see the instructions given in the ShoreTel 12: 
Planning and Installation Guide. When you have completed the installation process, the 
ShoreTel system automatically detects IP phones connected to the network.

Click the IP Phones link in the navigation frame to expand and display additional links, as 
shown in Figure 8-1.

8.2 System Settings – IP Phones

8.2.1 Setting IP Address Ranges
If a system includes more than one site (Headquarters), you must define an IP address 
range for ShoreTel IP Phones at each site in the system. To set ranges for each site ensures 
that new added phones are associated with the correct site. 

ShoreTel Converged Conferencing uses IP phone ports to support conference call ports. 
Include the capacity of any ShoreTel Converged Conference Bridges in the IP address range 
calculations.
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You can review all the IP phones in the system from the IP Phone List page (see "Viewing 
IP Phones" on page 202). You can also view IP phones by the switch supporting them from 
the IP Phone Maintenance page. For more information, see Chapter 19: ChapName on 
page 537.

To set the IP address range, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > IP Phones Address Map. The IP Address 
Map List page appears as shown in Figure 8-1. The page lists the sites and 
associated IP address ranges.

Figure 8-1 IP Address Map List Page

Step 3 Click the New button. The Site IP Address Range edit page appears as shown in 
Figure 8-2.

Figure 8-2 Site IP Address Range Edit Page

Step 4 In the Site field, select the site for which you want to configure the IP address 
range.

Step 5 In the Low IP Address field, enter the lowest IP address that you want to use for 
the site. The IP Address must be valid for the network in which the site is 
located. 
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Step 6 In the High IP Address field, enter the highest IP address that you want to use 
for the site. The IP address must be valid for the network in which the site is 
located.

Step 7 In the Caller’s Emergency Service Identification (CESID) field, type the Caller 
ID number that the system passes to emergency responders when an 
emergency call originates on an IP phone at the site. See A, starting on 
page595, for information about configuring a system for emergency calls.

Step 8 Check the Teleworkers check box if teleworkers will use the site.

Step 9 Click Save. The information for the site is listed on the IP Phone Address page.

8.2.1.1 About Teleworking IP Phones
Improved support for teleworking IP phones does not require a dedicated site and ShoreTel 
switch for the best codec selection and correct bandwidth management. IP phones that fall 
into the IP address ranges for any teleworking IP phones operate just as other IP phones 
with a few differences:

• The inter-site voice codec will be used for all calls to and from teleworking IP 
phones.

• For bandwidth management purposes, the teleworking IP phone is not associated 
with any site and calls to and from that phone will not deduct from the available 
bandwidth of the call agent switch for that phone.

• The IP phone will be hosted by an available call agent switch at the site associated 
with the IP address map. Numbers dialed from teleworking IP phones will be 
interpreted in the context of the dial plan for the site associated with the IP address 
map.

8.2.2 Setting IP Phone Options
To set IP phone options such as passwords and configuration switches, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Options. The IP Phone Options page 
appears as shown in Figure 8-3.

Figure 8-3 IP Phones Options Edit Page
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The parameters on the IP Phone Options edit page are defined as follows:

• IP Phone Configuration Switch 1 and IP Phone Configuration Switch 2: You need 
to designate the switch that serves as the phone’s Communicator. This switch must 
be managed by the headquarters server. The IP addresses of these switches are 
downloaded to the IP phones whenever the IP phones are booted. These switches 
communicate with the ShoreTel server to determine which switch manages calls for a 
particular IP phone. You have the option of assigning two switches to this function, 
in case one switch fails. Every installation with IP phones must have at least one 
configuration switch.

To assign configuration switches, simply select an available switch from the drop-
down lists for configuration switches 1 and 2. In a new installation, the ShoreTel 
system automatically assigns the first two ShoreTel-120/24, ShoreTel-60/12, or 
ShoreTel-40/8 switches you configure as the configuration switches.

• User Group for Unassigned Phones: Unassigned IP phones are available for users 
configured for Any IP Phone. From the drop-down list, select the user group that has 
the call permissions you want unassigned IP phones to have.

• IP Phone Announcement: Enter a message of the day that displays on all IP phones 
except the ShoreTel IP Phone IP210 phones. The text can be up to 19 characters long 
and appears left-justified on the phone display. If you wish to center the message, 
add leading spaces. 

• IP Phone Password: This field is used only with ShoreTel IP Phones that require a 
password. It is initially set to “1234”. It may be blank or be 1 through 8 digits long. It 
sets the default password for new IP phones coming online. 

• Enable IP Phone Failover: When this box is checked, IP phones send a keep-alive 
message to their Communicator switch every four minutes. If a response is not 
received, the IP phone attempts to contact an alternate Communicator.

Changing the state of this field requires a reboot of all IP Phones. The process can 
take several minutes. Phones in the process of rebooting may drop calls.

Refer to "Failover – Call Continuation" on page 196 for information about IP Phone 
Failover

• Delay After Collecting Digits: This field represents the timeout period for 
transferring calls. Instead of having to press a soft key to initiate a call transfer, the 
desired operation will occur automatically at the expiration of a configurable timeout 
period. Once all of the necessary digits have been entered (which could vary based 
on the site's dialing plan), digit collection stops and the timeout period begins 
counting down. At the end of the countdown, which can be as short as one second, 
the call is transferred.

The following features will also be affected by this change:

— Conference

— Dialing from the Directory

— Intercom

— On-hook dialing

— Park

— Pickup

— Redial

— Transfer
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— UnPark

The timeout period can only be set once for the entire system. You cannot configure 
different timeout periods for different features or for different users. The timeout 
period cannot be configured via Communicator or the IP phone interface.

This automatic transfer behavior applies only to blind transfers. If a consultative 
transfer is placed, the call will remain in the call stack until the far end answers.

8.2.3 LLDP-MED and IEEE 802.1x Support
The Link Layer Discovery Protocol-Media Endpoint Discovery (LLDP-MED) is an 
enhancement to the Link Layer Discovery Protocol (LLDP) that addresses the following:

• Device location discovery to support location databases and VoIP E911 services.

• Auto-discovery of LAN policies to support to “plug and play” networking. 

• Extended and automated power management of PoE endpoints. 

• Inventory management

A component of IEEE 802.1 group of networking protocols, 802.1x addresses port-based 
Network Access Control. It provides an authentication mechanism for devices attaching to 
a LAN port to either establish a point-to-point connection or prevent the device from 
accessing the port if authentication fails. 802.1x is based on the Extensible Authentication 
Protocol (EAP).

8.2.3.1 Implementing LLDP-MED
ShoreTel implements LLDP-MED implementation through the following:

• ShoreTel IP Phone parameter: LldpEnable

LldpEnable is a ShoreTel IP Phone parameter that consists of one ASCII character. 
Valid settings for LldpEnable are 0 and 1:

— LldpEnable = 1 (LLDP is enabled)

— LldpEnable = 0 (LLDP is disabled)

Default value is 1 (enabled)

• Modify Setup Source Preferences

When setting up ShoreTel IP Phones, parameter settings are obtained from the 
following sources, listed in order of highest to lowest precedence:

— Config File

— DHCP (if active)

— LLDP (if active)

— Setup Command

— Default values

Implementing LLDP-MED requires LLDP-MED capable network switches. ShoreTel IP 
Phones IP110 and IP210 do not support LLDP-MED.

8.2.3.2 Implementing IEEE 802.1x
ShoreTel IP Phones support 802.1x network authentication and enables 802.1x by default. 
Authentication requires the device to present an ID and password for the user. The default 
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SID (user ID) is the last 6 characters of the MAC address of the phone, but the password 
must be manually entered when the phone boots for the first time. The password is cached 
if authentication succeeds.

If 802.1x enabled on the phone and the network is not set up to handle the feature, the 
phone boots normally.

Upon an upgrade from another firmware version that supports 802.1x (3.3.x or 3.4.x), the 
previous settings (802.1x on/off, SID, password) are preserved. Upon an upgrade from 
another firmware version that does not support 802.1x (2.2, 2.3, 3.1, 3.2), Logical Link 
Discovery Protocol (LLDP) is turned on by default, and a default SID of the last 6 
characters of the MAC address are applied.

While 802.1x is enabled by default in ShoreTel 11 and higher, 802.1x might have been 
explicitly enabled in earlier releases through the ShoreTel IP Phone parameter 
802.1xEnable (a 1-character ASCII parameter). If 802.1x is enabled on the ShoreTel IP 
Phone and disabled on the network switch, the ShoreTel IP Phone never comes up.

Valid settings for 802.1xEnable are 0 and 1:

• 802.1xEnable = 1 (802.1 authentication is enabled).

• 802.1xEnable = 0 (802.1 authentication is disabled).

Default value is 0 (disabled).

NOTE ShoreTel IP Phones IP110 and IP210 do not support 802.1x.

8.2.4 Failover – Call Continuation
The IP Phone Calls Continue Through Failover feature maintains active calls through the 
normal completion of the call even when the Communicator switch handling the call 
becomes unavailable. IP Phone Calls Continue Through Failover is applicable to ShoreTel 
IP Phones, SIP extensions, and Conference Bridges. SoftPhone does not support 
continuation of calls through failover.

8.2.4.1 Failover Description
When a phone’s Communicator switch becomes unavailable during a call while IP Phone 
Failover is enabled, the phone goes through two failover stages:

• Pending Failover is the period between when the phone does not receive the 
expected acknowledgement signal from its Communicator switch until the time that 
an alternate switch is assigned to perform Communicator tasks for the phone. This 
period typically lasts between two to four minutes after the switch becomes 
unavailable.

• Failover is the period after the alternate switch is assigned to perform Communicator 
tasks for the phone.

IP Phone Failover is enabled on the IP Phones Options edit page, as described in "Setting 
IP Phone Options" on page 193.

When a phone enters the pending failover stage, calls in progress remain active. Call 
control options, including softkey operation, are unavailable during this time. Users cannot 
initiate new calls and the phone display remains frozen during pending failover.

When IP Phone Calls Continue Through Failover is not enabled, all active calls are 
dropped when the phone enters the failover stage. The phone then resumes normal 
operation, allowing the user to initiate or receive calls and perform call control actions on 
new calls.
196



Chapter 8: Configuring IP Phones System Administration Guide
When Opaline Calls Continue Through Failover is enabled, active calls are maintained 
through the beginning of the failover stage until the normal completion of the call. All 
pending failover restrictions remain in place after the phone enters the failover stage until 
calls maintained through Failover initiation are completed.

8.2.4.2 IP Phone Behavior during Failover
This section describes IP Phone Calls Continue through Failover behavior on supported 
devices and references the following switch and endpoint terms:

• Failed switch: The switch that became unavailable to trigger the failover process.

• New switch: The switch that replaces an unavailable switch in response to a failover.

• Local endpoint: An endpoint controlled by the failed switch during a failover.

• Remote endpoint: An endpoint controlled by the functioning switch during a 
failover.

ShoreTel IP Phone – Local Endpoint

During the Pending Failover stage, the telephone user interface (TUI) displays a No 
Service message until the phone is assigned to a new switch. Call control operations are not 
available on surviving calls. All inbound calls to the local endpoint are routed to the 
destination specified by the current Call Handling Mode

During the Failover stage, the TUI displays Failover Mode while surviving calls remain 
active. Pressing phone keys generates a No Service message on the TUI. Call control 
operations on surviving calls remain unavailable. All inbound calls to the local endpoint 
are routed to the destination specified by the current Call Handling Mode. After all 
surviving calls are concluded, the ShoreTel IP Phone returns to normal operation.

ShoreTel IP Phone – Remote Endpoint

ShoreTel IP Phones on remote endpoints during failover calls can hang up the call, place 
the call on hold, or retrieve the call from hold. All other softkey operations are unavailable 
for the duration of the call. The ShoreTel IP Phone continues displaying call information 
until the of the call. Call control operations on other calls remain available.

SIP Phones

This feature causes no changes to messages displayed by SIP devices. Failover procedures 
and restrictions are applicable to SIP phones. Call control operations initiated from SIP 
phones on failover calls are not available.

Trunk Behavior

ShoreTel only releases the trunk after the remote side goes on hook. System cleanup 
procedures, executed every two hours, release trunks that were left hanging.

8.2.5 Adding Individual IP Phone Users
There are two ways to add IP phone users to the system. The first method requires you to 
assign IP phones to each user, while the second uses the Any IP Phone feature to allow 
users to assign their own phone from their desktop and voice mail. Using the Any IP Phone 
method simplifies the setup of multiple new users. You can use either or both methods, 
depending on your specific installation.
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8.2.5.1 Adding Users with Any IP Phone
This section describes how to configure to use an IP phone. For information about creating 
users, see “Configuring Users” on page -313. To add an IP phone to a user profile:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 In the “Add new user at site” field, select the site where you want to add a new 
IP phone user.

Step 4 Click Go. The Edit User page appears as shown in Figure 8-4.
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Figure 8-4 Edit User Page
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Step 5 Scroll to the Primary Phone Port parameter and do the following:

• Click the IP Phones radio button.

• In the field, select the IP phone profile that you want this user to use.

• Click Save.

Step 6 Click Administration > Users > User Group. The User Groups page appears.

Step 7 Select a user group with a Class of Service telephony profile that allows 
extension reassignment. For more information about extension reassignments, 
see "Telephony Features Permissions" on page 315.

Step 8 Click Save.

NOTE You can use this profile to create other users. To do so, click Copy and 
repeat Step 5 through Step 8.

Instruct the users to log in to their voice mail from their desktop and follow the prompts. 
Each user’s extension will automatically be assigned to the IP phone he or she is using. 
Make sure that users know which phone they should initially use so that phones are not 
accidently assigned to the wrong users.

All IP Phones are assigned to the “Headquarters” site. When you assign a specific IP phone, 
the user belongs to the site where the IP phone is located. Only IP phones associated with 
the currently selected site appear in the IP phone drop-down list.

After users have logged into voice mail to assign their IP phones, you can view the IP 
phones and users from the IP Phone list page or the IP Phone Maintenance page. For 
information about editing user information, see “Configuring Users” on page -313.

8.2.5.2 Assigning IP Phones by User
You can also assign IP phones through the Edit User page, one user at a time. You can 
assign phones by specific IP addresses or assign users to Any IP Phone according to the 
user’s needs.

To assign an IP phone:

Step 1 Click Users > Individual Users from the navigation frame.

Step 2 In the Add New User at Site field, select the site for the new user. 

Step 3 Click Go. The Edit User page appears as shown in Figure 8-4 on page 199.

Step 4 In the Primary Phone Port section, click IP Phones and select the IP phone by 
IP address or select Any IP Phone. Only the IP phones in the current site are in 
the list.

Step 5 Complete the user profile as required. For information about user settings, see 
“Configuring Users” on page -313.

Step 6 Click Save.

8.2.6 Anonymous Telephones
Anonymous telephones provide flexibility to the ShoreTel system by making additional 
ports or IP phones available without assigning them to any particular user extension. When 
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configured as anonymous telephones, these ports and IP phones cannot receive calls but do 
have access to dial tone. If they have the proper Class of Service (CoS) permissions, users 
can assign their extensions to these phones via the telephone user interface. Once the port 
or IP phone is assigned an extension, it will receive calls to that extension until the user 
unassigns it. For more information on how to use the Extension Assignment feature, see 
the "Using Extension Assignment" on page 410.

The Anonymous Telephones page (Figure 8-5) lets you configure anonymous telephone 
ports and IP phones. Click the Anonymous Telephones edit page from under the expanded 
Users link in the navigation frame.

Figure 8-5 Anonymous Telephones Edit Page

The Anonymous Telephones page first lists any Vacated Telephones. A vacated telephone is 
a telephone that is configured as the home port or IP phone of a user on the system, but 
that user is currently assigned to another telephone and no other user is assigned to the 
vacated home phone.

Click Add This Record to add a new anonymous telephone port. Click Delete next to a 
record to delete an anonymous telephone port from the ShoreTel system. This also 
disconnects any calls that are in progress on the port. 

You can make multiple changes on the Anonymous Telephones page. You must click Save 
to save the changes. 

• Assigned User Group: This lets you select a user group that you assign to an 
anonymous telephone port. 

• Jack #: This is the name of the telephone jack associated with the vacated port. 
This is typically the physical telephone jack that the telephone plugs into.

• Switch: This is the switch that the vacated telephone port is associated with. It can 
be either an analog port or an IP phone.

• Port: This is the physical switch port number or IP phone MAC address that 
identifies the vacated telephone.

• Current User: This is the name of the user currently using the anonymous telephone 
port.

• Current Ext: This is the extension of the user currently using the anonymous 
telephone port or IP phone.

8.3 Viewing and Editing IP Phones on the System
To help you manage the IP phones, ShoreTel Director allows you to view and edit all IP 
phones on the system. Figure 8-6 shows the IP Phones list and edit pages.
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Figure 8-6 IP Phones List and Edit Pages

8.3.1 Viewing IP Phones
To view the IP phones on the system:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Individual IP Phones from the navigation 
frame.

Step 3 In the By Sites field, select the site that you want to view.

Step 4 In the By Switch field, select the switch you want to view from drop-down list.

Step 5 Click Find Now. The IP phones for the sites and switches you have selected are 
displayed.

IP phones can also be viewed from the maintenance pages of ShoreTel Director. For more 
information, see “Maintenance” on page -537.

8.3.2 Renaming IP Phones
You can change the name of an IP phone from the IP Phone List. By default, IP phones are 
listed by MAC address in the IP Phone List Name column. 

To change the name of an IP phone:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Individual IP Phones.

Step 3 In the By Sites field, select the site where the phone for which you want to 
change the name is located.
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Step 4 In the By Switches field, select the switch that the phone uses.

Step 5 Click Find Now. The IP phones that satisfy the parameters appear on the page.

Step 6 In the Name column, click the IP phone you want to re-name. The IP Info 
dialog box appears. 

Step 7 In the Name field, enter the name you want to use for the phone.

Step 8 Click Save.

8.3.3 Deleting an IP Phone
IP phones can be deleted from the system.

To delete an IP phone:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Individual IP Phones.

Step 3 In the By Sites field, select the site where the phone for which you want to 
change the name is located.

Step 4 In the By Switches field, select the switch that the phone uses.

Step 5 Click Find Now. The IP phones that satisfy the parameters appear on the page.

Step 6 Click the check box of the IP phone that you want to delete.

WARNING Make sure that you have the selected the correct phone and that no 
other phones are selected. 

Step 7 Click Delete. A dialog box requests confirmation.

Step 8 Click Yes to delete the phone. 

If you wish to add the IP phone back into the system, you must reboot the IP phone. 
It will be reconfigured during the boot process and become available again. For more 
information on IP phone configuration, see the ShoreTel 12: Planning and 
Installation Guide.

8.3.4 Moving an IP Phone
To move an IP phone to a destination switch on a remote site, the remote site must have an 
IP address range defined. You may not move an IP phone to a switch on a remote site if the 
IP address of the phone is not within the IP address range of the destination site. 

You can move an IP phone across switches at Headquarters without entering an IP address 
range for the Headquarters site. The IP address range restrictions are only for switches at 
remote sites.

To move an IP phone:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Individual IP Phones.
ShoreTel 12.2 203



System Administration Guide Chapter 8: Configuring IP Phones
Step 3 In the By Sites field, select the site where the phone for which you want to 
change the name is located.

Step 4 In the By Switches field, select the switch that the phone uses.

Step 5 Click Find Now. The IP phones that satisfy the parameters appear on the page.

Step 6 Click the check box of the IP phone you want to move.

Step 7 In the Move field, select the switch to which you want to move the phone.

Step 8 Click Move. A dialog box requests confirmation.

Step 9 Click Yes to move the phone. 

8.3.5 IP Phone State Display
The following list explains the states displayed by the IP phones:

• Available: Phone has no user assigned to it. Calls can be placed from the phone but it 
does not receive calls. The Caller ID is “Anonymous”.

• <User Name> <User Ext>: The phone is assigned to <User Name>.

• Anonymous: The assigned user has used the Extension Assignment feature. Calls 
can be placed from the phone but it does not receive calls. The Caller ID is 
“Anonymous.”

Another method by which it can become anonymous is if the administrator explicitly 
configures anonymous phones which do not have assigned users.

• Unavailable: The phone was once in the ShoreTel system but has been removed 
using Director. The phone has no dial tone and is not functional.

8.3.6 Displaying ShoreTel IP Phone Settings
You can display the phone’s current IP parameters setting by entering a key sequence from 
the phone’s keypad.

To display the phone’s IP parameter settings:

Step 1 Press the MUTE key followed by 4636# (INFO#). The phone will display the 
first two parameters.

Step 2 Press # to advance the display or * to exit. The phone will resume normal 
operation after the last parameter has been displayed.

8.3.7 Resetting the ShoreTel IP Phone

Phones are reset by a key sequence on the phone’s keypad. To reset the phone, a user 
presses the Mute key followed by 73738# (RESET#). The phone reboots.

8.4 Feature Settings – IP Phones
IP phones can be configured by individual phones types or by User Group settings. The 
following sections describe how to configure ring tones and wallpaper (displayed graphics) 
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for all phones of the same type. This section describes how to configure ringtones, 
wallpaper, and application settings on appropriate phones assoicated with specific user 
groups.

8.4.1 Custom Ring Tones
ShoreTel IP phones offer four different sets of ring tones, with each set consisting of one 
tone for internal calls and another for external calls. The user is free to select from the four 
tones as desired. However, in some densely populated work environments, four tones may 
not be enough for users to be able to distinguish the sound of their phone from that of their 
neighbors’ phones.

To help reduce confusion, most ShoreTel IP phones support the ability to load custom ring 
tones on an IP phone so that each user can have a unique ring tone.

One set consisting of two custom ring tones can be loaded onto each IP phone. This new 
set of tones displaces one of the existing sets of ShoreTel ring tones, as shown in Figure 8-7.

Figure 8-7 The 4th Set of ShoreTel ring Tones Is Replaced by the New Custom Tones

8.4.2 Loading Custom Ring Tones
Ring tones must be in waveform audio file format (WAV). ShoreTel does not offer custom 
ring tones, but numerous web sites offer free WAV downloads. After a set of custom ring 
tones has been selected, the system administrator downloads the tones to an IP phone by 
way of an FTP server. A list of relevant details for custom ringtones follows, and 
configuration steps follow this list.

• This feature is supported on all ShoreTel IP phones but is not supported on the 
Polycom IP100 phones.

• ShoreTel offers no tools for creating or managing the custom WAV files.

• Custom files must be loaded in WAV format only.

• The following formats are supported by the phone:

— μ-law: 8-bit, 8 kHz, 16 kHz, monaural
— -law: 8-bit, 8 kHz, 16 kHz, monaural
— 16-bit, 8 kHz, monaural -or- 16-bit, 16 kHz, monaural

• Two custom tones can be loaded on a phone. Their combined size must be less than 
750 KB.

• If a WAV file lasts less than six seconds, the phone loops the ring out to a six-second 
length before it repeats WAV file.
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To load a ring tone onto an IP phone:

Step 1 Identify the WAV files to use (by online search or by creating them manually). The 
files must reside on a server that is accessible to the IP phone by anonymous FTP. 
(This server does not have to be the same as the host of the configuration files.)

Step 2 Manually create a phone-specific configuration text file and store it in the same 
directory as the standard IP phone configuration files. The name of the phone-
specific file should contain the MAC address of the target phone for the ring tone. 
The MAC address can be found on the sticker on the back of the phone. (See the 
"Creating the Phone-Specific Configuration File" on page 206 for details.)

Alternatively, you can load the same pair of custom ring tones onto other IP phones 
at the same time, but all of the phones must be the same model (for example, all 
IP560g phones or all IP212k phones). This approach could cause ring tone 
confusion if the phones were concentrated in one area of a building.

Step 3 Reboot the phone so that it retrieves the information in the text file and the 
pointer to the WAV. At boot time, the phone indicates the success or failure of 
phone-specific configuration download and the WAV download.

8.4.2.1 Creating the Phone-Specific Configuration File
To create a phone-specific configuration file, two new configuration parameters, 
WaveRinger1 and WaveRinger2 can be inserted into a phone-specific configuration file. 
These parameters identify the name and location of the custom ring tones that the IP 
phone will download (via FTP) into the phone's RAM at boot time as shown in Table 8-1.

The name of the phone-specific configuration file should be as follows:

shore_aabbccddeeff.txt

where “aabbccddeeff” is the MAC address.

To load the same custom ring tone onto several IP phones at the same time, do not use the 
MAC address in the name of the file. Instead, use the custom configuration file for the 
phone type being deployed (e.g. S6 for an IP560). For example, the configuration file name 
for an IP560 phone would be: S6custom.txt

For example, to load one of the custom ring tones, you could replace L/r14 (i.e. Ring 4 
External) and L/r15 (i.e. Ring 4 Internal) with the name and location of the file containing 
the new custom ring tone as shown in Table 8-2.

Also note that it is possible to replace internal and external ring tones in separate sets (e.g. 
Ring 2 external and Ring 4 internal), but only one set of ring tones can be active at a time 

Table 8-1 WaveRinger1 and WaveRinger2 configuration parameters

WaveRinger1
WaveRinger2

Up to 64 ASCII 
Characters

Used to assign one Wave File to any of the ring 
tones defined in Table 2. The first value is the 
ring tone, and the second value is the location of 
the file on the FTP server.

Examples:
WaveRinger1 L/rg 192.168.0.20/audio/dave.wav
WaveRinger2 L/r1 192.168.0.20/audio/dave.wav
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so activating either set of ring tones will only activate only one of the custom rings tones at 
a time.

8.4.3 Customizing Color LCD Displays with Wallpaper
The ShoreTel 265 and 565g IP phone models offer color TFT-LCD color displays. One of 
the benefits of having a color display is the ability to download images of your choice onto 
the phone from a server and display the image as wallpaper.

8.4.3.1 Wallpaper File Specifications
The wallpaper is 320 by 240 pixels and uses an uncompressed 256-color.bmp file format. 
Each of the 256 colors is defined by a 24-bit RGB value. Bitmap files can be composed 
using MS Paint or any other editor that can create Paint-compatible files.

To create a graphic file that can be used as a wallpaper image:

Step 1 Open the image in Microsoft Paint.

Step 2 Click Image > Attributes. The Attributes dialog box appears.

Step 3 Verify the following parameters are set as follows and make the appropriate 
adjustments:

• Width = 320

• Height = 240

• Units = Pixels

• Colors = Colors

Step 4 Click OK to close the dialog box.

Step 5 Click File > Save As. The Save As dialog box appears.

Step 6 In the “Save as type” field, select 24-bit Bitmap (*.bmp;*.dib).

Step 7 In the File Name field, enter the name that you want to use for the file.

Step 8 Click Save.

Table 8-2 Ring Tones and Symbols

Ring tone Symbol

Standard - External ring L/rg

Standard - Internal ring L/r1

Ring 2 - External ring L/r10

Ring 2 - Internal ring L/r11

Ring 3 - External ring L/r12

Ring 3 - Internal ring L/r13

Ring 4 - External ring L/r14

Ring 4 - Internal ring L/r15
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8.4.3.2 Downloading the File to Several Color-Screen IP Phones
The wallpaper file that each IP phone displays is specified in configuration files located in 
the phone configuration directory on the Headquarters server. On standard ShoreTel 
installations, the phone configuration directory is C:\Inetpub\ftproot.

ShoreTel specifies one text file for each phone model that defines default characteristics for 
all phones of that model type on the system. You specify the default Wallpaper for phones 
of a specific model by adding a line to the corresponding configuration file.

To load a wallpaper image onto all system phones of an specific model:

Step 1 Save the wallpaper file on the headquarters (HQ) server in following directory: 
C:/Inetpub/ftproot

Step 2 Access the C:/Inetpub/ftproot directory on the HQ server.

Step 3 Open the customization file for the desired phone model:

• For IP 265, open s36custom.txt

• For IP 565g, open s6ccustom.txt

Step 4 Add the following line to the open file: Wallpaper2pixmap abc.bmp, entering 
the name of the wallpaper file in place of abc.bmp, then save and close the file.

For example, if the wallpaper file is name logo.bmp, then enter Wallpaper2pixmap 
logo.bmp.

Step 5 Open the configuration file for the desired phone model:

• IP 265: open shore_s36.txt 

• IP 565g: open shore_s6c.txt

Step 6 Verify that the file contains the one of the following lines

• IP 265: Include s36custom.txt. 

• IP 565g: Include s6ccustom.txt.

Add this line to the file if it is not present.

Step 7 Reset the phones.

Step 8 Verify that, when each phone reboots, they download and save the wallpaper 
file.

Step 9 Verify that each phone displays the new wallpaper file.

8.4.3.3 Downloading the File to a Single Color-Screen IP Phone
Individual configuration files override model default settings for individual IP phones. You 
can assign custom wallpaper files for individual IP phones by modifying the corresponding 
configuration file.

To load a wallpaper image onto a single phone:

Step 1 Save the wallpaper file on the HQ Server computer in following directory: C:/
Inetpub/ftproot.

Step 2 Access the C:/Inetpub/ftproot directory on the HQ Server.
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Step 3 Create a text file named shore_xxxxxx.txt, where xxxxxx is the MAC address 
of the phone. Use lower case text when naming the file.

The MAC address is a twelve digit number that uniquely identifies each 
individual device. This address is printed on the white bar code located on the 
bottom of the phone. 

Example: If the MAC address of an IP 565g is 00104907020C, then create a file 
named shore_00104907020c.txt

Step 4 Add a line in the open file with the following format: Wallpaper2pixmap 
abc.bmp, where abc.bmp is the name of the wallpaper file, then save and close 
the file. For example, if the wallpaper filename is logo.bmp, enter 
Wallpaper2pixmap logo.bmp.

Step 5 Reset the phone.

Step 6 Verify, while the phone reboots, that it downloads and saves the wallpaper file.

Step 7 Verify that the phone displays the wallpaper file

8.4.4 Setting Custom Phone Options for User Groups
ShoreTel 12 and later provide enhanced configuration options for configuring ringtones, 
wallpaper, and applications on appropriate phones used by User Groups. These phone 
settings allow phones like the ShoreTel IP 655 to be customized for given users.

Custom phone configurations for groups can be modified from the Users > User Groups 
menu in Director (see Figure 8-8).

Figure 8-8 Phone customization section of User Groups Edit menu
ShoreTel 12.2 209



System Administration Guide Chapter 8: Configuring IP Phones
To configure custom features for user groups, go to the Administration -> Users -> User 
Groups menu and select the desired user group for the options (or create a new group if 
desired).

The bottom third of the menu provides fields to configure applications for phones that can 
use them, such as the ShoreTel IP 655. These applications are referenced by entering a URL 
that invokes the appropriate application. Additionally, both the ringtones and wallpaper 
utilized by the phones can be configured from the appropriate fields on this menu.

8.4.5 Wireless Headset Hook Switch
A handset lifter is a device that can be used with phones that do not support the ability to 
place a call while the phone's handset is on-hook. The device is used in conjunction with a 
wireless headset worn by the user. When the user wishes to answer a call, she presses an 
activation button on the wireless headset which signals the handset-lifting device to 
manually lift the handset, thus generating dial tone and allowing the call to be placed. The 
small device attaches to the side of the phone and physically lifts the phone handset off-
hook and keeps it there for the duration of the call. 

As technology has advanced, many phone systems have eliminated the need for a physical 
handset lifter and have incorporated an electronic version of this device (i.e. electronic 
hook switch) into the phone design. Thus, the phone can be instructed to go off-hook 
electronically (as opposed to mechanically) in order to produce dial tone.

ShoreTel has incorporated the electronic handset-lifting functionality into various IP phone 
models (see below for a list of supported models). These ShoreTel IP phones work with the 
Plantronics CS50 wireless headset. Users who have purchased this supported headset 
model can answer or end calls by pressing the activation button on their headset when they 
hear their phone ring. If they are too far from their phone to hear it ring, the headset will 
generate an audible cue to announce incoming calls.

Details:

• This feature is currently supported on the following ShoreTel IP phone models:

— IP565g
— IP560g
— IP560 – Newer models support this feature while older IP560 models do not. 

(To see if your IP560 supports this feature, flip the phone and check the label 
with the model number. If the model number ends with a suffix of "-03" or 
higher, the phone will support this feature. If the suffix ends in "-01" or "-02" 
the feature is not supported.)

— IP265
— IP230
— IP212k

• Using this feature will defeat auto on-hook and off-hook behaviors.

• The feature is only supported in conjunction with Plantronics CS50 headsets.

To configure this feature in ShoreTel Director:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 Select the user for whom you want to set this feature. The Edit User page 
appears.
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Step 4 Click the Personal Options tab.

Step 5 Scroll down to Automatic Off-Hook Preference and click the Wireless Headset 
radio button.

Step 6 Click Save.

To configure this feature on an IP phone via the telephone interface:

Step 1 Press the Options button on the IP phone, followed by the associated password 
and the # key.

Step 2 Scroll to option 2: Auto Off-Hook.

Step 3 Press the Edit soft key to select this option.

Step 4 Scroll to option 3: Wireless Headset.

Step 5 Press the OK soft key to confirm.

Step 6 Press the Done soft key to confirm.

8.4.6 Programmable IP Phone Buttons
An administrator or user can change the functions associated with the ShoreTel IP Phone 
or B "Programmable IP Phone Buttons" on page 211 custom buttons. Users can create 
shortcuts for operations that would normally require pressing two or three buttons to 
accomplish the same task.

The action associated with the bottom button on an IP 530/560 could be configured to 
speed dial a particular extension or external number. The button above that could be set to 
perform overhead paging, and so on. All of the custom buttons are configurable except for 
the top-most button, which is permanently set to provide call appearance information (i.e. 
ringing indicator and call timer information).

Users can keep track of which actions they perform on a regular basis and then associate 
those actions with the custom buttons. Instead of having to dial a star code (such as *14 for 
picking up the Night Bell) they can just press one button. See Table 8-3 for supported 
functions.

Table 8-3 Supported Programmable Button Functions:

Function Parameter Comments

Agent Login None

Agent Logout None

Agent Wrap-Up None

Barge In Extension or none

Bridged Call 
Appearance

Extension or none

Call Appearance None Not supported on Button Box

Centrex Flash None Refer to Section 7.2.11 on page 170.

Change CHM Change Call Handling 
Monitor
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Change Default Audio 
Path

Audio Call Path

Conference Blind Extension or external 
number

Conference 
Consultative

Extension or external 
number

Conference Intercom Extension or none

Dial Mailbox Extension or none

Dial Number (Speed 
Dial)

Extension or external 
number

Group Pickup Extension

Hotline Extension

Intercom Extension or none

Monitor Extension Extension or none

Page None

Park Extension or none

Park and Page Extension or none

Pickup Extension or none

Pickup Night Bell None

Pickup/Unpark Extension or none Uses internal presence to determine 
which operation to perform

Record Call Mailbox Operates on selected call in connected; 
Pressing a second time stops the 
recording.

Call recordings can be saved in the 
mailbox of the initiating client (by 
leaving the mailbox field blank), or 
can be routed to an alternate mailbox 
by entering a mailbox number in the 
field.

Record Extension Extension or mailbox Call recordings can be saved in the 
mailbox of the initiating client (by 
leaving the mailbox field blank) or can 
be routed to an alternate mailbox by 
entering a mailbox number in the field.

Send Digits Over Call Extension

Silent Coach Extension

Silent Monitor Extension or none

Toggle Handsfree None

Table 8-3 Supported Programmable Button Functions:

Function Parameter Comments
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Details:

• After a function is assigned to a button, users can enter a label (up to five characters 
on multiline ShoreTel IP Phones and up to six characters on the IP 100 and BB24). 
The label appears on the LED display next to the custom button.

• The system administrator can configure the custom buttons via ShoreTel Director on 
behalf of a user, or he can enable permissions for an individual user so that the user 
can modify the custom buttons on his own IP phone via the telephone interface. 

• The programmable button feature is supported on the multiline models but is not 
supported on the IP 210.

8.4.6.1 Configuring Programmable Buttons via Director
To configure programmable buttons via ShoreTel Director, follow the procedure below:

Step 1 Launch ShoreTel Director.

Step 2 Click on the Administration > Users > Individual Users.

Step 3 Click the name of the user whose phone you want to modify.

Step 4 Click the Personal Options tab.

Step 5 Click the Program IP Phone Buttons link. The Program IP Phone Buttons page 
appears as one shown in Figure 8-9.

Transfer Blind Extension or external 
number

Transfer Consultative Extension or external 
number

Transfer Intercom Extension or none

Transfer to Mailbox Extension or none

Transfer Whisper Extension or none

Unpark Extension or none

Unused None

Whisper Page Extension or none

Whisper Page Mute None

Table 8-3 Supported Programmable Button Functions:

Function Parameter Comments
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Figure 8-9 Program IP Phone Buttons Page

Step 6 In the IP Phone Type field, select the type of phone the user is using.

Step 7 For each button # that you want to configure, do the following:

Step a In the first Function field, select the category that you want to use for this 
button.

Step b In the second field, select the action you would like to associate with a 
particular button. For information about the actions, see Table 8-3 on page 
211.

Step c In the Label field, enter a descriptive word to remind the user which 
function is associated with that button. This label can be up to five 
characters long for the multiline phones and up to six characters long for the 
IP 100 and BB24.The label will appear on the LED display adjacent to the 
button.

Step d When applicable, enter the appropriate information in the fields that appear 
in the Target section.

Certain functions do not require entering a destination, but other functions 
such as speed-dial or blind transfer can optionally take a destination. Some 
functions take only extensions and some take any type of phone number.

Step 8 Click Save.

8.4.6.2 Configuring a Hotline Button
A Hotline is a bi-directional ringdown circuit accessed through IP Phone or Communicator 
buttons. A hotline call is initiated by pressing the assigned button. Hotline calls can be 
configured as speed dial or intercom calls. To configure a hotline button, do the following:
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Step 1 Launch ShoreTel Director.

Step 2 Click on the Administration > Users > Individual Users.

Step 3 Click the name of the user whose phone you want to modify.

Step 4 Click the Personal Options tab.

Step 5 Click the Program IP Phone Buttons link. The Program IP Phone Buttons page 
appears as one shown in Figure 8-9 on page 214.

Step 6 In the IP Phone Type field, select the type of phone the user is using.

Step 7 Identify button # that you want to configure and do the following:

Step a In the first Function field, select the All or Telephony.

Step b In the second field, select Hotline.

Step c In the Label field, enter a descriptive word to remind the user which 
function is associated with that button. This label can be up to five 
characters long for the multiline phones and up to six characters long for the 
IP 100 and BB24.The label will appear on the LED display adjacent to the 
button.

Step d In the Extension field, enter the extension to which you want the call to 
connect.

Step e In the Call Action field, select the method you want to use for making the 
connection.

Step 8 Click Save.

8.4.6.3 Copying Programmable Buttons Configurations
The Copy IP Phone Buttons page allows a system administrator to copy the programmable 
button configuration from one use to another, thus reducing the tedious work of 
configuring IP phone buttons.

To copy the programmable button configuration from one user’s IP phone to another, 
follow the procedure below:

Step 1 Launch ShoreTel Director.

Step 2 Click on the Administration > Users link > Individual Users. The Individual 
Users page appears.

Step 3 Click on the name of the user whose IP phone you would like to modify. The 
Edit User page appears.

Step 4 Click the Personal Options tab.

Step 5 Locate the Program IP Phone Buttons link and click the Copy button. The 
Copy IP Phone Buttons dialogue box appears as shown in Figure 8-10.
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Figure 8-10 Copy IPPhone Buttons Dialog Box

Step 6 In the From User field, enter the name or extension of the party that you want 
the hotlink to call. You can enter the first letters or digits of the name or 
number of target party and click Search button to initiate search of the 
available users.

Step 7 In the Phone Type section, check appropriate phone option. The phone types 
must match, meaning that you cannot copy an IP110 button configuration to 
an IP230.

If both users have multiple phones on their desk (e.g. an IP560 phone with a 
BB24 button box), you can copy the button configuration for several devices 
simultaneously, assuming the other user also has an IP560 phone and a BB24 
button box). To do this, just select the appropriate Phone Type check boxes. In 
this manner, you could copy up to four button box configurations at once.

Step 8 Click Copy to duplicate the programmable button configuration from one user 
to another.

To enable a user (as opposed to a system administrator) to configure the programmable 
buttons on his or her ShoreTel IP Phone, follow the procedure below:

Step 1 Launch ShoreTel Director.

Step 2 Click on the Administration > Users link > Individual Users.

Step 3 Click the name of the user whose profile you would like to modify (enabling 
him to customize the buttons on his IP phone). The Edit User page appears.

Step 4 Click the Go to this User Group link. The User Groups page for the user group 
to which the user is associated appears.

Step 5 For COS - Telephony, click Go to this Class of Service. The Class of Service 
page appears as shown in Figure 8-11.
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Figure 8-11 COS Edit Telephony Features Page

Step 6 Enter a name for the Class of Service profile in the Name field (unless you are 
modifying an existing Class of Service profile for which you would like to 
preserve the existing name).

Step 7 Check the Allow Customization of IP Phone Buttons check box.

Step 8 Click the Save button to store your changes. 

Details:

• The default for new Class of Service (Telephony) profiles is to have this feature 
disabled, thus preventing users from modifying their own custom buttons.

• Once this Class of Service (Telephony) profile has been created, you can apply it to 
every person in the system that you would like to allow to change his or her custom 
buttons. 

To change the custom buttons on your ShoreTel IP Phone or BB24 via the telephone 
interface, follow the procedure below:

Step 1 Press the Options button on your IP phone and enter your password, followed 
by the # key.

Step 2 Scroll through the list to option 4: Program Buttons.

Step 3 Press the Edit soft key. 

Step 4 Press the custom button that you would like to modify. (If you are using the 
phone interface to modify the buttons on a BB24 device, press the button on 
the BB24 that you would like to configure.)
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Step 5 Scroll through the list of functions until you find the function that you would 
like to apply to this button.

Step 6 When you have highlighted the appropriate function, press the Next soft key.

Step 7 Enter an extension, external number, or leave it blank. Then, press the Next 
soft key.

Step 8 Press the 1 > Aa soft key to shift the key pad to alphabet mode.

Step 9 Use the key pad to enter a short descriptive word that will remind you of the 
new function of the custom button.

Step 10Press the Done soft key.

Step 11Press the Done soft key again to store your changes.

8.5 Malicious Call Trace
ShoreTel provides organizations with the ability to report a malicious call by requesting 
ShoreTel Communicator trace and record the source of the incoming call. Organizations 
deploying this release can provide their users with a method to initiate a sequence of events 
that will trace a call when they suspect that it has a malicious intent. 

The Malicious Call Trace (MCT) feature enables the ShoreTel phone user to identify the 
source of malicious calls. A user, who receives a malicious call from the PSTN via an ISDN 
trunk supporting MCT, can initiate a MCT on the ShoreTel phone by pressing a 
programmable button or entering a star code sequence or using the Communicator toolbar 
button.

8.5.1 Implementation
Once the user initiates the Malicious Call Trace process, the ShoreTel Windows Event Log 
is notified and the user receives an urgent email confirming the action along with an 
audible tone. The system provider is notified through the PSTN of the malicious nature of 
the call. This allows the system provider to take action, such as notifying legal authorities.   

NOTE Malicious Call Trace is an ISDN feature. It is implemented on BRI and PRI trunks 
to ISDN service providers supporting the feature. The ShoreTel implementation of 
MCT will support the ETSI standard configurable on switches supporting Euro-
ISDN. Trace information is not provided to or displayed by the ShoreTel user 
phones.

8.5.1.1 Configuring a Programmable Button in Director
To configure malicious call trace button in ShoreTel Director, follow the procedure below:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users.

Step 3 Click on the name of the user whose phone you want to modify.

Step 4 Click the Personal Options tab.
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Step 5 Click the Program IP Phone Buttons link. The Program IP Phone Buttons page 
appears as one shown in Figure 8-9 on page 214.

Step 6 In the IP Phone Type field, select the type of phone the user is using.

Step 7 Identify button # that you want to configure and do the following:

Step a In the first Function field, select the All or Telephony.

Step b In the second field, select Malicious Call Trace.

Step c In the Label field, enter a descriptive word to remind the user which 
function is associated with that button. This label can be up to five 
characters long for the multiline phones and up to six characters long for the 
IP 100 and BB24.The label will appear on the LED display adjacent to the 
button.

Step d In the Mailbox field, select the user mailbox to which you want to send the 
event logs.

Step e In the Call Action field, select the method you want to use for making the 
connection.

Step 8 Click Save.

8.5.1.2 Initiating a Malicious Call Trace with (*) Star Code
On a ShoreTel IP phone, SIP phone, analog phone, or Extension Assignment device the 
user needs to place the suspected malicious call on hold and then enter the MCT star code 
to start the tracing process. 

Example: The user receives an incoming malicious call. Using a ShoreTel IP phone, SIP 
phone, Analog phone or Extension Assignment device the user presses the hold button and 
then enters *21 to start the trace sequence. Once the trace sequence starts, a confirmation 
tone will be played prior to returning to the call to indicate that an MCT request has been 
initiated, an event is logged in Director, record call is attempted to the local extension's 
mailbox, and an urgent email is sent to the recipient of the call.

8.5.1.3 Initiating a Malicious Call Trace using a ShoreTel IP Programmable Button
On a ShoreTel IP phone, the user presses the IP Programmable Button to start the tracing 
process.

Example: The user receives an incoming malicious call. Using a ShoreTel IP phone with 
programmable keys, the user presses the programmable key which will start the trace 
sequence. Once the trace sequence starts, a confirmation tone will be played to indicate 
that an MCT request has been initiated, an event is logged in Director, record call is 
attempted to the configured extension's mailbox, and an urgent email is sent to the 
recipient of the call.

8.5.1.4 Initiating a Malicious Call Trace using the Communicator Toolbar Button.
Using Communicator, the user presses the Communicator Toolbar button to start the 
tracing process. 

Using Softphone, the user presses the IP Programmable Button to start the tracing process. 
The signal requesting MCT initiation is sent to the switch via TMS. 

NOTE Communicator will not support the initiation of MCT using the star code.
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Example: The user receives an incoming malicious call via Communicator or a softphone, 
the user can press the programmable toolbar key which will start the trace sequence. Once 
the trace sequence starts, a confirmation tone will be played to indicate that an MCT 
request has been initiated, an event is logged in Director, record call is attempted to the 
configured extension's mailbox, and an urgent email is sent to the recipient of the call.

Initiating a Malicious Call Trace using a ShoreTel IP Phone without Programmable Buttons 
or using Analog or SIP Phone

On a ShoreTel IP phone without programmable buttons or on Analog or SIP Phone, the 
user places the suspected incoming malicious call on hold then enters the MCT star code to 
start the tracing process. 

Example: The user receives an incoming malicious call. The user places the call on hold 
and then enters *21 to start the trace sequence. Once the trace sequence starts, a 
confirmation tone will be played prior to returning to the call to indicate that an MCT 
request has been initiated, an event is logged in Director, record call is attempted to the 
local extension's mailbox, and an urgent email is sent to the recipient of the call.

8.5.2 Important Considerations
When setting up your system, keep the following in mind:

• ShoreTel MCT feature will only work with carriers supporting ETSI standard EN 300 
130-1 V1.2.4.

• ShoreTel switches support the malicious call identification originating function 
(MCID-O) only. They do not support the malicious call identification terminating 
function (MCID-T). If the switch receives a notification from the network of a 
malicious call identification, it ignores the notification. 

• Supported only for incoming calls from the ISDN network. 

• Service provider must have MCID functionality enabled for the feature to work.

• ShoreTel ISDN interface on the ShoreTel E1/BRI switches must have the Protocol 
Type set to ISDN User with the Central Office Type set to Euro ISDN. When MCID is 
initiated on a SIP phone by putting a call on hold and initiating the star code *21 
sequence, after the successful initiation of the signal the previous call continues to be 
held. User needs to manually unhold the call. For ShoreTel IP Phones and analog 
phones, the held call is connected back after MCT initiation. 

• Malicious Call Trace confirmation tone is not given to SIP phone. SIP calls are not 
automatically taken off hold.

• Communicator and Softphone does not support initiation through the star code 
sequence.

• Mobile Communicator does not support the Malicious Call Trace feature.

• Malicious Call Trace confirmation tone signals an invocation attempt. It does not 
signal that the MCT request was successfully received at the connected network 
(CO). The MCT response is not processed by the ShoreTel ISDN stack. 

• Malicious Call Trace phone programmable button may configure a target mailbox for 
recording the call, but MCT initiated via star code will always be recorded to the 
initiating user’s mailbox (no way to specify target).

• Malicious Call Trace attempt can only be issued once per call.

• Malicious Call Trace invocation is only valid while the call is established.
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• Malicious Call Trace is not supported on conference calls created on a ShoreTel PBX.

• Intercommunication/Networking considerations. MCID caller info on calls between 
different networks is subject to agreement between the service providers.

8.6 VPN Phone
VPN Phone provides secure audio communications through open VPN SSL tunnels for 
remote IP phones using the ShoreTel system. To support VPN Phone, ShoreTel offers two 
VPN Concentrators capable of supporting up to 100 calls through VPN tunnels. The 
ShoreTel IP Phones VPN Phone supports include the IP655, IP565g, IP560g, and IP230g.

Terms

Secure Socket Layer (SSL): A cryptographic protocol that provide secure communications 
on the Internet. 

Point to Point Protocol (PPP): A data link protocol used to establish a direct connection 
between two nodes over serial cable, phone line, trunk line, cellular telephone, specialized 
radio links, or fiber optic links

Virtual Private Network (VPN): A computer network in which some internode links are 
facilitated via open connections or virtual circuits through a larger network instead of via 
physical wires. The link-layer protocols of the virtual network are said to be tunneled 
through the larger network. One common application is secure communications through 
the public Internet.

VPN Concentrator: A gateway that provides secure access to a corporate network for 
remote devices through VPN tunnels.

Stunnel: A multi-platform program that provide SSL tunnels between a remote device and a 
VPN gateway.

Tunnel: An link between two networks (such as LANs) that are connected by a larger 
network (such as a WAN or the Internet). Tunnel packets containing messages exchanged 
by the smaller networks are encapsulated into packets that facilitate routing through the 
larger network. Each VPN communication session establishes a tunnel, which is removed 
when the session is finished.

8.6.1 Functional Description

8.6.1.1 Feature Summary
VPN Phone provides secure audio communications for ShoreTel IP Phones located 
remotely from ShoreTel switches through open VPN SSL tunnels.

The feature includes an Open SSL VPN client in the ShoreTel IP phone and an Open SSL 
VPN Gateway. The Open SSL structure allows the traversal of firewalls implemented by 
many enterprises for blocking VPN tunnels.

8.6.1.2 Components
VPN Phone implementation requires two components – a VPN Concentrator and a 
ShoreTel IP Phone capable of communicating over a VPN
ShoreTel 12.2 221



System Administration Guide Chapter 8: Configuring IP Phones
VPN Concentrator

The SSL based VPN Concentrator enables remote ShoreTel IP Phones to establish secure 
voice communications with through the local ShoreTel PBX through SSL VPN tunnels. For 
every tunnel, a virtual PPP interface is created on VPN Concentrator and a peer PPP 
interface is created on the remote ShoreTel IP Phone. Signaling and media streams go 
through the PPP interface and are secured by SSL encryption.

ShoreTel offers two VPN Concentrator Models:

• VPN Concentrator 5300 – supports a capacity of 100 calls.

• VPN Concentrator 4500 – supports a capacity of 10 calls.

The VPN Concentrator 4500/5300 Installation and Configuration Guide provides 
additional information about the ShoreTel VPN Concentrators.

VPN Phone Licenses

ShoreTel licenses VPN Phone usage on a stunnel basis. Establishing a stunnel uses a 
license, which becomes available when the tunnel is discontinued.

ShoreTel IP Phone

Three ShoreTel IP Phone models support the VPN Phone feature:

• IP565g

• IP560g

• IP230g

8.6.1.3 Network Configuration
Figure 8-12 depicts the functional structure the ShoreTel implementation of a VPN 
network.

Figure 8-12 ShoreTel VPN Phone Implementation Architecture

The VPN Concentrator is located at ShoreTel’s Main Site, connected to the same LAN as 
local ShoreTel switches and the Main ShoreTel server. Refer to the VPN Concentrator 4500/
5300 Installation and Configuration Guide for specific deployment options based on the 
router and firewall configuration of the ShoreTel Network.
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8.6.1.4 Stunnel Establishment
Each remote device is assigned a user name and password that is recognized by the VPN 
Concentrator. Phone logging into the Concentrator are authenticated through the 
verification of its user name and password. When the phone is successfully authenticated, 
the Concentrator establishes a stunnel to that phone, after which it can receive and make 
phone calls through the ShoreTel system. The stunnel remains in place until the phone sets 
the VPN parameter to off or the Concentrator times out all stunnel connections.

Establishing a stunnel requires an available VPN phone license. If the number of active 
stunnels equals the number of available licenses, The VPN Concentrator will not establish 
new stunnels until an existing stunnel is disconnected.

8.6.1.5 Phone Calls
After a stunnel is established from the ShoreTel IP Phone to the Concentrator, VPN phone 
calls are performed from the ShoreTel IP Phone in the same manner as if the phone is 
located on same LAN as the VPN Concentrator. The VPN Concentrator manages the 
connection from the phone to the ShoreTel.

8.6.2 Implementation
Configuring VPN Phone comprises three steps:

• Installing the VPN Concentrator

• Configuring Director

• Configuring the ShoreTel IP Phone

The following sections describe the VPN Phone implementation process.

8.6.2.1 VPN Concentrator
Refer to the VPN Concentrator 4500/5300 Installation and Configuration Guide for 
instructions on physically inserting the VPN Concentrator into the network. The guide 
also describes web browser pages that configure the VPN concentrator. The following 
sections describe the pages and fields that require configuration.

Initial Configuration

The VPN Concentrator is shipped with the pre-configured IP address 192.168.1.1 for the 
LAN port.

To access the VPN Concentrator web interface pages, perform the following:

Step 1 Assign static IP address 192.168.1.2 with subnet 255.255.255.0 to the Ethernet 
interface of the computer that is connected to the LAN port.

Step 2 Launch a web browser on the PC and access the following URL:

• http://192.168.1.1.

The computer displays the login page shown in Figure 8-13.
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Figure 8-13 VPN Concentrator Login Page

Step 3 Enter the following parameter values to log into the system:

• Username – root 

• Password – default

Network Page

The Network page defines the IP address through which the VPN Concentrator is accessed. 
To access the Network page, select Network in the blue Configuration Menu on the left 
side of the page. Figure 8-14 displays the Network page.

Figure 8-14 Network Configuration Page

Enter the appropriate values in the following data entry fields:

• LAN Interface Settings: Enter the IP address by which other LAN devices will access 
the VPN Concentrator

• WAN Interface Settings: Enter the IP address by which remote devices can access the 
VPN Concentrator.
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Stunnel Page

The Stunnel page specifies setup characteristics about the Stunnels that facilitate 
communications between the concentrator and the remote phones. To access the Stunnel 
page, select Stunnel in the blue Configuration Menu on the left side of the page. Figure 8-
15 displays the Network page.

Figure 8-15 Stunnel Configuration Page

Verify that the following parameters are set as follows:

• Stunnel Enable is selected.

• Stunnel Server IP Address is set to the LAN address of the VPN Concentrator, as 
specified on the Network page.

• Stunnel Server Port Number is set to 443.

Route Page

The Route page defines the static routes to networks or servers on the LAN. To access the 
Route page as shown in Figure 8-16, select System > Route in the blue Configuration Menu 
on the left side of the page.
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Figure 8-16 Route Configuration Page

To add a static route, do the following:

Step 1 Enter the subnet address and mask in the IP Network and Netmask data fields, 
respectively.

Step 2 Enter the IP address that accesses the Gateway server of the added network.

Step 3 Press the Submit button.

Usernames’ List Page

The Username Configuration page defines the user accounts that are allowed Stunnel 
access to the VPN Concentrator. To access the Username’s List page as shown in Figure 8-
17, select Stunnel > Username Database in the blue Configuration Menu on the left side of 
the page.
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Figure 8-17 Username Configuration Page

To add a user account, perform the following:

Step 1 Enter the username and password for the user in the Username and Password 
data fields, respectively.

Step 2 Re-enter the password in the Confirm Password data entry field.

The Password and Confirm Password data entry field contents must be 
identical.

Step 3 Press the Submit button. 

8.6.2.2 ShoreTel Director
ShoreTel Director assigns codecs on the basis of the site assignment of the ShoreTel IP 
Phone’s IP address. Assigning the IP address block allocated to the VPN Concentrator to a 
specific site assures that the switch uses the proper codec when handling VPN Calls.

To assign an IP address block to a site, perform the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > IP Phone Address Map. The IP Phone 
Address Map List page appears.

Step 3 Click the New button. The IP Phone Address Map Info appears as shown in 
Figure 8-18.
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Figure 8-18 IP Phone Address Map Info Page

Step 4 In the Site Name field, select the VPN site.

Step 5 In the Low IP Address field, enter the lowest IP address of the block allocated 
to VPN calls. The IP address must be valid for the network where the site is 
located.

Step 6 In the Low IP Address field, enter the highest IP address of the block allocated 
to VPN calls.

Step 7 Press the Save button.

NOTE Refer to Table A-1 on page 603 for configuration recommendations for 
Emergency 911 related features on VPN phones.

8.6.2.3 Phones
ShoreTel IP Phones are manually configured to establish a stunnel with the VPN 
concentrator. After the phone is configured and placed on a WAN port (such as the 
internet) it attempts to communicate with the Concentrator. ShoreTel does not provide 
DHCP options for automatically setting these parameter values at startup.

The following parameters are manually configured on the ShoreTel IP Phone to perform 
VPN calls:

• VPN Gateway: This parameter specifies the WAN IP Address of the VPN 
Concentrator to which the ShoreTel IP Phone connects. Default value is 0.0.0.0.

• VPN Port: This parameter specifies the port number of the VPN Concentrator to 
which the ShoreTel IP Phone connects. Default value is 443.

• VPN: This parameter, when set to On, enables VPN Phone on the ShoreTel IP Phone. 
Default setting is Off.

• VPN User Prompt: This parameter, when set to On, programs the ShoreTel IP Phone 
to prompt the user for a VPN user name after completing a power cycle. 

• VPN Password Prompt: This parameter, when set to On, programs the ShoreTel IP 
Phone to prompt the user for a VPN password after completing a power cycle.

• FTP: This parameter specifies the IP Address of the RTP server from which the 
phone requests VPN Phone software upgrades. When set to the default value of 
0.0.0.0, the phone solicits upgrades from the IP Address of the VPN Gateway.
228



Chapter 8: Configuring IP Phones System Administration Guide
Manually Configuring a ShoreTel IP Phone

To configure the ShoreTel IP Phone IP phone, perform the following:

Step 1 Press the Mute button, then enter SETUP#

SETUP translates numerically to 73887

Step 2 Enter the phone’s password, followed by #.

Step 3 Press the # button to step through the phone options.

Configuring the User Name and Password

The user name and password is stored in non-volatile RAM on the phone. Power cycling 
and normal phone operations have no effect on the stored name and password. The VPN 
Concentrator authenticates the ShoreTel IP Phone when the phone attempts to establish a 
stunnel by verifying the phone’s username and password is included in the user accounts 
on the Usernames’ List page.

New ShoreTel IP Phones are shipped with this memory location vacant. The first time a 
user power cycles the phone with the VPN parameter set to On, the phone prompts the 
user for a username and password. The phone prompts for these values if the VPN User 
Prompt and VPN Password Prompt parameters are set to On; otherwise, the ShoreTel IP 
Phone continues using the previous memory contents when attempting to establish a 
stunnel.

8.7 Simultaneous Ringing and Call Move
Simultaneous ringing allows a ShoreTel user to ring up to 2 additional phones in addition 
to their assigned phone. The simultaneous ringing configuration is done through the user's 
Communicator interface or from their user page in ShoreTel Director. 

When the feature is configured, calls to the ShoreTel extension of the user ring the primary 
phone and all additional configured phones simultaneously. For convenience, the feature 
can be turned on and off to stop the simultaneous ringing at any time. 

Incoming calls to simultaneous ringing devices are presented as standard calls with 
standard ring tone. A ring delay can be configured for additional destinations which allows 
the preferred phone to ring first. 

After a simultaneous ringing call is established, the call may be moved between the 
simultaneous ringing devices. The Call Move mechanism can be initiated by a ShoreTel IP 
Phone softkey button, the Communicator call cell button, or a star code sequence (*23).

8.7.1 Implementing Simultaneous Ringing and Call Move
Administrators can enable the features through the Telephony Class of Service. Any 
ShoreTel User may be configured for Simultaneous Ringing. After a ShoreTel User is 
configured for Simultaneous Ringing, their extension becomes Preferred. This preferred 
user can be configured as a standard system extension, external Extension Assignment, 
SoftPhone, VPN phone, SIP phone, or Analog phone.

The process for configuring Simultaneous Ringing and Call Move is described in the next 
sections.
ShoreTel 12.2 229



System Administration Guide Chapter 8: Configuring IP Phones
8.7.1.1 Modifying Class of Service
In order for the user to be able to configure Simultaneous Ringing of their phones, the 
Administrator must first modify the default Class of Service in order to enable the user. To 
modify the Class of Service, follow these steps:

Step 1 Log onto ShoreTel Director.

Step 2 Click Administration > Users > Class of Service.

Step 3 In the Telephony Features Permissions section, select an existing feature to 
modify or click Add New to create a new Class of Service. The Edit Telephony 
Features Permissions page appears.

Step 4 Check the Allow External Call Forwarding and Find Me Destinations check 
box as shown in Figure 8-19. and option.

Figure 8-19 Class of Service - Edit Telephony Feature Permissions

Step 5 Check the Allow Additional Phones to Ring and Move Calls check box.

Step 6 In the Scope section, click the radio button to specify the type of calls on which 
you want to allow users of this class of service to use these features.

Step 7 Click Save to save your configuration.

8.7.1.2 Configuring Users
To configure users for simultaneous ringing, follow these steps:

Step 1 Log into ShoreTel Director.

Step 2 Click the Administration > Users > Individual Users. The Individual Users 
page appears.

Step 3 Select the user profile that you want to modify or create a new user.

Step 4 Click the Personal Options tab.

Step 5 Click External Assignment and Additional Phones. The Find Me, External 
Assignment and Additional Phones page as shown in Figure 8-20 appears.
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Figure 8-20 Find Me, External Assignment and Additional Phones Page
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Step 6 In the Additional Phones section, do the following to configure a first and 
second phone as required:

Step a In the Phone section, click a radio button to indicate the additional 
extension you want to ring as follows:

• None: No number.

• Extension: Enter or select a ShoreTel extension in the field.

• External: Enter the dialable number of an external phone in the field.

Step b In the Number of Rings field, enter the number of times you want the phone 
to ring before the call is rerouted.

Step c In the Activation field, select the method the user is to use to answer calls:

• Accept call by answering: Requires the user to remove the phone from 
the hook and speak.

• Accept call by pressing ‘1’: Requires the user to press 1 on the phone to 
signal that they are answering.

Step 7 Click Save to save your configuration.

8.7.1.3 Configuring Simultaneous Ringing through Communicator
Simultaneous Ringing and Call Move can be configured through the ShoreTel 
Communicator Options and Preference page. Users can access this page to configure the 
additional phones they want to use for simultaneous ringing. This will allow users to 
quickly turn Simultaneous Ringing On or Off as needed.

To configure Communicator to use this feature, follow these steps.

Step 1 Launch ShoreTel Communicator.

Step 2 Click Tools > Options. The Options and Preferences page appears.

Step 3 Click Addition Phones. The Additional Phones page appears as shown in 
Figure 8-21. 
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Figure 8-21 Options and Preference - Additional Phones Page

Step 4 Do the following to configure a first and second phone as required:

Step a In the Phone section, click a radio button to indicate the additional 
extension you want to ring as follows:

• None: No number.

• Extension: Enter or select a ShoreTel extension in the field.

• External: Enter the dialable number of an external phone in the field.

Step b In the Number of Rings field, enter the number of times you want the phone 
to ring before the call is rerouted.

Step c In the Activation section, click the radio button to specify the method you 
want to use to answer calls:

• Accept call by answering: Requires the user to remove the phone from 
the hook and speak.

• Accept call by pressing ‘1’: Requires the user to press 1 on the phone to 
signal that they are answering.

Step 5 Click Save to save your configuration.
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8.7.1.4 Disabling/Enabling Simultaneous Ringing
Users can enable or disable the simultaneous ringing functionality through their 
Communicator application and allow them to quickly turn simultaneous ringing on or off 
as needed.

To enable or disable simultaneous ringing, follow these steps:

Step 1 Launch ShoreTel Communicator.

Step 2 Click the ShoreTel logo. A drop-down menu appears.

Step 3 Highlight Additional Phones. A drop-down menu appears (see Figure 8-22).

Figure 8-22 Communicator - Additional Phones Page

Step 4 Do one of the following:

• Select Enable calling for...: Turn on this feature for the current call 
handling mode.

• Disable calling for...: Turn off this feature for the current call handling 
mode.

The status of the ShoreTel extension changes immediately.

8.7.2 Using Call Move
The ShoreTel system supports call move. Call move allows users to switch from one phone 
device to another without disrupting the conversation. For instance, if you attend a 
conference call, you easily move your call from your desk phone to your cell phone and go, 
without disrupting the conference.

Call Move from an IP Phone or Communicator

The user sees two behaviors while moving a call:

• When the call is on the assigned phone and the user presses MOVE or uses the Move 
Call Action from Communicator, the call goes on hold. Simultaneous ringing on idle 
phone(s) lasts until the user picks up one the phone. Until the user picks up the call, 
the caller hears silence.
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• When the call is on one of the Additional Phones and you press MOVE on the 
assigned phone or use the Move Call action from Communicator, the conversation is 
immediately switched to the assigned phone

— The preferred phone pushes the softkey Move or Move Call action from 
Communicator button to move the call to an Additional Phone. NOTE: 
Preferred phone will not ring.

— Additional destination phones will start ringing with no ring delay.

— Ringing on Additional phones will stop after the call is answered by an 
Additional phone.

— When additional answers, Call is Moved to Additional destination.

8.7.2.1 Call Move Using Star Code on a Mobile Phone

• Dial *23 (at the dial tone).

• Your simultaneous ringing- idle- phone(s) will ring until you pick one of them.

• Until then, the caller will hear silence.

• Additional destinations will ring.

• When the call is answered on the additional phone, the call is moved to new device.

8.7.2.2 Call Move Cancellation

• Unhold the call or execute *23 code again.

• If the Cancel is successful, the call is retrieved.

8.7.2.3 Other Considerations

• Only SIP extension type phones can be configured as an additional device.

• If a conference call is in progress Call Move operation is not allowed.

• Call Move pull functionality is not supported from additional destinations.

• Call Move push functionality is not supported on SIP trunks only if they support 
DTMF signaling using SIP INFO.

• Call Move pull functionality is not supported from Communicator.

• The only supported star code sequences from additional destinations is *23.

• Communicator only displays calls on assigned phone.

• Call Move or Simultaneous Ringing on/off is not supported from ShoreTel Mobile 
Communicator.

• When OSE is configured as additional phone, care should be taken to make sure the 
call is directly placed to OSE and not AA.

• When cell phone is configured as additional phone, care should be taken to set the 
activation mode to 'answer by pressing 1' so that when the call is redirected to cell 
phone VM, other simultaneous ringing destinations do not stop ringing.

• If the preferred user is a work group agent, WrapUp softkey will be presented in 
place of AddOn/ AddOff softkey. However if the user receives a personal call (not a 
WorkGroup/ Contact Center call) then MOVE softkey will be presented.
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C H A P T E R 9

Setting Call Control Options

This chapter provides information about configuring the system-wide call control features 
of the ShoreTel system. The topics include:

• "Account Codes" on page 237

• "Multi-site Account Codes" on page 240

• "Bridged Call Appearances" on page 245

• "Bridged Call Appearance Conferencing" on page 250

• "Shared Call Appearance" on page 256

• "Silent Coach" on page 265

• "Hunt Groups" on page 272

• "Paging Groups" on page 276

• "Multi-site Paging Groups" on page 278

• "Priority Group Paging" on page 281

• "Pickup Groups" on page 283

• "Route Points" on page 286

• "Call Control Options" on page 290

• "Bandwidth Management and Codec Negotiation" on page 293

• "Automatic Ringdown" on page 300

• "Media Encryption" on page 310

9.1 Account Codes
Account codes are typically used to assist ShoreTel users in the billing of their clients. For 
example, if a law firm wants to keep track of the length of calls to their clients so that they 
may later bill those client for services rendered, they can enter an account code that 
corresponds to that client before dialing the client's phone number. At the end of the call, 
the call length, time, and date are entered in a record, thus helping the firm to keep track of 
the calls made to each of their clients.

Account Codes can vary in length and be flexibly formatted. You can configure the system 
to require users to enter an account code for outbound calls in a mandatory or optional 
fashion. In this way, the account code can also function to prevent unauthorized employees 
from dialing long-distance numbers.

ShoreTel supports wildcard characters in account codes. This enhancement allows the 
system to surpass the previous limit of 50,000 account codes so that an almost unlimited 
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number of account codes can be supported. The wildcard character – a question mark – 
can be entered in place of DTMF digits in the account code.

The use of wildcards introduces less strict validation of the account code entered by the 
user. Rather than checking each individual code, a length check is performed instead. The 
introduction of wildcards into the account codes does not impact the ability of the system 
to assign an account code to individual clients.

You can create account codes with non-numeric characters, but these characters are 
discarded during code collection. The following table gives example account codes and 
shows how the Account Codes Service interprets the code.

Account code collection is enabled on the basis of user groups, with the collection of 
account codes set to be one of three states: 

• Disabled

• Optional

• Forced 

For information about account codes and User Groups, refer to Section 10.3.

Call Detail Reports include details of account codes associated with outbound calling. 
Account Codes are associated with a configurable extension and have a dedicated user 
group that defines ultimate call permissions and trunk group access. 

A new user group named “Account Codes Service” is created for use by the Account Codes 
Service. Since it is only intended for use by the Account Codes Service, this user group does 
not appear in drop-down lists for the assignment of User Groups to users and other objects 
such as workgroups. You can, however, change all attributes of the Account Codes Service 
User Group except the fields indicating whether Account Codes are disabled, optional, or 
required.

9.1.1 Account Code Collection
When account code collection is enabled or required for a user group, calls placed via the 
telephone or the Communicator are routed to the account code extension. The Account 
Codes Service prompts the user to enter an account code followed by the “#” key. If the 
account code entered does not match the digits in a stored account code, an explanation 
message is played and the user can enter an account code again. When a matching account 
code is collected, the call is placed according to the originally dialed number.

The call permissions define which dialed numbers will be directed to the Account Codes 
Service for user groups configured with account codes. For calls that are redirected to the 
account codes extension, the call will be completed with the trunk access and call 
permissions of the Account Codes Service. 

Table 9-1 Sample Account Codes

Sample Account Code Recorded Code

Sales 200 200

1001-3 10013

1.234A 1234

3000 Exec 2 3002
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This structure imposes two sets of permissions to outbound calls: 
1. The call permissions for the user group of the user that places the call are used to 

determine whether an account code must be collected or not. 

2. The call permissions for the Account Codes Service user group determines whether 
calls are finally placed or if the intercept tone is played.

Calls forwarded to external numbers are NOT subjected to account code restrictions. 
Forwarding calls to external numbers is controlled from the Class of Service settings. For 
more informations, see the "Classes of Service" on page 314. 

The Account Codes Service is associated with a system extension that is hosted on the 
SoftSwitch running on the headquarters (HQ) server only. If the HQ SoftSwitch is not 
reachable by the originating ShoreTel switch, the call will be handled according to the 
setting on the caller's user group. Specifically, during such a connectivity outage, calls 
placed by users who have optional account code collection will be automatically placed and 
calls placed by users who have forced account code collection will be automatically 
rejected.

If you have a ShoreTel Converged Conference solution installed, Account Codes can be set 
up for collaborative voice and data conferencing. Document sharing is a feature allowed in 
a 2-way or Make Me Conference call. Up to 20 documents can be dragged and dropped 
during the call. You can create associated project codes on the conference bridge for 
tracking purposes. Bridge project codes are not enforced.

9.1.2 Adding and Editing Account Codes
To configure the account code wildcard feature follow the procedure below:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Call Control > Account Codes. The Account Codes 
page appears as shown in Figure 9-1.

Figure 9-1 Account Codes Page

NOTE The Filter Account Code section lets you search for existing account code 
by name or account code. To search, enter the beginning string of the 
name or account code in the Name or Account Code field and click Find 
Now. To display the entire list, leave both fields blank and click Find Now.

Step 3 Click the New button. The Account Code Info dialog box opens (Figure 9-2).
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Figure 9-2 Account Code Info Dialog Box

Step 4 In the Name field, enter a name for the account code.

Step 5 In the Account Code field, enter an account code. 

Account codes can include up to 20 alpha-numeric characters and must include at 
least one digit. Digits are significant characters and may not be replicated as a 
particular string. For example, the system identifies 8888, p88q88, and 
abc8de8fg8hij8 as the same code: 8888. 

Step 6 Click Save to create the account. To create another account, click Next.

Account codes are enabled on the basis of user groups. For more information, see the "User 
Groups" on page 325.

9.2 Multi-site Account Codes
Many organizations need to track calls made to clients so that they can bill the clients for 
the time they spend on the call. The Multi-site Account Codes feature allows the ShoreTel 
Headquarters server, a Distributed Voicemail Server, or a ShoreTel Voicemail Switch to 
validate account codes. This feature benefits customers by distributing the processing of 
the account code validation load thus eliminating any single point of failure for account 
codes validation. Account Codes is an easy to use tool that helps businesses identify and 
invoice for client calls.

Account code validation is performed by the Headquarters server by default. Outbound 
external calls are redirected to the Headquarters server for account code validation. Once 
the account code is validated, the call is redirected to the originally dialed external number.

The Multi-site Account Codes feature adds the capability of allowing a Distributed 
Voicemail Server or ShoreTel Voicemail Switch to validate account codes. In addition, if the 
Distributed Voice Server or ShoreTel Voicemail Switch is unavailable, the Account Code 
validation will migrate to another ShoreTel Server or ShoreTel Voicemail Switch according 
the site hierarchy. This allows account code validation to be more reliable in a multi-site 
environment.
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9.2.1 Implementation

9.2.1.1 Configuring Multi-site Account Codes 
To successfully configure your ShoreTel system with Multi-site Account Codes, you must 
complete the following configuration activity:

• Change the System-wide Account Code Extension

• Change the Account Codes Local Extension for the Headquarters Server

• Add the Account Codes Local Extension to the Distributed Voicemail Server

• Add the Account Code Local Extension to the ShoreTel Voicemail Switch 

9.2.2 Usage
To use Account Codes, a person picks up the phone and dials an external number. The call 
is redirected to a ShoreTel Server or ShoreTel Voicemail Switch and they are prompted to 
enter an account code. The person enters the account code and presses the # key. If the user 
enters a valid account code, the call is recorded in the database and redirected to the 
external destination. Then ShoreTel system administrator can then run Account Code 
reports to show the time, date and length of the call.

If the person repeatedly dials an incorrect account code, and the ShoreTel system 
administrator has configured the callers User Group such that it is mandatory to enter an 
account code (Forced), the call will be dropped. 

If the person repeatedly dials an incorrect account code, and the ShoreTel system 
administrator has configured the callers User Group such that it is optional to enter an 
account code (Optional), the call will be proceed to the external number, but it will not be 
recorded in the database and made available to Account Code reports.

9.2.3 Configuring Multi-site Account Codes 

9.2.3.1 Changing the System-wide Account Code Extension
The System-wide Account Code Extension is populated by default when the ShoreTel 
software is installed on the Headquarters server. If the system-wide Account Code 
Extension conflicts with the existing customer dial plan, the administrator can change the 
Account Code Extension. 

To change the System-wide Account Code Extension, follow these steps:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameter > Systems Extensions. The System 
Extensions edit page appears as shown in Figure 9-3.
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Figure 9-3 System-wide Account Code Extension Page

Step 3 In the Account Code Extension field, change the extension.

Step 4 Click Save button to save your changes.

9.2.3.2 Changing the Account Code Local Extension for the Headquarters Server
The Account Code Local Extension is populated by default for the Headquarters Server 
only. 

To change the Account Code Local Extension for the Headquarters server, follow these 
steps:

Step 1 Log into ShoreTel Director.

Step 2 Click on the Administration > Applications Servers > HQ/DVS. The HQ/DVS 
Servers page appears.

Step 3 Select your headquarters server. The HQ/DVS Edit Servers page for the 
headquarters server appears as shown in Figure 9-4.
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Figure 9-4 HQ/DVS Edit Server Page for Headquarters Server

Step 4 In the Account Code Local Extension field, enter the account code that you 
want to use for the headquarters server.

9.2.3.3 Adding the Account Code Local Extension to the Distributed Voicemail 
Server
The Account Code Local Extension is not populated by default for Distributed Voicemail 
Servers (DVS). The administrator must manually enter the extension. 

To add the Account Code Local Extension to a Distributed Voicemail Server, follow these 
steps:

Step 1 Log into ShoreTel Director.

Step 2 Click on the Administration > Applications Servers > HQ/DVS. The HQ/DVS 
Servers page appears.

Step 3 Select the Distributed Voicemail Server to which you want to assign an account 
code. The HQ/DVS Edit Servers page for the DVS server appears similar to that 
shown in Figure 9-4 above.

Step 4 In the Account Code Local Extension field, enter the account code that you 
want to use for the DVS server.

Step 5 Click on the Save button to save your changes.
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9.2.3.4 Adding the Account Code Local Extension to the ShoreTel Voicemail 
Switch 
The Account Code Local Extension is not populated by default for Voicemail Switches. The 
administrator must manually enter the extension. To add the Account Code Local 
Extension for a ShoreTel Voicemail Switch, follow these steps:

Step 1 Log into ShoreTel Director.

Step 2 Click Platform Hardware > Voice Switches/Service Appliances > Primary. The 
Primary Voice Switches/Service Appliances page appears.

Step 3 Select a ShoreTel voicemail switch (50V or 90V) to which to add an account 
code local extension. The Edit Voice Switches page for the voice switch appears 
as shown in Figure 9-5.

 

Figure 9-5 Edit Voice Switch Page for Voicemail Switch
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Step 4 In the Account Code Local Extension field, enter an account code for local 
extensions.

Step 5 Click Save.

Additional Configuration Requirements 
Once the system has been configured to validate account codes, the ShoreTel system 
administrator must restrict the users call permissions so that outbound external calls are 
not permitted. 

9.3 Bridged Call Appearances
A Bridged Call Appearance (BCA) is an extension that is shared among multiple users. A 
BCA has an internal extension number and call stack depth. Each user with the same BCA 
sees the same BCA extension number, and the number of calls that can reside on that BCA 
is its call stack depth. The maximum BCA stack size is 24.

Some characteristics of a BCA are as follows:

• It does not require a license.

• It is assigned to a ShoreTel Voice Switch.

• It supports Call Handling Mode.

• It cannot be controlled by a schedule.

A user answers a BCA call by pressing a ShoreTel IP Phone button that is assigned to a BCA 
call stack position. Calls to a BCA occupy distinct call appearances and are identified by 
their position in the call stack. ShoreTel IP Phone buttons that answer calls are configured 
to handle calls to a specific call stack position of a BCA. A button can be programmed for 
each position in the call stack.

Example: The system administrator configures a BCA with an extension of 118 and a call 
stack depth of 3. The ShoreTel IP Phones of three users are configured to handle calls to 
the BCA as follows:

• User One has one button that answers calls from Stack Position #1.
• User Two has one button that answers calls from Stack Position #2.
• User Three has three buttons configured to answer BCA calls – the first button 

answers calls to Stack Position #1, the second button answers calls to Stack 
Position #2, and the third button answers calls to Stack Position #3.

The first incoming call to the BCA arrives on Stack Position #1. User Two cannot 
answer this call. A second call to the BCA will arrive on Stack Position #2 if the first call 
is still active. User One cannot answer that call. User Three is the only user that can 
answer calls that arrive on Stack Position #3.

When a call stack position on a BCA receives a call, the button on each phone configured 
for that stack position flashes orange to indicate an incoming call. When the call is 
answered, the LED on the phone of the person that answers it turns solid green while the 
other BCA stack buttons are red (without BCA conferencing) or orange (when BCA 
Conferencing has been enabled for the BCA).

A user places a call from a BCA by pressing a programmed ShoreTel IP Phone button. The 
LED on the outbound caller's phone becomes solid green, and the buttons associated with 
the BCA stack position on all other phones become solid red. If the call is placed on hold, 
the button LED for the applicable call stack position on all phones indicates a call on hold.
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Pressing the top-most BCA custom button for outbound calls does not necessarily access 
trunk 1. No one-to-one correlation exists between the custom buttons programmed for 
BCA extensions and a particular trunk. The system administrator can associate trunks with 
BCA extensions through a variety of approaches.

A caller ID number can be associated with a BCA. The following rules determine which 
caller ID number is displayed at the far end for an outbound BCA call:

• Outbound to an internal extension – the name and number of the user that initiated the 
BCA call is sent. If the user is a “private,” the caller ID is blank.

• Outbound to an external number – the system sends the first number in the following 
list that is available:

— Outbound caller ID number that is assigned to the BCA
— DID number assigned to the BCA 
— External identification or caller ID number of the user who initiates the BCA call

• Outbound to an external emergency number (such as 911) – the emergency 
identification or the user’s CESID number is sent.

The system can be configured to display the caller ID on inbound calls. It also can be 
configured to enable, disable, or delay inbound call ringing.

9.3.1 Switch Support for Bridged Call Appearances
ShoreGear one-rack unit (1-U) Half Width and 1-U Full Width voice switches support 
BCAs with the following limits:

• Up to 24 BCA extensions can be configured on a switch.

• Up to 128 BCA extensions (on other switches) can be monitored.

• A maximum of 32 phones can be configured to point to the same BCA extension.

9.3.2 Configuring BCA Parameters
To create a BCA profile:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Call Control > Bridged Call Appearances from the 
Main Menu. The Bridged Call Appearances List page appears as shown in 
Figure 9-6.

Figure 9-6 Bridge Call Appearance List Page

Step 3 Click New (or select an existing BCA profile to edit). The Edit Bridged Call 
Appearances page appears as shown in Figure 9-7.
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Figure 9-7 Edit Bridged Call Appearance Page

Step 4 Set the parameters for the BCA profile as described below:

• Name: This field specifies the label by which other Director panels and ShoreTel 
devices identify the BCA.

• Extension: This field specifies the extension on which the BCA receives a call.

• Backup Extension: This field specifies the extension that receives calls for the BCA 
when the switch that supports the BCA is out of service.

If another BCA serves as the Backup Extension, the two BCAs must be assigned to 
different switches.

• DID: This field specifies the DID number assigned to the BCA.

See to "DID Ranges" on page 164 for additional information about DID numbers and 
ranges.

• DNIS: This field specifies the DNIS information sent on outbound BCA calls.

• Outbound Caller ID: This field specifies the Caller ID number that the system sends on 
an outbound BCA call.
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• Include in System Dial by Name Directory: When this parameter is enabled, the BCA 
extension appears on a ShoreTel IP Phone display when the user presses the Directory 
button.

• Make Number Private: This parameter designates the BCA extension as Private. The 
Private setting is described in "Private Numbers" on page 409.

• Switch: This field specifies the ShoreTel Voice Switch to which the BCA is assigned.

• Call Stack Depth: This field specifies the number of calls that the BCA can 
simultaneously handle.

• No Answer Number of Rings: This field specifies the No Answer condition for a call to 
a BCA.

• Call Forward Destination: These fields specify the number that should receive 
inbound BCA calls that are not answered in either of the following situations:

—  Call Stack Full: This number receives calls that are unanswered when the BCA 
already has the number of calls specified by the call stack depth setting.

— No Answer: This number receives calls that are unanswered after the number of 
rings specified by the No Answer Number of Rings setting.

Step 5 Click Save to store your changes.

9.3.3 Configuring Answer Options on an IP Phone
This section describes how to configure BCA buttons. User answer BCA calls by pressing 
the green-flashing button. BCA button are buttons configured to answer calls at a specific 
stack position of a BCA extension.

NOTE IP Phone buttons can also be configured so that a BCA call is answered when the 
user lifts the handset or presses either the speaker or headset button.

Do the following to configure BCA buttons:

Step 1 Launch ShoreWare Director.

Step 2 Select Administration > Users > Individual Users from the Director menu. 
The Individual Users page appears.

Step 3 Select the user you want to configure with BCA capability. The Edit User page 
appears.

Step 4 Click the Personal Options tab.

Step 5 Click Program IP Phone Buttons. The Edit Custom Keys page appears as 
shown in Figure 9-8. 

NOTE You can also click the Copy button which allows you to use the phone 
button profile of another user to configure the current user.
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Figure 9-8 Edit Custom Keys Page

Step 6 In the IP Phone Type field, select the phone device that the user will use to 
answer calls.

Step 7 In the first function field, select All or Telephony.

Step 8 In the second function field, select Bridged Call Appearance. The Bridged Call 
Appearance options appears in the Target pane as shown in Figure 9-9.

Figure 9-9 BCA Parameters in Program IP Phone Button Page
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Step 9 Set the BCA IP phone button parameters as described below:

• Extension: This parameter identifies the BCA to which the button responds.

• Call Stack Position: This parameter specifies the individual calls to the BCA extension 
that the IP Phone Button can access.

• Ring Delay Before Alert: This parameter specifies the number of inaudible rings for an 
inbound call on the IP Phone before the ringing on the phone becomes audible. Valid 
settings include:

— None: No delay—starting with the first ring, the phone rings audibly.

— 1, 2, 3, or 4: The phone begins playing the audio alert after this number of rings.

— Don’t Ring: The phone never plays the audio alert.

• Show Caller ID on Monitored Extensions: This option specifies when the caller ID for 
the inbound call appears on the extension. Choices are Never, Only When Ringing, and 
Always. The Always choice means the caller ID remains during the conversation.

• Enable Auto-Answer when Alerting: When this option is selected, the Inbound BCA 
Call is answered when the user either presses the IP Phone button, takes the handset 
off-hook, presses the speaker button, presses the headset button, hook-flashes, or 
presses an unused Call Appearance button.

When this option is not selected, the inbound BCA call is answered when the user 
presses the IP Phone button programmed for the BCA or presses the Answer button.

• No Connected Call Action: These radio buttons programs the phone’s ringdown 
behavior. Refer to "Director Configuration Pages" on page 304 for more information 
about configuring Ringdown.

— Answer Only: Select this option to disable ringdown

— Dial Tone: Select this option to configure the phone as the recipient on a ringdown 
circuit.

— Dial Extension: Select this option to configure the button as the initiating end of a 
ringdown circuit when the recipient is an IP phone on the ShoreTel network.

— Dial External: Select this option to configure the button as the calling end of a 
ringdown circuit when the recipient is a device that is not on the ShoreTel network.

Step 10 Click Save.

9.4 Bridged Call Appearance Conferencing
This section describes BCA conferencing. BCA conferencing is available to regular BCA 
users and SCA users (and their assistants).

Bridged Call Appearances are set up to be private by default, so a BCA or SCA user with a 
call in progress cannot be joined by other BCA users on the same extension. However, the 
default setting can be changed to allow others to join, and an override on the phone lets the 
owner of the call lock or unlock the conference regardless of the default.

When a call is made to the BCA line, the flashing orange BCA button turns green when the 
user answers the BCA call. Other BCA users see either of the following on this line:

• A solid orange LED if conferencing is allowed by default: If the button is orange, the 
BCA user can press the button to join the BCA call in progress.
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• A solid red LED if conferencing is disallowed by default: If the button is red, users 
cannot join the active BCA call unless the owner of the call presses the Unlock 
button on his or her phone.

Figure 9-10 shows an outside call to a BCA line.

Figure 9-10  Call to a Bridged Call Appearance
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With permission, a BCA user can join the active BCA call by pressing the orange BCA 
button on the phone. Figure 9-11 shows that other BCA users have joined a BCA call. Note 
that in Figure 9-11, the caller directly connects to the original BCA users’ ShoreTEL IP 
Phone. The phone of each additional BCA user is transferred to a ShoreTel Voice Switch 
with available Make Me Conference ports that directly connects each additional BCA user.

9.4.1 Answering and Joining the BCA Call
When a call comes into an BCA line, the color of the BCA button indicates if the BCA call is 
ringing, has been answered, is private, or allows conferencing. When the BCA line is 
ringing, the BCA button programmed on each ShoreTel IP Phone shows a flashing green 
color. The first user that picks up the line sees a solid green button labeled for the BCA. 
Other users of the BCA see either an orange or red button. If the button is orange, press the 
button to attempt to join the call. If enough Make Me Conference ports are available and 
the maximum number of allowed conferenced parties has not been reached, the user will 
be added to the active bridged call. If the BCA button is red and the user presses the button, 
an error message on the phone display and will not be able to join the conference call.

Figure 9-11  Bridged Call Appearance - Conference Call
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9.4.2 Setting Up Conferencing Ability for BCA and SCA Users
The BCA conference parameters for either the SCA or regular BCA users are configured in 
the lower-left corner of the Edit Bridged Call Appearance window.

For the selected BCA user, the entire window is active. For an SCA user, only the 
conference area of the BCA edit window is activated. The reason is that BCA parameters for 
the SCA user are inherited from the SCA account. Therefore, the rest of the BCA 
configuration window remains inactive (grayed out).

9.4.2.1 Specifying the Settings for a Regular BCA User
This section describes how to enable conferencing for a regular BCA user. The 
configuration consists of the enable, default privacy setting, and the enable of a tone that 
sounds when another party joins the conference.

To override the default privacy setting for the current BCA call, press the Lock/Unlock 
softkey on the ShoreTel IP Phone (with the green LED). The text above the softkey 
describes the action to be applied to the active call. (The softkey text label is a toggle 
between Lock and Unlock.) For example, to make the call private, the user with the call 
should press the button labeled “Lock.” To make the call available for conferencing, the 
user presses when the button shows “Unlock.”

To configure a BCA to have the conferencing:

NOTE See "Configuring Answer Options on an IP Phone" on page 248 for more 
information on assigning the BCA to IP phone buttons.

Step 1 Log into ShoreTel Director.

Step 2 Click Administration > Call Control > Bridged Call Appearances.The Bridged 
Call Appearance List page shown in Figure 9-12 appears.

Step 3 Click the New button or click on an existing Bridged Call Appearance profile. 
The Edit Bridge Call Appearances page shown in Figure 9-13 appears.

Figure 9-12  Bridge Call Appearances List Page
ShoreTel 12.2 253



System Administration Guide Chapter 9: Setting Call Control Options
Figure 9-13 Edit Bridged Call Appearance 

Step 4 Click the Allow Bridged Conferencing check box to enable the BCA 
conference facility for an SCA user or regular BCA users.

Step 5 In the Default Privacy Setting section, do one of the following:

• Select the Other Parties Can't Join radio button to designate that privacy is 
initially enabled for active BCA calls. Other users of the BCA are restricted 
from joining the active call. This is the default behavior.

• Select the Other Parties Can Join radio button to designate that the privacy 
feature is not initially enabled for active BCA calls. Other users of the BCA 
are allowed to join the active call.

Step 6 Check the Provide Tone When Parties Join check box to have a tone sound 
when a party joins the BCA conference.

Step 7 Click Save.

Step 8 Assign the BCA to the appropriate ShoreTel IP Phones. See "Configuring 
Answer Options on an IP Phone" on page 248 for more information on 
assigning the BCA to IP phone buttons.
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Step 9 Configure the appropriate number of Make Me Conference ports on a ShoreTel 
Voice Switch that is available to the site. Refer to Switch Parameters for more 
information on configuring Make Me Conference ports.

9.4.2.2 Enabling the BCA Conference Ability for an SCA User
The Edit Bridge Conference Appearance page lets you:

• Enable the executive’s conference ability

• Set the privacy default (the default for permitting or locking out other users)

• Enable the join-in tone

The SCA user always owns the conference call and can decide when other BCA users are 
admitted to the conference. An SCA user can override the default privacy setting by 
toggling the Lock/Unlock sofkey.

To configure BCA conferencing for an SCA user:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Call Control > Bridge Call Appearances. The Bridged 
Called Appearances List page appears. Figure 9-14 shows a Bridged Called 
Appearances List that includes SCA users.

Figure 9-14 Bridge Call Appearance Page

SCA users are differentiated in the list using the format <first name>_<last 
name>_<extension>, where

• first name represents the first name of the user.

• last name represents the last name of the user.

• extension represents the user’s extension (for SCA or regular BCA user).

Step 3 Click on the SCA user name in the Name column. The Edit Bridged Call 
Appearance page in Figure 9-13 on page 254 appears.

Step 4 Check the Allow Bridged Conferencing check box. The default privacy choice 
and the enable for the join tone become activated.

Step 5 In the Default Privacy Setting section, do one of the following:
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• Select the Other Parties Can't Join radio button to designate that privacy is 
initially enabled for active BCA calls. Other users of the BCA are restricted 
from joining the active call. This is the default behavior.

• Select the Other Parties Can Join radio button to designate that the privacy 
feature is not initially enabled for active BCA calls. Other users of the BCA 
are allowed to join the active call.

Step 6 Check the Provide Tone When Parties Join check box to have a tone sound 
when a party joins the BCA conference.

Step 7 Click Save.

9.5 Shared Call Appearance
The Shared Call Appearance (SCA) feature provides call appearances that are shared 
between an executive (the SCA user) and an assistant (configured as a regular BCA user). 
The assistant can monitor the SCA user’s call appearances to facilitate call handling and 
conferencing needs. With SCA, an assistant can help an executive with his or her 
communication needs by making or answering calls on behalf of the executive and by 
setting up phone conferences. The assistant is not restricted to supporting an executive and 
can receive other telephony capabilities through configuration in the ShoreTel Director. 
(Configuration has the flexibility to support multiple executives and assistants for different 
call-handling arrangements.)

For telephone conferences, the SCA user and assistant have the following:

• BCA conferencing

• Blind conferencing

• Regular conferencing abilities that all IP phone users have

BCA conferencing lets an assistant or executive set up conference calls so that, when the 
executive is ready, he or she can enter the conference by pressing the SCA button on the IP 
phone. The assistant can stay in the conference, leave the conference, or be locked out of 
the conference by the executive.

SCA relies on BCA as an underlying technology to support its functionality. All IP phone 
models except IP210, IP115, and IP110 support SCA. SIP and analog phones do not 
support the SCA.

9.5.1 SCA Feature Components
This section describes the main feature components of SCA. It divides components into 
different non-conference and conference-related areas.

9.5.1.1 Associated Bridge Call Appearance
An Associated Bridged Call Appearance (aBCA) is a bridged call appearance that is 
associated with an executive extension. Associated BCAs differ from other BCAs as follows:

• An aBCA can be specified in the Edit User panel rather than the Bridged Call 
Appearance Director panel.

• aBCAs are created when a ShoreTel extension is converted to a executive extension.
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9.5.1.2 Non-conference Functionality
When a regular user is enabled for SCA, the system automatically creates an associated 
BCA (aBCA) gives it an aBCA extension number.

Nearly all the BCA parameters that could be selected for the regular BCA user are fixed. 
Only the label for each SCA button can be specified.

The settings for SCA IP programmable buttons are fixed at the following values:

• Ring Delay before Alert: None

• Show Caller ID on Monitored Extensions: Always

• Button push actions default: (unused)

• No Connection Call Action: Dial tone

• Call Stack Position: Automatically ordered (no manual ordering allowed)

The SCA call stack positions are automatically set and not manually configurable in 
ShoreTel Director. However, call stack positions are automatically reordered if a button is 
specified to be other than an SCA. The SCA buttons are reconfigured around the new 
button type.

NOTE For a button box, the system does not auto-shift call stack positions.

When a regular user is enabled for SCA, each regular call appearance converts to an SCA. 
Standard call appearances do not exist for the SCA user, and no SCA button can be 
converted back to a regular call appearance unless the SCA configuration is removed by 
disabling SCA.

9.5.1.3 BCA Conference Parameters
The BCA conference parameters are configured in the Call Control –> Edit Bridged Call 
Appearances window for a specific BCA or aBCA. For a description of the conferencing 
setup for an SCA user, see "Enabling the BCA Conference Ability for an SCA User" on page 
255. The conference parameters are:

• The enable for bridged conferencing

• The Default Privacy setting—an enable for letting other BCA users join the 
conference (can be overridden by the executive user on a per call basis)

• A tone that sounds when a party joins a conference

9.5.2 Enabling a User for SCA
This section first introduces the program flow for specifying an SCA user configuration and 
then gives the steps for this task. The other, standard configuration tasks for a user are in 
the Configuring Users chapter.

9.5.2.1 Program Flow for Configuring SCA Users and BCA Conferencing
This section outlines a sequence of steps that a system administrator might follow to set up 
a new SCA user and assistant and enable BCA conferencing. The purpose of this outline is 
to promote smoother execution of the configuration steps. Readers who are already very 
familiar with BCA and SCA can go directly to the steps for specifying the accounts for SCA 
users and assistants as well as BCA conferencing for the executive.

In general, the configuration flow for creating an SCA user is as follows:
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• A system administrator navigates to Users–>Individual Users, selects a site in the 
drop-down scroll box labeled “Add new user at site:” in the upper left corner, and 
clicks the GO button next to that scroll box. 

• After configuring and saving the user account basics—thus creating a regular user 
account—the system administrator enables Shared Call Appearances in the lower 
half of the Edit User (General) window. For a new user, the basic user parameters 
must be saved before Director activates the Shared Call Appearances enable. This 
requirement is also pointed out in the pertinent configuration step.

• When Shared Call Appearances is enabled, the system automatically creates and 
numbers an associated BCA (aBCA) for the SCA.

• The system automatically generates the aBCA extension number and displays it in 
the Associated BCA box within the Edit User window. The system administrator can 
change the generated number, for example, according to network planning 
guidelines that mandate such numbers exist in a certain range (for resource 
management purposes). 

NOTE Once saved, an SCA user’s aBCA extension cannot be changed unless 
Shared Call Appearances is disabled for the user.

• The aBCA is deleted if the system administrator reverts the SCA user back to a 
normal user by clearing the user’s Shared Call Appearances checkbox in the Edit 
User panel.

NOTE Before the Share Call Appearances check box can be cleared, certain 
programmed items must be cleared. The system administrator must clear:

— All of the assistant’s IP buttons that monitor the executive’s aBCAs

— The assistant’s Communicator toolbar programming for monitoring the 
executive’s aBCA (if present)

In summary, implementation tasks for a new SCA user and regular BCA user (assistant) 
have the following sequence:

1. Create the new regular user account that is intended for the SCA user.
2. Convert the new user to an SCA (executive) user by enabling SCA.
3. Configure the IP phone buttons that the SCA user’s account calls for.
4. In the Bridged Call Appearances window, enable conference ability, select the default 

privacy setting, and enable the join-tone for the executive. (See "Setting Up 
Conferencing Ability for BCA and SCA Users" on page 253.)

5. Create a new regular BCA user to have an assistant’s phone setup: configuration 
includes the executive’s extensions that the assistant monitors. For details, see 
"Creating an Assistant Account" on page 260.

9.5.2.2 Creating a New Executive User
The configuration tasks in this section apply to a new executive (SCA) user and a new 
administrator (regular BCA) in a subsequent section. Other types of steps for configuring a 
new user apply to the executive and administrator accounts, but they are largely omitted 
here. Refer to the chapter on creating Users for all the details on user accounts.

NOTE If the executive and assistant need to manage SCA calls in Communicator, the 
Access License for each of these users must be Operator.

To create a user with the SCA user:

Step 1 Launch ShoreTel Director. 
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Step 2 Click Administration > Users > Individual Users.

Step 3 In the “Add new user at site” field, select the site for the new user, then click 
Go. The Users-Edit Users appears. This window shows some defaults that are 
specific to the site and the server.

Step 4 In the First Name and Last Name fields, type a first and last of the new user. 
(As a subsequent step shows, Director displays first, last name, and extension 
number in a specific format.)

Step 5 In the Access License field, select Professional or Operator. ShoreTel 
Communicator requires the Operator license to display the BCA Window. 

Step 6 In the Primary Phone Port section, click the IP Phones radio button and select 
a specific phone in the drop-down list. (If an IP phone model of sufficient 
capability is not recognizable in the list of MAC addresses, the right phone can 
be determined by matching the IP phone model number to a MAC address in 
Administration > IP Phones > Individual IP Phone.)

NOTE Before enabling SCA for a new user, the system administrator must do an 
intermediate Save after entering the basic user details in the upper part of 
the Edit Users window. The Enable SCA checkbox becomes active only 
after this intermediate Save.

Step 7 Check the Shared Call Appearances checkbox.

Step 8 In the Associated BCA, enter a number for the extension.

The next available extension number is automatically generated when Shared 
Call Appearance is enabled. The number can be changed. If the system 
administrator has an organized scheme for extension numbers, manual entry is 
a logical choice. A manually entered alternative could be valuable if an auto-
generated number is outside the number management scheme and, therefore, 
possibly confusing.

NOTE A number must be deemed acceptable before the Save button is clicked to 
save the SCA setting. After the SCA enable has been saved, the Associated 
BCA value cannot be changed except by deleting the SCA (by unchecking 
the SCA box) and then starting the SCA configuration over.

Step 9 (Optional: This step can be skipped if the auto-fill value is acceptable.) Type an 
aBCA number in the Associated BCA field. 

Step 10 Click Save if the aBCA number is acceptable.

Step 11 Click the Personal Options tab.

Step 12  In the Current Call Stack Size field, type a value for the depth of the call stack 
field. 

This entry is the number of SCA buttons that the executive has. The number is 
subsequently reflected in the window for programming IP phone buttons (the 
Program IP Phone Buttons window). The system default is 8, but we 
recommend some planning for resource usage. For example, some executives 
might need only two or three while others might need eight or more, and 
planning should have been completed for button boxes and how many 
executives one assistant might have to support.
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Step 13 Click the Program IP Phone Buttons link. The Program IP Phone Button page 
for the current user appears as shown in Figure 9-15.

Figure 9-15 Programming the IP Phone Buttons for SCA

Step 14 In the IP Phone Type field, select type of IP phone the user uses.

Step 15 In the Label field for each SCA button, type a name. All other BCA parameters 
are fixed for an SCA button. Non-SCA buttons can be programmed for other 
functions, such as speed dial, hotline, and so on.

Step 16 Click Save when all necessary parameters are configured.

NOTE Clearing the Shared Call Appearances checkbox returns the executive 
extension to a normal extension and deletes the extension’s aBCA 
associated.

The executive account has been created, but conferencing and default privacy settings for 
the SCA user still need setting up. To configure the conference-related details for the SCA 
user, refer to "Setting Up Conferencing Ability for BCA and SCA Users" on page 253.

9.5.3 Creating an Assistant Account
The steps in this section focus on configuring a regular BCA user to monitor the executive’s 
call appearances. The description omits many common details for configuring a regular 
user. For the standard user details, see the chapter Configuring Users.

NOTE Making all the executive’s call appearances visible to the assistant is not required: If 
an executive wants one or more lines to be invisible to the assistant, the 
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administrator omits the requested number of hidden lines from the assistant’s 
configuration.

After creating the assistant as a regular BCA user in Edit Users, the system administrator 
proceeds with configuring the assistant to monitor the executive’s phones, as follows:

Step 1 Save the regular user parameters in the Edit User > General tab.

Step 2 Select the Personal Options tab.

Step 3 Click the Program IP Phone Buttons link. The Program IP Phone Buttons page 
appears.

Step 4 In the IP Phone Type field, select the type of IP phone the assistent uses.

Step 5 In the first function field, select All or Telephony.

Step 6 In the second function field, select Bridged Call Appearance. The Bridged Call 
Appearance options appears in the Target pane.

BCA parameters for assistant-monitoring of an executive’s call appearances are 
available, but the executive’s aBCA first must be selected after a search for it.

Step 7 Click the Search button. The Dialing Numbers--Webpage Dialog shown in 
Figure 9-16 appears. 

Figure 9-16 Searching for the SCA User for the Assistant to Monitor

Step 8 Select an aBCA with whom to associate the assistent. aBCAs are listed using the 
format: <first name>_<last name>_<extension>.
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Step 9 Configure other BCA parameters as needed. See "Configuring Answer Options 
on an IP Phone" on page 248 for more information about the BCA parameters.

NOTE The No Answer Number of Rings and Call Forward Destination 
parameters reflect the initial values of these parameters. However, the 
real-time state of these parameters can change, based on the activity of the 
user. For a regular BCA user, these parameters are editable in the BCA 
window in Director. In contrast, for an SCA user (tied to an aBCA), these 
parameters are grayed out in the window because the SCA user inherits 
the parameters when the system creates the aBCA. Thereafter, if the SCA 
user is changing these parameters in real time, the changes are actually 
inherited in the aBCA, but the BCA page in Director is not updated to 
reflect the changes. Put another way, ShoreTel Director continues to 
reflect the initial value of these two SCA parameters.

Step 10 Configure other call appearances as needed for this executive (or for other 
executives after searching the same pop-up window described in Step 7).

Step 11 Repeat as needed the configuration steps for each executive call appearance.

Step 12 Click the Save button when the configuration steps for this window are 
complete.

9.5.4 Usage Guidelines for SCA
This section contains different usage scenarios and suggestions.

When an executive extension is routed to a phone that does not have programmable 
buttons, the executive extension is handled as a normal extension. The extension behavior 
reverts back to that of an executive extension when extension calls are routed to a phone 
with programmable buttons.

9.5.4.1 Bridged Call Appearance Monitoring
The Bridged Call Appearance Monitor is a ShoreTel Communicator window that displays 
all Bridged Call Appearances accessible to the user’s extension through all devices assigned 
to the user. The BCA Monitor consolidates all of a user’s aBCA activity into a single panel.

The Bridged Call Appearance Monitor is available in ShoreTel Communicator only if the 
Access License for the user is Operator.

In Communicator, because calls are tracked as BCA calls in the BCA monitor window, the 
active call cell disappears when a call is put on hold, and the held call can be viewed only in 
the BCA monitor window.

aBCA is hidden in the phone directory list so that users do not accidently call an aBCA 
instead of the executive. However, as with regular BCAs, the system administrator can 
configure an aBCA as the destination of a trunk group or the targeted extension of a 
programmable button function. The decision of how to use aBCA belongs to the system 
administrator’s discretion.

Placing an executive extension call on hold parks the call on the aBCA. Held calls on a 
executive extension are viewable from the Bridged Call Appearance Monitor in ShoreTel 
Communicator or from the IP Phone display.
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9.5.4.2 Assistant Users
Assistant accounts need no special configuration for the monitoring of the executive’s call 
appearances other than the assignment of programmable buttons for IP phones. However, 
for monitoring of executive call appearances in Communicator, the assistant’s Access 
License must be Operator.

9.5.4.3 Hotline
A typical SCA setup includes a hotline circuit between an executive and assistant. They use 
a hotline circuit to communicate requests, responses, and status of calls.

To land a call on a hotline button for intercom or speed dial, both parties must have a 
hotline-programmed button. In the absence of this programming, the offered call is 
processed as a regular call.

Hotline calls and Extension Monitor calls to an executive extension that are picked up are 
not bridged. Refer to the Hotline section for configuration information.

NOTE A hotline intercom call uses the intercom permissions of the user. Therefore, the 
rules that apply to that user’s regular intercom call also apply to a hotline-intercom 
call.

9.5.5 Inbound and Outbound SCA Calls
This section describes the typical actions that executives and assistants take when the 
assistant takes a call on behalf of an executive and when the assistant places a call on behalf 
of the executive. In this section, blind conferencing is not used. Examples of blind 
conferencing are in "Blind Conferencing and the SCA User" on page 264.

9.5.5.1 Assistant Support for Inbound Calls
The following scenario describes a typical sequence of actions when an assistant takes a call 
on behalf of an executive.

1. The inbound call triggers a flashing orange light on the IP phone of both the assistant 
and the executive. If the Access License of the executive and assistant is Operator, 
Communicator also signals the incoming call. (The executive could just pick up the call 
and pre-empt the assistant’s involvement with this call.)

2. The assistant answers the call on the flashing BCA button and could, for example, get 
the caller’s name and purpose.

3. The assistant puts the call on hold.

NOTE The executive call timer is reset if the executive puts the call on hold.

4. The assistant presses the hotline button shared with the executive.

5. The assistant tells the executive of the call in progress (on hold) and gives pertinent 
information about the call.

6. The executive picks up the call by pressing the flashing orange SCA button.

NOTE Internal users who call an executive see the called party ID aBCA while the 
phone is ringing and the actual executive number after the call is picked up.
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9.5.5.2 Assistant Support for Outbound Calls
The following scenario describes a typical sequence of actions when the assistant sets up a 
call for the executive.

1. The assistant accesses one of the executive’s call appearances by pressing an appropriate 
IP Phone or ShoreTel Communicator button.

2. The assistant calls the intended recipient of the executive’s call.

3. The assistant user places the called party on hold.

4. The assistant presses the hotline button to the executive.

5. The assistant tells the executive of the call in progress (on hold) and provides 
information about the call as needed.

6. The executive takes the call by pressing the flashing orange button that the assistant has 
identified.

NOTE An executive extension’s redial list shows only outbound calls.

9.5.6 Blind Conferencing and the SCA User
This section illustrates blind conferencing and the SCA user in two contexts. In one 
situation, the assistant receives a call on behalf of the executive while the latter is already 
on a call. In the other context, the executive is on a call but then asks the assistant to call 
someone and conference the called party into the existing call.

Blind Conferencing of an Inbound Call

In this scenario:

1. The executive is currently on a call with party number one. 

2. The assistant receives a call from a second party.

3. The assistant determines that the executive is on a call and wants the second party to 
join the executive's call. 

4. The assistant hotlines the executive to say that the second party is on the line and ready 
to join the call. 

5. The hotline call ends, and the executive is connected back to party one, and the assistant 
is connected back to party two. 

6. The assistant initiates a conference and selects the executive's call into which party two 
must join. 

After the conference connection is completed, parties one and two are in the same call.

Blind Conferencing of an Outbound Call

In this scenario:

1. The executive is on the phone with party one and uses the hotline to ask the assistant to 
bring another party into the call

2. The executive goes back on-line with party one. 

3. The assistant calls party two.

4. The assistant hotlines the executive to say that party two is ready to join. 
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5. The assistant adds party two by initiating the blind conference and then pushing the 
button for the executive’s active call appearance.

9.6 Silent Coach
Silent Coach is a client feature that lets a user (the initiator) intervene in another user’s 
active call and communicate with that user (the recipient). The initiator can speak to the 
recipient and listen to all other call participants on the call. The recipient is the only call 
participant that can hear the initiator.

The right to use Silent Coach is set by the system administrator. The system administrator 
also specifies the users (recipients) whose calls the initiator can monitor. A Telephony 
Class of Service assigns Silent Coach rights. Silent Coach can be initiated through various 
ShoreTel IP Phone models or through ShoreTel Communicator.

NOTE Silent Coach is not available on SIP extensions or over SIP phones trunks.

9.6.1 Operational Behaviors of the Silent Coach Feature
The following are details about Silent Coach Behavior:

• Silent Coach lets the initiator switch between Silent Monitor, Barge In, and Silent 
Coach functions for the same call.

• Silent Coach sessions can be initiated through ShoreTel IP Phone or ShoreTel 
Communicator programmable buttons, ShoreTel Communicator menu options, and 
star code calls from other calling devices.

• The initiator of a Silent Coach session can change the session to a Silent Monitor or 
Barge In session. Silent Monitor sessions can be changed into a Silent Coach 
sessions.

• The recipient can place the original call on hold to engage in a two-way conversation 
with the Silent Coach initiator. At the end of this conversation, the user can resume 
or terminate the original call.

• Silent Coach cannot be initiated with users who are on conference calls.

• A call with an active Silent Coach session cannot be transferred or converted to a 
conference call.

• The recipient cannot record calls while Silent Coach is active.

NOTE The following devices do not support session transitions, coach consulting, 
and coach resumption.

• Analog phones

• IP110

• IP210

9.6.2 Configuring Silent Coach Permissions
Silent Coach access is controlled through Telephony CoS settings. Permissions for 
monitoring calls or having calls monitored are configured through the Silent Monitor / 
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Silent Coach option on the Telephony Class of Service Edit panel. To configure Silent 
Coach for a Telephony Class of Service:

Step 1 Launch ShoreWare Director.

Step 2 Click Administrator -> Users -> Class of Service.

In the Telephony Features Permissions section, click the feature profile that you want to 
configure or “Add new” to create a new feature profile. The Edit Telephony Features 
Permission page appears as shown in Figure 9-10.

Step 3 Scroll down to the Silent Monitor / Silent Coach Other’s Calls section and do 
the following:

• Check the Allow Initiation checkbox.

• In the Accept section, check the radio button of the permission you want 
users with this CoS to have to monitor BCA calls. The option are:

— None: Select to allow users to monitor calls.

— All: Select to allow users to monitor all calls.

Figure 9-17  Class of Service Setting – Silent Coach
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— From Only: Select to allow users to monitor specific call participants. In 
the From Only field, seclect the participant for whom you want to allow 
monitoring.

Step 4 Click Save.

9.6.3 Enabling the Silent Coach Warning Tone
ShoreTel provides an option for playing a Silent Coach Warning Tone to all call participants 
when a Silent Coach session is initiated and if the Silent Coach Warning Tone option is 
enabled. The Warning Tone setting applies to all Silent Coach sessions on the system.When 
a user transitions between Silent Coach and Silent monitor, the warning tones start/stop are 
based on the silent coach or silent monitor warning tone setting. 

To enable the Silent Coach Warning Tone option:

Step 1 Launch ShoreWare Director.

Step 1 Click Administration > Call Control > Options. The Call Control Options Edit 
page appears as shown in Figure 9-18.

Step 2 Check the Enable Silent Coach Warning Tone check box.

9.6.4 Configuring Silent Coach buttons
ShoreTel IP Phone and ShoreTel Communicator programmable buttons can be configured 
to initiate a Silent Coach session with a specific user or to query the caller for a Silent 
Coach destination. The configuration processes for ShoreTel IP Phone and ShoreTel 
Communicator programmable buttons are almost identical.

Figure 9-18  Enabling the Silent Coach Warning Tone
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To configure an IP Phone button to initiate Silent Coach:

Step 1 Launch ShoreWare Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 Select the user that you want to be able to initiate the silent coach feature. The 
Edit User page appears.

Step 4 Click the Personal Options tab.

Step 5 Click the Program IP Phone Buttons link. The Program IP Phone Buttons page 
appears.

Step 6 For the IP phone button that you want the user to use, select All or Telephony 
in the first field.

Step 7 In the second field, select Silent Coach. The Target pane in the Program IP 
Phone Buttons page populates as shown in Figure 9-19.

Step 8 Select Silent Coach from the Function drop-down menu of a selected button.

Step 9 In the Label field, enter a name for the button.

Step 10 To program the button to monitor the calls of a specific user, enter the user’s 
extension in the Extension field.

NOTE If this field is left blank, pressing the IP Phone button queries the initiator 
to enter a number in the Telephone User Interface before the session 
begins.

Step 11 Click Save.

Figure 9-19  Programming IP Phone Button – Silent Coach
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9.6.5 Performing Silent Coach Operations

Silent Coach is initiated from the following:

• ShoreTel Communicator programmable button

• ShoreTel Communicator menu option

• ShoreTel IP Phone programmable button

• Any phone by pressing the code *22, then entering the target extension.

9.6.5.1 Initiating Silent Coach Operations with ShoreTel Communicator
ShoreTel Communicator supports two methods of initiating Silent Coach operations – from 
menu options and by pressing a tool bar button.

To perform a Silent Coach from a ShoreTel Communicator Menu:

Step 1 Perform one of the following:

• Click the Application Button, then select Dial > Silent Coach.

• Select Dial > Silent Coach from the main menu.

• Right click the System Tray ShoreTel icon select Dial > Silent Coach.

ShoreTel Communicator displays the Silent Coach dialog box, as shown in 
Figure 9-20.

Step 2 Enter an extension or select an item from the drop-down list.

Step 3 Click the Silent Coach button at the bottom of the panel.

Figure 9-20  Silent Coach Dialog box
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To perform a Silent Coach from a ShoreTel Communicator tool bar button:

Step 1 Press the programmable Silent Coach button, as shown in Figure 9-21.

NOTE If the button specifies a Silent Coach recipient, the system immediately 
initiates a Silent Coach session with that user. Skip the remaining steps.

NOTE If the button does not specify a Silent Coach recipient, ShoreTel 
Communicator displays the Silent Coach dialog box. In this case, 
continue to the next step.

Step 2 Enter an extension or select from the drop-down list.

Step 3 Click the Silent Coach button.

To transition a Silent Coach session into a Silent Monitor or Barge In session, perform 
one of the following:

• Right click the call cell and select the desired session type on the context menu.

Figure 9-21 displays the context menu during a Silent Monitor Session.

• If available, press the Monitor or Barge In programmable button.

Figure 9-21 displays Silent Monitor, Silent Coach, and Barge In programmable 
buttons.

Figure 9-21  ShoreTel Communicator – Silent Coach session
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The same process transitions a Silent Monitor session into a Silent Coach session.

9.6.5.2 Initiating Silent Coach Operations with ShoreTel IP Phones
To perform a Silent Coach from a ShoreTel IP Phone programmable button, press the Silent 
Coach button.

• If the button specifies a Silent Coach recipient, the system immediately initiates a 
Silent Coach session with that user. Disregard the remaining steps.

• If the button does not specify a Silent Coach recipient, enter the recipient’s name or 
number in the Telephone User Interface.

ShoreTel Communicator displays the Silent Coach dialog box. In this case, continue to the 
next step.

To perform a Silent Coach from any system phone,

• Enter the *22 code, followed by the number of the target extension.

ShoreTel phones display softphone options while a Silent Monitor option is active. Figure 
9-22 displays the ShoreTel IP560 Telephone User Interface for a user that initiated a Silent 
Coach session.

Softkey options available to the Silent Coach initiator:

• SilMon: Transitions the session into a Silent Monitor session

• Barge: Transitions the session into a Barge In call.

• Show: Displays all call participants in the Telephone User Interface

• Hangup: Terminates the Silent Monitor session.

Softkey options available to the Silent Coach recipient:

• Consul: Places the active call on hold and establishes a two-way voice path between 
with the Silent Coach initiator.

While the recipient consults with the initiator, soft key options include:

— Resume: Restarts the recipient’s original call.
— Show: Displays all call participants.
— HangUp: Terminates the call.

• Show: Displays all call participants in the Telephone User Interface.

• Hangup: Terminates the Silent Monitor session.

Figure 9-22 IP Phone User Interface – Silent Coach Initiator
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9.7 Hunt Groups
The Hunt Groups list page is shown in Figure 9-23.

Figure 9-23 Hunt Groups List Page

Clicking on a group name shows the details for the hunt group, as shown in Figure 9-24 in 
the Hunt Groups edit page.
272



Chapter 9: Setting Call Control Options System Administration Guide
Figure 9-24 Configuring Hunt Groups

Hunt groups allow a call to be offered to a limited set of user extensions with no reporting, 
queuing, sophisticated schedules, log-in, log-out, or wrap-up states. Each hunt group is 
composed of an ordered list of no more than 16 users. A maximum of 8 hunt groups 
totalling no more than 16 members can be assigned to a single switch. If your requirements 
more complex, you should use workgroups. 

Rather than being reliant on the Headquarters Server, a hunt group can be assigned to the 
switch closest to the agents and/or trunks associated with it. The switch controls the 
hunting, with no dependency upon the server. Hunt Groups have an extension number 
and, optionally, can also have a DID and/or DNIS number. They can be call forward 
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extensions for users, workgroups, route points, personal assistants, site fax redirect 
extensions, site operator extensions, and the target for trunk groups. They are also allowed 
as the backup destination for workgroups and route points. This can be useful to allow 
some basic call handling when the workgroup server is not reachable. 

The caller ID displayed for a hunt call is the external caller’s ID. 

A user may belong to more than one hunt group. In addition, a user assigned to a 
workgroup may also be assigned to hunt groups. Each call is hunted as a new call; that is, if 
the hunt mode is top down, each new call begins hunting from the top of the list. In this 
case, the person at the top of the list will get most of the calls.

Fields are defined as follows:

• Name: This is the name of the hunt group. Each hunt group name must be unique.

This is a required field.

• Extension: This is the extension number of the hunt group. Each hunt group 
extension must be unique.

This is a required field.

• Backup Extension: This is the backup extension of the hunt group. If the hunt group 
is unreachable or the switch is down, calls can be directed to this extension. A 
backup extension may be another hunt group, a workgroup, a route point, or a user.

This is a required field.

• DID: You can assign one DID number to a hunt group. 

Check the first box to select DID. Make a selection from the drop-down list of area 
codes. This is an optional field.

Refer to “DID Ranges” on page -164 for additional information about DID numbers 
and ranges.

• DNIS: The Edit DNIS Map button invokes the Select DNIS Trunk Group dialog box. 
This lets you select a trunk group for DNIS routing. Only trunk groups that are 
configured for DNIS will be presented in the dialog box. You can assign multiple 
DNIS numbers to a hunt group. 

DNIS is typically used to route 800-number calls to a workgroup or application. 

This is an optional field.

• Include in System Dial By Name Directory: This check box includes the hunt group 
in the auto-attendant dial-by-name directory. No name is recorded for a hunt group. 
When a hunt group is chosen, the extension is announced by a generic message.

This is an optional field.

• Make Number Private: This check box makes the hunt group extension private. 
When the hunt group is private, it is not listed in the system directory and does not 
appear in the Communicator dialing lists. See also the "Individual Users" on page 
329.

This is an optional field.

• Switch: Select from the drop-down list of available switches. This is the switch that 
will host the hunt group and do the hunting of calls
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• Call Stack Depth: This lets you specify the maximum number of simultaneous calls 
that can be “stacked” on the hunt group extension. When this number is met, 
additional inbound calls will be routed to the Busy Destination.

Default value is 8. Valid entries are 1 through 16.

• Distribution Pattern: Click either Top Down or Simultaneous. Top Down hunts 
sequentially through the ordered list of group members. Simultaneous rings all 
group members at the same time. The first to answer is presented with the call. The 
default is Top Down. 

This is a required field.

• Rings Per Member: The default is 2 rings. All group member extensions ring with 
the same number of rings. If the phone is not answered, the hunt continues on to the 
next group member.

This is a required field.

• No Answer Number of Rings: The default is 6 rings. This value determines the 
number of ring backs a caller will hear while the call is being hunted. Once this value 
is exceeded, the call is sent to the No Answer Destination.

This is a required field.

• Call Member When Forwarding All Calls: Default is disabled. When enabled, even 
if a group member’s call handling mode is Call Forward Always, the call is offered to 
the member. 

• Skip Member if Already on a Call: Default is disabled. When enabled, even if a 
group member’s call stack is not full, if the member’s phone is busy or currently 
being offered a call, the new call is not offered to the member.

• Busy Destination: An alternate call destination can be specified for calls to be sent 
when all members of the hunt group are busy and the call stacks are full.

This is an optional field.

• No Answer Destination: An alternate call destination should be specified for times 
when no member answers a call. The hunt will continue until the No Answer 
Number of Rings value is exceeded, after which callers are sent to this No Answer 
Destination.

• On-Hours Schedule: From the drop-down list, select an on-hours schedule or None. 
Selecting None causes all calls to be treated as if it is on-hours.

• Holiday Schedule: From the drop-down list, select a holiday schedule or None. 
Holidays are handled the same as off-hours.

• Off-Hours/Holiday Destination: Each hunt group can have a call forward destination 
for use during the off-hours state.

This is an optional field.

• Current Call Handling Mode: You can configure several call handling modes for the 
hunt group: On-Hours, Off-Hours, or Holiday. The default is On-Hours.

This is an informational field.
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• Choose Members: Click a member name and then click Add to add a member to the 
Hunt Group. Members can be removed and re-ordered, as well. This is useful since 
the Hunt Group membership is an ordered list. 

NOTE You can use filters to sort available members into an order that makes your 
selection process easiest for you. 

9.7.1 Setting the Hunt Group to Busy
Users with correct permissions can set the hunt group to a busy state from the Switch 
Maintenance page or from the telephone user interface by using a star code (*18) followed 
by the hunt group extension. A confirmation prompt is played to confirm the state of the 
hunt group following entry of the star code. The *18 code is used to place the hunt group 
back into service, as well.

You can busy out the hunt group when all members are unavailable. Calls are then 
forwarded to the Busy Destination. After a switch reboots, the hunt group is available, by 
default. 

Hunt Groups may also be busied out or returned to service from the Switch Maintenance 
page. From the Maintenance Quick Look page, select the switch that handles the hunt 
group, select a hunt group, and then change the busy state.

9.8 Paging Groups
As an alternative to using an in-house paging system, you can broadcast a message over a 
group of speakerphones with the Paging Groups feature. This feature allows a system 
administrator to designate groups of extensions that can be paged by dialing a single 
system extension and recording your message. This feature can be a cost-effective 
alternative for environments that do not already have an overhead paging system installed.

For environments that have an overhead paging system, Paging Groups can target your 
message to a select group of individuals within the organization while not exposing the 
message to everyone in the building, as would happen with an overhead page.

9.8.1 Adding Overhead Paging to Paging Groups
A Paging Extension (i.e. the extension which, when dialed, sends a page announcement to 
a site’s overhead paging system) can be included in a Paging Group. By merging a Paging 
Extension within a Paging Group, you can broadcast a message to a select group of user 
extensions AND send it to the overhead paging system at the same time. Adding multiple 
Paging Extensions to an extension list provides the capability to simultaneously page the 
overhead paging system of multiple sites.

• Paging Group messages sent to an IP phone that is on-hook are announced on the 
speaker of that IP phone. Pages sent to an IP phone or analog phone that is already 
on a call are treated as a normal call.

• Call handling does not apply to paging calls.

• A maximum of 100 extensions can be paged at one time.

• After receiving a request to play a paging message, the workgroup server introduces a 
short pause to synchronize the audio across several phones. This pause (which can 
last up to 6 seconds) allows calls to all affected extensions to connect to the server, 
after which the server begins playing the message.
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This pause synchronizes the audio paging across a group of devices, reducing the 
chance of a cluster of phones playing the message at different times (which could 
create a disconcerting echoing effect if the phones were within earshot of one 
another). Refer to Product Bulletin 0200 on the ShoreCare website for more 
information.

9.8.2 Configuration
To specify who should be paged, create an extension list of paging user numbers. For 
information about creating extension lists, refer to Section 10.6.4. Users in the extension 
list used as a paging group must belong to a user group that allows overhead paging. As an 
alternative to calling the paging number, group paging is available from the auto-attendant 
(for internal users) and can be used if this fulfills your paging needs. Group paging is not 
available to external callers.

Paging groups are viewed, edited, or deleted on the Call Control Paging Groups list page.

Figure 9-25 Paging Groups List Page

Select an existing group for editing or click New to add a new paging group. The Paging 
Groups edit page is shown in Figure 9-26.

Figure 9-26 Edit Paging Group Page

The fields on the Paging Groups edit page are:

• Name: This is the name of the paging group. Each paging group name must be 
unique. This is a required field.

• Extension: This is the extension number of the paging group. Each paging group 
extension must be unique. This is a required field.

• Include in System Dial By Name Directory: This check box includes the paging 
group in the auto-attendant dial-by-name directory. No name is recorded for a paging 
group. When a paging group is chosen, the extension is announced by a generic 
message. This is an optional field.
ShoreTel 12.2 277



System Administration Guide Chapter 9: Setting Call Control Options
• Make Number Private: This check box makes the paging group extension private. 
When the paging group is private, it is not listed in the system directory and does not 
appear in the Communicator dialing lists.

This is an optional field.

• No Answer Number of Rings: The default is 2 rings. This is always used for analog 
phones. It is used for IP phones if the phone is busy. This is a required field.

• Extension List: Select the name of the extension list to be used as the paging group 
from the drop-down list. 

9.9 Multi-site Paging Groups
The distributed nature of business often requires that business tools available to employees 
in the corporate headquarters also be available to remote office workers. One such business 
tool is a paging system. Many businesses need to have a quick way to alert employees that a 
customer needs assistance or that a call is waiting.

The Multi-site Paging Group feature allows employees to be paged in each remote office in 
an efficient manner. Multi-site Paging Groups is a ShoreTel enhancement that improves 
paging efficiency by allowing the audio for the page to be recorded and sent from a local 
ShoreTel Voicemail Server. This reduces any impact on WAN bandwidth for pages made 
within the Headquarters and the remote offices including any dependency on the 
Headquarter server.

• The Multi-site Paging Group feature allows users to pick up a phone and dial a single 
system extension to page a group of telephones. With Multi-site Paging Groups, the 
administrator can now configure local paging extensions for each site.

• The Multi-site Paging Group functionality can be implemented on the Headquarters 
Server and Distributed Voice Mail Servers. This feature is configured in a similar 
manner to the Paging Group feature implemented in previous releases. 

NOTE Group paging is not available on Voice Model Switches (switches with the letter V 
appended to the model name—the ShoreTel Voice Switch 90V, for example).

Figure 9-27 shows a two site implementation where each site has a Paging Group. With 
Multi-site Paging Groups, both pages are recorded and sent by their local server with no 
impact on WAN bandwidth.
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Figure 9-27 Multi-site Paging Groups

NOTE There is no additional licensing requirement to implement Multi-site Paging 
Groups. This feature is not implemented on ShoreTel Voicemail Switches.

9.9.1 Paging Groups Operation
To use Paging Groups, a person picks up a phone and dials the Paging Group extension. 
They then record their page message and hang up the phone. The Paging Group Sever then 
attempts to play the page on each phone referenced by the Extension List configured for 
the Paging Group. 

In order to reduce the perceived audio delay of paging multiple phones in the same room, 
the ShoreTel system will wait to verify that the extensions referenced on the Extension List 
are ready to receive the page. This delay period is specified in the Group Paging 
Synchronization Delay field in the Paging Groups edit page.

9.9.2 Configuring Paging Groups 
Once the desired Extension Lists are created, the administrator can then assign the 
Extension Lists to Paging Groups. The following steps outline the procedure to configure a 
Paging Group:

Step 1 Log in to ShoreTel Director.

Step 2 Select Call Control under the Administration section.
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Step 3 Click the Paging Groups link to display the list of Paging Groups as shown in 
figure below.

Figure 9-28 Paging Groups List Page

Step 4 Click New to create a new paging group or click on an existing Paging Group 
to modify the parameters.

Step 5 Edit the Paging Groups fields.

Step 6 Click the Save button to save your changes.

Figure 9-29 Paging Groups Edit Page

• Name: The paging group. Each paging group name must be unique. This is a 
required field.

• Extension: The extension number of the paging group. Each paging group extension 
must be unique. This is a required field.

• Group Paging Server: Select the Headquarters Server or one of the Distributed 
Voicemail Servers. The server selected will be the source of the audio streamed to the 
telephones during the page. The default server is set to Headquarters. This is a 
required field.

• Include in System Dial By Name Directory: This check box includes the paging 
group in the auto-attendant dial-by-name directory. No name is recorded for a paging 
group. When a paging group is chosen, the extension is announced by a generic 
message. This is an optional field.

• Make Number Private: This check box makes the paging group extension private. 
When the paging group is private, it is not listed in the system directory and does not 
appear in the Communicator dialing lists. This is an optional field.
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• No Answer Number of Rings: The default is 2 rings. This is always used for analog 
phones. It is used for IP phones if the phone is busy. This is a required field.

• Extension List: Select the name of the extension list to be used as the paging group 
from the drop-down list. This is a required field.

• Group Paging Synchronization Delay: The time in seconds that the server will wait 
to connect to all phones in the extension list prior to sending the audio stream to the 
phones. This delay was introduced to reduce the perception of audio echo when 
paging large groups of phones. The default time is set to 3 seconds. This is a required 
field.

9.9.2.1 Important Considerations

• The maximum number of extensions that can be paged at one time is 100.

• Group paging is not available to external callers.

• Group paging is not available on Voice switches.

9.10 Priority Group Paging
Many organizations rely on paging for critical communications with their employees. In 
business, calls that are made to an IP phone from a paging server will show up as normal or 
a non-urgent call to the user when the phone is in use. In these instances the individual 
being paged has no idea of this request and there is no guarantee that the individual will 
suspend their current call to listen to the page being delivered. 

Priority Group Paging provides system administrators with a method for designating 
groups of extensions that can be paged by dialing a single system extension and recording a 
message. 

9.10.1 How Priority Group Paging Works
When Priority Group Paging is enabled, the recipient of a Priority Group Page or forced 
page will hear the audio of the page regardless of whether or not they are on a call. If the 
intended recipient is on an active call, that call will be automatically be placed on hold 
before the page is played. When the page completes, the call that was placed on hold will 
automatically resume.

Priority paging differs with Paging Groups in the way a Hold/Transfer/Conference is 
handled. A normal Paging Group page call will terminate when the user presses Hold/
Transfer/Conference. During a priority page this operation is not allowed and will be 
ignored.

9.10.2 Enabling Priority Paging Groups
Priority paging is an enhancement to the existing implementation of page groups by 
allowing the server to act as a media relay from source to the recipient. The call controller 
or the switch plays a limited role. 

NOTE The Priority Paging feature provides new functionality to the page recipient. There 
are no changes in the core paging implementation. 

To enable priority paging groups functionality. 

Step 1 Log into ShoreTel Director.
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Step 2 Click Administration > Call Control > Paging Groups. The Paging Groups 
window opens.

Step 3 Click the New button to create a new Paging Group. The Edit Paging Group 
page appears as shown in Figure 9-30.

Figure 9-30 Paging Groups Edit Page

Step 4 Edit the following fields in the Edit Paging Groups screen. 

• Paging Group Server - The server hosting the Workgroup. All Distributed 
Voicemail Servers will be listed. Voice Model Switches will not be listed.

• Make Number Private -This check box makes the paging group extension 
private. When the paging group is private, it is not listed in the system 
directory and does not appear in the Call Manager dialing lists.

• Enable Priority Paging -This checkbox enables Priority Group Paging. The 
default is unchecked.

• Deliver Group Paging via -This check box allows the administrator to 
configure preferred audio path on the phone to deliver the page.

• Speakphone - The Page is played on the speaker. 

• Active Audio Path - Active Audio path refers to the active media source such as 
a headset or phone handset. 

• Backup extension -The backup extension of the Workgroup. If the Workgroup 
does not answer after the specified number of rings (for example, server 
unavailable or network problem), the call is routed to this extension. This 
allows you to configure backup call routing in case of failures.

• No Answer Number of Rings - This is field is required. Default is 2 rings. This 
is always used for analog phones. It is used for IP phones if the phone is busy.

• Extension List - Select the name of the extension list to be used as the paging 
group from the drop-down list.
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• Group Paging Synchronization Delay- The time in seconds that the server will 
wait to connect to all phones in the extension list prior to sending the audio 
stream to the phones. This delay was introduced to reduce the perception of 
audio echo when paging large groups of phones. The default time is set to 3 
seconds. This is a required field.

Step 5 When finished, click Save.

9.10.2.1 Important Considerations

• When a previously held call is restored, the audio path of the original call is retained. 
However, in a special case—when the page is over a speaker phone and the user 
decides to “cradle” the handset, for example—the audio path is not restored to the 
previous audio path. The audio path would be speaker phone. This exception is for 
Handset only—the headphone should work as expected. The problem with Handset 
is that, today’s ShoreTel IP Phones are not notified when the user puts the handset in 
the cradle (and is on speaker).

• Page-over-Page is not supported, i.e. if you issue a Priority page to an extension, 
while the extension is already being paged, the page is presented as an incoming call. 
This is because we do not have priorities set for page groups. In other words, if there 
were priorities assigned to PGs a page-over-page would result in a lower priority 
page being put on hold and the higher priority page being auto answered.

• Other Paging group limitations apply. SIP/Analog/OAE page will still be delivered 
but the calls cannot be auto answered.

9.11 Pickup Groups
Pickup Groups is a traditional PBX and key system feature used in group environments that 
allows users to answer any ringing phone in that group. The feature works best in places 
where a set of people work together on a daily basis, such as design firms. If a group 
member is away from her desk and across the room when her phone rings, she can quickly 
answer the call from another person's IP phone by pressing the relevant soft key or 
programmable button, or by using a simple star command (*13 + extension) from an 
analog phone.

Similarly, if she is out of the office and her phone rings, anyone can answer her call from 
another phone with a simple 'group pickup' command and take a note for her.

User extensions are added to an extension list and then this list is associated with a pickup 
group. The pickup group has its own extension (e.g. x3755), but this extension is invalid, 
cannot be dialed, and thus acts more like a code than an actual dialable extension.

• Pickup groups can be associated with a programmable toolbar button, or with a 
programmable button on an IP phone, or on IP phones that have soft keys.

• The user whose phone will be picked up must have class of service “Call Pickup 
Allowed” to use this feature. However, other users need not be members of the 
pickup group to pickup a call.

• This feature is not supported on the following legacy ShoreTel switch models: 
ShoreTel T1 and ShoreTel E1.

• The pickup feature will support:

— 24 members per group

— 16 groups per switch
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— The members assigned to all pickup groups on a switch cannot exceed 80

— A single user can be a member of up to 5 pickup groups

• A single switch can host a combined total of up to 24 hunt groups, bridged call 
appearances, and pickup groups.

• This feature can be accessed in three different ways:

— IP Phone – If a programmable button has been configured for this feature, the 
user can press the button, or key, and enter the extension for the pickup group 
to answer the call.

— Communicator – If one of the pre-programmed buttons in Communicator has 
been set up for pickup groups, a user can enter the extension of the group to 
answer the call. If the key has already been programmed with the extension of 
the pickup group, then it is not necessary to enter the extension.

— Analog Phone – The user can enter the *13 command from the keypad, 
followed by the pickup group extension to answer calls from an analog phone.

9.11.1 Configuring Pickup Groups
Configuring the Pickup Groups feature consists of two separate tasks. First, you must 
create an extension list and populate it with the extensions of the members that will belong 
in this group. Second, you must create and name the pickup group and associate it with the 
extension list you just created.

To create the new extension list for a pickup group:

Step 1 Launch ShoreTel Director and enter the user ID and password. Then click the 
Login button.

Step 2 Click Administration > Users > Extension Lists. The Extension Lists page 
appears.

Step 3 Click the New button to to create a new extension lists. The Edit Extension 
List page appears as shown in Figure 9-31.

Figure 9-31 Edit Extension List Page
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Step 4 Enter the desired name in the Name field.

Step 5 Select one or more users from the list on the left pane, and click the Add button 
to move them over to the Extension List Members pane on the right.

Step 6 Click Save to store your changes.

To create a new pickup group and associate it with an extension list:

Step 1 Launch ShoreTel Director still open, click on the Call Control link.

Step 2 Click on the Pickup Groups link to display a window similar to the one shown 
in Figure 9-32:

Figure 9-32 Pickup Groups Page

Step 3 Click the New button to display a window similar to the one shown in Figure 
9-33:

Figure 9-33 Edit Pickup Group

Step 4 Enter a name for the new Pickup Group in the Name field.

Step 5 The Extension field will auto-populate.

Step 6 Click on the Switch drop-down menu and select the appropriate switch for this 
group. You should select the switch that is physically closest to the members of 
the group.

Step 7 Click the Extension List drop-down menu and select the extension list that 
you just created in the previous task.

Step 8 Click Save to store your changes.
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9.12 Route Points
Route points allow third-party applications complete access to call control signalling (using 
TAPI) and the actual voice media stream (using TAPI and WAV APIs). Configuring a route 
point enables calls to be terminated and controlled by a server on the network. To 
configure a route point, click the Route Points link under Call Control in the navigation 
frame. The Route Points list page is shown in Figure 9-34.

Figure 9-34 Route Points List Page

Then click “Add new” to invoke the Route Point edit page (shown in Figure 9-35).
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Figure 9-35 Route Point Edit Page

9.12.1 Parameters
The parameters that appear on the Route Point edit page are as follows:

• Name: This is the name of the route point.

• Extension: This is the extension number of the route point. Each route point 
extension must be unique. This is a required field.

If you change the existing extension number to a new number and there is an 
associated mailbox, messages will be retained. 

• DID: You can assign one DID number to a route point. This is an optional field.
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Refer to “DID Ranges” on page -164 for additional information about DID numbers 
and ranges.

• DNIS: The Edit DNIS Map button invokes the Select DNIS Trunk Group dialog box. 
This lets you select a trunk group for DNIS routing. Only trunk groups that are 
configured for DNIS will be presented in the dialog box. You can assign multiple 
DNIS numbers to a workgroup. This is an optional field.

DNIS is typically used to route 800-number calls to a workgroup or application. 

• Language: Select the route point language from the drop-down list.

• User Group: This drop-down list lets you assign a user group to the route point. 

The route point requires permissions just like a user. For instance, the route point 
call to external call forwarding needs access to trunk groups and has a mailbox. This 
is a required field.

Consult Section 10.3.

• Route Point Server: This selects the server that provides route point services for 
third-party applications. Third-party applications gain control of calls handled by the 
ShoreTel system through route points. This is a required field.

It is recommended that the route point server be a separate server from the 
headquarters server and not be configured with mailboxes.

• Mailbox (server): This provides the route point with a mailbox on the associated 
server. If you change the server, all messages are automatically moved to the new 
server. The default mailbox server is the headquarters server. This is a required field.

• Accept Broadcast Messages: This check box enables the route point mailbox to 
receive broadcast messages. This is an optional field.

• Include in System Dial by Name Directory: This check box includes the route point 
in the auto-attendant dial-by-name directory. This is an optional field.

• Make Number Private: This check box makes the route point extension private. 
When the route point is private, it is not listed in the system directory and does not 
appear in the Communicator dialing lists. This is an optional field.

• Fax Redirect: This check box enables fax redirection. When the route point answers 
a call and a fax tone is detected, the fax is redirected away from the route point to the 
headquarters fax extension. This is an optional field.

• Call Stack Depth: This lets you specify the maximum number of simultaneous calls 
that can be “stacked” on the route point extension. When this number is met, 
additional inbound calls will be routed to the call forward busy destination.

Valid entries are 1 through 200.

Call Stack depth is a licensed feature. 

• Recorded Name: The Record, Play, Enter, and Import buttons let you record a name 
for the route point. The Recorded Name is used as part of the default mailbox 
greeting as well as in the dial-by-name directory. This is an optional field.

You can use your PC microphone and speakers or a telephone to play and record 
within ShoreTel Director. Please refer to the auto-attendant options for more 
information.

You can also import prompts into ShoreTel Director. Prompts must be recorded as μ-
law WAV files.
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• Voice Mail Password: This is the password used for accessing a route point voice 
mailbox over the telephone. Enter a password in the first text-entry field and again in 
the Confirm field. This is a required field.

The default password is “1234”. Passwords may be numeric only.

• Schedule: You can configure schedules for the On-Hours, Holiday, and Custom 
modes that automatically change the call handling of the route point. The rules for 
schedules are:

— If it is custom time, use Custom mode.

— If it is holiday time, use Holiday mode.

— If it is on-hours time, use On-Hours mode.

— Otherwise, use Off-Hours mode.

If no schedules are specified, On-Hours mode is used.

The Edit this schedule link provides a quick way to navigate to the associated 
schedule. This is an optional field.

• Call Handling Call Forward: These buttons let you specify when calls are 
forwarded. The conditions are Always, No Answer/Busy, and Never.

— Always—The Always condition forwards calls to the number specified in the 
Always Destination parameter immediately when a call is received.

— Busy—The Busy condition forwards calls to the Busy Destination immediately 
if the user’s call stack is full.

— No Answer—This condition forwards calls if there is no answer.

— No Answer Number of Rings—Sets the number of rings after which a no 
answer condition is assumed to exist.

This is a required field.

— Always Destination—When the Always call forward condition is selected, calls 
are forwarded immediately to this extension. You can also forward calls to an 
external number (access code required). 

— Busy Destination—When the No Answer/Busy call forward condition is 
selected, calls are forwarded to this extension immediately if the user’s call 
stack is full. You can also forward calls to an external number (access code 
required).

— No Answer Destination—When the No Answer/Busy call forward condition is 
selected, calls are forwarded to this extension after the specified number of 
rings. You can also forward calls to an external number (access code required).

• Mailbox Greeting: This lets the user record a greeting for his or her mailbox, using 
the Record, Play, Erase, and Import buttons. This is on by default.

• Assistant: Each route point can have a personal assistant, which is the destination a 
calling party is transferred upon dialing “0” in the route point mailbox. This is an 
optional field.

• Enable Calling Message Notification: This check box enables message notification 
for this call handling mode. The manner in which the user is notified is determined 
by the user’s message notification settings. The recommended default is off.
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9.13 Call Control Options
Set the general call control options from the Call Control Options page, as shown in Figure 
9-36.

Figure 9-36 Call Control Options Edit Page

9.13.1 Distributed Routing Service
Distributed Routing Service (DRS) lets a large system scale beyond 100 switches to up to a 
total of 500 switches (including SoftSwitches). The DRS is optional on systems up to 100 
switches but must be enabled on systems with 101 or more switches.

When Distributed Routing Service is disabled, ShoreTel switches in a system build an 
internal routing database from the peer-to-peer communication with other switches. Each 
ShoreTel switch contains routing information for all endpoints in the system including 
information regarding trunk selection for outbound calls. When calls are placed from any 
extension, each switch is able to route the call to the correct ShoreTel switch based on its 
internal routing database. 

When Distributed Routing Service is enabled, ShoreTel switches only exchange routing 
information with other switches at the same site rather than exchanging routing 
information with every other switch in a multi-site system. Although each ShoreTel switch 
only maintains routing information within its site, each ShoreTel server also includes an 
instance of the Distributed Routing Service which maintains system-wide routing 
information. When calls are initiated, ShoreTel switches contact the Distributed Routing 
Service in order to find the ShoreTel switch or switches needed to complete the call. 
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In a system with more than one ShoreTel server, the ShoreTel switches may contact an 
alternate instance of the routing service if the primary instance is not reachable. ShoreTel 
servers have a hierarchical relationship and switches first try to contact the nearest instance 
of the Distributed Routing Service in the hierarchy. If that instance of DRS is not reachable, 
the instance of DRS at the parent server in the hierarchy will be contacted as a fallback. If 
both instances of DRS are not reachable the switch will make a best effort to route the call 
based on its internal routing tables built from communicating with peer ShoreTel switches 
at the same site.

9.13.2 Parameters
The parameters on the Call Control Options edit page are as follows:

9.13.2.1 General Parameters Area in the Options Window

• Use Distributed Routing Service for call routing: Enables Distributed Routing 
Service (see preceding explanation.)

• Enable Monitor / Record Warning Tone: When a 2-way or Make Me Conference call 
is monitored or recorded, checking this box causes a tone to be played that warns of 
monitoring or recording. This option is enabled by default.

Deselect this check box to enable silent recording. Silent recording allows operators 
and supervisors to hide the fact that they are recording agents' calls by “silently” 
recording those calls. This behavior can be desirable in certain situations, such as for 
monitoring the telephone manners of an employee.

When the recording is silent or hidden, Communicator offers no visual or audible 
indication that the call is being recorded. The periodic beeping sound (used to notify 
call participants that their calls are being recorded) is suppressed.

Example: ShoreTel does not warrant or represent that your use of call monitoring or 
recording features of the Software will be in compliance with local, state, 
federal or international laws that you may be subject to. ShoreTel, Inc. is not 
responsible for ensuring your compliance with all applicable laws.

Before disabling the warning tone, you may wish to consult with legal 
counsel regarding your intended use.

• Generate an event when a trunk is in use for N minutes: You can set this parameter 
to generate an event log when a trunk has been in use for the specified time period.

• Park Timeout after NNNNNN seconds: You can set how long a call will remain on 
park before the call returns to the party that parked the call. The timeout is in 
seconds and can have a value from 1 to 100,000 seconds. Unchecking the Park 
Timeout check box allows calls to be parked indefinitely.

• Hang Up Make Me Conference after NN minutes of silence: The default timeout is 
20 minutes. If a conference is silent for the set length of time, a hang-up will be 
forced.

• Delay before sending DTMF to Fax Server: Enter the amount of delay (in 
milliseconds) after which the DTMF information will be sent to the fax server. 
Consult your fax server documentation to find out how much delay the fax server 
expects.
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9.13.2.2 SIP Parameters in the Call Control Options Window

• Enable SIP Session Timer: Select this check box to have keepalive heartbeats sent to 
SIP endpoints.

• Session Interval (90-3600): Enter the number of seconds in the Session Interval 
field to specify the keepalive interval at which heartbeats will be broadcast. The 
heartbeat will be sent out at the specified period and if no response is received, the 
session will be dropped. (See RFC 4028 for details on this parameter.)

• Refresher: Use the Refresher drop-down menu to specify whether the SIP Session 
Timer will be applied to the caller or callee. Choices are None, Caller UAC, and 
Caller UAS. (See RFC 4028 for details on this parameter.)

9.13.2.3 Voice Encoding and Quality of Service in the Call Control Options 
Window

• Maximum Inter-Site Jitter Buffer: This parameter sets the maximum size of the jitter 
buffer. A larger jitter buffer might result in more delay between calling parties, which 
might degrade the quality of service. The buffer can be set from 20 to 300 msec. The 
default is 50 msec.

• DiffServ/TOS Byte: This parameter configures DiffServ/ToS for voicemail, 
workgroup, account code collection (ACC), and contact center calls.The value 
entered in this field must be a decimal number between 0 to 255. This setting applies 
to all ShoreTel servers in a ShoreTel system. To enable a new DiffServ/ToS setting, you 
must reboot all ShoreTel servers.

NOTE ToS is an eight-bit field in the IP Packet Header. It is used to 
accommodate applications that require real-time data streaming, as 
specified by RFC 3168. The ToS fields contains a six-bit Differentiated 
Services Code Point and a two-bit Explicit Congestion Notification field.

• Media Encryption: This option specifies the encryption method used by ShoreTel to 
protect payload packets. Refer to the "Media Encryption" on page 310 for more 
information.

• Admission control algorithm assumes RTP header compression is being used: To 
enable this feature, select the check box. 

• Always Use Port 5004 for RTP: By default, this box is checked. This option is not 
available on systems that utilize SIP extensions or SIP trunks.

All IP Phones and switches must be rebooted for settings to take effect. Failure to 
reboot may result in one way media.

9.13.2.4 Video Quality of Service in the Call Control Options Window

• DiffServ/ToS Byte: This parameter configures the DiffServ/ToS field in the IP Packet 
Header of the Video Call payload packet. The default value for the Video DiffServ/
ToS Byte is 0, indicating that priority is not defined for video. Changing this setting 
does not affect active video sessions. The updated value is applied to new video 
sessions. Communicator recognizes the new value without being restarted.
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9.13.2.5 Trunk-to-Trunk Transfer and Tandem Trunks in the Call Control Options 
Window
This lets you manage trunk-to-trunk transfers when the Allow Trunk-to-Trunk Transfer 
parameter is enabled on the Telephone Features Permissions class of service edit page. The 
field is defined in the section called Section 10.2.1.

The ShoreTel system supports trunk-to-trunk transfers, which allow a user to transfer an 
external caller to an external number. Since this feature can lead to unwanted toll charges, 
the system also supports a class of service permission that only grants this feature to 
selected user groups. To grant this permission, you enable the Allow Trunk-to-Trunk 
Transfer parameter on the Telephone Features Permissions class of service edit page. 

Users with trunk-to-trunk transfer permission might accidently transfer an external caller 
to an external number without realizing it. This can lead to “hung” trunks, resulting in the 
inability to make outbound calls or take inbound calls.

The ShoreTel system lets you manage trunk-to-trunk transfers using the Call Control 
Options page. This lets you eliminate unwanted trunk-to-trunk transfers while ensuring 
that valid trunk-to-trunk transfers are not dropped. 

The following are considered trunk-to-trunk transfers:

• A user is talking with an external party and transfers the external party blindly or 
consultatively to an external number.

• A three-party conference call is taking place with one user and two external parties, 
and the user drops from the call.

An external party forwarded to an external number by a user’s call handling mode is not a 
trunk-to-trunk transfer.

• Hang up after N minute(s) of silence: Enabling this parameter automatically drops 
trunk-to-trunk transfers after both parties have been silent for the defined time 
period. The default time period is 60 minutes.

• Hang up after N minutes: Enabling this parameter automatically hangs up the 
trunk-to-trunk transfer after the defined time period. This parameter should be set 
only if truly needed and set for a long period. The default period is 480 minutes.

9.14 Bandwidth Management and Codec Negotiation
ShoreTel supports additional codecs available on ShoreTel IP Phone and through SIP 
devices. Codec negotiation during voice call setup is facilitated by data structures, 
including codec lists and profiles.

Bandwidth Management and Codec Negotiation tools available through Director include:

• Codec lists that are configurable through Director.

• Video codec support

• A Director parameter that permits inter-site video sessions.

• SIP codec negotiation method that complies with RFC 3264 – An Offer / Answer 
Model with the SDP.

9.14.1 Codec Lists
Codec lists enumerate a set of codecs. Director defines two types of codec lists: Supported 
Codecs and Preferred Codecs.
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9.14.1.1 Supported Codecs
Supported Codecs is a comprehensive list of all codecs available to system devices. When 
ShoreTel is initially installed, the Supported Codecs list comprises the set of codecs 
provided by ShoreTel and available on ShoreTel IP Phones. Administrators can add codecs 
to support SIP devices that may use codecs not initially provided by ShoreTel.

The Supported Codecs list also indicates the bandwidth required by each codec. The 
bandwidth numbers are used by ShoreTel to allocate bandwidth as voice calls are initiated 
and terminated.

Supported Codecs list contents, including the bandwidth settings, are passed to all switches 
in the system, where they are used for selecting codecs for individual call sessions.

9.14.1.2 Preferred Codec Lists
Preferred Codec lists are subsets of the Supported Codecs list. Preferred Codec lists are 
referenced by Sites within a ShoreTel system to specify the codecs used for intersite and 
intrasite voice calls. ShoreTel provides six default codec lists which cannot be deleted or 
modified. Administrators can define additional lists through Director.

The default codec lists provided with ShoreTel include:

• Fax Codecs

• High Bandwidth Codecs

• Low Bandwidth Codecs

• Medium Bandwidth Codecs

• Very High Bandwidth Codecs

• Very Low Bandwidth Codecs

9.14.2 Intersite Video Sessions
Intersite Video Sessions are enabled through a Telephony Class of Service setting. ShoreTel 
does not allocate bandwidth for video calls.

9.14.3 Codec Negotiation
ShoreTel supports simultaneous audio, video, and data codec negotiations to facilitate 
multimedia sessions between SIP endpoints as defined by RFC 3264 – An Offer / Answer 
Model with the SDP. Codecs specified in the Supported Codec list are offered during 
session parameter negotiations.

The ShoreTel negotiation process that supports RFC 3264 is as follows:
1. The calling device sends the list of codecs it supports to the ShoreTel servicing the 

call.

2. The ShoreTel switch that controls the calling device compiles a codec list. The codec 
list contains all codecs contained in the following:

— The calling device’s codec list

— One of the site’s codec lists – intersite, intrasite, or fax – depending on the call 
type

Codecs on the combined list are sorted as specified by the selected site codec list.
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3. (Intersite Calls only): The ShoreTel switch that controls the destination device 
modifies the codec list by removing all codecs that are not listed on the destination 
site’s codec list.

4. The ShoreTel switch controlling the destination device sends the codec list to the 
destination device.

5. The destination device replies by sending a list of one or more codecs to the 
originating device.

6. The list sent by the destination device typically includes, from the received codec 
list, the highest priority codec it can support.

7. The two devices begin sending RTP streams using the highest priority codec listed 
in the destination device’s reply.

9.14.4 Implementation

9.14.4.1 Supported Codecs Page
The Supported Codecs page lists the audio codecs that are available to devices making 
voice calls through ShoreTel. Codec lists used when negotiating call parameters comprise 
codecs displayed on this page. Although most commonly used codecs are listed on this 
page, the system can also support other codecs by adding them to the list.

To access the Supported Codecs page, shown in Figure 9-37, select Administration > Call 
Control > Supported Codecs from the Director menu. Each row in the table lists a codec.

Figure 9-37 Supported Codecs Page

Table fields in the Supported Codecs page include:

• Name: This parameter is fully qualified codec ID string of the codec. ShoreTel uses 
this string to specify codecs while negotiating with other calling devices.

The codec ID string comprises the name and sampling rate of the codec. While the 
codec name generally corresponds with the name by which the codec is commonly 
referred, PCMA specifies a G.711 codec (A-law) and PCMU specifies a G.711 codec 
(μ-law).

• Bandwidth (in kbps): This parameter identifies the bandwidth required by the 
codec. ShoreTel uses this figure when allocating bandwidth resources.

• Default: This parameter specifies the source of the codec entry:
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— Yes indicates a codec that was provided with ShoreTel. Default codecs cannot 
be removed from the list.

— No indicates a codec that was provided by the system administrator. These 
codecs can be removed from the list.

To add a new codec to the list, do the following:

Step 1 Click the Add button at the top of the page to open the Supported Codec Info 
popup, shown in Figure 9-38.

Figure 9-38 Supported Codec Info Popup

Step 2 Enter the fully qualified codec ID string in the Name data entry field.

The field must be entered exactly as expected by devices that negotiate call 
parameters.

Step 3 Enter the codec bandwidth in the Bandwidth data entry field.

Entering incorrect numbers in this field compromises ShoreTel’s ability to 
manage bandwidth resources.

Step 4 Press the Save button to store the changes to the database and return to the 
Supported Codecs page.

The Default field is used when editing existing codecs to denote a codec that is 
supplied with ShoreTel. This parameter is not editable.

To edit an existing codec:

Step 1 Click the name of the codec to be edited to open the Supported Codec Info 
popup.

Step 2 Change the contents of the Name or Bandwidth data entry fields.

The Default box is not editable.

Step 3 Press SAVE to store the changes and return to the Supported Codecs page.

9.14.4.2 Codec Lists
Codec lists are subsets of the codecs supported by the ShoreTel system. Codec lists are 
selected in the Edit Sites page to determine the codecs used for intersite and intrasite calls. 
Director pages that support codec lists include the Codec List page and the Edit Codec 
Lists page.

Each codec list must include the PCMU (G.711 μ-law) codec.
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Codec List Page

The Codec List page, shown in Figure 9-39, provides a roster of Codec Lists configured on 
the system. Codec list names, as specified on this page, are used on the Edit Sites page 
when selecting codecs for intersite and intrasite calls. To access the Codec List page, select 
Administration > Call Control > Codec Lists from the Director menu. Each line in the table 
corresponds to a Codec List.

Figure 9-39 Codec List Page

To add a new codec list, open the Edit Codecs Lists page by clicking the New button in the 
top left corner of the page.

To view or edit an existing codec list, open the Edit Codec List page by clicking the name 
of the desired codec list. Default codec lists supplied with ShoreTel cannot be edited.

To delete an existing codec list, select the box left of the desired codec and press the Delete 
button in the top left corner of the page. Default codec lists supplied with ShoreTel cannot 
be deleted.

Edit Codec List

The Edit Codec List page, shown in Figure 9-40, modifies the Codec List specified by the 
Name field contents. The page displays two tables:

• The Choose Codec table lists the codecs available on the system that are not in the 
specified codec list.

• The Codec List Members table displays the codecs that are in the specified codec 
list.
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Figure 9-40 Edit Codec List Page

All codecs available on the system, as defined by the Supported Codecs page, are listed 
either in the Choose Codec table or the Codec List Members table.

To add a codec to the codec list, select the desired codec in the Choose Codec, then click 
the ADD button between the tables.

To remove a codec from the codec list, select the desired codec in the Codec List Members 
table, then click the REMOVE button between the tables.

To change the position of a codec within the Codec List Members table, select the desired 
codec in that table and click the MOVE UP or MOVE DOWN buttons located between the 
tables.

To save Codec List changes, click the SAVE button at the top of the page

To create a new codec list, press the NEW button at the top of the page.

To use the displayed codec list as a template for a new list, click the COPY button at the top 
of the page.

To revert the codec list to the last saved version, click the Reset button at the top of the 
page.

Default Codec Lists

ShoreTel provides six default codec lists that cannot be modified or deleted. The following 
enumerates the codecs, in order of priority, within each list:

• Very High Bandwidth Codecs

— L16/16000

— G722/8000

— BV32/16000

— L16/8000

— PCMU/8000

— DVI4/8000

— BV16/8000

— G729/8000
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• High Bandwidth Codecs

— G722/8000

— BV32/16000

— L16/8000

— PCMU/8000

— DVI4/8000

— BV16/8000

— G729/8000

• Medium Bandwidth Codecs

— G722/8000

— BV32/16000

— PCMU/8000

— DVI4/8000

— BV/8000

— G729/8000

• Low Bandwidth Codecs

— BV32/16000

— DVI4/8000

— BV16/8000

— G729/8000

— PCMU/8000

• Very Low Bandwidth Codecs

— G729/8000

— PCMU/8000

• Fax Codecs

— L16/8000

— PCMU/8000

9.14.4.3 Intersite Video
To configure the Intersite Video setting for a Class of Service:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Class of Service.

Step 3 Click the name of the desired Telephony Features Permissions Class of Service 
in the top table of the page. The edit feature page appears as shown in Figure 9-
41.
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Figure 9-41 Allow Intersite Video Calls parameter

Step 4 Check the Allow Intersite Video Calls check box to allow members of the 
Class of Service to participate in video calls. Clear this setting to deny access to 
video calls.

9.15 Automatic Ringdown
An automatic ringdown circuit comprises predefined devices at the circuit endpoints and 
is configured to ring a recipient device immediately after an initiating device goes off hook. 
Automatic ringdown calls are completed without dialing or any other signaling other than 
the initiating device going off hook. 

The simplest example of an automatic ringdown circuit consists of two points, with one 
telephone at each end of the circuit. When the telephone at one end goes off-hook, the 
phone at the other end immediately rings. Phones without dials may be used on each end 
of the circuit.

Ringdown circuits may be unidirectional or bidirectional.

• In unidirectional circuits, calls always originate from the same end of the network. A 
device on a receiving endpoint going off hook has no effect on the initiating endpoint 
device.

• In bidirectional circuits, both ends can initiate and receive automatic ringdown calls. 

9.15.1 Dedicated Circuit Ringdown
ShoreTel IP Phones with call appearance buttons and the ShoreTel Button Box support 
Dedicate Circuit Ringdown. A call appearance button is programmed for Ringdown by 
configuring it as a Bridged Call Appearance and selecting a Ringdown option. When using 
ShoreTel IP Phones as the calling and recipient devices, an IP Phone button on both devices 
is be configured for Ringdown. ShoreTel supports using external devices as the ringdown 
recipient.

A ringdown call is initiated by pressing the ringdown button on a calling device. The 
ringdown button on the recipient device blinks; the recipient device can be configured to 
ring or remain silent on an inbound ringdown call. The ringdown call is answered on the 
recipient phone either by lifting the handset or pressing the blinking ringdown button. If 
the phone is configured to remain silent when a ringdown call is incoming, the blinking 
button must be pressed to answer the call.
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ShoreTel IP Phones can be configured for one-way or two-way ringdown. When phones are 
configured for one-way ringdown, one phone is defined as the recipient device; pressing 
the ringdown button on that device will not initiate a call to the phone on the other end of 
the circuit. When phones are configured for two-way operation, pressing the ringdown 
button on either device initiates a call to the device on the other end of the circuit.

To force a device to ring until it is answered, the call stack depth for Bridge Call 
Appearances supporting ringdown should be set to 1 and call handling mode transfers 
should be disabled by selecting No Answer.

The following sections describe four typical ringdown configurations. 

9.15.1.1 Basic One-to-One Ringdown
Basic one-to-one ringdown, as depicted in Figure 9-42, is enabled by configuring a Call 
Appearance button on each phone as a Bridged Call Appearance (BCA). During an 
incoming ringdown call, the BCA button on the recipient device blinks.

Figure 9-42 One to One Ringdown Operation

ShoreTel supports one-way or two-way ringdown in this configuration.

9.15.1.2 One-to-many Ringdown
ShoreTel supports one-to-many ringdown operation. When the Ringdown BCA is pressed 
on the calling device, Extension A in Figure 9-43, the corresponding button on all recipient 
devices programmed to receive the ringdown call flashes Green and off. When the call on 
one of the recipient devices is answered, the Ringdown button on the other devices is Red. 
If the answering device places the call on hold, the call is parked to the Bridged Call 
Appearance and is available for all of the recipient devices. Conference calls involving a 
ringdown number that is placed on hold is not parked onto the BCA extension.

Figure 9-43 One to Many Ringdown Operation

Extension BExtension A

One way or two ways

Extension B

Extension C

Extension D

Extension A

One way or two ways

One way or two ways
One way or two ways
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ShoreTel supports two-way ringdown for the one-to-many configuration. When a 
ringdown call is placed from a recipient device, (Extension B in Figure 9-43), the BCA 
button on the other recipient devices (Extensions C and D) becomes solid red when 
Extension A answers the call, indicating that the line is busy. Pressing theses red buttons 
has no effect. If Extension A does not answer the ringdown call, the phone rings until the 
caller on Extension B hangs up or the call handling mode for Extension A handles the call.

9.15.1.3 Multiple ring down buttons
ShoreTel IP Phones with sufficient call appearance buttons support multiple ringdown 
circuits. In Figure 9-44, Extension A is configured to support two ringdown circuits:

Figure 9-44 Multiple Ringdown Buttons

• One ringdown circuit with Extensions B, C, and D at the other end.

• One ringdown circuit with Extension E at the other end.

This configuration requires four Bridge Call Appearance extensions: two BCA extensions 
for Extension A; one BCA extension shared by Extensions B, C, and D; and one BCA 
extension for Extension E.

9.15.1.4 Ring Down to an External Device
Ringdown to an external device is supported by programming the ringdown button to 
access a trunk group that has a unique trunk access code and contains only one trunk. 
When the user presses the ringdown button, it accesses that trunk. 

To place a call over a ringdown circuit to an external device, the user enters the trunk 
access code in addition to the phone number of the device. For instance, when configure a 
analog trunk group to service the ringdown call, the default trunk access code of 9 must be 
dialed to place a ringdown call.

This trunk is not required to be reserved solely as the ringdown circuit. Any user can dial 
this trunk access code to select this trunk. If the trunk is busy, pressing the ringdown 
button generates a busy signal. “Enable CHM” only applies for an incoming call. It is not 

One way or two ways

One way or two ways

One way or two ways

One way or two ways

Extension EExtension A
Ringdown Button 2

Extension D

Extension C

Extension BExtension A
Ringdown Button 1
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applicable for an outbound call. To enable ringdown buttons on the ShoreTel devices 
(Extensions B, C and D in Figure 9-45), the BCA extension must be configured on the 
Trunk Groups page.

Figure 9-45 Ringdown from an External Device

9.15.2 Phone Delayed Ringdown
ShoreTel permits IP phones that provide a dial tone to perform ringdowns by taking the 
handset off hook. If a number is not dialed within a specified period after taking the phone 
off hook, a ringdown call is directed to the predefined recipient device.

When the ringdown device goes off hook by lifting up handset or pressing speaker or 
headset, the ringdown number is dialed if a digit is not entered within the configured 
ringdown delay period. If a digit is entered within this period, the ringdown call is not 
performed.

Analog phones to which a user extension is assigned can receive incoming calls even when 
configured for delayed ringdown calls. When an anonymous user is assigned to the port, 
the device cannot receive incoming calls if it is configured to make delayed ringdown calls.

9.15.3 Ringdown Implementation
Automatic ringdown circuits may also be configured in a one-to-many topology. In these 
circuits, one initiating device rings a group of phones on the other circuit endpoints.

Automatic ringdowns are activated on ShoreTel IP Phones by pushing an IP Phone Call 
Appearance button or lifting a handset on a dedicated ringdown device. These actions 
cause the recipient device to continuously ring until the call is answered or the calling 
party ends the call. The Call Handling Mode on the recipient device is ignored for 
ringdown calls. Automatic ringdown is supported only by phone; Communicator does not 
support automatic ringdown.

ShoreTel implements Ringdown through the following methods:

• Dedicated Circuit Ringdown: Ringdown is immediately initiated when a 
programmed Call Appearance button is pushed or a specified device goes off hook. 
The ringdown call is answered on the recipient by pressing the corresponding Call 
Appearance button or taking the device off hook.

• Phone Delayed Ringdown: ShoreTel permits IP phones that provide a dial tone to 
perform ringdowns by taking the handset off hook. If a number is not dialed within a 

One way or two ways

One way or two ways

One way or two ways

Extension D

Extension C

Extension BExternal Device
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specified period after taking the phone off hook, a ringdown call is directed to the 
recipient device.

9.15.3.1 Director Configuration Pages
Ringdown circuits are implemented by configuring IP Phone buttons for circuit endpoints 
through Director. Delayed ringdown circuits are configured from the Edit User – General 
page.

Configuring IP Phone Buttons

IP Phone Buttons for ShoreTel users are configured from the Program IP Phone Buttons 
page, as shown in Figure 9-46. To access the Program IP Phone Buttons page, open the Edit 
User – Personal Options page for the desired user, then click Program IP Phone Buttons.

Figure 9-46 IP Phone Button Ringdown Options

In the figure above, button #2 is configured to monitor the Bridged Call Appearance 
specified by the Extension data entry field. Selecting Answer Only disables the ringdown 
feature on the specified button. BCA options located below the Normal Operation option 
configure ringdown options for the button.

BCA Ringdown parameters include:

• Dial Tone: Select this option to configure the phone as the recipient on a ringdown 
circuit. Buttons configured with Dial Tone cannot initiate ringdown calls.

• Dial Extension: Select this option to configure the button as the initiating end of a 
ringdown circuit when the recipient is an IP phone located on the ShoreTel network. 
The Extension data entry field specifies the Bridged Call Appearance that is dialed 
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when the IP Phone button is pushed. Buttons configured to perform ringdown calls 
can also receive ringdown calls.

• Dial External: Select this option to configure the button as the calling end of a 
ringdown circuit when the recipient is a device not located on the ShoreTel network. 
The data entry field specifies the phone number that is dialed when the IP phone 
button is pushed; the trunk access code required to access the trunk group dedicated 
to this ringdown circuit must be included as part of the phone number.

Configuring a Delayed Ringdown Circuit

Delayed ringdown circuits are configured on the Edit User – General page for the user 
extension that initiates the ringdown call. Figure 9-47 displays the section of the Edit – 
User General page containing the delayed ringdown parameter fields, which are located in 
the bottom third of the page.

Figure 9-47 Delayed Ringdown Configuration Parameters

Delayed Ringdown Circuit parameters include:

• Delayed Ringdown: Select this checkbox to enable Delayed Ringdown for the 
extension. If this parameter is not enabled, all other Ringdown parameters are not 
selectable.

• Extension: Select this option to specify a ShoreTel extension as the recipient device, 
then enter the extension of the recipient device in the corresponding data entry field.

• External Number: Select this option to specify a phone outside of the ShoreTel 
network as the recipient device, then enter the phone number of the recipient device, 
including the Trunk Access Code of the ringdown trunk, in the corresponding data 
entry field.

• Ringdown Delay: Enter the period of time that the phone waits after the user picks 
up the handset before initiating the ringdown call. Enter 0 in this field to cause the 
phone to immediately dial the ringdown device whenever the handset is picked up.
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9.15.3.2 Ringdown Procedures
The following sections describe the procedures required to implement various ringdown 
circuit configurations.

Implementing a One-to-One Unidirectional Ringdown Circuit

Unidirctional ringdown circuits require two Bridged Call Appearances – one for the calling 
device and one for the recipient device. Both devices in this procedure are ShoreTel 
extensions.

To implement a One-to-One Unidirectional Ringdown Circuit:

Step 1 Create two Bridged Call Appearances as follows:

Step a Launch ShoreTel Director.

Step b Click Administration > Call Control > Bridged Call Appearances. 

Step c Click the NEW button. The Edit Bridged Call Appeances page appears.

Step d Set parameters for a new profile. See the  "Configuring BCA Parameters" on 
page 246 for more information about creating a Bridged Call Appearance 
profile.

Step 2 Program an IP Phone Button on the calling device to make ringdown calls, as 
follows:

Step a Click Administration > Users > Individual Users. The Individual Users 
page appears.

Step b Select the user that you want to allow to use BCA. The Edit User page 
appears.

Step c Click the Personal Options tab.

Step d Click Program IP Phone Buttons. The Program IP Phone Buttons page 
appears.

Step e In the IP Phone Type field, select the type of phone the user uses for bridged 
calls.

Step f For the button that you want to program for the user, do the following:

• In the first Function field, select the All or Telephony.

• In the second Function field, select Bridge Call Appearance. The 
Program IP Phone Buttons page for the Bridged Call Appearance option 
appears as shown in Figure 9-48.
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Figure 9-48 Program IP Phone Button: BCA Option Page

• In the Label field, enter a name that you want to assign this profile.

• In the Extension field, enter the extension number of the BCA profile 
with which you want to associate the user.

• In the Call Stack Position field, select the call escalation order with 
which you want to associate the user.

• In the Ring Delay Before Alert field, select the number of times that you 
want the phone of the user to ring before an automatic message is 
played.

• In the Show Caller ID on Monitored Extension field, click the radio 
button for the value that describes when you want the caller ID of this 
user to display for calls the user monitors.
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• Check the Enable Auto-Answere When Alerting check box to the user 
to use standard means for answering phone calls.

• In the No Connected Call Action section, click the radio button for how 
the call is to be handle when there is not answer.

Step g Click Save.

Step 3 Program an IP Phone Button on the recipient device to receive ringdown calls, 
as follows:

Step a Create a button for a second user as described in Step 2 above.

Step b Enter the second Bridged Call Appearance extension number created in Step 
1 in the Extension Field located right of the button function selection fields.

Step c Select Dial Tone, located below the Extension Field.

Step d Click Save.

Implementing a One-to-One Bidirectional Ringdown Circuit

Creating a bidirectional ringdown circuits differs from creating a unidirectional circuit in 
that the recipient device is configured to make ringdown calls. Both devices in this 
procedure are ShoreTel extensions.

To implement a One-to-One Bidirectional Ringdown Circuit:

Step 1 Create two Bridged Call Appearances.

Bridged Call Appearances are listed in the Bridged Call Appearance list page, 
which is accessed by selecting Administration -> Call Control -> Bridged Call 
Appearances from the Director menu. Press the New button at the top of this 
page to create new BCAs. Refer to the System Administrator’s Guide for 
information on creating Bridged Call Appearance.

Step 2 Program an IP Phone Button on the calling device to make ringdown calls, as 
follows:

Step a Launch ShoreTel Director.

Step b Click Administration > Users > Individual Users.

Step c In the First Name column, click the name of the desired user. The Edit User 
page appears.

Step d Click the Personal Options tab.

Step e Click the Program IP Phone Buttons link. The Program IP Phone Buttons 
page appears.

Step f In the first Function field, select All or Telephony.

Step g In the second Function field, select Bridged Call Appearance. Bridged Call 
Appearance parameters populate the Target pane.

Step h Enter the first Bridged Call Appearance extension number created in Step 1 
in the Extension Field located right of the button function selection fields.
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Step i Select Dial Tone, located below the Extension field, and enter the second 
Bridged Call Appearance number created in Step 1 in the corresponding data 
entry field.

Step j Click Save.

Step 3 Program an IP Phone Button on the recipient device to make ringdown calls, as 
follows:

Step a Repeat Step a through Step e (under Step 2) for the recipient user’s 
extension.

Step b Enter the second Bridged Call Appearance extension number created in Step 
1 in the Extension Field located right of the button function selection fields.

Step c Select Dial Tone, located below the Extension field, and enter the first 
Bridged Call Appearance number created in Step 1 in the corresponding data 
entry field.

Step d Press Save.

Creating One-to-Many Ringdown Circuits

The process for creating a One-to-Many Ringdown Circuit differs from creating a One-to-
One circuit in that the process of configuring the recipient devices is repeated for each 
recipient device in the ringdown network.

Implementing a Delayed Ringdown Circuit

A unidirectional delayed ringdown circuit requires one Bridged Call Appearance that is 
assigned to the recipient end of the circuit.

To create a unidirectional delayed ringdown circuit:

Step 1 Create one Bridged Call Appearance.

Step 2 Program a phone to make ringdown calls, as follows:

Step a Open the Individual User list page in Director by selecting Administration 
-> Users -> Individual Users from the main menu.

Step b Open the Edit User page by clicking the First Name of the desired user in 
the Individual User List.

Step c Click the General tab.

Step d Select Delayed Ringdown and do one of the following:

• Click the Extension radio button and enter the Bridged Call Appearance 
extension that you want to associate with the user in the field.

• Click the External Number radio button and enter the external number 
that you want to associate the user with in the field.

Step e In the Ringdown Delay field, enter period in seconds that you want the 
system to wait for the receiver to respond before dialing the ringdown 
number.

The delay period is the time between when the handset is lifted and when 
the ringdown call is initiated.
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Step 3 Program an IP Phone Button on the recipient device to receive ringdown calls, 
as follows:

Step a Open the Individual User list page in Director by selecting Administration 
-> Users -> Individual Users from the main menu.

Step b Open the Edit User page by clicking the First Name of the desired user in 
the Individual User List.

Step c Select Personal Options on the page selection bar at the top of the page.

Step d Click Program IP Phone Buttons to open the Program IP Phone Buttons 
page.

Step e Select Bridged Call Appearance as the function for the desired IP button.

Step f Enter the initiator’s extension number in the Extension Field located right 
of the button function selection fields.

Step g Select Dial Tone, located below the Extension Field.

Step h Click Save.

Creating a Ringdown Circuit with an External Endpoint

The process for creating a ringdown circuit to an external endpoint differs from the 
procedure for circuits with internal endpoint as follows:

• The number of the recipient device is entered in External Number data entry fields 
instead of the Extension data fields.

These fields are located in the Program IP Phone Buttons page and the Edit User 
page.

• The external number must be accessed through a specific trunk that is configured as 
the only trunk within a trunk group.

• The number of the recipient device includes the Trunk Access Code of the specified 
trunk group.

9.16 Media Encryption
ShoreTel encrypts RTP (payload) packets within the ShoreTel network. Call control packets 
are not encrypted.

9.16.1 System Support
Encryption is enabled or disabled through ShoreTel Director by a system administrator. 
Encryption is enabled or disabled only on a system basis and cannot be enabled for 
individual devices or selected calls. Encryption is transparent to the end user and end users 
have no control over which calls are encrypted. Changing the system encryption setting 
does not alter calls that are in progress; unencrypted calls in place when encryption is 
enabled remain unencrypted until the calls are terminated.

System administrators enable and select an encryption algorithm through ShoreTel 
Director. The following encryption options are available:

• None

• 128 bit ShoreTel Proprietary
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• SRTP - 128 bit AES

SRTP with AES and authentication has a significant impact on the system load when a large 
number of media channels are encrypted.

SRTP-AES encryption is provided on all ShoreTel 9 and later systems and does not require 
an additional license.

9.16.2 Devices

9.16.2.1 Switches and Codecs
Encryption is supported by the following ShoreTel Voice Switches:

• All Voicemail Model switches

• All 1-U Half Width switches

• All 1-U Full Width switches

Switches do not support SRTP with linear (LRNB/8000) or wide-band (LRWB/16000) 
codecs. When SRTP is enabled, codec negotiation excludes these codecs.

ShoreTel switches support a maximum of 36 encrypted media streams. This limitation 
potentially impacts switches that provide T1 or E1 channels with high 3-way conference 
call traffic. 

Each channel in a 3-way conference requires two media stream encryption resources, 
limiting switches to 18 encrypted channels for 3-way conferences. In this scenario, all 
remaining trunks provided by the switch are blocked while 18 channels are engaged in 3-
way conference calls. Switches can service any combination of two-way (one encrypted 
media stream) and three-way (two encrypted media streams) calls that do not exceed 36 
media streams. Analog ports on the SG-220T1A are included in this limitation.

9.16.2.2 Phones and Applications
All ShoreTel IP Phones that run support encryption. SoftPhone, which is available through 
Communicator, also supports encryption.

Communicator and the ShoreTel IP Phones display a padlock icon for each call utilizing 
SRTP encryption is active. The Call History list also uses the padlock icon to denote 
encrypted calls. ShoreTel IP Phones IP210, IP110, and IP115 do not display the encrypted 
call padlock icon. The padlock icon indicates the call media is secure on the ShoreTel 
network; ShoreTel cannot guarantee call security outside of the network, such as calls that 
terminate across an analog or digital trunk. The padlock icon is not displayed when 
Proprietary Encryption is active.

The ShoreTel Conference Bridge, the IP 8000 Conference Phone, voicemail and auto 
attendant do not support SRTP-AES encryption.

Phones that do not support SRTP cannot perform barge in, whisper, or silent monitor 
functions on existing calls that are SRTP encrypted. When added to a call using SRTP, new 
parties using devices that do not support SRTP exchange unencrypted media streams. SRTP 
does not address user registration, call setup, or signaling related security.
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9.16.3 Implementation
The Enable Media Encryption parameter on the Call Control Options page, controls 
encryption.

To configure encryption:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Call Control > Options. The Call Control Options 
page appears as shown in Figure 9-49.

Figure 9-49 Enable Media Encryption option on the Call Control Options Page

Step 3 In the Media Encryption field, select the desired option.

Step 4 Click Save.
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C H A P T E R 1 0

Configuring Users

This chapter provides information about configuring user parameters. The topics discussed 
include:

• "Overview" on page 313

• "Classes of Service" on page 314

• "User Groups" on page 325

• "Individual Users" on page 329

• "Active Directory" on page 342

• "User Management Utilities" on page 350

10.1 Overview
The Users link in the Director navigation pane provides access to the windows for 
Individual Users, User Groups, Class of Service, Notify Users, Anonymous Telephones, 
Extension Lists, Batch Update Utility, and Call Handling Mode Defaults. Within these 
windows, user accounts can be added and edited and receive assignments for their phone 
properties. Figure 10-1 shows the navigation pane and the Individual Users list.

Figure 10-1 Users Navigation Links
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The task of creating user accounts actually begins with the specification of the classes of 
service (COS). In the larger sense, configuring users has a specific order: 

1. Classes of service (COS)

2. User groups

3. Individual users

Having the following information expedites the whole user configuration process:

• A list or outline of the COSs that are appropriate for the ShoreTel deployment and 
available for assignment to user groups

• A list or outline of user groups to which individual users are assigned

• A list of new users to add to the system

A ShoreTel system comes with default classes of service and user groups.

10.2 Classes of Service
A class of service grants permission to a specified set of features and privileges. Users 
assigned to a class of service can access the specified features and privileges. ShoreTel 
defines three types of service classes: telephony features, call permissions, and voicemail 
permissions.

Configuring classes of service is the first step in configuring users. To configure Class of 
Service, you must access the Class of Service page. To access the Class of Service page, do 
the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Class of Service. The Class of Service page 
appears as shown in Figure 10-2.

Figure 10-2 Class of Service Page

You can configure permissions for telephony features, outside calling, and voice mail usage. 
Descriptions and instructions are provided for these permissions in the following sections:

• "Telephony Features Permissions" on page 315
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• "Call Permissions" on page 321

• "Voice Mail Permissions" on page 323

10.2.1 Telephony Features Permissions
This section describes the classes of service that can be configured from the Telephony 
Features Permissions edit page. Telephony features permissions are assigned to user groups 
and define how users can use their telephone features, such as call stack depth, paging, and 
call forwarding to an external number. 

To configure a telephony feature class of service:

Step 1 Navigate to the Class of Service window.

Step 2 Click one of the preconfigured COS profiles (Fully Featured, Minimally 
Featured, or Partially Featured) or the Add New link to create a new class of 
service for Telephony Features. The Edit Telephony Features Permissions page 
for the class of service you select appears as shown in Figure 10-3.
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Figure 10-3 Telephony Features Permissions Edit Page – Top
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Step 3 Specify the following COS parameters:

• Name: This specifies a descriptive name of the COS that you are creating or editing.

• Max. Call Stack Depth: This lets you specify the maximum number of 
simultaneous calls that can be “stacked” on a user’s extension. When this number 
is met, additional inbound calls are routed to the call forward busy destination.

Valid entries are 1 through 16

• Max Buddies Per Users: This option specifies the number of individuals that a 
service class member can designate as a contact in Communicator. Users can 
monitor presence status of their contacts.

• Max. Parties in Make Me Conference: This lets you specify the maximum number 
of parties that can be included in any Make Me Conference call made from your 
site. Select the number of parties from the drop-down. The default number is 3. 
Valid values are 3 through 6. 

• IM Presence Invitation Handling: This option designates the default method of 
handling requests for viewing IM presence status. Each user can specify personal 
handling methods through Communicator.

• Allow Call Pickup: This check box enables call pickup, which lets users pick up 
any ringing extension (including the night bell) or pick up any parked call.

• Allow Trunk-to-Trunk Transfer: This check box enables trunk-to-trunk call 
transfers. A trunk-to-trunk transfer is defined as follows:

— An internal party is talking with an external party. The internal party transfers 
the external party blindly or consultatively to an external party via the telephone 
or a ShoreTel Communicator application.

— A three-party conference call with one internal party and two external parties 
when the internal party drops from the call via the telephone or a ShoreTel 
Communicator application.

A trunk-to-trunk transfer is not an external party forwarded to an external number 
by a user’s call handling mode. This is not to be confused with Allow External Call-
forwarding.

This feature is automatic and by-passes toll-related call permissions. If there is the 
potential for toll fraud by employees who might abuse this feature, limit this 
permission to only a few select user groups. For example, only the executive and 
sales user groups may be granted permission.

If this parameter is enabled, trunk-to-trunk transfers can be managed from the Call 
Control Options edit page.

• Allow Overhead and Group Paging: This check box lets users dial any site paging 
extension and make an announcement using the overhead paging system or group 
paging. 

• Allow Make Hunt Group Busy: If granted, this permission allows the user to busy 
out a hunt group or return it to service by keying *18 on the telephone keypad. In 
addition, the Quick Look Maintenance page can be used to busy out or return a 
hunt group to service. Calls will be forwarded to the Busy Destination set in the 
Hunt Groups page. 

Should a hunt group be busied out while on a holiday or off-hours schedule, the 
schedule takes precedence. 
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• Allow Extension Reassignment: This check box lets users reassign their extension 
to another telephone.

• Allow PSTN Failover: This check box indicates that site-to-site calls that fail over 
proprietary routes will be automatically made over a PSTN number. The PSTN 
number to use in case of failure must be entered on the User edit page. 

• Show Caller ID Name and Number on Monitored Extensions: Select this check 
box to enable the monitoring party to see information about the incoming calls on 
the monitored party's line. If unchecked, the incoming call will still be shown with 
an icon and LED, but not textually in the announcement area.

• Enumerate Individual Held Calls for Unpark: Select this option to authorize users 
to view individual calls parked on another user’s call stack. User’s require this 
authorize to specify the call to be unparked from another user’s stack.

• Allow Customization of IP Phone Buttons and Communicator Monitor 
Windows: Select this check box to allow users to configure the programmable 
buttons on their ShoreTel IP Phone or BB24 device.

Clear the check box to prevent users from being able to configure custom buttons. 
This action will, for example, prevent users from being able to configure their 
phones to monitor the extension of anyone they please and will require that 
extension monitor, and other features, be set up by a system administrator. 

Without the box checked, only the system administrator can configure a user's 
phone for extension monitoring. Extension Monitor will only monitor those 
extensions that are monitored on the phones. If there are none, extension Monitor 
is disabled.

• Show Extensions with Different Prefixes in Directory: Select this check box to 
display extensions that have different prefixes. The On-Net Dialing feature often 
results in a remote site having a different prefix from a headquarters site. Enabling 
this check box will cause all extensions (even those at the remote sites) to appear in 
the directory.

• Allow Collaboration Features: Checking this box allows document sharing. See 
Chapter 11: Configuring Client Applications on page 361 for additional 
information

• Allow Recording of Own Calls: Checking this box grants permission to record 
one’s own calls. This will also be impacted by the Enable Monitor/Record Warning 
Tone parameter in Chapter 9.

• Allow Intersite Video Calls: When this option is selected, class members are 
authorized for video calls with users located at other ShoreTel sites.

• Allow Call Notes: Enables the Call Notes feature in ShoreTel Communicator that 
allows users to make text notes during calls. Notes appear in the call history.

NOTE If the Call Notes feature is disabled in ShoreTel Director, existing notes 
will remain available for users to view but will not be editable.

• Show Call History: Enables the Call History feature in ShoreTel Communicator. 
This feature allows users to view call activity on their ShoreTel extension.

• Directed Intercom/Paging: The Allow initiation check box and Accept radio 
buttons can be used to configure the intercom/paging calls function. 

For more information about this feature, see the "Intercom, Whisper Paging, Barge 
In, Record, and Monitor" on page 436.
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• Barge In: Barge In permits one party to join an existing call as a fully conferenced 
participant. When barge in is initiated, a brief intrusion tone is played to the other 
participants and (if present) the monitor/record warning tone is discontinued. 
Checking Allow Initiation allows users with this CoS to barge in on users with 
Accept Barge In enabled.

See the "Call Handling Mode Delegation" on page 435 for details on configuring 
this option.

• Record Other’s Calls: Select this check box to allow a user to record the calls of 
another user (for example, a that a supervisor can record the calls of an agent in a 
call center).

The “Selectable Mailboxes” feature allows the automatic placement of recorded 
calls into mailboxes other than that of the client who initiated the call recording. 
See “Record Call” and “Record Extension” in Table 12-1 for details.

A monitor/record warning tone is played. To make recordings silent, disable the 
warning tone. See the"General Parameters Area in the Options Window" on page 
291 for details.

See the "Intercom, Whisper Paging, Barge In, Record, and Monitor" on page 436 
for details on configuring this option.

• Silent Monitor/Silent Coach Other’s Calls: Allows a supervisor to monitor a phone 
call of a user and to speak to the user without the other party hearing. These check 
boxes allow the user to monitor calls. The monitor/record warning tone is played if 
enabled in Call Control.

See the "Intercom, Whisper Paging, Barge In, Record, and Monitor" on page 436 
for details on configuring this option.

• Allow Call Handling Changes: These check boxes allows users to make changes to 
their call handling settings.

— Current Mode—Checking this box allows users to change their current call 
handling mode from ShoreTel IP Phone IP phones and Personal 
Communicator.

— Detailed Settings—Checking this box allows users to change all call handling 
settings, such as call forward destinations, from Personal Communicator.

• Allow External Call-forwarding and Find Me Destinations: This check box lets 
users forward incoming calls to an external number, as restricted by the Scope, 
Restrictions, and Exceptions parameters.

This must not be confused with Allow Call Transfer Trunk to Trunk.

• Allow External Extension Reassignment: This check box allows users in this COS 
to assign their extension to a PSTN phone for use with the Extension Assignment 
feature. If this check box is marked, the user is able to use a cell phone or home 
phone as an extension of a phone in the ShoreTel network.

— Allows External Assignment: 

Allow Additional Phones to Ring Simultaneously and to Move Calls: This feature 
lets users configure one or two additional phones to ring at the same time as their 
main ShoreTel phone rings. The user can specify the phone number of additional 
phones in ShoreTel Communicator, or the administrator can configure these phone 
numbers in the ShoreTel Director's individual user page (Personal Options > 
External Assignment and Additional Phones).
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After this feature is configured, the user simultaneously receives calls on the 
ShoreTel extension and his or her additional phones. As a convenience, the user 
can suspend this function by using Communicator. Also, an optional ring delay can 
be configured by the Administrator to let the main telephone ring a configurable 
number of times before the additional phones start ringing.

After the Simultaneous Ringing call is established, the call can be moved between 
the Simultaneous Ringing devices. The Call Move mechanism can be initiated by a 
“Call Move” IP Phone programmable button on the ShoreTel IP 655 Phone (other 
options are available on ShoreTel IP Phones, Analog and SIP devices, and ShoreTel 
Communicator).

• Scope: Scope allows a general permission level setting. Levels are presented 
from the most restrictive to the most permissive. The Restrictions and 
Permissions listed are applied in addition to the general scope setting.

— Local Only allows forwarding or extension reassignment only to local 
or additional local area codes, as defined on the Site edit page.

— National Long Distance also allows forwarding or extension 
reassignment to long-distance numbers within the country, as defined 
on the Site edit page.

— National Mobile allows forwarding or extension reassignment to 
mobile numbers. Some countries use “caller pays” mobile calling, so do 
not select this radio to avoid incurring the associated costs of calls 
being sent to a mobile phone.

— International Long Distance also allows forwarding or extension 
reassignment to international numbers, as defined on the Site edit page.

— All Calls allows forwarding or extension reassignment to any number, 
including 900, Operator Assisted, and Carrier Select numbers. This is 
the default.

• Restrictions: Restrictions are applied in addition to the Scope. Follow these 
rules for specifying restrictions:

— The comma-separated restriction expressions have a limit of 50 
characters, total (including commas and semicolons).

— Numbers must be entered in canonical format, including the 
international designation “+” and country code. For example, to 
restrict forwarding to the 408 area code in the U.S., use +1408.

— Non-routable calls (311, 411, etc.) for a country must be designated by 
the country code plus the “/” character. For example, to restrict 
forwarding to 311 in the U.S., use 1/311.

— Each field can contain multiple entries as long as they are separated by 
commas or semicolons.

— Each entry must consist of numbers only.

— Access codes (such as 9) must not be included

— The wildcard of “x” can be used.

When a call is both restricted and permitted, it is permitted. For example, 
restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 
area code except those to 408 331-xxxx.
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• Permissions: Permissions are applied in addition to the Scope. Follow 
these guidelines for specifying permissions:

— The comma-separated permission expressions have a limit of 50 
characters, total (including commas and semicolons).

— Numbers must be entered in canonical format including the 
international designation “+” and country code. For example, to permit 
forwarding to the 408331 area code and prefix in the U.S., use 
+1408331.

— Non-routable calls (311, 411, etc.) for a country must be designated by 
the country code plus the “/” character. For example, to permit 
forwarding to 311 in the U.S., use 1/311.

— Each field can contain multiple entries as long as they are separated by 
commas or semicolons.

— Each entry must consist of numbers only.

— Access codes, such as 9, must not be included.

— The wildcard of “x” can be used.

When a call is both restricted and permitted, it is permitted. For example, 
restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 
area code except those to 408 331-xxxx.

10.2.2 Call Permissions
This section describes the types of call permissions the ShoreTel administrator can set. Call 
permissions are classes of service that specify the type of call users are allowed to dial. Call 
permissions are assigned to user groups. Figure 10-4 shows the Call Permissions edit page.

Figure 10-4 Call Permissions Edit Page

The parameters on the Call Permissions edit page are as follows:

• Name: A descriptive name of the COS being added or edited.

• Scope: The scope is a general permission level. The scopes in the window descend 
from most restrictive to most permissive. The Restrictions and Permissions list is 
applied in addition to the general scope for the COS.

— Internal Only allows calls only to internal extensions and to the configured 
emergency number.
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— Local Only allows calls only to local or additional local area codes, as defined 
on the Site edit page.

— National Long Distance also allows calls to long-distance numbers within the 
country, as defined on the Site edit page.

— International Long Distance also allows calls to international numbers, as 
defined on the Site edit page.

— All Calls allows calls to any number, including 900, Operator Assisted, and 
Carrier Select numbers, as well as use of Vertical Service Codes. This is the 
default.

• Restrictions: Restrictions are applied in addition to the Scope setting. The rules for 
specifying restrictions are as follows:

— For this COS, the maximum number of characters in the comma-separated 
restriction expressions is 255. 

— Numbers must be entered in canonical format including the international 
designation “+” and country code. For example, to restrict calls to the 408 area 
code in the U.S., type +1408.

— Non-routable calls (311, 411, and so on) for a country must be designated by 
the country code plus the “/” character. For example, to restrict 311 in the U.S., 
type 1/311

— Each field can contain multiple entries as long as they are separated by commas 
or semicolons.

— Each entry must consist of numbers only.

— Access codes, such as 9, must not be included.

— The wildcard of “x” can be used.

If a call is both restricted and permitted, it is permitted. For example, restricting +1 
408 and permitting +1 408 331 restricts all calls to the 408 area code except those 
to 408 331-xxxx.

• Permissions: Permission are applied in addition to the Scope setting. The rules for 
entering restrictions are as follows:

— For this COS, the maximum number of characters in the comma-separated 
permission expressions is 255. 

— In general, numbers must be entered in canonical format including the 
international designation “+” and country code. For example, to permit calls to 
the 408331 area code and prefix in the U.S., use +1408331.

— Non-routable calls (311, 411, and so on) for a country must be designated by 
the country code plus the “/” character. For example, to permit 311 in the U.S., 
use 1/311

— Each field can contain multiple entries as long as they are separated by commas 
or semicolons.

— Each entry must consist of numbers only.

— Access codes, such as 9, must not be included.

— The wildcard of “x” can be used.
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If a call is both restricted and permitted, it is permitted. For example, restricting +1 
408 and permitting +1 408 331 restricts all calls to the 408 area code except those 
to 408 331-xxxx.

10.2.3 Voice Mail Permissions
This section describes the classes of service that you configure from the Voice Mail 
Permissions edit page, shown in Figure 10-5. Voice mail permissions are assigned to user 
groups, providing users with specific usage of the ShoreTel voice mail system.

Figure 10-5 Voice Mail Permissions Edit Page

The parameters on the Voice Mail Permissions edit page are as follows:

• Name: This is a descriptive name of the CoS record that you are creating or editing.

• Incoming Message Length: This is the maximum length of an incoming voice mail 
message.

Valid values are from 1 to 3600 seconds. The default is 300 seconds.

• Incoming Max. Messages: This is the maximum number of messages that can be 
queued in a mailbox, including new, saved, and deleted messages.

Valid values are from 1 to 500 messages. 

• Outgoing Message Length: This is the maximum message length that a user can 
record before sending a message to another extension. This parameter controls 
both the composed message and the greeting.

Do not confuse this with the user’s personal voice mail greeting.

Valid values are from 1 to 3600 seconds.

• Lifespan of Voicemail Password: Select this check box to have the system 
periodically require users to change their TUI passwords. It is recommended to 
enable this feature as requiring periodic password changes increases the security of 
the system.

The password change applies to the following Dialed Number types:
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— User extensions

— Workgroup extensions

— Route point extensions

— External user extension

Valid values are from 30 to 365 days. The default value for the time limit is 90 days.

• Days in Advance of Password Expiration Before Warning: When the Lifespan of 
Voicemail Password is selected, this option to warn users that their password is 
about to expire also becomes active. Select the check box to enable the feature, thus 
allowing users to be notified prior to the expiration of their passwords, and giving 
them time to proactively change their passwords days or weeks in advance of the 
actual expiration date.

Enable the feature by selecting the check box and then entering the number of days 
((prior to the password expiration), at which point group members will begin 
receiving warning messages. If the check box is not selected or if “0” is placed in 
the data entry field, password expiration warning messages are not delivered to the 
group member.

Valid values are from 1 to 30 days. The default value for the time limit is 7 days.

• Allow Access to Broadcast Distribution List: This gives users access to the 
company-wide distribution list. A user with this permission is able to broadcast 
voice mail messages to all users throughout the company.

• Allow Access to System Distribution Lists: This gives users access to system 
distribution lists.

• Allow Message Notification: This enables message notification. It might be further 
qualified by Allow Message Notification to External Number.

This is enabled as a system default.

• Allow Message Notification to External Number: This permits message 
notification to an external number. It cannot be set unless Allow Message 
Notification is enabled.

This is enabled as a system default.

• Auto-Delete:

— Delete Saved / Unheard Messages after (30-2000) days: Select this check box 
to have the system automatically delete saved or unheard voice mail messages 
that are older than n days. 

Valid values are from 30 to 2000 days. The default value for the time limit is 0 
days (meaning the feature is disabled).

— Delete Heard Messages after (30-2000) days: Select this check box to have the 
system automatically delete heard voice mail messages after n days.

Valid values are from 30 to 2000 days. The default value for the time limit is 0 
days (meaning the feature is disabled).

As with Saved/Unheard messages, the user will receive several warnings before 
messages are deleted (see above for details).

— Enable Auto-Delete Notification: Select this check box to have the system 
automatically delete heard voice mail messages after n days. This option is 
available only if “Delete Saved / Unheard Messages after (30-2000) days” or 
“Delete Heard Messages after (30-2000) days” is selected.
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If enabled, users who have messages older than the expiry time limit will 
receive multiple warnings in the form of email and/or voice mail messages 
indicating that their voice mail messages (that exceed the time limit) will be 
deleted. The first warning is sent two weeks before the expiration deadline, and 
a second message is sent one week prior to deadline.

After the time limit has passed, the user will receive a message similar to the 
following: “Your mailbox was cleaned automatically; n messages were deleted.”

This message can be emailed to the user if an email address is specified in the 
profile of the ShoreTel recipient.

10.3 User Groups
Configuring user groups is the second step in configuring users. 

10.3.1 Viewing User Groups
To view the available user groups, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > User Groups. The User Groups page appears 
as shown in Figure 10-6.

Figure 10-6 User Groups List Page

User Group List page column definitions are as follows:

• Name: This is the name of the user group.

• Telephony Features: This is the telephony features permissions CoS associated 
with the user group.

• Call: This is the call permissions CoS associated with the user group.

• Voice Mail: This is the voice mail CoS associated with the user group.

• SMDI: This is the Simplified Message Desk Interface mode set for the user group. 
Also see the "Legacy Voice Mail Integration" on page 75.

• Account Codes: This is the account code collection mode set for the user group. 
Also see the "Multi-site Account Codes" on page 240.
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• DID As CESID: Indicates whether a DID number should be sent as the Caller’s 
Emergency Service ID number for a 911 emergency call.

10.3.2 Creating a User Group
To create a user, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > User Groups. The User Groups page appears.

Step 3 Click Add new. The Edit User Group page appears as shown in Figure 10-7.
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Figure 10-7 User Group Edit Page

Step 4 Configure parameters for the user group as follows:

• Name: This is a descriptive name of the group you are adding or editing.
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• COS – Telephony: This is the telephony features permissions COS associated with 
the user group.

• COS – Call Permissions: This call permission COS is associated with a user group.

• COS – Voice Mail: This is the voice mail permissions COS record associated with 
the user group.

• Send Caller ID as Caller’s Emergency Service Identification (CESID): The caller 
ID configured on the User’s page is the telephone number sent to the service 
provider when a user dials an emergency services number (e.g., 911 in the U.S.). 
Default setting is checked on. If this option is not selected, the outbound caller ID 
will be either the user’s DID or the site’s CESID.

For more information on setting up emergency dialing, see Appendix A, 
"Emergency Dialing Operations" for more information.

• Send DID as Caller’s Emergency Service Identification (CESID): This telephone 
number is sent to the service provider when a user dials an emergency services 
number from a home phone (for example, 911 in the U.S.). If this option is not 
selected and Send Caller ID as Caller’s Emergency Service Identification (CESID) is 
also not selected, the outbound caller ID becomes the site’s CESID.

For more information on emergency and 911 calls, see Appendix A, "Emergency 
Dialing Operations" for more information.

• Account Code Collection: Select from Disabled, Optional, or Forced account code 
collection for the selected user group.

— Disabled—Account collection is not active for this group.

— Optional—Users are prompted to enter an account code. If no account code is 
entered, the call is completed without account code records. 

— Forced—Users must enter an account code for all calls outside the bounds of 
the call permissions set for the user.

For more information about account codes, see the "Multi-site Account Codes" on 
page 240.

• Show Communicator users a list of account codes when dialing: Enabling this 
option allows Communicator users to select an account code from the complete list 
of account codes when prompted for an account code. Disable this feature to 
restrict the user’s visibility of account codes.

• Outgoing Trunk Groups (Access Code): Select the trunk groups to which this user 
group has access for outgoing calls. You can assign multiple trunk groups for this 
user group.

• Voice Mail Interface Mode: This parameter allows you to specify special routing to 
the voice mailbox for users associated with this user group. Choose any of the 
following:

— None: The user uses a standard ShoreTel voice mailbox.

— External Voice Mail, QSIG: Connects to an external voicemail system using 
QSIG protocol.

— External Voice Mail, SMDI: Connects to an external voicemail system using 
SMDI protocol.

— External Voice Mail, SIP: Connects to an external voicemail system using SIP 
protocol.
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— ShoreTel Voice Mail, SMDI: Connects to a legacy ShoreTel system using SMDI 
protocol.

• User Profile:

• Phone Application:

— On Idle:

— Available Applications:

• Ringtone:

• Wallpaper:

10.4 Individual Users
Configuring individual users is the final step in setting up user parameters. From the 
Individual Users list page, shown in Figure 10-8, invoke the Edit User page by selecting a 
site and clicking Go. The Edit User page specifies the user’s general information, personal 
options, distribution lists, and workgroups.

Figure 10-8 Individual Users List Page

If there are more users than can be displayed on one page, use the forward and backward 
arrows to page through the names and specify the number of records to display per page.

10.4.1 Individual Users List Page
The columns in the Individual Users list page are defined as follows:

• First Name: The first name of the user.

• Last Name: The last name of the user.

• Site: The site associated with the user.

• User Group: The user group that is associated with the user.
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• Client Type: The Communicator type for which the user is authorized.

• Extension: The user’s extension.

• Mailbox: The user’s voice mailbox.

• Switch: The switch associated with the user.

• Port: The port associated with the user or the MAC address of an IP phone. 

• Status: This shows the user’s telephone port status. 

Home indicates that the user is at his or her home telephone port; Assigned 
indicates otherwise.

To add or edit a user’s profile from the Edit User page, fill out the four tabs – General 
information, Personal Options for user options, Distribution Lists, and Workgroups – as 
described in the following sections. For information on importing user information from a 
spreadsheet, see the "User Import Tool" on page 350.

10.4.2 User Configuration Pages

10.4.2.1 General Page
General information about new and existing users is provided under the General tab on the 
Edit User page. Many data entry fields are automatically filled from other Director fields.

The following three subsections describe parameters on the General page.

Upper-Section Parameters

The parameters in the upper portion of the Edit User: General page, are shown in Figure 
10-9.
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Figure 10-9 Edit User: General Page
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The following are description of parameters located in the Edit User: General page:

• First Name: Specifies the first name of a user, fax machine, conference room, or 
“virtual user.”

• Last Name: This is the last name of the user.

• Number: This is the user’s extension.

When configuring a new user, this field auto-fills with a number based upon a local 
cookie that was stored the last time a new user was configured.

• License Type: Set the user’s license type from the following values: Extension and 
Mailbox, Extension-Only, and Mailbox-Only.

— Extension and Mailbox—The user will have both a phone extension and an 
internal ShoreTel mailbox for voice mail.

— Extension-Only—The user will have an extension but no mailbox. Use 
Extension-Only if, for example, the user has a mailbox for voice mail on a 
legacy switch or PBX. Selecting Extension-Only results in the following:

• The voice mail server drop-down menu and associated check boxes are 
disabled.

• User groups with SMDI ShoreTel voice mail are not available.

— Mailbox-Only—The user will have a mailbox on the ShoreTel switch but will 
not have a phone extension. Selecting Mailbox-Only results in the following: 

• User groups with SMDI External voice mail are not available

• Ports cannot be assigned to Mailbox-Only users.

• Extension Assignment is not available to Mailbox-Only users, regardless of 
CoS settings.

ShoreTel capacity is licensed by user license type. Make sure you have licenses 
for all users and required types.

• Access License: The access license field enables assignment of various levels of 
permissions for users using the ShoreTel Communicator application. Select from:

— Personal (default)—This access level is available to all users and delivers 
desktop call control, visual voice mail, call history, and directory services, as 
well as options to control call handling and message notification. Since this is 
the default client configuration, it does not require a special license. 

— Professional – This access level provides access to all functions available 
through Personal Communicator plus Instant Messaging, Presence, Contact 
Viewer, and SoftPhone. A video license is also provided to users that have rights 
to Professional Communicator, providing access to VGA video.

— Workgroup Agent—This access level is typically assigned to members of a 
workgroup and provides access to all features available through Professional 
Communicator, plus workgroup features—including login, logout, wrap-up, 
queue monitor, and shared workgroup mailbox—and the ability to transfer 
calls by dragging and dropping call cells into the buddy list. Does not include 
access to video.

— Workgroup Supervisor—This access level is typically assigned to the 
supervisor of a workgroup and provides access to the agent monitor, in 
addition to all features available to Workgroup Agents.
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— Operator—This access level is typically assigned to operators, secretaries, and 
executive assistants. In addition to all features available in Workgroup 
Supervisor, it provides access to XGA Video and detailed information about 
destination extensions, including access to an extension monitor.

— Enable Contact Center Integration

• Caller ID: This number is used for caller ID on outbound calls. A caller ID entered 
here will take precedence over the user’s DID and the site’s CESID number (both 
for normal outbound and 911 calls). If no number is entered, the user’s DID or the 
site’s CESID will be used for outbound caller ID.

This feature is available only on outbound calls using a T1 PRI trunk.

• DID Range: This provides the user with a Direct Inward Dial (DID) number. This 
requires that DID services are properly configured against the desired trunk group. 
This is enabled by default if a DID trunk group is configured.

— DID Number: In the field, enter the DID number that you want to assign to the 
user.

• PSTN Failover: Select from None, DID, or a specific phone number. When a 
specific phone number is to be entered, a text box opens. This field supplies the 
PSTN number to be dialed to complete a failed site-to-site call. When DID is 
selected and a call fails, the call is routed via the PSTN network to a local PSTN 
DID number for the user. When an external number is supplied and a call fails to 
go directly to its intended extension, the call is routed to the number indicated, for 
example, an auto-attendant.

The user must have a Class of Service that has “Allow PSTN Failover” enabled. See 
the "Classes of Service" on page 314 for more information.

If there is no available bandwidth or if a WAN is down for a site to site call and if 
the call destination has no PSTN failover, the call is directed to voice mail.

• User Group: This displays all user groups. Associate one group with the user. The 
system default is Executives. However, this default value may be modified using the 
Preferences menu of Director. Clicking Go to this User Group invokes the 
associated user group page.

• Site: This is the site for the user. This filters the list of switch ports that you must 
select from as well as provide a different default DID number if available.

• Language: Select the language this user will hear for voice mail prompts from the 
drop-down list of available languages.

• Primary Phone Port: This displays a list of available switch ports and IP phones. 
Select the switch port or IP phone to be associated with this user. 

If assigning an analog port and a selection is not specified, ShoreTel Director selects 
the next available port.

Selecting IP Phone causes the drop-down list to display Any IP Phone as the 
default. For information about the Any IP Phone feature, see Chapter 12: 
Configuring User Features on page 409.

If y Port is selected, the drop-down list displays ports available for phone use. 

To create a user without a port (a virtual user), select SoftSwitch as the home port.

Assigning users to an analog port or SoftSwitch for their home port can cause the 
loss of phone service if the user selects the Go Home option in Communicator. 
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ShoreTel recommends that Extension Assignment users be assigned Any IP phone 
as their home port.

• Current Port: This field indicates the user’s current switch port. This shows which 
switch port the user has assigned himself or herself. This field cannot be changed 
directly. Change the current port setting to the home port by clicking Go Home. 

Clicking Go Home causes the system to force the user back to his or her home 
telephone. This option is useful when a temporary user is no longer using that 
phone.

• Jack #: This is an informational field where the patch-panel jack number associated 
with the user’s switch port may be recorded.

• Mailbox on Server: This enables the user’s voice mailbox. The drop-down list 
allows selection of the server to host this mailbox. This is enabled by default.

Changing a user’s server requires the user exiting and re-launching the client to 
establish a connection to the new server.

— Escalation Profiles and Other Mailbox Options: 

• Accept Broadcast Messages: When enabled, this lets individual users receive 
broadcast messages. Disable this feature for users who do not want to receive 
broadcast messages. This is enabled by default.

• Include in System Dial By Name Directory: When enabled, this causes the user’s 
name to be included in the auto-attendant’s dial-by-name directory.

This is enabled by default.

• Make Number Private: Checking this check box removes this number from the 
system directory and call handling destination lists.

• Fax Support: If a port is connected to a Fax machine and is in an environment 
where SIP PSTN gateways are used, this option can be configured such that the 
switch will freeze the jitter buffer and disable the echo canceller at the beginning of 
the call to ensure that FAXes are clearly and reliably transmitted. (Although jitter 
buffer and echo canceller enhance the quality of voice calls, they also impede 
reliable Fax transmission.) Options are:

— User - No Redirect (Extension is connected to a user; do not redirect inbound 
Fax calls)

— User - Redirect (Extension is connected to a user; redirect inbound Fax calls to 
site Fax redirect extension)

— Fax Server (Extension is connected to a Fax server; do not redirect inbound fax 
calls but pulse DTMF digits)

— Fax Machine (Extension is connected to a fax machine; do not redirect 
inbound fax calls)

— Non-T38 Data Terminal 

— Non-T38 Fax Server 

• Allow Video Calls: Selecting this option allows the user to perform video calls. 
Video calls is a user-licensed feature.

— None Disables video capability for this user.

— Standard Resolution

— High Resolution 
334



Chapter 10: Configuring Users System Administration Guide
• Allow Telephony Presence: Telephony presence indicates a user’s availability for 
accepting voice calls. Select this option to allow the user to access telephony 
presence information about other users.

• Share Call Appearances: This field allows a user to participate in Shared Call 
Appearances functions, assuming that a Bridged Call Appearance extension has 
been configured. See the"Bridged Call Appearance Conferencing" on page 250 for 
more information about Shared Call Appearances and Bridged Call Appearance 
configuration.

— Associated BCA 

• Allow Use of SoftPhone: Check this box to allow the user to have access to the 
SoftPhone option in Communicator.

• Allow Phone API: Third-party developers have the ability to create applications 
that can run on certain ShoreTel IP phone models. (Check with a ShoreTel 
representative for models that support this behavior.)

Selecting this checkbox enables the IP phone associated with this user to go into 
PAPI browser mode, thus allowing the phone to run those third-party applications.

• Allow Mobile Access: Select this checkbox to enable Communicator for Mobile 
(CM) to run on this user’s mobile device. The CM client software consists of a 
small Java applet that is installed on a mobile device, such as a BlackBerry. The CM 
software provides remote/mobile users with an interface similar to ShoreTel 
Communicator.

Clear this checkbox to disable Communicator for Mobile on this user’s mobile 
device.

• Delayed Ringdown: Select this checkbox to enable Delayed Ringdown for the 
extension. If this parameter is not enabled, all other Ringdown parameters are not 
selectable. Refer to Section 9.15.3.1 for information about Ringdown.

— Extension: Select this option to specify a ShoreTel extension as the recipient 
device, then enter the extension of the recipient device in the corresponding 
data entry field.

— External Number: Select this option to specify a phone outside of the ShoreTel 
network as the recipient device, then enter the phone number of the recipient 
device, including the Trunk Access Code of the ringdown trunk, in the 
corresponding data entry field.

— Ringdown Delay: Enter the period of time that the phone waits after the user 
picks up the handset before initiating the ringdown call. Enter 0 in this field to 
cause the phone to immediately dial the ringdown device whenever the 
handset is picked u

• Client User ID: This is the login name that a user uses when logging into the 
ShoreTel Communicator or ShoreTel Director. By default, it is the first initial of the 
user’s first name followed by the user’s entire last name. This can be changed at 
your discretion.

This field is automatically filled in when western language data is entered in the 
First Name and Last Name fields.

• Client Password: This is the password that a user will use when logging in to the 
system from the ShoreTel Communicator or ShoreTel Director. Characters that are 
entered in this field appear as asterisks.
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The default password is changeme. Users are asked to change this password the first 
time they log in to the system.

It is recommended that this password NOT be changed because it is used by users 
who are configuring their Communicator for the first time.

• Voice Mail Password: This is the password that a user uses when logging in to his 
or her voice mailbox from the telephone. Characters that are entered in this field 
appear as asterisks.

The default password is 1234. Users are asked to change this password the first 
time they log into the system.

It is recommended that this password not be changed because it is used by users 
who are configuring their telephone for the first time.

— Must Change on Next Login: This check box is selected by default when a new 
user is created. This forces the user to enter a new password the first time they 
log into their mailbox. Once the user has entered a new password, the system 
clears this checkbox.

If a user has forgotten his or her password, the system administrator can reset 
this option (i.e. select the checkbox) and enter a generic password, thus 
allowing the user to re-enter a new password.

• SIP Password: Entering a value in the data entry box enables the extension to 
support SIP. Clearing the SIP Password data fields disables the extension from 
supporting SIP. Refer to Section 18.2.6.5 for more information.

• Email Address: This is the user’s e-mail address. By default, it is automatically 
entered when you enter the user’s first and last names in the First Name and Last 
Name fields. It consists of the first initial of the user’s first name followed by the 
user’s entire last name—for instance, sdemont. In addition, the 
@companyname.com domain is saved in a cookie on your workstation each time 
you save a user. This information is then presented as a default, which can be 
changed at your discretion.

Be sure to delete this field if the user does not have or use e-mail.

• Conference Bridge: This section allows you to assign the user to an Service 
Appliance 100 (SA-100) conference device.

— Appliance: In the field, select the SA-100 that you want the user to use.

10.4.2.2 Personal Options
To configure new and existing users’ personal options, click the Personal Options tab 
(shown in Figure 10-10) on the Edit User page. After making entries, click the link at the 
bottom of the page to return to the user’s edit page.
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Figure 10-10 Edit User Page – Personal Options

The parameters under the Personal Options tab are as follows: 

CALL CONTROL OPTIONS

• Current call stack size: A call stack is the ShoreTel extension component that 
manages an entity’s call appearances. The call stack size defines the maximum 
number of calls – including active and held calls – that an extension can handle 
simultaneously. When this number is exceeded, calls are either given a busy tone or 
forwarded, depending on the call handling mode that is currently in effect.

Valid values are 1 through 16 with the limitation that the value specified in the call 
stack size of the user’s CoS becomes the upper limit.

• Ring Type: Select from the drop-down list of one of the four different ring types. 
The ring type applies to ShoreTel IP Phones but not to analog telephones.
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NOTE Ring type is a personal option for the user and not a configuration setting 
of the phone. When a user moves from phone to phone, their ring type 
will follow them.

Also, keep in mind that most ShoreTel IP phone models support the ability 
to load customized ring tones onto each phone, so that each user can have 
a unique ring tone, if desired. See the "Custom Ring Tones" on page 205 for 
details.

• Wall Paper: This field allows the user to select the “wallpaper” or background 
appearance of their Communicator program.

• Automatic Off-Hook Preference: This option is intended for users who rely 
primarily on a headset (standard or wireless). This feature eliminates the 
requirement to manually press the Headset button on the IP phone to activate the 
headset.

— Speakerphone: Automatically route incoming or outgoing calls to the 
speakerphone. This is the default.

— Headset: Automatically route incoming or outgoing calls to the headset.

— Wireless Headset: Automatically route incoming or outgoing calls to the 
wireless headset.

— Bluetooth Headset: Automatically route incoming or outgoing calls to the 
Blootooth headset.

For configuration instructions, refer to "Wireless Headset Hook Switch" on page 
210.

• Handsfree Mode: This enables the user’s handsfree mode. When enabled, dial tone 
is disabled so that the user can use a headset or speakerphone to answer and make 
calls from the desktop client.

Handsfree mode is useful for both headset and speakerphone users.

The default is disabled.

• Call Waiting Tone Enabled: This enables the user’s call waiting tone. When 
enabled, the user hears the tone from the telephone handset when a second call is 
waiting.

The default is enabled.

Subtle differences can be heard in the call waiting tone one hears for a direct 
extension as opposed to a monitored BCA extension. This difference has been 
implemented to help differentiate between the two.

• Trunk Group Access Code: This lets you assign the default trunk access code for 
this user. Although this actually lists trunk groups, the only parameter leveraged is 
the access code. If the user has access to multiple trunk groups with the same 
access code, these trunks are seized based upon the Network Call Routing feature 
operation described in the ShoreTel 12: Planning and Installation Guide.

This eliminates forcing every user to configure his or her desktop client with the 
proper access code for dialing.

• Mailbox for Recorded Calls: Call can be monitored or recorded by people with 
appropriate permissions. Indicate the mailbox to be used for recordings. The 
maximum length of recording is determined by the voice mail class of service for 
the destination mailbox.
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• Program IP Phone Buttons: This link takes you to the Program IP Phone Buttons 
page where you can assign functions to the ShoreTel IP Phone or BB24 
programmable buttons.

For configuration instructions, refer to "Programmable IP Phone Buttons" on page 
211.

• Copy: This button takes you to the Copy IP Phone Buttons page. The Copy button 
reduces the tedious work of configuring the programmable buttons on each user’s 
IP phone by allowing a system administrator to copy a programmable button 
configuration from one user to another.

For configuration instructions, refer to the "Copying Programmable Buttons 
Configurations" on page 215.

• Program Communicator Toolbars: This link takes you to the Program 
Communicator Toolbars page where you can create new toolbars and assign 
common functions to the buttons on that toolbar.

The customizable toolbars that extend across the top of the Communicator user 
interface. The buttons in these toolbars can be programmed with common 
operations in a manner similar to the custom buttons on some IP phone models. 
Communicator users can then perform many operations (e.g. “speed dial” or open 
URL) just by clicking a button on the toolbar.

For configuration instructions, refer to the "Creating a Personal Programmable 
Toolbar" on page 375.

• External Assignment: This link takes you to the Find Me and External Assignment 
page where you can set two Find Me numbers as forwarding destinations, or where 
you can enter an external PSTN phone number for use with the Extension 
Assignment feature.

For configuration instructions, see the "Find Me and External Assignment Page" 
on page 419, or just refer to Chapter 12 for related topics.

• Personalized Call Handling Rules: 

CALL HANDLING MODE OPTIONS

• Current Call Handling Mode: This lets the system administrator set the current 
call handling mode for the user. Subsequently, users can select and edit each call 
handling mode from their desktop client.

The default is Standard.

For more information about call handling, see the "Automated Call Handling" on 
page 421.

• Delegation: You have the option of delegating the call handling management to one 
or more other users. This feature is helpful for users who may want their personal 
assistants to change their call handling mode for them. 

• Outlook Automated Call Handling: This lets a user’s Microsoft Outlook Calendar 
control his or her call handling mode. Select this check box to enable this feature.

• Edit Call Handling Modes: The links under this section bring you to the call 
handling mode configuration pages. Call handling modes specify how, when, and 
where calls are forwarded, and whether the user requires message notification 
when voice mail is received.
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MAILBOX OPTIONS

• Find Me: This link takes you to the Find Me and External Assignment page where 
you can set two Find Me numbers as forwarding destinations or where you can 
enter an external PSTN phone number for use with the Extension Assignment 
feature.

• Escalation Profiles and Other Mailbox Options: This link takes you to the 
Escalation Profiles and Other Mailbox Options page where you can create Message 
Notification Escalation Profiles, configure Email Delivery Options for a user, and 
set up Automatic Message Forwarding.

For configuration instructions, see the "Escalation Profiles and Other Mailbox 
Options" on page 448.

10.4.2.3 Distribution Lists
A distribution list lets a user easily send a voice mail message to multiple users at one time. 
Each distribution list has a descriptive name and distribution list number associated with 
it.

See the "System Distribution Lists" on page 441 for details about adding and populating 
Distribution lists.

Users can be associated with the distribution lists from either the Distribution Lists options 
on the Edit User page (Figure 10-11) or the System Distribution List edit page. When a 
user is associated with a distribution list, that user receives messages sent to that list.

Figure 10-11 Edit User Page (Distribution Lists Tab)

If the user clicks the Distribution Lists tab on the Edit User page, the System Distribution 
List page appears.

The Distribution List Memberships box shows the distribution lists that are currently 
available. Clicking their check boxes adds or removes the user from the indicated list.

Users can be associated with more than one distribution list.
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10.4.2.4 Workgroups
The Workgroups tab on the Edit User page allows editing a user’s workgroup membership, 
as shown in Figure 10-12. Users can belong to multiple workgroups; however, a user’s login 
status is the same for all workgroups of which he is a member.

Figure 10-12 Edit User Page (Workgroups Tab)

The Workgroups box shows the workgroup lists that are currently available. Clicking the 
check boxes adds or removes the user from the indicated list. Click the Logged In check 
box to activate membership.

10.4.3 System Directory Record
When adding a new user to the system, a user entry is automatically made to the system 
directory. Edit a user’s system directory record by going to the System Directory Entry edit 
page, shown in Figure 10-13.

Figure 10-13 System Directory Edit Entry Page
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Edit some or all of the fields on the System Directory Entry edit page as needed. The First 
Name, Last Name, and E-mail Address fields are automatically entered when adding a new 
user. Fields modified on either page are automatically updated on the other page.

10.5 Active Directory
Directory services store organization information and settings in a central, organized, 
accessible database. Active Directory (AD) is the Microsoft application that implements AD 
on Windows based systems. AD is widely deployed among large enterprises. 

The ShoreTel AD implementation supports the synchronization of user records between the 
ShoreTel database and other applications using Active Directory on Windows based 
networks.

ShoreTel AD includes the following features:

• Authentication of AD Users, as described in "Authenticating AD Users" on page 
345.

• Synchronizing AD Directory and ShoreTel Director user records, as described in 
"Synchronizing AD and Director User Records" on page 347.

• Bulk Provisioning of User Accounts, as described in "Bulk Provisioning of User 
Accounts" on page 348.

10.5.1 Active Directory Implementation
Active Directory Integration is an optional ShoreTel feature that is disabled by default. 
Systems that disable AD Integration do not recognize links to the Active Directory for 
properties attached to system users and do not provide AD authentication, 
synchronization, or provisioning services.

When AD Integration is enabled, only users that have administrative permissions can log 
into ShoreTel Director. This requires the explicit definition of at least one administrator 
role and the assignment of users requiring ShoreTel Director access to an administrative 
role.

10.5.1.1 Enabling AD Integration on a ShoreTel System
Active Directory is enabled from the Edit Other System Parameters page, as shown in 
Figure 10-14, is accessed through ShoreTel Director by selecting Administration -> System 
Parameters -> Other. To enable Active Directory, select Enable AD Integration located at the 
bottom of the page, then enter the Active Directory path in the data entry field.
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Figure 10-14 Enabling Active Directory

IMPORTANT Since AD prevents anonymous users from logging in through the default 
admin account, at least one user must be assigned Administrative rights before 
enabling AD. 

"Configuring AD on a New System" on page 343 provides a procedure that 
includes required user and administrative assignment steps for enabling Active 
Directory on a newly installed ShoreTel system.

10.5.1.2 Configuring AD on a New System
The following procedure enables AD Integration on a new system, includes initial user 
configuration and assignment of administrative permissions:

Step 1 Login to an Active Directory account through which ShoreTel Director will be 
accessed.

Step 2 Access ShoreTel Director through the following parameters:

username – admin
password – changeme

Step 3 Add a user to the ShoreTel system with Client User ID name that matches the 
Active Directory login name.

To add a system user, select Administration -> Users -> Individual Users from the 
Main Menu. Refer to the ShoreTel Administration Guide for more information.

Step 4 Assign Administrative Rights to the new user account. 

To assign rights, press the New button in the Administrators List page that is 
accessed by selecting Administration -> System Parameters -> Administrative 
Permissions -> Administrators page.

Step 5 Open the System Parameters: Edit Other Parameters page by selecting 
Administration > System Parameters > Other from the Director Main Menu Login.
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Step 6 Click Enable AD Integration located at the bottom of the page, then enter a valid 
AD path in the AD Path data entry field. 

Step 7 When prompted to save your changes and close the window, press the OK button 
and yes option.

This step logs you out of Director

Step 8 Log into Director again, using the username created in Step 3. 

The default password is changeme.

Step 9 Open the Edit User page for the new user and enable Active Directory for that user, 
including the domain and user id for the user.

Step 10Log out of ShoreTel Director and close the window.

Subsequent ShoreTel Director launches when logged on to the domain through this 
username will automatically log into Director.

10.5.1.3 Mapping Active Director Attributes to ShoreTel Fields
ShoreTel user records contain eleven data fields that map directly to Active Directory 
records. The following is a list of these data fields, categorized by the Director page that sets 
their ShoreTel value

Edit User Page

• First Name: Active Directory field capacity is 64 characters; ShoreTel capacity is 50.

• Last Name: Active Directory field capacity is 64 characters; ShoreTel capacity is 50.

• Number: ShoreTel extracts the number of digits specified by the extension length, 
starting from the right side of the AD phone number.

• DID

• Email Address

• Client User ID: Active Directory length is limited to 20 characters. 

System Directory

• Home Phone

• Pager

• Cell Phone

• Fax Phone

ShoreTel Database (does not appear in Director)

• LDAP-GUID: Used internally by the ShoreTel system when performing subsequent 
user updates from the AD database.
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10.5.1.4 Authenticating AD Users
ShoreTel supports AD authentication for users logging into Communicator, Web Client, 
and Director, permitting access to these programs without providing the ShoreTel 
username or password.

• AD Users logging into Director and Communicator are authenticated through 
Single Sign On (SSO) with their current network credentials. Users are not required 
to re-enter their credentials to access these applications.

• AD users logging into Web Client are authenticated through Explicit 
Authentication, which requires re-entry of their credentials each time they access 
the application.

10.5.1.5 Director
When AD Integration is enabled, user access to ShoreTel Director is restricted as follows:

• Only users with a domain account can log into Director

• Only users with administrative permissions can log into Director

• Users do not need to be logged into their domain account to access Director

• Users do not need their ShoreTel account configured for Active Directory (AD 
Users) to access Director

The following sections describe Director access scenarios. 

AD User Logged into the Domain

Users configured for AD within ShoreTel that are logged into the domain network are 
directed to the Director Quick Look page when they attempt to access Director without 
entering their network credentials.

Upon logging off from Director, the browser displays a ShoreTel entry page that allows 
Director access by pressing a button, as shown in Figure 10-15.

Figure 10-15 Director Login Page – AD user

Non-AD User Logged into the domain

Users that are not configured for AD within ShoreTel that are logged into the domain 
network are directed to a Director Login page, as shown in Figure 10-16. Users access 
Director from this page by entering their ShoreTel username and password in the respective 
data fields.
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Figure 10-16 Director Logon Page – Non-AD user

Users not logged into the domain

Users attempting to access Director without first logging into the domain network are 
initially routed to a domain login page, as shown in Figure 10-17. After entering their 
network credentials, users are routed to the appropriate page – AD users are routed to the 
Quick Look page and Non-AD users are directed to a login page.

Figure 10-17 Domain Login Page

10.5.1.6 Communicator
When AD Integration is enabled, access to Communicator is available all system users, 
including users without domain accounts or not configured as ShoreTel AD users.

Initial Configuration

When installing Communicator, users authenticated through AD are not queried for their 
credentials; they are immediately prompted for the server name after which wizard panels 
guide them through the setup process.

Users that are not authenticated through AD are required to enter their name, password 
and server name. After verifying the user’s credentials, Communicator guides the user 
through the setup process.
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Logging into Communicator

Attempts to log into Communicator after the initial setup are handled on the basis of the 
user’s AD configuration. Active Directory users are authenticated by SSO through the 
verification of their AD credentials. Users not configured for Active Directory are 
authenticated through the verification of their ShoreTel username and password, as 
previously loaded through their Communicator account. In either case, users are typically 
not required to re-enter their username or password each time they open Communicator 
from their computer.

Communicator behavior after an authentication failure is not changed by this feature.

User Name – Telephony Options Page

The User Name data field at the top of the Options and Preferences: Telephony page 
displays the User name of the Communicator account. This field is read only for users 
authenticated through AD credentials, as shown in Figure 10-18.

Figure 10-18 Options and Preferences: Telephony Page

10.5.1.7 Web Client
When AD Integration is enabled, access to the Web Client is available all users systems, 
including users without domain accounts or not configured as ShoreTel AD users.

Attempts to log into Web Client always require the user to enter credential information. 
Domain members configured as ShoreTel Active Directory members enter their Active 
Directory user name and password and are authorized through Explicit Authentication. All 
other users enter their ShoreTel username and password.

10.5.2 Synchronizing AD and Director User Records
Director provides an interface for adding, updating, and deleting AD users from the 
ShoreTel database. Synchronization is performed on individual users and does not affect 
the AD directory.
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10.5.2.1 Enabling AD for a ShoreTel User
When AD Integration is enabled, the first parameter the Edit User: General page enables 
Active Director for the user. 

To enable Active Director for a user, enable the Active Directory User option at the top of 
the page, then enter the domain\user name for the user, as shown in Figure 10-19.

Figure 10-19 Enabling Active Directory for a User

10.5.2.2 Updating AD Fields
Active Directory users can synchronize user account records with contents from the Active 
Directory database by pressing the Sync from AD button located left of the user’s Active 
Directory userid. Pressing the Show From AD button displays parameter settings for the 
users; Active Directory account.

The Show From AD and Sync From AD buttons are inactive for users accessing this page 
that are not configured as AD users 

10.5.2.3 Removing AD Users
When an administrator attempts to delete a user with an AD account, ShoreTel displays a 
warning message and requires confirmation before removing the record from the ShoreTel 
database.

10.5.3 Bulk Provisioning of User Accounts
ShoreTel supports the bulk provisioning of user accounts from AD records through a two 
step process:

Step 1 Export of AD records to a CSV file.

Step 2 Import CSV records to the ShoreTel user database.

10.5.3.1 Exporting AD Records
ShoreTel provides a VBScript file to export data records from an Active Directory database 
to a CSV file. The VBScript file can be used as a template for specific ShoreTel system 
requirements.

The parameter section of the file is shown in Figure 10-20. This section consist of two 
subsections:
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Figure 10-20 Sample ldaptocsv.vbs file – parameter sections

• The Top Section receives values from the AD database for each imported file. As 
indicated in the comments section, one value can be assigned to individual fields 
for all users by entering the value in place of the quotes. 

• The Bottom section is a data template containing non-AD fields that are saved to 
the CSV file. The values entered in these fields are assigned to all records retrieved 
from the AD database.

The following command line executes the AD to CSV file import:

cscript ldaptocsv.vbs outputCSVfile LDAPpath [modifiedInLastN#OfDays]

where

outputCSVfile specifies the name of the output file
LDAPpath specifies the path to the AD database
[modifiedInLastN#OfDays]

The resulting CSV file can be modified though a spreadsheet program to customize user 
settings for import to the ShoreTel database.

10.5.3.2 Exporting the CSV File
DBImport.exe is a executable file that imports CSV contents to the ShoreTel database that 
was introduced in a previous ShoreTel release and described in the ShoreTel Administrator 
Guide. 

DBImport supports SIP servers. SIP server names can be entered in the pre-existing 
voicemail server field. DB Import determines the user licence type and user group 
voicemail interface mode to use for looking up the voicemail server name.
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To support AD record imports, the following fields are supported by DBImport.exe:

• LDAP-User flag: a indicator that the user settings were imported from an AD 
database.

• LDAP-GUID: a data field that creates an association between an AD record and the 
corresponding ShoreTel record.

• LDAP-DomainName: specifies the name of the user’s domain network

The following command line imports CSV file records to the ShoreTel database.

Dbimport -log DbLog.log -err DbErr.err <inputCSVfile>

10.6 User Management Utilities

10.6.1 User Import Tool
The database import utility allows a system administrator to make changes across all users 
in a system with a single action. This new feature improves the ease with which a system 
administrator can modify information for large groups of users.

The system administrator creates a spreadsheet using a common application, such as 
Microsoft Excel. He or she modifies the user data in the spreadsheet in “free form” fashion, 
instead of having to modify each user's information, one at a time, from within Director. 
For someone who is skilled at using spreadsheet software, the time savings can be 
enormous.

Once the user information has been manipulated within the spreadsheet, it can be exported 
to a CSV format and this CSV file can then be imported into the ShoreTel system.

Details:

• The import tool supports modify/delete/insert operations, allowing a system 
administrator to add users, delete users, or modify the account of an existing user.

• Using the import tool does not require scheduled downtime. However, when 
importing large files that contain many rows of information, performance may be 
affected as the database is frequently queried. So depending on the size of the 
imported file and the type of information that is being added or modified, it may be 
recommended to perform the import during off hours.

• The ShoreTel system does not currently support the ability to export user data into 
a CSV file.

• The Import utility does not allow the administrator to specify the Users’ Home 
Port. The Home Port parameter is automatically set to SoftSwitch within each User 
record added or modified by an import.

Table 10-1 lists and provides information about field headers that must appear as the first 
row in the CSV file that will be imported. The field order can be random, but all fields are 
mandatory, case sensitive, and must have data.
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Table 10-1 Field Headers for CSV File

DataBase Import Field DataBase Field Name Accepted Input

Extension UserDN

FirstName (String) TabAddresses.FirstName

LastName (String) TabAddresses.LastName

GuiLoginName (String) GuiLoginName

GUIPassword (String) GUIPassword

UserLicenseType (Code) LicenseTypeID Extension-Mailbox

Extension-Only

Mailbox-Only

CallerID (String) CIDNumber A full canonical number 
(such as +1 (408) 331-
3300)

UserGroup UserGroupID (Code. Must be one of the 
existing User groups 
configured on the system.)

Site Site (String Name - Must be one 
of the existing Site Name)

Language DN.LanguageID Value should be a language 
name (e.g. “English(US)”). 

VMServer VMServerID Value should be a VM 
server, SIP server, or QSIG 
server name, depending on 
user's user group interface 
mode.

CallStackSize CurrentCallStackDepth Number

AcceptBroadcasts Mailboxes.NoReceiveBroadc
asts

Boolean 

DB value is opposite of 
input value

MakeNumberPrivate DN.Hidden Boolean

DialByName DN.ExcludeFromDialByNa
me 

Boolean

DB value is opposite of 
input value

Fax Support FaxSupport “User-No Redirect”

“User-Redirect”

“FAX Server” 

“Fax Machine” 

AllowSoftPhone AllowSoftPhone Boolean
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ClientType ClientType Personal

Professional

Workgroup Agent

Workgroup Supervisor

Operator

Contact Center Supervisor

Contact Center Agent

EmailDomain TabAddresses.EmailAddress String

ConferenceServer BridgeID String Name - Must be the 
existing Conference Bridge 
Name or “None”

ConferenceServerUserID 
(String - User ID for the 
conference bridge)

BridgeUserID

ConferenceServerPassword 
(String)

BridgePassword

RingType RingToneID Value must be a ring tone 
name:

Standard

Ring 2

Ring 3

Ring 4

CallWaitingToneEnabled CallWaitingToneEnabled Boolean

HeadsetAudioPath UseHeadsetAudioPath Number

HeadsetMode HeadsetMode Boolean

PSTNFailOverType PSTNFailOverTypeID None

External

DID

PSTNFailOverNumber PSTNFailOverNumber A full canonical number 
(such as +1 (408) 331-
3300)

DIDRange DIDDigitMap.DIDRangeID A full canonical number 
base of range (such as +1 
(408) 331-3300) 

DIDNumber DIDDigitMap.Digits A full canonical number 
(such as +1 (408) 331-
3300)

VoiceMailboxForRecordedC
alls

VoiceMailboxForRecordedC
alls

An existing valid extension 
(or can be left blank)

Table 10-1 Field Headers for CSV File

DataBase Import Field DataBase Field Name Accepted Input
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Additional considerations:

• String names fields must exist in the system. For example, if a new user is to be 
created in site New York. “New York” must exist as a site name. String names are 
case sensitive.

• For fields that are code in nature, specify the description to be displayed as it 
appears in Director. Data validation will translate the displayable value to the 
appropriate code. Note that the descriptions are case sensitive.

MustChangeTUIPassword MustChangeTUIPassword Boolean

MustChangeGUIPassword MustChangeGUIPassword Boolean

EnableCC ContactCenterIntegration Boolean

MustRecordName MustRecordName Boolean

HomePhoneMACAddress

HomePhoneNumber A full canonical number 
base of range (such as +1 
(408) 331-3300) 

WorkPhoneNumber TabAddresses.WorkPhone A full canonical number 
base of range (such as +1 
(408) 331-3300) 

PagerPhoneNumber TabAddresses.PagerPhone A full canonical number 
base of range (such as +1 
(408) 331-3300) 

CellPhoneNumber TabAddresses.CellPhone A full canonical number 
base of range (such as +1 
(408) 331-3300) 

FAXPhoneNumber TabAddresses.FAXPhone A full canonical number 
base of range (such as +1 
(408) 331-3300) 

LdapUser LDAPUser “Non-LDAP user” 

“Active Directory” 

LdapGuid LDAPGuid String

LdapDomainName LDAPDomainName String

AllowPapi AllowPAPI Boolean

MCMAllowed MCMAllowed Boolean

MCMPinEntryFrequency MCMPinEntryFrequency Number

AllowVideoCalls AllowVideoCalls Boolean

AllowTelephonyPresence AllowTelephonyPresence Boolean

IMServer IMServerID Value should be an IM 
server name. 

“<NULL>” clears the field. 

Table 10-1 Field Headers for CSV File

DataBase Import Field DataBase Field Name Accepted Input
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• Boolean fields can be true/false or 1/0.

• All fields are mandatory when adding new users.

• When updating an existing user, fields left blank will not change existing values.

Example: Table 10-21 shows a sample of the spreadsheet values before the Director import.

Figure 10-21 Spreadsheet values before Director import

The following procedure describes the process of importing data from a CSV file into the 
user database. This procedure assumes that you have already successfully exported the data 
from the spreadsheet into a CSV file, and stored that file in the proper location.

Step 1 Verify that the CSV file to be imported is located on the HQ server and in the 
following location:
C:\Program Files\Shoreline Communications \ ShoreWare Server

Adding Users

• These fields are required to add a user with DB Import: FirstName, LastName, 
GUIPassword, TUIPassword, GUILoginName. 

• The Extension field is optional when adding a user. If not provided, it will be 
automatically assigned. 

• Any blank or omitted fields will be left unchanged. 

Updating Users

• “Enter the Extension and any fields to be updated. 

• “Any blank or omitted fields will be left unchanged. 

Deleting Users

• “Enter the Extension and leave all other fields blank to delete a user. 

Step 2 Open the command prompt window in the directory shown above and run the 
following command:
Dbimport -log DbLog.log -err DbErr.err <CSV-file>

• -err is the flag to create an error log file.

• error.log is the file where error messages will be stored.

• CSV-file is the name of the file.

The import adds any new users and modifies any existing users in the user 
database as indicated in the CSV file.

When a user is updated, he or she is assigned to “Any IP Phone” on the headquarters 
server.
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10.6.2 Batch Update Utility
The Batch Update Utility lets you make changes to multiple users at the same time. It 
allows you to find a set of users and globally change certain parameters. Due to the scope of 
this change, you are prompted to stop all ShoreTel voice services before running the batch 
update. 

You can find a set of users based on any or all of the following criteria:

• Server
• User Group
• Personal Assistant
• Home Site
• Home Switch

You can globally change one of the following parameters for the selected users:

• Server
• User Group
• E-mail Domain Name
• Personal Assistant (for all call handling modes)
• Default Trunk Access Code
• Collaboration Server 

To use the Batch Update Utility do the following:

Step 1 Launch ShoreTel Director with administrator privilege.

Step 2 Click Administration > Users > Batch Update Utility. The Batch Update Utility 
page appears as shown in Figure 10-22.

Figure 10-22 Batch Update Utility Page

Step 3 Check the check box for criteria you want to use.

Step 4 In the criteria field, select the parameters that you want to use.

Step 5 Repeat Step 3 and Step 4 for each criteria you want to use.

Step 6 Click Find. The Batch Update Utility Update page updates with user 
information as shown in Figure 10-23.
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Figure 10-23 Batch Update Utility Update Criteria Page

Step 7 In the Select from list field, highlight the users you want to change and click 
the Add button. The users are moved to the Users to update field as shown in 
Figure 10-24. 

Figure 10-24 Batch Update Utility Page—Select Entities for Action

Step 8 In the Select Update Action field, select the change type that you want to 
implement as shown in Figure 10-25.

Figure 10-25 Batch Update Utility Page—Select Update Action
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Step 9 Click the Update button at the top of the page to initiate the change. Feedback 
on the action is presented in the Update Results field as shown in Figure 10-26.

Figure 10-26 Batch Update Utility Page—Results List

When the change is complete, you can make additional batch updates.

Remember to restart the voice services when you have finished making your 
batch changes.

10.6.3 Notify Users
The Notify Users page, shown in Figure 10-27, enables you to notify users that their 
ShoreTel client – Communicator or Communicator for Mobile – has been installed or 
upgraded. Once the user receives notification that their client application has been 
installed, the user can begin configuring personal options and use the application. 

To invoke automatic notification, do the following:

Step 1 Launch ShoreTel Director with administrator privilege.

Step 2 Click Administration -> Communicator -> Notify Users. The Notify Users 
page appears as shown in Figure 10-27.

Figure 10-27 Notify Users Page

Step 3 In the Send Email for field, select the ShoreTel client to which you want to 
send notification. 

Step 4 In the Notify section, select the option that you want to initiate. The options 
include the following:

• Click the All users radio button to notify all users using the selected client.

• Click the All users on this server radio button and in the field select the 
ShoreTel server to notify all users using the selected client on the ShoreTel 
server you select.
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• Click the All users not yet notified radio button to notify all users using 
the selected client who have not been notified.

• Click the This one user radio button and use the Search field to select a 
specific user to notify to upgrade their client.

Step 5 Click Send Email to send the notification e-mail.

10.6.4 Extension Lists
The Extension Lists page lets you create user groups that can be used by group paging and 
departmental auto-attendant. To create an extension list, do the following:

Step 1 Launch ShoreTel Director with administrator privilege.

Step 2 Click Administration -> Users -> Extension Lists. The Extension Lists page 
appears as shown in Figure 10-28.

Figure 10-28 Extension Lists

Step 3 Click New to create a new list. The Edit Extension Lists page appears as shown 
in Figure 10-29.

Figure 10-29 Edit an Extension List

Step 4 In the Name field, enter the name that you want to use for this extension list.
358



Chapter 10: Configuring Users System Administration Guide
Step 5 In the Filter Users By section, do either of the following to specify how you 
want to sort users to include in this extension list as follows:

• In any of the filter fields (First Name, Last Name, and Extension) enter the 
initial characters or numbers on which you want to search.

• In the Sort field, select the criteria that you want for listing the directory.

Click Apply. The sorted list appears in the Choose Member field. The field lists 
up to 50 members.

NOTE The Show Page field groups the member entries into segments. You can 
use this field to select segment that you want to appear in the field.

Step 6 Select the members that you want to include in the extension list and click 
Add. The members appear in the Extension List Members field.

Step 7 Click Save.
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Configuring Client Applications

This chapter describes ShoreTel applications that users access during their daily activities. 
This chapter assumes that ShoreTel communicator is already installed on the client 
computer. For information about client-computer hardware, operating system, and 
software requirements and installation instructions, refer to the ShoreTel 12 Planning and 
Installation Guide. Topics include:

• "ShoreTel Communicator for Windows" on page 361.

• "Contact Center Integration with Communicator" on page 380.

• "Communicator for Mobile" on page 393.

11.1 ShoreTel Communicator for Windows
This section describes the system resource requirements and the installation steps for the 
ShoreTel Communicator client application.

Through its graphical user interface, an end user can manage phone calls, voice mail, and 
personal system settings. The ShoreTel Communicator application supports five access 
types and related feature sets. The five types of access are:

• Personal access
• Professional access
• Workgroup Agent access
• Workgroup Supervisor access
• Operator access

Except for Personal access, the ShoreTel Communicator features require additional licenses 
or specific administrative authorization. For example, ShoreTel SoftPhone and Standard 
Resolution Video are covered by the Professional access license. For a complete list of 
Communicator features, see the ShoreTel Communicator for Windows Guide.

The server platforms that can support ShoreTel Communicator are:

• Windows 2008 Terminal Server, 32-bit, SP2 

• Windows 2008 Terminal Server, 64-bit (not R2)

11.1.1 Installation
This section describes the following topics for the installation of Communicator:

• Installation on a 64-bit Windows server

• Particular steps that are unique to deployment in a large environment that uses 
Microsoft Corporation’s Active Directory

• Installation of Communicator for Windows
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• Microsoft Office Communication Server (OCS)

• ShoreTel Converged Conference Bridge Server

11.1.1.1 64-bit Platform Supports
The 64-bit platforms on a terminal serve ShoreTel Communicator supports are Window 
2003 and Windows 2008 R2. To install ShoreTel Communicator:

Step 1 Install .Net Framework for 64-bit Windows machines – Version 3.5 or higher.

NOTE .Net Framework is not supplied with the ShoreTel installation software. 
This software is available from Internet sources or from your software 
vendor.

Step 2 Install Communicator for Windows.

Step 3 Access Control Panel > Phone and Modem > Advanced (tab) and remove 
ShoreTel Remote TAPI Service Provider.

Step 4 Run TSPInstall.exe.

TSPInstall.exe is provided with the ShoreTel installation software.

Installing Communicator for Windows on a 64-bit platform places files in the following 
folders:

• The default location is C:\Program Files (x86)

• The location of 32-bit client dll files is C:\Windows\SysWow64

11.1.1.2 Installation in a Large Deployment that Uses Active Directory
Some unique requirements exist for the installation of ShoreTel Communicator in a large 
deployment that uses Active Directory. This section outlines both the manual and the 
automated installation of ShoreTel Communicator in a large site with Active Directory. The 
decision for how to proceed depends on the following key factors:

• Whether manual (local) or remote installation is used

• Presence on the server of .NET Framework version 3.5 or higher

• Access to the World Wide Web (if .NET Framework 3.5 is not on the server)

The version of .NET Framework that is used should be the 32-bit version for a 32-bit server 
or the 64-bit version for a 64-bit server.

Manual Installation

Manual installation of .NET Framework can be in one of two scenarios. In one scenario, 
the Prerequisites folder contains .NET Framework 3.5 (or higher). In the other scenario, 
.NET Framework 3.5 does not exist at all on the ShoreTel server. If the required version of 
.NET Framework does not exist on the system, Web connectivity is required during 
installation.
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Manual Setup with .NET Framework in the Prerequisites Folder

The ability to install ShoreTel software manually depends on the availability of .NET 
Framework 3.5. If the Prerequisites folder contains .NET Framework 3.5 (along with other 
needed files), the system administrator can run setup.exe while the system is disconnected 
from the Web. If the system does not already have .NET Framework, the system must have 
an operational connection to the Web.

Manual Setup with .NET Framework Absent

If the Prerequisites folder does not contain .NET Framework 3.5, the system must have 
Web connectivity because, when the system administrator runs setup.exe, the system 
automatically downloads .NET Framework 3.5.

Automated Setup

If the system administrator is using automated (remote) installation to set up ShoreTel 
Communicator in a large network that uses Active Directory, the administrator must push 
the following packages in the order listed below by using Microsoft Corporation’s Group 
Policy Object (GPO) or another deployment tool:

1. Microsoft .NET Framework 3.5 (not located in the Prerequisites folder). Either .NET 
Framework exists on the system or the system must be connected to the Web (so that 
initiation of setup.exe causes a download of .NET Framework.)

2. Interop Assemblies (located in the Prerequisites folder) should contain Primary Interop 
Assemblies for 2007 and VSTO (Visual Studio Tools for Office). This resides in the 
Prerequisites folder.

3. Communicator (CMWin), located in the Setup folder.

11.1.1.3 Installing Communicator for Windows
To install ShoreTel Communicator for Windows, enter the following URL in a browser:

http://<ShoreTel_server_name>/shoreware resources/clientinstall.

NOTE Windows hotfix KB978637 must be installed prior to the installation of ShoreTel 
Communicator on a 64-bit Windows 7 system.

NOTE In some PC configurations, SDA drivers used in ShoreTel 12.0 Communicator for 
Windows may disable Microsoft Windows 7 Aero during Web conferences active 
presentation share or during installation.

11.1.1.4 Installing Communicator for Mac
See the ShoreTel Communicator for Mac Client User Guide for more details about the Mac 
client.

ShoreTel Communicator support all Mac platforms.

Mac users download and install ShoreTel Communicator for Mac in the same way as the 
ShoreTel Communicator for Windows, by accessing the ShoreTel Communicator Install 
webpage hosted by ShoreTel Director:

http://<serverIPaddress>/ShoreTelresources/Clientinstall/

where <serverIPaddress> is the IP Address of the ShoreTel Headquarters server.

A disk image file (.dmg) is then downloaded and automatically mounted by Safari. It can 
then be installed on the Mac
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Installation of ShoreTel Communicator for Mac is performed by dragging and dropping the 
ShoreTel Communicator Icon into the Mac Application folder.

11.1.2 Configuring for Instant Messaging
Instant messaging is the real-time transmission of text between two system users. Instant 
messages are sent from and received through a message window. Instant messages do not 
use call cells. 

ShoreTel Instant Messaging complies with RFC 3261 – SIP: Session Initiated Protocol and 
RFC 3428 – Session Initiated Protocol (SIP) Extension for Instant Messaging. Instant 
Messaging requires ShoreTel access to Microsoft Office Communicator Server (OCS).

Instant messaging is supported by ShoreTel Communicator for Windows allowing users to 
interface with third party instant messaging servers that support SIP/SIMPLE protocols. 
ShoreTel Instant Messaging is provided to Communicator users through a ShoreTel Service 
Appliance 100, a ShoreTel Converged Conference Bridge Sever, or Microsoft Office 
Communications Server (OCS).

ShoreTel Service Appliance 100 (SA-100)

The ShoreTel Service Appliance 100 also supports ShoreTel instant messaging and presence 
information exchanges. Refer to the ShoreTel Service Appliance 100 (SA-100)Planning, 
Installation and Administration Guide for more information.

ShoreTel Converged Conference Bridge Server

The ShoreTel Converged Conference Bridge Server Version 7.1 supports ShoreTel instant 
messaging and presence information exchanges. Refer to the ShoreTel Converged 
Conferencing Director Installation and Administration Guide for more information.

Microsoft Office Communication Server

This section describes Microsoft OCS implementation requirements for compatibility with 
the ShoreTel system. Readers should keep in mind that Microsoft Corporation maintains 
some of these requirements, and compatibility can change without notice.

• OCS Versions: ShoreTel is compatible with the Microsoft OCS 2007 Standard edition 
or better.

OCS software is available in three editions: Standard, Enterprise, and Enterprise 
Expanded. Standard Edition is typically sufficient for ShoreTel deployments with less 
than 5,000 users.

• The requirements for OCS system components include:

— Windows Server 2003 or later. The 2003 version is compatible with Microsoft OCS 
2007.

— Windows Active Directory.

• License Requirements: OCS requires one standard client access license (CAL) for each 
ShoreTel user enabled for instant messaging.

• Server Configuration: The OCS server must be configured for UDP transport. 
Communicator for Windows support Transport Layer Security (TLS) protocol.

• Connectivity Testing: To test ShoreTel server connectivity, log two OCS servers to the 
ShoreTel server and send an instant message between the OCS servers.
364



Chapter 11: Configuring Client Applications System Administration Guide
• Additional Information: Additional OCS information is available from the following 
sources:

— The Office Communicator 2007 Resource Center at:

http://office.microsoft.com/en-us/help/HA102373941033.aspx

— “Microsoft OCS Requirements for ShoreTel Communicator Instant Messaging 
Feature ST-10063.”

These application notes are posted on the support site and searchable through the 
Knowledge Base.

11.1.2.1 Setting up the System Server
The following presence servers support ShoreTel Instant Messaging:

• horeTel Service Appliance 100 (SA-100)

NOTE Support IM transmissions through HTTPS

• Converged Conference Bridge Server Version 7.1.

NOTE Support IM transmissions through HTTPS

• Microsoft Office Communications Server, Version 2007.

NOTE When using OCS, ShoreTel supports IM transmissions through TCP, TLS, 
and UDP.

NOTE When using the ShoreTel Converged Conference bridge, ShoreTel IM users will see 
the following behavior when Communicator for Windows presence invitation is 
set to 'Prompt to accept invitation':

• If a user (user A) sends an IM to another user (user B) and neither user has granted 
permission to share presence information with the other, the Communicator will 
only prompt the IM recipient (user B) to share presence information, but not the 
sender (user A). 

• The sender's IM presence (user A) will be displayed in an 'Away' (Yellow) status until 
user B sends an IM to user A, prompting a request to share presence information.

ShoreTel permits multiple presence servers on a system. Each user can be assigned to a 
maximum of one presence server. Users can exchange instant messages only with other 
users assigned to the same presence server.

To associate a presence server with the ShoreTel system:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Application Servers > IM Servers. The IM Server List 
page appears as shown in Figure 11-1.
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Figure 11-1IM Server List Page

Step 3 Click the New button. The IM Server Info dialog box appears as shown in 
Figure 11-2.

Figure 11-2IM Server Popup

Step 4 In the Name field, enter the name that you want to use for this IM profile.

Step 5 In the Server Type field, select the type of server that you want to use for IM.

Step 6 In the Protocol field, enter the protocol the IM server uses.

Step 7 In the Host field, enter the domain or IP address of the IM device you want to 
use to provide IM services for this profile.

Step 8 Check the Override Default Port checkbox if the server is using a port other 
than 5222.

Step 9 Press the Save button in the IM Server popup.

Step 10Ping the IP address entered in the IMServer Info page to verify that the address 
is accessible.

When changing the Presence Server version, access the IM Server popup and enter the 
presence version in the Server Type data entry field.
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11.1.2.2 Configuring a User for Instant Messaging
The following Communicator types can send and receive Instant Messages:

• Professional Access

• Workgroup Agent Access

• Workgroup Supervisor Access

• Operator Access

Configuring Instant Messaging for a User is a two step process:

Step 1 The administrator enables instant messaging for the user.

"Enabling Instant Messaging for a System User" on page 367 describes the 
process of enabling instant messaging for a user.

Step 2 The user configures instant messaging user options.

The Communicator for Windows User Guide has instructions for configuring instant 
messaging options in the user’s Communicator window.

11.1.2.3 Enabling Instant Messaging for a System User
To enable Instant Messaging for a system user:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Individual User List 
page appears.

Step 3 In the First Name column, select the user that you want to enable. The Edit 
User page appears as shown in Figure 11-3.

Figure 11-3Instant Messaging Parameters on the Edit User Page

Step 4 Verify the First Name and Last Name parameters list the user for which you are 
enabling Instant Messaging.
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Step 5 In that Access License field, select a license for the use that supports IM: 
Professional, Workgroup Agent, Workgroup Supervisor, or Operator.

Step 6 Check the Allow Telephony Presence check box.

Step 7 Scroll down to the Instant Message Settings section and in the Server/ 
Appliance field, select the SA-100 or other IM server that you want this user to 
use.

Step 8 In the IM ID data entry field, enter the address through which the user will 
receive and send Instant Messages as it is configured on the OCS server.

NOTE This field does not appear and is not required if you are using an SA-100 
for instant messaging. 

Step 9 Press the “Save” button at the top of the page to enable the changes.

Step 10Verify that the presence server is configured to authorize access by the address 
specified for the user in Step 8.

Consult the user documentation for the presence server for instructions on 
authorizing user access.

Step 11Do the following to advise the user to verify access to the presence server:

Step a Opening the “Options and Preferences” page from the user’s Communicator 
Main Window.

Step b Selecting Instant Messaging in the Menu on the left side of the page.

Step c Entering the user’s OCS User Name and Password in the Account 
Information section at the top of the page.

Step d Pressing the Reconnect button.

The Status Bar in the Main window will display the results of 
Communicator’s attempt to access the presence server.

11.1.3 Presence
Presence is a ShoreTel feature that identifies, uses, and distributes the availability of system 
users and other personal contacts. Presence information allows users to verify the 
availability of other users before attempting to contact them. Presence improves overall 
enterprise productivity by reducing calls to unavailable parties and by providing the 
enhanced ability to immediately schedule meetings, events, and communication sessions 
based on the availability of desired participants. Users can also choose when to receive 
Instant Messages by changing their presence settings.

Communicator for Windows defines three presence settings for each user. 

• Telephony presence indicates a user's availability to accept voice calls. 

• Instant Messaging presence indicates a user's availability to engage in IM 
conversations.

• Combined presence is a single setting that indicates user availability on the basis of 
Telephony and IM presence status.

Communicator automatically adjusts the presence status of users as they use system 
resources. Users can also manually adjust their status at any time.
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A user can monitor the presence of a maximum of 500 other contacts. Administrators 
configure the number of contacts a user can monitor by setting the maximum contact list 
size, as described in the "Setting the Maximum Contact List Size" on page 369.

11.1.3.1 Configuring a User for Presence
Telephony presence is available to users of all Communicator types. IM presence is 
available to users authorized to use Professional, Operator, Workgroup Agent, or 
Workgroup Supervisor Communicator. Director settings control user access to both 
presence types.

Configuring Presence for a User is a two step process:

Step 1 The administrator enables presence for the user.

The "Enabling Presence for a User" on page 369 describes the process of 
enabling presence for a user.

Step 2 The user configures presence user options.

Refer to the Communicator for Windows User Manual for instructions on 
configuring presence user options from the user’s Communicator window.

11.1.3.2 Enabling Presence for a User
To enable a user for telephony presence:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 In the First Name column, click on of the desired user. The User page appears.

Step 4 Verify the First Name and Last Name parameters list the user for which instant 
messaging is being enabled.

Step 5 Check the Allow Telephony Presence check box.

Step 6 Click Save.

To enable a user for IM presence:

Users that are authorized for instant messages are automatically configured for IM 
presence.

11.1.4 Setting the Maximum Contact List Size
Contacts are directory entries whose information is organized into specialized lists called 
Contact Lists to provide convenient access by the Communicator user. Contacts are 
selected from directories accessible to Communicator, including the System Directory, 
Personal directory or Microsoft Outlook. Contact Lists, which are normally accessed from 
the Communicator main page, provide quick access to regular directory entries without 
navigating through the directory menus. Users can perform tasks on Contact List entries 
that are available from other directories such as initiating voice call or instant messages, 
handing active calls, and sending email or voice messages.

The maximum ShoreTel Contact List size is 500 contacts for each user. The size of each 
user’s Contact List is controlled through a Class of Service setting.
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To set the maximum Contact List size for a selected Class of Service:

Step 1 Open the Class of Service list page by selecting Administration -> Users -> 
Class of Service in the Director Menu.

Step 2 Open the Edit Telephony Features Permissions page by clicking the name of 
the selected Telephony Features Permissions class of service at the top of the 
Class of Service list page.

Step 3 Enter the maximum Contact List size in the Max. Buddies Per User field 
located at the top of the Edit Telephony Features Permissions page, as shown in 
Figure 11-4.

Figure 11-4Setting the Maximum Contact List Size for a Class of Service

The maximum Contact List size specified by a class of service is imposed upon a user when 
the class of service is assigned to that user.

11.1.5 Enable SoftPhone for Users
SoftPhone is a completely integrated software component of Communicator for Windows. 
SoftPhone users participate in voice calls and listen to messages through a headset or 
speakers with a microphone without any additional hardware.

The Edit User – General page in Director enables users to access to SoftPhone.

To enable SoftPhone access for a selected user:

Step 1 Open the Individual User list page in Director by selecting Administration -> 
Users -> Individual Users from the main menu.

Step 2 Open the Edit User page by clicking on the First Name of the desired user in 
the Individual User List.

Step 3 Verify the First Name and Last Name parameters list the user for which 
SoftPhone service is to be enabled.

Step 4 Verify that the General menu tab is selected on the page selection bar at the top 
of the page.

Step 5 Select the Allow Use of SoftPhone parameter, located in the center of the page.

Step 6 Press the SAVE button at the top of the page to enable the changes.
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11.1.6 Video Calls
ShoreTel supports video calls between two Communicator users that are communicating 
directly. However, Communicator instances cannot have video when these instances are 
communicating through a ShoreTel server. ShoreTel does not support server-based, star-
configurations or interoperability with other video solutions. ShoreTel supports video calls 
through an SVC codec.

ShoreTel does not support video-only calls. Video is added to a voice call when requested 
by a user. Video can either be added to an active voice call or established as a part of a new 
voice call.

IMPORTANT End users who attempt video calls must have the most recent video driver and 
have all the updates installed for the video card. Refer to the documentation 
from the manufacturer of the individual video card for complete information.

11.1.6.1 Supported Video Cameras
For a list of Video Cameras currently supported by Communicator, refer to “Video Camera 
Requirements for ShoreTel Communicator, Feature AN-10062”. These application notes 
are posted on the support site and searchable through the Knowledge base.

11.1.6.2 Enabling Video Calls for Users
The Edit User – General page in Director enables users for video calls.

To enable Video Call access for a selected user:

Step 1 Open the Individual User list page in Director by selecting Administration > 
Users > Individual Users from the main menu.

Step 2 Open the Edit User page by clicking the First Name of the desired user in the 
Individual User List.

Step 3 Verify the First Name and Last Name parameters list the user for which Video 
is to be enabled.

Step 4 Verify that the General menu tab is selected on the page selection bar at the top 
of the page.

Step 5 Select the desired option from the Allow Video Calls drop-down menu located 
in the center of the page.

The drop-down menu options include

• None: The user cannot make video calls or add video to existing voice 
calls.

• Standard Resolution: The user can perform VGA resolution video calls.

Step 6 Press the Save button at the top of the page to enable the changes.

11.1.6.3 Enabling Intersite Video Calls
The Video call site setting is a Class of Service parameter. Members of a class of service can 
only conduct video calls with other Communicator users at the same site unless this 
parameter is set for intersite calls.

To enable intersite video calls for a class of service:
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Step 1 Open the Class of Service list page by selecting Administration > Users > Class 
of Service in the Director Menu.

Step 2 Open the Edit Telephony Features Permissions page by clicking the name of 
the selected Telephony Features Permissions class of service at the top of the 
Class of Service list page.

Step 3 Select the Allow Intersite Video Calls parameter on the top portion of the Edit 
Telephony Features Permissions page. 

11.1.7 Programming Personal Communicator Toolbar
Programmable Toolbars for Communicator are similar to regular toolbars in that they 
extend across the top of the Communicator user interface. However, the buttons in these 
new toolbars can be programmed with common operations in a manner similar to the 
programmable buttons on some IP phone models.

Once a user’s toolbar buttons have been configured, the user can perform many basic 
telephony operations just by clicking a button in Communicator. For example, a button 
could be configured to “speed dial” another extension or open up the user's default 
browser to a programmed URL when clicked. 

In addition, Programmable Toolbars also provide the foundation for integrating ShoreTel 
Communicator with Contact Center’s Agent Toolbar. End users can assign Contact Center 
functions to the buttons on the Communicator Toolbar and control their contact center 
state while accessing call control functions from a single, unified interface.

Details:

• Toolbars must be configured by the system administrator via ShoreTel Director.

• Toolbars can be configured per-user (see Table 11.1.7.1 on page 375) or globally (see 
the "Creating a Global Programmable Toolbar" on page 377).

• Up to 6 toolbars can be defined per user, with each toolbar supporting up to 24 
programmable buttons.

• Each user can additionally inherit up to 3 global toolbars through their user group.   

• Each toolbar can exist on a separate row in the UI or toolbars can share a row.

• Rows can be docked or moved around the top portion of the window as a group.

• Individual toolbars can be shown or hidden from the View menu in the 
Communicator user inter-face (see Displaying Toolbars on page 72).

• Buttons may combine an operation with a parameter (such as a user extension), 
allowing one-click access to commonly performed operations, such as blind-
transferring to a particular user.

• Buttons assigned with a particular operation will be disabled when their 
corresponding menu items are disabled. For example, some of the Contact Center 
function buttons are not available as menu items, thus ensuring that the system 
administrator can easily block access to those functions on a per-user basis.

• Buttons that are associated with an extension (such as Blind Transfer or Extension 
Monitor) will show the Communicator-user when the monitored party has call 
activity. Additional presence information appears if the user hovers the cursor over 
the associated button.

• The user can have any and all toolbars active at once.
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• Supported operations are listed on the following page.

Supported operations:

• Add/Modify Contact

• Agent Login

• Agent Logout

• Agent Wrap-Up

• Answer

• Answer Call Center Call

• Assign to Last External Number (Extension Assignment / Extension)

• Barge In

• Blind Transfer Agent

• Bridged Call Appearance

• Change CHM

• Change Default Audio Path

• Conference

• Conference Blind

• Conference Consultative

• Conference Intercom

• Consult Transfer Agent

• Dial Mailbox

• Dial Number (Speed Dial)

• Edit Call Note

• End Wrap-Up

• Execute DDE command

• Extend Wrap-Up

• Go Home

• Group Pickup

• Hangup

• Help

• Hold 

• Intercom

• Invoke Command line

• Invoke URL

• Login Group

• Login Primary Groups
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• Logout Group

• Logout Primary Groups

• Monitor Extension

• Open Agent Monitor

• Open Conference Mgr

• Open Control page

• Open Directory

• Open Extension Monitor

• Open External Assignment

• Open History Viewer

• Open Queue Monitor

• Open Soft Phone

• Open Voice Mail

• Page

• Park

• Park and Page

• Pickup

• Pickup Night Bell

• Record Call

• Record Extension

• Reinsert Busy Call

• Reinsert Terminated Call

• Reinsert Unanswered Call

• Release with Code

• Resume/Release

• Run Contact Center App

• Send Digits Over Call

• Set Agent ID

• Silent Monitor

• Supervisor Help

• To AA

• To VM

• Toggle Handsfree

• Transfer

• Transfer Blind
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• Transfer Consultative 

• Transfer Intercom

• Transfer to Mailbox

• Transfer Whisper

• Unpark

• Whisper Page

• Whisper Page Mute

• Wrap Up Code

11.1.7.1 Creating a Personal Programmable Toolbar
To configure the buttons of a user's Communicator Programmable Toolbar, follow the 
instructions below:

Step 1 Launch ShoreTel Director and enter the user ID and password.

Step 2 Click Administration > Users > Individual Users. The Individual User page 
appears.

Step 3 Select the user whose profile you want to edit. The Edit User page appears.

Step 4 Click the Personal Options tab. The Personal Options tab appears as shown in 
Figure 11-5.

Figure 11-5Personal Options Tab

Step 5 Click the Program Communicator Toolbars link. The Program Communicator 
Toolbars page appears as shown in Figure 11-6.
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Figure 11-6Program Communicator Toolbars Page

Step 6 Click the New button. The Program Communicator Toolbar Buttons page 
appears as shown in Figure 11-7.

Figure 11-7Program Communicator Toolbar Buttons

Step 7 In the Name field, enter the name you want to use for this toolbar.

Step 8 Click on the first Function drop-down menu (which should say “All”) and 
select the category. Options are:

• All - This lists all operations

• Contact Center - (For example, Login Group, Logout Group, Answer Call 
Center Call, etc.) 

• Config - (For example, toggle Handsfree mode, toggle audio path, Agent 
Wrap-Up, etc.) 

• Other - (For example, Unused)

• Telephony - (For example, Conference, Intercom, Group Pickup, etc.)

• Windowing - (For example, Open History Viewer, Open Agent Monitor, 
Open Control Panel, etc.)

Step 9 Click on the second Function drop-down menu (which should say “Unused”) 
and select the specific operation this button identifies.
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Step 10Enter a label in the Label field. The maximum is 12 characters.

Step 11In the Target field, enter the appropriate information as required for the type of 
operation the button will be performing. (For example, if the desired operation 
is changing the CHM, then a drop-down menu would appear in the Target area, 
allowing you to select from the various modes.)

Parameters are mandatory for some functions (e.g. Change CHM) and are 
optional for others (e.g. Blind Transfer). For optional parameters, the user is 
prompted to provide information for the optional parameter the first time the 
function executed via the programmable toolbar.

Step 12Continue programming the toolbar buttons as desired.

Step 13If a button is left unused or blank and this unused button is between other used 
buttons, Communicator will interpret the sequence of blank buttons as a 
divider that will be visible on the toolbar.

Step 14Once you have finished configuring the toolbar programmable buttons, click 
Save to store your changes.

When finished programming the toolbar for a user, the user's Communicator window 
should now have a toolbar similar to the one shown in Figure 11-8.

Figure 11-8Communicator Window with Programmable Toolbar

11.1.7.2 Creating a Global Programmable Toolbar
Alternatively, instead of configuring the Programmable Toolbar for an individual user, you 
can configure a global Programmable Toolbar which can then be applied to many users at 
once, thus simplifying the configuration process.

To create a global Programmable Toolbar, follow the instructions below:

Step 1 Launch ShoreTel Director. 

Step 2 Click Administration > Communicator > Global Toolbars. The Global 
Toolbars List page appears as shown in Figure 11-9.
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Figure 11-9Global Toolbar List Page

Step 3 Click the New button. The Edit Global Toolbar Buttons page appears as shown 
in Figure 11-10.

Figure 11-10Edit Global Toolbar Page

Step 4 In the Name field enter a name for this toolbar.

Step 5 Click the first Function field (All is the default) and select a category:

• All - This lists all operations.

• 3rd Party - (For example, Login Group, Logout Group, Answer Call Center 
Call, and so on).

• Config - (For example, toggle Handsfree mode, toggle audio path, Agent 
Wrap-Up, and so on).

• Other - (For example, Unused).

• Telephony - (For example, Conference, Intercom, Group Pickup, and so 
on).

• Windowing - (For example, Open History Viewer, Open Agent Monitor, 
Open Control Panel, and so on).

Step 6 Click the second Function field (which should say “Unused”) and select the 
specific operation this button will perform.

Step 7 Enter a label in the Label field. The maximum size is 12 characters.
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Step 8 In the Target field, enter the appropriate information as required for the type of 
operation the button will be performing. (For example, if the desired operation 
is changing the Call Handling Mode, then a Call Handling Mode drop-down 
menu appears in the Target area, letting you select from the various CHMs.)

Parameters are mandatory for some functions (e.g. Change CHM), while they 
are optional for others (e.g. Blind Transfer). For optional parameters, the user 
is prompted to provide information for the optional parameter the first time the 
function executed via the programmable toolbar.

Step 9 Continue programming the toolbar buttons as needed.

If a button is unused or blank and this unused button is between other, used 
buttons, Communicator shows the sequence of blank buttons as a divider that 
is visible in the toolbar.

Step 10Click Save to store the changes.

To assign a global programmable toolbar to a user profile, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > User > User Groups. The User Groups page appears.

Step 3 Select select the user group to which you want to assign a global programmable 
toolbar. The Edit User Group page appears as shown in Figure 11-11.

Figure 11-11Edit User Group Page
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Step 4 In the User Profile section, click the Toolbar 1 field and select the desired global 
toolbar. All members of this user group will now have this toolbar appear on 
their Communicator. 

Step 5 Repeat Step 4 if multiple toolbars are desired - up to three global toolbars can 
be assigned to a user group.

Step 6 Click Save to store the changes.

11.2 Contact Center Integration with Communicator

11.2.1 Description
ShoreTel integrates Contact Center functionality into Communicator, allowing end users to 
control their contact center state and access Contact Center functions and Communicator 
operations from a single, unified interface.

Figure 11-12 displays the non-integrated Contact Center Agent Toolbar. 

Figure 11-12Contact Center Agent Toolbar

This interface allows Contact Center users to program buttons on the toolbar by assigning 
common functions and call center operations to the various buttons. Users can perform the 
desired operation with the click of a button.

Contact Center functions are integrated into Communicator by assigning Contact Center 
operation buttons into Programmable Toolbars, as described in the "Programming Personal 
Communicator Toolbar" on page 372. Each toolbar can contain 24 buttons. To display 
additional buttons beyond those normally visible, click the arrow icon on right side of the 
toolbar. Figure 11-13 displays a Communicator toolbar that contain Contact Center 
function buttons.
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Figure 11-13Communicator Toolbar Containing Contact Center Operation Buttons

Details:

• Up to 24 buttons can be programmed in a single Communicator toolbar.

• Toolbars can be created on a per-user basis or on a global basis. Toolbars created at the 
global level can be deployed to multiple users in the system.

• Three global toolbars can be used per User Group, with a maximum of 100 per system.

• Six personalized toolbars can be created for each user.

• A user can employ 3 global toolbars in addition to 6 personalized toolbars, (total of 9 
toolbars). With 24 buttons per toolbar, a user can deploy a total of 216 programmable 
toolbar buttons. (24 buttons per toolbar X 9 toolbars = 216 buttons.)

11.2.2 Accessing Contact Center Agent Toolbar Functions
The available Contact Center operations in Table 11-1 show the name of corresponding 
operations in the integrated Communicator (if applicable). An operation that does not 
appear in the Contact Center Agent Toolbar column does not have an analogous function 
in the integrated Communicator. Often, a Contact Center operation does not have an 
analogous Communicator operation because the Contact Center operation can be done 
through an existing function in the regular (non-integrated) ShoreTel Communicator.

11.2.3 Configuration
To configure integrated Communicator – Contact Center for a user: 

Step 1 Launch ShoreTel Director.
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Table 11-1 Communicator access methods to Contact Center operations

Contact Center Operation 
Name

Operation Button or Path in Communicator

Telephony Operations

Answer Answer Call Center Call

Set Callback - Reinsert Busy Reinsert Busy Call

Set Callback - Reinsert No 
Answer

Reinsert Unanswered Call

Set Callback - Reinsert 
Terminate

Reinsert Terminated Call

ACD Operations

Groups Manager Select Contact Center > Agent Manager from 
Communicator

Login Primary Groups Login Primary Groups

Logout from Primary Groups Logout Primary Groups

Login Group Login Group

Logout Group Logout Group

End Wrap Up (Ready) End Wrap-Up

Release with Code Release With Code

Resume/ Release Resume/Release

Supervisor Help Supervisor Help

Transfer to Agent Blind Transfer Agent

Wrap-Up Code Wrap-Up Code

Wrap-Up Manual Control Extend Wrap-Up

Accessing Applications Windows

Desktop Wallboard Select Contact Center -> Desktop Wallboard from 
Communicator

Call Status Select Contact Center -> Call Status from Communicator

Queue Calls Select Contact Center -> Queue Calls from 
Communicator

Agent Log Select Contact Center -> Agent Log from Communicator

Contact Center Reports Select Contact Center -> Contact Center Reports from 
Communicator

Other Operations

Pop-up window as client is 
launched

Set Agent ID

Execute an Application Run Contact Center App. (or execute from Command 
Line)

Contact Center Functions Not Available in Communicator
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Step 2 Click Administration > Users > Individual Users.

Step 3 Click on the name of the user whose toolbar you would like to configure. The 
Edit User page appears as shown in Figure 11-14.

Figure 11-14Edit User Page

Step 4 In the Access License field, select a license that supports Contact Center 
(Personal or Professional). 

Step 5 Check the Enable Contact Center Integration check box.

Step 6 Click Save to store changes.

To configure the programmable buttons toolbar for this user, do the following:

Step 1 Click the Personal Options tab for the user who’s system is to be configured, 
and then click the Program Communicator Toolbars link. 

Step 2 On the Program Communicator Toolbar page, click the New button. The 
Program Communicator Toolbar Button page appears as shown in Figure 11-
15.

Divert Incoming Call

Manage List of Login / Logout ACD Groups

Open Telephony Window

Chat Tree

Table 11-1 Communicator access methods to Contact Center operations (Continued)

Contact Center Operation 
Name

Operation Button or Path in Communicator
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Figure 11-15Program Communicator Toolbar Button Page

Step 3 Enter a name for the toolbar and then click on the Function drop-down menu 
and select Contact Center.

Step 4 Then, select the desired operation from the drop-down menu. This operation 
will be associated with this specific toolbar button.

Step 5 Enter a label in Label field.

Step 6 If the function requires Target information, the required fields will appear to 
the right of the function. Enter the appropriate information as required for the 
type of operation the button will be performing. (For example, if the desired 
operation is Blind Transfer Agent, then an Agent ID field would appear in the 
Target area).

If a required target field for an operation is left blank or is configured with 
invalid information, the system will open a pop-up dialog box to collect more 
information (or valid information) when the user clicks on the associated 
button in Communicator. This behavior applies to the following operations:

• Consult Transfer to Agent

• Blind Transfer to Agent

• Login/Login Group

• Logout Group

• Release with Reason Code

• Wrap-up with Code

Step 7 Continue programming the toolbar buttons as desired.

If a button is left unused or blank and this unused button is between other used 
buttons, Communicator will interpret the sequence of blank buttons as a 
divider that will be visible on the toolbar.

Step 8 Once the configuration of the toolbar programmable buttons is complete, click 
Save to store the changes.
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Details

• Repeat this process of assigning operations to buttons for each new user that will be 
using the integrated Communicator. 

• When finished configuring buttons for each new user, follow the procedure below to 
configure the Communicator clients.

11.2.4 Configuring Call Center Options through Communicator
To configure the Contact Center options for a Communicator user, refer to the 
Communicator User’s Manual.

11.2.5 Integrating ShoreTel Communicator with Contact Center
To configure integrated ShoreTel Communicator – Contact Center for a user: 

Step 1 Launch ShoreTel Director; type the user ID and password; and then click Login.

Step 2 Click on the Administration link if necessary to expand the list.

Step 3 Click on the Users link and then click on the Individual Users link.

Step 4 Click on the name of the user to select the toolbar to configure.

Step 5 Select Enable Contact Center Integration, as shown in Figure 11-16.

Step 6 Click Save. The next task is to program the user’s toolbar buttons.

To configure the programmable buttons toolbar for the selected user:

Step 1 Click the user’s Personal Options tab.

Figure 11-16 Selecting the Contact Center Client Type
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Step 2 Click the Program Communicator Toolbars link near the center of the Personal 
Options window. If the user already has a Communicator toolbar 
configuration, a window like the example in Figure 11-17 opens. If no 
configuration exists, a blank space is displayed. For a new toolbar 
configuration, go to Step 3.

Step 3 Click the New button to open a fresh button-programming screen.

The example in Figure 11-18 shows a new toolbar window in progress. It shows 
the choices and illustrates how the choice of operation can activate an additional 
parameter called Target. (Target can be a text entry box or drop-down menu.) In 
Figure 11-18, the two new function/operation combinations have triggered the 
appearance a Target option related to the selected operation. For the Contact 
Center’s Blind Transfer Operation, the Target becomes the ID of the agent who 
should receive the transferred call.

Step 4 Type a name for the new toolbar in the Name field.

Step 5 Select Contact Center from the drop-down menu under the Function heading.

Step 6 Select the operation from the drop-down menu to the right of the Function 
choice. This operation is associated with this toolbar button. (After the Contact 
Center function is chosen, the available operations apply to Contact Center 
only.)

Step 7 Type a label in Label field.

Figure 11-17 Assigning Contact Center Operations to Communicator Toolbar Buttons
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Figure 11-18 Configuring the Buttons of a New Toolbar

Step 8 Specify a target if the selected operation activates the Target option.

If a required target field for an operation is left blank or configured with invalid 
information, the system opens a dialog box to collect valid information when the 
user clicks on the associated button in Communicator. This pop-up dialogue box 
appears when inadequate information is configured for the following operations:

• Consult Transfer to Agent
• Blind Transfer to Agent
• Login/Login Group
• Logout Group
• Release with Reason Code
• Wrap-up with Code

Step 9 Continue programming the toolbar buttons as needed.

NOTE: If a button is unused or blank and this unused button sits between other, 
used buttons, Communicator interprets the sequence of blank buttons as a divider 
that is visible on the toolbar.

Step 10When the toolbar button programming is done, click Save.

Repeat the process of assigning operations to buttons for each new user who is to 
use the integrated Communicator. 
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11.2.6 ECC Agent Queue
In a small call center or a sales-oriented call center, calls that are routed to an agent often 
must be queued for the agent when he or she is not available. The Agent Queue feature in 
Enterprise Contact Center allows calls to wait in a queue that is specific to an agent. Also, 
in conjunction with the Agent Queue feature, ShoreTel Communicator has been enhanced 
to let the agent manage his or her Enterprise Contact Center queue. 

After a system administrator enables Transfer to Agent Queue for the individual agent-user 
in ShoreTel Director, the agent sees a Transfer to Agent Queue toolbar button in his or her 
ShoreTel Communicator. Subsequently, after logging into Enterprise Contact Center, the 
agent can press a button in Communicator to transfer an incoming call to his or her 
individual agent queue.

11.2.6.1 Implementation
This section describes how to enable the Agent Queue capability for an agent-user in 
Director. The Transfer to Agent Queue toolbar button is enabled in the same manner as 
other toolbar buttons in ShoreTel Director. 

Refer to the Enterprise Contact Center Administrator Guide for additional information on 
the implementation of the feature.

To enable the Agent Queue capability in Director:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Users page appears.

Step 3 Click the Personal Options tab.

Step 4 Click the Program Communicator Toolbars link. The Program Communicator 
Toolbars page appears.

Step 5 Click the New button or select the user you want to configure. The Program 
Communicator Toolbar Buttons page appears as shown in Figure .
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Figure 11-19Configuring Agent Queue Toolbar

Step 6 In the first Function field, select Contact Center.

Step 7 In the second Function field, select Transfer to Agent Queue.

Step 8 In the Label field, type the label for the button. You can use up to 12 characters 
for the label.

Step 9 Click Save.

11.2.6.2 Error Messages for ShoreTel Communicator Enhancements
ShoreTel Communicator lets an agent transfer an existing ACD call to an Agent Queue. In 
addition, the enhancements include failure messages for attempted transfers that fail and a 
warning message if the agent tries to log out while calls still exist in the Agent Queue.

Table  describes the new messages that an agent might see.

11.2.7 ShoreTel Communicator Availability of Workgroup 
Controls to ECC Agents for Failover
Workgroup controls in the ShoreTel Communicator are available to Enterprise Contact 
Center (ECC) agents who use ShoreTel Communicator and are also members of a 
workgroup. The Login/Logout controls reflect their state in both ECC and the workgroups 
and are synchronized between these two systems.

Figure 11-20 shows the menu of ECC items for the Workgroup Agent Communicator 
when ECC integration has been enabled for the user. ECC control and status items are:

• “Logged Out of All Groups” (agent status)

• Set Agent ID
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• Log In/Out

• Release/Resume

• Wrap-up Code

• Release with Code

Figure 11-20 Workgroup Agent Communicator with ECC Integration Enabled

11.2.7.1 Agent State Changes in ShoreTel Communicator
When an agent starts up ShoreTel Communicator, the agent’s initial state is logged out of all 
ECC groups and all workgroups. Upon selecting Log Into All Groups, the agent logs into 
all ECC groups and all workgroups for which he or she is programmed (see Figure 11-21). 
Upon logging out, the agent is logged out of all ECC groups and all workgroups. If the ECC 
agent state changes to the Release state, the Workgroup state changes to the Wrap-Up state.

Note: We strongly recommend that an ECC agent be allowed to log into only workgroups 
that serve as a backup for the main ECC route. Receiving calls concurrently from ECC and 
Workgroups that are not backup workgroups might show inconsistencies in reporting of 
Non-ACD (NACD) calls in ECC.

Table 11-2 Agent Queue Error Messages

Message Description

You have queued calls in your personal 
queue. Press OK to logout of all queues or 
Cancel to remain logged in to just your 
personal queue.

When an agent logs out of all Enterprise 
Call Center groups from ShoreTel 
Communicator but still has calls queued in 
the Agent Queue, a warning message 
window pops up.

FAILMSG_FAILED_TO_SEND_CALL_TO
_AGENT_QUEUE = 38

An attempt to transfer the call to the agent 
queue has failed.

FAILMSG_FAILED_TO_SEND_CALL_TO 
_AGENT_QUEUE_ALREADY_ANSWERE
D = 39

An attempted call transfer to an agent 
queue failed because the call was answered 
by another agent.

FAILMSG_FAILED_TO_SEND_CALL_TO
_AGENT_QUEUE_NON_ACD = 40

An attempt to transfer the call to the agent 
queue has failed because the call is a non-
ACD call.

FAILMSG_LOGOUT_FROM_AGENT_QU
EUE_FAILED = 41

An attempt was made to logout all, logout 
primary, or logout specific from an agent 
queue while are calls were queued in the 
agent queue.
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Figure 11-21 Changing States by Using ShoreTel Communicator

11.2.7.2 Failover Behavior of ShoreTel Communicator
If ECC is unreachable or unavailable, ShoreTel Communicator indicates the system is in 
“Failover Mode” (while the agent is a member of a Workgroup), as shown in Figure 11-22. 
Failover Mode lets an agent continue to log in and out of workgroups through the Contact 
Center menu or the toolbar menu. As Figure 11-22 suggests, only the Log Into All Groups 
and Log Out of All Groups options remain available. Other options are grayed out.

Figure 11-22 Failover Behavior of ShoreTel Communicator with Workgroup

If ECC is unreachable or unavailable and the agent is not a member of a Workgroup, 
ShoreTel Communicator displays “System Unavailable” as shown in Figure 11-23.
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Figure 11-23 Failover Behavior of ShoreTel Communicator without Workgroup

11.2.7.3 Other Behaviors of ShoreTel Communicator
If ShoreTel Communicator loses contact with an ECC server, it keeps the login state locally. 
(The local state is the state the client was in before disconnection.) When connectivity 
resumes, ShoreTel Communicator logs in or logs out based on the local login state.

If an administrator disables Contact Center Integration in ShoreTel Director, ShoreTel 
Communicator logs out of all ECC groups but remains in the last known state that was set 
for the workgroups (any workgroup) of which the ShoreTel user is a member.

11.2.7.4 Workgroup Agent Contact Center Integration
To enable Contact Center Integration if you want the agent to use the Workgroup Agent 
Access level licensing as well follow these steps:

Step 1 Log into ShoreTel Director.

Step 2 Click on the Users -> Individual Users link (see Figure 11-24).

Step 3 In the Access License drop-down list, select Workgroup Agent.

Step 4 Put a check the Enable Contact Center Integration checkbox.

Step 5 Click on the Save button.
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Figure 11-24 Selecting the Workgroup Agent Access License Configuration

11.3 Communicator for Mobile
Communicator for Mobile expands the remote user feature set by adding Communicator 
functionality to mobile devices. 

Communicator for Mobile comprises the following components:

• Communicator for Mobile Server (MCMS) is a ShoreTel server component that 
manages all communications with ShoreTel Communicator for Mobile clients. 
Installing the ShoreTel Server includes the automatic installation of MCMS.

• The Communicator for Mobile (CM) client application is installed on each mobile 
device. Communicator for Mobile accesses ShoreTel functions, configuration 
information, voicemail, and calling history by communicating with the MCMS.

The MCMS is located on the main and distributed ShoreTel servers. Secure wireless 
communication sessions with specified mobile devices are conducted through a Reverse 
Proxy Server or a Blackberry Enterprise Server.

Mobile devices receive MCM Client Installation Files from the ShoreTel Server through a 
Blackberry Enterprise Server. After installing these files, the end user can configure the 
mobile device to access the ShoreTel server through an IP address provided by the system 
administrator.

ShoreTel Communicator for Mobile enables a mobile device to function as a ShoreTel 
extension and provides an interface, similar to Communicator, for accessing ShoreTel client 
information. In addition to initiating calls from the Call History, Voice Mail, and 
QuickDialer screens, end users can access their voice mail, configure call handling mode 
settings, set the active call handling mode, configure Extension Assignment settings, and 
activate Extension Assignment from the ShoreTel Communicator for Mobile user interface.

Communicator for Mobile supports up to 200 conventional users per ShoreTel system.

11.3.1 Supported Configurations

11.3.1.1 ShoreTel Communicator for Mobile Support – Languages
Communicator for Mobile software supports all elements of English (U.S.), English (U.K.), 
German, Spanish, Swedish, French, Dutch, Danish, Italian, and Norwegian.
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Usability Enhancements

Communicator for Mobile now supports smart type. Smart type means that certain keys do 
not need a special key to enable character entry. On a BlackBerry, for example, a user can 
type a “.” or “-” without using the Alt key on numeric fields. This addition expedites the 
entry of IP addresses or extension numbers.

The left and right direction keys move the cursor so the user can insert one or more 
characters instead of being required to delete an entire field to correct an error. This feature 
is available on most supported devices.

Localization Features

Localization support affects the following area of the product:

• Western languages: the supported languages are English (U.S.), English (U.K.), 
German, Spanish, Swedish, French, Dutch, Danish, Italian, and Norwegian.

• Keyboard types: on devices that have full keyboards, users can choose from 
programmed keyboard layouts for their location. For example, the top row of letters 
on American keyboards includes q w e r t y; German keyboards have q w e r t z; and 
French keyboards have a z e r t y.

• Character set: Communicator for Mobile utilizes the Latin-1 character set (see http:/
/htmlhelp.com/reference/charset/). This character set includes all accented 
characters and other global symbols.

• Ordering of time and date: based on the language that a user specifies, 
Communicator for Mobile orders the date and time data according to the custom for 
that language. For example, with U.S. English, the order is mm/dd/yy; for U.K. 
English, dd/mm/yy; and for Dutch, dd-mm-yy. A table with the format of dates and 
times appears in the "Localized Date and Time Table" on page 405.

• Accented characters: Communicator for Mobile supports accented characters 
(diacritical marks). The keyboard for the selected language supports these marks, 
and the QuickDialer key filter also supports diacritical marks.

• The thumb wheel on the side of the device or other rotating character facility lets the 
user enter accented characters on the phone. The specific method for rotating 
through a character set depends on the model, yet the implantation is specific to 
Communicator for Mobile. (The ShoreTel model mirrors how a user enters 
characters on the device.)

• Localized time on the phone: The server uses a standard GMT format that the client 
converts to the time according to the time zone that is detected by the device. 
Therefore, the phone shows the time according to the time zone where the phone is 
located.

11.3.2 ShoreTel Communicator for Mobile Support – Devices
ShoreTel Communicator for Mobile is supported on the following devices:

• Samsung BlackJackII (New in ShoreTel 11)

• BlackBerry 81xx Series

• BlackBerry 83xx Series

• BlackBerry 88xx Series

• BlackBerry 90xx Series
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• BlackBerry 8900 

• BlackBerry 9500 

• Nokia E61i

• Nokia E65

• Nokia E71

• Nokia E72 

• Nokia E75 

• Nokia Surge 6790 

• Nokia E90

• Nokia N78

• Nokia N82

• Nokia N95

• HTC Mogul (Sprint PPC-6800)

• HTC P6500 (Sirius)

• HTC TyTn II

ShoreTel Communicator for iPhone

• iPhone OS 3.1 and later

• iPhone 3G and 3GS

• iPhone 4

The following section describes a few functional differences based on the manufacturer or 
by model. Most models support all functions in Communicator for Mobile. This section 
lists the exceptions, so every model supports every function of Communicator for Mobile 
unless noted under a heading in this section.

11.3.2.1 Carrier Support
ShoreTel Communicator for Mobile is supported across carriers that allow installation of 
third-party applications onto the BlackBerry device.

The BlackBerry series 8100, 8300, 8700, and 8800 and the BlackBerry 7290 models are 
supported on any network that allows the installation of third party software. Although 
some mobile carriers restrict the downloading and installation of third-party software 
through their network, no known restrictions for the BlackBerry devices currently exist in 
any network.

Carrier support and restrictions on Nokia E65 series devices can be addressed by the end 
user’s carrier.

ShoreTel Communicator for Mobile supports LBS on the Nokia E71.

Devices supporting LBS must either have internal GPS hardware or the capability of 
connecting to an external device that provides GPS functionality, such as dongles. The 
carrier must allow GPS on the device and allow third party applications, such as MCM, to 
use GPS functionality. External GPS devices may be used to enable LBS features on these 
devices, depending on carrier limitations.
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11.3.2.2 PIM Integration
The Nokia E71 supports PIM entry import. The ShoreTel Communicator for Mobile 
settings page provides an option to disable PIM loading. The TY TN II does not support 
PIM.

11.3.2.3 Screen Transition
Screen transition refers to leaving one screen and going to another screen. Manufacturers 
offer menu-operations, buttons, or softkeys for moving to another screen. This section lists 
restrictions that manufacturers have for screen transitions by the clicking of a menu item, 
physical button, or soft key.

• Menu: The Nokia E65 does not have menu-activated screen transitions.

• E65 screen transitions are done by softkeys.

• Button: None of the current models have button-only screen change activation.

• Soft key: Soft key is not supported by any of the BlackBerrys. 

11.3.2.4 Personal Information Manager
Personal Information Manager (PIM) lets a device synchronize information from the 
Quickdialer feature in Personal Communicator so that this information is automatically 
loaded and updated in Communicator for Mobile. PIM is supported by all supported 
devices.

11.3.2.5 Preview Voicemail
Voicemail cannot be previewed on the BB7290 because this model has no external speaker.

11.3.2.6 Font Size
Font size in the display cannot be changed on any of the BlackBerry models. 

11.3.3 Requirements

11.3.3.1 MCMS
The Communicator for Mobile Server (MCMS) is the ShoreTel server component that 
manages ShoreTel Communicator for Mobile client communications. The MCMS is 
installed on the ShoreTel HQ and DVM servers as part of the normal ShoreTel Server 
installation process. The MCMS contains no configuration parameters and requires no 
administrator intervention or monitoring during normal ShoreTel operations.

11.3.3.2 MCM Client Installation Files
Communicator for Mobile Client Installation Files are a set of files that provide the 
ShoreTel Communicator for Mobile client application to mobile devices. Clients download 
these files to their mobile devices from a server specified by the system administrator. 
Communicator for Mobile Client Installation Files are maintained and updated by the 
system administrator. 

These files are originally placed on the ShoreTel Server as part of the ShoreTel installation, 
then moved by the system administrator to a server that can be accessed by the mobile 
devices of system end users.
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11.3.3.3 Servers
Mobile devices must connect with the ShoreTel server to access MCMS services. Enterprise 
security requirements affect the structure of the network that provides application support. 
The following section describes servers that are typically used to implement ShoreTel 
Communicator for Mobile.

11.3.3.4 Blackberry Enterprise Server (BES)
The Blackberry Enterprise Server is a middleware application, offered by Research in 
Motion, that supports ShoreTel Communicator for Mobile by synchronizing email and PIM 
information through a secure back channel between the MCMS and BlackBerry mobile 
devices. The BES also supports Client Installation File downloads from ShoreTel to 
BlackBerry devices.

11.3.3.5 Reverse Proxy Server
A reverse proxy server is a proxy server that is normally installed in front of web servers. 
Internet communications addressed to a web server are routed through the reverse proxy 
server, which can process the request or pass the request to the specified web server. 
Implementing a reverse proxy server within the corporate DMZ maintains the integrity of 
the corporate firewall and insulates the ShoreTel Server, along with other corporate assets, 
from public networks.

A reverse proxy server provides secure wireless communication between Mobile Devices 
running ShoreTel Communicator for Mobile and ShoreTel server. A reverse proxy server 
can serve the same role as a BES for conducting ShoreTel Communicator for Mobile 
wireless communication sessions.

To fully set up a reverse proxy you would need an Apache server version 2.2 or higher, and 
a SSL certificate from a root certificate authority. The system supports a self-signed 
certificate, however, the users will receive a warning each time the application is launched. 
This is not recommended for production deployments

See the ShoreTel 12: Planning and Installation Guide for details on configuring reverse 
proxy services.

Direct communication between an MCMS with the mobile devices is not recommended. 
This configuration compromises the integrity of the corporate firewall and exposes the 
ShoreTel Server and other connected corporate assets to attacks from public networks.

11.3.4 Administrator Configuration
ShoreTel Communicator for Mobile administration comprises two application activities: 
client application installation file delivery to the mobile devices and ShoreTel 
Communicator for Mobile communication sessions with the mobile devices. Configuring 
ShoreTel to support ShoreTel Communicator for Mobile requires the completion of the 
following tasks:

• Installing at least one additional server

• Acquiring the required ShoreTel Communicator for Mobile license 

• Authorizing clients to use ShoreTel Communicator for Mobile

MCMS installation is performed with the installation of a ShoreTel server. The MCMS 
requires no additional installation or configuration. The following sections describe the 
tasks required to install and support ShoreTel Communicator for Mobile.
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11.3.4.1 Server Installation (Headquarters and DVM)

Server configuration options:

• ShoreTel Communicator for Mobile communication sessions with a BlackBerry 
device are supported by a BES or a Reverse Proxy Server.

• Client Installation File downloads to a BlackBerry are supported through a BES.

Systems can use a BES server for all ShoreTel Communicator for Mobile activities.

BlackBerry Enterprise Server (BES)

The BlackBerry Enterprise Server supports ShoreTel Communicator for Mobile 
communications between the ShoreTel server and BlackBerry devices. BlackBerry devices 
can also access MCM Client Installation Files located on the ShoreTel server through the 
BES. The BES implements a secure connection, similar to that of a VPN, to provide access 
for mobile devices to resources that are protected by the corporate firewall.

For information on installing a BES, refer to BES installation instructions provided by 
Research in Motion.

11.3.4.2 Client Installation Files
Installing the ShoreTel Server places the Communicator for Mobile Client Installation Files 
directly on the ShoreTel Server. BlackBerry devices can access the files directly from the 
ShoreTel Server if the network includes a BES.

Version numbering for Communicator for Mobile is in sync with the ShoreTel version 
number. The download format is xx.yy.zz. This format is required by the Nokia E65. In 
contrast, the BlackBerry does not have such a requirement. Nevertheless, an image with a 
number like 13.20.8700.0 is listed on the server as 13.20.87.00 for download activities, yet 
it appears in the device’s About window as 13.20.8700.0.

Client Installation files can be delivered from a system that runs Windows 2003 or 2008 
Server and has IIS. The IIS server must be configured to serve WML (Wireless Markup 
Language) files to the mobile devices. Table 11-3 lists the MIME types required to serve the 
installation files.

To register the required MIME types:

Step 1 On the computer desktop, click Start > Settings > Control Panel. The Control 
Panel appears.

Step 2 Select Administrative Tools.

Step 3 Select Internet Information Service.

Table 11-3 Mime Types Required to Serve MCM Installation Files

File Extension MIME Type

.jad text/vnd.sun.j2me.app-descriptor

.jar application/java-archive

.wml text/vnd.wap.wml

.cod application/vnd.rim.cod
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Step 4 Open the HTTP Headers page, shown in Figure 11-25, by clicking the HTTP 
Headers tab at the top of the Internet Information Services page.

Figure 11-25Internet Information Services Page – HTTP Headers Page

Step 5 Open the MIME Types page by clicking the MIME Types... button in the 
bottom right corner of the HTTP Headers page.

Step 6 Open the MIME Types Dialog box by clicking the New button on the top right 
corner of the MIME Types page, as shown in Figure 11-26.

Figure 11-26MIME Types Page

Step 7 Enter the Associated extension and content type data in the corresponding data 
entry field of the MIME Types Dialog box, shown in Figure 11-27, for one of 
the following types:
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• Content type: text/vnd.sun.j2me.app-descriptor; extension: .jad

• Content type: application/java-archive; extension: .jar

• Content type: text/vnd.wap.wml; extension: .wml

• Content type: application/vnd.rim.cod; extension: .cod

Figure 11-27MIME Types Dialog Box

Step 8 Click the OK button to close the MIME Types dialog box and return to the 
MIMES type page.

The table lists the type entered in Step 7.

Step 9 Repeat Step 6 through Step 8 for each type listed in Step 7.

Step 10Click OK buttons on each successive page to save your changes and return to 
the desktop.

11.3.5 ShoreTel Director Configuration

11.3.5.1 Licenses
One ShoreTel Communicator for Mobile Keyed License is required for each client that is 
enabled for ShoreTel Communicator for Mobile. To view the number of ShoreTel 
Communicator for Mobile licenses available on the system, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > System Parameters > Licenses > Requirements. The 
License Requirements List page appears as shown in Figure 11-28.
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Figure 11-28License Requirements Page

Step 3 In the Keyed License section, locate the Mobile Access License listing and 
check the Configured and Purchased columns for information about your 
mobile license status.

11.3.5.2 Client Authorization
ShoreTel administrators grant ShoreTel Communicator for Mobile access to clients through 
ShoreTel Director. To enable ShoreTel Communicator for Mobile access for a ShoreTel user:

Step 1 Launch ShoreTel Director. 

Step 2 Click Administration > Users > Individual Users.

Step 3 Click the name of the user in the User List. The Edit User page appears as 
shown in Figure 11-29.
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Figure 11-29Configuring an End User for ShoreTel Communicator for Mobile

Step 4 Check the Allow Mobile Access check box.

Step 5 Locate the Voice Mail Password fields and uncheck the Must Change on Next 
Login check.

Step 6 Click Save.

11.3.6 Client Configuration Information Delivery
The administrator must provide the following information to each client authorized to use 
ShoreTel Communicator for Mobile:

• URL of the server through which mobile devices download the Client Installation 
Files.

• IP address and Port Number through which the mobile device accesses the MCMS.

• the client’s user extension.

• the client’s voicemail password.

11.3.7 Configuring Information upon First-Time Use
This section describes the first-time configuration requirements of the device.

11.3.7.1 Languages
The first screen that a user sees upon first-time startup of Communicator for Mobile under 
ShoreTel 12 is the language selection screen (Figure 11-30). The supported languages are 
English (U.S.), English (U.K.), German, Spanish, Swedish, French, Dutch, Danish, Italian, 
and Norwegian.
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Figure 11-30Language Selection Screen

Step 1 To select a language, use the track ball, wheel (at the right side of the device), 
or other device-specific selector to highlight a language.

Step 2 Press the wheel or press Select to use the highlighted language.

On devices that have a full keyboard, the keyboard selection screen appears after 
language selection. For devices that do not have a full keyboard, users are taken to 
the provisioning window.

11.3.7.2 Keyboard Type
After selecting a language, users see the keyboard selection menu on devices that have a 
full keyboard as shown in Figure 11-31:

Figure 11-31Keyboard Selection

Step 1 To select a keyboard, use the track ball or wheel at the right side of the device 
(or other, device-specific selector) to highlight the sequence of letters on the 
top row of the keyboard.

Step 2 Press the wheel or press Select to use the highlighted keyboard. After the user 
selects a keyboard, the informational screen appears in the selected language.
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Step 3 Press Next to open the next screen, where specific user-details are entered. See 
next section, Provisioning User Details.

11.3.7.3 Provisioning User Details
The following user information is required for the first-time provisioning of a new phone:

• The IP address of the server that hosts the user account (not the DNS) is obtained from 
a system administrator. This server can be the BES or some other mechanism for 
reaching the server from the outside, such as a reverse proxy server.

• The Port number on the server that hosts the user account (obtained a system 
administrator).

• The user’s extension.

• The password is the personal ID number (PIN): the user must enter this ID before 
hearing voicemail. Upon power up after the first-time specification of the password, the 
User Information screen does not show the password field.

After these four values are entered upon the initial run, Communicator for Mobile retains 
the configuration so the user does not need to re-enter it. An example of the regular User 
Information screen that is displayed after the initial configuration appears in Figure 11-32.

Figure 11-32User Information Screen

The user can change the startup screen through the Settings window (“Default Start Page” 
in Figure 11-33).

Figure 11-33Settings Screen
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After user information is initially entered, a status message momentarily appears, followed 
by a welcome message. After the welcome message, the Main Menu appears as the default 
startup window. The user can choose a different startup window by using the Settings 
window.

11.3.7.4 Specifying Accented Characters
The rotating character facility lets the user enter accented characters on the phone. This 
scheme follows the model used on the manufacturer’s device. However, the implantation is 
specific to Communicator for Mobile, and this model mirrors the way a user enters 
characters on the device.

If a user enters the string “Andre” but actually wants “André Dupont,” a wide variety of 
possibilities can come up (if they exist in the user’s directory), for example:

Andre, Andrè, André, Andrê, Andrë, AndrÈ, AndrÉ, AndrÊ, AndrË . . . .

Now, the user can enter “André” to get André Dupont. Quickdialer can use the specific 
device’s scrolling mechanism to select an accented character. Different devices have 
different mechanisms for scrolling through character choices. For the BlackBerry models, 
the user holds down a key and uses the trackball or thumb-wheel to scroll through the 
possibilities. Furthermore, all accent marks are available regardless of the selected 
language.

11.3.7.5 Localized Date and Time Table
This section consists of a table (Table 11-4) that lists the date and time that appears on a 
device based on the selected language.

Table 11-4 Date and Time Formats by Language (Country)

Language Date Time

Deutsch dd.mm.yy 08:48
23:59

Español dd/mm/yy 8:48
23:59

Svenska yy-mm-dd 08:48
23.59

Français dd/mm/yy 08h48
23h59

Nederlands dd-mm-yy 8:48
23:59

Dansk dd-mm-yy 8:48
23:59

Italiano dd/mm/yy 8:48
23:59
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11.3.8 Upgrading Communicator for Mobile
For an administrator, upgrading Communicator for Mobile requires only the installation of 
ShoreTel Version 12 to the server that runs Communicator for Mobile. This installation 
automatically places new versions of Communicator for Mobile’s server components and 
client installer on the server. 

Before upgrading a client device, the subscriber must delete the existing application from 
the device. To perform the upgrade, the subscriber accesses the URL that was used to 
download client software. Access to the Communicator for Mobile is available through the 
following URL format:

http://server/mcm/client/

where server is either a valid DNS name or IP address of the Communicator for Mobile 
server. Upon entry of the correct URL, the device’s browser is automatically directed to the 
latest file.

The server needs to be reachable from the mobile phone. This server could be a BlackBerry 
Enterprise Server (BES) or some other mechanism for reaching the server from the outside, 
such as a reverse proxy.

The following sequence illustrates an installation from a BES server:
1. The system administrator sends an email with a link to the location of the 

Communicator for Mobile software to the subscriber.

2. On the mobile device, the subscriber clicks on the email’s enclosed link to get access 
to the download site.

3. The subscriber removes the current MCM version from the device.

4. The subscriber clicks the link leading to the download site on the browser window.

5. After the Communicator for Mobile software has been downloaded, the subscriber 
configures the client with the IP address and port allocated on the ShoreTel server 
for Communicator for Mobile.

As long as the device can reach the ShoreTel server, no other configuration or setup is 
required between the BES and the ShoreTel Server. (A company could restrict on access to 
its BES.)

Alternatively, the user can open a browser on the device and enter the URL of the server (in 
the format http://server/mcm/client). The server window opens with choices for locating 
the newest client software, as Figure 11-34 shows.

Norsk dd.mm.yy 08h48
23h59

English U.K. dd/mm/yy 08h48
23h59

English U.S. mm/dd/yy 8:48 AM
11:59 PM

Table 11-4 Date and Time Formats by Language (Country)

Language Date Time
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Figure 11-34Accessing the Newest Client Software

The user selects the application for the device. In Figure 11-35, the software is for a 
BlackBerry 8800 series.

Figure 11-35Choosing Specific Client Software

To download the client software, the user highlights and presses the Download button 
(Figure 11-36).
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Figure 11-36Starting the Download of the Selected Client Software

Upon successful software download a message (Figure 11-37) shows that the device is 
ready for the user to make choices for Communicator for Mobile’s operation.

Figure 11-37After Successful Download
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C H A P T E R 1 2

Configuring User Features

This chapter is about setting up users in the ShoreTel system. The topics discussed include:

• "Private Numbers" on page 409

• "Using Extension Assignment" on page 410

• "Inbound Call Management" on page 418

• "Call Intervention Methods" on page 429

12.1 Private Numbers
Users can have private numbers that are not listed in the System Directory or in 
Communicator Quick Dialer and thus have Caller ID information suppressed. This is 
enabled through the check box on the Edit User page called Make Number Private. When 
checked, the user's extension becomes a Private Number. 

The following conditions apply to private numbers:

• The user’s Private Number extension no longer appears in the QuickDialer for dial-
by-name operations or in the ShoreTel Directory Viewer.

• Calls placed by a Private Number user show the caller's name but not their number 
to the dialed party for internal calls. This applies to analog phones, IP phones, and 
associated instances of the Communicator. The ring style is a double-ring, 
indicating an internal call.

• Calls placed from a private number to an external party do not deliver a Direct-
Inward-Dial (DID) number as Caller ID when PRI trunks are used for the outbound 
call. The proper CESID (Caller’s Emergency Service ID) will only be delivered for 
911 calls. 

• Calls placed from a private number to an off-system extension on PRI trunks with 
NI2 signaling deliver calling name information but not calling number 
information.

• Routing slips and the Communicator and History viewer show the Private Number 
user's name but not their extension number.

• The Private Number users are listed with name and number in the Extension 
Monitor extension selection dialog box.

• The user can be dialed directly via the telephone or the Communicator if their 
extension is known.

• Contacts imported from Microsoft Outlook or Exchange that reference a Private 
Number user's extension are not blocked and are fully visible in the Communicator 
Quick Dialer.
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• CDR database records show both number and name for Private Number users. The 
Caller-ID Flags field will indicate that only the name is valid however.

• CDR legacy log files show the number of Private Number user calls that are 
inbound or outbound calls.

• The ShoreTel Director shows number information for Private Number users as with 
other users, as for example on the User List page.

12.2 Using Extension Assignment
Extension Assignment is a feature of the ShoreTel system that allows a user to quickly and 
easily re-assign his or her extension to any telephone on the system or off the system. The 
user’s communications profile is reassigned to that telephone, and calls placed to the user 
will be routed to that telephone, while calls placed from that telephone will reflect proper 
caller ID information.

The Extension Assignment feature might be used by the following types of users:

• Multi-site users, such as executives or managers, who might use the system across 
multiple locations. Extension Assignment allows these users to pick up a telephone 
at any location on the enterprise network, log into voice mail, and assign their 
extension to that telephone. (See the "Configuring On-Net Extension Assignment" 
on page 417.)

• Office hotel users, such as contractors or telecommuters, who may occasionally be 
out of the office or who might share a cubicle (and thus a phone) with another 
employee. Extension Assignment allows these users to have their own extension 
and mailbox, yet not have a dedicated switch port. They can simply assign their 
extension to a telephone on the network when they are in the office while allowing 
another user to usurp that phone when they are done with it. (See the "Configuring 
On-Net Extension Assignment" on page 417.)

• Remote or mobile users, such as employees in sales or support, who might travel 
frequently and would like to have all calls directed to their cell phone or home 
office PSTN phone. Extension Assignment allows these users to have their own 
extension and mailbox, yet not have a dedicated switch port, thus optimizing 
system resources. (See the "Configuring Off-Net External Assignment" on page 
414.)

• Legacy PBX Users, such as users with Off-System Extensions working with 
Communicator. (See the "Configuring Off-Net External Assignment" on page 414.)

Extension Assignment also allows the system administrator to configure all telephones as 
anonymous telephones and all users as virtual users, eliminating administrative costs 
associated with frequent moves. When a move occurs, users simply assign their extension 
to the telephone at the new location.

The feature also allows an off network user to manage a call via Communicator, so while 
the conversation occurs over the cell phone or home phone, the call appears via 
Communicator and can be controlled using many of the features available via 
Communicator. Note that this requires the user to be located near a PC that has access to a 
broadband connection and that Communicator is running.

Other benefits to the (Off-Net) Extension Assignment user include:

• Use the existing PSTN line for voice while managing the call via Communicator 
over an ordinary broadband Internet connection.
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• Emulate analog extension hook switch actions via star-star (**) for FLASH and 
pound-pound (##) for on-hook/off-hook.

• Access the user's directory numbers at the office.

• The user appears to be calling from the office.

• Keep communication costs minimized with flexible IP & trunking requirements.

• Retain call management features of the ShoreTel system over a broadband 
connection while maintaining audio quality over PSTN.

12.2.1 Special Considerations
The following list shows considerations for Extension Assignment:

• When an Extension Assignment call finishes but the carrier has not reported back 
to the ShoreTel system that the far side has disconnected, the call remains active for 
approximately five seconds before it is finally disconnected. To initiate a new call 
during the five-second window, the user can press “##.”

• To use the Extension Assignment feature, the user must be in a user group that has 
a Telephony Class of Service with Allow Extension Reassignment. See "Configuring 
Permission Settings" on page 412.

• SIP is not supported as the external number to which the user is reassigned.

• ShoreTel supports up to 1,000 virtual users.

• Incoming calls to a user's extension that has been assigned to an off-net location 
rings on the cell phone or Off-System Extension. If the call is not answered, normal 
call handling allows the caller to leave a message in the user's ShoreTel mailbox.

• Extension Assignment, when assigned to an off-net location, is fully controllable 
through ShoreTel Communicator (except for answering a call, which must be done 
manually). Also, Extension Assignment has limited TUI functionality.

• Extension Assignment calls that are terminated through ShoreTel Communicator 
are not followed by the standard dial tone. Extension Assignment uses a unique set 
of internal and external dial tones. This difference in tones can be important in 
installations where network devices have been configured to listen for normal class 
progress tones before taking action on a call, such as hanging up.

• Calls placed or answered through Extension Assignment, when assigned to an off-
net location, continue to show in the ShoreTel Communicator call stack. Normal 
call control functions, such as hold, unhold, conference, transfer, and park, 
continue to work. Park to the Extension Assignment extension, when assigned to 
an off-net location, is not supported.

• Extension Assignment, when assigned to an off-net location, behaves like an 
automated “Find Me” feature except that the caller does not press 1 to find the 
called party. (The PSTN phone number is immediately called.) The call recipient 
can answer the call by lifting the handset (or activating a cell phone) and pressing 
the DTMF digit 1 in response to the repeating prompt.

• Prompts (such as those used for Find Me) can be used to confirm answering. The 
answer style can be configured to be one of the following possibilities:

— Wait for DTMF (the default) - The call is not forwarded until the user presses 
DTMF 1.
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— Wait for Answer - The ShoreTel system forwards the call as soon it detects the 
far-end answer. (Note that far-end answer detection is not supported by the 
central office for some trunk types, in which case the user must press 1.) 
(DTMF is audible to the caller.)

12.2.2 Terminology
The terms used to describe Extension Assignment are as follows:

• Anonymous telephone: A telephone not currently assigned a user. You can make a 
call from an anonymous telephone, but you cannot call an anonymous telephone.

• Any IP Phone: The feature that lets users assign their extension to any IP phone on 
the enterprise network.

• Assign: The command that assigns an extension to a telephone.

• Assigned: The status of a user who is currently assigned to a telephone that is not 
their home phone.

• Current telephone: The telephone to which the user is currently assigned (also 
known as the current switch port).

• Go Home: The command to assign a user’s extension back to his or her home 
telephone.

• Home: The status of a user who is assigned to his or her home telephone.

• Home telephone: The telephone to which the user is normally assigned (also know 
as the home switch port). This is the telephone to which the user returns when 
using the Go Home command.

• Extension Assignment: The feature that lets users assign their extension to any 
telephone, on-system or off-system extension.

• Unassign: The command that unassigns an extension from a telephone.

• Vacated telephone: A home telephone that currently does not have a user assigned. 
These are listed on the Anonymous Telephones edit page under Vacated 
Telephones.

• Virtual user: A user who does not have a physical telephone port and is currently 
assigned to the SoftSwitch.

12.2.3 Configuring Permission Settings
To configure the Extension Assignment feature, the system administrator must first give 
the end user permission to use the feature by following the procedure below:

Step 1 Launch ShoreTel Director and enter the user ID and password.

Step 2 Click on the Administration link to expand the list (if it has not already been 
expanded).

Step 3 Click on the User Groups link.

Step 4 Create a new user group for the Extension Assignment users, or click on the 
name of an existing user group (in which all members will have access to 
Extension Assignment).
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Step 5 For the COS - Telephony field, click on the Go to this Class of Service link to 
display as shown in Figure 12-1.

Figure 12-1 Configuring the Edit Telephony COS window for Extension Assignment

Step 6 Select the Allow Extension Reassignment check box.

Step 7 Select the Allow External Call Forwarding and Find Me Destinations check 
box and the appropriate Scope radio button.
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Step 8 Click Save to store your changes.

Details:

• If you are intending for a user to have access to the Extension Assignment feature, 
you should verify that he or she belongs to a User Group that is associated with the 
Class of Service you just modified above.

12.2.4 Configuring Off-Net External Assignment
The off-net external assignment is intended for mobile users who often work outside the 
office. These users might travel frequently or work from home, so they could benefit from 
having all calls directed to an “off-net” device, such as a cell phone or home office PSTN 
phone. Extension Assignment lets a user have a ShoreTel extension and mailbox without 
requiring a dedicated switch port and physical telephone in the office.

NOTE For an off-net ShoreTel user’s phone to display the ID of a caller who is outside a 
ShoreTel site, the system administrator must activate the function called Enable 
Original Caller Information on applicable trunk groups, as introduced in the 
"Outbound Settings" on page 159 and detailed in the "Forwarding Original Caller 
ID Outside a ShoreTel Network" on page 174.

To assign an extension to an off-net location, the ShoreTel user does the following steps:

Step 1 Launch Communicator on the client machine.

Step 2 Click on the Options menu (the ShoreTel symbol in the upper left hand corner) 
and select Extension Assignment > Configure Extension Assignment.

Figure 12-2 Using Communicator to Configure the Client Machine for Extension 
Assignment

Step 3 A pop-up window similar to the one shown in Figure 12-3 appears.
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Figure 12-3 Select the Enable External Assignment Check Box

Step 4 Select the Enable External Assignment check box

Step 5 Type the external phone number to which calls are to be routed. (This can be a 
cell phone, home phone, or other PSTN number outside the ShoreTel system.) 
If the external number has not already been entered, you do it now.

You cannot configure a PSTN number that would require the call to go out a 
SIP trunk.

Step 6 Select one of the following Activation radio buttons:

• Select Accept call by pressing “1” to answer calls on the device by pressing 
1.

• Select Answer call by answering to answer calls on the device by releasing 
the switch (e.g. lifting the handset off the cradle).

Step 7 Click the OK button to store changes.

Step 8 Click the Options menu and select Call Handling > Configure Call Handling. 
A Call Handling window appears as shown in Figure 12-4. 
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Figure 12-4 Call Handling Window

Step 9 In the Forward Calls area of the window, select the When No Answer or Busy 
radio button.

Step 10Under the “Forwarding destination” area, click the Edit Destination button. 
The Call Handling Destination dialog box appears as shown in Figure 12-5.

Figure 12-5 Edit Call Handling Destination Window

Step 11In the “Forward after” field, set the number of times the phone is to ring before 
the call is sent to voicemail.
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NOTE The default of three rings might be insufficient for answering a call before 
it goes to voicemail. Selecting the Edit Destination button shown in the 
middle-right area of Figure 12-4 opens a window for modifying the 
destination and number of rings parameters (Figure 12-5).

Step 12Click OK.

Details:

• When finished with the configuration, the user can verify that Extension 
Assignment is enabled on the client machine by checking the Forwarding 
Destination box in the call handling configuration window.

12.2.5 Configuring On-Net Extension Assignment
On-net extension assignment is intended for users who may travel frequently, accessing the 
ShoreTel system from multiple sites “on the network.” These users can benefit from not 
being tied down to a single physical telephone, and Extension Assignment allows them the 
freedom to pick up a ShoreTel telephone and assign their extension to that telephone via 
the voicemail menu.

To assign or unassign an extension to any on-net telephone using the voicemail Telephone 
User Interface (below) or using Communicator (see the "Inbound Call Management" on 
page 418), follow the appropriate procedure below:

12.2.5.1 Using the Telephone User Interface
To assign an extension to a telephone:

Step 1 Log in to voice mail.

Step 2 Press 7 to select Change Mailbox Options.

Step 3 Press 3 to select Re-assign Extension.

Step 4 Press 1 to select Assign.

Step 5 Wait for a dial tone, then hang up.

This option is available only from telephone ports and not trunk ports.

To unassign an extension from a telephone:

Step 1 Log in to voice mail.

Step 2 Press 7 to select Change Mailbox Options.

Step 3 Press 3 to select Re-assign Extension.

Step 4 Press 2 to select Unassign.

Step 5 Wait for a dial tone, then hang up.

If no other user is assigned to the home telephone port, the extension automatically reverts 
back to the home telephone. If another user is assigned to the home telephone port, the 
extension will be assigned to the SoftSwitch until the home telephone port becomes 
available. A user can “kick out” the other user from the home telephone port by assigning 
the extension from their home telephone using the procedure above.
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12.2.5.2 Using ShoreTel Communicator
The ShoreTel Communicator login is integrated with Microsoft Windows. If you want to 
run the ShoreTel Communicator from another workstation, you must exit Windows, and 
log in by using your credentials. (You must have a valid profile on the workstation and 
ShoreTel Communicator.)

To return to a home telephone port:

Step 1 Verify the user status displayed in the lower-right corner of Communicator.

Step 2 Click the Go Home icon on the status bar, as shown below, or select Go Home 
from the File menu.

12.3 Inbound Call Management

12.3.1 Find Me
Find Me is a call handling method that allows a user to route inbound calls to a specified 
extension or phone number as an alternative to sending callers to voicemail.

Find Me call handling provides inbound callers with a method of connecting to their 
intended call recipient while listening to the recipient’s voicemail greeting. Callers are 
routed to an extension or phone number callers by pressing “1” while listening to the 
recipient’s voicemail greeting. 

System users configured for Find Me can specify two numbers for receiving call through 
Find Me. The standard voice mail greeting does not prompt the caller on the availability of 
Find Me call handling.

Find Me call handling is enabled through call handling mode settings. Find Me 
destinations are independent of the call handling modes that activate Find Me.

After the caller presses “1”, the system informs the caller that Find Me destinations are 
being called. Calls not answered at either Find Me destination are sent to voice mail.

When a call is forwarded to a Find Me destination, the phone at the Find Me destination 
displays recipient’s voice mail caller ID to the call originator. When answering a call, the 
recipient hears a prompt announcing the call and, if available, the caller’s ID information. 
The recipient can then accept the call or route the caller to voicemail.

Announced Find Me provides for the recording of the caller’s name for calls routed to Find 
Me destinations. This feature provides the capacity for all inbound callers to be identified 
when their call is routed to a Find Me destination. 

Figure 12-6 Extension Assignment Status and Go Home Function – Communicator 
Status Bar
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When Announced Find Me is enabled, callers from external numbers or from internal 
extensions without a recorded name are prompted to record their name before the call is 
routed to the recipient.

12.3.1.1 Find Me and External Assignment Page
When you click the Find Me and External Assignment link on the Personal Options page, 
the Find Me and External Assignment page appears, as shown in Figure 12-7.

Figure 12-7 Find Me and External Assignment Page
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Find Me allow users to configure two phone numbers as forwarding destinations, so that if 
they miss an incoming call, the call will be sent to voice mail, and from there, it will be 
redirected to one of the pre-configured forwarding destinations. External Assignment is 
also known as Extension Assignment. Refer to "Using Extension Assignment" on page 410 
for more information.

When a caller dials a user on the ShoreTel system, if the call is not answered, it is sent to 
voice mail. At this point, the caller is offered the option to “press 1 to activate Find Me call 
handling,” and the system subsequently attempts to route their call to one of the Find Me 
destinations that the user configured.

No system prompt informs callers that they need to press 1. The ShoreTel user must inform 
callers of this “press 1 to activate Find Me” option in the outgoing voice mail greeting.

After pressing “1”, the caller hears a message that the Find Me destinations are being called. 
If the call is not accepted at either of the Find Me destinations, the call is sent to voice mail.

Alternatively, users also have the option to automate the Find Me behavior, thus bypassing 
the requirement for callers to “press 1 to activate Find Me.” When Auto Find Me is 
enabled, calls will be immediately sent to the Find Me destination number(s) without any 
action on the part of the caller.

Details:

• Users are authorized to use Find Me through a Telephony Class of Service that 
enables Find Me.

• Find Me destinations can be extensions or external numbers.

• Find Me call handling can be enabled/disabled for each of the five call handling 
modes. The same Find Me destinations apply to all call handling modes with Find 
Me enabled.

To configure Find Me destinations:

Step 1 For the primary Find Me destination, select Extension or External. You can use 
the Search button to find system extensions. Enter external numbers in the 
External text box.

Step 2 Enter a value in the Number of Rings field. This is the number of times the 
phone must ring without being answered before the call is forwarded to the 
primary Find Me destination.

Step 3 For the backup Find Me destination, select Extension or External. You can use 
the Search button to find system extensions. Enter external numbers in the 
External text box.

Step 4 Once again, enter a value in the Number of Rings field. This is the number of 
times the phone must ring without being answered at the primary Find Me 
destination before being forwarded to the backup Find Me destination.

Step 5 Select the Send Incoming Caller ID check box if you want the caller ID 
forwarded to the Find Me destination.

Step 6 Select the Enable Auto Find Me check box to automate the process of routing 
calls to the Find Me destinations. With this enabled, users will no longer have 
to press 1 to activate Find Me. You can deselect the check box if you wish to 
continue to require callers to “press 1 to activate the Find Me feature.”
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If you enable Auto Find Me, make sure that your outgoing voice mail message 
is no longer telling callers to “press 1 to activate the Find Me feature.” The 
automation aspect of this enhancement means that callers will not have to do 
anything and calls will be forwarded automatically.

Step 7 Click Save.

12.3.1.2 Configuring Announced Find Me
Announced Find Me is available for users assigned to a class of service for which Find Me 
is authorized. ShoreTel provides three methods of enabling Announced Find Me for a user: 
from Director, from Communicator for Windows, and from Communicator for Web.

Users can receive Announced Call Me introductions for all callers or restrict the 
introductions to calls for which Caller ID is not available.

Administrators enable Announced Find Me for system users from the Find Me and 
External Assignment page.

To enable Announced Find Me for a user, perform the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users list 
page appears.

Step 3 Select the user whose profile you want to edit. The Edit User page appears.

Step 4 Access the user’s Find Me and External Assignment page, as shown in Figure 
12-7 on page 419, by selecting Personal Options in the selection bar at the top 
of the Edit User page, then clicking Find Me at the bottom of the Personal 
Options page.

Step 5 Select the Enable Record Caller’s Name for Find Me (When Caller ID is 
unavailable) checkbox.

Step 6 To enable Announced Find Me when Caller ID is available, select the Record 
Name Even If Caller ID Is Present checkbox.

12.3.2 Automated Call Handling
A Call Handling Mode defines call management conditions and tasks for your inbound 
calls. ShoreTel defines the following five call handling modes for each extension to 
customize the manner that a user’s calls are handled over a variety of situations:

• Standard.

• In a Meeting.

• Out of Office.

• Extended Absence.

• Custom.

One call handling mode is always active. ShoreTel automatically selects the active call 
handling mode on the basis of system schedules maintained by the system administrator. 
Users can also manually select their active call handling mode.
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The following sections describe call management tasks controlled by Call Handling Modes, 
along with the automatic and manual methods of selecting the active call handling mode.

12.3.2.1 Setting the Active Call Handling Mode
The active Call Handling Mode specifies the manner in which a user’s inbound calls are 
handled. ShoreTel automatically activates call handling modes, as specified by system 
schedules maintained by the administrator. Users can also manually select the active call 
handling mode.

A ShoreTel schedule is a software component that specifies a set of time periods. 
Communicator uses schedules to program call handling mode changes for system users.

Each schedule consists of a name and a list of day-time intervals. Communicator pages 
refer to the schedule by its name and specify an active call handling mode during the 
intervals.

ShoreTel defines three schedule types:

• On-hour schedules: On-hour schedules specify day and time intervals over a 
weekly period without referencing a specific date. Figure 12-8 displays three 
examples of On-hour schedules.

Figure 12-8 On-Hour Schedule Examples

• Holiday schedules: Holiday schedules specify dates. Periods that identify a year are 
valid once; periods that do not specify a year are valid each year on the listed dates. 
Holiday schedules take precedence over On-hour schedules during periods covered 
by each schedule. Figure 12-9 display examples of Holiday Schedules.

Figure 12-9 Holiday Schedule Examples

• Custom schedules: Custom schedules specify date and time intervals. Periods that 
identify a year are valid once; periods that do not identify a year are valid each year 
on the listed dates. Custom schedules take precedence over On-hour and Holiday 
schedules during periods listed by multiple schedules. Figure 12-10 display 
examples of Holiday Schedules.
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Figure 12-10 Custom Schedule Examples

Schedules are configured by the system administrator. To determine the periods specified 
by an individual schedule, consult your system administrator.

Default active call handling modes are managed through the Schedule parameter of the Call 
Handling Mode configuration pages:

• The Standard and Out of Office modes determine the active call handling mode 
during normal daily activities. 

— The available options in Standard’s schedule parameter are the On-hour 
schedules configured by the system administrator. Standard is the default Call 
Handling Mode during the times listed by the selected schedule.

— The Out of Office schedule is the inverse of the selected schedule in the 
Standard Call Handling Mode configuration page. Out of Office is the default 
Call Handling Mode during all periods not covered by the On-hour schedule in 
the Standard Call Handling Mode page. Schedules are not selected in the Out of 
Office Call Handling Mode page.

Example: Assume that Day Shift in Figure 12-8 is the selected schedule in the 
Standard Call Handling Mode page. Standard is the default call handling mode 
between 8 am to 5 pm on Mondays through Friday. Out of Office is the default 
call handling mode all other times.

• The Extended Absence mode determines the active call handling mode during the 
selected holiday schedule. The Schedule drop down menu on the Extended 
Absence call handling mode lists the Holiday schedules configured by the 
administrator.

• The Custom mode determines the active call handling mode during the selected 
custom schedule. The Schedule drop down menu on the Custom call handling 
mode lists the Custom schedules configured by the administrator.

• In a Meeting mode is not associated to a schedule and cannot become active 
through an automatic mode selection.

12.3.2.2 Call Handling Mode Defaults
Call Handling Mode Defaults are the set of call handling parameters assigned each time 
you add a new user. ShoreTel strongly recommends that you review and change these 
defaults before you add the bulk of your users.

Once a user is saved on the system, there is no relationship between the user’s call handling 
modes and the default call handling modes. Changes to the default call handling modes do 
not affect the call handling modes of current users. 

If you need to change the Personal Assistant of some or all users, you can use the Batch 
Update Utility.

There are five default call handling modes, used for initializing each user’s call handling 
modes. These modes provide a quick and easy way for users to change the way their 
inbound calls are handled. 

The five default call handling modes are:
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• Standard.
• In a Meeting.
• Out of Office.
• Extended Absence.
• Custom.

Each of the call handling modes has the same configuration parameters.

Figure 12-11 Call Handling Mode Default Values Edit Page

Call handling modes specify how, when, and where calls are forwarded, and whether the 
user requires message notification when voice mail is received. The links in the Edit Call 
Handling Modes section under the Personal Options tab on the Edit User page bring up 
variants of the call handling mode pages. You can edit these copies for each user’s personal 
options. Users can also modify these options from their desktop client applications.

Users can also change their call handling settings though a web interface on the ShoreTel 
server. For more information and the web interface URL, see the ShoreTel 12: Planning and 
Installation Guide.

The Call Handling Mode Default parameters are as follows:

• Call Forward Condition: These buttons let you specify when calls are forwarded. 
The conditions are Always, No Answer/Busy, and Never.

— The Always condition forwards calls to the number specified in the Always 
Destination parameter immediately when a call is received.

— The No Answer/Busy condition forwards calls to the No Answer Destination 
after the specified number of rings, or to the Busy Destination immediately if 
the user’s call stack is full.

— The Never condition disables call forwarding.

The recommended default is No Answer/Busy.

• Always Destination: When the Always call forward condition is selected, calls are 
forwarded immediately to this extension.

• Busy Destination: When the No Answer/Busy call forward condition is selected, 
calls are forwarded to this extension immediately if the user’s call stack is full.
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The recommended default is Voice Mail.

• No Answer Destination: When the No Answer/Busy call forward condition is 
selected, calls are forwarded to this extension after the specified number of rings.

The recommended default is Voice Mail.

• No Answer Number of Rings: When the No Answer/Busy call forward condition is 
selected, this parameter specifies how many times the phone rings before the call is 
forwarded to the No Answer Destination.

The recommended default is three rings.

• Personal Assistant: Each user can specify a Personal Assistant, which is the 
destination to which a calling party is transferred upon dialing “0” in the user’s 
mailbox. For example, executives often want callers transferred to their own 
executive assistant rather than to the operator when a caller dials “0” in their 
mailbox.

If no personal assistant is defined and a caller dials “0,” the call is transferred to the 
site operator. If no site operator is defined, the call is transferred to the auto-
attendant.

Users can also reach the Personal Assistant from the voice mail menu. By pressing 0 
from the main voice mail menu, users can access the assistant. Alternatively, users 
can press 00 while listening to a voice mail message to reach the assistant. This can 
be helpful if a user is checking voice mails and wants to quickly reach the assistant 
to communicate something heard in a voice message. 

The recommended default is an operator.

• Enable Find Me: This check box enables the Find Me feature by default for new 
users. When enabled, users can configure up to two numbers where they would 
like to receive calls that are forwarded from their voice mail. For more information, 
see the "Find Me and External Assignment Page" on page 419.

• Enable Message Notification: This check box enables message notification for this 
call handling mode. The manner in which the user is notified is determined by the 
user’s message notification settings.

The recommended default is off.

• Schedule: This drop-down menu lets you select the schedule that will be associated 
with this call handling mode. For example, you may want to associate the Standard 
CHM with a schedule that is active from the hours of 9am to 5pm. Alternatively, 
you might wish to schedule the Out of Office CHM with a “graveyard” schedule 
that becomes active from the hours of 10pm to 6am.

For more information, see the Chapter 15: Configuring Schedules starting on page 
475.

• Call Handling Note: This text entry option lets you type a note that is visible only 
to users whose access license is Operator. We recommend leaving the field empty.

12.3.3 Personalized Call Handling
Personalized Call Handling defines a method of handling inbound calls on the basis of 
multiple end user, caller, system, and environment criteria.

Personalized Call Handling is available to all System Users that are authorized for the 
following Communicator types:
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• Professional.

• Operator.

• Workgroup Agent.

• Workgroup Supervisor.

Administrator authorization is not required for users assigned to these Communicator 
types.

12.3.3.1 Description
A Call Routing Plan manages a user's inbound voice calls. The plan consists of call 
handling rules, each of which specifies a method of handling a call when a condition set is 
valid. The plan enables and prioritizes selected rules. The user's inbound calls are evaluated 
against the call handling rules. The highest priority rule with conditions that are satisfied 
define the handling method for the call. 

This section describes the structure and call handling rules, followed by a discussion of 
creating a call routing plan from these rules.

Call Handling Rules

Call handling rules define evaluation conditions and handling action. When the rule is 
active and the condition is satisfied, the action determines how the call is handled.

Three components comprise a call handling rule: name, condition, and action. The 
following sections describe call handling rule components.

• Name: The name is the label by which Communicator and Director refers to a call 
handling rule. Users specify the name when they create the rule.

• Condition: The condition is the filtering criteria that determines if a corresponding 
call handling action is performed. When a condition statement consists of multiple 
criteria, each criterion must be satisfied or the action is not performed.

Call Handling Rules defines the following six types of criteria:

— Phone number match: The phone number match is satisfied when the caller ID 
of the inbound call is a subset of the specified match type. Users can select one 
of the following match types:

❋ Specific number – user specifies the number that must match the caller ID; 
numbers can be internal extension or phone number external to the 
system.

❋ Off system extension – user specifies the off system extension that must 
match the caller ID.

❋ Any internal extension starting with – user specifies the digits that must 
match the first digits of numbers originating from internal callers.

❋ Any external extension starting with – user specifies the digits that must 
match the first digits of numbers originating from phone numbers external 
to the system.

❋ Private – matches all calls that are identified by caller ID as private.

❋ Out of area / unknown – matches all calls that caller ID identifies as out of 
area or unknown.

❋ Every internal number – matches all calls originating from a device within 
the ShoreTel network.
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❋ Every external number – matches all calls originating from a device not 
located within the ShoreTel network.

Users can specify a maximum of ten phone number match entries.

— I am on the phone: This criterion is satisfied when the user’s phone is busy.

— Call Handling Mode: This criterion is satisfied when the user’s active Call 
Handling Mode matches the specified mode.

— Time of day: This criterion is satisfied when the call is received during the 
specified time ranges.

— Day of week: This criterion is satisfied when the call is received on one of the 
specified days.

— DNIS Match: This criterion is satisfied when the DNIS of the inbound call 
matches the specified number.

Time of day and Day of week entries are based on the timezone setting of the 
site to which the user is assigned.

• Action: The action specifies the resolution for calls that match the specified 
condition. Call Handling Rules define the following five action types:

— Forward Call to Specific Number: This action routes the call to the specified 
number. Users can select one of the following number types:

❋ Specific Number.

❋ Off System Extension.

— Forward Call to Voice Mail: This action routes the call to the recipient’s voice 
mail.

— Forward Call to Auto Find Me: This action routes the call to voicemail, which 
then forwards the call to the recipient’s Find Me number.

— Forward Call to Announced Find Me: This action routes the call to voicemail, 
which then forwards the call to the recipient’s Find Me number. The system 
attempts to announce the caller’s name to the recipient, which may require the 
caller to record their name before the call is presented to the recipient.

— Play Ringtone: This action programs the ShoreTel IP Phone to play the 
designated ring tone that announces the presence of the inbound call to the 
recipient.

Call Routing Plan

The Call Routing Plan is the data structure that determines the routing method of a user’s 
inbound calls. The following sections describe the composition and operation of a call 
routing plan.

A call routing plan consists of a maximum of ten call handling rules. The plan specifies the 
rules that are active and lists the rules in the order that by which they are used to evaluate 
characteristics of the inbound call.

When a user receives an inbound call, the system evaluates the characteristics against the 
highest priority call handling rule that is enabled. If all of the criteria comprising the 
condition of that rule matches the call characteristics, the call is routed as specified by the 
rule’s action and the plan execution is complete. If any of the criteria do not match the call 
characteristics, the system continues the plan execution by evaluating the call against the 
next highest priority call that is enabled.
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This process is repeated for all enabled call handling rules. If the call characteristics do not 
match the conditions of any enabled call handling rule, the call is routed as specified by the 
active Call Handling Mode.

12.3.3.2 Implementing Personalized Call Handling
Users configure their Personalized Call Handling routing plans through Communicator. 
Refer to the Communicator User’s Manual.

The Director Personalized Call Handling Rules page, shown in Figure 12-12, displays the 
Call Handling Rules created by the specified user. The table displays the name, condition, 
and action and enabled status of each rule. The rules are listed in the order that they were 
created; the table does not display the usage priority of the rules.

Figure 12-12 Personalized Call Handling Rules Page (Director)

To access the Personalized Call Handling page:

Step 1 Open the Individual User list by selecting Administration -> Users -> 
Individual Users from the Director Main Menu

Step 2 Open the Personal Options page for the desired user by clicking the name of 
the desired user in the Individual User List, then selecting Personal Options on 
the menu bar toward the top of the Edit User page.

Step 3 Click Personalized Call Handling Rules, located in the middle of the Personal 
Options page, as shown in Figure 12-13.
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Figure 12-13 Edit User Page – Selecting Personalized Call Handling Rules

12.4 Call Intervention Methods

12.4.1 Whisper Page
The Whisper Page feature allows a user to break into an active call in order to speak with 
an internal user. This occurs without the remote caller hearing the interruption and 
without the operator hearing the remote caller. 

A real-world example illustrates the function: You are on a call with a client when another 
client arrives in the lobby for an appointment with you. The administrative assistant knows 
that you are on a call and uses the Whisper Page feature to interrupt the call to announce 
that someone is waiting for you in the lobby. You hear the voice of the administrative 
assistant and the client at the same time, but neither of them can hear the other. 

Implementation details:

• The Whisper Page feature can be invoked from:

— Communicator

— Any phone (analog or IP) by pressing the code *19

— One of the ShoreTel IP Phone soft keys

• While on a Whisper Page call, the internal user can mute the audio channel to the 
original caller. The user can respond to the operator without the original caller 
hearing. This can be accomplished from:

— One of the ShoreTel IP Phone soft keys rather than the standard mute button

— Communicator, if you do not have an IP phone
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• Both the operator and the internal user hear a tone when the Whisper Page call is 
connected. (The tone is the same as the tone for the Intercom feature.)

• To receive a Whisper Page call, the internal user must be on the handset of a 
multiline ShoreTel IP Phone. If a Whisper Page call is sent to any other phone 
(SoftPhone) the call will be treated as an intercom call.

• If a Whisper Page call is sent to a phone that is not on an active call, the feature 
behaves the same as an intercom call.

• The Whisper Page feature does not work if the internal party is on a three-way 
conference call.

• No call control operations can be performed on a Whisper Page call except to hang 
up the call. For example, the Whisper Page call cannot be put on hold, transferred, 
parked, and so on.

Configuring Whisper Page 

To configure the Whisper Page feature:

Step 1 Launch ShoreTel Director and enter the user ID and password.

Step 2 Click Administration > Users > Class of Service. The Class of Service page 
appears.

Step 3 Select a Telephony Features Permissions profile. The Edit Telephony Features 
page appears, as shown in Figure 12-14.

Figure 12-14 Edit Telephony Features Page
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There is no separate check box specifically for the Whisper Page feature. The 
functionality has been coupled with the intercom functionality. 

Step 4 In the Whisper Paging field, check the Allow Initiation check box to allow this 
user to place a Whisper Page call. (This user would most likely be an operator 
or administrator.) The Accept check box enable lets a user be on the receiving 
end of a Whisper call.

Step 5 Click Save to save changes.

After the Whisper Page feature in a Class of Service profile is enabled, be sure 
that this Class of Service profile is applied to the appropriate user group to 
which the target user belongs. Put another way, the user intended to use the 
Whisper Page feature must belong to a user group that has the COS - 
Telephony value set to the name of the COS profile.

12.4.2 Monitoring Extensions from an IP Phone
Extension monitoring is one of the available functions you can assign to the custom 
buttons on a ShoreTel IP Phone. However, due to its complexity, this feature is described 
separately from the other functions.

The extension monitoring function lets a user monitor the extension of another user and 
answer the other person's calls if necessary. For example, two secretaries are working on 
different floors of the same building and are responsible for answering calls from the main 
phone line. If one secretary already is on a call when another call arrives on the main line 
(with extension monitoring enabled), the other secreatry can see that the first assistant is 
busy and, therefore, knows to answer the incoming call.

To configure extension monitoring:

Step 1 Navigate to Administration > Users > Individual Users in ShoreTel Director.

Step 2 Click on a name to modify that user’s phone. The user’s general settings appear.

Step 3 Click the Personal Options tab.

Step 4 Click the link for Program IP Phone Buttons. The Program IP Phone Buttons 
editor opens, as Figure 12-15 illustrates.
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Figure 12-15 Monitor Extension from IP Phone

Step 5 For the intended button (except number 1, which is reserved), click on the 
Function drop-down menu for one of the programmable buttons and select 
Monitor Extension to display the custom key editor.

Step 6 Enter a label for the button in the Label field.

Step 7 Enter the extension of the monitored party in the Extension field, or click the 
Search button to locate the desired extension.

Step 8 Click on the Ring Delay Before Alert drop-down menu and select the number 
of rings that should elapse on the monitored party's phone before the 
monitoring party will receive an alert. (This delay gives the monitored party a 
chance to answer and prevents the monitoring party's phone from ringing 
incessantly.)

Step 9 Select the appropriate radio button in the Caller ID on Monitored Extensions. 
For an multiline phone, choices are:

• Do Not Show – The Caller ID information does not appear, but an 
indicator will show that the monitored phone is busy. This option offers the 
monitored party the most privacy and should be selected if you do not 
want the monitoring party to know who the monitored party is talking to.

• Show Only When Ringing – The Caller ID information appears while the 
phone is ringing, but disappears once the call has been answered.
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• Show Always – The Caller ID information appears while the monitored 
phone is ringing, and continues to appear even after the call has been 
answered.

Step 10The custom buttons can be configured to perform different actions based on 
whether or not the person being monitored is on a call. To associate a 
secondary function with the custom button that will apply when the phone is 
inactive, click the drop-down menu and select another action from the No 
Connected Call Action menu. The action you select here will apply when the 
custom button is pressed AND while the monitoring party’s phone is inactive.

Step 11To associate a third function with the custom button, click the drop-down 
menu and select another action from the With Connected Call Action menu. 
This action will apply when the custom button is pressed while the monitoring 
party does not have a call that can be picked up or unparked, and the user's 
own extension has a connected call. 

The idea behind these last two steps is that the custom button can be 
configured to do whatever makes sense given the situation. The button can be 
configured to pick up incoming calls, or park/unpark calls when the person 
being monitored is on a call. And if the person being monitored is not on a call, 
the custom button then becomes a one-touch button allowing the operator to 
transfer a call to the monitored extension. And if the person being monitored is 
not on a call and if there are no calls to transfer, then the custom button 
becomes a speed-dial button, allowing the operator to dial that person's 
extension at the touch of a button. 

Step 12Click Save to store your changes.

Details:

• The custom button will illuminate red (on the monitoring-person's phone) when 
the person being monitored is on a call. If that call is put on hold and a second call 
is accepted on the monitored extension, the LED will turn green and will flash 
twice. Similarly, the LED will flash three times if a third call is accepted. For more 
information about LED flash patterns, see Table 12-1.

• The custom button (to which extension monitoring has been assigned) can serve 
dual purposes based on whether the monitoring party is in a call or not. The button 
can be set to speed dial, intercom, or transfer calls to the monitored extension.

• When the “Show Caller ID Name and Number on Monitored Extensions” Class of 
Service (Telephony) setting is not enabled, Communicator Contact Viewer (and 
Agent Viewer) show the number of calls on a user's stack but do not show who the 
user is talking to. “Properties” is also disabled.

Table 12-1 Programmable Buttons LED Flash Patterns

State Pattern

CALL APPEARANCE STATES

Idle Off

Idle and DND Orange, Steady On

Idle and Message Waiting Off

Idle, Message Waiting and DND Orange, Steady On
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Off Hook Green, Steady On

Active Call Green, Steady On

Active Conference Call Green, Steady On

Remote Hold Green, Steady On

Offering Call Green, 1000/1000 ms

Held or Parked Call (3) Orange, 250/250 ms

Whisper Page Call Red, Steady On

Active Call Whisper Muted Red, Steady On

EXTENSION MONITOR STATES

Idle Off

Idle and DND Orange, Steady On

Idle and Message Waiting Off

Idle, Message Waiting and DND Orange, Steady On

Offering Call Green, 1000/1000 ms

Active Call Picked Up Green, Steady On

Held or Parked Call [3] Orange, 250/250 ms

Monitored Ext. on Active Call Red, Steady On

Monitored Ext. on Conference Call Red, Steady On

Monitored Ext on Active Call + Offering Call Green, 200/100/700/1000 
ms

Picked up Monitored Ext. Call + Monitor Ext on Active 
Call

Green, 800/Orange 200 ms

Picked up Monitored Ext. Call and Held + Monitor Ext on 
Active Call

Orange, 200/100/200/500 
ms

Picked up Monitored Ext. Call + Monitor Ext held Active 
Call

Orange, 200 ms
Green, 800 ms
Orange, 200 ms
Green, 100 ms

BRIDGED CALL APPEARANCE STATES

Idle Off

Offering Call Green, 1000/1000 ms

Active Call Picked Up Green, Steady On

Line In-Use Red, Steady On

Held or Parked Call [3] Orange, 250/250 ms

FEATURE KEY WITH EXTENSION TARGET STATES

Idle or Offering Call Off

Table 12-1 Programmable Buttons LED Flash Patterns (Continued)

State Pattern
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12.4.3 Call Handling Mode Delegation
The Call Handling Mode Delegation window lets the system administrator specify a list of 
users who can change the Call Handling Mode of another user. A delegated (authorized) 
user with an Operator Access License can modify another user’s Call Handling Mode 
through ShoreTel Communicator or Communicator for Web Client. These authorized 
(delegated) users are specified through ShoreTel Director by the system administrator or 
through Communicator by the user whose active Call Handling Mode is changed.

12.4.3.1 Delegating through ShoreTel Director 

To select the users who are authorized to change another user’s active call handling mode:

Step 1 Navigate to Administration > Users > Individual Users.

Step 2 Select the user for whom you are authorizing other users to change the active 
call handling mode of the selected user. 

Step 3 Click the Personal Options tab. 

Step 4 In the Call Handling Mode Options section, click Delegation. The link is next 
to the Current Call Handling Mode field. The Call Handling Mode Delegation 
window opens (Figure 12-6).

Connected or Held Call Red, Steady On

DND Orange, Steady On

(Dial/Transfer Mailbox Only) MWI Red, Steady On

(Pickup, Pick/Unpark, Pickup NightBell Only) Offering Green, 1000/1000 ms

(Unpark, Pick/Unpark Only) Held/Parked Orange, 250/250 ms

TOGGLE FUNCTIONS (RECORD, WHISPER MUTE)

Function Off Off

Function Available Orange, Steady On

Record Active Orange, 500/500 ms

Whisper Mute Active Orange, 500/500 ms

Table 12-1 Programmable Buttons LED Flash Patterns (Continued)

State Pattern
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Figure 12-16 Delegating Call Handling Mode to Other Users

Step 5 In the left column, select one or more users to authorize.

Step 6 Click Add (or Remove if you are removing names from the list of delegates).

Step 7 Click Save at the top of the window when delegation is complete.

12.4.3.2 Selecting Delegates through ShoreTel Communicator
Users can manage the list of individuals who can change their active Call Handling Mode 
through Communicator. The ShoreTel Communicator for Widows Guide contains more 
information.

12.4.4 Intercom, Whisper Paging, Barge In, Record, and Monitor

12.4.4.1 Feature Descriptions
Monitoring allows one party to eavesdrop on a call. It is a limited conference call where the 
monitoring party hears the other parties, but the monitored parties do not hear the 
monitoring party. Monitoring is undetectable by the parties being monitored, except by a 
warning tone. Monitoring is typically used in workgroups to evaluate agent performance.

A recording warning tone may be played to the customer during call recording and 
monitoring. The warning tone is enabled for the entire system using a Call Control option. 
For a specific call, it may be disabled by using an Auto-Attendant menu option. No tone is 
played during a Barge In call.
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Barge In allows one party to join an existing call as a fully conferenced participant. When 
Barge In is initiated, a brief intrusion tone is played to the other participants and (if 
present) the monitoring warning tone is discontinued.

To simplify discussion of this feature, we will refer to three parties: the supervisor, the 
agent, and the customer. The supervisor initiates monitoring by selecting an agent. The 
agent is on a call with another party, the customer. The customer may be an external caller, 
but supervisors and agents must be on extensions.

In a monitored call, a supervisor hook flash is ignored. However, a hook flash by the other 
parties works the same as in a two-party call. In particular, an agent flash puts the call on 
hold and allows a consultative transfer or conference.

Because there is a limit of three parties in a conference call, if the agent or customer makes 
a consultative transfer or conference, the supervisor is automatically dropped. Similarly, if 
another party barges into a monitored extension, then the monitoring is dropped.

If a conference call is already in progress, it cannot be monitored. If monitoring is already 
in progress, no one else can monitor the call.

The supervisor can barge into a call he or she is monitoring. However it is not possible to 
revert a barge in to just a monitored call. If desired, the supervisor can hang up and restart 
monitoring.

After a barge in, the agent remains the controlling party of the call. A subsequent agent 
hook flash disconnects the supervisor, who was the last party added.

12.4.4.2 COS Settings
Each telephony COS permission has check boxes and radio buttons in ShoreTel Director 
for configuring Intercom, Whisper Paging, Barge In, Call Recording, and Call Monitoring. 
These options appear near the bottom of the window in Figure 12-17. For more 
information about setting permissions, refer to "Telephony Features Permissions" on page 
315.
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Figure 12-17 The COS Edit Telephony Features Permissions Window

• Allow initiation for Intercom/Paging—If this check box is selected, users with this 
COS can place an intercom call or page to other system users. If this box is empty, 
the user with this COS cannot initiate an intercom call or page.

• Accept Intercom/Paging—Radio button choices are:

— Accept: None If the choice for Accept is None, users with this COS cannot 
receive intercom calls or pages.

— Accept: All If the choice for Accept is All, users within this COS can receive 
intercom calls or pages from anyone in the COS.

— Accept: Only From: If the choice for Accept is Only From, users with this COS 
may receive intercom calls or pages from only the person or extension specified 
in the associated field.

• Allow initiation for barge in—If this check box is selected, users within this COS 
may barge in on the calls of other system users. If cleared, then no barge in can be 
initiated.

• Accept barge in—Radio button choices are:

— Accept None: If selected, users within this COS may not receive barge-in’s from 
anyone.
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— Accept All: If selected, users within this COS may receive barge-in’s from 
anyone else in this COS.

— Accept Only From: If selected, users within this COS may only receive barge-
in’s from the person or extension specified in the field associated with this radio 
button.

• Allow initiation for record others calls—If this check box is selected, users within 
this COS may record the calls of other system users. If cleared, then no call 
recording can be initiated.

• Accept record others calls—Radio button choices are:

— Accept None: If selected, users within this COS may not have their calls 
recorded from anyone.

— Accept All: If selected, users within this COS may have their calls recorded 
from anyone else in this COS.

— Accept Only From: If selected, users within this COS may only have their calls 
recorded by the person or extension specified in the field associated with this 
radio button.

• Allow initiation for silent monitor—If this check box is selected, users within this 
COS may monitor other system users. If cleared, then no monitoring can be 
initiated.

• Accept silent monitor—Radio button choices are:

— Accept None: If selected, users within this COS cannot be monitored by 
anyone.

— Accept All: If selected, users within this COS can be monitored by anyone else 
in this COS.

— Accept Only From: If selected, users within this COS can only be monitored by 
the person or extension specified in the field associated with this radio button.

No special permissions exist for ShoreTel Enterprise Contact Center agents or supervisors. 
However, to use center recording, monitoring, and barge in, an agent or supervisor must 
have a CoS with the settings that allow these features.
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C H A P T E R 1 3

Configuring Voice Mail

This chapter provides information about configuring the voice mail system. The topics are:

• "System Distribution Lists" on page 441

• "AMIS Voice Mail" on page 443

• "Delivery and Notification" on page 448

• "Voice Mail Reports" on page 456

• "Voice Mail Synchronization with Gmail for Business" on page 459

Also refer to the "Voice Mail Permissions" on page 323 for information about configuring 
your voice mail system. 

13.1 System Distribution Lists
System distribution lists provide a mechanism for sending the same message to multiple 
users at one time. They are managed from the ShoreTel Director. You add and edit system 
distribution lists from the Voice Mail System Distribution Lists. To access the Voice Mail 
System Distribution Lists page, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Voice Mail > System Distribution Lists. The System 
Distribution Lists page appears as shown in Figure 13-1.

Figure 13-1 Voice Mail System Distribution Lists Page

NOTE You can also add or remove a user from a system distribution list from 
the Edit User page (see the "Individual Users" on page 329).
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The columns in the System Distribution List page are as follows:

• Description: This is the name of the system distribution list.

• Number: This is the number that is used for sending messages to members in the 
distribution list. Users can enter this number in either the ShoreTel client or when 
addressing a message from the telephone user interface.

The ShoreTel system lets a user with the proper class of service send a broadcast message to 
all mailboxes. Unlike system distribution lists, the broadcast distribution list cannot be 
edited. If necessary, the administrator can remove individual mailboxes from the broadcast 
list on the associated Edit Users page, Workgroup edit page, or Route Point edit page.

To add or edit a system distribution list, click “Add new” or click the name of an existing 
list that appears in the Voice Mail System Distribution Lists table. When you click either of 
these items, the Edit System Distribution List page appears as shown in Figure 13-2.

Figure 13-2 System Distribution List Edit Page

The parameters on the System Distribution List edit page are described as follows:

• Name: This is the name of the distribution list.

• Number: This is the number that is used for sending messages to members in the 
distribution list. Users can enter this number in either the ShoreTel client or when 
addressing a message from the telephone user interface.

This number cannot go beyond the range of numbers that you defined in the First 
System Distribution List Number and Last System Distribution List Number fields 
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in the section from Chapter 2: Setting Up System Parameters starting on page 35. 
Also, the first system distribution list number is reserved for future use.

• Recorded Name: The buttons that correspond to this item let you Record, Play, 
Erase, or Import a recorded name for the distribution list.

— Click Record to record a name for the distribution list.
— Click Play to play back the recording.
— Click Erase to erase the recording.
— Click Import to import a sound file.

• Language: Select a language from the drop-down list. 

• Select from List: Filter Users By—If you want to search for users with certain 
extension numbers or names beginning with a specific letter, use the Filter Users 
By fields. You can sort by Last Name, First Name, or Extension. 

If more names fit the criteria than can be displayed, use the Show Page controls. 
Either select a page number from the drop-down list or use the arrow keys to scroll 
through the list.

After selecting a name (or names) from the user list, click Add to add it (or them) 
to the Distribution List Members box.

If you want to remove a user from the directory list, select the user name from this 
box and click Remove.

• AMIS Systems: This lets you add users on AMIS systems to the distribution list. To 
add an AMIS user to the distribution list, select the AMIS system where the user 
you want to add is located and click Add. A dialog box prompts you for the 
extension number of the user. Enter the number and click OK. The AMIS System 
ID and extension (Mailbox ID) appears in the distribution list box.

13.2 AMIS Voice Mail
The ShoreTel system sends and receives voice mail messages to and from legacy voice mail 
systems by using Audio Messaging Interchange Specification (AMIS) protocol Version 1 — 
Spec February 1992. To send voice mail messages to remote AMIS sites, ShoreTel dials a 
phone number to access the remote system. Likewise, to receive voice messages from a 
remote system, the remote system must have the number to dial into the ShoreTel system. 
To reach the ShoreTel system, the remote system must be configured to dial a number that 
reaches an auto-attendant menu.

AMIS call support is enabled by default. Incoming AMIS voice mail is delivered in the same 
manner as other voice mail; however, replies cannot be sent. To send outbound AMIS voice 
mail, you must create AMIS systems in ShoreTel Director.

ShoreTel negotiates the setup, handshaking, and teardown of AMIS system calls. Each voice 
mail requires a call over the AMIS delivery and call-back numbers. 

You can configure AMIS systems for two addressing methods. If the system does not use 
off-system extensions, a System ID number is required to direct the voice mail to the 
correct site. When a user wants to send a voice mail to a recipient on an AMIS system, he or 
she first must enter the System ID and then the mailbox number (extension).
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If the system uses off-system extensions, these extensions become “off-system mailboxes.” 
In this case, users simply address the voice mail by mailbox number and without entering 
the System ID.

Before you create AMIS systems to remote sites:

• Enable AMIS messaging from the Voice Mail Options page (default is enabled).

• Set permissions for the Voice Mail User Group to include dialing AMIS numbers. 
For more information, see the "Voice Mail Permissions" on page 323.

• Review the extension plans for all the systems to which you are making a 
connection. Make sure they use the same extension length and that extension 
numbers do not overlap.

After these global settings are done, creating AMIS systems require the following steps:

• Name the AMIS site and enter a System ID.

• Enter the phone number the ShoreTel system calls to connect to each remote AMIS 
system.

• Enter the phone number that remote AMIS systems call to send AMIS messages. 
This number must reach an auto-attendant.

• If a system is using off-system extensions, select the extension range for each AMIS 
system.

13.2.1 AMIS Restrictions
Some restrictions are placed on AMIS voice messages, as follows:

• ShoreTel establishes a call to an AMIS system for each voice mail. If a voice mail is 
addressed to multiple recipients, ShoreTel delivers as many as nine voice mails in a 
single call. If a voice mail has more than nine recipients, ShoreTel makes additional 
calls until the voice mail is delivered to all recipients. You can optimize AMIS voice 
mail delivery by using distribution lists at the remote AMIS sites.

• The maximum message length permitted is eight minutes.

• After ten failed attempts to complete a call to an AMIS system, ShoreTel disables 
the AMIS system and generates an event log.

• After ShoreTel establishes an AMIS system call, it tries three times to complete 
message delivery to each recipient. If ShoreTel fails to deliver a voice message after 
three attempts, it stops trying and returns the message to the sender. However, if 
the sender’s voice mailbox is full, they do not receive failed messages.

• Outbound voice mail messages for disabled AMIS systems are accepted and 
queued. To deliver queued messages, enable the AMIS system in question from 
AMIS edit page (see Figure 13-3).

Table 13-1 Examples of Address with a System ID

System ID Recipient Mailbox Number
8331 1234
8408331 45657
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13.2.2 Enabling AMIS 
To enable AMIS systems:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Voice Mail > Options. The Voice Mail Options page 
shown in Figure 13-3 appears.

Figure 13-3 Voice Mail Options Edit Page

Step 3 Set the following set global AMIS parameters:

• Minimum Message Length Accepted: Specify minimum length a message 
must be to be acceptable. In milliseconds. The system default is 2000 
milliseconds.

• From Address for Email Notifications: Specify the e-mail address to be 
placed in e-mail notifications about new messages.

• Enable AMIS: To enable AMIS systems support, click the check box 
(enabled by default). The Enable AMIS check box enables/disables all 
AMIS systems. Individual AMIS systems can be enabled and disabled from 
the AMIS edit page. For more information, see the "Creating AMIS 
Systems" on page 446.

• Allow Incoming AMIS access to Broadcast DL: To allow delivery of 
incoming AMIS messages to the Broadcast Distribution List, click the check 
box. 

• Allow Incoming AMIS access to System DL: To allow delivery of incoming 
AMIS messages access to the System Distribution Lists, click the check box.

The Voice Mail application will automatically remove silence from voice 
messages. If the resultant message after silence removal is less than this 
minimum message length, the message is assumed to be a hang-up and will 
be deleted from the system.

Step 4 Click Save.
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13.2.3 Creating AMIS Systems
After you enable AMIS systems from the Voice Mail Options page, the next step is to create 
and configure the individual AMIS systems. Enter the AMIS delivery and call back number 
for each AMIS system you want to configure.

Expand the Voice Mail link in the navigation frame and click AMIS. The AMIS Systems list 
page appears as shown in Figure 13-4.

Figure 13-4 AMIS Systems List Page

To add a new AMIS system, click Add New. To edit an existing system, click an entry in the 
AMIS System column. The AMIS edit page appears, as shown in Figure 13-5

Figure 13-5 AMIS Edit Page

The following section describes the AMIS edit page parameters.

• Name: In the Name text box, enter the name of this AMIS site.

• System Enabled: Click this check box to enable this AMIS system. 

Outbound voice mail for this system is queued until the system is reset by clicking 
the System Enabled check box.
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• System ID: The System ID defines the AMIS site where the voice mail for this 
system is delivered. The System ID plus a mailbox number identifies the site and 
the voice mail recipient. Plan the System ID to simplify the process of sending 
AMIS voice mail for your users. The System ID consists of an access code plus a site 
identifier. 

The System ID must begin with a digit reserved for trunk access codes, although it 
can be different from other trunk access codes. To make the System ID intuitive to 
voice mail users, choose a site identifier related to the public numbers used at the 
site.

For example, if the voice mail delivery number is +1 (408) 555-1234, then System 
IDs like 8555 or 9408555 will be intuitive to your users. Generally, the shorter the 
System ID number, the easier it is to use.

The System ID plus the mailbox length cannot exceed 15 digits.

System IDs are required and can be single digits. Each AMIS system you create 
must have a unique System ID.

• Delivery Number: This is the number ShoreTel calls to send AMIS voice messages 
to the remote system. An external number is a public PSTN number and a private 
number is an internal, off-system extension connecting to an intra-site PBX system.

• Call Back Number: This is the number on which you receive AMIS messages. An 
external number is a public PSTN number and a private number is an internal, off-
system extension connecting to an intra-site PBX system.

• Mailbox Length: Set the mailbox length of the remote sites mailboxes (extensions). 
If you are using off-system extensions, the length must match the length of your 
extensions.

The System ID plus the mailbox length cannot exceed 12 digits.

• Off-System Extensions: If your system is using off-system extensions, select the 
extension range for each AMIS system. These extensions function as off-system 
mailboxes, allowing users to address voice mail to users on remote AMIS sites 
without entering a System ID. For more information, see the "Add or Edit a Trunk 
Group" on page 156.

13.2.4 Disabling AMIS Systems
You can disable AMIS systems globally or by individual connection. Individual AMIS 
systems are automatically disabled when ShoreTel fails to complete a call to an AMIS 
system.

To globally disable AMIS systems, deselect the Enable AMIS check box in the Voice Mail 
Options page (see Figure 13-3 on page 445). To disable an individual AMIS system, from 
the AMIS System list page, double-click the name of the AMIS system you want to disable. 
The AMIS edit page appears. Clear the System Enabled check box and click Save.

When you disable AMIS, ShoreTel will not send or receive AMIS voice messages.

Users can address outgoing voice messages while the system is disabled. Outbound 
messages are queued until the individual AMIS system is re-enabled. Attempts to deliver to 
a disabled AMIS system fail.
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13.2.5 Setting Voice Mail User Group Permissions
You must set the permissions for the Voice Mail User Group to allow ShoreTel calls to the 
AMIS system delivery numbers you have configured. For instructions on setting these 
permissions, see the "User Groups" on page 325.

13.2.6 AMIS Test Mailbox
ShoreTel allows you to designate a mailbox that a remote AMIS system can use to test AMIS 
features. When you address a voice mail to the AMIS test mailbox, ShoreTel automatically 
replies with the same message.

Voice Mail reports are used by administrators to monitor, administer, and manage system 
resources and user activity. 

13.3 Delivery and Notification
The user’s voice mail notification options are edited from the Escalation Profiles and Other 
Mailbox Options page. Voice mail escalation parameters specify what should happen if 
notification is enabled at the time a message arrives. These options include the user’s 
message notification telephone number, pager ID number, and try options.

Voice mail may be auto-forwarded. That is, a mailbox may be configured to send any 
message it receives to another mailbox. The message sent to the original mailbox can be 
automatically deleted, as an option. The target mailbox for forwarded messages may be any 
user, a workgroup, a route point, AMIS address, or a system distribution list (other than a 
broadcast distribution list). A message is pre-pended to the forwarded message, along with 
a time-stamp, announcing that the message has been auto-forwarded. As an example, the 
recipient of an auto-forwarded message might hear, “Auto-forwarded message received at 
9:10 AM from Customer Support Mailbox”. 

An example of use might be the handling of off-hours calls when few support staff are 
available. Off-hours calls may be routed to a back-up extension. If no one is available to 
answer the back-up extension, calls may wind up in a voice mailbox that will not be 
checked for hours. The back-up extension can be set to auto-forward any calls that are 
received in its mailbox. Calls can be forwarded to a mailbox that is checked on a regular 
basis. 

Auto-forwarding is available between distributed voice mail servers. The message is 
handled as any other message would be, including any message waiting indicator, any 
calling notification, return receipt requests, or urgent markings. Auto-forwarded messages 
can be forwarded and replied to. If the target mailbox is full, the is left in the sending 
mailbox. If a message is being auto-forwarded to a list of mailboxes and one is full, that 
target is skipped.

13.3.1 Escalation Profiles and Other Mailbox Options
The Escalation Profiles and Other Mailbox Options page can be accessed from a link on the 
User’s Personal Options page. From here, you can configure Escalation Profiles to notify 
employees when a voice mail is received (which can be helpful in providing your 
customers with superior service/support after hours), and you can configure Automatic 
Message Forwarding, and Email Delivery Options for a user, so that users can be notified 
when their voice mailboxes are almost full.

The Escalation Profiles and Other Mailbox Options page is shown in Figure 13-6.
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Figure 13-6 Escalation Profiles and Other Mailbox Options Page

13.3.1.1 Parameters
The Escalation Profiles and Other Mailbox Options parameters are as follows:

Email Delivery Options

• Email Address: This is the user’s e-mail address. By default, it is automatically 
entered when you enter the user’s first and last names in the First Name and Last 
Name fields. It consists of the first initial of the user’s first name followed by the 
user’s entire last name. In addition, the @companyname.com domain is saved in a 
cookie on the workstation each time you save a user. The system presents this 
information as a default, which can be changed as needed.

Be sure to delete this field if the user does not have or use email.

• Deliver Message as Email: Select one of three e-mail delivery options:

Disabled, Email Text Only, or Attach WAV File. The Email Text Only option notifies 
the user of the time, duration, and Caller ID of the message that was recorded. The 
Attach WAV File option attaches the voice message to the email as a WAV file.

Selecting the Mark Message as Heard results escalation profiles being disabled for 
messages that are delivered to “generic” email address (i.e. not the ones in the 
escalation steps).

• Send Email When Mailbox is Full: Select the Send Email When Mailbox is Full 
check box to enable Voice Mailbox Full Notifications. This feature sends users a 
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notice informing them that their mailbox is almost full. This message is sent when 
the user's mailbox approaches maximum capacity and crosses a non-configurable 
threshold (i.e. space for only 10 messages remaining).

See the "Configuring Voice Mailbox Full Notifications" on page 450 for more 
information.

Automatic Message Forwarding

• Destination: Messages may be auto-forwarded to a user, a workgroup, a route 
point, or a system distribution list. If the system distribution list includes AMIS 
destinations, they also receive the auto-forwarded message.

The default is None, meaning, no forwarding.

The destination may not be a broadcast distribution list.

• Delete Message After Forwarding: Select the checkbox to cause the automatic 
deletion of the message after forwarding. The default is not to delete.

Message Notification Escalation Profiles

• Escalation Notification Options: Escalation Paging is a traditional voice mail 
feature that allows support groups to offer round-the-clock service to their 
customers.

Customers can call into your system when they have a problem, and can leave a 
voice message. This causes the Escalation Paging feature to begin notifying (via 
email and/or pager/voice message) the appropriate personnel. 

If the first person does not respond to the notification by listening to the customer’s 
voice mail message within a certain time period, the next support person on the list 
is contacted, and so on, until as many as 10 people have been contacted.

You can choose to begin the notification process for each new message that arrives 
in the voice mailbox by selecting the Escalate for Each New Message radio button, 
or you can select the Escalation Paging for First Unheard Message radio button so 
that the notification process will activate for only the first unheard voice message 
(in which case subsequent unheard messages would be regarded as redundant and 
would not trigger another wave of notifications).

For more information on configuring this feature, see the "Configuring Escalation 
Notification" on page 452.

• Profile: Name of the Escalation Notification Profile.

• Used By: This is a user’s Call Handling Mode (CHM) that is associated with the 
Escalation Notification Profile. A profile can be associated with one or more CHM’s

• Steps: This is the number of steps in that profile.

13.3.1.2 Configuring Voice Mailbox Full Notifications
The Voice Mailbox Full Notification feature offers a way for users to receive an alert that 
tells them their mailbox is almost full before it gets to the point that they stop receiving 
messages.

When a user's mailbox approaches its maximum capacity (and a non-configurable 
threshold has been crossed), the system sends users a notice informing them that their 
mailbox is almost full and that there is only enough room for 10 additional messages. Each 
time users log into voice mail, they will receive a notice telling them how much space 
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remains. In this way, mailbox owners are given adequate notice that they must clean up 
their mailboxes and they are not caught off-guard by an unexpected (and unwanted) 
“mailbox full” notification.

Recall that the maximum number of messages a user can receive ranges from 0 to 500 and 
can be set on the “Class of Service - Voice Mail” window in Director. This flexibility implies 
that not all users in the system will have the same upward limit to the number of voice mail 
messages they can receive.

Details:

• The mailbox warning threshold occurs when there is room for only 10 more 
messages in a user's mailbox. This threshold is non-configurable and is the same 
for all users, regardless of total mailbox capacity. 

• As a user's mailbox approaches its limit, a warning message will be played 
indicating that the user has room only for “n” number of messages where the value 
“n” will be a countdown from 10 to 0. This message will be played when a user logs 
into the mailbox via the telephone user interface or Communicator.

• The “almost full” notification will be played until a users delete their messages, 
thereby reducing the number below the threshold.

• When a mailbox has finally reached its limit, the mailbox owner will be notified (if 
this option has been enabled for this user) and a warning NT event will be logged.

• When a message is deleted, it is no longer counted against the total capacity for a 
user's mailbox.

• Deleted messages are temporarily held in a “deleted messages” folder. Up to 200 
deleted messages can be temporarily held. Once this limit is reached, the mailbox 
will be considered full and the user will be unable to receive new messages until the 
deleted messages have been purged. If this happens, the mailbox owner will receive 
a notification telling him, “Your mailbox is full. No more messages will be accepted 
until you purge your deleted messages.”

• Deleted messages can be manually purged by the user or automatically by the 
system. Automatic purging occurs on a nightly basis.

To enable the Voice Mailbox Full Notifications feature for a user:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual User. The Individual Users page 
appears.

Step 3 Select the user for whom you want to enable notification when their voice mail 
box is full. The Edit User page for that user appears.

Step 4 Click the Personal Options tab.

Step 5 Scroll to the bottom of the page and click Escalation Profiles and Other 
Mailbox Options. The Escalation Profiles and Other Mailbox Options for the 
user appears.

Step 6 Select the Send Email When Mailbox is Full check box.

Step 7 Click Save to store your changes.
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Step 8 Repeat this process for each user for which you would like to configure 
mailbox full notifications.

13.3.1.3 Configuring Escalation Notification
The ShoreTel system supports Escalation Notification. This voice mail feature allows your 
organization to know when your customers need help.

For example, if a customer in a small town calls his local utility provider to complain about 
a power outage at 4 a.m., it is possible nobody would be in the office at that hour to handle 
his call. However, with ShoreTel’s Escalation Notification feature, the customer could leave 
a voice mail, and in doing so, he would set in motion a chain of events that would cause 
support personnel from the utility company to respond to his concerns.

The message left by the customer on the voice mail system would trigger the Escalation 
Notification feature to send out a page, phone call, or email to an employee in the support 
department of the utility company. If this first employee ignores the beeping pager, another 
person will be contacted, and so on. Each of those utility company employees specified in 
the escalation profile will be contacted until someone dials into the ShoreTel system and 
listens to the customer's voice mail message and handles the problem. (See Figure 13-7 
below.)

Figure 13-7 Anatomy of an Escalation Profile Event

Details for creating an Escalation Notification profile:

• Each escalation profile has ten notification steps, allowing the system administrator 
to specify who will be contacted at each step and the method used to contact that 
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person (i.e. phone call or pager). An email can be sent to that person in addition to 
the phone call or pager notification.

• A maximum of nine notification profiles are supported.

• Call handling modes can be associated with different notification profiles.

• If a message is left, and someone listens to it, the notifications will stop. However, if 
someone marks a message unheard, that will restart the notification process in the 
same way that receiving a new voice message will.

• Escalation notification is supported on all mailboxes, including user mailboxes 
(extension and mailbox users, mailbox-only users, SMDI mailbox-only users) as 
well as workgroup mailboxes.

To configure Escalation Notifications via ShoreTel Director:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual User. The Individual Users page 
appears.

Step 3 Select the user for whom you want to enable notification when their voice mail 
box is full. The Edit User page for that user appears.

Step 4 Click the Personal Options tab.

Step 5 Scroll to the bottom of the page and click Escalation Profiles and Other 
Mailbox Options. The Escalation Profiles and Other Mailbox Options for the 
user appears.

Step 6 In the Message Notification Escalation Options section, do one of the 
following: select the appropriate radio button. Options are:

• Check the Escalate for Each New Message check box to have the system 
send a new wave of escalation notification messages each time a new voice 
mail message arrives. If several messages arrive within a short period of 
time, those who are notified will receive multiple notifications (when 
perhaps one notification would have been all that was required).

• Check the Escalate for First Unheard Message check box to have the 
system send an escalation notifications to begin at the receipt of the first 
voice mail message. Subsequent unheard voice mail messages will not 
trigger another wave of notifications as long as the first message remains 
unheard.

Step 7 In the Profile section, click the link for the desired escalation profile. The 
Escalation Profile page appears as shown in Figure 13-8.
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Figure 13-8 Escalation Profile Page

Step 8 Do the following to create an escalation profile:

Step a In the Name field, enter the name that you want to use for the profile.

Step b In the Repeat Count field, enter a value ranging from 0 to 200. This is the 
number of times the system will loop through the 10 steps of this profile 
before it quits trying to contact the various notification members. Selecting 
0 will cause the escalation notification profile to execute once, without 
repeating. Selecting 1 will cause it to execute twice (i.e. once with one repeat 
loop).

Step c In the Timeout field, enter the number of minutes (0 - 3600) you want to 
elapse before the next step within this profile is executed. (This is the 
amount of time a message recipient has to respond to the original voice mail 
before escalation occurs.)

Step d Check the Urgent Only check box to have notification sent in only when the 
escalation is determined to be urgent.

Step e In the Deliver Message as Email field, select the method you want to use for 
email delivery. The options are as follows:

• Select Disabled to not send email notification.

• Select Email text only to have a text message sent to this user's email 
inbox. The message will contain basic information about the message 
(e.g. timestamp, sender, etc.)
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• Select Attach WAV file to have a copy of the voice mail sent to the 
designated user's email inbox. This will allow the recipient to play the 
message from his or her PC. 

Step f In the Email Address field, enter the email address of the first person that 
you want to notify.

Step g In the Voice Mail Notification Method section, select radio button for the 
method that you want to use to send voice mail notification: Pager, Phone, 
or None.

Step h In the Notification Number section, select radio button for the type of phone 
you want to send the voice mail message to, Extension or External, and 
enter the phone or pager number of the user in the field. 

Step i In the Pager ID field, enter the pager pin number required to access the 
recipient.

Step j In the Pager Data field, enter the code the recipient requires to indicate that 
a page is waiting.

Step k Click Save to store your changes.

NOTE Click on the next Escalation Step (above the Timeout field) and repeat 
this process to configure up to ten steps within this escalation profile. 
Any unconfigured steps will be skipped over when the escalation 
profile is executed.

13.3.1.4 Linking an Escalation Notification Profile to a Call Handling Mode
To link an Escalation Notification Profile to a Call Handling Mode (CHM):

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual User. The Individual Users window 
appears.

Step 3 Select the user for whom you want to enable notification when their voice mail 
box is full. The Edit User page for that user appears.

Step 4 Click the Personal Options tab.

Step 5 Scroll to the Edit Call Handling Modes section and select the call handling 
mode that you want to associated with an escalation profile. The CHM page 
appears, as shown in Figure 13-9.
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Figure 13-9 Selecting the escalation profile to associate with Out of Office CHM

Step 6 In the Escalation Profile field, select the desired escalation notification profile 
that you want to use.

Step 7 Click Save to store your changes.

Step 8 Repeat this process to associate different escalation notification profiles with 
each of the different Call Handling Modes as needed.

13.4 Voice Mail Reports
When an administrator requests a Voice Mail report, the system retrieves statistics from the 
main server and all distributed servers. ShoreTel provides two types of reports from this 
information: 

• Summary Report: The Summary Report lists voice mail resource data for each 
application server on the ShoreTel network.

• Server Report: The User Report lists voice mail usage information for the specified 
application server and users assigned to the application server.

13.4.1 Summary Report
The Voice Mail Servers Maintenance Summary page displays the Voice Mail Summary 
Report. To open the Summary page, shown in Figure 13-10, select Maintenance -> Services 
-> Voice Mail from the Director menu.
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Figure 13-10 Voice Mail Statistics: Totals Report

The table lists all application servers configured on the network.Each row corresponds to 
one application server and each column lists a server property or resource statistic.

The Summary Report includes the following fields:

• Site: This parameter lists the site to which the server is assigned, as specified by the 
Edit Application Servers page.

• Voice Mail Server: This parameter lists the name of the server, as specified by the 
Edit Application Servers page.

• Mailboxes: This parameter lists the number of mailboxes on the server.

• Messages: This parameter lists the number of messages that are stored in the 
server’s mailboxes.

• Space Used (MB): This parameter lists the memory the server is using to store 
mailbox messages, user name recordings, auto attendant prompts, logs, and other 
data.

• Free Space (MB): This parameter lists the hard disk memory available on the 
server.

When less than 25% of memory capacity of the server is available, the page displays 
a red icon next to the free space value for that server. When the available memory is 
between 25% and 50% of capacity, the page displays a yellow icon next to the free 
space value.

• Last Successful Backup: This parameter lists the date that information on the 
server was backed up.

13.4.2 Server Report
The Voice Mail Servers Maintenance Server page displays a voice mail statistics report for 
the specified application server. To open the Summary page, shown in Figure 13-11, click 
the link of the desired application server on the Voice Mail Servers Maintenance Summary 
page.
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Figure 13-11 Voice Mail Statistics: User Report

The page lists the name of the application server for which the page is reporting statistics 
below the Voice Mail Servers Maintenance text in the upper left corner of the page. The 
page comprises two sections:

• Summary: The summary section lists resource usage and availability statistics for 
the specified application server.

• Details: The Details section lists resource usage statistics for users assigned to the 
application server.

13.4.2.1 Summary
The summary section, located on the top section of the Server page, lists resource usage 
and availability statistics for the specified application server. Statistics listed in this section 
include:

• Mailboxes: This parameter lists the number of mailboxes on the server.

• Messages: This parameter lists the number of messages that are stored in the 
server’s mailboxes.

• Space Used for: These parameters indicate the manner in which the server’s 
memory is allocated: 

— Users: This parameter lists the memory used to store voice mail and mailbox 
configuration settings.

— Recorded Names: This parameter lists the memory used to store recordings of 
all user names.

— Auto-Attendant Prompts: This parameter lists the memory used to store auto-
attendant prompts.

— Logs and Other Data: This parameter lists the memory used for log files 
generated by services hosted by the server.

— Free: This parameter lists the available unused memory resources.
— Total: This parameter lists the total memory resources on the server.
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13.4.2.2 Details
The Details section lists resource usage statistics for the fifty largest mailboxes on the 
server. Mailboxes are sorted in order of the amount of disk space used to store their 
contents.

Each row corresponds to one mailbox on the application server. Each column lists a 
mailbox property or resource statistic.

The Details Report includes the following fields:

• User Information: These parameters identify the user to whom the mailbox is 
assigned. User information parameters are configured in the Edit User – General 
page.

— First Name: This parameter lists the first name of the mailbox owner.
— Last Name: This parameter lists the last name of the mailbox owner.
— Mailbox: This parameter lists the extension of the mailbox.
— User Group: This parameter lists the User Group to which the mailbox owner 

is assigned.

• Number of Messages: These parameters list the mailbox capacity and contents 
statistics.

— Total: This parameter lists the number of messages in the mailbox.
— Unheard: This parameter lists the number of messages that are marked as 

unheard.
— Allowed: This parameter lists the capacity of the mailbox. The number of 

messages that a mailbox can hold is configured through Class of Service 
settings.

• Saved / Unheard (Days): These parameters list the age of the oldest message in the 
specified mailbox that has not been heard.

— Oldest: This parameter lists the age, in days, of the oldest message that is 
marked unheard.

— Allowed: This parameter lists when messages marked as unheard are removed 
from the server, in terms of the message age. This parameter is configured 
through Class of Service settings.

• Heard (Days): These parameters list the age of the oldest message in the specified 
mailbox that has been heard.

— Oldest: This parameter lists the age, in days, of the oldest message that is 
marked heard.

— Allowed: This parameter lists when messages marked as heard are removed 
from the server, in terms of the message age. This parameter is configured 
through Class of Service settings.

• Space Used: This parameter lists the memory required to store contents of the 
specified mailbox. This statistic includes the memory required to store messages 
that are deleted but not purged.

13.5 Voice Mail Synchronization with Gmail for 
Business
The Synchronization with Gmail for Business feature automatically synchronizes the state 
of a ShoreTel user’s voice mail with the state of each corresponding email (when voicemail 
status is sent by way of ShoreTel’s email notification). The HQ or DVS server monitors the 
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state of a user’s voice mails and emails and synchronizes those states. For example, when a 
user opens the voicemail notification email, the voicemail is marked heard on the voicemail 
system, and the message-waiting indicator on the phone is turned off.

NOTE In the current release, Google Gmail is the only email server that a ShoreTel system 
can interoperate with for synchronization of voicemail status. The feature currently 
works on Gmail Premier and Educational email accounts only. These accounts have 
the APIs that are necessary for the integration to work.

13.5.1 Background
A user account can be configured so that the user receives email notification of a new voice 
message. This email notification can also arrive with an attached WAV file of the actual 
voice message. The user can receive both the notification and the voicemail by way of the 
email client. However, in releases below Release 11.2, the status of the messages is not 
synchronized.

NOTE Below Release 11.2, email notification is not synchronized with the related voice 
message on the server: After a user listens to a message by playing the WAV file 
attached to the emailed notification, the message on the voicemail server remains 
marked as unheard. Even though a system administrator could specify in Director 
that messages be marked as heard after email notification is sent, this approach 
does not allow the ShoreTel system to determine whether the message has actually 
been read by the email client.

13.5.2 Voicemail Synchronization Terms
This section contains definitions of acronyms that are relevant to the feature.

• Gmail: Google’s email service. 

• IMAP4: Internet Message Access Protocol 4. An application-level Internet protocol 
used for accessing email from a remote mail server.

• OAuth: This open protocol supports secure API authorization from desktop and 
web apps through a simple, standard method. For more details, see Use of the 
OAuth Protocol section. To research OAuth, go to http://code.google.com/apis/
accounts/docs/OAuth2.html.

13.5.3 Behavioral Details
This section describes a range of details about the feature. Some details are more visible, 
such as the consequences of user action on a message as described in the Synchronization 
Rules section. Certain internal and network-level details are also described.

13.5.3.1 General Details
This section contains some general technical details of the feature. 

• To monitor the status of email, Synchronization with Gmail for Business uses the 
IMAP4 and OAuth protocols to access and authenticate with Gmail server. The 
Secure Sockets Layer (SSL) protocol is used to secure pertinent communications on 
the network. 

• Access to user email by login with the username and password is not used. 
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13.5.3.2 Synchronization Service
The service runs on HQ and all DVS servers. The name of this service is ShoreTel-
VmEmSync.

Each service is responsible for synchronizing the mailboxes that are on the same server. For 
example, the service running on HQ syncs the mailboxes located on HQ.

In the case of mailboxes on a Voice Mailbox Server switch (VMB switch), the synchronizing 
is done by the VmEmSync service that is running on the same server as the TMS that 
manages the VMB.

13.5.3.3 Synchronization Rules
The tables in this section contain synchronization rules. The applicable rules depend on 
whether an email notification has the attached WAV file and whether the server is 
synchronizing during ShoreTel-VmEmSync service startup or during normal operation.

13.5.3.4 Synchronization upon Startup
Start-up synchronization refers to initialization of the ShoreTel-VmEmSync service. This 
service gathers information on all voicemail and related email for each user and then 
synchronizes the states based on the rules in either Table 13-2 (for email text only) or 
Table 13-3 (for email with WAV file attachment). In these tables, the voicemail and email 
states occupy the two columns at left, and the resulting sync action is in the column at 
right.

13.5.3.5 Synchronization during Normal Operation
Synchronization during normal operation is triggered when a user makes a change to a 
voicemail or email. In Table 13-4 and Table 13-5, the voicemail change is in the left 
column, and the consequence for the voicemail or email is in the right column.

Table 13-2 Start-up Synchronization with Email-only Text

Voice Mail State Email State Sync Action
Deleted Not Deleted Delete Email
Heard Unread Mark Email Read
All other states Any state No action

Table 13-3 Start-up Synchronization with WAV File Attachment

Voice Mail State Email State Sync Action
Heard Unread Email Read
Unheard Read Mark Voice Mail Heard
Deleted Not Deleted Delete Email
Not Deleted Deleted Delete Voice Mail
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13.5.3.6 Usage of Network Resources
Before setting up this feature, consider its use of network resources as described in this 
section.

The ShoreTel system monitors the state of all user messages so that, for example, when a 
voice message is heard, the system reflects the state change in a timely manner. To ensure 
timely updates to the status of all messages, the system uses network bandwidth in 
proportion to the number of messages.

For example, consider a ShoreTel deployment that supports 1000 users and that each user 
has 5 messages. The state of 5000 messages total is monitored by the ShoreTel system. For 
monitoring the state of 5000 messages, the required bandwidth is 75 Kbytes per second. In 
this scenario, the time to synchronize a message’s state change between voice mail and 
email is less than 20 seconds. 

In the event of a server restart, the initial synchronization time for a system with up to 1000 
users is less than 3 minutes.

13.5.3.7 Synchronization Criteria
Synchronization is automatically enabled for a user if both of the following are true:

1. The user is configured to receive email notifications. The email address must be that 
of the user’s Premier/Education Gmail account.

Table 13-4 Sync with Email-only Text during Normal Operation

Event Sync Action
Voicemail is deleted. Delete email.
Voicemail is heard Mark email as read.
All other events. No sync action.

Table 13-5 Sync with WAV File Attachment during Normal Operation

Event Sync Action
Voicemail is deleted. Delete email.
Voicemail is heard. Mark email as read.
Voicemail is undeleted. Move email to Inbox. Mark email as 

unread if voice mail is unheard.
Voicemail is marked unheard. Mark email as unread if voicemail is in 

“NEW” folder.

Email is deleted. Delete voicemail.
Email is read. Mark voicemail as heard.
Email is undeleted. Move voicemail to “Saved” folder.
Email is marked unread. Mark voicemail as unheard if email is 

not in “Trash” folder.
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2. The system administrator configured an email server with the domain for the user’s 
email address (by using OAuth consumer key and secret strings). As an example, the 
system administrator configured OAuth access with the domain for the user’s email 
address (explained further in ‘Google OAuth Configuration’ and ‘ShoreTel Director 
Configuration’ sections).

13.5.3.8 Use of the OAuth Protocol
The OAuth protocol lets a 3rd party gain access to a user’s account without needing the 
user’s password. By relying on OAuth, the ShoreTel-VmEmSync service can use the IMAP4 
AUTHENTICATE command to examine a user’s email (without logging in as the user). 
Gmail and most Google APIs support OAuth. 

For the Premier and Education versions of Gmail, OAuth is set up by the system 
administrator. The admin enables certain capabilities and acquires a system-generated 
consumer secret at the Google OAuth management web page. The system administrator 
must first perform these actions in the applicable Google page before providing access to all 
accounts on a domain. An example of the Google Apps web page appears in Figure 13-12. 
In Figure 13-12, the machine-generated “OAuth consumer secret” is the value that the 
admin copies to a new Gmail configuration area of Director (described in Implementation).

The consumer secret from Google OAuth management and the consumer key (also 
described in Implementation) allow the ShoreTel HQ server or DVS to:

• Authenticate with Google mail servers without needing the user passwords. 

• Establish a trusted host relationship between the two servers.

NOTE The Google Apps web page can change without notice, so the admin might see a 
variation of what appears in Figure 13-12.

13.5.4 Configuration
This section describes how to set up this feature but first provides some prerequisite 
information.

ShoreTel synchronization with Gmail Premier and Education Services utilizes a Google 
Apps OAuth key and user secret. The origins of the key and secret are described in the 
Google OAuth Configuration and ShoreTel Director Configuration sections. 

13.5.4.1 Google OAuth Configuration
This section describes the steps that a system administrator performs at the Google Apps 
web site (for OAuth Management) before performing the steps in ShoreTel Director.
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Figure 13-12 Google OAuth Management Page

To do the requisite steps at the Google Apps site:

Step 1 Navigate to the current Google Apps page (see example page in Figure 13-12).

Step 2 Put a check in the following two checkbox enables:

• “OAuth consumer secret . . . Enable this consumer key”

• “Two-legged OAuth access control . . . Allow access to all APIs”

Step 3 At “OAuth consumer secret,” click the button labeled Regenerate OAuth 
consumer secret. A secret is generated and displayed.

Step 4 Write down or otherwise copy the secret. This secret must be entered in 
ShoreTel Director as described in ShoreTel Director Configuration.\

This completes the needed steps at the Google Apps site.

13.5.4.2 ShoreTel Director Configuration
An existing Director page has a new area for setting up Synchronization with Gmail for 
Business. The page is “System Parameters – Edit Other Parameters,” and the new area is 
labeled Gmail Configuration, as Figure 13-13 shows.
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Figure 13-13 New System Parameters - Edit Other Parameters Fields

The consumer key is what is listed on Google’s OAuth Management Page. It is visible in 
Figure 13-12 on page 464, next to the label “OAuth consumer key:”

The consumer secret comes from the Google Apps domain management web site.

To activate the feature in Director:

Step 1 Open Edit Other Parameters by navigating to Administration –> System 
Parameters –> Other.

Step 2 The “OAuth consumer key” from the Google OAuth management page should 
be entered in the box labeled Gmail Consumer Key.

Step 3 Type the secret that was generated in the Google Apps web page in the box 
labeled Gmail Consumer Secret.

Click the Save button at the top of the Edit Other Parameters window.
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Configuring the Auto-Attendant

This chapter describes how to configure Auto Attendant.The topics include:

• "Auto-Attendant Menus List Page" on page 468

• "Edit Menu Page" on page 469

• "Timeout Errors Drop-Down List" on page 473

• "Too Many Errors Drop-Down List" on page 473

• "Multiple Digits drop-Down List" on page 473

An Auto Attendant is a program that answers and handles inbound calls without human 
intervention. Auto attendants typically provide menu-driven options through which callers 
can obtain information, perform tasks, or connect to a requested extension.

The auto-attendant can answer incoming calls and transfer a caller to an extension, a 
mailbox, another menu, a workgroup, or a route point. It also includes a dial-by-name 
feature that transfers callers to the system directory, where they can connect to an 
extension by dialing the user’s name.

14.1 Multiple Auto-Attendants
Multiple auto-attendants can be configured for different user groups or departments, and 
each auto-attendant configuration can have multiple levels of menu options.

There are no hard limits to the number of Auto-Attendants that can be configured in a 
ShoreTel system. However, in most installations, the system can support up to 500 AA 
menus. This number may be affected by the complexity of your dialing plan.

When the “main” auto-attendant is reached, it provides options for forwarding calls to 
individual user extensions. It can also provide options for forwarding calls to the sales 
department and customer operations department auto-attendants. From the sales or 
customer operations auto-attendants, callers are given options that transfer calls to the 
appropriate extension.

The dial-by-name operation of the auto-attendant can be limited to a department or other 
organizational sub-group by associating the operation with an extension list. To create 
extension lists, see the "Extension Lists" on page 358. Only users that have been selected to 
be included in the dial-by-name list will be included. For more information, see the 
"Individual Users" on page 329.

When callers are transferred back to the auto-attendant, either willingly or because of an 
error, they are returned to the default auto-attendant menu on the associated server.
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14.2 Menus
The auto-attendant Menus page is where you begin the configuration to add a new auto-
attendant menu or edit an existing menu.

Figure 14-1 Auto-Attendant Menus List Page

14.2.1 Parameters

The parameters that appear on the Menus page are as follows: 

• Name: This is the name of an existing auto-attendant menu configuration. Clicking 
an auto-attendant invokes the Menus edit page.

• Extension: This is the extension that is associated with an existing auto-attendant 
menu.

• On-Hours: This is the name of the On-Hours schedule, if any, that is associated 
with an existing auto-attendant menu.

• Holiday: This is the name of the Holiday schedule, if any, that is associated with an 
existing auto-attendant menu named in the Name column.

• Custom: This is the name of the Custom schedule, if any, that is associated with an 
existing auto-attendant menu.

14.2.2 Adding and Editing an Auto-Attendant Menu
To add a new or edit an existing auto-attendant menu, invoke the Menus page. From the 
Menus page, click Add new, or click an existing menu name in the Name column. This 
invokes the Edit Menu page, as shown in Figure 14-2.
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Figure 14-2 Edit Menu Page

14.2.2.1 Parameters
The parameters that appear on the Menu edit page are as follows:

• Menu Name: This is the name of the auto-attendant menu.

• Extension: This is the extension number associated with the auto-attendant menu. 
It must fall between the first and last menu numbers defined on the Dialing Plan 
edit page under System Parameters. See the "Setting Dial Plan Parameters" on page 
35.

• DID: When the check box is selected, a DID number is used to access the 
associated auto-attendant menu. If you are adding a new menu or editing an 
existing menu and you want to access it using a DID number, check this box and 
enter a DID number in the accompanying text-entry field. 

Refer to "Assigning DID Numbers from a Range" on page 165 for additional 
information about DID numbers and ranges.

• DNIS: Click this link to set up one or more DNIS mappings to this menu. For more 
information about DNIS, refer to "Edit DNIS Digit Map" on page 167.
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• Language: Select a language from the drop-down list. This is the language that will 
be used by the auto-attendant menu for responses such as “invalid entry”. 
Greetings must be recorded in this language.

• Make Number Private: Checking this box removes this number from the system 
directory and call handling destination lists.

• Allow Prompt Recording Using Telephone: Select this check box to enable the 
User Recording of Auto-Attendant Menus via the menu mailbox.

User recording of auto-attendant menus allows end users to dial into the system to 
record AA prompts in the same way that they would change their personal mailbox 
greeting (i.e. without having to access the recording interface through ShoreTel 
Director). This frees the system administrator from the task of recording AA 
menus, allowing him or her to delegate the task to more appropriate team 
members.

• Menu Password: A separate “Menu Mailbox” is created for each AA menu, 
allowing users to dial into the system to change the menu prompts. Each AA menu 
may have its own password and a unique, dialable number.

If a password is desired, enter the password in the field provided, and enter it a 
second time to confirm.

• On-Hours / Off-Hours / Holiday / Custom: These are the operating modes for a 
new or existing auto-attendant menu. You can configure them for different 
situations. Click the appropriate link to view the schedules. Schedules are set using 
the Schedules link. See Chapter 15: Configuring Schedules starting on page 475.

— On-Hours mode lets you configure the auto-attendant to handle incoming calls 
during regular office hours. 

— Off-Hours mode covers all hours not scheduled in other modes. This is 
typically when the office is closed for the evening and weekend. 

— Holiday mode lets you configure how the auto-attendant functions on 
holidays. 

— Custom mode is used for single days that are not covered by the other modes 
such as a company special event.

• Disable Monitor/Recording Warning Tone: This check box can be used to stop 
playing the warning tone for call recording and monitoring if the tone is turned on 
in the Call Control page. To see where the warning tone is first set, refer to the 
"Call Control Options" on page 290.

WARNING ShoreTel, Inc. does not warrant or represent that your use of call monitoring 
or recording features of the Software will be in compliance with local, state, 
federal or international laws that you may be subject to. ShoreTel, Inc. is not 
responsible for ensuring your compliance with all applicable laws. 

Before disabling the warning tone, you may wish to consult with legal counsel 
regarding your intended use.

• Timeout: Set a timeout between 0-30000 milliseconds. This is the time the caller 
has to perform an action.

• Prompt Text: Before recording a prompt for a new or existing auto-attendant menu, 
enter the text for the prompt in this field. This also provides a convenient record of 
your prompt if you should ever need to re-record the prompt.

This is an optional parameter.
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Prompts on the ShoreTel system can be imported into the system using μ-law, WAV 
file format. If you would like your prompts to match the voice of the ShoreTel 
system, please contact Worldly Voices at www.worldlyvoices.com and request that 
“Connie” record your prompts. Worldly Voices provides this service with a rapid 
turnaround time for a nominal fee.

• Prompt: The Record, Play, Erase, and Import buttons associated with this 
parameter are used to record your auto-attendant menu prompt.

Click Record to record the prompt; Play to play it back; Erase to erase the prompt; 
and Import to import a prerecorded prompt from a sound file.

• Schedule: This drop-down list shows the auto-attendant schedules: On-Hours, Off-
Hours, Holiday, and Custom. Select a schedule from this list and click Go to this 
schedule to invoke the schedule so that you can configure a new or existing auto-
attendant menu’s schedule.

See Chapter 15: Configuring Schedules starting on page 475, for information about 
setting up schedules.

• Operation: Each item in the Operation drop-down list lets you select the action 
that is associated with its dialpad number. This number is located to the left of each 
Operation drop-down list. When prompted by the auto-attendant, the caller is 
asked to enter this number.

— Dial by first name lets the caller spell the user’s first name from the dialpad. 
The auto-attendant then transfers the caller to the user’s extension. To limit the 
dial list to a department or other organizational sub-group, select an extension 
list from the Ext column.

— Dial by last name lets the caller spell the user’s last name from the dialpad. The 
auto-attendant then transfers the caller to the user’s extension.

To limit the dial list to a department or other organizational sub-group, select 
an extension list from the Ext column.

— Go to extension lets the user enter the extension he needs. This functions the 
same as a transfer but without a voice prompt.

— Go to menu transfers the caller directly to the user’s mailbox without ringing 
the user’s extension. This is also used to send the caller to another menu. You 
must select the destination from the extension (Ext) pop-up dialog box.

— Hang up lets the caller disconnect the call.

— Repeat prompt lets the user hear the prompt again.

— Take a message lets the caller leave a message by selecting a user’s extension.

— Take a message by first name lets the caller leave a message by selecting a 
user’s name from the menu.

— Take a message by last name lets the caller leave a message by selecting a user’s 
name from the menu.

— Transfer to extension transfers the caller to the user’s extension where he or 
she can speak with the user or leave a message if the user does not answer. You 
must select a destination from the extension pop-up dialog box.

Dial by last name is supported by default. 

• Ext: This pop-up dialog box lets you select the destination that is associated with 
the Go to Menu or Transfer to extension operation.
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Used this field to select an extension list to be used by the Dial by First Name and 
Dial by last Name operations.

• Time Out: This drop-down list lets you specify the action that the auto-attendant 
takes when the caller does not press a dialpad key in a system-defined period of 
time. Typically, the action is Repeat Prompt. 

• Too Many Errors: This drop-down list lets you specify the action that the auto-
attendant takes when the caller presses an invalid key too many times in a row. You 
might specify a user extension, such as the operator, for this. Typically, the action is 
Hang Up. If no action is specified, Hang Up is invoked by default. 

• Invalid Entry: This drop-down list selects an action to take when a key is pressed 
that the auto-attendant does not recognize. Typically, the action is Repeat Prompt. 

• Multiple-Digit: This drop-down list lets you select a multiple-digit action that the 
caller takes. The choices are None, Transfer to Extension, Take a Message, Go to 
Extension, and Go to Menu. The default is None.

— None assigns no multiple-digit operation to the menu.

— Transfer to Extension assigns a multiple-digit operation to the menu and 
prompts the caller to dial directly into a user’s extension.

— Go to Menu assigns a multiple-digit operation to the menu and prompts the 
caller to dial directly into a user’s mailbox. 

14.2.3 Configuring an Auto-Attendant Menu
To configure an auto-attendant menu from the Menus page:

Step 1 Enter the name of the menu in the Menu Name field.

Step 2 If this is a new menu, enter the menu’s extension in the Number field. If you 
are editing an existing menu, enter a new extension in this field if necessary.

Step 3 If the menu will be associated with a DID number, check the DID check box 
and enter the DID number in the DID text-entry field.

Step 4 To associate the menu with a DNIS number, click Edit DNIS Map and set the 
map.

Step 5 Make Number Private to remove the number from the system directory.

Step 6 Select the Allow Prompt Recording Using Telephone check box to enable the 
User Recording of AA menus, and enter and confirm a password for the 
associated mailbox.

Step 7 Click the auto-attendant mode—On-Hours, Off-Hours, Holiday, or Custom—
that to associate with the menu.

Step 8 Set a Timeout.

Step 9 Enter the text that you will use for recording the menu’s prompt in the Prompt 
Text field. This is optional.

Step 10Do one of the following:

• Click Record to record the prompt.
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• Click Play to hear the prompt.

• Click Erase to erase it.

• Click Import and select the file from the appropriate directory to import a 
prerecorded prompt from a WAV file. 

Step 11Select a schedule for this menu from the Schedule drop-down list, and click Go 
to this schedule. See Chapter 15: Configuring Schedules starting on page 475 
for information about schedules.

Step 12Select the action that the auto-attendant takes in response to each supported 
digit from the Operation drop-down list.

Step 13Assign an extension to the Operation (if applicable) from the extension (Ext) 
pop-up dialog box.

Step 14Select an action from the Time out drop-down list, and select an extension from 
its extension pop-up dialog (if applicable).

Figure 14-3 Timeout Errors Drop-Down List

Step 15Select an action from the Too many errors drop-down list and select an 
extension from its extension pop-up dialog box (if applicable).

Figure 14-4 Too Many Errors Drop-Down List

Step 16Select an action from the Invalid Entry drop-down list, and select an extension 
from its extension pop-up dialog box (if applicable). The options are the same 
as are available in the Timeout pop-up.

Step 17Select an action from the Multiple digits drop-down list.

Figure 14-5 Multiple Digits drop-Down List

Step 18Click Save to save the configuration.
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14.2.3.1 Configuring Multiple Auto-Attendant Menus
Configuring multiple auto-attendant menus lets you add menus to your main menu so that 
callers can be directed to other departments in your company.

To add multiple auto-attendant menus to your main menu:

Step 1 Go to the Menus page and configure the menu you are adding to the main 
auto-attendant menu, as described in the "Adding and Editing an Auto-
Attendant Menu" on page 468.

Step 2 Go back to the main auto-attendant menu’s configuration on the Menu edit 
page.

Step 3 Go to the Operations section on the Menu edit page and select Go to menu.

Step 4 Associate the menu you are adding with a digit and the menu’s extension. For 
example, if the menu’s extension is 503, select this number from the Ext. drop-
down list.

Step 5 Click Save so that your changes are recorded.

You can define the auto-attendant’s schedule when configuring an auto-attendant menu 
from the Menus page or by invoking the Schedules link. Refer to Chapter 15 for 
information about establishing schedules. 

The following schedule pages can be edited from the Menus page or from the Schedules 
link:

• On-Hours

• Holiday

• Custom

With the exception of the Off-Hours mode, each mode has a schedule configuration page. 
Off-hours is equal to all time not entered in the other schedules. 

The following logic determines which schedule is active:

1. The auto-attendant first looks for the Custom schedule.

2. If the Custom schedule is not available, the auto-attendant looks for the Holiday 
schedule.

3. If the Custom or Holiday schedule is not available, the auto-attendant looks for the 
On-Hours schedule.

4. If the Custom, Holiday, or On-Hours schedule is not available, the auto-attendant 
looks for the Off-Hours schedule. 

ShoreTel Director forms the Off-Hours schedule from all the hours not scheduled in the 
other modes. If you do not create a schedule for at least one of the other modes, the Off-
Hours schedule will be all possible hours.
474



C H A P T E R 1 5

Configuring Schedules

This chapter describes how to create schedules for the ShoreTel system. The topics 
discussed include:

• "Accessing the Scheduling Page" on page 476

• "Configuring the On-Hours Schedule" on page 476

• "Holiday Schedule" on page 478

• "Custom Schedule" on page 479

Schedules let you to define business hours and can facilitate proper routing of inbound 
calls. Schedules can be used by Hunt Groups and by the Auto-Attendant.

The ShoreTel system supports the following types of schedules:

• On-Hours

• Holiday

• Custom

Hours for on-hour and custom schedules are configurable. Holiday schedules let you 
identify the days when your organization is otherwise not open for business. Off-hours are 
considered all time that is not entered in the other schedules.

The following logic determines which schedule is active:

1. The auto-attendant or hunt group first looks for the Custom schedule.

2. If the Custom schedule is not available, the auto-attendant or hunt group looks for 
the Holiday schedule.

3. If the Custom or Holiday schedule is not available, the auto-attendant or hunt group 
looks for the On-Hours schedule.

4. If the Custom, Holiday, or On-Hours schedule is not available, the auto-attendant or 
hunt group looks for the Off-Hours schedule. 

ShoreTel Director forms the Off-Hours schedule from all the hours not scheduled in the 
other modes. If you do not create a schedule for at least one of the other modes, the Off-
Hours schedule will be all possible hours.
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15.1 Accessing the Scheduling Page
To access the scheduling page, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Schedules. The Schedules page appears as shown in 
Figure 15-1.

Figure 15-1 Schedules Pane

15.2 Configuring the On-Hours Schedule
To configure the On-Hours schedule, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Schedules. The Schedules page appears.

Step 3 In On-Hours section in the Name column, click On-Hours to modify the 
existing schedule. You can also click Add new under the On-Hours heading to 
create a new on-hours schedule. The Edit On-Hours Schedule page appears as 
shown in Figure 15-2.
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Figure 15-2 On-Hours Schedule Edit Page

Step 4 Create hour blocks by clicking in the hour slot for the start-time of a work day 
and drag the mouse to the end-time for block that day. Right-click to save.

Step 5 Repeat Step 4 for each workday. You can modify time frames on the fly by 
clicking the right mouse button to invoke the options shown in Figure 15-3.

Figure 15-3 Time Frame Options
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The options include:

• Click Fill Week to populate the other days of the week with the same 
schedule.

• Click Edit to edit the selected time block.

• Click Delete to remove the selected time block.

If you want to change the entire schedule, you must delete all entries in the 
schedule; otherwise, duplicate entries will be made.

Step 6 Click Save to save the schedule in the database.

You can schedule a mode to start and stop multiple times in one day. For example, on 
Monday, you can set the schedule to start at 4:30 am and stop at 9:00 am, and then 
schedule it to resume at 2:00 pm until 5:30 pm by performing Step 4 and Step 5 again.

15.3 Holiday Schedule
The Holiday Schedule edit page is shown in Figure 15-4.

Figure 15-4 Holiday Schedule Edit Page

15.3.1 Parameters
The parameters that appear on the Holiday Schedule edit page are as follows

• Schedule Name: Displays the name of a new or existing Holiday schedule. You can 
enter a name in this field for a new schedule or edit it for an existing Holiday 
schedule.

• Holidays – Add New Item: Click Add New Item to add a new holiday to the 
schedule; the Holiday Name and Date text-entry fields are added to the Holiday 
Schedule edit page.

• Holiday Name, Date: This lets you enter a name and date for a new Holiday 
schedule. The date format is MM/DD or MM/DD/YY.

Not entering a value for the year will repeat the same month and day throughout 
year.
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15.3.2 Configuring the Holiday Schedule
To configure the Holiday schedule:

Step 1 Select a holiday from the Schedule Name drop-down list or add a new one by 
clicking Add New and entering a name and date in the Holiday Name and Date 
text-entry fields.

Step 2 Repeat Step 1 for all known holidays.

Step 3 To delete a holiday from the schedule, click Delete Item.

Step 4 Click Save to save the Holiday schedule to the database.

15.4 Custom Schedule
The Custom Schedule edit page is shown in Figure 15-5.

Figure 15-5 Custom Schedule Edit Page

15.4.1 Parameters
The parameters that appear on the Custom Schedule edit page are as follows:

• Schedule Name: This displays the name of a new or existing Custom schedule. You 
can enter a name in this field for a new schedule or edit it for an existing Custom 
schedule.

• Custom Ranges – Add New: Click Add New to add a new Custom schedule; the 
Custom Name, Date, Start Time, and End Time text-entry fields are added to the 
Edit Custom Schedule page.

• Custom Name: This displays the name of a Custom schedule. Enter the name of a 
new Custom schedule or edit the name of an existing schedule in this field.

• Date: This displays the date when a Custom schedule is used. Enter the date a new 
Custom schedule or edit the date of an existing schedule in this field. The format is 
MM/DD or MM/DD/YYYY.

Not entering a value for the year will repeat the same month and day every year.

• Start Time: This displays the start time of a Custom schedule. Enter the start time 
of a new Custom schedule or edit the start time of an existing schedule in this field. 
The format is hh:mm:am or hh:mm:pm.
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• End Time: This displays the end time of a Custom schedule. Enter the end time of 
a new Custom schedule or edit the end time of an existing schedule in this field. 
The format is hh:mm:am or hh:mm:pm.

15.4.2 Configuring a Custom Schedule
To configure a Custom schedule:

Step 1 Select a holiday from the Schedule Name drop-down list or add a new one by 
clicking Add New and entering a name and date for the new holiday in the 
Custom Name and Date text-entry fields.

Step 2 Enter a start time in the Start Time field.

Step 3 Enter an end time in the End Time field.

Step 4 To delete a custom range, click Delete Item.

Step 5 Click Save to save the Custom schedule to the database
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C H A P T E R 1 6

Configuring Workgroups

This chapter provides information about configuring your ShoreTel system for workgroups, 
such as Sales or Customer Care, within your organization. The topics discussed include:

• "Overview" on page 481

• "Workgroups Description" on page 484

• "Selecting a DNIS Trunk Group for DNIS Routing" on page 490

• "Editing Workgroup Membership" on page 490

• "Editing Workgroup Queue Handling" on page 492

• "Workgroup Thresholds" on page 496

• "Multi-site Workgroups" on page 496

16.1 Overview
In a large enterprise, small to medium-sized groups can work as a contact center. The 
ShoreTel Contact Center Solution provides the ability to queue and distribute calls to these 
workgroups, supports agent and supervisor functions, and reports on workgroup activity.

16.1.1 Call Routing
The ShoreTel system has many different call routing options to allow enterprises to 
configure their system and telephony services to match their needs. Callers reach the 
contact center by calling through a dedicated trunk pointed at the contact center, calling a 
DID or DNIS number directed to the workgroup, or calling and then navigating to an auto-
attendant menu option linked to the workgroup.

Call handling options are combined with the system’s schedules to provide even greater 
flexibility after callers reach the workgroup. Four call handling modes are configured for 
the workgroup that are scheduled for different times of the day. Each of the four call 
handling modes starts or stops according to the schedules and can invoke different options 
and transfer callers to different destinations when all agents are unavailable. 

16.1.2 Call Distribution
The ShoreTel system provides flexibility to ShoreTel’s Enterprise Contact Center for 
distributing calls to contact center agents. In addition, the system has options for managing 
the overflow of inbound calls. Inbound calls to a workgroup are managed on the ShoreTel 
server and distributed to agents in one of four configurable patterns. When no agent is 
available, calls can go to a mailbox for the workgroup. accessible by all agents or to a queue 
where calls can be held until an agent is available.
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Distribution of the inbound calls is managed based on agent status. When agents are ready 
for calls, they log in and begin to receive calls. When they complete their day, they log out 
and calls are no longer delivered. In addition, the workgroup can optionally be configured 
so that all agents enter a “wrap-up” mode after every call. In “wrap-up” mode, agents 
remain logged in but do not receive new calls until the configured wrap-up time passes. 
This allows agents to complete any required updates to the customer records between calls.

The following is a summary of the call distribution and call overflow options:

Call Distribution Options

• Round Robin

• Top Down

• Longest Idle

• Simultaneous Ring

Call Overflow Options

• Hold calls in the queue until an agent is available
• Transfer calls to another workgroup, extension, or external number

• Transfer calls to the shared workgroup mailbox

16.1.3 Call Queuing
The queue gives the administrator of the workgroup additional flexibility in managing his 
or her call flow. When all agents are busy, not logged in, or do not answer, callers can be 
directed to a queue where they are held until an agent is available to take their call. The 
queue offers up to five steps, each of which can be configured for different caller 
interactions and to enable caller-selected routing. 

The following is a summary of the call queuing options:

Queue Step Configuration Options

• Announce the caller’s estimated wait time

• Announce the configured prerecorded prompt

• Provide a menu to offer callers transfer options

Supported Menu Functions

• Customer inputs 0–9, *, #

• Transfers to menus, extensions, or mailboxes

• Repeat prompt or hang up the call 

Call Queue Control Options

• Each step can be skipped for call routing flexibility

• Callers are on hold between steps for the configured “step time”

• The last step repeats until the call is delivered 
482



Chapter 16: Configuring Workgroups System Administration Guide
Other Features

• Queue is an option only for on-hours call handling

• Callers hear the main site’s on-hold music while waiting

16.1.4 Workgroup Communicators
The ShoreTel Communicator applications for workgroup agents and supervisors provide 
the information the contact center representatives need in order to be effective, and also 
give them point-and-click control of their voice communications. 

The Communicator applications give agents and supervisors real-time call information, 
including available Caller ID, call duration, and call state. The call’s detailed routing 
information is displayed so that agents know everyone the current caller spoke with in the 
enterprise before reaching the contact center. Additionally, the contact center’s mailbox is 
displayed to every agent for accessing and handling the callers who chose to leave a 
message rather than wait for an agent.

Agents and supervisors have access to the real-time Queue Monitor. This application 
provides current information on what is happening in the contact center queue. It displays 
the number of callers, specific information about each, and how long people have been 
waiting.

The Agent Monitor is the supervisor’s tool for managing the workgroup agents. It shows 
the supervisor the current login status of all the agents, whether they are on a call or not, 
and allows for changing the agent’s status from the supervisor’s position to manage contact 
center coverage. 

The following is a summary of the workgroup Communicator features:

Communicator applications

• Display Caller ID, call duration, and call state.

• Display detailed routing information for calls.

• Display and access the shared contact center voice messages.

• Provide point-and-click access to the system’s call handling features.

• Log in and log out of the workgroup call flow.

Real-time Queue Monitor 

• Display a summary of the number of callers waiting and the longest wait time.

• Show a detailed view of the information about each waiting call.

• Display warnings when the number of calls or longest wait time exceeds the 
supervisor’s thresholds.

• Display or control the call handling mode.

Supervisor’s Agent Monitor 

• Display the current login status of the agents in the workgroup.

• Show whether agents are on a call and how long they have been talking.

• Control agent’s login status from the supervisor’s position.
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16.1.5 Reporting
As calls are received and handled by the agents of the contact center, records are kept to 
help supervisors manage the call flow and resources. Each call to the workgroup is logged 
in terms of how long it spends in the queue, how it ends, which agent handles the call, and 
how long the call takes. 

Three different views of contact center activity are reportable at the ShoreTel server using 
these easy-to-run, standard reporting tools:

• Queue Summary Report

• Agent Summary Report

• Agent Detail Report

Please refer to Appendix E for more information on the workgroup reports.

16.2 Workgroups Description
Workgroups is a ShoreTel entity that performs Automatic Call Distributor (ACD) functions 
for inbound calls. Calls are routed to a workgroup through an extension which, in turn, 
routes them to workgroup agents. Each workgroup is assigned an extension, mailbox, and 
other parameter settings.

Director allows the creation of a maximum of 256 workgroups, with up to 300 members 
per workgroup. The Workgroups List page displays all workgroups in the system.

16.2.1 Workgroups List Page
To open the Workgroups list page, click the Workgroups link in the navigation frame, 
shown in Figure 16-1. From this list page, you can add a new workgroup or link to an 
existing workgroup.

Figure 16-1 Workgroups List Page

The columns on the Workgroups list page are as follows:

• Name: This is the name of the workgroup.

• Extension: This is the workgroup extension.

• # Agents: This value is the number of agents assigned to the workgroup. (Agents 
can be assigned to multiple workgroups.) The maximum number of agents in a 
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workgroup depends on whether the Simultaneous Ringing feature has been 
enabled for the workgroup, as follows:

— 64 agents per workgroup without Simultaneous Ringing

— 16 agents per workgroup when Simultaneous Ringing is enabled

• On-Hours: This is the name of the On-Hours schedule, if any, that is associated 
with a workgroup (named in the Name column at the left).

• Holiday: This is the name of the Holiday schedule, if any, that is associated with an 
existing workgroup.

• Custom: This is the name of the Custom schedule, if any, that is associated with an 
existing workgroup.

16.2.2 Editing Workgroups
This section describes how to edit workgroups in the Workgroups editing page (Figure 16-
2). The tasks include assigning extensions and user group features and scheduling.
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Figure 16-2 Workgroups Edit Page

The parameters on the Workgroups edit page are as follows:

• Name: (Required) Each workgroup must have a name.

• Extension: (Required) Each workgroup must have a unique extension number. 
The system can support up to 128 workgroup extensions 

If the system administrator changes the extension number of a user who has an 
associated mailbox, the user’s messages are retained.
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This is a required parameter and must be unique. A maximum of 128 workgroup 
extensions can be defined.

• Backup Extension: (Required) The backup extension of the workgroup supports 
back-up call routing in case of failures. If the workgroup does not answer after a 
specified number of rings (because of, for example, an unavailable server or 
network problem), the call is routed to this extension. 

If the call volume is low, calls can be routed to an agent. If the call volume is high, 
we recommend that these calls go to a “must answer line” with a distinctive ring. 
Agents can use the call pickup feature to “pick” calls from the “must answer line” if 
the workgroup server is unavailable.

• DID: (Optional) This lets you assign a Direct Inward Dial (DID) number to the 
workgroup. You can assign one DID number to a workgroup.

See "Assigning DID Numbers from a Range" on page 165 for additional 
information about DID numbers and ranges.

• DNIS: (Optional) Clicking the Edit DNIS Map button opens the Select DNIS Trunk 
Group dialog box. This box lets you select a trunk group for DNIS routing. DNIS is 
typically used to route 800-number calls to a workgroup or application. Only trunk 
groups configured for DNIS appear in the dialog box. You can assign multiple DNIS 
numbers to a workgroup. See also "Selecting a DNIS Trunk Group for DNIS 
Routing" on page 490.

• User Group: (Required) This lets you assign the workgroup to a user group from 
the accompanying drop-down list. The workgroup must inherit permission from 
the User Groups COS, since it has access to some telephony features (such as Call 
Forward External), as well as some voice mail features (such as Incoming Message 
Length and Message Notification). See "User Groups" on page 325 and "Telephony 
Features Permissions" on page 315.

To use Barge In, Record, or Monitor, users must belong to groups with the 
necessary permissions enabled in the groups’ COS.

• Mailbox (server): This provides the workgroup with a mailbox on the associated 
server. If you change the server, all messages are automatically moved to the new 
server.

Calls to the workgroup that go to voice mail end up in the workgroup mailbox. 
Calls to a user that go to voice mail end up in the user’s mailbox. The workgroup 
mailbox is shared by all workgroup members who run the Workgroup Agent or 
Supervisor Communicator. In addition, you can log into the workgroup mailbox 
over the telephone using the mailbox number and voice mail password.

This is an optional parameter.

• Language: Select a language from the drop-down list. This is the language that will 
be used by the auto attendant for prompts played to calls in the queue, such as 
“your estimated wait time is...”

• Accept Broadcast Messages: This lets the workgroup receive broadcast messages. 

In general, you will want to remove the workgroup from the broadcast message list.

This is an optional parameter.

• Include in System Dial By Name Directory: This includes the workgroup in the 
auto-attendant’s dial-by-name directory.

This is an optional parameter.
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• Make Number Private: Checking this check box removes this number from the 
system directory and call handling destination lists.

• Recorded Name: The Record, Play, Enter, and Import buttons let you record a 
name for the workgroup. This name is used as part of the default mailbox greeting 
as well as in the Dial By Name directory.

You can use your PC microphone and speakers or a telephone to play and record 
within ShoreTel Director. Please refer to the Auto-Attendant options for more 
information.

You can also import prompts into ShoreTel Director. Prompts must be recorded as 
μ-law, WAV files.

This is an optional parameter.

• Voice Mail Password: This lets you enter and confirm the workgroup’s voice mail 
password.

The voice mail password is used in conjunction with the mailbox number to log in 
to the workgroup mailbox over the telephone. 

This is a required parameter. The initial default is “1234”. Passwords may be 
numeric only.

• Enable Automatic Agent Logout On Ring No Answer: This check box lets you 
automatically log out agents that do not answer a workgroup call after a specified 
number of rings. 

This feature is useful to avoid calls repeatedly being offered to an agent who has 
physically left the workgroup but has forgotten to log out.

This is an optional parameter.

• Workgroup Membership: (Required) The Edit Agents button invokes the 
Workgroup Membership page, which lets you add and remove agents to and from 
the workgroup. You can also change the call distribution hunt order of agents via 
this page.

• Workgroup Queue Handling: (Required) The Edit Queue Handling button invokes 
the Workgroup Queue Handling edit page. This page lets you edit the Queue Step 
Menu as well as the Queue Thresholds. For more information, see "Editing 
Workgroup Queue Handling" on page 492.

• Wrap Up Time: Wrap Up Time allows agents a fixed period of time in seconds to 
complete post-call tasks before being presented with another call. When the call 
wrap-up time is set to zero, this feature is effectively disabled.

This is an optional parameter.

• Current Call Handling Mode: The is a read-only display of the current call 
handling mode as defined by any associated schedules.

• Escalation Profile: Select an Escalation Profile from the drop-down menu to 
associate the desired profile with this workgroup. (See "Configuring Escalation 
Notification" on page 452 for details.)

• Schedule: You can configure schedules against the On-Hours, Holiday, and Custom 
modes that automatically change the call handling of the workgroup. The rules for 
schedules are:

— If it is custom time, use Custom mode;

— If it is holiday time, use Holiday mode;
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— If it is on-hours time, use On-Hours mode;

— Otherwise, use Off-Hours mode.

If no schedules are specified, On-Hours mode is used.

The Edit this schedule link provides a quick way to navigate to the associated 
schedule. For tips on editing schedules, refer to Chapter 15: Configuring Schedules 
starting on page 475.

This is an optional parameter.

• Call Handling Distribution Pattern: (Required) This lets you configure how calls 
are distributed to agents within the workgroup:

— Top Down begins at the top of a list of agents and proceeds down the list 
looking for an available agent until one is found.

— Round Robin selects the next agent on the list following the agent that received 
the last call and then starting again at the top of the list and so on. This works 
in a looping fashion.

— Longest Idle distributes calls to the agent who has been idle the longest.

— Simultaneous distributes calls simultaneously to all available agents, so all 
phones for the workgroup ring simultaneously.

• Call Forward: These buttons let you specify when calls are forwarded. The 
conditions are Always or No Answer/Busy. The default is No Answer/Busy.

The Always condition forwards calls to the number specified in the Always 
Destination parameter immediately when a call is received.

The No Answer/Busy condition forwards calls:

— to the No Answer Destination after the specified number of rings, or

— to the Busy Destination immediately if the user’s call stack is full.

This is a required parameter. 

• Always: When the Always call forward option is selected, calls are forwarded 
immediately to this Extension. You can also forward calls to an External number 
(access code required). If the Call Forward parameter is set to Always, enter 
extensions here.

• Busy: When the Busy call forward option is selected, calls are forwarded to this 
extension immediately if all agents are busy. You can also forward calls to Queue, 
an External number (access code required), or Extensions here.

• No Answer: When the No Answer call forward option is selected, calls are 
forwarded to this extension after the specified number of rings. You can also 
forward calls to Queue, an External number (access code required), or Extensions 
here.

• Logged Out: When the Logged Out call forward option is selected, calls are 
forwarded to this extension if all agents are logged out of the workgroup. You can 
also forward calls to Queue or to an External number (access code required).

• Rings per Agent: This is the number of rings attempted before the call is forwarded 
to the next available agent.

• No Answer Number of Rings: This is the maximum number of rings that a call will 
ring before it is forwarded to the no-answer destination.
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• Mailbox / Workgroup Greeting: The Record, Play, Enter, and Import buttons let 
you record a mailbox greeting for each call handling mode of the workgroup.

This is an optional parameter.

• Workgroup Assistant: To assign a workgroup assistant, select one from the drop-
down list. When a caller is connected to the workgroup’s voice mail and enters “0”, 
the call is transferred to the workgroup assistant extension.

This is an optional parameter.

• Enable Calling Message Notification: This check box activates the message 
notification feature for the workgroup’s mailbox. 

This is an optional parameter.

16.3 Selecting a DNIS Trunk Group for DNIS Routing
To add Dialed Number Information Services (DNIS) routing to a trunk group:

Step 1 Click Edit DNIS Map in the Workgroups edit page. The DNIS Trunk Group list 
opens (Figure 16-3).

Step 2 Click an available trunk group from the list, and then click OK.

Figure 16-3 Select DNIS Trunk Group Dialog Box

16.4 Editing Workgroup Membership
To build a list of workgroup members, click Edit Agents found on the Workgroups edit 
page. The Workgroup Membership edit page (Figure 16-4) lets you add and remove agents 
to and from the workgroup.
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Figure 16-4 Workgroup Membership Edit Page

This page lets you add and remove agents to and from the workgroup, and also change the 
order of agents. Note that if more members exist than can be displayed on one page, you 
can use the forward and back buttons to scroll through the members or enter filter criteria 
in the Filter Users By box. Also note that you can sort members by Extension, First Name, 
or Last Name by using the Sort By drop-down list. 

To add members to a workgroup, select a member’s name from list on the left side of the 
page and click Add. The member’s name appears in the list on the right. When you add a 
new workgroup member, that member is in a logged out state by default.

To remove a member from the workgroup, select that member’s name from the list at the 
right side of the page and click Remove. The member’s name is returned to the list on the 
left side of the page.

To change the order of a member’s hunt order in the workgroup, select the member’s name 
in the right-most list and click Move Up or Move Down until the member appears in the 
order you want.

To change the member’s login status, double-click the name from the right-most list and 
the Edit Workgroup Member dialog box (Figure 16-5) appears.

Figure 16-5 Edit Workgroup Member Dialog Box
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You can change the agent’s Client Type, Logged In, or Call Wrap Up status, and click OK to 
commit the changes. The change is reflected in the Name list on the Workgroup 
Membership edit page.

16.5 Editing Workgroup Queue Handling
The Workgroup Queue Handling edit page (Figure 16-6) lets you edit the queue threshold 
and the Queue Step Menu. Click Edit Queue Handling from the Workgroups edit page.

A calling party that reaches the queue will hear the following, in order:

1. The recorded prompt.

2. Silence for eight seconds during the “wait for digits” time-out.

3. The estimated wait time (if enabled).

4. Music on hold for the configured duration.

The calling party does not have access to the DTMF actions while listening to music on 
hold.

The ShoreTel system ignores DTMF actions if there is no message for the queue step.

Figure 16-6 Workgroup Queue Handling Edit Page

The “Allow agents to pickup from queue” checkbox enables and disables the queue 
handling step menu. 
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A five-step menus can be set for each queue. 

To set the Queue Step Menu: 

Step 1 To set a step, click Step 1, Step 2, Step 3, Step 4, or Last Step. To skip a step, 
select Skip This Step.

Step 2 Select Announce Estimated Wait Time to enable this feature. This informs the 
caller of how much time is left in queue.

Estimated wait time is a moving average based on the duration of the previous 
calls and rounded to the minute. It is calculated as:
Average wait seconds = ((“Average wait seconds” * 9) + “New wait time”) / 10

Where the “New wait time” is the time it took the last call to get to an agent. 
The wait time that is spoken to the caller is:
Spoken wait time = “Position in queue” * “Average wait seconds”

This means the wait time is based on a rolling weighted average of previous 
calls. After 10 calls, 61% of the time is based on the 10 most recent calls. After 
20 calls, 86% of the time is based on the last 20 calls. The wait time may be 
inaccurate with a low call volume.

Step 3 Enter the value for the Time Until Next Step routine in the Seconds field.

Step 4 Enter the text used for the prompt in the Prompt Text field.

Step 5 Click Record to record the prompt. If you have a “canned” prompt, click 
Import to import the Wave file.

Click Play to hear the recording. Click Erase to erase the recording.

Prompts on the ShoreTel system can be imported into the system using μ-law, 
Wave file format. If you would like your prompts to match the voice of the 
ShoreTel system, please contact Worldly Voices at www.worldlyvoices.com and 
request that “Connie” record your prompts. Worldly Voices provides this 
service with a rapid turnaround time for a nominal fee.

Step 6 Click an operation function from the Operation drop-down list and assign it an 
extension. The Single Digit Actions allow you to configure all the digits of the 
telephone keypad (0–9, #, *) for operations similar to an auto-attendant menu. 
The following actions are supported:

• None

• Repeat prompt

• Go to menu

• Transfer to extension

• Take a message

• Hang up

Details:

• For information about overflowing / interflowing calls to a workgroup call, see 
"Configuring Workgroup Overflow / Interflow" on page 494.
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16.5.1 Configuring Workgroup Overflow / Interflow
Workgroup overflow and interflow capabilities offer a way to reduce the wait time for 
callers who are dialing into an Automatic Call Distribution (ACD). This helps to ensure 
faster service and greater customer satisfaction.

Calls can be overflowed (i.e. transferred from one workgroup queue to another higher 
priority queue once a wait time threshold has been exceeded) in order to ensure that 
certain customers who have paid for a higher level of support service (e.g. “Gold Level”) 
have their calls answered faster.

Alternatively, calls can be interflowed to any dialable number when a wait time threshold 
has been exceeded. This external number could be, for example, a cell phone number for a 
supervisor who could answer the call immediately.

Interflowing a call is typically done as the final step in a series of overflows. In other words, 
if a call is sent from one workgroup queue to another without being answered, the call is 
interflowed from the Last Step to an external number (such as the supervisor's cell phone).

To configure the Workgroup Overflow / Interflow feature:

Step 1 The overflow / interflow functionality is set as the Last Step within the Queue 
Step Menu. Thus, you must follow the procedure in "Editing Workgroup 
Queue Handling" on page 492 before configuring the overflow / interflow 
option.

Step 2 Click on the Last Step tab and scroll down to the Overflow / Interflow section 
toward the bottom of the window, as shown in Figure 16-7.
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Figure 16-7 Overflow / Interflow options found at Last Step of WG Queue 
Handling

Step 3 In the Overflow / Interflow section, select the desired radio button:

• Selecting None results in the Overflow / Interflow behavior being disabled.

• Selecting Extension enables the Overflow or Interflow behavior. If this is 
selected, click the Search button to locate the desired extension where calls 
will be overflowed or interflowed. 

• Selecting External enables the Interflow behavior. Enter the desired dialable 
number where calls are sent when the threshold is exceeded.

Step 4 Select the Maintain Wait Time check box to store information about the length 
of time a caller has been waiting. The starting time associated with a call will be 
preserved even after the call has been transferred from one workgroup queue to 
another, and the caller’s “place in line” will be reserved within the next queue. 
If the check box is disabled, the wait time will be lost when the caller is 
transferred and the caller will go to the back of the line in the new queue.

If the call is interflowed to an external number, the wait time cannot be 
retained. The system will recognize if these conditions are present and the 
Maintain Wait Time check box will be grayed out.
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Step 5 Click Save to store your changes.

Details: The number of seconds in the Time Until Next Step field for Steps 1 through the 
Last Step, when added up, represent the total amount of time the caller waits before being 
overflowed / interflowed.

16.6 Workgroup Thresholds
To adjust the queue threshold, click Edit Alert Thresholds found on the Workgroup Queue 
Handling page. The Workgroup Thresholds page (Figure 16-8) appears.

Figure 16-8 Workgroup Thresholds Page

The threshold of Calls in Queue Warning specifies the number of calls in queue that 
triggers an alert in the Queue Monitor in the workgroup Communicator application.

The Calls Waiting Time Warning specifies the number of seconds that triggers an alert in 
the Queue Monitor for the longest wait time of any caller in the workgroup queue.

16.7 Multi-site Workgroups 
Multi-site Workgroups is a feature that allows organizations to deploy Workgroups 
functionality at multiple sites ensuring that enterprises don’t lose any key applications 
needed to drive revenue and customer support. Multi-site Workgroups enables a group of 
users to appear as a single unit to calling parties, by distributing calls to Workgroup agents 
at multiple sites without relying solely on the Headquarters server. When successfully 
deployed, Multi-site Workgroups will provide the reliability and availability required for 
organizations to remain competitive. 

16.7.1 Configuring Multi-site Workgroups

16.7.1.1 Site Specific Workgroups
Using Multi-site Workgroups allows more flexibility through the use of backup 
Workgroups where the Workgroups can be hosted on a different server. When a call is 
directed to a Workgroup the switch will route the call to the Workgroup Extension. If the 
Workgroup extension is unreachable because of server or WAN failure, the switch will 
route the call to the Backup Extension in the server that was configured to handle that 
workgroup. The Backup Extension can be a Workgroup, Hunt Group, Menu or any system 
extension.

NOTE This routing process may take a brief period of time until the no answer number of 
rings limit is reached which will then trigger the activation of the backup 
extension. 
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To configure a site specific Workgroup, follow these steps. 

Step 1 Log into ShoreTel Director and select Workgroups.

Step 2 Select New to create a new Workgroup or select an existing Workgroup that 
you wish to modify. See Figure 16-9.

Figure 16-9 Workgroups Edit Screen

Step 3 Edit the following fields in the Edit Workgroup screen. 

• Workgroup Server - The server hosting the Workgroup. All Distributed Voicemail 
Servers will be listed. Voicemail switches will not be listed.

• Backup extension -The backup extension of the Workgroup. If the Workgroup 
does not answer after the specified number of rings (for example, server 
unavailable or network problem), the call is routed to this extension. This allows 
you to configure backup call routing in case of failures.

NOTE If the call volume is low, you can route these calls to an agent. If the call 
volume is high, it is recommended that you route these calls to a must 
answer line with a distinctive-sounding ring. Agents can use the call 
pickup feature to pick calls from the must answer line if the Workgroup 
server is unavailable.

16.7.2 System-Wide Workgroups
System Wide Workgroup is the setup in which two or more servers are providing call-
routing access. A System Wide Workgroup is supported by Hunt Groups along with Multi-
site Workgroups. Together, they offer calls first to the primary Workgroup and then to 
other Workgroups that are members of the Hunt Group.
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Hunt Groups can have up to 16 members, which provide a higher degree of resiliency. 
Using Hunt Groups is a faster method for call routing in case of a failure because you can 
configure Hunt Groups to offer calls to a larger number of backup Workgroups.

To configure a System Wide Workgroup, follow these steps.

Step 1 Log into ShoreTel Director and select Call Control -> Hunt Groups.

Step 2 Click Administration > Call Control > Hunt Groups. The Hunt Groups page 
appears.

Step 3 Select New to create a new Hunt Group or select an existing Hunt Group that 
you wish to modify. The Edit Hunt Groups page appears as shown in Figure 16-
10.

Figure 16-10 Hunt Groups Edit Screen

Step 4 Edit the following fields in the Edit Hunt Group screen. 

• Distribution Pattern - Click either the Top Down or the Simultaneous radio 
button. With Top Down, the system sequentially hunts through the ordered list of 
group members. With Simultaneous, the phones for all group members ring 
simultaneously. With Simultaneous, the first group member to answer the phone 
gets the call. The default is Top Down.

NOTE: Simultaneous and Top Down are mutually exclusive.

• On-Hours Schedule -From the drop-down list, select an on-hours schedule or 
None. Selecting None causes all calls to be treated as if it is on-hours.
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16.7.3 Important Considerations 

16.7.3.1 Switches that Provide Voice Mail
This feature does not work on the voice switches that provide voice mail (ShoreTel Voice 
Switch 90V, ShoreTel Voice Switch BRIV, and so on).

16.7.3.2 CDR
All CDR records collected by remote severs will be sent to the Headquarters server. The 
existing TMSCDR DCOM interface will be used by the remote servers to send records to 
the Headquarters server. If the Headquarters server is offline then records will be queued 
on remote servers until the Headquarters server comes back on line. There will be a time 
limit on the CDR records that will be kept by remote servers when the Headquarters server 
is offline. The Workgroup server will use the same time limit that is used by TMS. 

16.7.3.3 Call Handling Mode Scheduling
Workgroups can have their call handling mode changed based on a system schedule. For 
Multi-site Workgroups, call handling scheduling is based on the time zone of the server 
hosting the Workgroups. Local call handling mode changes can not be made by any 
Communicator application or IP phone.

16.7.3.4 Hunt Group and Workgroup Scheduling
An additional consideration is the scheduling of the activation time for both Hunt Groups 
and Workgroups.Hunt Group schedules times are based on the Headquarters server time. 
Workgroups schedule times are based on the Workgroups server’s time. Scheduling for 
Workgroups and Hunt Groups are configured by calculating the time zone offset necessary 
for the Hunt Group to activate at the same time as the Workgroup. Refer to the ShoreTel 
Administration Guide for more information on Hunt Group and Workgroup scheduling.

16.7.3.5 Headquarters Server Offline
If the HQ server is down, then changes to Agent state do not work because the HQ server is 
hosting all of the agents’ states. All states, whether logged in, logged out, or in wrap up, 
remain unchanged until the HQ server is back on-line.
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C H A P T E R 1 7

Managing the System Directory

This chapter discusses how the system directory is used and provides instructions for 
adding new entries and editing existing ones. The topics discussed include:

• "System Directory" on page 501

• "Adding an Off-system Directory Entry" on page 503

17.1 System Directory
The system directory is a company-wide address book that list users and off-system 
contacts by name and provides additional information such as home address and phone 
numbers. This directory is read-only to general users through the ShoreTel clients. Only the 
system administrator can update it using ShoreTel Director. Users can copy system 
directory entries to their personal directories.

Individual users automatically populate the system directory when you create them. (For 
more information about creating system users, see the "Individual Users" on page 329). 
You may also add additional listing to the system directory using the System Directory page 
in ShoreTel Director. 

To access the System Directory page:

Step 1 Launch ShoreTel Director with administrator privilege.

Step 2 Click Administration > System Directory. The System Directory page appears 
as shown in Figure 17-1.
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Figure 17-1 System Directory Page

ShoreTel Communicator automatically populates each user’s Quick Dialer with entries 
from the system directory, the user’s personal directory, and all Microsoft Outlook Contact 
folders. This includes each user’s personal contacts as well as any contacts on the Microsoft 
Exchange Server.

To access the system directory, click System Directory from the navigation frame.

The system directory can be filtered by site or dial number. You can also page through the 
directory by page, with a configurable number of records per page displayed.

The columns that appear in the table on the System Directory page are as follows:

• First Name: This is the first name of an existing directory entry.

• Last Name: This is the last name of an existing directory entry.

• Ext.: This is typically a contact’s telephone number or extension.

• Type: This is the type of extension, such as workgroup, FAX, and so on.

• Site: This is the site where the extension is located.

• Trunk Group: This is the trunk group associated with the extension.

• DID: This is the direct inward dial number for the user.

• Work: This is the work number for the user.

• Home: This is the home number for the user.
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• Fax: This is the FAX number for the user.

• Cell: This is the cell number for the user.

17.2 Adding an Off-system Directory Entry
You can add commonly accessed off-system contacts to the directory using the System 
Directory page.To add new off-system contact, do the following:

Step 1 Launch ShoreTel Director with administrator privilege.

Step 2 Click Administration > System Directory. The System Directory page appears.

Step 3 In the By Site field, select the site where you want the listing to appear.

Step 4 Click the New button. The Edit Entry page appears shown in Figure 17-2.

Figure 17-2 System Directory Edit Entry Page

Step 5 Enter the pertinent information in the following fields as required:

• First Name: This field displays the user’s first name.

• Last Name: This field displays the user’s last name.

• Home Phone: This is the user’s home telephone number. Use the format 
shown next to the field to make this entry.

• Work Phone: This is a work telephone number for the user other than his 
or her extension. Use the format shown next to the field to make this entry. 
Do not enter a user extension number in this field.

• Fax Phone: This is the user’s FAX number. Use the format shown next to 
the field to make this entry.

• Cell Phone: This is the user’s cellular telephone number. Use the format 
shown next to the field to make this entry.
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• Pager: This is the user’s pager number. Use the format shown next to the 
field to make this entry.

• E-mail Address: This is the user’s e-mail address.

Step 6 Click Save.

17.2.1 Go to This User Link
The “Go to this user” link appears on the System Directory edit entry page when you are 
editing an existing user directory entry. This link takes you to the Edit User page so that 
you can edit the user’s general, personal, and distribution list options.
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Session Initiation Protocol

This chapter provides detailed information about the Session Initiation Protocol (SIP). You 
should refer to this chapter for help in planning a SIP deployment on your ShoreTel system. 
The topics discussed include:

• "Setting Up SIP Trunks" on page 505

• "Setting Up SIP Extensions" on page 518

• "Setting Up SIP Integration with Third-Party Unified Messaging Systems" on page 
532

ShoreTel supports SIP trunks and SIP Extensions

18.1 Setting Up SIP Trunks
Session Initiation Protocol (SIP - RFC 3261) is a newer protocol that is still being fine 
tuned by the IETF and that is regarded as having the potential to become the global 
signaling standard that will enable all switches, gateways, and phones to talk to one 
another.

The protocol, which works at the application layer, allows users to initiate interactive 
sessions between any network devices that support the protocol. SIP is capable of initiating 
or terminating Internet telephony calls and other multimedia applications such as video or 
gaming.

The protocol is based on a client-server model. With support for redirection services, 
networked users can initiate a call or receive a call, regardless of their physical location.

In its networking negotiations SIP takes into account the following pieces of information: 

• The address of the end system.
• The physical media.
• The call recipient's acceptance to the invitation.

The protocol then configures the parameters for the session and handles the call setup and 
tear-down.

SIP allows two discrete ShoreTel systems to be integrated with any IP connection, without 
the need for physical tie trunking. (Note that care should be taken to make sure that the 
extension numbering plans in the two systems do not overlap, and that if they do overlap, 
translation tables need to be used to resolve conflicts.)

Further, the addition of SIP obviates the need to support other trunking standards, such as 
BRI, through use of a SIP gateway. 

SIP trunks will be assigned to a particular switch as with any other trunk, so that SIP calls 
into and out of the ShoreTel system will be routed through these trunks. However, up to 
five SIP trunks can be associated with one analog switch port, meaning that there will be no 
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physical channel/port associated with each SIP trunk. The SIP trunk is a logical trunk end 
point which only handles call control responsibilities. The media flows directly between 
the end-point SIP devices (i.e. call initiator and the call terminator), freeing the switch from 
the burden of controlling media flow.

18.1.1 Supported RFCs
ShoreTel supports SIP Trunks as specified by the following RFCs: 

• 1889 - Transport Protocol for RTP Applications

• 2806 - URL for Telephone Calls

• 2327 – Session Description Protocol (SDP)

• 2396 - URI (Uniform Resource Identifiers)

• 2833 - DTMF

• 2976 - SIP Info

• 3261 - SIP (Session Initiation Protocol)

• 3361 - DHCP (for IPv4)

• 3515 - SIP Refer Method

• 3891 - SIP Replaces Header

• 3892 - SIP Referred-by Mechanism

• 3966 - URI for Telephone Calls

18.1.2 General SIP Comments
Previous ShoreTel versions support SIP trunks in the following configurations:

• Static Trunking connects two PBXs within a ShoreTel installation.

• Dynamic Trunking connects a PBX to a SIP device.

• Outbound SIP Trunking connects a PBX to an Ingate SIP Trunk Module, which can 
connect to external IP networks or to an ITSP to for connecting to the PSTN.

The SIP trunking implementation in previous versions does not support the use of SIP 
devices as ShoreTel extensions.

18.1.2.1 Conferencing

• Ports for MakeMe conferences must be available on the initiating side of a 3-way 
conference call involving a SIP end-point.

• MakeMe conference ports are needed even for 3-way conference. Note that 
configuration of any MakeMe conferencing support in Director requires a 
minimum of 3 available conference ports.

• An individual SIP trunk must be provisioned for each call to the SIP device 
(including conference-in or transferred calls). Thus, static SIP trunks must be 
provisioned with additional trunks in line with the highest anticipated number of 
such calls. Similarly, dynamic SIP trunks also require that additional individual 
dynamic SIP trunks are provisioned to handle calls that are placed on hold or for 
conference-in calls.
506



Chapter 18: Session Initiation Protocol System Administration Guide
18.1.2.2 DTMF

• ShoreTel can be configured to use SIP INFO for DTMF signaling in environments 
where out-of-band DTMF is needed but RFC 2833 is not applicable. SIP tie trunks 
must use SIP INFO and cannot use RFC 2833 DTMF Relay.

• ShoreTel supports RFC2833 (DTMF) for users calling over SIP trunks regardless of 
the negotiated voice codec.

18.1.2.3 Foreign Language Support

• In addition to English, ShoreTel will support Spanish, French and German (Caller 
Name, Called Name, User Name) over SIP tie trunks and service provider trunks, 
although certain third-party devices may not be able to display the Spanish or 
German characters.

18.1.2.4 Routing with Static and Dynamic Trunks
From the trunk group perspective, when static and dynamic trunks are used:

• A switch can have only one trunk group with dynamic trunks is.

— Outbound calls to this trunk group must be completed based on the 
registration table.

— Calls to the same IP address do not work.

— Calls to different devices going to the PSTN are randomly selected.

• Trunk groups with static IP addresses will not route calls based on OSE ranges due 
to the fact that static trunks do not need registration.

— The switch sends the call to the next available trunk instead of sending it to the 
correct OSE within the range.

— This issue can be solved by creating a trunk group on a per-device basis.

• OSEs routed over trunk groups in more than one switch (with dynamic trunks) 
fail.

18.1.2.5 Extension Assignment over SIP Trunks
ShoreTel supports Extension Assignment phone assignment to devices available over SIP 
trunks. Extension Assignment procedures and capabilities over SIP trunks are identical to 
those for reassignments to phones over other supported trunks.

Using Extension Assignment over SIP Trunks requires using an ITSP that supports SIP-
INFO. If the ITSP does not support SIP-INFO, ShoreTel cannot support DTMF for users 
configured for the SIP Trunk who during Extension Assignment calls. This requires that 
they are configured for “Accept on Answer” and restricts them from using keypad features 
during the call. Theses users can still control their calls through Communicator.

The following limitations apply:

• SIP Tie lines to other ShoreTel systems do not support Extension Assignment.

• SIP Trunks to supported SIP carriers through Ingate support Extension 
Assignment.

• SIP Trunks using SIP gateways supported by ShoreTel (including SIP-BRI 8 and 
Vegastream SIP gateways) support Extension Assignment.
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• Gateways must support, and be configured to send, DTMF in INFO messages to 
support certain functions through Extension Assignment, including Wait for 
DTMF, ** flash, and ## hangup).

• Extension Assignment users cannot hear in-band call-waiting tone for a second call 
over SIP Trunks. Communicator can signal the presence of a second call.

• Features not supported by normal calls on a SIP trunk are also not supported by 
Extension Assignment extension using a SIP trunk.

18.1.2.6 General Feature Consideration

• ShoreTel supports Music On Hold (MOH) over SIP trunks. The capacity limits of 
MOH switches is the same as other trunks; a switch can provide up to 15 streams. 
However, these streams can be to other switches or to SIP devices.

• If the ShoreTel server has a conference bridge 4.2 installed, you should not enable 
SIP. The conference bridge is not compatible with a ShoreTel system that has SIP 
enabled due to the dynamic RTP port required for SIP.

• Three-way conference on a SIP trunk call uses Make Me conference ports. A 
minimum of three Make Me ports must be configured to support three-way 
conferencing.

• A SIP trunk can be a member of a 3-party conference but cannot initiate a 3-way 
conference (unless the SIP device merges the media streams itself).

• ShoreTel SIP supports basic transfers (i.e. blind transfers) and attended transfers 
(i.e. consultative transfers).

• Silent Monitoring and Silent Coach are not supported on a SIP trunk call.

• Barge-In is not supported on a SIP trunk call.

• Call recording is not supported on a SIP trunk call. Call recording requires 
presence of a physical trunk in the call.

• Call redirection by SIP devices is not supported.

• Silence detection on trunk-to-trunk transfers is not supported since it requires a 
physical trunk.

• Fax (and modem) redirection is not supported with SIP trunks as only physical 
trunks can detect fax tones.

• SIP Unified Messaging (UM) can support up to 37 concurrent SIP UM calls from IP 
phones.

18.1.2.7 Additional Configuration Considerations

• SIP Info configuration in a Trunk Group should be enabled if ShoreTel SIP tie 
trunks are used.

• Overlapping number plans are not allowed between two systems tied with SIP 
trunks unless digit translation is used.

• When translating digits between two ShoreTel systems tied with SIP trunks, even 
system extensions like VM, AA should be properly translated.

• SIP devices should either be physically present in the ShoreTel site where the 
ShoreTel switch is hosting the SIP trunk or should be out of the ShoreTel network. 
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• A SIP trunk group cannot host both dynamic and static SIP trunks simultaneously.

• A SIP trunk group hosting dynamic SIP trunks cannot span ShoreTel switches.

• When ShoreTel is working with Dynamic Trunks:

— Multiple registrations of different numbers using the same IP address is not 
supported as ShoreTel uses the last one received. (This is the case of Mediatrix 
2102/1402; customers are expected to use only static trunks for these devices.)

• When ShoreTel is working with Static Trunks:

— OSE ranges might not work when different SIP devices are part of the same 
trunk group. Customers are expected to create a dedicated trunk group for 
each device that needs a static trunk.

— Customer must ensure that SIP devices work with static trunks. Routing 
problems may occur when the same switch has a dynamic trunk group. These 
devices should not be registered with the ShoreTel system.

• Director does not show information about the SIP devices registered in a switch. 
This information can be accessed by telneting to the switch and issuing the 
command print_register_table (applies only to dynamic SIP trunks).

• Groups of SIP trunks can be created at once but are deleted one at a time.

• SIP devices need to work with dynamic audio ports. Customers are expected to 
disable the parameter that forces the system to use only audio port 5004.

— This parameter is found in Director under Call Control > Options.

18.1.3 Configuring SIP Trunks
Configuring SIP on your ShoreTel system consists of the following tasks:

• Configuring the ShoreTel System via Director

— Reserve the Trunk.
— Create a Trunk Group.
— Create a Trunk (static or dynamic).

• Configuring the SIP Device (per the manufacturer's instructions).

These tasks are discussed in more detail in the sections that follow.

18.1.3.1 Reserving SIP Trunk on ShoreTel Switches
One of the first tasks involved in configuring your ShoreTel system for Session Initiation 
Protocol (SIP) is to reserve the trunk. To reserve a new SIP trunk, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Switches page appears.

Step 3 Select the switch on which you want to reserve SIP trunks or add a new switch. 
(See Chapter 5, "Configuring Switches", starting on page 89 for information 
about adding switches.) The Switches page as shown in Figure 18-1 appears.
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Figure 18-1 Switches Page

Step 4 In the Port Type field for the port that you want to use for SIP trunks, select the 
SIP trunk configuration to use:

• 5 SIP Trunks—Configures port to support up to five SIP trunk sessions 
concurrently.

• 100 SIP Proxy—Configures port to support up to 100 SIP proxy sessions 
concurrently.

Step 5 Click the Save button.

18.1.3.2 Creating a SIP Trunk Group
To create a SIP trunk group, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Trunks > Trunk Groups. The Trunk Groups page 
appears.

Step 3 Do the following:

Step a In the “Add new trunk group at site” field, select the site for which you want 
to create the SIP trunk group.

Step b In to “of type” field, select SIP.

Step c Click Go. The Edit Trunk Group page appears as shown in Figure 18-2.
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Figure 18-2 Edit SIP Trunk Group Page: Sip Specific Parameters

Step 4 Do the following to set SIP specific parameters for the trunk group:

Step a In the Name field, enter the name that you want to use for the trunk group.

Step b In the Language field, select the language that you want to use for this trunk 
group.

NOTE The Teleworkers SIP trunk parameter is not used. When teleworkers are 
routed through a SIP trunk:

• Audio proxies via the SG vs. the RTP are directed to ShoreTel Director 
or DVS.

• RTP audio packets are sent in 20 ms audio samplings instead of 
10 ms.

• The inter-site call codec is used.

Step c Check the Enable SIP Info for G.711 DTMF Signaling check box to have 
SIP information sent between the SIP device and voice mail. Enable this if 
connecting with a ShoreTel system running a release previous to ShoreTel 
8.1. Clear if the trunk is primarily used to connect a third-party SIP device.

Step d In the Profile field, select the trunk profile that you want to use for this trunk 
group. The options are:

• ATTBVOIP—Select for use with VOIP service from AT&T.

• SystemTrunk—Select for use with another VOIP carrier.

• Verizon—Select for using VOIP service from Verizon.
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Step e In Digest Authentication field, select the type of calls for which you want 
the trunk to do authentication. The options are:

• None—Disable authentication.

• Inbound-only—Challenges credentials on incoming calls.

• Outbound-Only—Provides credentials when outbound calls are 
challenged.

• All—Authenticates all calls.

All third party SIP devices must have matching information in the 
associated fields, and the user ID and password of the device will be 
authenticated against the information stored in the ShoreTel system

Step f In the User ID field, enter the user ID that you want to use for 
authentication.

Step g In the Password field, enter the password that you want to use for the user.

Step 5 Do the following to configure the trunk to receive inbound calls:

Step a In the Number of Digits from CO field, enter the number digits that your 
telephone service provider will send.

Step b Check the DNIS checkbox to enable the trunk group to support DNIS 
numbers. Click Edit DNIS Map to create DNIS translation profiles. 

Step c Check the DID checkbox to enable the trunk group to support DID 
numbers. Click the Edit DID Range button to specify the range of number 
the trunk group will accept from the PSTN.

Step d Check the Extension checkbox to allow the trunk group to modify 
extensions of inbound calls. The modification options are:

• Translation Table—Click this radio button to have the trunk group use 
a translation table, and in the field, select the translation table you want 
the trunk group to use.

• Prepend Dial in Prefix—Click this radio button to have the trunk 
group place a prefix in front of inbound numbers, and in the field, 
enter the prefix that you want the trunk group to use.

• Use Site Extension Prefix—Click this radio button to have the trunk 
group send the extension prefix associated with the site.

Step e Check the Tandem Trunking check box to enable tandem trunking support 
for the trunk group and do the following:

• In the User Group field, select the user group that you want to user the 
tandem trunks

• In the Prepend Dial in Prefix field, enter the prefix that you want the 
trunk group to attach to front of the number of inbound calls.

Step 6 Do the following to configure network call routing parameters for the trunk 
group for outbound calls. Figure 18-3 shows the bottom portion of the Edit Sip 
Trunk Group page.
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Figure 18-3 Bottom Portion of Edit SIP Trunk Group

Step a In the Access Code field, enter access code that you want users to dial to use 
this trunk. The access code structure must already be established in your 
dial plan. See "Setting Dial Plan Parameters" on page 35.

Step b In the Local Area Code field, enter the area code for location this trunk 
group services.

Step c Click the Addition Local Area Code Edit button to identify adjacent area 
codes to the location this trunk group services.

Step d Click the Nearby Area Code Edit button to identify area codes that this 
trunk group can dial to reduce toll charges.

Step 7 Do the following to configure trunk service parameters for the trunk group for 
outbound calls.

Step a Check the Local check box to enable the trunk group to place off-premise 
local calls.

Step b Check the Long Distance check box to enable the trunk group to place long-
distance calls.
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Step c Check the International check box to enable the trunk group to place 
international calls.

Step d Check the Easy Recognizable Codes (ERC) check box to enable this trunk 
group to support services such as toll-free dialing calls (e.g., 800, 888, 900).

Step e Check the n11 check box to enable this trunk group to place telephone 
service, but not emergency, calls such as directory assistance.

Step f Check the Emergency check box to enable the trunk group to place 
emergency calls.

NOTE You must have at least one trunk group per site that allows 911 calls.

Step g Check the Explicit Carrier Selection check box to enable the trunk group 
to allow users to dial special numbers to access long-distance carriers (e.g., 
1010xxx).

Step h Check the Operator Assisted check box to enable the trunk group to dial 
the outside operator (e.g., 0+).

Step i Check the Called ID not blocked by default check box to enable this trunk 
group to pass Caller ID information by default on outbound calls. 

NOTE In the United States, the user can override this option with vertical 
service codes.

Step 8 To configure trunk digit manipulation for this trunk group, do the following:

Step a Check the Remove leading 1 from 1+10D check box to have the trunk drop 
the leading “1” your users dial on long-distance calls. (Refer to service 
provider to verify whether this is required.)

Step b Check the Remove leading 1 for Local Area Codes check box to have the 
trunk drop the leading “1” your users dial when dialing the local area code. 
(Refer to your service provider to verify whether this is necessary.)

Step c Check the Dial 7 digits for Local Area Code check box to enable the trunk 
to dial local numbers in the local area code with seven digits, if required by 
your local service providers. 

NOTE (For all prefixes unless a specific local prefix list is provided below.)

Step d Check the Dial in E.164 Format to enable this trunk group to support E.164 
numbers.

Step e In the Local Prefixes field, select local prefix profile that you want the trunk 
group to use for local calls. You can use the Go to Local Prefixes List link 
to create prefix profiles. 

NOTE All prefixes that are not listed in the profile are considered long distance 
and calls to these numbers require a long distance trunk service.

Step f In the Prepend Dial Out Prefix field, enter the string that you want the 
trunk group to prepended outbound numbers.

NOTE A dial-out prefix is typically required when connecting to and leveraging 
the trunks on a legacy PBX. Dial Out Prefix is not applied to Off-System 
Extension calls.
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Step g For Off System Extensions, click Edit to add or edit any ranges of 
extensions that can be accessed through this trunk group. This is typically 
used when setting up a tie trunk to a legacy PBX and configuring 
coordinated extension dialing. The Dial Out Prefix rules are not applied to 
Off-System Extensions.

Step h In the Translation Table field, select the translation table that you want this 
trunk group to use.

18.1.3.3 Creating a SIP Trunk
To create a SIP Trunk, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click on the Administration > Trunks > Individual Trunks. The Trunks by 
Group page appears.

Step 3 Do the following:

• In the Add new trunk at site field, select the ShoreTel server site in which 
you want to install the new SIP trunk. 

• In the in trunk group field, select the name of the SIP trunk group with 
which you want to associate the new trunk.

• Click Go. The Edit Trunk page appears as shown in Figure 18-4.

Figure 18-4 Edit Trunk Page

Step 4 In the Name field, enter a name for the trunk.

Step 5 In the Switch field, select the switch with which you want to associate the new 
trunk.

Step 6 Select the desired SIP Trunk Type radio button. There are two choices:

• Dynamic - Select this radio button to provide more flexibility than a static 
IP address. Note that all inbound calls will be accepted, regardless of their 
IP address. If this is selected, you should use the authentication methods 
available to prevent unauthorized callers from accessing the system.
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• Use IP Address - Select this radio button to enter a static IP address. This is 
recommended if the systems are static and will not be changing IP 
addresses often.

Step 7 In the Number of Trunks field, enter the desired number of SIP trunks.

Step 8 Click Save to store your changes.

18.1.3.4 Configure the SIP Device
SIP devices are the third-party telephones, gateways, terminal adapters, and other devices 
that support the protocol. The ShoreTel phones do not currently support the SIP protocol.

With each of the SIP devices you will be using, you will have to consult the manufacturer's 
instructions for specific instructions on configuring the device. 

In a general sense, the configurations for each SIP device will be essentially the same, and 
will require that the following pieces of information are entered:

• IP address of the SIP server
• IP address of the SIP registrar server
• User name (identification for outbound calls)
• User information (OSE or DID)
• User password
• DTMF protocol (i.e. must support RFC 2833)

18.1.4 SIP Trunk Profiles
SIP Trunk Profiles supports custom SIP Trunk parameter settings to specify third party 
service provider configurations. A SIP Trunk Profile is assigned to a SIP Trunk Group from 
the Edit SIP Trunk Group page. See "Add or Edit a Trunk Group" on page 156 for 
information about adding a SIP trunk.

In addition to a generic profile, ShoreTel provides a profile that supports ATT BVOIP and 
Verizon.

18.1.4.1 SIP Trunk Profile List
The SIP Trunk Profiles List page, shown in Figure 18-5, displays the names of all 
SIP Trunk Profiles on the system. To access the SIP Extension Profile list page, 
select Administration -> Trunks -> SIP Profiles from the Director menu.

Figure 18-5 SIP Trunk Profiles List Page
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Each row corresponds to a SIP Extension Profile. Table columns list the following profile 
parameters:

• Name: This parameter is the label by which Director refers to the profile.

• User Agent: This parameter is the expression ShoreTel uses to identify devices 
covered by the profile. ShoreTel compares this expression to the User Agent field in 
the header of SIP packets handled by the system.

• Enabled: This parameter lists the status of the profile. ShoreTel uses only profiles 
that are enabled when evaluating the characteristic set of a device.

• Priority: This parameter determines the order by which the profiles are evaluated 
against the SIP packet header. Profiles with larger priority values are evaluated 
before profiles with smaller priority values.

The User Agent field of successive profiles are compared to the User-Agent field of 
the SIP packet header until a match is found. The profile containing the matching 
User-Agent field is then used to specify device configuration settings.

To add a profile, press the New button in the top left corner of the page.

To remove a profile, select the checkbox that corresponds to the profile to be deleted, then 
press the Delete button in the upper left corner of the page. Predefined profiles cannot be 
deleted.

To edit a profile, open the Edit SIP Extension Profile page by clicking the name of the 
profile to be modified. 

18.1.4.2 Edit SIP Trunk Profile
The Edit SIP Trunk Profiles page, shown in Figure 18-6, is the Director list page from 
which parameter settings for the specified profile are configured. The Edit SIP Trunk 
Profile page is accessed from the SIP Trunk Profile List by adding a new profile or editing 
an existing profile. All parameter fields can be edited for User Defined profiles. Enable is 
the only parameter that can be modified on predefined pages.

Figure 18-6 Edit SIP Extension Profile Page
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Parameters listed on the page include:

• Name: This parameter is the label by which Director refers to the profile.

The field contents are not editable for predefined profiles.

• User Agent: This parameter is the index key that ShoreTel compares to the User-
Agent field in the header of inbound REGISTER or INVITE methods handled by 
the system.

The field contents are not editable for predefined profiles.

• Priority: This parameter is used to determine the profile that is used when the User 
Agent field of multiple profiles match the User-Agent field in the SIP packet header.

The field contents are not editable for predefined profiles.

• Enable: This parameter lists the status of the profile. ShoreTel uses only profiles 
that are enabled when evaluating the characteristic set of a device.

• System Parameters: This field lists the device characteristics and default settings.

• Custom Parameters: The contents of this field list additional device settings or 
overwrite default settings listed in the System Parameters field. Supported 
parameters include:

— DontFwdREFER: When enabled, packets are inhibited from sending REFER 
messages.

18.2 Setting Up SIP Extensions
ShoreTel supports the use of SIP devices that comply with RFC 3261 (Session Initiation 
Protocol) as ShoreTel extensions. SIP devices configured as ShoreTel extensions support 
most features offered by ShoreTel IP Phones.

The ShoreTel implementation of SIP devices support standards specified by the following 
documents:

• RFC 3261 Session Initiation protocol (SIP)

• RFC 2833 In-band DTMF/Out-of-band DTMF 

• RFC 3515 SIP Refer Method

• RFC 3550 A Transport protocol for real-time (RTP/RTCP) applications

• RFC 3551 RTP Profile for Audio and Video Conferences with Minimal Control 

• RFC 2327 Session Description Protocol (SDP) 

• RFC 2396 Uniform Resource Identifiers (URIs) 

• RFC 2806 URLS for Telephone Calls

• RFC 3966 URIs for Telephone Calls

• RFC 2976 SIP Info Method

• RFC 3264 SDP Offer/answer 

• RFC 3842 Message waiting indication reception 

• RFC 3265 Subscription for MWI events 
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• RFC 3891 The Session Initiation Protocol (SIP) “Replaces” Header

• RFC 4208 Session Timers in the Session Initiation Protocol

18.2.1 Network Elements
Implementing SIP extensions require the following components:

• A SIP Proxy or endpoint is the logical entity to which SIP transactions 
communicate through a SIP device. 

ShoreTel resources can be reallocated from supporting trunks, analog extensions, 
or IP devices to support SIP endpoints. Switch resources are reallocated to support 
the following number of endpoints:

— One trunk resource is reallocated to support 100 SIP endpoints.
— One analog extension resource is reallocated to support 100 SIP endpoints.
— One IP phone resource is reallocated to support 20 SIP endpoints.

ShoreTel half-width switches also provide built-in SIP proxy resources that do not 
require the reallocation of other resources.

• Proxy servers are network devices that facilitate communication between SIP 
endpoints. The Proxy Server forwards requests from endpoints to the correct 
endpoint or another server.

Within a ShoreTel network, Proxy Server functionality is built into ShoreTel half 
width and full width switches. ShoreTel switches provide Proxy Servers for SIP 
devices within the same site as the switch. Administrators can designate up to two 
Proxy Switches per site: one switch is assigned as the primary Proxy Server while 
the other switch acts as the backup Proxy Server.

One Virtual IP address (VIP) is designated as the SIP Proxy Server address for each 
site that supports SIP extensions. This address must be static and is assigned to the 
ShoreTel switch that is configured as the SIP proxy for the site. The VIP is moved to 
the backup Proxy Server switch if the primary Proxy Switch fails.

If only one Proxy Server is configured, a VIP address does not need to be 
configured.

• Registrars handle SIP REGISTER requests. Users send REGISTER requests for 
uploading their current location, which is then used by the Proxy server when 
routing information to the user.

The switch that acts as the Proxy Server also serves as the Registrar for the site.

• SIP call managers routes SIP calls to and from SIP endpoints. All switches acting as 
SIP Proxy Servers can also perform call management functions. 

ShoreTel automatically designates a SIP endpoints call manager when it registers. 
SIP endpoints send register requests to the ShoreTel switch serving as its proxy 
server. When an unprovisioned device registers, the switch forwards the request to 
ShoreTel server IPCS, where it is authenticated. IPCS then assigns a call manager 
switch by load balancing across the site’s switch resources. If the site does not have 
sufficient call manager resources, the SIP device is not provisioned.

When a call is made to or from an extension on the SIP device, the requests are sent 
to the call manager switch, which determines how the call is routed.
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18.2.2 Supporting SIP Devices

18.2.2.1 Provisioning SIP Phones
The procedures for provisioning SIP extensions is similar to that for MGCP extensions:

1. The phone sends a register request to the registrar server.

Existing registrations: The registrar server relays the request to SIP call manager 
switch, which then completes authentication. 

New registrations: The request is relayed to IPCS, which then provisions the phone 
on a ShoreTel switch call manager.

2. The user inputs their ShoreTel username, SIP password, and SIP proxy address (VIP 
address) in the configuration form provided by the phone.

ShoreTel can recognize the extension, DID number, or the director log-in name as 
the user portion of a SIP address of record. The DID number is the preferred choice 
for creating the address of record.

3. If the device provides a URN, the system uses it to identify the device. If the device 
does not provide a URN, the system identifies the device by using the contact header 
information. 

Changing the IP address of a SIP device may result in the listing of the device by 
two switches. This dual listing persists until the earlier registration expires. 
Therefore, identifying a device by the contact header may result in a dual switch 
listing if the contact header changes when the phone is provisioned.

All requests to the phone are routed through the SIP call manager switch directly to the 
phone or to the destination specified by the active call handling mode.

All requests from the phone are sent to the proxy server, which forwards them to the SIP 
call manager switch.

18.2.2.2 Phone Profiles
Various SIP device models support differing sets of features, including call control 
capabilities, codec compatibility, and provisioning procedures. SIP Extension Profiles 
distinguish between the different SIP Device models, as described in the "SIP Extension 
Profiles" on page 527.

18.2.2.3 Phone Management
The SIP Protocol specifies phone management levels to denote the degree to which the 
system maintains control over the configuration of the device. Unmanaged devices do not 
have their configuration managed by the phone system. Managed devices have their 
configuration tightly managed by the system.

ShoreTel only supports unmanaged SIP devices.

18.2.2.4 Extension Assignment
Extension Assignment is a ShoreTel feature that assigns a ShoreTel extension to a ShoreTel 
IP Phone or a calling device external to the system. Users transfer their extension to the 
phones upon which they perform the Extension Assignment transfer. The device from 
which the extension is transferred is designated as an Anonymous Telephone if it is a 
ShoreTel IP Phone device.
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When a user transfers an extension from a SIP device, ShoreTel recognizes the SIP device as 
an anonymous phone until the most recent register message sent by the phone expires. 
When the REGISTER message expires, the SIP device is removed from the IP phone list. 
While the SIP device is an Anonymous Telephone, the credentials of the user previously 
assigned to the device remain active.

An extension can be assigned to a SIP device through Extension Assignment only after the 
device becomes an Anonymous Telephone from an earlier Extension Assignment transfer 
and before the device is removed from the IP phone list. The only user that can use 
Extension Assignment to assign an extension to the device is the user that previously 
transferred the extension from the device.

18.2.3 User Features
This section describes the user features supported by SIP extensions.

18.2.3.1 Call Dialing and Initiation
SIP extensions support the following call initiation features:

• Make Call: Calls can be made from the phone or from Communicator.

• On hook dialing: On hook dialing is supported from Communicator.

• Intercom: Intercom calls are initiated from SIP devices by dialing *15 followed by 
#.

Intercom calls to SIP extensions are presented as regular calls.

• Redial and Speed dial: Redial and Speed dial initiated from SIP extensions through 
Communicator operate similar to on hook dialing.

Redial and Speed dial methods differ for each SIP device model. Feature keys on 
specific SIP devices may be programmed to support speed dial.

• E911: Calls to emergency number 911 from SIP extension sends the user’s 
emergency identification or CESID number with the call.

Unregistered SIP phones cannot dial 911 calls.

• Dial plans and extension lengths: SIP extensions support all extension lengths 
ShoreTel can configure. When the SIP call manager receives an Incomplete number 
or an illegally formed number from a SIP device, it returns the SIP response 484 
Address Incomplete or 420 Bad Address, respectively.

• Night bell: SIP extensions can ring the night bell by dialing star code *14.

18.2.3.2 Call Handling
Call handling operations provide options for answering or routing incoming calls. SIP 
extensions support the following call handling options:

• Answer call: SIP extensions can answer calls only from the phone.

Offering calls can be redirected to Voice Mail, an Automated Attendant, or another 
extension through Communicator.

• Hang-up: SIP extensions can hang up calls from the phone or from Communicator.

• Ring No Answer (RNA): The number of rings that trigger a No Answer response is 
specified in the Call Handling Mode definition for each user. When the No Answer 
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condition is triggered, the SIP call manager redirects the call to the RNA 
destination as specified by Director.

• Busy: If the user call stack size is smaller than the phone call stack size, calls that 
overflow the user call stack are redirected to the busy destination as specified by 
Director. 

When the user call stack is larger than the phone call stack, the SIP phone reject 
overflow calls with SIP response 486 Busy. The switch then redirects the call to the 
busy destination as specified by Director.

• Forward Always: SIP extensions supports Forward Always. When this parameter is 
set, all calls will be forwarded to the destination specified by Director.

• Call waiting: The specific call waiting implementation differs for each SIP phone 
model. SIP extensions support call waiting to one or multiple simultaneously 
offered calls for SIP devices that support this feature.

• Call rejection: When the SIP phone rejects the call with 603 Decline response code, 
the switch fails the call and play the reorder tone to the phone

• Call redirect: If the SIP phone returns 3xx response code, the switch redirects the 
call to the user’s RNA destination. If RNA destination is not configured, the reorder 
tone is played.

• Find Me: SIP extensions support FindMe and Call Message notification.

18.2.3.3 Caller ID
Caller ID is the caller information transmitted to the other party during a voice call.

• Caller ID presentation: SIP extensions can display caller name and number.

• Caller ID blocking: SIP extensions support CID blocking and Make Number 
Private.

• Caller ID for Workgroup and Hunt Group agents: The system sends the name of 
the Hunt Group or Workgroup with the original caller number while the call rings. 
After the call is answered, the system sends the original caller name and number.

18.2.3.4 Call Control
Users perform call control operations to manage their active voice calls. SIP extensions 
support the following call control operations:

• Hold: Call hold and unhold are performed from the phone. Implementation of the 
reminder ring for held calls differs among SIP phone models. This feature is 
handled internally by the phone.

• Basic transfer: SIP extensions support blind transfers that use REFER. Transfers 
using re-INVITE are not supported.

• Consultative transfer: SIP extensions support consultative transfers that use 
REFER. Transfers using re-INVITE are not supported.

• Park from SIP phone: Calls are parked from SIP extensions by dialing *11 followed 
by #.

• Unpark on SIP phone: SIP phone users pickup calls parked from their extension 
stack by dialing *12 followed by their extension number.
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Taking the SIP phone offhook is not sufficient to resume a call parked on the same 
extension.

• Pickup: SIP extensions pickup calls by dialing *13 followed by #.

• Unpark: SIP extensions unpark calls by dialing *12 followed by #.

• Conference Calls: Three party conference calls initiated from the phone use the 
phone’s resident MCU.

— Three party conferences calls initiated from Communicator uses MakeMe 
conferencing. 

— MakeMe conferencing is used when a SIP phone joins a conference call.
— Four to six party conference calls are supported using MakeMe and must be 

initiated through Communicator.

• Call recording: SIP Extension call recordings are supported only for only calls 
involving a physical trunk and can be initiated only through Communicator.

• Voicemail: SIP extensions reach voice mail by dialing # on the phone or pressing 
the Communicator VM button. 

• MWI: SIP extensions support Message Warning Indicator by using NOTIFY or 
SUBSCRIBE/NOTIFY on phone models that support MWI. MWI is configurable 
through SIP phone profiles.

• Agents: SIP extensions are available for Workgroup and Hunt Group agents.

• Bridged call appearance: SIP extensions do not support Bridged Call Appearances.

• DTMF: SIP Extensions support DTMF tones as specified by RFC 2833.

• Huntgroup busyout: SIP extensions can busyout huntgroups by dialing *18 
followed by HG#.

18.2.3.5 Specialty Calls
Specialty calls establish communication between system users during voice calls.

• Silent monitor: SIP Extensions cannot initiate this operation. Silent Monitor 
cannot be performed on SIP extension phones.

• Barge In: SIP Extensions cannot initiate this operation. Barge In cannot be 
performed on SIP extension phones.

• Whisper Page: SIP Extensions cannot initiate this operation. Silent Monitor cannot 
be performed on SIP extension phones.

18.2.4 System Features
SIP extensions support the following system features:

• Account codes: Users on SIP extension can be forced to use account codes for 
external calls.

• Bandwidth allocation: ShoreTel allocates bandwidth for SIP voice calls.

• Backup Auto Attendant (BAA): The SIP call manager switch provides BAA to the 
SIP extension. All BAA prompts are played in G.711 format.
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• Supported Codecs: ShoreTel default settings support negotiation of the following 
codecs: 

— L16/16000
— L16/8000
— AAC_LC/32000
— PCMU/8000
— PCMA/8000
— G722/8000
— DVI4/8000
— BV32/16000
— BV16/8000
— G729/8000

New codecs can be added to the Supported Codec List. This list is accessed from 
Director by selecting Administration > Call Control > Supported Codecs from the 
main menu.

• Fax redirection: Fax calls to SIP extensions are redirected to the site fax redirect 
number. SIP extensions do not support T.38.

• Music on Hold (MoH): ShoreTel does not provide music on hold to SIP extensions

• Extension Assignment – external devices: SIP extension user can be configured 
such that Extension Assignment can be performed from devices external to the 
ShoreTel system.

• On-Net dialing: SIP extensions can use on-net dialing.

• PSTN failover: SIP extensions can be reached via PSTN failover.

• Packetization period: The default packetization period for all calls involving SIP 
extensions is 20 ms. 

• Video call: The “Allow intersite video calls” setting restricts video calls across sites. 
ShoreTel does not allocate bandwidth for video calls.

• Country Call Progress Tones and Ring Tones: SIP extensions provide call progress 
and ring tones for countries supported by ShoreTel.

• Language support: SIP extensions provide support for languages as required by the 
countries supported by ShoreTel.

18.2.5 User Assignment
ShoreTel can use the extension, DID, or Client User ID to identify or authenticate a user. 

The contact name, or the information that is placed in the SIP header for messages from the 
device, is constructed from the contact name configured in the SIP device.

The address of record is the IP address by which a user can be reached through the SIP 
device. The address of record is from the user name configured in the SIP device.

18.2.6 Configuration
This section describes the procedures required to implement SIP extensions.
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18.2.6.1 Specifying the SIP Network Elements
The Edit Sites page supports the following SIP Network configuration tasks for the 
specified site: 

• Defines the IP address for the SIP Proxy and Registrar Server.

• Designates the ShoreTel switches that serve as the site’s SIP Proxy and Registrar 
servers. Data entry fields are available for designating primary servers and 
secondary servers.

To configure the SIP Network Elements for a ShoreTel site:

Step 1 Launch ShoreTel Director.

Step 2 Select Administration > Sites. The Sites page appears.

Step 3 Click the site that you want to edit. The Edit Site page appears as shown in 
Figure 18-7.

Figure 18-7 Configuring SIP Network Elements on the Edit Site Page

The SIP Proxy section, located in the bottom section of the page, configures the following 
parameter settings:

• Virtual IP Address: This parameter defines the IP address of the site’s SIP Proxy 
Server and Registrar server. The IP address is independent of the switch that 
performs the server functions. SIP extensions require that this parameter is set to a 
valid address.

• Proxy Switch 1: This setting designates the switch that performs the site’s SIP server 
functions. The drop down menu lists all switches assigned to the site. SIP 
extensions require the setting of this parameter.

• Proxy Switch 2: This setting designates the switch that performs the site’s SIP server 
functions when the switch specified by Proxy Switch 1 is not available. This 
parameter is optional.

18.2.6.2 Setting the SIP Call Controls
The Edit Call Control Options panel configure SIP parameters for the ShoreTel system.
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To configure the SIP Network Elements for a ShoreTel Voice Switch:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration -> Call Control -> Options. The Edit Call Control 
Options page appears as shown in Figure 18-8.

Figure 18-8 Editing SIP Parameters in the Call Control Options Page

Step 3 Set values for the following call control parameters:

• Realm: A realm is a protection domain over which SIP authentication 
parameters are specified. For digest authentication, each such domain 
defines a set of usernames and passwords, through which access is granted. 
The Realm parameter configures the name of the realm to which the site 
devices belong.

Resetting the Realm requires a system reboot.

• Enable SIP Session Timer: SIP Session Timer measures the timeout period 
that determines when devices transmit or receive a RE-INVITE or UPDATE 
method to refresh a session still in progress. This timeout informs stateful 
proxies that a call remains active.

When Enable SIP Session Timer is selected, the following parameters are 
active:

— Session Interval: This parameter specifies the keep alive period for SIP 
Sessions when Enable SIP Session Timer is enabled.

— Refresher: This parameter designates the device – the UAC or UAS – 
that sends the refresh. The method (RE-INVITE or UPDATE) is 
dynamically selected based on the Timer header supported by the SIP 
endpoint.
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18.2.6.3 SIP Extension Profiles
A SIP Extension ShoreTelProfile is a ShoreTel record, defined for a specific SIP device, that 
lists characteristics, properties, features, and settings for that device. A ShoreTel Voice 
Switch uses SIP Extension Profiles to monitor and service the SIP devices connected to the 
system. ShoreTel supports predefined and user defined profiles.

• Predefined profiles are provided by ShoreTel to support generic devices or devices 
for which a specific profile is not defined. Although predefined profiles cannot be 
deleted or modified, they can be deactivated or superseded by user defined profiles.

• User defined profiles are created through Director and list parameter settings for 
specific SIP device models.

SIP Extension Profile List

The SIP Extension Profiles List page displays the names of all SIP Extension Profiles on the 
system. To access the SIP Extension Profile list page, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > SIP Profiles. The Sip Profiles page appears 
as shown in Figure 18-9.

Figure 18-9 SIP Extension Profiles List Page

Each row corresponds to a SIP Extension Profile. Table columns list the following profile 
parameters:

• Name: This parameter is the label by which Director refers to the profile.

• User Agent: This parameter is the expression ShoreTel uses to identify devices 
covered by the profile. ShoreTel compares this expression to the User Agent field in 
the header of SIP packets handled by the system.

• Enabled: This parameter lists the status of the profile. ShoreTel uses only profiles 
that are enabled when evaluating the characteristic set of a device.

• Priority: This parameter determines the order by which the profiles are evaluated 
against the SIP packet header. Profiles with larger priority values are evaluated 
before profiles with smaller priority values.

The User Agent field of successive profiles are compared to the User-Agent field of 
the SIP packet header until a match is found. The profile containing the matching 
User-Agent field is then used to specify device configuration settings.

To add a profile, press the New button in the top left corner of the page.
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To remove a profile, select the checkbox that corresponds to the profile to be deleted, then 
press the Delete button in the upper left corner of the page. Predefined profiles cannot be 
deleted.

To edit a profile, open the Edit SIP Extension Profile page by clicking the name of the 
profile to be modified. 

Edit SIP Extension Profile

The Edit SIP Extension Profiles page, shown in Figure 18-10, is the Director list page from 
which parameter settings for the specified profile are configured. The Edit SIP Extension 
Profile page is accessed from the SIP Extension Profile List by adding a new profile or 
editing an existing profile. All parameter fields can be edited for User Defined profiles. 
Enable is the only parameter that can be modified on predefined pages.

Figure 18-10 Edit SIP Extension Profile Page

Parameters listed on the page include:

• Name: This parameter is the label by which Director refers to the profile.

The field contents are not editable for predefined profiles.

• User Agent: This parameter is the index key that ShoreTel compares to the User-
Agent field in the header of inbound REGISTER or INVITE methods handled by 
the system.

The field contents are not editable for predefined profiles.

• Priority: This parameter is used to determine the profile that is used when the User 
Agent field of multiple profiles match the User-Agent field in the SIP packet header.

The field contents are not editable for predefined profiles.

• Enable: This parameter lists the status of the profile. ShoreTel uses only profiles 
that are enabled when evaluating the characteristic set of a device.

• System Parameters: This field lists the device characteristics and default settings.
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• Custom Parameters: The contents of this field list additional device settings or 
overwrite default settings listed in the System Parameters field. Supported 
parameters include:

— optionsping: Set this parameter to 1 if the SIP device can process SIP OPTIONS 
command. This command is sent to the SIP device as Keepalive message.

— sendearlymedia: Set this parameter is 1 when the SIP device is capable of 
receiving “early media”. Some BAA prompts are streamed as early media.

— mwi: 

❋ Set to none if the SIP device does not support MWI

❋ Set to subscribe when the SIP device subscribes for message waiting service. 

❋ Set to notify when the SIP device will can receive MWI notification without 
subscribing for the service.

— 1CodecAnswer: When set to 1, only one codec is set in answer SDP.
— StripVideoCodec: When set to 1, ShoreSIP UA strips video codec from SIP SDP.
— AddGracePeriod: When extra time needs to be added to the expire time for SIP 

registrations
— FakeDeclineAsRedirect: When set to 1, response code “603 decline from SIP 

endpoint” is treated as redirect to CHM destination.

18.2.6.4 Allocating Switch Resources
A SIP extension can be utilized only if an unused SIP Proxy Port is available on a switch 
assigned to the site. Proxy ports are allocated through the Edit Switch page. Figure 18-11 
displays the Edit ShoreTel 50 Switch page.
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Figure 18-11 Allocating SIP Proxy Ports

ShoreTel switches provide two SIP proxy port sources: Built-in capacity and Port 
assignment.

• Built-in capacity: ShoreTel half-width switches, such as the ShoreTel Voice Switch-
50, provide IP phone, SIP trunk, and SIP proxy resources that are independent of 
port switches. The number of resources varies with each switch model. Each 
resource unit supports one IP phone, one SIP trunk, or five SIP Proxies.

The example in the figure indicates that the SG-50 provides 20 resource units. The 
resources allocation configure is:

— 10 resources as IP phones
— 5 resources as SIP trunks
— 5 resources that provide 100 SIP proxy ports.

To configure the Built-in resource for SIP Proxy Port allocation, enter the desired number 
of IP Phone and SIP Trunk resources in the specified data entry fields. The remaining 
resources from the total available are automatically designated for use as SIP proxy ports.

• Port resources: Switch ports can be configured to support 100 SIP proxy ports.

To configure a port for SIP Proxy Port allocation, access the drop down menu of the desired 
port in the port section of the page and select the 100 SIP Phones option.
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18.2.6.5 Setting an Extension Password
An extension is enabled for SIP if a value is assigned to the User’s SIP Password parameter. 
The SIP Password parameter is located at the bottom of the Edit User: General page, as 
shown in Figure 18-12. Clearing the SIP Password data fields disables the extension from 
supporting SIP.

Figure 18-12 Setting a SIP Password

18.2.6.6 Monitoring SIP Phones
All SIP extension devices on the ShoreTel network are listed on the IP Phone page in 
Director, as shown in Figure 18-13. SIP devices are deleted from this page when they are 
physically removed from the network.

Clicking on the name of a SIP device displays an Edit IP Phone page for that device. The 
Edit IP Phone page displays, in addition to the information listed on the IP Phones list 
page, the Credential Name, User Name, Contact, and Address of Record for the device. The 
only information editable from this page is the name of the device.
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Figure 18-13 SIP devices listed on IP Phones list Page

SIP Register popup

The SIP Register popup, shown in Figure 18-14, displays registration information for the 
corresponding device. This popup is accessed by pressing the SIP Registration on the IP 
Phones page. 

Figure 18-14 SIP Register popup Page

SIP devices can be manually registered using SIP Registration button on the IPPhones page.

18.3 Setting Up SIP Integration with Third-Party 
Unified Messaging Systems
ShoreTel software allows organizations to integrate with external third-party Unified 
Messaging (UM) systems. Enterprise organizations that want to take advantage of 
deploying a separate voicemail or fax server within the ShoreTel environment can do so. 
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After the ShoreTel solution is deployed, an organization can use third-party solutions such 
as Microsoft Exchange to retrieve voicemail and send faxes through any ShoreTel-
supported UM fax server.

Microsoft Exchange Server 2007 and Microsoft Exchange Server 2010 are certified and 
supported by ShoreTel 12.1 and 12.2.

Support for integrating the ShoreTel solution with third-party UM systems gives enterprise 
organizations the flexibility of deploying a separate Unified Messaging (UM) server for 
voicemail or fax.

18.3.1 General Feature Consideration
Integration with third-party UM systems are subject to the following considerations:

• Moving ShoreTel users to a third-party UM server deletes existing voicemails on the 
ShoreTel system. We recommend that you save any existing voicemails before 
upgrading to ShoreTel.

• ShoreTel Communicator and Communicator for Mobile do not support voicemail 
for MSE users.

• Voicemail with Outlook integration is not available from Communicator.

• Message waiting indication is not available for ShoreTel Communicator.

• Although messaging is available from ShoreTel, the following voicemail features are 
not available to a user when ShoreTel is integrated with a third-party UM systems:

— Any Phone

— Find-Me

— Escalation Profiles

• Switching between ShoreTel and External SIP Unified Messaging voicemail results 
in the following conditions.

— Loss of all existing ShoreTel messages

— Users might need to re-create the ShoreTel Communicator rules to reflect the 
new voicemail number.

18.3.2 Configuration
This section describes the procedures required to configure a ShoreTel SIP UM server.

To integrate with third-party UM system, you must first configure your ShoreTel SIP server 
through ShoreTel Director, and then setup and configure one of the ShoreTel supported 
3rd.-party UM solutions. This section describes how to configure a ShoreTel SIP UM server.

NOTE SIP Unified Messaging Servers cannot be added to the system if Always Use 5004 
Port is checked on the Call Control–>Options page. Uncheck this flag before 
proceeding.

NOTE Enable a ShoreTel Voice Switch to be the SIP proxy for the site where you want to 
add the SIP UM Server. This switch is referred to as the site proxy switch.

18.3.2.1 Configuring the SIP Server
To set up and configure a new SIP Unified Messaging server, perform the following steps.
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NOTE You need a ShoreWare External Unified Messaging SIP Link license to use the 
“Allow Extenal Voice Mail for Extension-Only User” option.

Step 1 Launch ShoreTel Director and log in as the administrator.

Step 2 Click Administration > SIP Servers > SIP Servers. The SIP Servers page appears.

Step 3 Click New. The SIP Server Info dialog box shown in Figure 18-15 appears.

Figure 18-15 SIP Server Info Screen

NOTE: Before putting a mark in the checkbox for “Allow External Voice Mail for 
Extension-Only User,” the administrator should verify the presence of a license for 
ShoreTel External Unified Messaging SIP Link.

Step 4 Enter the SIP Server information for the new server.

Table 18-1 displays the IP Server configuration fields and descriptions.

Table 18-1 SIP Server Info Requirements

Field Description

Name Microsoft Exchange SIP Server name.
Site Site where this UM Server will reside. Note that a popup 

message will occur if you change the UM Server site 
later. 

Protocol Select SIP transport protocol for SIP UM server. Select 
TCP for Microsoft TCP Microsoft Exchange server.

Host (Name/Address/
Domain):

IP address or Host name of the SIP Server.

Override Default Port Default port is 5060. If you want to use another value, 
use this field.
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Step 5 Click Save when you are finished.

18.3.2.2 Creating a User Group to the Use SIP Server
After configuring a SIP server, you must create a user group for SIP server users.

To create a user group for SIP server users, perform the following steps.

Step 1 Launch ShoreTel Director and log in as the administrator.

Step 2 Click the Administration > User Groups. The User Groups page appears.

Step 3 Click the user group that you want to use SIP trunks or and click New create a new 
user group. The Edit User Group page appears.

Step 4 In the Voice Mail Interface Mode field, select External Voice Mail, SIP. A pop-up 
message appears.

Step 5 Click OK.

The CHM destinations for this user are set to the selected SIP server extension.

18.3.2.3 Configuring a User To Have SIP Server Access
To create a user within a User Group for a SIP Server, follow these steps.

Step 1 Launch ShoreTel Director and log in as the administrator.

Allow Fax Redirect to This 
Server

Enable this to use this server as Site Fax Server.

Extension Enter a unique extension for SIP UM Server. This should 
be identical to the pilot number assigned on the SIP UM 
Server.

Assigned User Group This is used to provide outbound trunk calling capabil-
ity from the MSE server. Please assign a user group with 
outbound trunk access to this SIP Server. In case of 
Exchange server, this user group will be used to make 
external calls for these features: 

• MS outlook play on phone feature for playing voice mail on external 
number.

• Call sender feature to call to an external user who left the voice mail.

SIP Profile Select the right profile from the list, based on your SIP 
Server. If using Exchange server, select Microsoft 
Exchange profile.

Digest Authentication Select from drop down, depending on what is supported 
by the SIP UM server. Select none for MSE. 

User ID User name for authentication, if enabled.
Password Password for authentication, if enabled.

Table 18-1 SIP Server Info Requirements (Continued)

Field Description
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Step 2 Click Administration > Users > Individual Users. The Individual User page 
appears.

Step 3 Select a User that you want to with SIP server permissions. The Edit User page 
shown in Figure 18-16 appears.

Figure 18-16 Creating a User within a User Group for a SIP Server

Step 4 In the License Type field, select Extension Only.

Step 5 In the User Group field, select the user group configured to use a SIP voice mail 
interface for the user.

Step 6 In the External Mailbox through Server field, select UM Server from the drop-
down list.

NOTE The limit for simultaneous active calls is 24 per switch. The active calls are SIP 
calls handled by a ShoreTel Voice Switch that could be voice, T.38, or a 
combination of these.

18.3.2.4 Configuring a Third-party Unified Messaging Server 
After you have successfully configured ShoreTel Director, you must setup and configure 
your third-party UM server. Please contact the ShoreTel Technology Partners Program at 
http://www.shoretel.com/partners/technology/certified_partners.html for more information on 
configuring ShoreTel supported third-party UM solutions.

NOTE A Unified Messaging SIP Link license is required for every Unified Messaging (SIP) 
server added in ShoreTel Director.
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Maintenance

The ShoreTel system provides maintenance information through ShoreTel Director to let 
system administrators check the operational status of switches, ports, servers, and services. 
It also provides information to resolve an event or error that might occur while the system 
is running. Operational status and events are tracked by the system. The information is 
displayed on the maintenance pages that you access from the Maintenance section in the 
navigation frame.

This chapter provides information about the maintenance functions available in ShoreTel 
Director. The topics include: 

• "Quick Look" on page 537

• "Switch Maintenance" on page 543

• "Switch Connectivity" on page 556

• "Conference Ports" on page 557

• "Event Log" on page 558

• "Services" on page 561

• "Database Maintenance" on page 565

19.1 Quick Look
The Quick Look maintenance page provides a snapshot of the entire ShoreTel system. It 
includes information about each site and the corresponding switches and servers. To access 
the Quick Look page, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Quick Look. The Quick Look page appears as shown in 
Figure 19-1.
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Figure 19-1 Quick Look Page

The Quick Look page is described as follows:

• Refresh: Click this word, located at top of the page, right of the Last Updated time, 
to update the page information. The Quick Look page automatically updates every 
60 seconds.

• Switches: This area lists all of the sites on your system. Sites without servers are 
listed beneath their associated site that has a server. The following is represented 
under Switches:

— Site: Clicking the name of a site will bring you to the Maintenance Switches 
Summary page.

— TMS Comm: This summarizes the communication state of all switches at the 
site. The first number represents switches with which TMS can currently 
communicate. The second number is the total number of switches at the site.

— Usage: Shows either an Idle or In Use state. 
— Service: This summarizes the service state of all the switches at the site.

• Servers: This area lists all of the ShoreTel servers.

— Server: Sites that have a server list the server in bold and a link to the Quick 
Look Server Maintenance page is provided. Sites without servers list the 
associated server they are served by.

— Status: This summarizes the status of the server.
— Services: This summarizes the status of the ShoreTel services on the server.
— Today’s Events: This summarizes the events that have been recorded in the 

event log on the server. See the "Quick Look Server Events" on page 555.

• Apply this Command to All Switches: Each option initiates restart operations for 
all system switches. The restart begins immediately when an option is selected:

— Restart: Select this option to immediately shut down and restart all switches. 
Calls that the switches are servicing when this command is selected are lost.

— Restart when idle: Select this option to shut down and restart, each switch 
once the calls they are currently servicing are completed. Calls that are in place 
when this command is selected are allow to completely normally.

— Reboot: This option performs the same operation as Restart.
— Reboot when idle: This option performs the same operation as Reboot when 

idle.
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19.1.1 Maintenance Switches Summary
The Maintenance Switches Summary page (shown in Figure 19-2) is accessed by clicking 
on a site name listed on the Quick Look page. The switches summary lists all ShoreTel 
voice switches configured at the site. Switches are identified by name and IP address.

Figure 19-2 Maintenance Switches Summary Page

The Restart All and Restart All When Idle buttons restart all switches. When clicked, 
Restart All restarts all switches and discontinues any calls in progress. Clicking Restart All 
When Idle restarts each switch only after all calls have ended.

19.1.1.1 Voice Switches and Service Appliances Elements
The columns in the Voices Switches and Service Appliance section includes the following 
elements:

• Switch/Appliance: Lists the names of the voice switches and service appliances 
that are installed on the system. Clicking a name invokes the maintenance page for 
that device.

• IP Phones: Lists the number of IP phones currently registered with the device and 
the device capacity.

• SIP Trunks: Lists the number of SIP trunks currently registered with the device and 
the capacity of SIP trunks the device is configured to support.

• SIP Proxy:

• BCA: Lists the number of Bridge Call Appearance (BCA) extensions currently 
registered with the device and the BCA capacity the device is configured to support.

• Type: Lists the type of device.

• IP Address: Lists the IP address assigned to the device.

• MAC Address: Lists the Ethernet address of the device.
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• Comm: Lists the number of devices this device with which this switch is currently 
communicating and the total number of devices on the network with which this 
device can communicate.

NOTE Clicking the Comm fraction takes you to the Switch Connectivity page, 
which provides more detail on each switch’s communication status. 

• Audio Ports: Lists the number of audio conference ports the device is currently 
using and the number of audio conference ports the device is licensed to use.

• Web Ports: Lists the number of Web conference ports the device is currently using 
and the number of Web conference ports the device is licensed to use

• Conference: Indicates the number of conference ports currently in use. 

• Hunt Groups: Lists the number of hunt groups registered with the device. 

• Usage: This is the usage state of the device.

— Unknown—The usage state is unknown. This might be true because 
communication between the server and the switch might have been lost.

— In Use—At least one port or IP phone has an active call.

— Off Hook—At least one port or IP phone is off-hook, but no ports are in use.

— Idle—There are no ports or IP phones off-hook or in-use.

• Service: This is the service state of the device.

— Lost Communication—The server lost communication with the voice switch. 
Note that the voice switch may be fully operational but the ShoreTel server 
cannot see the voice switch due to a networking issue. This also occurs when 
the voice switch is powered off.

— Upgrade in Progress—The voice switch is currently being upgraded with a 
new software version.

— Restart Pending—A Restart when idle command was issued but the restart did 
not occur because ports are still in use.

— Firmware Version Mismatch—The voice switch is running a version of 
software that does not match the version on the server. The voice switch 
continues to run call control but does not have access to any voice services on 
the server. This typically happens on software upgrades after the server was 
upgraded but before the voice switches were restarted and upgraded. Note that 
voice switches at the same firmware version also continue to operate together.

— Firmware Update Available—This means the server has a new optional 
version of firmware available for the voice switch. A voice switch in this state 
continues to run call control as well as access the voice services on the server. 
This state typically happens when you install a patch on the ShoreTel server. If 
you want, or need, the patch to propagate to the voice switches, you must 
restart them.

— FTP Booted—This means the ShoreTel voice switch did not boot from FLASH 
memory but booted from an FTP server, most likely on the ShoreTel server. You 
can correct this problem by rebooting the voice switch. If this does not correct 
the problem, please contact ShoreTel’s Customer Response Center.

— Port Out of Service—All ports on the ShoreTel Voice Switch are out of service. 

— IP Phone(s) Out of Service—One or more IP phones associated with the 
switch are out of service.
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— Port Out of Service—This means one or more, but not all, ports or IP phones 
are out of service on the ShoreTel voice switch. Ports or IP phones typically go 
out of service because either someone manually put them out of service or the 
call control software automatically put them out of service due to a signaling 
problem (for example, the dial tone was not received from the central office).

— In Service—This means the configured ports or IP phones are ready for service.

• Command: Allows you to issue commands to the device. The commands are as 
follows:

— Restart: This restarts the voice switch. Active calls are dropped. 

This is a forceful way to shed traffic from a voice switch when you are 
performing a software upgrade.

— Restart when idle: This restarts the voice switch once all ports are idle. All idle 
ports are put out of service and remaining ports are put out of service when 
they go idle. Once all ports are out of service, the voice switch restarts. 

This is a graceful way to shed traffic from a voice switch when you are 
performing a software upgrade. Note that active calls are completed but no new 
calls can be made or received until the voice switch restarts.

— Put in service: This puts all ports on the voice switch in service. Ports already 
in service with active calls are not affected. 

— Put out of service: This places all ports on the voice switch out of service. 
Active calls are dropped. 

This is a forceful way to shed traffic from a voice switch when you need to 
replace the switch.

— Put out of service when idle: All idle ports are put out of service and remaining 
ports are put out of service when they go idle. 

This is a graceful way to shed traffic from a voice switch when you need to 
replace the switch.

NOTE SoftSwitches only have Restart and Restart When Idle in the command 
list.

19.1.1.2 Spare Switch Parameters
The columns in the Spare Switches section includes the following elements:

• Spare Switch: Lists the name of the spare switch.

• IP Phones: List number of phones currently registered with the switch and the total 
number the switch supports.

• Type: Lists the switch type.

• IP Address: Lists the IP address of the spare switch.

• MAC Address: List the Ethernet address of the spare switch.

• Failover Status: 

• Current Site: Lists the site the spare switch is currently supporting.

• Home Site: Lists the site in which the spare switch is registered.

• Usage: This is the usage state of the spare switch.
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— Unknown—The usage state is unknown. This might be true because 
communication between the server and the switch might have been lost.

— In Use—At least one port or IP phone has an active call.

— Off Hook—At least one port or IP phone is off-hook, but no ports are in use.

— Idle—There are no ports or IP phones off-hook or in-use.

• Service: This is the service state of the spare switch.

— Lost Communication—The server lost communication with the voice switch. 
Note that the voice switch may be fully operational but the ShoreTel server 
cannot see the voice switch due to a networking issue. This also occurs when 
the voice switch is powered off.

— Upgrade in Progress—The voice switch is currently being upgraded with a 
new software version.

— Restart Pending—A Restart when idle command was issued but the restart did 
not occur because ports are still in use.

— Firmware Version Mismatch—The voice switch is running a version of 
software that does not match the version on the server. The voice switch 
continues to run call control but does not have access to any voice services on 
the server. This typically happens on software upgrades after the server was 
upgraded but before the voice switches were restarted and upgraded. Note that 
voice switches at the same firmware version also continue to operate together.

— Firmware Update Available—This means the server has a new optional 
version of firmware available for the voice switch. A voice switch in this state 
continues to run call control as well as access the voice services on the server. 
This state typically happens when you install a patch on the ShoreTel server. If 
you want, or need, the patch to propagate to the voice switches, you must 
restart them.

— FTP Booted—This means the ShoreTel voice switch did not boot from FLASH 
memory but booted from an FTP server, most likely on the ShoreTel server. You 
can correct this problem by rebooting the voice switch. If this does not correct 
the problem, please contact ShoreTel’s Customer Response Center.

— Port Out of Service—This means all ports on the ShoreTel voice switch are out 
of service. 

— IP Phone(s) Out of Service—This means one or more IP phones associated 
with the switch are out of service.

— Port Out of Service—This means one or more, but not all, ports or IP phones 
are out of service on the ShoreTel voice switch. Ports or IP phones typically go 
out of service because either someone manually put them out of service or the 
call control software automatically put them out of service due to a signaling 
problem (for example, the dial tone was not received from the central office).

— In Service—This means the configured ports or IP phones are ready for service.

• Command: Allows you to issue commands to the device. The commands are as 
follows:

— Restart: This restarts the voice switch. Active calls are dropped. 

This is a forceful way to shed traffic from a voice switch when you are 
performing a software upgrade.
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— Restart when idle: This restarts the voice switch once all ports are idle. All idle 
ports are put out of service and remaining ports are put out of service when 
they go idle. Once all ports are out of service, the voice switch restarts. 

This is a graceful way to shed traffic from a voice switch when you are 
performing a software upgrade. Note that active calls are completed but no new 
calls can be made or received until the voice switch restarts.

— Put in service: This puts all ports on the voice switch in service. Ports already 
in service with active calls are not affected. 

— Put out of service: This places all ports on the voice switch out of service. 
Active calls are dropped. 

This is a forceful way to shed traffic from a voice switch when you need to 
replace the switch.

— Put out of service when idle: All idle ports are put out of service and remaining 
ports are put out of service when they go idle. 

This is a graceful way to shed traffic from a voice switch when you need to 
replace the switch.

— Failback: Clears the parameters assigned to the system for failover and returns 
the switch to the spare-switch state at the home site.

19.2 Switch Maintenance
Clicking an individual switch name on the Switches Summary page brings you to the 
associated Switch Maintenance page. The individual Switch Maintenance pages are very 
similar but may vary to some degree. Examples of Switch Maintenance pages such as 
Figure 19-3 are shown on the pages that follow. Each type of switch may show less than all 
of the details show.
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Figure 19-3 Switch Maintenance Page for a ShoreGear 120/24 Switch

19.2.1 Switch Section
The top of the Switch Maintenance page repeats some of the information on the Switches 
Summary page. The Switch Maintenance page also expose the individual ports as well as 
more detailed information on the switch operation. 

The following is additional state information for ShoreTel-120/24, ShoreTel-60/12, 
ShoreTel-40/8, ShoreTel-T1, and ShoreTel-E1:

• Fan: Status of the fan, with the following states:

— OK
— Slow
— Failed
— Unknown

Switches: 24, 12, 8, T1, E1
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• Temperature: Status of the temperature, with the following states:

— OK
— Yellow Alarm
— Red Alarm
— Unknown

Switches: 24, 12, 8, T1, E1

• Talk Battery Voltage: Status of the Talk Battery Voltage, with the following states:

— OK
— Failed
— Unknown

Switches: 24, 12, 8

• Ring Voltage: Status of the Ring Voltage, with the following states:

— OK
— Failed
— Unknown

Switches: 24, 12, 8

19.2.2 Link Section
The ShoreTel-T1 and ShoreTel-E1 uses T1, T1 PRI, or E1 PRI signaling and additional 
information is presented on the status of the link and on the status of the PRI D-Channel.

Figure 19-4 displays the Switch Maintenance page for a ShoreTel T1 switch.
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Figure 19-4 Link Section of the Switch Maintenance Page (SG-T1)

Figure 19-5 displays the Switch Maintenance page for a ShoreTel 220E1 switch.
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Figure 19-5 Link Section of the Switch Maintenance Page (SG-220E1)

The following is the link state information for the SG-T1/E1 and SG-220T1/220E1:

• D-Channel (PRI only)

— States: In Service, Out of Service, Unknown
— Commands: Reset, Put in service, Put out of service, Put out of service when 

idle

• Line Coding

— States: OK, Bipolar Violations, Loss of Signal, Unknown

• Framing

— States: OK, Yellow Alarm, Bit Error, Out of Frame, Unknown

• Loopback

— States: Off, On, Unknown
— Commands: Turn On, Turn Off

• Span

— Commands: Reset, Put in service, Put out of service, Put out of service when 
idle.

The following is the link performance information for the SG-T1/E1 and SG-220T1/220E1:

• Error Free Seconds: The number of error-free seconds that occurred in the last 15 
minutes and 24 hours.

• Errored Seconds: The number of errored seconds that occurred in the last 15 
minutes and 24 hours.

• Severely Errored Seconds: The number of severely errored seconds that occurred 
in the last 15 minutes and 24 hours.

• Unavailable Seconds: The number of seconds the server was not available.
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• Bit Error Rate: Not used.

• Out of Frame: The number of times the link has been out of frame in the past 15 
minutes and 24 hours.

19.2.3 Ports Section
Each Switch Maintenance page has a Ports section, where the configured ports are shown. 
The Ports section shows the port number, port description (first and last name or trunk 
name), usage state, service state, and available commands. Refer to Figure 19-6.

Figure 19-6 Ports, Hunt Groups, and Details Sections of Switch Maintenance Page

The following are the port Usage states:

• Unknown: The state is unknown, likely because communication between the 
server and the switch has been lost.

• In Use: The port has at least one active call.

• Off Hook: The port is off-hook and has no active calls.

The following are the port Service states:

• In Service (green arrow up): The port is in service.
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• Out of Service (red arrow down): The port is out of service. 

On telephone ports, outbound calls cannot be made (no dial tone) and inbound 
calls will not be offered.

On trunk ports, outbound calls will not seize the trunk, and inbound calls are not 
answered. On loop start trunks, the trunk is seized to emulate a busy condition to 
the central office.

• Out of Service (operational) (red arrow down): The port is out of service due to a 
manual “put out of service” command.

Applies only to trunks. The trunk failed to seize. The switch automatically attempts 
to seize the trunk on a periodic basis. When successful, the trunk is automatically 
put back in service.

The following are the port Commands:

• Reset: Resets the port (puts the port out of service then automatically back in 
service). Active calls are dropped.

• Put in service: Puts the port back in service.

• Put out of service: Puts the port out of service. Active calls are dropped.

• Put out of service when idle: Puts an idle port out of service and puts an in-use 
port out of service when it goes idle. 

19.2.4 Hunt Groups Section
Double-clicking on a Hunt Group on the Switch Maintenance page shows the Hunt Groups 
edit page as shown in Figure 19-7. You can use the Command drop-down to busy out a 
hunt group or return it to normal service from this page.

Figure 19-7 Changing State of a Hunt Group

This section shows the number of Hunt Groups configured on the Switch, The information 
provided in the Hunt Groups section includes:

• Extension: The extension number of the hunt group.

• Description: The text name of the hunt group.

• Usage: The current usage state of the hunt group: Idle or Normal

• Service: Current service state of the hunt group: In Service, Out of Service, 
Unknown

• Command: Choose between Normal or Make Busy. Selecting Make Busy idles out 
the Hunt Group. 
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19.2.5 IP Phone Maintenance
The ShoreTel-120/24 Switch Maintenance page shown in Figure 19-8 has an additional 
section for IP phones. It shows how many IP phones are connected through the switch and 
the capacity of the switch. ShoreTel-120/24 switches can support as many as 120 IP 
phones, the ShoreTel 60/12 can support up to 60 IP phones, and the ShoreTel-40/8 can 
support up to 40 IP phones

Figure 19-8 IP Phones Section of Switch Maintenance Page

• Phones: Lists the number of IP phones on the switch.

• Usage: The current usage state of the IP phones: Idle or Normal

• Service: Current service state of the IP phones: In Service, Out of Service, 
Unknown

You can perform several functions on the IP phones connected to the switch by double-
clicking the IP Phones Maintenance link. Figure 19-9 shows the IP Phones Maintenance 
page.
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Figure 19-9 IP Phones Maintenance Page

You can view the service history of a phone by clicking on its name from the IP Phone 
Maintenance page.

19.2.6 SIP Trunks Section
The Switch Maintenance page shown in Figure 19-10 has an additional section for SIP 
trunks. This section shows how many SIP trunks are connected through the switch and the 
capacity of the switch.

Figure 19-10 SIP Trunks Maintenance Page

• Trunks: Lists the number of SIP trunks on the switch.

• Usage: The current usage state of the trunk group: Idle or Normal

• Service: Current service state of the trunk group: In Service, Out of Service, 
Unknown

19.2.7 Details Section
The following additional information is provided in the Details section:

• Last Boot Time: The last time the switch booted.

• Boot Source: Flash, FTP boot, or unknown boot source.

• Connect Time: The last time the server re-established a connection with the 
switch.

• Boot ROM Version: The boot ROM version number. Recommended 2.0.x.x or 
higher.

• Firmware Version: The firmware version number the voice switch is running. 

• CPU Board Version: The version number of the switch’s CPU board.

• Telephony Board Version: The version number of the telephony board.
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• Ethernet Negotiation: The rate at which the voice switch negotiated the Ethernet 
interface. Ethernet states include:

— 10: Half-Duplex
— 10: Full-Duplex
— 100: Half
— 100: Full

19.2.8 ShoreTel-T1 PRI and ShoreTel-E1 PRI Maintenance
When you click the name of a ShoreTel-T1 switch configured for PRI of the ShoreTel-E1 on 
the Switches Summary page, the Switch Maintenance page shown in Figure 19-11 appears.

Figure 19-11 ShoreTel-T1 PRI or ShoreTel-E1 PRI Switch Maintenance Page
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19.2.9 Quick Look Server Maintenance—Main Server
Click a server from the list on the Quick Look Server Maintenance page. The main server is 
shown in Figure 19-12. It is divided into three sections: Status, Services, and Events.

Figure 19-12 Quick Look Main Server Maintenance

19.2.9.1 Quick Look Server Status Area
The information displayed in the Status areas is as follows:

• TAPI States:

— OK—The TSP on the main server knows that the applications on the server 
have logged into TAPI

— Lost TAPI—The TSP on the main server knows that the applications on the 
server are not logged into TAPI.

• SMTP Send States:

— OK—The SMTP messages for the server are leaving.
— Failed—The SMTP outbound queue on the server is not sending e-mail 

messages. The SMTP transport is used to send voice messages between voice 
mail servers.

19.2.9.2 Quick Look Server Services Area
The Services area provides details about the ShoreTel services areas shown in Table 19-1.
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Clicking the ShoreTel service name takes you to a page used for starting or stopping that 
service, as shown in Figure 19-13.

Table 19-1 ShoreTel Service Areas

Name Description Details

ShoreTel-ACC ShoreTel Account Codes 
Collection Server

This service collects call information by 
account code and reports call activity in 
the call detail reports.

ShoreTel-CDR ShoreTel Call Accounting This service records call accounting 
information, call queueing data, and 
media stream data.

ShoreTel-CSISSVC ShoreTel CSIS Server This service manages communications 
between the server and ShoreTel 
Communicator.

ShoreTel-DTASSvc ShoreTel Distributed 
Telephony Application 
Service

This service provides connectivity 
between applications and instances of 
distributed TMS.

ShoreTel-DRS ShoreTel Distributed 
Routing Service

This service allows the ShoreTel system 
to scale beyond 100 switches.

ShoreTel-
EventWatch

ShoreTel EventWatch 
Server

This service monitors the event log and 
delivers e-mail notifications on certain 
events.

ShoreTel-IPCS ShoreTel IP Phone 
Configuration Service

This service automatically configures IP 
phones as they are inserted into the 
system.

ShoreTel-IPDS ShoreTel IP Phone Display 
Service

This service manages the IP phone 
display.

ShoreTel-MailServ ShoreTel Voice Mail 
Message Server

This service is part of the ShoreTel Voice 
Mail system.

ShoreTel-PortMgr ShoreTel Voice Mail Port 
Manager

This service is part of the ShoreTel Voice 
Mail system.

ShoreTel-
SoftSwitch

ShoreTel Software 
Telephony Switch

This is the ShoreTel call control software 
running the server generally used to 
host virtual users.

ShoreTel-TMS ShoreTel Telephony 
Management Server

This service provides the telephony 
platform for ShoreTel applications and 
services.

ShoreTel-Vmail ShoreTel Voice Mail 
Application

This service is part of the ShoreTel Voice 
Mail system.

ShoreTel-WGSvc ShoreTel Workgroup Server This service manages workgroups and 
queues.

ShoreTel-Zin ShoreTel Database 
Management Service

This service manages and updates the 
ShoreTel database.
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Figure 19-13 Service Maintenance Page

19.2.9.3 Quick Look Server Events
The Quick Look Events area provides a quick summary of event activity and lists all events 
that have been logged during the last two days—Today and Yesterday. Clicking the 
Application Log icon takes you to the Application Event Log maintenance page. See the 
"Event Log" on page 558 for more information.

The information displayed in the Quick Look Events area includes:

• Date: The day the event was reported: Today or Yesterday.

• Errors: The number of errors that were reported. Errors require your immediate 
attention.

• Warnings: The number of warning messages that were reported. Warnings alert 
you to potential errors.

• Informational: The number of informational messages that were reported. 
Informational messages provide the status of a service, switch, or port.

19.2.10Quick Look Server Maintenance—Distributed Servers
The Quick Look Distributed Server Maintenance page is shown in Figure 19-14. This page 
is hosted on a web site on the distributed server. The information provided is a subset of 
the main server maintenance page, since not all ShoreTel services run on the distributed 
server.
ShoreTel 12.2 555



System Administration Guide Chapter 19: Maintenance
Figure 19-14 Quick Look Server Maintenance—Distributed Server

19.3 Switch Connectivity
The Switch Connectivity page (Figure 19-15) lists all ShoreTel voice switches when 
Distributed Routing Service (DRS) is disabled. When DRS is enabled, the switch 
connectivity table is organized by site.
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Figure 19-15 Switch Connectivity Page

The Switch Connectivity page includes the following:

• Connectivity Grid: The following indicators provide information about the listed 
switch:

— Green (C) indicates that the switch is connected and communicating with 
other switches in the system.

— Yellow (U) indicates that the switch connectivity is unknown because it cannot 
communicate with TMS.

— Red (N) indicates that the switch has lost communications with the server.

For more detailed information about a switch, place the mouse cursor over the connectivity 
cell in question and status information is displayed in the status bar at the bottom of your 
browser.

19.4 Conference Ports
The Conference Ports page as shown in Figure 19-16shows the number of ports currently 
being used for conferencing and the number of free ports allocated for conferencing for 
each site in the system. The number of Make Me Conference calls active at each site is also 
shown. As with the Quick Look page, clicking on an entry in the Site column displays the 
Maintenance Switches Summary page described earlier in this chapter (refer to Figure 19-2 
on page 539).
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Figure 19-16 Conference Ports Page

There are two main section displayed on the Conference Ports page. The first is data about 
in-use ports and the second is data about free ports.

• In-Use

— Active Calls: Lists the number of calls active on the ports at a site
— Ports: The number of ports that are in use at each site.

• Free

— Ports: The number of ports that are free at each site.
— Percent: The percentage of total ports at a site that are currently free.

19.5 Event Log
All events are reported to and viewed from the System Event Log (Figure 19-17) and 
Application Event Log (Figure 19-18) maintenance pages. To refresh these pages, click the 
refresh link. Clicking the Quick Look link takes you to the Quick Look maintenance page, 
described in "Quick Look" on page 537.
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Figure 19-17 System Event Log Page
ShoreTel 12.2 559



System Administration Guide Chapter 19: Maintenance
Figure 19-18 Application Event Log Page

ShoreTel system events can also be viewed with the Windows Event Viewer.

Event categories for ShoreTel sources are reported to the applications log, in the following 
categories:

• Event Watch

• Java Client

• Java Server

• Notification

• Port Mapper

• Software Telephony Switch

• Switch

• System Management Database
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• System Management Interface

• Voice Mail Application

• Voice Mail Message Server

• Voice Mail Port Mapper

• Workgroup Server

19.5.1 Viewing Event Reports
To view an event report, click an entry in the Date column on the Services or Application 
Event Log page. The associated Event Info page is invoked as shown in Figure 19-19.

Figure 19-19 Event Info Page

The Event Info page provides the following information, from which you can ascertain the 
severity of the event:

• Source reporting the event

• Category of the event

• Event number

• Event description

• Date and time

• Event type (error, warning, or information)

Clicking the Go back link takes you back to the top-level event log (System or 
Application) page.

19.6 Services
The Services maintenance page, shown in Figure 19-20, lists all the services that reside on 
the server. It includes the name of the service, its description, and its operational status 
(running, not running, or paused).
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Figure 19-20 Services Page

To refresh the page, click the refresh link. Clicking the Quick Look link takes you to the 
Quick Look maintenance page, described in "Quick Look" on page 537.

Green, upward-pointing arrows indicate that the service or application is running. Red, 
downward-pointing arrows indicate that the service or application is not running or 
paused.

19.6.1 Service Maintenance Page
To start a service that is not running or paused, click the service name to invoke the Service 
Maintenance page, shown in Figure 19-21.
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Figure 19-21 Service Maintenance Page

From this page you can start or stop the service by clicking the Start or Stop button. 
Clicking the Quick Look link takes you back to the Quick Look maintenance page, 
described in "Quick Look" on page 537. Clicking the Go back link takes you back to the 
Services page.

19.7 Event Filters
Event filters specify the criteria for which e-mail notifications are sent after an event has 
been reported. The Event Filters list page, shown in Figure 19-22, displays a list of event 
filters that you create. You invoke this page by clicking Event Filters from under the 
Maintenance link in the navigation frame.

Figure 19-22 Event Filters List Page

The Event Filters list page provides the following information:

• Source: The name of the event source.

• Category: The category for the source.

• Event ID: The event number that is assigned to the filter.

• Type: The event type that is assigned to the filter.

• Server: The server that the event filter runs on.

• Email: The e-mail address that the filter reports to.

To view the parameters of an existing event filter, click its name in the Source column. 

19.7.1 Event Filter Parameters
The Event Filter edit page, shown in Figure 19-23, lets you create new and edit existing 
event filters. To add a new event filter, click add new on the Event Filters list page, or click 
New or Copy on the Event Filter edit page.
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Figure 19-23 Event Filter Edit Page

The parameters on the Event Filter edit are as follows:

• Server: This is the server that the event filter runs on. Click All or choose a server 
from the drop-down list.

• Source: These options define the event source for the filter. Select from the 
following:

— ShoreWare—Notifies about ShoreTel events. The associated drop-down list lets 
you select the ShoreTel category. Selecting Any reports events about all ShoreTel 
categories.

— Services—Notifies about any non-ShoreTel service.
— Other—Notifies about any event source.

• Category: This lets you select a category when the Services or Other option is 
selected.

• Event ID: This lets you select the event identification number that is referenced in 
the e-mail notification.

• Type: These options let you select the severity type:

— Error—Requires immediate attention.

— Warning—Alerts to potential errors.

— Information—Provides status of service, switch, or port.

— All—Notifies about all three types.

• Target E-mail Address: This is the e-mail address of the intended system 
administration or technical support entity.

19.7.2 Editing and Creating Event Filters
To create or edit an event filter:

Step 1 Open the Event Filters List page by selecting Maintenance -> Event Filters in 
the Navigation frame.

Step 2 To edit an existing filter, click the filter’s name in the Event Filters page. 
To create a new filter, click Add new.
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Step 3 Click All or choose a server from the Server drop-down list.

Step 4 Select a source by clicking the ShoreWare, Services, or Other option.

Sources may have more than one filter associated with them, depending on 
how you set the criteria. For example, the ShoreTel Event Watch service might 
have two or more filters, each having different event types assigned to them.

Step 5 Select a source and category based on the following:

• If the ShoreWare option is selected, select an event category from the 
Category drop-down list or select Any for all.

• If Services is selected, select a service from the drop-down list, as well as a 
category.

• If Other is selected, enter a service name, as well as a category.

Step 6 Enter an event number from the Event ID drop-down list or select Any.

Step 7 Select an event type by clicking the Error, Warning, Information, or All option.

Step 8 Enter an e-mail address in the Target E-mail Address field.

Step 9 Click Save to save the service’s filter criteria.

19.8 Database Maintenance
ShoreTel uses MySQL to manage the ShoreTel configuration and CDR databases residing on 
the Headquarters server. MySQL databases support the UTF-8 character set. All ShoreTel 
configuration and CDR data is stored in UTF-8 format.

NOTE ShoreTel supports Unicode Character sets by incorporating the v5.1 MySQL ODBC 
connector, resulting in databases that support Unicode Character sets. Support of 
Unicode character sets extends to the ShoreTel system and CDR databases. 
Although Director also supports Unicode Character sets, automatic population of 
some data entry fields depend on the character set of the originating data.

19.8.1 MySQL Services

19.8.1.1 Monitoring MySQL Service
ShoreTel reports MySQL service status on the Main Server Maintenance window. To access 
the Main Server Maintenance window, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Quick Look, the Quick Look page appears.

Step 3 Perform one of the following:

• Click the first site on the list, typically named Headquarters, and click the 
name of the Soft Switch.

• Click the name of the Main Server, typically named Headquarters Server.
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Figure 19-24 indicates the position of the MySQL service monitor on the Main Server 
Maintenance page. To restart the MySQL service, access the MySQL Command drop down 
menu on the right side of the page and select Start.

Figure 19-24 MySQL Service Monitor and Command – Main Server Maintenance 
Page

19.8.1.2 Browsing MySQL Database Tables
MySQL provides a query browser for viewing the database tables. The browser is available 
at http://dev.mysql.com/downloads/gui-tools/5.0.html

ShoreTel does not support MySQL tools or any problems arise from using these tools.

19.8.1.3 Compatibility with Backup and Antivirus Utilities
Running a virus checker or a backup utility (disk or file) on a MySQL database file causes 
the MySQL service to crash. 

When running these utilities, the MySQL database file (c:\Shoreline Data\Call 
Records 2\Data\[ibdata1, ib_logfile*]) and the folder C:\windows\temp must be 
included in the exclusion list.

19.8.2 MySQL Backup and Restore Utilities
MySQL provides utilities for backing up, restoring, and replicating MySQL databases. The 
following sections describe the processes for performing these functions.

19.8.2.1 Database Backup
The following command stores a backup copy of the ShoreTel configuration database:

(ShoreWare Path)(Command Path)\mysqldump.exe --user=root --
password=shorewaredba --add-drop-database --routines --single-
transaction --port=4308 --databases [database_to_backup]> 
[backupfile.sql]

where 

— (ShoreWare Path) is the location where ShoreWare was installed

— (Command Path) is the location of mysqldump.exe in the installation directory

— backupfile.sql specifies the proposed location of the created backup file.
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— db_name is either shoreware or shorewarecdr:

shoreware is entered to backup the configuration database

shorewarecdr is entered to backup the CDR database

Example: To backup the configuration file where:

• ShoreTel is installed at C:\Program Files\ShoreLine Communications\ShoreWare 
Server

• mysqldump.exe is located at C:\Program Files\ShoreLine 
Communications\ShoreWare Server\MySQL\MySQL Server 5.0\bin\

• The backup is to be placed at C:\shoreware_Bkup.sql

• The password is shorewaredba

Execute the following command line:

C:\Program Files\Shoreline Communications\Shoreware Server\MySQL\MySQL 
Server 5.0\bin\mysqldump.exe --user=root --password=shorewaredba --add-
drop-database --routines --single-transaction --port=4309 --databases 
[database_to_backup]> [backupfile.sql]

OR change directories, then run the executable:

>cd C:\Program Files\Shoreline Communications\Shoreware 
Server\MySQL\MySQL Server 5.0\bin\

>mysqldump.exe --user=root --password=shorewaredba --add-drop-database -
-routines --single-transaction --port=4309 --databases 
[database_to_backup]> [backupfile.sql]

MySQL provides documentation on database backup at:

http:/dev.mysql.com/doc/refman/5.0/en/disaster-prevention.html

19.8.2.2 Database Restore
The following command restores a backup copy of a ShoreTel configuration database as an 
active database:

(ShoreWare Path)\\(Command Path)\\mysql -u [username] -p [password] 
[database_to_restore] < [backupfile.sql]

where 

— (ShoreWare Path) is the location where ShoreWare was installed

— (Command Path) is the location of the mysqldump.exe within the installation 
directory

— backupfile.sql specifies the location of the backup file to be restored.

To restore a configuration file where:

• ShoreTel is installed at C:\Program Files\ShoreLine Communications\ShoreWare 
Server

• mysql.exe is located at C:\Program Files\ShoreLine Communications\ShoreWare 
Server\MySQL\MySQL Server 5.0\bin\

• the backup is located at C:\shoreware_Bkup.sql

• the password is shorewaredba
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Execute the following command:

C:\Program Files\Shoreline Communications\Shoreware 
Server\MySQL\MySQL Server 5.0\bin\mysql.exe --user=root --
password=shorewaredba --port=4308 [database_to_restore]< 
[backupfile.sql] 

OR change directories, then run the executable:

>cd C:\Program Files\Shoreline Communications\Shoreware 
Server\MySQL\MySQL Server 5.0\bin\

>\mysql.exe --user=root --password=shorewaredba --port=4309 
[database_to_restore]< [backupfile.sql]

19.8.2.3 Database Replication
MySQL provides a built in database replication tool. Refer to the following for information 
on setting up the database replication:

http://www.howtoforge.com/mysql_database_replication

Refer to the following for tools, and add-ons that can assist in database replication:

http://solutions.mysql.com/solutions/tools?type=25

The database replication tool is provided by MySQL. ShoreTel does not provide support for 
MySQL database replication.

19.8.2.4 Database Compacting
When database records are deleted, MySQL does not return the space recovered from the 
deletion. This results in a database that continues growing as records are added and 
replaced.

ShoreTel provides a compacting script that recovers unused space that was abandoned 
when records were deleted. Because the databases are not available during compaction, the 
script should only be run during scheduled maintenance activities.

To run the MySQL compacting script, open a Windows command prompt and executed the 
following script:

Program Files\Shoreline Communications\ShoreWare Server\MySQL\MySQL Server 
5.0\bin\CompactMySQLData.wsf

The script accepts one optional command line argument – the ShoreTel cdr archive 
database name. When this argument is not specified, the script uses the default name of 
shorewarecdrarchive. This argument is required only if the archive database name 
differs from the default.
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System Recovery

This chapter describes methods and tools that protect your system against computer 
failure. The topics discussed in this chapter include:

• "Backup and Restore" on page 569.

• "Configuring the Backup and Restore Script" on page 571.

• "Preliminary Procedure for Remote Devices" on page 573.

• "Backing Up the Headquarters Server" on page 574.

• "Backing Up Distributed Voice Mail Servers" on page 575.

• "Backing Up Voice Mail Switches" on page 576.

• "Backing Up Service Appliance 100s" on page 576.

• "Restoring the Headquarters Server" on page 577.

• "Restoring Distributed Voice Mail Servers" on page 578.

• "Using Batch Files" on page 579.

• "Failover Support" on page 580.

• "Failover and Restoration of IP Phones" on page 582.

20.1 Backup and Restore
ShoreTel recommends that you regularly backup the files on your headquarters server, 
distributed voicemail (DVM) servers, voicemail switches, and SA-100s. You can use the 
backed up files to restore the current hardware or upload the files to replacement hardware. 
A pre-prepared script is available for you to use to preform backup and restore on these 
ShoreTel devices. The script file is copied to a directory on the ShoreTel headquarters and 
DVM servers when you install the server software. You can use the script to back up the 
files listed in Table 20-1.

Table 20-1 Files that Are Backed Up

Headquarters Server
Distributed Voicemail 
Server Voicemail Model Switch Service Appliance 100 

/inetpub/mailroot /shoreline data /cf /cf
/intepub/ftproot /MessageFiles cfg.dat cfg.dat
/windows/my.ini /Prompts ShoreTel.cfg ShoreTel.cfg
/shoreline data /SoftSwitch
/MessageFiles /Templates
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The backup and restore script is designed to service a server site. The script backs up and 
restores only the server it is installed on but can be configured to backup and restore any 
voicemail switch and SA-100 in your system. You can use a batch file to intiate system-wide 
backups or restoration. Pre-prepared batch files are also installed in the folder with the 
backup and restore script that allow you to perform different types of backups. You can use 
a program such as Microsoft Scheduler to schedule automatic backups.

20.1.1 Estimated Backup and Restore Times
The time it takes to perform a backup or restore depends on many factors including how 
much information you have to backup or restore. This section provides an estimate of the 
time it takes to backup or restore different elements in the ShoreTel system for a couple of 
conditions. Actually times will vary depending on your configuration and environment.

The following is an estimate of time required by ShoreTel backup procedures:

• Clean System (No VM, CDR, or SA-100)

— Total – 379 secs 

— VM – 2 secs 

— CDR– 35 secs

• Loaded System (VM: 100 messages/13.5 MB; CDR: 500,000 calls)

— Total – 508 secs 

— Backup VM – 21 secs 

— Backup CDR – 104 secs

The following is an estimate of the time required to restore ShoreWare Server files:

• Clean System

— Total – 416 secs

— VM – 3 secs

— CDR – 32 secs

— SA-100 – 

/Prompts /Logs
/Scripts /Vms
/SoftSwitch
/Templates
/Call Records 2
/Database
/Logs
/Vms

Table 20-1 Files that Are Backed Up (Continued)

Headquarters Server
Distributed Voicemail 
Server Voicemail Model Switch Service Appliance 100 
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• Loaded System (VM: 100 messages/13.5 MB – CDR: 500,000 calls)

— Total – 525 secs

— VM – 22 secs

— CDR – 98 secs

20.1.2 Backup Strategy
When backing up a server, server activity must be stopped prior to backing up files to 
prevent file corruption. The procedures provided by ShoreTel stops server activity before a 
backup and restarts the server after the backup is complete. ShoreTel recommends backing 
up files during scheduled down times or periods of light activity.

When backing up an entire system, ShoreTel recommends starting with the distributed 
voice servers and backing up the headquarters server last. This allows the HQ to remain 
operational while other servers are unavailable. You can back up multiple distributed voice 
servers simultaneously. After the distributed voice servers are completed, backup the files 
on the headquarters server. This operational order minimizes the down time of the 
headquarters server.

20.1.3 Restoration
The ShoreTel backup and restore script and batch files perform all necessary steps to restore 
your HQ, DVMs, voicemail switches, and SA-100s. You can use these files to perform a 
complete restore or a select restore.

Operations and files received on a server after the backup was created are lost when files 
are restored to the server. When restoring a headquarters server, all files on distributed 
servers that do not require restoring remain intact; however, voicemail received for 
mailboxes created since the backup was created may be lost regardless of the server upon 
which they reside.

Server activity must be stopped while files are restored to a server. The ShoreTel backup 
and restore script stops the server before the restoring the files and restarts it after the 
restoration is complete. Files must be restored to a directory identical to the directory in 
which they were stored.

When restoring an entire system, ShoreTel recommends restoring the headquarters server 
first so as to establish a functioning system as soon as possible. After the headquarters 
server is restored, you can restore distributed servers while the headquarters server is 
active. This operational order minimizes the down time of the headquarters server.

Files can only be restored to the server from which they were backed up. Backup files from 
the headquarters server can restore only the headquarters server. For systems with more 
than one distributed server, backup files are not interchangeable between the servers.

20.2 Configuring the Backup and Restore Script
Before you can use the script for backup and restore, you must modify the file with the 
following information:

• Path of the backup destination folder.

• IP addresses of the voicemail switches for which you want the current server to 
initiate backup and restore.
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• IP addresses of the SA-100 for which you want the current server to initiate backup 
and restore.

• Drive letter where the script file is installed if changed.

• Path to the script file on the headquarters server or DVM if changed.

• Path on the server where the PLINK and PSCP are found if changed.

To configure the headquarters server and distributed voice servers to perform backup, do 
the following:

Step 1 On the desktop of the ShoreTel server that you want to use to perform a 
backup, click Start > Program Files > Shoreline Communications > 
ShoreWare Server > Scripts > Sample_Backup_Restore.

Step 2 Right-click sw_backup_restore.ini and select Edit. The Window.Install.Drive 
page appears.

Step 3 On the line “Window.Install.Drive=”, type the letter of the drive where the 
Windows operating system is installed. The default drive is C:.

Step 4 In the Back Options section, do the following to specify where you want to 
create the backup files:

Step a On the line “Backup.Drive=”, type the path for the volume to which you 
want to back the ShoreTel system files up.

Step b On the line “ShoreWare.Drive=”, type the letter of the drive on which the 
ShoreTel system files you want to backup are stored. The default value is C.

Step c On the line “Backup.Root.Directory =” type the path that you want to use 
for backing the files up. The default path is:

\Shoreware Backup\Backup

Step d On the line “Backup.Shoreware.Directory =” type the name of the file to 
which you want to back the files up. The default name is:

\Shoreline Data

Step 5 In the Shoreware File Location section, do the following to specify the location 
of the ShoreTel files on the current server:

Step a On the line “ShoreWare.Scripts.Root.Directory=”, type the path to where the 
ShoreTel headquarters server backup scripts are located. The default value 
is:

C:\Program files\Shoreline Communications\ShoreWare Server\Scripts

Step b On the line “ShoreWare.Scripts.DVM.Root.Directory=”, type the path to 
where the ShoreTel DVM server backup scripts are located. The default 
value is:

C:\Program files\Shoreline Communications\ShoreWare Remote 
Server\Scripts

Step 6 On the line “VMB.ip.list =”, type the IP addresses of the voicemail switches that 
you want this server to backup. Use a comma to separate the addresses.
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Step 7 On the line “UCB.ip.list =”, type the IP addresses of the Service Appliance 100s 
that you want this server to backup. Use a comma to separate the addresses.

Step 8 On the line “PLINK.CMD =”, type the path where the PLINK command can be 
found. The default is:

C:\Program files\Shoreline Communications\ShoreWare 
Server\Scripts\Sample_Backup_Restore\plink

Step 9 On the line “PSCP.CMD =”, type the path where the PSCP command can be 
found. The default is:

C:\Program files\Shoreline Communications\ShoreWare 
Server\Scripts\Sample_Backup_Restore\pscp

Step 10Click File > Save to save your changes.

20.3 Preliminary Procedure for Remote Devices
Backup and restore operations are initiated for voice mail switches and SA-100s as remote 
devices from the HQ or a DVM. To perform backup or restore an SSH connection must be 
established between the server and the remote device. PLINK and PSCP commands are 
used to access the remote device using an RSA key for validation. Before you can back up or 
restore files for a voicemail switch or SA-100, you must cache an RSA key in the registry of 
the server for each switch or SA-100.

To cache an RSA key for a voicemail switch or SA-100 in a server registry, do the following:

Step 1 Open the Command prompt on the server that you want to use to initiate 
backup and restore for the switch or SA-100.

Step 2 Type plink <IP address of the voicemail switch or SA-100>.

Step 3 Press Enter. The program returns a message indicating the storage status of the 
RSA key in the registry of the server. Figure 20-1 displays the messages if the 
key is not present.

Figure 20-1Caching the Registry Key By Using Plink.

Step 4 If the key is not cached to the registry, press y when prompted.

Step 5 Repeat Steps 2 through 4 for each remote device for which you want this server 
to initiate backup and restore operations.

C:\Shoreline Data\Database\Scripts\Sample_Backup_Restore.>plink 10.1.1.242

The server's host key is not cached in the registry. You have no guarantee that the server is 
the computer you think it is.

The server's rsa2 key fingerprint is: ssh-rsa 2048 
08:b0:43:35:fd:21:1b:c2:6b:27:b4:3f:a9:f7:be:2d

If you trust this host, enter "y" to add the key to PuTTY's cache and carry on connecting.

If you want to carry on connecting just once, without adding the key to the cache, enter "n".

If you do not trust this host, press Return to abandon the connection.

Store key in cache? (y/n) y

login as: ^C
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Step 6 Save and close the file.

20.4 Backing Up the Headquarters Server
This section describes how to backup your headquarters servers. It describes how do a 
complete backup of the server and a partial backup of the server.

NOTE Server activity must be stopped before backing up files to prevent corruption 
caused from modifying files during its backup. The processes provided by ShoreTel 
stop the server before the backup and restarts the server after the backup is 
complete. ShoreTel recommends backing up files during scheduled down times or 
periods of light activity.

20.4.1 Performing a Complete Backup
To perform a complete backup of your headquarters server, do the following:

Step 1 Access the command prompt on the headquarters server.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files (x86)\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_backup.wsf hq all

Press Enter.

20.4.2 Performing a Selective Backup
You can perform a backup of selected files. To use the headquarters server to backup 
selected files, do the following:

Step 1 Access the command prompt on the headquarters server.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_backup.wsf x y

where x is component type that you want to backup and y is the file type as 
shown in Table 20-2.

Press Enter.
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20.5 Backing Up Distributed Voice Mail Servers
This section describes how to backup your distributed voicemail servers. It describes how 
do a complete backup of the server and a partial backup of the server.

NOTE Server activity must be stopped before backing up files to prevent corruption 
caused from modifying files during its backup. The processes provided by ShoreTel 
stop the server before the backup and restarts the server after the backup is 
complete. ShoreTel recommends backing up files during scheduled down times or 
periods of light activity.

20.5.1 Performing a Complete Backup of a DVM
To perform a complete backup of a DVM, do the following:

Step 1 Access the command prompt on the DVM that you want to backup.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_backup.wsf hq all

Press Enter.

20.5.2 Performing a Selective Backup of a DVM
You can perform a backup of selected files. To use the headquarters server to backup 
selected files, do the following:

Step 1 Access the command prompt on the DVM that you want to backup.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Table 20-2 Backup Arguments

Component File Type
Argument  Definition Argument  Definition
hq Headquarters server db database (not valid if the 

server_type = dvm or vmb)
dvm Distributed Voice Mail server vm voicemail (not valid if server type 

= vmb)
vmb Voicemail Model Switch log log files (not valid if server type = 

vmb)
ucb Service Appliance 100 ucb conference bridge
ShoreTel 12.2 575



System Administration Guide Chapter 20: System Recovery
Step 3 At the prompt, type:

cscript.exe shoreware_backup.wsf x y

where x is component type that you want to backup and y is the file type as 
shown in Table 20-2 on page 575.

Press Enter.

20.6 Backing Up Voice Mail Switches
Backup of voice mail switches must be initiated on the headquarters server or a DVM. The 
backup script on the server must be modified to include the IP addresses of the voice mail 
switches that you want to backup (see the "Configuring the Backup and Restore Script" on 
page 571 for information about modifying the script file). This section describes how to 
backup voice mail switches.

Requirements

• Headquarters server or DVM to implement backup.

• sw_backup_restore.ini file on implementation server modified to include IP address 
of voice mail switch.

• Server able to establish an SSH connection with the voicemail switch.

To backup voice mail switches, do the following:

Step 1 Access the command prompt on the ShoreTel server that is configured to 
backup to the voice mail switches you want to backup.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_backup.wsf vmb all

Press Enter.

20.7 Backing Up Service Appliance 100s
Backup of SA-100s must be initiated on the headquarters server or a DVM. The backup 
script on the server must be modified to include the IP addresses of the SA-100s that you 
want to backup (see the "Configuring the Backup and Restore Script" on page 571 for 
information about modifying the script file). This section describes how to backup SA-
100s.

Requirements

• Headquarters server or DVM to implement backup.

• sw_backup_restore.ini file on implementation server modified to include IP address 
of voice mail switch.

• Server able to establish an SSH connection with the SA-100.
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To backup SA-100s, do the following:

Step 1 Access the command prompt on the ShoreTel server that is configured to 
backup to the SA-100s you want to backup.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_backup.wsf ucb all

Press Enter.

20.8 Restoring the Headquarters Server
This section describes how to use the ShoreTel backup and restore script to perform 
complete and selective restores to the HQ.

20.8.1 Performing a Complete Restore
To perform a complete restore of your headquarters server, do the following:

Step 1 Access the command prompt on the headquarters server.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_restore.wsf hq all

Press Enter.

20.8.2 Performing a Selective Restore
You can perform a restore of selected files. To use the headquarters server to restore selected 
files, do the following:

Step 1 Access the command prompt on the headquarters server.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_restore.wsf x y

where x is component type that you want to backup and y is the file type as 
shown in Table 20-2.
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Press Enter.

20.9 Restoring Distributed Voice Mail Servers
This section describes how to use the ShoreTel backup and restore script to perform 
complete and selective restores to DVMs.

20.9.1 Performing a Complete Restore of a DVM
To perform a complete restore of a DVM, do the following:

Step 1 Access the command prompt on the DVM that you want to restore.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, type:

cscript.exe shoreware_restore.wsf hq all

Press Enter.

20.9.2 Performing a Selective Restore of a DVM
You can perform a restore of selected files. To use the headquarters server to restore selected 
files, do the following:

Step 1 Access the command prompt on the DVM that you want to restore.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Table 20-3 Restore Arguments

Component File Type
Argument  Definition Argument  Definition
hq Headquarters server all
dvm Distributed Voice Mail server db database (not valid if the 

server_type = dvm or vmb)
vmb Voicemail Model Switch vm voicemail (not valid if server type 

= vmb)
ucb Service Appliance 100 ucb conference bridge

log log files (not valid if server type = 
vmb)
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Step 3 At the prompt, type:

cscript.exe shoreware_restore.wsf x y

where x is component type that you want to backup and y is the file type as 
shown in Table 20-2 on page 575.

Press Enter.

20.10 Using Batch Files
ShoreTel has created batch files that you can use to backup your ShoreTel components. The 
batch files are located in the same folder as the backup-and-restor script which they use to 
perform backups. These batch files allow you to backup or restore different ShoreTel 
components on the site including the following:

• Headquarters.

• Distributed voice mail.

• Voicemail Model Switches.

• SA-100s (UCBs).

To batch file commands for backup are as follows:

• hq_backup_all.bat

• dvm_backup_all.bat

• vmb_backup_all.bat

• ucb_backup_all.bat

The batch commands for restore are as follows:

— hq_restore_all.bat

— dvm_restore_all.bat

— vmb_restore_all.bat

— ucb_restore_all.bat

To use a batch file to backup or restore files, do the following:

Step 1 Access the command prompt on the ShoreTel server.

Step 2 Navigate to the directory where the ShoreTel backup and restore scripts are 
found. The default path is:

c:\program files (x86)\shoreline communications\shoreware 
server\scripts\sample_backup_restore

Step 3 At the prompt, enter the batch file that you want to use for backup or restore. 
Press Enter.

20.10.1Log Files
Log files display the commands that are performed during Backup and Restore operations 
at SwBackupRestore.log. By default, Windows maintains three log files.
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20.11 Failover Support
To provide high availability, ShoreTel supports failover at two critical points in the 
system structure. ShoreTel supports failover for the headquarters server and for voice 
switches. For the headquarters server, you can install a backup server that mirrors and 
monitors the primary server. If the primary server fails, operations are immediately 
transferred to the backup server with minimal interruption of telephony services. After 
the primary server is repaired, you must manually failback the secondary server which 
returns operations to the primary server and returns the backup server to the 
monitoring and backup role.

For switches you build in failover by setting up your system with extra port capacity or 
installing spare switches that can be activated within minutes to temporarily take on 
the phones that lose connection with the failed switch. Spare switches can be physically 
installed on a remote network from the failed switch and its phones, and may not 
provide the same level of service.

This section discusses failover at the server level. For more information about switch 
failover, see the "Failover for IP Phones: Spare Switch" on page 103.

To provide failover protection for ShoreTel servers, ShoreTel recommends that you use 
Double-Take. For complete information on implementing Double-Take failover 
protection, refer to the Double-Take application note available on the ShoreTel Website.

20.11.1Configuring a Secondary IP Address
After you have created a backup server for your system, you must designate the backup 
server for failover function. To designate a backup server for the failover function, do the 
following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Application Servers. The Application Servers page 
appears.

Step 3 Select the Headquarters Server. The Edit Server page for the Headquarters 
server appears as shown in Figure 20-2.

Figure 20-2Headquarters Edit Server Page
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Step 4 In the Secondary IP Address field, enter the IP address of the ShoreTel server 
that you want to use for failover.

To convert a system to single Headquarters Server mode, remove the address from the 
secondary IP address field, then reboot the Headquarters server.

When the primary and secondary servers are in different subnets, their IP addresses must 
be static.

The DNS server accessed by a ShoreTel system must associate the same server name to the 
primary and secondary servers if:

• The primary and secondary servers are configured with static IP addresses.

and

• The HQ server supports Communicator clients or clients on Citrix or Windows 
Terminal servers.

The primary and secondary Headquarters server cannot be running and connected to the 
network at the same time.

20.11.2Conditions during the Failover and Failback Operations
ShoreTel performs a failover operation when the primary server fails to transfer 
Headquarters server functions to the secondary server. After the failover operation is 
complete, the secondary server performs all Headquarters server functions.

The administrator can initiate a failback operation to restore Headquarters server function 
to the primary server. After the failback is complete, the system structure that existed 
before the failback operation is restored.

Failover and failback operations typically require between five to 20 minutes, depending on 
the system configuration. During these periods, no Headquarter server services are 
available. Failover and failback operation effects are resolved after the operations are 
complete and the secondary (for failover) or primary (failback) server is functioning as the 
Headquarters server.

Failover and failback operation effects on Communicator include:

• Users configured on the Headquarters server lose most connectivity capabilities, 
including telephony and video. IM connectivity is not affected.

• Users configured on distributed servers maintain all connectivity capabilities. 

• Configuration changes are unavailable.

• Users logging into Communicator while the secondary server controls the system 
must specify the IP Address of the secondary server.

Refer to the Communicator User’s Manual for instructions on specifying the server 
IP address.

Failover and failback operation effects on voicemail include:

• Sites that receive voicemail through the Headquarters server lose voicemail access.

• Mailboxes lose access to any voicemail that is routed through the Headquarters 
server.

• Sites that receive voicemail from distributed servers retain voicemail access.

Failover and failback operation effects on other system components include:
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• Account Code and Workgroup services are not available.

• Director, Web Client, and Communicator configuration changes are not available.

• If DRS is enabled, intersite calls are unavailable to users residing on sites whose only 
access to a DRS server is through the Headquarters’ DRS.

20.11.3System Failover Conditions and Requirements
After the failover operation is complete, the secondary server performs all distributed 
server and application connectivity activities managed by the Headquarters server. The 
following sections describe required administrator tasks after the failover operation.

20.11.3.1License Compliance
After a failover operation transfers Headquarters server control to the secondary server, 
license status on the secondary server is non compliant. To restore the system to 
compliance, reinstall all licenses that were originally purchased for the secondary server.

20.11.3.2Communicator Failover Requirements
To assure proper Communicator client operation and performance after a Failover or a 
Failback, the browser cache must be cleared. The system administrator should send 
messages to all MCM clients after a failover operation advising them to clear the browser 
cache on their devices.

20.11.4System Failback Conditions and Requirements
After the failback operation is complete, the primary server resumes all distributed server 
and application connectivity activities managed by the Headquarters server. The following 
sections describe required administrator tasks after the failback operation.

20.11.4.1License Compliance
After a failback operation transfers Headquarters server control to the secondary server, 
license status on the secondary server is non compliant. To restore the system to 
compliance, reinstall all licenses that were originally purchased for the secondary server.

20.11.4.2MCM Failback Requirements
To assure proper MCM client operation and performance after a failback, the browser cache 
must be cleared. The system administrator should send messages to all MCM clients after 
failback procedures advising them to clear the browser cache on their devices

20.12 Failover and Restoration of IP Phones
When you enable the system parameter to failover IP phones, IP phones will automatically 
failover to another switch on the same site or to a spare switch when they lose connection 
with their primary switch. The spare switch is designed as a temporary measure to ensure 
that IP phone users have basic phone connectivity should their primary switch fails. To 
ensure that users have their full connectivity, you must repair or replace the failed primary 
switch as soon as possible. This section describes how to restore normal operation after a 
failover occurs. This discusses the following topics:

• "Re-assigning the Primary Switch Profile to a Replacement Switch" on page 583.
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• "Moving IP Phones to Primary Switch" on page 583.

• "Failing Back the Spare Switch" on page 584.

• "Verifying Spare Switch Return Status" on page 585.

20.12.1Re-assigning the Primary Switch Profile to a Replacement 
Switch
If you must physically replace a primary switch that fails, you can re-assign the original 
switch profile to the new physical switch rather than create a new profile. This section 
describes how to re-assign the switch profile. 

Requirements:

• Obtain a replacement switch that has the same capabilities as the failed switch.

• Physically install the replacement switch on the same network as the old switch.

• Assign the new switch an IP address. Refer to the x for more information about.

• Unplug the port connections (telephones, trunks) from the existing voice switch and 
plug them into the new voice switch.

To re-assign the switch profile:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears.

Step 3 Select the voice switch that is being replaced. The Edit Switch page for the 
switch appears.

Step 4 In the IP Address field, enter the IP address (or Ethernet address) of the new 
switch that you want to use to replace the downed switch. 

NOTE You can also use the Find Switch button.

Step 5 Select the new voice switch and click Save. It can take up to two minutes for 
the switch to come on line.

NOTE You can use Quick Look to confirm that the new voice switch is on line. 

20.12.2Moving IP Phones to Primary Switch
To move IP phones from the spare switch to the primary switch, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > Individual IP Phones. The IP Phones page 
appears as shown in Figure 20-3.
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Figure 20-3IP Phone Page

Step 3 In the By Sites field, select the site where the failover has occurred and you 
want to perform restoration.

Step 4 In the Use the Switches field, select All Switches.

Step 5 In the Show Pages field, select the page that contains the IP phones that you 
want to move. The first name and the last name of the phones listed on the 
page are shown in the field along with the page number.

Step 6 Use the Site column to identify phones that have failed over to the spare switch 
that you want to move to the primary switch and check the check box to the 
left of the phone names (the MAC or IP address are often used as name).

NOTE You can select multiple phones to move at one time. The phones do not 
have to be registered to the same switch.

Step 7 In the field to the left of the Move button, select the switch to which you want 
to move the IP phones. 

Step 8 Click Move. The phones are moved to the target primary switch.

NOTE Calls that are currently in progress are dropped during the move.

20.12.3Failing Back the Spare Switch
After you move the IP phones to the primary switch on the site, you must manually 
failback the spare switch. To failback the spare switch, do the following:
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Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Quick Look. The Quick Look page appears.

Step 3 Select the site where the failover occurred and to which the spare switch is 
currently assigned. The Voice Switches and Service Appliances Summary page 
appears similar to Maintenance Summary page shown in Figure 20-4.

Figure 20-4Maintenance Summary Page

Step 4 In the Spare Switches section, identify the spare switch to fail back and in the 
Command column field, select Failback. The failback process starts.

NOTE Make sure that zero (0) IP phones are connected to the switch. (The 
listing in the IP Phones column should be 0/N where 0 is the number of 
phone currently registered with the switch and N is the switch capacity.)

The process takes a few minutes to complete and includes rebooting the spare switch. 
When the process is complete and successful, the spare switch returns to the spare state.

20.12.4Verifying Spare Switch Return Status
To verify that the switch has returned to the spare state, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform > Voice Switches/Service Appliances > 
Spare. The Spare Voice Switches page appears.

Step 3 Verify the following columns:

• The Current Site column is empty.

• The IP Phones in Use column lists zero (0).
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Reporting

ShoreTel Director allows you to generate reports from information gather throughout the 
ShoreTel system. You can generate activity reports about several topics as Call Detail 
Record (CDR) and about Web conferences. You can also set management parameters for 
handling reports such as setting up alternative report output, enabling archiving, and 
setting language parameters. This chapter provides information about the reporting 
capabilities of the ShoreTel system. The topics discussed include:

• "Accessing the Call Details Reports Page" on page 587.

• "Web Conference Reports" on page 589.

• "Options" on page 590.

• "Supporting Asian Fonts" on page 591.

• "Configuring Send CDR Out SMDR Interface" on page 592.

21.1 Accessing the Call Details Reports Page
To access the CDR page, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Reports > Call Details. The Call Details Report page appears as shown in 
Figure 21-1. This page is the primary method of accessing and viewing the 
CDR data in the MySQL database.
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Figure 21-1 Call Details Report Page

Step 3 In the Please select... field, select the report that you want to run.

Reports can be run from ShoreTel Director. After the report has been generated, it can be 
printed, exported, and navigated interactively, similar to compiled reports. 

NOTE No more than two users should run reports at the same time. Having more than 
two people generating reports simultaneously can adversely impact system 
performance.

21.1.1 Call Details Reports Page

21.1.1.1 Reports section

• Please select the report you want to run: This drop-down lists all of the different 
types of reports that can be run. Options are:

— Account Detail Report
— Account Summary Report
— Media Stream Detail Report
— Media Stream Summary Report
— Trunk Activity Detail Report
— Trunk Activity Summary Report
— Workgroup Queue Summary Report
— Workgroup Service Level Summary Report
— User Activity Detail Report
— User Activity Summary Report
— Workgroup Agent Detail Report
— Workgroup Agent Summary Report
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Refer to Appendix B for more information.

21.1.1.2 Parameters Section

• Enter the account code(s) you want to report on: Account codes are typically used 
to assist ShoreTel users in the billing of their clients (for example, a law firm 
tracking the length of a call). Enter the account code(s) that corresponds to one or 
more clients in the field provided and click the Add button to enter the number.

• Enter the extension, or range of extensions, you want to report on: Enter a single 
extension or a range of extensions in the fields provided to generate a report on 
only those extensions. You can also leave the fields blank to run the report on all 
extensions. You can enter an upper or lower extension and then select the No 
lower value or the No upper value radio button and to run a report on all 
extensions up to a specified extension.

• Enter the date range you want to report on: Click on the Calendar icon to select a 
Start of Range date and/or a End of Range date in the fields provided to generate a 
report on only those extensions.

Select the No lower value radio button and the No upper value radio button to run 
a report on run a report on all valid dates for which the system has CDR data.

• Enter the time range you want to report on: Click on the Start of Range radio 
button and use the drop-down menus to select the start time for the report. Click 
the End of Range radio button and use the drop-down menus to select the outside 
time limit for the report.

Select the No lower value radio button and the No upper value radio button to run 
a report on run a report on all hours within the specified dates.

21.2 Web Conference Reports
Director can also be used to generate Web Conference Reports from a local host or a remote 
server.

To generate Web conference reports do, the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Reporting > Reports > Web Conference. The Web Conference Report 
page appears as shown in Figure 21-3. 

Figure 21-2 Web Conference Reports Page
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Reports can be generated based on the date of the conference, the type of device 
(conference bridge or Service Appliance), or the access code assigned to scheduled 
conferences.

NOTE This process may cause some implementations of Microsoft Internet Explorer 8 to 
fail. If downloading Web report files causes your implementation of Microsoft IE8 
to fail, enable the IE8 security parameter “Websites in less privileged web 
content zone can navigate into this zone.” To navigate to this parameter in IE 8, 
click Tools > Internet Options >Security Tab >Local Intranet > Custom Level. 
Scroll down the page to the parameter and click Enable.

21.3 Options
The Reporting Options page as shown in Figure 21-3 is accessed by clicking on the Options 
link under Reporting.

The ShoreTel system supports the ability to send CDR data out a serial port on the main 
ShoreTel server. The Reporting Options page allows a system administrator to designate 
which COM port to enable. CDR data is subsequently sent out this port (in addition to 
being sent to the regular text file and/or a database). Sending the CDR data out the serial 
port does not change the formatting.

Figure 21-3 Reporting Options Page

The Reporting Options Page is described as follows:

• Refresh this page: Click this link to update the information displayed on the page. 
The Reporting Options page automatically updates every 60 seconds.

• COM Port for CDR Output: Select the desired COM port on the headquarters 
server when CDR data will be sent. The default value is none, with a valid range of 
1 – 10.

• Retention Period for CDR Archive: This value ranges from 1 day to 2000 days. 
Default value is 125 days.

• Retention Period for CDR Data: This value ranges from 1 day to 2000 days. 
Default value is 125 days.

• Enable Archiving: Select this check box to enable archiving. 

• Archive Database Name: Enter the name of the archive database. Saving the name 
of the database will not create the archive database; a separate utility must be used.
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See the "Creating the Archive Database" on page 593 for details on creating an 
archive database.

• Archive Database IP Address: Enter the IP address of the server where the archive 
database is stored.

• Select Language Variant: The field specifies the Asian Font that is supported on the 
computer running Director. Refer to "Supporting Asian Fonts" on page 591 for 
more information.

21.4 Supporting Asian Fonts
Ascender Corporation provides four font files (Arial Unicode for ShoreTel, Arial Unicode 
for ShoreTel Bold, Arial Unicode for ShoreTel Italics, and Arial Unicode for ShoreTel Bold 
Italics) for three languages: Japanese, Simplified Chinese, and Traditional Chinese. Only 
one set of files – supporting one language – can be installed on a computer at any time.

To install a font on a machine where web reports are required, perform the following:

Step 1 Open the Edit Reporting Options page by selecting Reporting -> Options from 
the Directory Main Menu. Figure 21-4 displays the Edit Reporting Options 
page.

Figure 21-4 Reporting Options Page

Step 2 Select the desired language from the Select Language Variant drop-down menu.

Step 3 Press the Install Fonts button. ShoreTel installs the requested font set on the 
computer.

Chinese Traditional font is installed on the Headquarters server by default. Access reports 
from a client machine or using a different Asian font requires a font installation through the 
Reporting Options page.
ShoreTel 12.2 591



System Administration Guide Chapter 21: Reporting
21.5 Configuring Send CDR Out SMDR Interface
The ShoreTel system captures CDRs in a database in a text-file format. However, for legacy 
call accounting systems that cannot read CDR from a database, the CDR data can be 
delivered as a Station Messaging Detail Record (SMDR) using a serial (COM) port on the 
main ShoreTel server. When using SMDR, the following applies:

• Formatting of the CDR data remains the same, regardless of whether it is sent out 
the COM port or written to the database.

• The application should auto-detect the serial port configuration by extracting 
information about the status of the serial port configuration (e.g. baud rate) from 
the Windows registry.

• The feature will be disabled by default and must be enabled by selecting a COM 
port.

• If the serial port should become unavailable through an event such as becoming 
locked by extremely high volumes of traffic, the CDR data will be queued in a 
buffer for 300 seconds to help prevent the loss of data. If the serial port returns to 
service within the 300-second time period, the streaming will resume.

To designate a COM port in order to send CDR Out SMDR Interface via ShoreTel Director:

Step 1 Launch ShoreTel Director.

Step 2 Click Reporting > Options. The Reporting Options page appears.

Step 3 Click COM Port. The CDR Output drop-down menu appears as shown in 
Figure 21-5. 

Figure 21-5 Selecting the desired COM port

Step 4 Select the COM port that you want to use for SMDR on the headquarters server.

Step 5 Click Save to store your changes. 

After the COM port is configured, the system directs CDR data to the SMDR port as calls 
move through the system.
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21.5.1 Creating the Archive Database
The following procedure describes the process of creating a separate (optional) archive 
database using the MakeCDRArchive.exe command line utility.

Step 1 On the ShoreTel headquarters server, navigate to C:\Program Files\Shoreline 
Communications \ ShoreWare Server and make sure the following files are 
installed in the same directory:

• MakeCDR.dll

• MakeCDR.sql

• MakeCDR_sp.sql

Step 2 Open the command prompt window in the directory shown above and run the 
following command:

MakeCDRArchive  -s localhost -d databasename

• Databasename is the name of the archive database to be created. The 
database name must be the same as the name created on the Options page.

• If no name is defined, the default name of shorewarecdrarchive will be 
created within the following directory:
C:\Shoreline Data \ Call Records2 \ Data

Records from main database will be archived to the archive database when the 
services start up and every night at approximately 12 a.m.

NOTE Instructions for installing MySQL on a secondary server is provide in the "MySQL 
Database" on page 616
ShoreTel 12.2 593



System Administration Guide Chapter 21: Reporting
594



A P P E N D I X A

Emergency Dialing Operations

This chapter explains the chain of events in the call flow when a emergency call is placed. 
This chapter also provides instructions for configuring your ShoreTel system to ensure that 
emergency services are dispatched to the correct location. And finally, the chapter tells you 
how to select which of the various pieces of caller ID information will be used to identify 
callers when an emergency call is placed. The topics discussed in this chapter include:

• "How Emergency Calls Work" on page 595

• "Using a PS/ALI Service Provider" on page 597

• "Feature Operation" on page 598

• "Selecting Caller ID Type for Emergency Calls" on page 600

• "Configuring Your System" on page 604

• "Planning Your Emergency Response" on page 609

• "International Emergency Numbers" on page 611

• "Verifying Your Emergency Configuration" on page 612

• "Additional Recommendations" on page 612

A.1 How Emergency Calls Work
This section provides a simple scenario of how emergency calls are handled with the 
ShoreTel system. Figure A-1 displays a simple emergency call-flow scenario.

Figure A-1 Simplified Emergency Call Flow Scenario
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A.1.1 Emergency Call Scenario
The following is a description of the call flow depicted in the figure.

1. A emergency call is placed from a ShoreTel desk phone.

2. The ShoreTel system identifies the call as an emergency and automatically routes it to an 
outbound trunk. Caller ID information is provided in either of the following ways:

• When the call is sent over a PRI trunk, the ShoreTel system provides caller ID 
information.

• When the call is sent over a non-PRI trunk, the service provider provides caller ID 
information.

3. The call is passed over the Public Switched Telephone Network (PSTN) to the exchange 
of the service provider.

4. The service provider passes the call to a Public Safety Answering Point (PSAP). This is 
the location of the emergency services dispatcher.

5. The dispatcher at the PSAP gets a “screen pop” which displays information contained in 
a emergency database. The database contains a mapping between the caller ID number 
and the geographic location of the caller.

6. The dispatcher sends emergency response personnel to the calling party’s location.

For emergency calls placed from residential or a single-site businesses, determining the 
location of the calling party is fairly simple and straightforward. However, when dealing 
with large offices and campus environments, your emergency configuration can get 
complex. If you are maintaining a configuration that has many remote sites, it is imperative 
that you do the following:

• Keep your emergency information current with your PSAP.

• Work with your service provider to find out what kinds of caller ID information 
they will accept.

• Work with the local PSAP to ensure that any changes in your emergency 
configuration (i.e. names, phone numbers, locations of the members) are mirrored 
in the PSAP’s database.

A.1.2 Roles and Responsibilities
Each participant in an emergency call has a different role to fill and a different set of 
responsibilities to handle.

The role of the PBX is to:

• Identify the call as an emergency call.

• Route the call to an outbound trunk. (Preferably a dedicated trunk.)

• Pass the correct caller ID information to the exchange of the service provider when 
a PRI trunk is used to send the call.
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The role of the exchange of the service provider is to:

• Work with the customer to ensure the correct caller ID number is passed to the 
PSAP.

• Pass the caller information to the PSAP.

NOTE The billing number of the trunk is used if no other caller information is 
available.

The role of the PSAP is to:

• Receive emergency calls.

• Host a database that maps the caller ID numbers to the physical location of the 
users.

• Display information about the calling party to a dispatcher.

• Send the proper emergency response personnel to the caller’s location.

The role of the customer (i.e. you) is to:

• Decide which type of caller ID information best fits your needs for emergency calls.

• Work with the service provider to verify that they will accept your preferred type of 
caller ID information.

• Communicate any changes to your emergency configuration to ensure the PSAP is 
current.

A.2 Using a PS/ALI Service Provider
In addition to working with your local PSAP to provide accurate logistical information, we 
recommend that you subscribe to a Private Switch/Automatic Location Information (PS/
ALI) service provider as well.

A PS/ALI service provider maintains a database that stores specific address information for 
each extension or DID on your system. Subscribing to PS/ALI services ensures that accurate 
automatic number identification (ANI) information is passed to the PSAP in the event of an 
emergency call, and prevents the emergency responder from showing up at the wrong 
location.

A subscription to a PS/ALI service provider is particularly recommended in situations 
where a ShoreTel system is deployed in an environment where a single PRI is used to serve 
multiple locations (for example, if a single PRI is used for several schools in the same 
district). In such environments, it is possible for a user to make an emergency call from one 
of the elementary schools and have the emergency crews dispatched to the wrong location. 
This can happen if the local trunks are busy and the call gets routed across an analog trunk 
and across the WAN to the first available PRI, which might be at one of the other schools in 
the district. With no PS/ALI database to provide accurate information about the origination 
of the call, the emergency services providers see the call originating at the wrong 
location.While the correct phone number is sent to emergency services, the association is 
with the PRI instead of the school where the call originated.

This critical error can be prevented if a PS/ALI database is in place. Such a database 
(maintained by a PS/ALI service provider) can identify the location associated with a 
specific DID.

NOTE ShoreTel does not provide PS/ALI service. Contact the local telco carrier for 
information about PS/ALI service providers in the relevant areas.
ShoreTel 12.2 597



ShoreTel Administration Guide Appendix A: Emergency Dialing Operations
A.3 Feature Operation

A.3.1 Digit Collection for Emergency Calls
A ShoreTel user who dials an emergency number (or <access_code> + emergency number) 
will be routed to an emergency-capable trunk.

• If the user dials an access code followed by an emergency number, digit collection 
terminates immediately and the call is routed to an emergency-capable trunk.

• If the user forgets to dial an access code before dialing the emergency number, the 
system waits five seconds before routing the call to an emergency-capable trunk. 
This pause has been introduced to eliminate accidental calls to the emergency 
number. 

NOTE Systems that use 911 for the emergency number often also use 9 as an 
access code for outbound calls. This makes it easy for users to mistakenly 
dial 911 on a long-distance call by adding an extra 1 before the area code 
(for example, if he or she dialed the following number 9-1-1-408-555-
1212). If additional digits are entered after 9-1-1 during the five-second 
timeout period, the system will consider it a dialing error and the calling 
party will hear a reorder tone.

A.3.2 Ensuring Proper Routing of Emergency Calls
Without a dedicated emergency-enabled trunk, emergency calls may not be properly routed 
under the following circumstances:

• If all available emergency-enabled trunks are busy, the ShoreTel system will not 
route the emergency call.

• If a site has no emergency-enabled trunk and ‘Parent as Proxy’ is enabled for that 
site, the ShoreTel system will not route the call to the emergency-enabled trunks of 
the parent site if the admission control bandwidth is exceeded at either site.

• If the SIP tie-trunk is unavailable, the ShoreTel system will not failover and route 
the call through the parent site when the following are true:

— The site is connected to the parent site by an emergency-enabled SIP tie-trunk.

— Parent as proxy is enabled for the site.

— The site has no available emergency-enabled trunk.

NOTE At sites with multiple trunks, the trunk selection order is SIP, ISDN, Digital, 
Analog. Additionally, when trunk groups are configured in the ShoreTel system, 
the default programming enables emergency services in each trunk group.

System administrators should consider that emergency calls will be routed over SIP if a SIP 
trunk is available and are encouraged to configure a dedicated, non-SIP, non-emergency 
trunk and disable Emergency Services in SIP Trunk Groups.

IMPORTANT A dedicated emergency-enabled trunk must be configured at each site to 
ensure emergency calls always reach the CO and PSAP.

Call permissions are ignored when an emergency call is placed to ensure that a user can 
dial emergency number from any extension on the system, regardless of the permissions 
associated with that user or the extension from which he or she is calling.
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Once the user dials an emergency number, the call leaves the extension, arrives at the 
switch, and is routed to any available emergency-capable trunk at the originating site. If the 
user belongs to a user group that does not have access to any emergency-capable trunks, 
then the call will not be placed.

WARNING When adding users to the ShoreTel system, make sure each user is placed in a 
user group that has access to an emergency-capable trunk group. If a user is 
placed in a user group that does not have access to an emergency-capable 
trunk (e.g. a user group with long distance trunks only), members of that 
user group will not be able to dial emergency numbers, and they will get a 
reorder tone when attempting to do so.

To better understand this, you must realize that users are placed into user groups when 
added to the ShoreTel system. The user groups are assigned to trunk groups, and these 
trunk groups have different capabilities, one of which is the ability to place emergency 
calls. If a user belongs to only one user group, that group must have access to an 
emergency-capable trunk. It is crucial that each site have at least one emergency-capable 
trunk.

For details on adding users to a user group that has access to an emergency-capable trunk, 
see "User Groups" on page 325.

Always confirm with your service provider that a trunk supports emergency calls. In some 
instances, this may not be the case (for example, with long-distance trunks). If the trunk 
does not support emergency, be sure to un-check the emergency parameter as an available 
service in the associated trunk group in Director.

If you have mistakenly set up a site that has no available emergency-capable trunks, 
emergency calls will be routed to the emergency-capable trunk at the proxy site if one has 
been designated. By routing the call to a proxy site, the ShoreTel system is making a “last 
ditch” attempt to place the emergency call. This failover behavior can be unreliable and 
should not be relied upon to ensure that users on your system can dial emergency 
numbers. If you use the “parent as proxy” configuration, make sure the boundary between 
the two sites never traverses geographic locations that would send an emergency call to the 
incorrect emergency-service provider. For example, if improperly configured, a caller in 
Houston could pick up a phone, dial 911, and reach a 911 service in Boston because the 
system was configured to have the Boston site as the parent of the Houston site with 
“parent as proxy” checked.

Each site should have at least one emergency-capable trunk. If there will only be one trunk 
at a particular site, that trunk should be capable of placing an emergency call. You should 
also be aware that if there is only one trunk at a site, only one emergency call can be placed 
at a time. Therefore, you should make sure you have enough emergency trunks at each site 
to accommodate the (realistic) potential emergency traffic for that site.

WARNING If ShoreTel VPN phones are to be deployed in locations that are different from 
the site with which they are associated, placing an emergency call from a 
ShoreTel VPN phone needs special consideration. 

In the default case, an emergency call dialed from a VPN phone will be sent to 
the PSAP associated with the site that hosts the switch and VPN concentrator. 
The emergency call would be answered but likely by a response center that is 
out of area for the VPN phone user which could delay or prevent an 
appropriate response.

ShoreTel strongly recommends that you deploy a 3rd party solution that can 
send a VPN phone's emergency call to the appropriate response center. 
Otherwise you should clearly mark VPN phones to alert users that emergency 
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calls should not be attempted from such phones and you should educate your 
VPN phone users about the emergency-number limitations of the VPN 
phone. 

A.3.3 Trunk Signaling for Emergency Calls
When an emergency call is routed out an analog or digital loop-start or a digital wink start 
trunk, the service provider is responsible for passing caller ID information to the PSAP.

When an emergency call is routed through a T1 PRI trunk, the ShoreTel System sends the 
proper caller ID information to the service provider, and the service provider must forward 
the information to the PSAP.

Contact your local telecommunications service provider to communicate your emergency 
implementation plans and have them approved. It is important to ensure that the service 
provider will accept, and subsequently pass to the PSAP, the caller ID information 
configured within the ShoreTel system. In some cases, without proper planning, a provider 
will reject the caller ID information as configured in the ShoreTel system and will simply 
pass the caller ID information associated with the trunk to the PSAP. If this happens, the 
dispatcher may get a number telling them to go to the wrong location.

User’s have a “home port” defined in ShoreTel Director. If a user is not at his home port, it 
could change the caller ID number delivered to the service provider on emergency calls.

For mobile workers who travel between sites, the user must have access to an emergency-
capable trunk at every site. In remote locations, the user should use the emergency trunk 
associated with that remote location.

A.4 Selecting Caller ID Type for Emergency Calls
There are a number of different caller ID choices available within ShoreTel that can be used 
by the PSAP to identify callers when they place an emergency call. The list below 
summarizes the available choices for sending the caller ID to the service provider for 
emergency calls. Options are listed in the order of precedence, meaning that if the first item 
on this list is not configured within the ShoreTel system, then the next piece of information 
on the list will be sent. Additional details about each of these caller ID options appears after 
the list.

1. User’s Caller ID number

2. User’s Direct Inward Dialing (DID) number

3. Caller’s Emergency Service Identification ID (CESID) for an IP address range

The CESID is the telephone extension that a switch sends to a Public Safety Answering 
Point (PSAP). A CESID helps to locate callers who require emergency services.

4. CESID of the controlling switch

5. CESID of the site

6. Nothing sent by ShoreTel system (the service provider sends the caller ID number 
associated with the trunk)

For details on selecting the best choice for your situation, refer to "Available Caller ID 
Options" on page 601.

If you are configuring a system in the Netherlands, please see "Special Considerations for 
Netherlands" on page 611.
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A.4.1 Available Caller ID Options
User’s Caller ID number – Each user can be assigned a caller ID number that will identify 
him during outbound calls. This caller ID number is typically used for outbound calls from 
the ShoreTel system when you do not want the receiving party to know the calling party’s 
DID number. For example, an ACD agent may use caller ID to ensure that returned calls 
will go to a queue of sales agents, rather than directly to his desk. Similarly, this caller ID 
number can be sent to the service provider to identify the user when he places an outbound 
emergency call. The user’s caller ID number is a very specific way of identifying the 
location of an individual user and is therefore likely to become less accurate over time as 
the PSAP’s emergency database becomes out of date. Sending the CESID for outbound 
emergency calls is best for smaller organizations (see Figure A-2) and is defined on the 
User Edit page. You must select the “Send Caller ID as Caller’s Emergency Service 
Identification” check box on the user group page.

In the scenarios described above and below, the user’s caller ID number will only be sent 
when the user is at his home port. If the user is not at his home port, then the next available 
caller ID type is sent.

User’s DID number – The DID number (Direct Inward Dialing) is the number someone 
dials from outside the ShoreTel system to reach a user at her desk. The DID is what most 
people would consider to be a “normal” telephone number. This DID number can be sent 
to the service provider to identify the user when she places an outbound emergency call. 
Although this is the most granular way of identifying users, it is also the most likely to 
become out of date in the PSAP’s emergency database as people come and go. Sending the 
DID number for outbound emergency calls is most appropriate for smaller organizations 
(see Figure A-2) and is defined on the User Edit page. You must select the “Send DID as 
Caller’s Emergency Service Identification” check box on the user group page.

Figure A-2 Caller ID Options for Small Offices

CESID of the Specified IP Address Range – The CESID of an IP address range can also be 
delivered to the service provider during outbound emergency calls. A single CESID number 
is assigned to a range of IP addresses such that any IP phone that has an IP address that 
falls within the specified range will have this CESID sent for outbound emergency calls. 
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This option works best for identifying a phone in an office that has many floors and many 
extensions. Typically, a specific IP address range is configured for each floor of a building so 
that all users on that floor use the same CESID for emergency calls.

If a DHCP server is present, an IP phone will automatically receive an IP address within the 
specified range when it is connected to the network.

Sending the CESID for a specified IP address range for outbound emergency calls works 
best for larger organizations where simply identifying the site’s street address would not 
provide enough information for an emergency response team to locate the caller (see 
Figure A-3). Furthermore, this option offers the best flexibility, the highest accuracy, and is 
the least likely to become out of date in the PSAP’s emergency database. This option is 
defined on the IP Phone Address Map page.

Figure A-3 IP Address Mapping – Best for Larger Offices

CESID of the controlling switch – Similar to the previous option, the Caller’s Emergency 
Service Identification ID (CESID) of the controlling switch can also be sent to the service 
provider during outbound emergency calls. With this option, a CESID number is assigned 
to a phone switch and for any phone plugged into this switch, the switch’s CESID is sent 
for outbound emergency calls. This option is best for larger organizations in which users 
are calling from analog phones (see Figure A-3). Using the IP Phone Address Map method 
will not work with analog phones. This approach ensures that the emergency response 
team is sent to the approximate vicinity of the calling party. This option is defined on the 
Switch Edit page.

Site (Caller's Emergency Service Identification (CESID) – This option delivers the CESID 
associated with the site to the service provider during emergency calls. This approach 
might not be granular enough for larger enterprises, but it could work well for single-site 
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organizations or for situations in which it would be adequate to provide the emergency 
response personnel with a building address. This option is defined on the Site Edit page. 
(See Figure A-4).

Figure A-4 Send the Site CESID for Medium-Sized Offices

Table A-1 shows several common customer scenarios and provides recommendations for 
how E911 should be configured, along with reasons why that is the preferred 
configuration. 

Rules and regulations for E911 vary from one region to the next.Check with the local 
public safety agency to ensure you configure the system to meet the necessary 
requirements.

Table A-1 E911 configuration options

Scenario Note

Small site with analog 
trunks

• No emergency configuration necessary

College dormitory rooms
(with PRI)

• Emergency response personnel must be dispatched to a 
specific room

• Consider sending Caller ID or DID (we recommend 
turning off extension assignment for this application)

Classroom 
(with PRI)

• Emergency response personnel must be dispatched to a 
specific room

• Send DID or Caller ID (Consider turning off extension 
assignment)
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A.5 Configuring Your System
The following subsections provide information for configuring your ShoreTel system for 
proper emergency operation.

A.5.1 Trunk Groups
Make sure you have an outbound trunk group with outbound access that also supports the 
emergency trunk service. If there is no emergency-capable trunk group configured, you 
should create one on the appropriate Trunk Group edit page (see Figure A-5). 

To configure a trunk group to support emergency service, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Trunks > Trunk Groups. The Trunk Groups 
page appears.

Step 3 Select the trunk that you want to configure to support emergency dialing. The 
Edit Trunk Group page appears as shown in Figure A-5.

Multi-building campus or
office complex
(with centralized PRI)

• Caller ID or DID may be too granular with too much 
management overhead.

• Consider using IP phone address mapping and/or the 
switch CESID.

Large building with 
multiple floors
(with PRI)

• Caller ID or DID may be too complex.
• Consider using IP phone address mapping and/or the 

switch CESID.

SoftPhones or travelling 
user

• Use home phone or hotel phone for emergency calls.

Remote IP phones
(with PRI at headquarters)

• Dial an emergency number with home phone.
• Use the IP phone address map (home CESID) as a backup.

VPN Phone – Fixed 
Location

• Remote worker install phone once, then never moves it.
• Configure Caller ID of phone to reflect geographic location. 

One option is setting Caller ID to be identical to worker’s 
home phone number.

VPN Phone – Variable 
Location

• Remote worker uses phone when traveling from various 
locations.

• Use home phone or hotel phone for emergency calls.

Table A-1 E911 configuration options (Continued)

Scenario Note
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Figure A-5 Trunk Group Edit Page (T1 PRI Trunk Group)

Step 4 Check the Emergency (e.g. 911) check box.

Step 5 Click Save.

As a precaution, you should review all other trunk groups to make sure that the Emergency 
check box is not inadvertently enabled on a trunk that is not emergency-capable.

A.5.2 User Groups
Make sure each user group has access to a emergency-capable trunk group. You can select 
the desired emergency Caller ID choice on the User Group edit page.

• To send the Caller ID as the CESID number, verify the Send Caller ID as Caller’s 
Emergency check box is selected.

• To send the DID as the CESID number, verify the Send DID as Caller’s Emergency 
check box is selected.

To enable a user group to support emergency dialing, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > User Groups. The User Groups page appears 
as shown in Figure A-6.
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Figure A-6 User Group Edit Page

Step 3 Check the Send Caller ID as Caller’s Emergency check box to send the Caller 
ID as the CESID number.

Step 4 Check the Send DID as Caller’s Emergency check box to send the DID as the 
CESID number.

Step 5 Click Save.

Make sure you give access to trunk groups at other sites in case users in the group use the 
Extension Assignment feature from another site.

A.5.3 Users
Make sure the Caller ID field is configured if you are sending Caller ID as CESID for this 
user. Similarly, make sure the DID check box is selected (and contains a valid number in 
the DID field) if you are sending DID as CESID for this user.

Verify each user belongs to the correct user group. Use the Edit User page (Figure A-7) to 
associate users with the appropriate user group. See "Individual Users" on page 329 for 
more configuration information.

To configure a user to send Caller ID as CESID, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Users > Individual Users. The Individual Users page 
appears.

Step 3 Select the user that you want to send caller ID as CESID. The Edit User page 
appears as shown in Figure A-7.
606



Appendix A: Emergency Dialing Operations ShoreTel Administration Guide
Figure A-7 Edit User Page

Step 4 Do one of the following:

• In the Caller ID field, enter the number that you want to send for this user.

• Check the DID Range check box and make sure there is a valid number 
listed in the field.

• In the DID field, enter the DID number that you want to use for the user.

Step 5 In the User Group field, select a user group that has the type of emergency 
support enable that you want the user to use.

Step 6 Click Save.

You cannot configure any user (including workgroups or route points) with a 911, 911x, or 
911xx extension. These extension ranges are reserved for the 911 feature operation. We 
recommend that you take precaution when creating numbers that they do not conflict with 
the local emergency dial number.

A.5.4 Specifying CESID for IP Phone Address Range
When you have sites in different geographical areas, you must make sure that the correct 
local emergency number is associated with the site. You can do this by associating the local 
CESID number with the IP address range the system uses to assign number to new phones 
at the site. To associate the CESID with numbers assigned to phone at the site, do the 
following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > IP Phones > IP Phones Address Map. The IP Address 
Map List page appears.

Step 3 Click the site to which you want to associate the local CESID. The IP Phone 
Address Map Info dialog box appears as shown in Figure A-8.
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Figure A-8 IP Phone Address Map Dialog Box

Step 4 In the Caller Emergency Service Identification (CESID) field, enter the 
emergency phone number that is local for the site.

Step 5 Click Save.

A.5.5 Switch
To configure a switch with a CESID, do the following:

Step 1 Launch ShoreTel Director.

Step 2 Click Administration > Platform Hardware > Voice Switches/Service 
Appliances > Primary. The Primary Voice Switches/Service Appliances page 
appears.

Step 3 Select the switch that you want to configure with a CESID number. The Edit 
Switch page appears.

Step 4 In the Caller’s Emergency Service Identification (CESID) field, enter the CESID 
number that is local for the area the switch services.

Step 5 Click Save.

A.5.6 Sites
Use the Site edit page to configure a site’s CESID number. See Chapter 3: ShoreTel Sites 
starting on page 65, for additional information about configuring sites.

To configure a site to support emergency numbers, do the following:

Step 1 Launch ShoreTel Director.
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Step 2 Click Administration > Sites. The Sites page appears.

Step 3 Select the site that you want to configure to support emergency numbers. The 
Edit Site page appears as shown in Figure A-9.

Figure A-9 Site Edit Page

Step 4 In the Caller’s Emergency Service Identification (CESID) field, enter the 
number that you want the site to send for emergency responses.

NOTE Make sure this field is configured with the appropriate number for the 
country or area the site services. For example, sites serving phones in the 
United States and Canada use 911. 

Step 5 In the Emergency Number List section, check the Trunk Access Code 
Required check boxes with the trunk access code over which you want to send 
emergency calls.

Step 6 Click Save.

A.6 Planning Your Emergency Response
When an emergency call is made, the system automatically generates an event in the 
Windows event log at the beginning of the call. With the use of an event filter, you can 
automatically send an e-mail message to the appropriate people in your organization to 
help coordinate your local response (i.e. at the organizational level) whenever the 
emergency number is dialed.
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We recommend training the personnel at all sites on the emergency operations of your 
ShoreTel IP voice system. All users should know how to access emergency services during 
normal and power outage situations.

A.6.1 Call Notification
You can set up an event filter to generate an e-mail message to help coordinate your 
emergency response. For more information about event filters, see "Event Filters" on page 
563 for more configuration information. Use the Event Filter edit page to configure the 
event filter for the following parameters:

Step 1 Launch ShoreTel Director.

Step 2 Click Maintenance > Event Filter. The Event Filters page appears.

Step 3 Click Add New to create an event filter for emergency calls. The Edit Event 
Filter page appears as shown in Figure A-10.

Figure A-10 Event Filter Edit Page

Step 4 In the Server section, select the server that you want to monitor for emergency 
events.

Step 5 In the Source section, select switch.

Step 6 In the Event ID field, enter 1319.

Step 7 In the Type section, select All.

Step 8 In the Target email address field, enter the email address of the party to whom 
you want emergency notification sent.

Step 9 Click Save.

Figure A-11 shows a typical logging message that would result after an emergency call was 
placed – assuming notifications had been properly configured.
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Figure A-11 Event Log

We suggest naming your switches with location information such that you can understand 
which site the call was made from.

A.7 International Emergency Numbers
The ShoreTel system allows dialing of emergency numbers with and without trunk access 
codes. For this reason, you should reserve the dialing plan space for this feature. For 
example:

• “112” is used in Europe and other countries.

• “000” is used in Australia.

• “999” is used in Asia.

Thus, to make use of this feature, extensions should not begin with “112”, “911,” or “999”.

NOTE Extensions should never begin with “0”.

Each site can have a maximum of ten emergency numbers to accommodate locations where 
multiple emergency service numbers are required.

For more information on international installations, see the ShoreTel 12: Planning and 
Installation Guide.

A.7.1 Special Considerations for Netherlands
It is against the law in the Netherlands to “spoof” Caller ID. Caller ID will only be sent if 
the configured caller ID corresponds to the incoming DID that is associated with a 
particular trunk.

Any number entered in the CESID field in the “Switch Edit Page” and “Site Edit Page” will 
only be sent if the number matches the number associated with the incoming DID for that 
trunk.
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A.8 Verifying Your Emergency Configuration
After you have finished configuring your system for emergency operation, we recommend 
working with your local emergency dispatch center to test your configuration in order to 
verify that it has been correctly configured, is sending out the desired caller ID information, 
and is dispatching emergency response personnel to the proper location.

We recommend calling your local law enforcement agency’s non-emergency number to 
understand how to go about the test and to arrange a call time during non-peak hours. Do 
not place your emergency test call without making prior arrangements! Depending on your 
location, an officer may be required on-site when making test calls.

Table A-2 is intended to help you plan your test call to the local dispatch center.

A.9 Additional Recommendations
All sites should be configured with a designated power failure emergency phone configured 
appropriately. Each designated power failure emergency phone should be configured on the 
following ports, based on type of switch, to take advantage of ShoreTel's emergency line 
power failure feature:

• SG40 – Port 4: Analog Trunk; Port 5: Analog Emergency Phone

• SG60 – Port 8: Analog Trunk; Port 9: Analog Emergency Phone

• SG120 – Port 8: Analog Trunk; Port 9: Analog Emergency Phone

• SG30 – Port 1: Analog Trunk; Port 12: Analog Emergency Phone

• SG50 – Port 1: Analog Trunk; Port 12: Analog Emergency Phone

• SG50V – Port 1: Analog Trunk; Port 12: Analog Emergency Phone

• SG90 – Port 1: Analog Trunk; Port 12: Analog Emergency Phone

• SG90V – Port 1: Analog Trunk; Port 12: Analog Emergency Phone

• SG220T1A – Port 1: Analog Trunk; Port 12: Analog Emergency Phone

Table A-2 Emergency Call Test Matrix

Site Extension User
Expected 
Caller ID

Actual
Caller ID

Pass or 
Fail
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Call Detail Record Reports

Call detail record (CDR) reports are used to review the ongoing call activity on the ShoreTel 
system. Sections in this appendix include:

• "Overview" on page 613

• "Talk Time Record" on page 616

• "MySQL Database" on page 616

• "CDR Reports" on page 622

• "Interpreting CDR Reports" on page 626

• "CDR Database" on page 654

• "Connect Table" on page 657

• "MediaStream Table" on page 664

• "AgentActivity Table" on page 665

• "QueueCall Table" on page 667

• "QueueStep Table" on page 671

• "Web Tables" on page 671

B.1 Overview
The ShoreTel system tracks all call activity and generates call detail records into a database 
as well as into a text file on the ShoreTel server. The call detail records are used to generate 
CDR reports. The system comes bundled with twelve CDR reports based on data from the 
CDR database. In addition, the text files provide third-party call accounting systems with a 
simple and standard way to access the call data.

If the ShoreTel server is not up and running, call detail records will not be generated, and 
the associated calls cannot be presented in the CDR reports.

In the event of a WAN outage, CDR data is stored for up to two hours on the distributed 
server. When WAN connectivity is restored, the stored data is forwarded to the 
Headquarters database. After two hours, the distributed server deletes the data and logs an 
error to the NT event log.
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B.1.1 Call Accounting Service
The ShoreTel system has a call accounting service running on the main server that 
generates call detail records into a database and into a space-delimited text file for use by 
third-party call accounting applications. The call accounting service is also responsible for 
archiving all the CDR data. The CDR files are located under C:\Shoreline Data\Call Records 
2.

B.1.2 Active CDR Database
The call accounting service generates call detail records into the active CDR database. This 
file includes all call activity for the period of time specified in the Retention Period for CDR 
Data parameter in the Director Reporting Options page, as shown in Figure B-1. To access 
this page, select Reporting > Options from the Director menu.

Figure B-1 Reporting Options Page

When Enable Archiving is selected on the Reporting Options page, a nightly routine 
automatically moves call detail records that are older than the limit specified by the 
Retention Period for CDR Data into the Archive database.

B.1.3 Legacy CDR Text Files
The call accounting service automatically generates a daily legacy CDR text file for use by 
third-party call accounting applications. These packages typically provide numerous 
reports, including:

• Call accounting, cost allocation

• Most frequently dialed numbers

• Most costly dialed numbers

• Most costly users

• Trunk utilization

• Toll fraud

The CDR*.log files are text files created daily at midnight. It contains call records from 
midnight to midnight. Any call records that span the midnight hour will be recorded on the 
day that calls are completed. 
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B.1.3.1 Format
The file name format for the daily CDR-YYMMDD.HHMMSS.log where

• YY, MM, and DD are zero-padded character strings that represent the year, month, 
and day of the date when the file was created.

• HH, MM, and SS are zero-padded character strings that represent the hour, minute, 
and second of the time when the file was created.

Call records are entered in the log file in the order of when the call was completed and not 
when it began. 

It is the responsibility of the third-party reporting application to delete the daily log files.

The format of the record is column based, must be justified correctly, and end with a 
carriage return and line feed. A single blank character is inserted between each data field 
for readability. Table B-1 provides information about elements in the CDR text file.

Table B-1 CDR Text File Field Definitions

Field Column Length Comment

Call ID 1 10
right justified

A unique ID that represents the call. The Call ID is 
meant to be unique for the duration while it's active.

Date 12 10 Date of the call given in month, day, and year: mm/
dd/yyyy

Time 23 8 Start of the call given in hours, minutes, and 
seconds: hh:mm:ss

Extension 32 16
left justified

Inbound or outbound extension ID. Last valid party 
on the call. Valid parties include user extension and 
operator but not voice mail or auto-attendant. 

Duration 49 8 Call duration given in hours, minutes, and seconds. 
hh:mm:ss

Call 
Direction

58 1 Incoming/outgoing flag 
0 – Incoming
1 – Outgoing
2 – Tandem Trunking – Inbound Tandem Call

Dialed 
Number

60 16
left justified

Contains the number dialed but does not include 
any access code, such as 9, to seize the trunk. Valid 
only for outbound calls.

Caller ID 77 16
left justified

Blocked or unavailable information will be reported 
as blocked or unavailable in text. Valid only for 
incoming calls.

Trunk 
Member

94 4
right justified

The Port ID of the trunk.

Trunk Group 99 3
right justified

The Trunk group ID.

Account 
Code

103 20 The account code entered by the caller.

CR /LF 124 Carriage return.
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B.2 Talk Time Record
Call Detail Records provide a complete logging of all non “Private” calls placed in or out of 
the ShoreTel system. These logs include call volume, call origination, call destination and 
the length of each call.

The Talk Time Enhancement feature increases the usability of log data from the Call Detail 
Records by compiling only the actual time spent in a conversation between the calling 
parties. All call ring back time is eliminated from the Call Detail Records retaining only the 
actual Talk Time spent on the call.

When a call is placed the destination phone acknowledges and a ring tone is provided to 
both parties. The time of the call starts on the first ring and terminates when the calling 
parties hang up. The ShoreTel Appliance uses the Telephony Management Service (TMS) to 
report the call and it's the time to the HQ server. There the call is captured in the Call Detail 
Records. The entire length of the call is logged here, including the first ring up to the entire 
call tear down.

Talk Time Enhancements uses the FarEndAnswered event provided by certain trunks to 
determine when the called party answers the call. The length of time the call has been 
answered is reported to the CDR.

Calls placed over Digital Wink, PRI, BRI or SIP trunks support FarEndAnswered events. 
These events mark the moment when the called party answers the call. Talk Time 
Enhancement uses this event to report the Talk Time of the call to the Call Detail Records. 
The Call time represents only the actual Talk Time of the call. Calls over Analog loop start 
and Digital loop start trunks do not support FarEndAnswered events. These calls still 
report to the CDR through TMS, but their time values include the time for Ring Back. 

As administrators evaluate CDR reports, an understanding of the trunk types that support 
Talk Time Enhancement helps them to gain an accurate picture of the talk time being 
reported in the CDR.

B.3 MySQL Database
CDR records are maintained and queried through MySQL database. The maximum MySQL 
database size is 64 terabytes (TB). Database tables restricted to a maximum size of 2 TB. 

The data in the MySQL files can be viewed using a new Web-Based Reporting feature from 
ShoreTel Director (see the "Accessing the Call Details Reports Page" on page 587 for more 
information). Alternatively, the user can use common database command utilities via a 
command line interface to dump and restore files.

CDR reports are generated from Director, as described in "Accessing the Call Details 
Reports Page" on page 587.

MySQL database service can be monitored or restarted from Director by selecting 
Maintenance > Services in the menu page, then selecting MySQL in the table on the 
Services page.

B.3.1 Compatibility and Pre-Configuration Requirements

B.3.1.1 Disk Space Requirements
Storing call detail records for 50,000 workgroup calls requires a 1.5 GB MySQL database. 
Implementing a database of this size typically requires 4.0 GB of disk space. This includes 
disk space for the main database (1.5 GB), the archive database (1.5 GB), and temporary 
space required to generate reports (1.0 GB). 
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Although the main and archive databases are typically stored on the same server, MySQL 
permits the storage of the databases on different servers. 

B.3.1.2 Compatibility with Utility Programs 
ShoreTel should be run on a dedicated server. Other programs that access MySQL databases 
may not be compatible with ShoreTel, resulting in installation and data integrity issues. 
Before installing ShoreTel on any server, remove all pre-existing MySQL programs and 
databases.

Virus Checkers: MySQL database files must be excluded from all virus checker utilities 
running on the server. Specifically, if virus checker is running on the server, exclude 
MySQL CDR Database file (Where ever ShoreLine Data installed:\Shoreline Data\Call 
Records 2\Data\[ibdata1, ib_logfile0, ib_logfile1]) from your virus checker utility. If these 
files are not in the exclusion list, MySQL service will stop working.

Disk or Backup utilities: MySQL database files must be excluded from all disk or backup 
utilities running on the server. Failure to exclude the database will crash the MySQL 
service.

To restart the database after a crash, access the MySQL Service page from ShoreTel Director 
by selecting Maintenance > Services in the menu page, then selecting ShoreTel MySQL in 
the table on the Services page.

B.3.2 Archival and Backup Utilities
The following section describes database archival, backup, and replication tools. Table B-2 
summarizes the service availability for these features.

B.3.2.1 Record Retention Periods
You configure the number of days that a database stores a Call Detail Record in the Report 
Options page. To access the Report Options page, as shown in Figure B-2, open ShoreTel 
Director and select Reporting > Options from the Director Menu.

• Retention Period for CDR Data specifies the number of days that records remain in 
the main CDR database. Older records are removed from the database each day.

• Retention Period for CDR Archive specifies the number of days that records remain 
in the archive database. Older records are removed from the database each day.

Default values for each parameter is 125 days.

Table B-2 Archival, Backup, and Replication Services Availability

Field Backup

Archive
(Secondary 
Server) Replication

Technical Assistance Support Yes Yes No

Additional MySQL License 
Required

No Yes Yes

Execution Manual Daily Online

Reports run on remote machine No Yes No

Complete restoration if HQ fails Yes possible 
through manual 
recovery

Yes
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Figure B-2 Report Options Page

B.3.2.2 Database Archive Utility
The archive utility provides a method of removing older records from the main database 
and storing them in an archive database. Archiving older records into a separate database 
reduces the storage requirements of the main database, which reduces the time required to 
search for specific records or generate reports. The archived database provides the same set 
of services as the main database.

Archival services are configured and enabled in ShoreTel Director, where you can specify 
the number of days that records are maintained in the main database and in the archive 
database. When archiving is enabled, archival services are performed daily. The archival 
service copies records to the archive database that exceed the main database age limit, then 
removes those records from the main database. Records that exceed the age limit for the 
archive database are removed from the archive database. Age limits are established 
separately for each database; valid limits range from one to 2000 days. The default age 
limits for each database is 125 days.

Example: A sample implementation sets a 30 day limit on the main database and a 365 day 
limit on the archive database. In this case, the main database contains records for calls 
handled during the past 30 days while the archive database contains records for calls 
handled during the past 365 days.

The Backup utility can be used for record storage requirements that exceed 2000 days.

To create an archive database:

Step 1 Run MakeCDRArchive –d databasename, where databasename is the name of the 
archive database to be created. 

Step 2 Access the Reporting Options page in ShoreTel Director (Reporting | Options 
from the Menu page) to configure ShoreTel to access the archive database.

B.3.2.3 Database Backup Utility
The Backup utility creates a copy of a specified database, which can be restored at a later 
time and different location. The Backup utility differs from the Archival utility as follows:

• Archiving is configured once then performed daily. Backups are performed only 
when a command is executed.
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• Archival operations are configured from ShoreTel Director. Backups are performed 
from the command line.

• Archive databases can be accessed directly to generate reports. Backup databases 
must be restored before performing search and report generation tasks.

Backup and Restore operations can be performed without shutting down the MySQL 
service. Performing these operations during off peak hours reduces the execution time and 
the impact on other system services.

The file located at “C:\Program Files\Shoreline Communications\Shoreware 
Server\MySQL\MySQL Server 5.0\Examples\dump1.bat” is an example of a batch file that 
backs up a MySQL CDR database under generic default conditions. This file can be used as 
a template for creating a batch file that backs up the database under specific conditions. 
The password is shorewaredba. Backing up a 1.5 GB database requires 200 seconds.

Refer to http://dev.mysql.com/doc/refman/5.0/en/disaster-prevention.html for MySQL 
backup tools, add-ons, and documentation.

B.3.2.4 Database Restore Utility
Restoring a database copies the records in the backup database file to the database specified 
in the restore command. Records in the backup file that are duplicates of records in the 
target database are listed in the log file and are not restored.

The file located at “C:\Program Files\Shoreline Communications\Shoreware 
Server\MySQL\MySQL Server 5.0\Examples\restore1.bat” is an example of a batch file that 
restores a MySQL CDR database under generic default conditions. This file can be used as a 
template for creating a batch file that restores the database under specific conditions. The 
password is shorewaredba. Restoring a 1.5 GB database requires 1200 seconds.

B.3.2.5 Database Replication
MySQL provides a Database Replication tool. Access the following web pages for more 
information:

• http://www.howtoforge.com/mysql_database_replication provides MySQL database 
replication setup information.

• http://solutions.mysql.com/solutions/tools?type=25 lists tools and add-ons that assist 
with database replication.

B.3.3 Installing MySQL on a Secondary Server
Although the archive database is normally stored on the main ShoreTel server, MySQL 
databases can be installed on a Secondary Server to conserve main server resources. A 
separate licensed copy of MySQL Enterprise Server 5.0 is required to install the database on 
a Secondary Server. 

To install MySQL on a secondary server, perform the following procedure (Replace 
c:\Program Files\... in the instructions to the location where MySQL is installed on the 
server).

Step 1 Install MySQL Enterprise Server 5.0 on a Secondary server.

Step 2 Select all the default values during installation except for the following items: 

• Use root for UserID

• Use shorewaredba for the password, 
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• utf8 for the character set as part of the installation

Step 3 Backup the file c:\Program Files\MySQL\MySQL Server 5.0\my.ini from the 
Secondary server to a safe location (i.e. c:\MySQL_backup).

Step 4 Backup the files c:\Program Files\MySQL\MySQL Server 5.0\Data\[ib_logfile*] 
from the Secondary server to a safe location (i.e. c:\MySQL_backup).

Step 5 Select Start > Administrative Tools > Services > MySQL

Step 6 Click Stop the service and check that MySQL service status is blank

Step 7 Compare the file from the Main server directory with a secondary server file:

Main server directory—C:\Program Files\Shoreline 
Communications\ShoreWare Server\MySQL\MySQL Server 5.0\Examples 

Secondary server file— c:\Program Files\MySQL\MySql Server 5.0

Make sure that all the parameters specified in the archive_MySQL_my.ini are 
set appropriately in my.ini. 

Step 8 Archive_MySQL_my.ini values are as follows.

[mysql]
default-character-set=utf8
[mysqld]
default-character-set=utf8
tmp_table_size = 30M
key_buffer_size=2M
read_buffer_size=2M
read_rnd_buffer_size=2M
sort_buffer_size=2M
innodb_additional_mem_pool_size=2M
innodb_flush_log_at_trx_commit=0 
innodb_file_per_table
innodb_log_buffer_size=5M
innodb_buffer_pool_size=150M
innodb_log_file_size=24M
default-storage-engine=INNODB

Step 9 Delete the file ib_logfile* from the Secondary server directory (c:\Program 
Files\MySQL\MySQL Server 5.0\Data).

Step 10Check that innodb_flush_log_at_trx_commit=0 on Secondary server C:\Program 
Files\MySQL\MySql Server 5.0. If the value is not zero, archiving write 
operations will be more than 20 times slower.

Step 11Select Start > Administrative Tools > Services > MySQL

Step 12Click Restart the service and verify that MySQL service comes back up.

To convert the Secondary server database into an archive database:

Step 1 Verify the following files are placed in an equivalent location on the Secondary 
Server to that on the Main servers (default location is \\Shoreline 
Communications \Shoreware Server)
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• MakeCDR.dll

• MakeCDR.sql

• MakeCDR_sp.sql

• MakeCDRArchive.exe

Step 2 Run MakeCDRArchive –d databasename, where databasename is the name of the 
archive database to be created. 

Access the Reporting Options page in ShoreTel Director (Reporting | Options from the 
Menu page) to configure the name of the archive database within ShoreTel.

B.3.4 Performance Tuning for Report Generation
To improve on the CDR report generation performance, increase 
INNODB_BUFFER_POOL_SIZE defined in c:\windows\my.ini based as specified

Default setting: 

• INNODB_BUFFER_POOL_SIZE = 150 MB

If the database contains more than 350,000 records, set

• INNODB_BUFFER_POOL_SIZE = 200 MB

If the database contains more than 500,000 records, set

• INNODB_BUFFER_POOL_SIZE = 250 MB

B.3.5 Report generation time – CPU Utilization
Based on the size of the data requested for the report, the display time for the last page of 
the report from the first page may require ten minutes. Even though the priority of Report 
Generation process is set to below normal, generating large reports may potentially impact 
the call processing performance. To avoid performance degradation issues, do not generate 
large CDR reports during peak call loads.

B.3.6 MySQL CDR Database and Internationalization
MySQL CDR Database supports the UTF-8 character set. All CDR data in the database is 
stored in UTF-8 character set.

B.3.7 Monitor MySQL service
To monitor and, when necessary, restart the MySQL service from ShoreTel Director, access 
the Services page by selecting Maintenance | Services in the menu page, then select MySQL 
in the table on the Services page.

B.3.8 Tools for browsing MySQL database tables
MySQL provides MySQL Query Browser as part of their GUI Tools (http://dev.mysql.com/
downloads/gui-tools/5.0.html). MySQL Query Browser can be used to browse and view the 
queries. The open source tool (http://www.webyog.com/en/downloads.php) is available to 
view the CDR tables defined in MySQL. 

Browsing a large CDR database on the Main server may potentially degrade the call 
processing server. 
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Large amount of temporary disk space may be used by these MySQL browser tools. To 
avoid affecting call processing performance on HQ, a query with LIMIT criteria can be used 
to show a subset of rows.

B.3.9 Restrictions in the number of records returned by the 
MySQL CDR query
CDR database queries that exceed 300,000 records may cause performance degradation 
when generating certain reports, such as Trunk Activity Detail and Trunk Activity 
Summary. Increasing the amount of free disk space may mitigate this problem, as will 
modifying the query filter to reduce the number of records returned by the query to under 
300,000. 

B.4 CDR Reports
The ShoreTel system comes bundled with 12 CDR reports generated using data from the 
active CDR database on the ShoreTel server. CDR reports present information about users, 
trunks, WAN links, workgroup queues, account codes, and workgroup agents. Reports are 
grouped into two categories: summary and detail. 

Summary reports provide a high-level view of activity that occurred in a particular area, 
while detail reports provide a detailed view of activity beyond that of the summary report. 
Typically, you use the summary report to identify any discrepancies or problems, and the 
detail report to uncover more specific information. The workgroup queue report only has a 
summary report.

• User Activity Summary: Summarizes all calls for each user.

• User Activity Detail: Lists every call for each user.

• Trunk Activity Summary: Summarizes all calls for each trunk.

• Trunk Activity Detail: Lists every call for each trunk.

• Workgroup Agent Summary: Summarizes all inbound workgroup calls for each 
agent.

• Workgroup Agent Detail: Lists every inbound workgroup call for each agent and 
optionally, outbound calls. Non-workgroup calls for the agent are also reported.

• Workgroup Queue Summary: Summarizes queue activity for every workgroup, 
including calls that went directly to agents.

• Workgroup Service Level Summary: Summarizes data on call processing by the 
workgroup server.

• WAN Media Stream Summary: Summarizes media stream traffic and call quality for 
calls made over the WAN in multi-site deployments.

• WAN Media Stream Detail: Lists media stream made over the WAN in multi-site 
deployments.

• Account Code Summary: Summarizes call information for each account; counts of 
calls each day, along with their total and average duration. There are also totals for 
the reporting period. 

• Account Code Detail: Provides a detailed list of calls that occurred for each account. 
For each call the date/time of the call, number dialed, the extension making the call 
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and the duration of the call is included. For each account, a summary is provided of 
the number of calls, along with their total and average duration.

B.4.1 TMS-CDR Media Stream Statistics
The TMS-CDR Media Stream Statistics feature offers a method of formatting and storing 
Call Detail Records (CDR) data on media streams and stores that formatted information 
into a log file on the system, making it easier for the ShoreTel system to integrate with 
various third-party SNMP monitoring tools, and enabling users to acquire a more accurate 
picture of the traffic patterns in their network. This information can be useful in 
performing load analysis, identifying peak traffic times, and assisting the customer in 
setting up competitive pricing strategies.

The system processes media statistics for all calls and formats the raw data into separate 
lines, with each line partitioned into several columns separated by a comma. Formatted 
data is then saved in a text file and is subjected to appropriate rollovers similar to the other 
ShoreTel server logs.

One media stream statistic record will be generated for each RTP stream on a call. Thus, a 
3-way fully-meshed conference call would generate 6 records.

B.4.1.1 Formatting
Media statistics are collected and deposited line by line into a file. A delimiter separates one 
column from the previous one, with no delimiter prior to the first column and none after 
the last column. The column values will be left-justified and padded with spaces to the 
right. A value that exceeds the fixed-width column limit will be truncated so that it fits 
within the limit. 

Each line will look similar to the line below:

value-1,value-2,value-3,…..,value-n

The Table B-3 summarizes the details of the individual columns.

Table B-3 CDR Media Stream Statistics Formatting

Column 
number

Type Width Description

1 Integer 20 ID of the line in decimal 

2 String 20 Extension Number
For anonymous calls, extension number is not available. In 
such cases, an empty string will be placed at this column.

3 String 16 Name of Extension or Trunk or Phone (UTF-8)
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4 Integer 2 Party type in decimal
0 Unknown
1 Station
2 Trunk
3 Virtual
4 Workgroup
5 AutoAttendant
6 VMForward
7 VMLogin
8 BackupAA
9 Anonymous Phone
10 Nightbell
11 Paging
12 Workgroup Agent
13 Unknown
14 RoutePoint
15 ACC
16 HuntGroups
17 GroupPaging

4 Integer 2

5 String 32 SIP Call ID

6 String 16 Local IP Address (Switch, Trunk Switch, or IP Phone etc.) in 
dotted decimal form

7 String 16 Remote IP Address (Remote end point. Switch or Trunk or IP 
Phone etc.) in dotted decimal form

8 Integer 20 Local Site ID (Site ID of extension or trunk or phone that 
generated starts)

9 String 16 Local Site Name (UTF-8)

10 Integer 3 Code Type
1 ALAWPCMA/8000 (or G711A)
2 MULAWPCMU/8000 (or G711μ)
3 LINEARL16/16000
4 ADPCMDVI4/8000
5 G729AG729A/8000
6 G729BG729B/8000
7 LINEARWIDEBANDL16/16000
8 G722G722/8000
9 BV32BV32/16000
10 BV16BV16/8000
11 AAC_LC32000AAC_LC/32000
12 CustomCodec added by administrator

11 Integer 10 Payload size (in milliseconds)

12 Integer 2 Status code
0 – Normal
1 - Failure

13 String 12 Starting time of the collection in string HH:MM:SS.MSEC 
format

14 Integer 20 Duration (in seconds) of the collection in decimal.

Table B-3 CDR Media Stream Statistics Formatting (Continued)

Column 
number

Type Width Description
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This feature is applicable only on the main (i.e. headquarter) ShoreTel server, and is 
disabled by default. Enabling the TMS-CDR Media Stream Statistics feature requires 
making the appropriate changes to the registry settings.

WARNING Do not make any changes to the registry settings unless you are certain you 
know what you are doing!

Step 1 Click Start and select Run.

Step 2 Select the regedit application to display a window similar to the one shown in 
Figure B-3.

Figure B-3 Registry Editor window

Step 3 Navigate to SOFTWARE\Shoreline Teleworks\Call Accounting

Step 4 Double-click the file named LogMediaStatsToFile to open the Edit DWORD 
Value dialog box shown in Figure B-4.

15 Integer 20 Number of received packets

16 Integer 20 Number of lost packets

17 Integer 20 Max jitter

18 Integer 20 Underruns

19 Integer 20 Overruns

Table B-3 CDR Media Stream Statistics Formatting (Continued)

Column 
number

Type Width Description
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Figure B-4 Value data field

Step 5 Enter 1 in the Value data field and click OK to store your changes and enable this 
feature.

B.4.2 Generating CDR Reports
Refer to "Accessing the Call Details Reports Page" on page 587 for instructions on 
generating CDR Reports.

B.5 Interpreting CDR Reports
This section provides information on interpreting each of the 12 CDR reports.

B.5.1 User Activity Summary Report
The User Activity Summary Report (Figure B-5) shows a summary of all inbound and 
outbound calls for each user. This includes the type of calls made, as well as the total 
duration for all calls. This report can be run as an interval report in which user activity is 
subtotaled by the selected interval. Additionally, the summary can be run for selected 
extensions.
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Figure B-5 User Activity Summary Report

B.5.1.1 Calls Included
The User Activity Summary Report always displays External Calls and can be configured to 
display Internal Calls. External calls are those calls where the record in the Call table has a 
CallType of 2 (Inbound) or 3 (Outbound). 

B.5.1.2 Name (Extension Field)
For outbound calls, the Name (Extension) field of the Call record always reports the party 
that initiated the call. 

Inbound calls are reported according to the last party involved in the call (excluding voice 
mail and the auto-attendant). For example, if a call to extension 320 is not answered and 
the user’s Call Handling Mode (CHM) forwards the call to the assistant at extension 452—
who answers the call—the Extension field in the Call record contains 452.

When an inbound call is forwarded to voice mail, the Name (Extension) field records the 
party involved in the call before it was forwarded to voice mail. For example, if a user with 
extension 320 doesn't answer a call and his or her Call Handling Mode (CHM) forwards 
the call to voice mail, the extension field is set to 320.

The User Activity Summary Report is described in Table B-4.
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Table B-4 User Activity Summary Report field descriptions

Field
Presence/
Frequency Description

Name 
(Extension)

Once for each 
extension 
reported.

The name of the user, last name first. Users without a last name are 
presented first. 
Non-users such as Workgroups, Voice Mail, Voice Mail Login, and 
Auto-attendant are included in the report. The names for these 
extensions are reported for calls that only interact with these 
extensions (not a user extension).
Like many other non-user extensions, the ShoreTel Audio Conference 
extension is also not displayed.

Inbound All 
- Qty,
Duration, 
Average 
Duration

Once for each 
period reported. 

The quantity, total duration, and average duration for inbound calls 
during the reporting period are presented. A call is considered 
inbound if the CallType field of the Call table record is set to 2 
(Inbound). 
If the report is run with intervals, the call is only reported for the 
interval in which it started, even if it ends in a different interval. The 
StartTime field in the Call table is used to determine when the call 
started. 
Duration represents that extensions time on the call. This is found in 
the Connect table record's Duration field for this connection (where 
the Connect.CallTableID matches the Call.ID and Connect.PartyID 
matches Call.Extension). Since a call is reported during the period in 
which it starts, but may end during another interval, the duration can 
be longer than the 30-minute interval period—the total call duration 
time is reported during the interval in which the call begins. 
Total Duration during any period is the sum of the duration for the 
Inbound calls during the period. Average duration is found by 
dividing this total by the number of calls during the period. 

Outbound 
All - Qty,
Duration, 
Average 
Duration

Once for each 
period reported.

The quantity, total duration, and average duration for Outbound calls 
during the reporting period are presented. A call is considered 
outbound if the CallType field of the Call table record is set to 3 
(Outbound). 
Duration is calculated here in the same manner as for Inbound calls. 
Please see that description for details. 

Total All - 
Qty

Once for each 
period reported.

The quantity, total duration, and average duration of all calls during 
this period. This simply represents both the Inbound and Outbound 
columns. Inbound and Outbound quantity and total duration are 
added together and then averaged.
628



Appendix B: Call Detail Record Reports System Administration Guide
B.5.2 User Activity Detail Report
The User Activity Detail Report (Figure B-6) shows a list of every call for each user by user. 
This includes the time a call was received or made, the number dialed, and the trunk used. 
This report can be run as an interval report in which user activity is sub-totaled by the 
selected interval.

NOTE Conference calls that use a ShoreTel conferencing device have two entries in the 
User Activity Detail Report. The first entry shows the amount of time (duration) 
used to enter a pass code or user prompt. The second entry shows the duration of 
the entire conference call.

Outbound 
Non-Local 
Trunk - Qty

Once for each 
period reported.

The quantity, total duration, and average duration for Outbound non-
local calls during the reporting period are presented. A call is 
considered outbound if the CallType field of the Call table record is 
set to 3 (Outbound). A call is considered Non-Local if the 
LongDistance field in the Call table is set to true. This flag indicates 
whether or not the call was long distance from the perspective of the 
trunk that was used for the call. 
The calls reported here, are a subset of the calls reported under 
Outbound all. 
Duration is calculated in the same manner as for Inbound calls. Please 
see that description for details. 

Outbound 
WAN 
Trunk- Qty

Once for each 
period reported.

The quantity, total duration, and average duration for Outbound non-
local calls during the reporting period are presented. A call is 
considered outbound if the CallType field of the Call table record is 
set to 3 (Outbound). A call is considered a WAN call if a media stream 
was established between 2 sites. This is determined by looking in the 
MediaStream table for any records of media stream for this call (the 
MediaStream CallID will equal the CallID in the Call table record for 
the call.
The calls reported here, are a subset of the calls reported under 
Outbound all. 
Duration is calculated here in the same manner as for Inbound calls. 
Please see that description for details. 

Grand Total The totals for all the users in the system.

Table B-4 User Activity Summary Report field descriptions (Continued)

Field
Presence/
Frequency Description
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Figure B-6 User Activity Detail Report

B.5.2.1 Calls Included
The User Activity Detail Report always displays External Calls and can be configured to 
display Internal Calls. External calls are those calls where the record in the Call table has a 
CallType of 2 (Inbound) or 3 (Outbound). All specified calls that have at least one leg with 
a TalkTime greater than zero are included in the report.

B.5.2.2 Name (Extension Field)
For outbound calls, the Name (Extension) field of the Call record always reports the party 
that initiated the call. 

Inbound calls are reported according to the last party involved in the call (excluding voice 
mail and the auto-attendant). For example, if a call to extension 320 is not answered and 
the user’s Call Handling Mode (CHM) forwards the call to his or her assistant at extension 
452 who answers the call, the Extension field in the Call record contains 452.

When an inbound call is forwarded to voice mail, the Name (Extension) field records the 
party involved in the call before it was forwarded to voice mail. For example, if a user with 
extension 320 doesn't answer a call and his or her Call Handling Mode (CHM) forwards 
the call to voice mail, the extension field is set to 320.

The User Activity Detail Report is described in Table B-5.
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Table B-5 User Activity Detail Report Field Descriptions

Field
Presence/
Frequency Description

Name 
(Extension)

Once for each 
extension 
reported. 

The Last Name, First Name, and Extension being reported upon. 
These come from the PartyIDLastName, PartyIDName, and 
PartyID for the Connect record that matches the extension in the 
Call table. 
Non-users such as Workgroups, Voice Mail, Voice Mail Login, and 
Auto-attendant are included in the report. The names for these 
extensions are reported for calls that only interact with these 
extensions (not a user extension).
Like many other non-user extensions, the ShoreTel Audio 
Conference extension is also not displayed

Date/Time Once for each 
call reported.

The date and time when the call being reported started. These 
fields come from the StartTime field in the Call table record for 
the call being reported. When interval reports are generated, the 
actual time the call started is reported even if the call continues 
into another interval.

In/Out Once for each 
call reported.

If the CallType field of the Call record for the call is 2 (Inbound), 
“In-Int” is shown for internal calls and “In-Ext” for external calls.
If the CallType is 3 (Outbound), “Out-Int” is shown for internal 
calls and “Out-Ext” is shown for external calls.
ShoreTel Audio Conference Service calls are displayed as if the 
service called the user, this field will be ‘In-Int’ for ShoreTel Audio 
Conference Service

WG 
(Workgroup)

Once for each 
call reported.

The Workgroup field of the Call record for the call is examined. 
“Yes” or “No” is displayed depending upon whether or not the 
field indicates a workgroup call. 

WAN Once for each 
call reported.

A call is considered a WAN call if a media stream was established 
between 2 sites. This is determined by looking in the 
MediaStream table for any media stream records for this call. The 
MediaStream CallID will equal the CallID in the Call table record 
for the call.
Based on the CDR data, the following are displayed:
• “Y” or “N”

(Y = Yes, N = No)
• “S” or “NS”

(S = Secure, NS = Not Secure)
• “N-S” or “Y-S”

(N-S = No, Secure; Y-S = Yes, Secure)
• “N-NS” or “Y-NS”

(N-NS = No, Not Secure; Y-NS = Yes, Not Secure)
• “N-VPN-S” or “Y-VPN-S”

(N-VPN-S = No, Virtual Private Network, Secure)
(Y-VPN-S = Yes, Virtual Private Network, Secure)

• “N-VPN-NS” or “Y-VPN-NS”

(N-VPN-NS = No, Virtual Private Network, Not Secure)
(Y-VPN-NS = Yes, Virtual Private Network, Not Secure)
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B.5.3 Trunk Activity Summary Report
The Trunk Activity Summary Report (Figure B-7) shows a summary of all calls for each 
trunk by trunk group. This includes the type of calls, durations, and average durations 
made on each trunk.

User Activity 
Time Stamp 
Action

Once for each 
call reported.

This gives the action taken on the call and the time when the 
action took place. For example, in case of a transfer, the exact 
time of transfer is reported.

Dialed # Once for each 
call reported.

For outbound calls, this is the number the user dialed and is 
reported in full, canonical format (including country code). 
For inbound calls, this is the destination of the call. If the call was 
a DID or DNIS call, this is the DID or DNIS information for the 
number dialed. For other types of calls, this is the extension 
where the call first terminates.
The dialed number is retrieved from the Dialed Number field of 
the Call table record for the call. 

Calling # Once for each 
call reported.

For inbound calls, this is the calling number—ANI or Caller ID—
received by the ShoreTel system and is reported as delivered by 
the PSTN (may or may not include the 1 in front of the area 
code). The dialed number is retrieved from the CallerID field of 
the Call table record.
For outbound calls, this is the extension of the user that placed 
the call. In the case of Outbound calls, this data is retrieved from 
the PartyID field of the Connect record for the party that initiated 
the call. 

Trunk Once for each 
call reported.

This is the first trunk that was used for the call. This data is 
retrieved from the PortName field of the Connect record for the 
trunk’s involvement in the call. 

Duration The duration of the call at the indicated extension.
Duration is from the time media is established till it ends. Ring 
time is not considered in IN/OUT calls.
Duration should match Talktime+Hold time (if talk time is non-
zero value)
This applies to all the reports.
This data is retrieved from the Duration field of the Connect 
table’s record for this connection (where the Connect.CallTableID 
matches the Call.ID and Connect. PartyID matches 
Call.Extension).

Total The total number of calls, total duration, and average duration for 
the user.

Grand Total The total number of calls, total duration, and average duration for 
all users.

Table B-5 User Activity Detail Report Field Descriptions (Continued)

Field
Presence/
Frequency Description
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Figure B-7 Trunk Activity Summary Report

B.5.3.1 Calls Included
Any trunk activity is reported in the Trunk Activity Summary Report. These calls always 
have Call records with CallType of 2 (Inbound), 3 (Outbound), or 4 (Tandem). However, 
with ShoreTel, Release 2.0 and greater, the report is based on the TrunkDirection field in 
the Connect records representing trunk usage, not the CallType record. There is a 30-day 
change-over period for upgrades, during which the report reflects both methods of 
collecting this data. 

The Trunk Activity Summary Report is described in Table B-6.

Table B-6 Trunk Activity Summary Report Field Descriptions

Field
Presence/
Frequency Description

Trunk Group 
Name

Once for each 
TrunkGroup being 
reported upon.

This is the name of the TrunkGroup being reported upon. It's 
retrieved from the GroupName field of the Connect record 
representing a trunk’s involvement in a call.

Trunk Name Once for each 
trunk being 
reported upon. 

The name of the specific trunk used for a call. This is 
retrieved from the PortName field of the Connect record 
representing a trunk’s involvement in a call.

Inbound Qty, 
Duration, and 
Average Duration

Once for each 
trunk being 
reported upon.

The quantity, total duration, and average duration for all 
inbound trunk activity for this trunk during the reporting 
period are presented. 
Trunk activity is considered inbound if the TrunkDirection 
field in the Connect record is set to 2 (Inbound). 
The quantity is simply a count of the Connect table records 
during the reporting period for this trunk that indicate 
inbound trunk usage. 
Duration is the sum of all the Duration fields for the Connect 
table records during the reporting period for this trunk that 
indicate inbound trunk usage. 
The average duration is found by dividing this total by the 
quantity reported here.
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B.5.4 Trunk Activity Detail Report
The Trunk Activity Detail Report (Figure B-8) shows a list of every call for each trunk by 
trunk group. This includes the date and time, the number dialed, and the user’s name.

Figure B-8 Trunk Activity Detail Report

Outbound Qty, 
Duration, and 
Average Duration

Once for each 
trunk being 
reported upon.

The quantity, total duration, and average duration for all 
outbound trunk activity for this trunk during the reporting 
period are presented. 
Trunk activity is considered outbound if the TrunkDirection 
field in the Connect record is set to 3 (Outbound). 
The quantity is simply a count of the Connect table records 
during the reporting period for this trunk that indicate 
outbound trunk usage. 
Duration is the sum of all the Duration fields for the Connect 
table records during the reporting period for this trunk that 
indicate outbound trunk usage. 
Average duration is found by dividing this total by the 
quantity reported here.

Total Qty Once for each 
trunk being 
reported upon.

The total calls for the trunk.

Duration Once for each 
trunk being 
reported upon.

The total duration of calls, in hours, minutes, and seconds.

Average Duration Once for each 
trunk being 
reported upon.

The average duration of calls, in hours, minutes, and 
seconds.

Total The totals for all trunks in the trunk group.

Grand Total The totals for all trunks in the system.

Table B-6 Trunk Activity Summary Report Field Descriptions (Continued)

Field
Presence/
Frequency Description
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B.5.4.1 Calls Included
Any trunk activity is reported in the Trunk Activity Detail Report. These calls always have 
Call records with CallType of 2 (Inbound), 3 (Outbound), or 4 (Tandem). However, with 
ShoreTel Release 2.0 and greater, the report is based on the TrunkDirection field in the 
Connect records representing trunk usage, not the CallType record. There is a 30-day 
crossover period for upgrades during which the report will reflect both methods of 
collecting this data. 

The Trunk Activity Detail Report is described in Table B-7.

Table B-7 Trunk Activity Detail Report Field Descriptions

Field Presence/Frequency Description

Trunk Group 
Name

Once for each 
TrunkGroup being 
reported upon. 
If the trunk activity 
for a TrunkGroup 
requires more than 
one page to report, 
then the name is 
repeated at the top of 
each additional page.

This is the name of the TrunkGroup being reported upon. 
This data is retrieved from the GroupName field of the 
Connect record representing a trunk's involvement in a call.

Trunk Name Once for each 
TrunkGroup being 
reported upon. 
If the trunk activity 
for a TrunkGroup 
requires more than 
one page to report, 
then the name is 
repeated at the top of 
each additional page.

The name of the specific trunk used. This data is retrieved 
from the PortName field of the Connect record representing a 
trunk's involvement in a call.

Date Once for each trunk 
activity in the report.

The date is extracted from the ConnectTime field in the 
Connect record representing the trunk's involvement in the 
call. This is the date the trunk was added to the call. 

Time Once for each trunk 
activity in the report.

The time is extracted from the ConnectTime field in the 
Connect record representing the trunk's involvement in the 
call. This is the time the trunk was added to the call.

In/Out Once for each trunk 
activity in the report.

Trunk activity is considered “In” if the TrunkDirection field in 
the Connect record is set to 2 (Inbound), otherwise it is 
considered “Out.” 

When an external user calls the external number of the UCB, 
two records are displayed in the report, and each record is 
considered “In.”
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Dialed # Once for each trunk 
activity in the report.

For outbound calls, this is the number the user dialed and is 
reported in full, canonical format (including country code, 
etc.). For an inbound call this is the destination of the call. If 
the call was a DID or DNIS call, this is the DID or DNIS 
information for the number dialed. For other types of calls, 
this is the extension where the call first terminates.
For inbound calls (CallType = 2 in Call record) this data is 
retrieved from the DialedNumber field in the Call record. For 
other calls, it is retrieved from the PartyId field of the Connect 
record for the trunk activity. 
Inbound and outbound are relative to the call, not trunk 
usage.

Calling # Once for each trunk 
activity in the report.

For inbound calls, this is the calling number—ANI or Caller 
ID—received by the ShoreTel system and is reported as 
delivered by the PSTN (may or may not include the 1 in front 
of the area code).
For outbound calls, this is the extension of the user that 
placed the call. 
For outbound calls (CallType = 3 in Call record) this data is 
retrieved from the Extension field in the Call record. For 
other types of calls, it is retrieved from the CallerID field in 
the Call table.
Inbound and outbound are relative to the call, not trunk 
usage.

User Once for each trunk 
activity in the report.

The name associated with the extension that was the initial 
target of the call. For outbound calls (CallType = 3 in Call 
record), the user is the extension that first initiated the call. 
For inbound calls (CallType = 2 in Call record), the user is the 
extension that was the initial target of the call. In the case of 
Tandem calls (CallType = 4 in the Call record), nothing is 
shown.
This data is retrieved from the PartyIDName and 
PartyIDLastName fields of the Connect record for the party 
that initiated the call (ConnectReason = 19, “Originate” for an 
outbound call) or was the target of the call (ConnectReason = 
17, “Called” for inbound call).
Inbound and outbound are relative to the call, not trunk 
usage.

Duration Once for each trunk 
activity in the report.

The duration of the trunk activity. This data is retrieved from 
the Duration field of the Connect record for the trunk's 
involvement in the call. 
For an inbound call, the duration of the call begins when the 
trunk is seized and includes the ring time, talk time, and hold 
time. The duration ends when the user hangs up or when the 
external party hangs up and disconnect supervision is 
received by the ShoreTel system.
For an outbound call, the duration of the call begins when the 
trunk is seized. The duration ends when the user hangs up, or 
when the external party hangs up and disconnect supervision 
is received by the ShoreTel system.

Table B-7 Trunk Activity Detail Report Field Descriptions (Continued)

Field Presence/Frequency Description
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B.5.5 Workgroup Agent Summary Report
The Workgroup Agent Summary Report (Figure B-9) shows a summary of inbound 
workgroup calls and agent activity by the workgroup.

Figure B-9 Workgroup Agent Summary Report

B.5.5.1 Calls Included
This report includes calls routed to workgroup agents by the workgroup server, and non-
workgroup calls (both inbound and outbound). The report assigns non-workgroup calls to 
an agent's membership within a workgroup by examining the workgroup the agent was 
logged into during or before the call. No calls are reported when an agent is logged out. You 
can find Agent logins by examining the AgentActivity table for records with State = 5 
(LogInOut). 

Workgroup agents can be a member of more than one workgroup. When they log in, their 
login time is reported for all workgroups of which they are a member. 

Non-workgroup calls are reported against the workgroup with the lowest dial number that 
the agent is a member of when the call is made. For example, if the agent is a member of 
workgroups with dial numbers of 1100, 1200, and 1250, non-workgroup calls are reported 
against 1100. 

The StartTimeStamp field in these Agent Activity records represents the time that an agent 
logged into a specific workgroup (identified by the WorkgroupDN and WorkgroupName 
fields). The EndTimeStamp field records the time the agent logged out (this can be null 
when the agent is still logged into the workgroup). 

This report is call centric. While it does report agent activity, which consists of agent wrap-
up and login time, the report will only show this information for periods during which 
there was a call for the agent (workgroup or non-workgroup).

The Workgroup Agent Summary Report is described in Table B-8.

Subtotal The total of calls for the trunk.

Total The total of calls for the trunk group.

Grand Total The total of calls for all trunks in the system.

Table B-7 Trunk Activity Detail Report Field Descriptions (Continued)

Field Presence/Frequency Description
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Table B-8 Workgroup Agent Summary Report field descriptions

Field Presence/Frequency Description

Workgroup 
Name

Once for each 
workgroup being 
reported upon.

The name of the workgroup agent.

Agent Name Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The name of the agent and his or her extension. These come 
from the AgentActivity table's AgentLastName, Agent-
FirstName, and AgentDN fields.

Inbound 
WG Calls 
Qty, 
Duration, 
and Average 
Duration

Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The quantity, total duration, and average duration for all 
inbound workgroup calls during the reporting period are 
presented. Call is considered to be inbound if the CalType is 
set to 2 (Inbound). The quantity is simply a count of the 
Connect table records during the reporting period for this 
workgroup that indicate the call as inbound. Duration is the 
sum of all the Duration fields for the Connect table records 
during the reporting period for this workgroup. Average 
duration is found by dividing this total by the quantity 
reported here.

Inbound 
user Calls 
Qty, 
Duration, 
and Average 
Duration

Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The quantity, total duration, and average duration for all 
inbound user calls during the reporting period are presented. 
Call is considered to be inbound user if the CalType is set to 2 
(Inbound) and workgroup is not set in the call table. The 
quantity is simply a count of the Connect table records during 
the reporting period for this user that indicate the call as 
inbound. Duration is the sum of all the Duration fields for the 
Connect table records during the reporting period for this 
user. Average duration is found by dividing this total by the 
quantity reported here.

Outbound 
Calls Qty, 
Duration, 
and Average 
Duration

Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The quantity, total duration, and average duration for all 
outbound user calls during the reporting period are presented. 
Call is considered to be outbound user if the CalType is set to 
3 (Outbound) and workgroup is not set in the call table. The 
quantity is simply a count of the Connect table records during 
the reporting period for this user that indicate the call as 
outbound. Duration is the sum of all the Duration fields for 
the Connect table records during the reporting period for this 
user. Average duration is found by dividing this total by the 
quantity reported here.
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B.5.6 Workgroup Agent Detail Report
The Workgroup Agent Detail Report (Figure B-10) shows a list of every call for each agent 
by workgroup.

Figure B-10 Workgroup Agent Detail Report

An agent appears in the Workgroup Agent Detail Report if the agent had any workgroup 
call activity during the reporting period.

Other Calls 
Qty, 
Duration, 
and Average 
Duration

Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The quantity, total duration, and average duration for all other 
calls during the reporting period are presented. Call is 
considered to be other if the call is neither inbound nor 
outbound. The quantity is simply a count of the Connect 
table records during the reporting period. Duration is the sum 
of all the Duration fields for the records during the reporting 
period for this user. Average duration is found by dividing this 
total by the quantity reported here.

Total Calls 
Qty, 
Duration, 
and Average 
Duration

Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The quantity, total duration, and average duration for total 
calls during the reporting period are presented. It is sum of 
the all inbound, outbound and other calls. The quantity is 
simply a count of the Connect table records during the 
reporting period. Duration is the sum of all the Duration 
fields for the records during the reporting period for this user. 
Average duration is found by dividing this total by the 
quantity reported here.

Agent 
Activity 
Total 
Wrapup, 
Average 
Wrapup, 
and Total 
Login

Once for each agent 
reported upon (within 
an interval if intervals 
are selected when 
running the report).

The Total wrapup is simply the count of the wrapup records 
in the agent activity table during the reporting period for the 
agent. Average wrapup is found by dividing this total by the 
quantity reported here. The total login time is the time for 
which agent is logged in as workgroup agent.

Table B-8 Workgroup Agent Summary Report field descriptions (Continued)

Field Presence/Frequency Description
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B.5.6.1 Calls Included
This report includes calls routed to workgroup agents by the workgroup server, and non-
workgroup calls (both inbound and outbound). The report assigns non-workgroup calls to 
an agent's membership within a workgroup by examining the workgroup the agent was 
logged into during or before the call. Non-workgroup calls made while an agent is logged 
out are not reported. 

Workgroup agents can be a member of more than one workgroup. When they log in, their 
login time is reported for all workgroups of which they are a member. 

Non-workgroup calls are reported against the workgroup with the lowest dial number that 
the agent is a member of when the call is made. For example, if the agent is a member of 
workgroups with dial numbers of 1100, 1200, and 1250, non-workgroup calls are reported 
against 1100.

You can find agent logins by examining the AgentActivity table for records with State = 5 
(LogInOut). The StartTimeStamp field in these AgentActivity records represents the time 
that an agent logged into a specific workgroup (identified by the WorkgroupDN and 
WorkgroupName fields). The EndTimeStamp field records the time the agents logged out 
(this can be null when the agent is still logged into the workgroup).

The Workgroup Agent Detail Report is described in Table B-9.

Table B-9 Workgroup Agent Detail Report field descriptions

Field
Presence/
Frequency Description

Workgroup 
Name

Once for each 
workgroup being 
reported upon. 

The name of the workgroup agent. 

Agent Name Once for each 
agent reported 
upon (within an 
interval if 
intervals are 
selected when 
running the 
report).

The name of the agent and his or her extension. 
These come from the AgentActivity table's AgentLastName, 
AgentFirstName, and AgentDN fields. 

Date/Time Once for each call 
reported.

The date and time for the call being reported. These fields come 
from the StartTime field in the Call table record for the reported 
call. When interval reports are generated, the call is reported for 
the time when it starts even if it continues into another interval.

Dialed # Once for each call 
reported.

For inbound calls, this is the destination of the call. If the call 
was a DID or DNIS call, this is the DID or DNIS information for 
the number dialed. For other types of calls, this is the extension 
where the call first terminates.
The number dialed to initiate the call. This comes from the Call 
record's DialedNumber field.

Calling # Once for each call 
reported. 

The caller that initiated the call. For inbound calls, this is the 
calling number—ANI or Caller ID—received by the ShoreTel 
system and is reported as delivered by the PSTN (may or may 
not include the “1” in front of the area code).
This comes from the Call table's CallerID field. 
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Call Type Once for each call 
reported.

Indicates whether this is an incoming workgroup call (“InWG”), 
an inbound non-workgroup call (“In”), or an outbound call 
(“Out”). 
A call is categorized as an inbound workgroup call if the user 
joined the call as a workgroup agent. This is determined by 
examining the Connect record for the user's time on the call. 
The PartyType in the Connect record must be 12 (Workgroup 
Agent).
A call is categorized as an inbound non-workgroup call if the 
Call record's CallType = 1 or 2 (internal or inbound), and the 
user's Connect record has PartyType = 1 (station), and the user 
was not the originator of the call (ConnectReason in the 
Connect table not equal to 19-- originate).
A call is categorized as outbound if the user originated the call 
(as shown by the Connect record having ConnectReason = 19). 
These calls have CallType = 1 or 3 (internal or outbound) in the 
call record.
Note that for all calls, those calls with CallType = 1 (internal) are 
included only if the option to include internal calls is chosen.
Calls that involve multiple legs are also reported as:
Transfer—Call was transferred.
Conference—Call was conferenced
Monitor—Call was monitored
Barge-In—Call was barged

Other Calls Once for each call 
reported.

Indicates calls that do not belong to Call Type (i.e. those that are 
no In, InWG, or Out). This includes:
Transfer—Call was transferred.
Conference—Call was conferenced
Monitor—Call was monitored
Barge-In—Call was barged

Trunk Once for each call 
reported.

This is the first trunk that was used for the call. This data is 
retrieved from the PortName field of the Connect record for the 
trunk's involvement in the call. In the case of calls not involving 
a trunk, it will be blank (this can occur with internal calls). 

Call Duration Once for each call 
reported.

The duration of the call. Duration reports the time of the user's 
involvement in the call. It's reported by summing the TalkTime, 
RingTime, and HoldTime fields in the Connect record 
representing involvement in the call. 
Since a call is reported during the period in which it starts (as 
identified by the StartTime in the Call table record for the call) 
but may end during another interval, the duration can be longer 
than the 30- or 60-minute interval period. The total duration is 
reported during the interval in which the call begins. 

Table B-9 Workgroup Agent Detail Report field descriptions (Continued)

Field
Presence/
Frequency Description
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B.5.7 Workgroup Service Level Summary Report
The Workgroup Service Level Summary Report provides information related to the 
workgroup server call processing. Every time the workgroup server processes a call, a 
record about its disposition is added to the QueueCall table. Generally, this occurs once 
when the call gets processed by the server. However, in the case of call forwarding, the 
same call can pass through the workgroup server more than once. 

For example, a call made to the workgroup server is transferred to an extension. If that 
extension’s call handling mode forwards the call to the same or a different workgroup, the 
call passes through the workgroup server more than once. The rule in these cases is 
simple—for each time the workgroup server disposes of a call, a record is added to the 
QueueCall table.

The report always includes external calls to a workgroup. Internal workgroup calls are 
included in the report only if the option to include them is selected (the default is not 
included). The CallType field in the Call table is examined to determine if the call is internal 
or external. If the CallType is 1 (extension to extension), it is an internal call; otherwise it is 
an external call. The QueueCall record for a call processed by the workgroup server has a 
ConnectTableID that identifies the Connect table entry for the workgroup server being 
added to the call. The Connect table entry has a CallTableID field that is examined to 
determine the Call table record for the call, whether the call is internal or external.

If the workgroup service is not operational, the call is not processed by the workgroup 
server (it simply goes to the backup extension). Calls directed to the workgroup but not 
processed by the service because it is down are not included in this report. When this 
occurs, there is no record of the call in the QueueCall table since records are only added to 
the table when the workgroup server processes the call. Figure B-11 is an example of a 
Workgroup Service Level Summary Report.

Wrap-Up 
Duration

Once for each call 
reported.

Only applicable to inbound workgroup calls. This is the amount 
of time, if any, the agent spent in wrap-up after completing the 
call. 
The Wrap-up Duration is the difference between the 
StartTimeStamp and EndTimeStamp in the wrap-up record in 
the AgentActivity table for that agent. 

Queue Duration Once for each call 
reported.

Only applicable to inbound workgroup calls, the amount of time 
that the call was in the workgroup queue before it was assigned 
to the agent. This data is retrieved from the Duration field of the 
QueueCall table record for the call. 

Total Duration Once for each call 
reported.

The Total Duration includes the Queue Duration, Call Duration, 
and Wrap-up Duration. It is generally less than the total time the 
call spends within the ShoreTel system. The time between when 
the trunk was seized and the call was accepted by the 
workgroup, or any time the call spends with a menu or other 
extension, is not reflected. 

Sub-total The total calls for the workgroup agent.

Total The total calls for all agents in the workgroup.

Grand Total The total calls for all agents in the system.

Table B-9 Workgroup Agent Detail Report field descriptions (Continued)

Field
Presence/
Frequency Description
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Figure B-11 Workgroup Service Level Summary Report

The Workgroup Service Level Summary Report is described in Table B-10.

Table B-10 Workgroup Service Level Summary Report field descriptions

Field
Presence/
Frequency Description

Wait Time (sec.) Shown once for 
each 30-second 
period in 
workgroup/
internal where 
there are calls to 
be reported.

Range of wait-for-service times, The wait time is divided into 
30-second intervals. Information for the calls is reported for the 
interval in which it falls, according to when the call moved off 
the workgroup.
The actual wait or service time for each workgroup call is found 
in the Duration field of the QueueCall table. This duration is 
the time from when the call is offered to the workgroup server 
until it leaves the call queue.

Abandoned Once for each 
period reported.

Number of callers who abandoned the call (hung up) during 
the period. Those QueueCall records with the ExitReason set to 
7 (Abandoned) are counted as abandoned.

Handled by 
Agent

Once for each 
period reported.

Number of calls handled by agents during the period.
Those QueueCall records with the ExitReason set to 1 
(TransferToAgent) are counted as handled by an agent. A call 
that is picked up or unparked by an agent that is a member of 
the same workgroup is also counted as Handled by Agent.

Handled by 
Voice Mail

Once for each 
period reported.

Number of calls that went to the workgroup’s voice mail (either 
as a result of call handling, or when the caller chose the transfer 
to voice mail option).
Those QueueCall reports with the TargetType set to 3 (mailbox) 
and ExitReason set to 2, 3, 4, or 5 (ForwardAlways, 
ForwardBusy, ForwardNoAnswer, or ForwardNoLoginAgent), 
or 9 (TransferVM) with the TargetDN field equal to the 
workgroup DN itself are counted as Handled by Voice Mail.

Transfer Once for each 
period reported.

Number of calls transferred by WorkGroup agents.
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B.5.8 Workgroup Queue Summary Report
The Workgroup Queue Summary Report (Figure B-12) is a summary of queue activity and 
how the calls interact with the queue. The report can run with fixed interval sub-totals.

Figure B-12 Workgroup Queue Summary Report

Interflow / 
Overflow

Once for each 
period reported.

Number of automatic call transfers, based on caller wait time to 
a dialable number (interflow) or to another WorkGroup queue 
(overflow).

Handled by 
Others

Once for each 
period reported.

Number of calls handled by others (not workgroup agents or 
voice mail).
Any call for the workgroup that isn’t reported as Abandoned, 
Handled by Agent, or Handled by Voice Mail is counted as 
Handled by Others. Calls that are picked up by non-agents, or 
agents that do not belong to the group are counted as Handled 
by Others.

Total Calls Once for each 
period reported.

Sum of Abandoned, Handled by Agent, Handled by Voice Mail, 
Picked Up from the Queue, Unparked from the Queue, and 
Handled by Others for the period.

Table B-10 Workgroup Service Level Summary Report field descriptions 

Field
Presence/
Frequency Description
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B.5.8.1 Calls Included
The key determinant in this report is which workgroup server processes the call. Each time 
the workgroup server processes a call, a record about the call’s disposition is added to the 
QueueCall table. In most cases the call is recorded just once, but if forwarded, a call can be 
recorded twice. Normally the call comes in and is processed by the server where it is routed 
to an agent. The caller then chooses to go to voice mail or another destination, or hangs up 
(abandons the call) before it is routed beyond the workgroup. Since the report shows how 
the call was disposed of by the workgroup server, the call is reported once in the report. 
However, if the call is forwarded, the same call can pass through the workgroup server 
more than once. 

For example, a call goes to a workgroup server. While on the call, the user transfers it to 
another extension. The user’s extension's call handling mode forwards the call to the same 
or a different workgroup. In this case, the call passes through the workgroup server more 
than once and is reported each time the workgroup server processes the call. For each time 
the workgroup server processes the call, a record is added to the QueueCall table.

External calls to a workgroup are always included in the report. Internal workgroup calls 
are only included in the report if the option to include them is enabled (by default they are 
not). The CallType field in the Call table is examined to determine if the call is internal or 
external. If the CallType is 1 (extension to extension), it is an internal call; otherwise it is 
an external call. The QueueCall record for a call processed by the workgroup server has a 
ConnectTableID that identifies the Connect table entry for the workgroup server being 
added to the call. The Connect table entry has a CallTableID field that is then examined to 
determine the Call table record for the call. It is this record's CallType that is examined to 
determine whether the call is internal or external. 

If the workgroup service is not operational, the call is not processed by the workgroup 
server (it simply goes to the backup extension). These calls are not included in the report. 
When this occurs, there is no record of the call in the QueueCall table, since records are 
only added to that table when the workgroup server processes the call. 

The Workgroup Queue Summary Report is described in Table B-11.

Table B-11 Workgroup Queue Summary Report Field Descriptions

Field
Presence/
Frequency Description

Workgroup Name  The name of the workgroup.

Calls Abandoned Once for each 
period reported.

The number of callers who hung up or otherwise disconnected 
while waiting in queue.
Those QueueCall records with the ExitReason set to 7 
(abandoned) are counted as Abandoned.

Calls Handled by 
Agent

Once for each 
period reported.

The number of calls that were answered by agents in the 
workgroup.
Those QueueCall records with the ExitReason set to 1 
(TransferToAgent) are counted as Handled by Agent.

Calls Handled by 
Voice Mail

Once for each 
period reported.

Number of calls that went to the workgroup's voice mail (either 
as a result of call handling or when the caller chose to transfer 
to voice mail). 
Those QueueCall records with the TargetType set to 3 
(Mailbox), and ExitReason set to 2, 3, 4, or 5 (ForwardAlways, 
ForwardBusy, ForwardNoAnswer, or ForwardNoLoginAgent) 
or 9 (TransferVM) with the TargetDN field equal to the 
workgroup DN itself are counted as Handled by Voice Mail.
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B.5.9 WAN Media Stream Summary Report
The WAN Media Stream Summary Report (Figure B-13) shows the summary of call quality 
and call traffic for calls made over the WAN in multi-site deployments. By understanding 
the amount of time the WAN is used for calls, you can estimate the amount of toll charges 

Transfer Once for each 
period reported

Number of calls transferred by WorkGroup agents.

Overflow / 
Interflow

Once for each 
period reported.

Number of automatic call transfers, based on caller wait time to 
a dialable number (interflow) or to another WorkGroup queue 
(overflow).

Calls Handled by 
Others

Once for each 
period reported.

Number of calls handled by others (not workgroup's agents or 
voice mail).
Any call for the workgroup that isn't reported as Abandoned, 
Handled by Agent, Picked Up from the Queue, Unparked from 
the Queue, or Handled by Voice Mail is counted as Handled by 
Others.

Maximum 
Abandoned Time

Once for each 
period reported.

The maximum time during the period that a caller who 
abandoned the call stayed on the line.
The QueueCall records are examined for calls reported as 
abandoned during this period. The DurationSeconds field with 
the largest value for abandoned calls is reported.

Average 
Abandoned Time

Once for each 
period reported.

The average time during the period that those callers who 
abandoned the call stayed on the line.
The sum of the DurationSeconds field in all of the QueueCall 
records for abandoned calls during the period divided by the 
number of such calls to report the average time abandoned. 

Maximum 
Handled Time

Once for each 
period reported.

The maximum time during the period that a caller stayed on 
the line before the call was handled (by agent, voice mail, or 
others). Note that the maximum time could be zero even 
though there were handled calls in the case of the call being 
forwarded immediately to voice mail. 
The QueueCall records are examined for calls reported as 
handled during this period. The DurationSeconds field with the 
largest value for abandoned calls is reported.

Average Handled 
Time

Once for each 
period reported.

The average time during the period that a caller was on the line 
before the call was handled (by an agent, voice mail, or others). 
Note that the average time could be zero even though there 
were handled calls in the case of the call being forwarded 
immediately to voice mail.
The sum of the DurationSeconds field in all of the QueueCall 
records for handled calls during the period divided by the 
number of such calls to report the average time abandoned.

Total Calls Once for each 
period reported.

All calls passed through the workgroup. This includes calls that 
go straight to agents without waiting in queue.
Sum of Abandoned, Handled by Agent, Handled by Voice Mail, 
and Handled by Others for the period. 

Table B-11 Workgroup Queue Summary Report Field Descriptions (Continued)

Field
Presence/
Frequency Description
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your organization is saving. In addition, by understanding the jitter and packet loss, you 
can get an approximation of the quality of the WAN link and use this to influence your 
service provider if required. 

The Media Stream Report lists a matrix of all sites and the links to other sites on the system. 
Media streams are reported rather than calls, since this report focuses on the exact amount 
of bandwidth used. Calls can be quite complex involving multiple parties, including users, 
voice mail, and auto-attendant. Each media stream that is reported includes the associated 
Call ID (Call Identification) that can be correlated to the parties on the call for 
troubleshooting purposes using the CDR database. Figure B-13 is an example of the Media 
Stream Summary Report.

Figure B-13 Media Stream Summary Report

B.5.9.1 Calls Included
This report summarizes media streams (not calls) between the two sites. Media streams can 
be for extensions or trunks. You can configure the report to display information for all calls 
or for only intersite calls. IP phone media streams are not included in this report. 

The Media Stream Summary Report is described as follows:

Table B-12 WAN Media Stream Summary Report Field Descriptions

Field
Presence/
Frequency Description

Site A Once for each 
pair of sites being 
reported.

The name of the site. This data is retrieved from the 
ASiteName field in the MediaStream table. 

Site B Once for each 
pair of sites being 
reported.

The name of the site that communicates to Site A. 
This data is retrieved from the BSiteName field in the 
MediaStream table.

Quality - Avg 
Jitter

Once for each 
pair of sites being 
reported.

The average jitter is the average of the per-media 
stream maximum jitter between the sites given in 
milliseconds. This data is retrieved from the A 
MaxJitter and B MaxJitter fields in the MediaStream 
table.
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B.5.10 WAN Media Stream Detail Report
The WAN Media Stream Detail Report (Figure B-14) shows details of each media stream 
placed over the WAN. You can configure the report to display information for all calls or for 
only intersite calls.

Quality - Max 
Jitter

Once for each 
pair of sites being 
reported.

The maximum jitter is the worst jitter encountered 
on any media stream between the sites given in 
milliseconds. This data is retrieved from the A 
MaxJitter and B MaxJitter fields in the MediaStream 
table. The jitter buffer should be larger than this 
value for proper operation. 
The 'max jitter' value in this report is only recorded 
up to the maximum jitter buffer value configured in 
Director.

Quality - % 
Packet Loss

Once for each 
pair of sites being 
reported.

This is the number of packets that were expected to 
arrive but did not arrive at the destination. Lost 
packets were mostly likely dropped on their way 
through the network.

Quality - 
Blocked Calls

Once for each 
pair of sites being 
reported.

The number of media that were not routed across the 
WAN due to insufficient WAN bandwidth 
(admission control reached). This could indicate that 
more WAN bandwidth is required.
This is a count of the number of records in the 
MediaStream table between the two sites with 
FailureCode = 1 (Admission Control Inhibited Call). 

Traffic Volume - 
Total

Once for each 
pair of sites being 
reported.

The number of media streams used between the two 
sites as recorded in the MediaStream table.

Traffic Volume - 
Duration

Once for each 
pair of sites being 
reported.

The duration of all the media streams used between 
the two sites. The value is the sum of duration for all 
records between the two sites in the MediaStream 
table.

Traffic Volume - 
Avg Duration

Once for each 
pair of sites being 
reported.

The average duration of all the media streams used 
between the two sites. The average is total duration 
of the media streams between the two sites divided 
by the number of such media streams. 

Table B-12 WAN Media Stream Summary Report Field Descriptions (Continued)

Field
Presence/
Frequency Description
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Figure B-14 WAN Media Stream Detail Report

B.5.10.1 Call Included
See the Media Stream Summary Report for information about selection. This report calls 
out each media stream established between two sites. 

IP phone media streams are not included in this report. 

The Media Stream Detail Report is described in Table B-13.

Table B-13 WAN Media Stream Detail Report Field Descriptions

Field
Presence/
Frequency Description

Site A Once for each 
media stream.

The name of the site. This data is retrieved from the 
ASiteName field in the MediaStream table.

Site B Once for each 
media stream.

The name of the site that communicates to Site A. This 
data is retrieved from the BSiteName field in the 
MediaStream table.

Start Time Once for each 
media stream.

The time the media stream began. This data is retrieved 
from the StartTime field in the MediaStream table.

WAN Once for each 
media stream

“Yes” indicates the media stream accessed the WAN. 
“No” indicates the media stream did not access the WAN.

CallID Once for each 
media stream.

The Call Identification number for the media stream 
listed on the detail report. By matching the CallID in the 
report to the CallID of a WAN call with voice quality 
issues, you can understand the cause of the problems. 
This data is retrieved from the CallID field in the 
MediaStream table.
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B.5.11 Account Code Summary Report
Summarizes call information for each account, including number of calls each day, along 
with their total and average duration. There are also totals for the reporting period. This 
report allows the administrator to indicate whether there should be summary information 
for each account. If this is desired, each extension’s use of the account is summarized. If 
not, there's a simple total for the entire account code.

Account Codes are only applicable to outgoing calls. Outgoing calls are identified in the 
Call table of the CDR database with the CallType field set to 3 (Outbound). The only 
outgoing calls that appear in the report are those calls for which an Account Code was 
collected (the account code is recorded in the BillingCode field of the Call table). If the user 
does not provide an account code on an outgoing call (because it isn't required, or it is 
optional and they choose not to provide it), that call does not show up on the report. 
Figure B-15 is an example of the Account Code Summary Report.

Encoding Once for each 
media stream.

The method of voice encoding used for the media stream. 
This data is retrieved from the EncodingType field in the 
MediaStream table. The EncodingType field can have the 
following values for encoding methods: 
1 ALAW – PCMA/8000 (or G711A)
2 MULAWPCMU/8000 (or G711μ)
3 LINEARL16/16000
4 ADPCMDVI4/8000
5 G729AG729A/8000
6 G729BG729B/8000
7 LINEARWIDEBANDL16/16000
8 G722G722/8000
9 BV32BV32/16000
10 BV16BV16/8000
11 AAC_LC32000AAC_LC/32000
12 CustomCodec added by administrator

Max Jitter Once for each 
media stream.

The maximum jitter encountered. This value is the 
maximum of the A MaxJitter or B MaxJitter for the record 
in the MediaStream table for the media stream.
If a significant number of calls are reported with a Max 
Jitter value close or equal to the Maximum Jitter Buffer 
value, you may want to increase the Maximum Jitter 
Buffer or investigate the cause of excess jitter in the 
network.

% Packet 
Loss

Once for each 
media stream.

This is the number of packets that were expected to arrive 
but did not arrive at the destination. Lost packets were 
mostly likely dropped on their way through the network.

Duration Once for each 
media stream.

The duration of time the media stream was used across 
the WAN connection. 
This data is retrieve from the DurationSeconds field of the 
MediaStream table record for this call. 

Table B-13 WAN Media Stream Detail Report Field Descriptions (Continued)

Field
Presence/
Frequency Description
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Figure B-15 Account Code Summary Report

The Account Code Summary Report fields are described Table B-14.

Table B-14 Account Code Summary Report Field Descriptions

Field Presence/Frequency Description

Account Shown once for each 
account being 
reported on.

The account code that users enter to identify the account that 
a call is logged against. The name of the account code as 
configured in Director is also shown. For example, “300 
(Marketing),” where “300” is the account code and 
“Marketing” is the name. For each call where account code 
information is collected, the account code is stored in the 
BillingCode field of the Call table. The name of the account 
code is stored in the FriendlyBillingCode field.

User Only shown if the 
report option is 
selected to “Enable 
User Breakdown.” 
Shown once for each 
user who made calls 
for the account being 
reported upon. 

The name and extension of the user who originated calls 
summarized in the report. For example, “John Smith 
(x3415).”
The Extension field in the Call table identifies the party who 
originated the account code call. The extension field is where 
the report gets the extension number information. The name 
of the user comes from the PartyID (the first name) and 
PartyIDLastName (the last name) fields of the Connect 
record for the party that originated the call. The Connect 
record is tied to the Call table record, by the CallTableID field 
in the Connect table. All the Connect records for a particular 
call have the same CallTableID setting. 
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B.5.12 Account Code Detail Report
The Account Code Detail Report (Figure B-16) provides a detailed list of calls that occurred 
for each account. For each call the date and time of the call, number dialed, the extension 
making the call, and the duration of the call is included. For each account, a summary is 
provided of the number of calls, along with their total and average duration.

Account codes are only applicable to outgoing calls. Outgoing calls are identified in the 
Call table of the CDR database with the CallType field set to 3 (Outbound). The only 
outgoing calls that appear in the report are those calls for which an account code was 
collected (the account code is recorded in the BillingCode field of the Call table). If the user 
does not provide an account code on an outgoing call (because it isn't required, or it is 
optional and they choose not to provide it) that call does not show up on the report.

Total Calls Repeated for each row. The total number of calls for a particular day for the account. 
The total is broken down by user within each account if the 
“Enable User Breakdown” option is selected. A call is 
reported for the day on which the call started. That is, if a call 
starts on one day but ends on the next day, it is only reported 
for the day on which it started. The start of the call comes 
from the StartTime field in the Call table record for each call.

Total Duration Repeated for each row. The total duration of the calls being reported on the row. The 
duration is the total call duration, even if the call was 
transferred to parties such that the originator of the call was 
not on the call for the entire period. Duration is reported in 
the day the call started, but includes the entire call duration. 
For example, a call starts on 1/17 (with 20 minutes on 1/17) 
and ends on 1/18 (with 30 minutes on 1/18). The call is 
reported on 1/17 with duration of 50 minutes. This is then 
included in the total duration for all calls on 1/17.
The duration of each call in this report comes from the 
Duration field in the call table. 

Average 
Duration

Repeated for each row. Calculated by dividing the total duration for a row by total 
calls. 

Table B-14 Account Code Summary Report Field Descriptions (Continued)

Field Presence/Frequency Description
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Figure B-16 Account Code Detail Report

The Account Code Detail Report fields are described in Table B-15.

Table B-15 Account Code Detail Report Field Descriptions

Field
Presence/
Frequency Description

Account Shown once for 
each account 
being reported on

The account code that users enter to identify the account that a 
call is logged against. The name of the account code as configured 
in Director is also shown. For example, “300 (Marketing),” where 
“300” is the account code and “Marketing” is the name. 
For each call where account code information is collected, the 
account code is stored in the BillingCode field of the Call table. 
The name of the account code is stored in the 
FriendlyBillingCode field.

Date Repeated for each 
call.

The date on which the call started. A call is reported for the day 
on which the call started. That is, if a call starts on one day, but 
ends on the next day, it is only reported for the day that it started 
on. 
The Date is extracted from the StartTime field in the Call record 
for each call in the report. 

Time Repeated for each 
call.

The time at which the call started. 
Time comes from the StartTime field in the Call table record for 
each call in the report. 
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B.6 CDR Database
This appendix specifies how data is stored in the CDR database tables. The CDR database 
records call data in the following tables:

• Call Table: An entry is made in the Call table for each call in the ShoreTel system. 
Other tables often reference the entries to the Call table.

• Connect Table: An entry is made in the Connect table for each connection to a call. 
When used with the Call table, a complete call history is provided.

• MediaStream Table: An entry is made in the MediaStream table each time there is a 
media stream between two switches that are at different sites. In some cases, such as 
for conference calls, there may be multiple media streams per call. 

• AgentActivity Table: An entry is made in the AgentActivity table each time a 
workgroup agent logs into a workgroup and when he or she completes wrap-up. 

• QueueCall Table: An entry is made in the QueueCall table for each call that is 
handled by a workgroup server. The entry identifies how the call leaves the 
workgroup—either by abandonment or for handling. 

• QueueStep Table: An entry is made in the QueueStep table for each step where the 
workgroup server either hunts for agents or walks through workgroup queue steps. 
This provides more detailed information about how the call was disposed of by the 
workgroup server.

• QueueDepth Table: An entry is made in the QueueDepth table each time the depth 
of a workgroup server's call queue changes. 

In addition to the tables listed above, the database contains a number of enumeration 
tables, which are documented below when discussing the tables that reference these 
enumeration/lookup tables. 

Logged data is reflective of the time of the logging. For example, certain records contain the 
name of a trunk group from the configuration database. The name of the trunk group may 
be changed in the configuration database. New log entries reflect the changed name, but 
existing logs continue to have the old name. 

Dialed 
Number

Repeated for each 
call.

The number that was dialed to begin the call.
Dialed Number comes from the DialedNumber field in the Call 
table record for each call in the report. 

Calling 
Extension

Repeated for each 
call.

The number of the user that originated the call. 
Calling Extension comes from the Extension field in the Call table 
record for each call in the report. 

Duration Repeated for each 
call.

The total duration of the calls being reported on the row. The 
duration is the call duration, even if the call was transferred to 
parties such that the originator of the call was not on the call for 
the entire period.
The duration of each call in this report comes from the Duration 
field in the Call table.

Table B-15 Account Code Detail Report Field Descriptions (Continued)

Field
Presence/
Frequency Description
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B.6.1 Call Table
The CDR database reflects all calls within the system with a few exceptions which are listed 
below. These exceptions reflect the ShoreTel Telephony Management Server (TMS) that 
allows calls to continue even when portions of the system or network are not available. As 
the TAPI service provider for the ShoreTel Server, TMS manages the call control 
communications between all other ShoreTel services.

The exceptions are:

• If TMS is not connected to any of the call endpoints, the call is not recorded in the 
Call table. Because of network outages, TMS may not be connected to call endpoints, 
yet the call endpoints may have the connectivity necessary to complete the call (for 
example, the switches are able to communicate with each other but not to TMS). 

• If TMS is not connected to some of the call endpoints (for example, a switch 
involved in the call), the information about the call can be incomplete (for example, 
the information in the Connect table as explained in the next section would only 
reflect some of the parties involved in the call). 

• If TMS is restarted, any call entries that were incomplete, along with their associated 
Connect entries are destroyed. Incomplete calls do not show “Yes” in the locked 
field.

• Also at TMS restart time, TMS logs any calls in progress. 

Figure B-17 illustrates how new entries are added to the Call table whenever there is a call 
in the ShoreTel system. Note that an entry is added to the Call table when the call begins 
(or when TMS starts up, for any calls in progress) and is updated when the call ends.

Figure B-17 New Entries in the Call Table
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The Call table is reference by other tables, most important among them being the Connect 
table. You can analyze the Call and Connect tables to understand the complete disposition 
of a call as attempts are made to add parties, transfers occur, and so on. Other tables can 
index the Call table, through the primary key “ID,” which is unique for each record. 

There is a CallID field that is used internally by the ShoreTel system to identify calls. This, 
however, should not be used as the index into the table).   

Close examination of the Call table shows that there are more calls recorded than you may 
initially expect. For example, if a call is made to a workgroup, you will see an initial call, 
generally from an incoming trunk. As agents are hunted, calls are made by the workgroup 
server to agents. If multiple agents are hunted, there will be multiple calls. Once one of the 
agents is successfully hunted, if you looked at the Connect table you see the agent being 
attached to the original call. Table B-16 provides information about the elements in the Call 
Table.

Table B-16 Call Table Field Descriptions

Field Name Data Type Description

ID AutoNumber Unique identifier. (4-byte integer, required)

CallID Number Number for the existence of the call. (4-byte integer)

SIP GUID Text SIP Global ID number (32 characters, zero-length)

StartTime Date/Time For an inbound call, this is when the trunk has been seized. For an 
outbound call, this is when the user has completed dialing. (8-byte 
date/time, required)

StartTimeMS Number Append this information to the StartTime to reduce the absolute 
start time to the millisecond when the call began. (2-byte integer, 
required)

EndTime Date/Time Time when the call terminates (either by the near end hanging up or 
when the end external to the system hangs up) and the ShoreTel 
switch receives the notification of the disconnect. (8-byte date/time)

EndTimeMS Number Append this information to the StartTime to reduce the absolute 
start time to the milliseconds of when the call began (milliseconds). 
(2-byte integer, required)

CallNote Text User entered Call Note. This can be added from the ShoreTel 
desktop client. (64 characters, zero-length)

BillingCode Text Account code assigned to the call. (32 characters, zero-length) 

Locked Yes/No Read-only status for this call (set once call has ended). Not locked 
means the call is still in progress. (boolean)

Extension Text For an outbound or extension-to-extension call, the extension has 
the dialed number of the originator of the call.
This field is blank for an outbound call from an anonymous phone 
with no currently assigned DN. 
For an inbound call, the extension field contains the DN of the last 
party involved in the call (excluding voice mail or auto-attendant). 
For instance, an incoming call to an extension that transferred the 
call to extension 300 has “300” in the extension field (the complete 
history of parties connecting to the call can be found on the Connect 
table).
All calls to an extension that forwarded to voice mail have the 
extension of the called party and not the voice mail number. (15 
characters, zero-length)
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B.6.2 Enumeration Tables: Use for the Call Table

B.6.2.1 Call Type

B.7 Connect Table
The Connect table contains a record for each party in a call. There are many different types 
of parties that can be reflected in the table including individual user extensions, 
workgroups, workgroup agents, and trunks.

Figure B-18 illustrates how new entries are added to the Connect table each time a party is 
added to a call within the ShoreTel system.

Duration Date/Time Elapsed time of the call from beginning to end. Calculated by 
subtracting StartTime from EndTime. Start time begins when the 
first party is added to a call. End time is when the last party leaves 
resulting in the end of the call. (8-byte date/time).

CallType Number See enumeration in CallType table. (1-byte integer, required)

WorkGroupCall Yes/No Is this a workgroup call? Yes indicates that the workgroup server 
was involved in processing the call. 
If the call was directed toward a workgroup server, but that server 
was unavailable, then this field is set to “No” because the workgroup 
server never becomes involved in the call. (boolean)

LongDistance Yes/No From the perspective of the trunk for the call, did this call involve a 
long distance connection? The first connect record of the call is used 
to determine whether a call is long distance. If the first leg is an 
extension call, the value is always No.
A trunk call can be transferred or conferenced, so the total long 
distance time can only be determined by examining all Connect 
records. (boolean)

DialedNumber Text Extension-to-extension and outbound: Number dialed plus trunk 
access code if any. (15 characters, zero-length)

CallerID Text For CallType=Inbound only: Caller-ID number if present. If blocked 
or unavailable text is provided by the PSTN to indicate caller ID as 
unavailable it is included here; for example, the text may be 
“blocked” or “unavailable” (15 characters, zero-length)

Archived Yes/No Has this call been archived? (boolean)

Table B-17 Call Type Descriptions

Call Type Name Description

0 Null

1 ExtToExt Extension-to-extension call.

2 Inbound A trunk is the originating party.

3 Outbound An extension is originating and a trunk is called.

Table B-16 Call Table Field Descriptions

Field Name Data Type Description
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Figure B-18 New Entries in the Connect Table

B.7.1 Connect Table Field Descriptions
Table B-18 describes the Connect Table data fields.

Table B-18 Connect Table Field Descriptions

Field Name
Data 
Type Description

ID Auto-
Number

Unique identifier. (4-byte integer – required)

PartyType Number Party that initiated the call. Value corresponds to value from 
Connect Type Party Type table (Table B-19). (6-bit integer – 
required)

CallTableID Number Link to Call Table ID Key. (20-bit integer – required)

LineID Number TAPI permanent line ID for this party. (20-bit integer – required)

SwitchID Number Party’s Switch ID – unique ID assigned to configuration database to 
ShoreTel switch. Data only available through database – not 
Director. 
Value of 0 indicates the party is a workgroup, voicemail, or an 
unassigned user. In these cases, DN is are not assigned to a switch/
port. (11-bit integer)

PortNumber Number Party’s port number corresponding to physical port or channel 
number on the ShoreTel switch.
Value of 0 indicates the party is a a workgroup, voicemail or 
unassigned user. (11-bit integer)
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PortID Number Party’s port ID – if any. Unique ID assigned to ShoreTel switch port 
by configuration database. Data available through database – not 
Director.
Value of 0 indicates the party is a workgroup, voicemail, or an 
unassigned user. (11-bit integer)

PortName Text Name of port (Trunk or Extension) – user defined in Director. (50 
characters)

GroupID Number Unique ID assigned by configuration database. (11-bit integer) 
Value is a TrunkGroupID if PartyType=Trunk.
Value is UserGroupID if PartyType=Station.
Value is 0 if it is not applicable.

GroupName Number Data is defined is Director by use. (50 characters)
If PartyType=Station, value is name of the User-Group
If PartyType=Trunk, value is Trunk-Group.

ConnectTime Date/
Time

Time when party was added to call.
Initial parties on inbound call, value indicates time trunk was 

seized.
Initial parties on outbound call, value indicates time dialing was 

complete.

ConnectTimeMS Number Append to ConnectTime to determine start time of call with 
millisecond precision. (11-bit integer, milliseconds)

DisconnectTime Date/
Time

Time when party disconnected from call.

DisconnectTimeMS Number Append to DisconnectTime to determine end time of call with 
millisecond precision. (11-bit integer, milliseconds)

ConnectReason Number Connect reason code. Refer to Table B-21. (6-bit integer – required)

DisconnectReason Number Disconnect reason code. Refer to Table B-22. (6-bit integer – 
required)

PartyIDFlags Number Caller ID flags that specifies the data available in ID and Name 
fields

Internal party: number, name and last name from system address 
book. 

External party: data corresponds to caller ID field provided by the 
PSTN. Refer to Table B-20. (6-bit integer – required)

PartyID Text Number of party. Refer to PartyIDFlags field. (50 characters)

PartyIDName Text Name of party. Refer to PartyIDFlags field. (50 characters)

PartyIDLastName Text Last name of party. (50 characters)
Field is blank for external party – PartyIDName contains first and 
last name, as provided by PSTN Caller ID service.

CtrlPartyIDFlags Number Caller ID flags that specifies the data available in ID and Name 
fields for the controlling party. Controlling party causes the event. 
Example: for an entry listing a call was transferred from extension 
400 to extension 300, the controlling party is extension 400. 
Original call will not have a control party.
Refer to Table B-20. (6-bit integer – required)

Table B-18 Connect Table Field Descriptions (Continued)

Field Name
Data 
Type Description
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B.7.2 Enumeration Tables Used for Connect Table

B.7.2.1 PartyType
Table B-19 lists the Connect Table party types.

CtrlPartyID Text Number of controlling party. Refer to CtrlPartyIDFlags field. (50 
characters)

CtrlPartyIDName Text Name of controlling party. Refer to CtrlPartyIDFlags field. (50 
characters)

CtrlPartyIDLastName Text Last name of controlling party. (50 characters)

MailboxID Text Mailbox ID if PartyType=VMForward or VMLogin
PartyType=VMForward – specifies mailbox receiving forwarded 

message.
PartyType=VMLogin – specifies original target mailbox.

RelatedCallTableID Number Reserved. (20-bit integer).

TalkTime Date/
Time

Total connect time. Calls with more than 24 hours include the date. 
Date not included on calls shorter than one hour. (8-byte date/
time)
Example: A 25 hour call has a TalkTime of 1 day and 1 hour.

TalkTimeSeconds Number The seconds component of the TalkTime. (20-bit integer, seconds)

HoldTime Date/
Time

Time on hold. Includes date on calls with more than 24 hours hold 
time. Date not included on calls with less than one hour hold time. 
(8-byte date/time)
Example: A call with 25 hour time has a HoldTime of 1 day and 1 
hour.

RingTime Date/
Time

Inbound calls: time spent offering 
Outbound calls: ringback time.

Duration Date/
Time

The time between ConnectTime and DisconnectTime

LongDistance Number Lists trunk connected long distance for outbound calls if 
PartyType=trunks

TrunkDirection Number Indicates inbound / outbound direction. Refer to TrunkDirection 
Enumeration Table.

SecurityFlag Number AES/SRTP flags that indicates call encryption status. (6-bit integer)

SiteName Text Reserved (50 characters)

ServerName Text Reserved (64 characters)

Table B-18 Connect Table Field Descriptions (Continued)

Field Name
Data 
Type Description
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B.7.2.2 PartyIDFlag
Table B-20 lists the Connect Table party ID flags.

Table B-19 Party Type Enumeration Table

Type 
# Party Type Description

0 Null

1 Station User extension which is currently assigned a home port; 
sometimes referred to as a “logged in user”.

2 Trunk Trunk (of any kind).

3 Virtual A user extension which does not currently have an assigned home 
port (sometimes referred to as a “logged out user”).

4 Workgroup Workgroup extension.

5 AutoAttendant Auto-Attendant extension.

6 VMForward Voice mail forward extension (take a message).

7 VMLogin Voice mail login extension.

8 BackupAA Backup auto-attendant (built into switch).

9 AnonPhone Anonymous telephone.

10 Nightbell Nightbell extension.

11 Paging Paging extension.

12 WorkgroupAg
ent

Records marked as WorkgroupAgent for calls transferred from a 
Workgroup to an Agent. Direct inbound calls to an agent are 
Station type.

13 Unknown Unknown type.

14 RoutePoint Route point.

Table B-20 Party ID Flag Enumeration Table

Flag # Party ID Flag Name Description

0 Null

1 Blocked Blocked

2 OutOfArea Out-Of-Area

4 Name Name

8 Address Address

12 NameAddress Name & Address

16 Partial Partial

32 Unknown Unknown

64 Unavailable Unavailable
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B.7.2.3 ConnectReason
Table B-21 lists the Connect Table connect reason codes.

B.7.2.4 Disconnect Reasons
Table B-22 lists the Connect Table disconnect reason codes.

Table B-21 Connect Reason Enumeration Table

Connect #
Connect 
Reason Description

0 Null

1 Direct TMS was not available when the party connected to the call. 
Connection information is logged, but there is no more 
ConnectReason information. 

2 ForwardBusy The party was connected because the previous party's call 
handling mode was set to forward calls if the previous party 
was busy. 

3 ForwardNoAns
wer

The party was connected because previous party's call 
handling mode was set to forward calls if the previous party 
didn't answer.

4 ForwardAll The party was connected because previous party's call 
handling mode was set to forward all calls.

5 Pickup The call was connected because the called party answered the 
call. 

6 Unpark Unpark

7 Redirect Redirect

8 Completion Completion

9 Transfer The call was connected after the call was transferred to the 
party.

10 Reminder Reminder

11 Unknown Unknown

12 Unavailable Unavailable

13 Intrude Intrude

14 Parked Parked

15 CampedOn CampedOn

16 RouteRequest RouteRequest

17 Called The party was added to the call because it was the initial 
target of the call.

18 Forward Forward

19 Originate The party initiated this call.

20 Conference The party was added to the call because the party was 
conferenced into the call.
662



Appendix B: Call Detail Record Reports System Administration Guide
B.7.2.5 Trunk Direction 
Table B-23 lists the Trunk Direction flags.

Table B-22 Disconnect Reason Enumeration Table

Reason 
#

Disconnect 
Reason Description

0 Null

1 Normal Normal termination

2 Unknown Unknown reason

3 Reject Call Call was rejected

4 Pickup Call Call picked up by other destination

5 Forwarded Call Call forwarded to another destination

6 Busy Busy destination

7 NoAnswer No answer by destination

8 BadAddress Bad address

9 Unreachable Destination cannot be reached

10 Congestion Inadequate bandwidth

11 Incompatible Destination is incompatible

12 Unavailable Destination is unavailable

13 NoDialTone No dial tone from the trunk

14 NumberChange
d

Destination number changed

15 OutOfOrder Destination out of order

16 TempFailure Temporary failure

17 QoSUnavailable QoS not available

18 Blocked Destination blocked

19 DoNotDisturb Do not disturb

20 Cancelled Call cancelled

21 Unpark Call unparked to different destination

Table B-23 Trunk Direction Enumeration Table

Flag # Party ID Flag Name Description

2 Inbound The trunk direction is established by the central office

3 Outbound The trunk direction is established by the local system.
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B.8 MediaStream Table
The MediaStream table logs media information about InterSite Calls. At a high level, there 
is one such entry for each InterSite call. Information about both parties involved in the call 
is recorded. Table B-24 describes the elements in the MediaStream Table.

Table B-24 Media Stream Data Field Descriptions

Field Name Data Type Description

ID AutoNumb
er

Unique identifier. (4-byte integer, required)

CallID Number Unique number for the existence of the call. (4-byte integer)

SIP GUID Text SIP Unique Global ID number (32 characters, zero-length)

EncodingType Number Encoding type used for media stream. (1-byte integer)

PayloadSize Number Media payload size in bytes for each media packet. (4-byte 
integer)

StartTime Date/Time Date and time the call started.

Duration Date/Time Elapsed time of call from begin to end. (8-byte date/time)

DurationSeco
nds

Number Elapsed seconds time of call from begin to end. (4-byte 
integer)

FailureCode Number Error code. See MediaFailureCode table for enumeration. (1-
byte integer)

A PartyType Number Party A's type enumeration. See the PartyType table. (1-byte 
integer)

A SiteID Number Party A's Site ID. (4-byte integer)

A SiteName Text Party A's Site Name. (50 characters, zero-length)

A LineID Number TAPI permanent line ID for party A. (4-byte integer)

A Name Text Call type name for party A. (50 characters, zero-length)

A_Extension Text Call extension number for party A (32 characters, zero-
length)

A IP Address Text Local IP Address for party A. (15 characters, zero-length)

A 
TotalPackets

Number Total packets received by party A. (4-byte integer)

A LostPackets Number Total packets lost by party A. (4-byte integer)

A MaxJitter Number Maximum jitter (ms) for party A. (4-byte integer)

A Underruns Number Number of receive underruns for party A. (4-byte integer)

A Overruns Number Number of receive underruns for party A. (4-byte integer)

B PartyType Number Party B's type enumeration. (1-byte integer)

B SiteID Number Party B's Site ID. (4-byte integer)

B SiteName Text Party B's Site Name. (50 characters, zero-length)

B LineID Number TAPI permanent line ID for party B. (4-byte integer)

B Name Text Call type name for party B. (50 characters, zero-length)
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B.9 AgentActivity Table
The AgentActivity Table has information about the workgroup agents’ availability. Entries 
are made to record agents’ Login/Logout from the workgroup and to reflect their time in 
Wrapup mode. Figure B-19 illustrates the flow of new entries being added to the 
AgentActivity table.

Figure B-19 Entries to the AgentActivity Table

B_Extension Text Call extension number for party B (32 characters, zero-
length)

B IP Address Text Local IP Address for party B. (15 characters, zero-length)

B 
TotalPackets

Number Total packets received by party B. (4-byte integer)

B LostPackets Number Total packets lost by party B. (4-byte integer)

B MaxJitter Number Maximum jitter (ms) for party B. (4-byte integer)

B Underruns Number Number of receive underruns for party B. (4-byte integer)

B Overruns Number Number of receive overruns for party B. (4-byte integer)

InterSite Yes/No Indicates a logged call is InterSite. Only Intersite calls are 
logged.

Archived Yes/No Has this entry been archived? (boolean)

Table B-24 Media Stream Data Field Descriptions (Continued)

Field Name Data Type Description
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The left flow shows how each time a workgroup agent logs in, a LogInOut entry is added, 
which is then updated at logout time. The right flow shows how the AgentActivity table is 
also updated as agents complete their handling of workgroup calls. Table B-25 describes 
the elements in the Agent Activity table.

• Two types of records are placed in the AgentActivity table. The State field identifies 
the type of record. 

• LogInOut Records record the time that an agent is logged into the workgroup.

• Wrapup records record the time that an agent is in wrapup state.

• All records in the table should have ID, AgentDN, AgentFirstName, AgentLastName 
(unless blank), State, WorkGroupDN, WorkGroupName, StartTimeStamp, and 
Archived.

• LogInOut Records may exist for agents that have Logged into the workgroup but 
have not yet logged out. For these records the StartTimeStamp indicates the time 
when the agent logged into the workgroup. The EndTimeStamp is updated when the 
agent logs out of the workgroup with the time of the logout. 

• For wrapup records the StartTimeStamp indicates the time when the agent entered 
wrapup time and EndTimeStamp indicates when they exit wrapup state. 

Table B-25 Agent Activity Table field descriptions

Field Name Data Type Description

ID AutoNumber Unique identifier. (4-byte integer, required)

CallID Number Unique number for the existence of the call. Provided 
in wrapup records. (4-byte integer)

AgentDN Text WorkGroup Agent’s dialed number (extension). (15 
characters, zero-length)

AgentFirstName Text WorkGroup Agent’s First Name (50 Characters, zero-
length). 

AgentLastName Text WorkGroup Agent’s Last Name (50 Characters, zero-
length) (may be blank if the agent doesn’t have a last 
name in the configuration database)

State Number Enumerated Agent State—set AgentStateLUT for 
possible values.

WorkGroupDN Text WorkGroup dialed number (extension) for which this 
agent activity is for (15 characters, zero-length)

WorkGroupName Text Workgroup’s name. (50 Characters, zero-length)

StartTimeStamp Date/Time Start time stamp. For LogInOut records, 
StartTimeStamp indicates the time when the agent 
logged into the workgroup. For wrapup records, the 
StartTimeStamp indicates the time when the agent 
entered wrapup time. See notes below. (8-byte date/
time).

EndTimeStamp Date/Time End time stamp (8-byte date/time).

Archived Yes/No Has this entry been archived? (boolean)
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• Wrapup records can contain a CallID to identify the Call that the agent was wrapping 
up from for the Wrapup record. This will not be provided in cases where the agent is 
manually placed in wrapup state when not on a call. 

• There is always a wrapup record when an agent wraps up a call, even for the case 
where wrapup time is set to zero. 

B.9.1 Enumeration Tables Used for AgentActivity
Table B-26 lists the Agent Activity Enumeration Tables.

Login and Logout are no longer used.

B.10 QueueCall Table
Each time a call is processed by the workgroup server, an entry is made in the QueueCall 
table. A workgroup is a call queuing mechanism, thus the name “QueueCall” in the CDR 
database. 

Each time a call is made to a workgroup when the workgroup server is operational, an 
entry is made in the QueueCall table; moreover, there is only one entry for each call. In 
other words, one and only one entry appears for each call. A call can be made to the 
workgroup dialed number, but if the workgroup server does not process the call, an entry is 
not made in the QueueCall table for the call. Moreover, the call will not be marked as a 
workgroup call in the call table. 

Figure B-20 illustrates how updates are made to the QueueCall table.

Table B-26 Agent Activity Enumeration Table

State 
# AgentState Description

0 Null

1 Reserved Previously used for Login

2 Reserved Previously used for Logout

3 Wrap_Up Agent performing post-call wrap-up

4 Reserved Temporarily used for Outcalls

5 LogInOut Agent Login later updated with Logout time.

6 SecLogInOut Secondary login activity for agents belonging to multiple 
Workgroup.
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Figure B-20 New Entries to the CallQueue Table

Each entry in the QueueCall table contains the following fields as shown in Table B-27.

Table B-27 Queue Call Table Field Descriptions

Field Name Data Type Description

ID AutoNumber Unique identifier. (4-byte integer, required)

CallID Number Unique number for the existence of the call. (4-byte integer)

ConnectTableID Number Link to Connect Table ID Key. You can find more information 
about the connection to the call in the connect table. The Connect 
table entry here is for the Workgroup DNs connection to the call. 
If you want information from the Call table entry for this call, the 
reference to the Call table in the Connect entry should be used to 
find the Call table entry. (4-byte integer) 

StartTime Date/Time The time at which the call is answered by the workgroup server, 
thereby beginning it’s time on the call queue (workgroup) DN. 
(8-byte date/time)

Duration Date/Time Time from when the call is offered to the workgroup DN until it 
leaves the call queue. The call leaves the queue when it is 
answered by an agent, is abandoned by the calling party, or leaves 
the queue for other reasons. The complete lists of reasons for 
leaving the queue are found in the QueueExitReasonLUT table. 
(8-byte date/time)

DurationSeconds Number Duration expressed in number of seconds. (4-byte integer)
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• Partial records are never written. A record is written only once, either when the call 
is abandoned, the call is connected to an agent, or leaves the queue for other reasons 
as enumerated in QueueExitReasonLUT. 

• If QueueExitReason = Abandon, target information (TargetType, TargetFirstName, 
TargetLastName, TargetDN) is meaningless and will be blank.

• If QueueExitReason is TransferToAgent, the TargetFirstName and TargetLastName 
are filled in with information about the agent.

• If the QueueExitReason is Forwarding (2, 3, 4, or 5 for forward always, busy, no 
answer, or no logged in agent) or transfer (9, 10, and 11 for transfer to a menu, 
extension or voice mail), the DN that the call is being forwarded or transferred to is 
provided in the TargetDN field. However, the TargetFirstName and TargetLastName 
are not provided. 

• A QueueExitReason is always entered. The field will never be blank. “Unknown” will 
only be used in the case of failure (and maybe not at all).

B.10.1 Enumeration Tables Used for QueueCall
Table B-28 describes the elements in the Queue Call Exit Reason Enumeration table.

QueueName Text Name of the call queue (workgroup). (50 characters, zero-length)

QueueDN Text Extension number of the call queue (workgroup). (15 characters, 
zero-length)

ExitReason Number Enumerated reason the call left the call queue (see the 
QueueExitReasonLUT for enumerations). (1-byte integer)

TargetType Number Enumerated type of handoff target (see TargetTypeLUT for 
enumerations). (1-byte integer)

TargetFirstName Text Name or first name of target. (50 characters, zero-length)

TargetLastName Text Last name of target if applicable (blank if the target agent doesn’t 
have a last name in the configuration database). (50 characters, 
zero-length)

TargetDN Text Dialed number of target. (15 characters, zero-length)

Archived Yes/No Has this entry been archived? (boolean)

Table B-28 Queue Call Exit Reason Enumeration Table

ExitReason Name Description

0 Null

1 TransferToAgent Hunt succeeded and transferred to agent.

2 ForwardAlways Workgroup forwarding all calls.

3 ForwardBusy All logged in agents on call.

4 ForwardNoAnswer All available agents did not answer.

5 FwdNoLoginAgent No logged in agents.

Table B-27 Queue Call Table Field Descriptions

Field Name Data Type Description
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• ForwardMaxRings is no longer used. 

• Exit Reasons for Forwarding (2-5) reflects the call being forwarded from the 
workgroup. These are used when the call leaves the workgroup as a result of call 
handling and the call handling indicates to forward the call to an internal or external 
number. Call handling can also indicate that the call is entering the call queue for the 
workgroup. In that case, these exit reasons are not used because the call does not exit 
the queue at that point. 

• Exit Reason 8, Abandon, is used when the caller drops the call either by physically 
hanging up or by taking an option on a Queue Step to hang up. 

• Even after a call is forwarded to the queue, it remains on the queue and it may still be 
successfully transferred to an agent or abandoned. Exit Reason 1 or 7 is recorded if 
either of these occurs. 

• In addition to a call being successfully hunted or abandoned while on the queue, it 
may exit the queue because of an option taken during a queue step. The call will exit 
the queue if the caller takes any of the following options:

— Take a message
— Transfer to extension
— Go to menu
— Exit reasons 9, 10, and 11 have been added to cover these cases.

Table B-29 describes the elements in the Queue Call Target Type Enumeration table.

6 Reserved

7 Abandon Call dropped while in WG or Queue.

8 Reserved

9 TransferVM Option taken to transfer to voice mail

10 TransferExtension Option taken to transfer to an extension.

11 TransferMenu Option taken to transfer to a menu. 

12 Pickup Agent picked up call from queue.

13 Unpark Agent parked call from queue.

Table B-29 Queue Call Target Type Enumeration Table

Target # TargetType Description

0 Null

1 Agent Workgroup agent.

2 Menu A menu on the ShoreTel system.

3 Mailbox A mailbox on the ShoreTel system.

4 OtherIntrnExtrn Any other extensions to which the call is targeted. 

Table B-28 Queue Call Exit Reason Enumeration Table

ExitReason Name Description
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B.11 QueueStep Table
The QueueStep table logs data about time spent in queue steps or in hunting for agents. 
Table B-30 describes the elements in the QueueStep table.

There is a record for each period that the call spends hunting and for each period a call 
spends in a queue step. For example, if a call to a workgroup initially hunts for agents, then 
goes to the queue and exits the workgroup from that queue step, there will be two records 
for the call in the QueueStep table. The first record would be for hunting (the duration may 
be zero if, for example, no agents were logged in). The second record is for the first queue 
step from which the call exited.

B.12 Web Tables
Web tables log call data for audio only, web only, and audio and web conferences.

Audio Only Conference:

• The Connect table includes a record for each leg of the conference.

• All legs in the same conference have a similar Call.CallID.

• No records are added to web_session and web_attendee tables

Web Only Conference:

• A meeting session record is written to the web_session table after the meeting ends.

• A record is written to the web_attendee table for each attendee.

• No records are added to the Call and Connect tables.

Audio & Web Conference:

• The Connect table includes a record for each leg of the conference.

• All legs in the same conference have a similar Call.CallID.

• A meeting session record is written to the web_session table after the meeting ends.

Table B-30 Queue Call Field Descriptions

Field Name Data Type Description

ID AutoNumber Unique identifier. (4-byte integer, required)

QcallTableID Number Link to the Autonumber field in the QueueCall table. This 
essentially identifies the QueueCall that this step is associated 
with. (4-byte integer)

StartTime Date/Time Time at which the call first enters this step. (8-byte date/time)

Duration Date/Time Elapsed time spent in this step. (8-byte date/time)

DurationSeconds Number Elapsed seconds spent in this step. (4-byte integer)

StepNumber Number Step number if this is not a hunting record (as identified by 
the Hunting field set to Yes). The step number corresponds to 
the step number in the workgroup configuration. 

ExitReason Number Enumerated reason for exit from step. (1-byte integer)

Hunting Yes/No If true the times correspond to hunting, or else this indicates a 
queue step.    (boolean)
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• A record is written to the web_attendee table for each attendee.

• The Web_session table holds a CallID that references Call.CallID. If a web attendee 
reconciles his or her audio leg, web_attendee.caller_id references Connect.PartyID.

B.12.1 Web Session Table
Table B-31 provides information about the elements that appear in the log for web sessions.

B.12.2 Web Attendee Table
Table B-32 provides information about the elements that appear in the log for web session 
attendees.

Table B-31 Elements in the Web Session Log

Field Name Data Type Description

Id AutoNumber The session ID referenced by the attendee table

meeting_title Text Title of the meeting

meeting_desc Text Description of the meeting

meeting_type Text Normal, open or panel

start_time Date/Time Local time of UCB server when meeting session started

start_local_time Date/Time Local time of HQ server when meeting session started

start_utc_time Date/Time UTC time meeting session started

start_local_dst_flag Yes/No Flag to set UCB server dst flag

start_hq_dst_flag Yes/No Flag to set HQ dst flag

end_time Date/Time Local time of UCB server when meeting session ended

end_local_time Date/Time Local time of HQ server when meeting session ended

end_utc_time Date/Time UTC time meeting session ended

end_local_dst_flag Yes/No Flag to set local dst flag of UCB server

end_hq_dst_flag Yes/No Flag to set HQ dst flag

host_login Text Login name of meeting host

login_type Text Name, password, registration, none

Scheduled Yes/No 'Y' or 'N'

Public Yes/No 'Y' or 'N'

Server Text IP address of conference bridge

moderator_code Text Moderator's access code

Attendee_code Text Attendee's access code

CallID Number CallID associated with conference call. NULL for web only 
conference.

Archived Yes/No Has this entry been archived? 
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Table B-32 Elements In Web Attendee Log

Field Name Data Type Description

session_id Number References ID from web_session table

start_time Date/Time Local time of UCB server when attendee joined 
session

start_local_time Date/Time Local time of HQ server when attendee joined 
session

start_utc_time Date/Time UTC time attendee joined session

start_local_dst_flag Yes/No Flag to set UCB server dst flag

start_hq_dst_flag Yes/No Flag to set HQ dst flag

end_time Date/Time Local time of UCB server when attendee left session

end_local_time Date/Time Local time of HQ server when attendee left session

end_utc_time Date/Time UTC time attendee left session

end_local_dst_flag Yes/No Flag to set UCB server dst flag

end_hq_dst_flag Yes/No Flag to set HQ dst flag

break_time Number Time attendee is absent from meeting

user_name Text Login name of attendee

user_ip Text Attendee's IP address

caller_id Text Caller's phone number
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A P P E N D I X C

ShoreTel Switches

This appendix describes the ShoreTel Voice Switches. The topics discussed include:

• "Switch Models" on page 675

• "Specifications for ShoreTel 1U Half-Width Voice Switches" on page 678

• "Specifications for ShoreTel Voice Model Switches" on page 714

• "Specification for ShoreTel 1U Full-Width Voice Switches" on page 725

C.1 Switch Models
Switch model numbers are located on the rear panel as shown in Figure C-1.

Figure C-1 Switch Model Number Label

ShoreTel models are classified into two switch families, based on chassis type:

• 1-U Half Width Switches

• 1-U Full Width Switches

The following is a brief description of each switch family.

C.1.1 ShoreTel 1-U Half Width Voice Switches
ShoreTel Voice Switches are classified into two switch families, based on chassis type:

• 1-U Half-width switches
• 1-U Full-width switches

The next section briefly describes each switch family.
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C.1.2 ShoreTel 1-U Half-Width Voice Switches
The ShoreTel 1-U Half-Width Switch family is the most recent ShoreTel Voice Switch 
design. The 1-U Half Width has a smaller footprint, uses less power, and has lower heat 
dissipation requirements than earlier ShoreTel Voice Switches. These switches offer higher 
granularity in the number of IP users supported, allowing customers to program the switch 
to satisfy their precise requirements.

The switches can be stacked or mounted in a standard 19-inch rack. Rack mounting 1-U 
Half Width Switches requires the ShoreTel Dual Tray. One or two switches are inserted into 
the Dual Tray, which is then mounted into the 19-inch rack. Two switches are mounted side 
by side. Rack mounting the switches require the ShoreTel Dual Tray.

ShoreTel 1-U Half Width Voice Switch models include:

• ShoreTel Voice Switch 30
• ShoreTel Voice Switch 30BRI
• ShoreTel Voice Switch 50
• ShoreTel Voice Switch 90
• ShoreTel Voice Switch 90BRI
• ShoreTel Voice Switch 220T1
• ShoreTel Voice Switch 220T1A
• ShoreTel Voice Switch T1k
• ShoreTel Voice Switch 220E1
• ShoreTel Voice Switch E1k

C.1.3 ShoreTel Voicemail Model Voice Switches
Voicemail Model Switches are ShoreTel Voice Switch that provide voicemail services and 
access to auto attendant menus for extensions hosted by the switch. Voicemail Model (V 
Model) switches provide local access to voicemail while being controlled by a Distributed 
server at a different location.

The switches can be stacked or mounted in a standard 19-inch rack. Rack mounting 1-U 
Half Width Switches requires the ShoreTel Dual Tray. One or two switches are inserted into 
the Dual Tray, which is then mounted into the 19-inch rack. Two switches are mounted side 
by side Rack mounting the switches require the ShoreTel Dual Tray

ShoreTel V Model Switch models include:

• ShoreTel Voice Switch 90V

• ShoreTel Voice Switch 50V

• ShoreTel Voice Switch 90BRIV

C.1.3.1 Capacity

Number of V Model switches allowed per system

A ShoreTel system supports a maximum of 100 V Model Switches. There are no restrictions 
concerning the allocation of switches among the sites defined by the system.

Simultaneous Voicemail Calls per V Model switches

Voicemail Model Switches support the following number of simultaneous voicemail calls.

• ShoreTel Voice Switch 50V – Maximum of 5 Voicemail calls per switch 
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— G.711 calls: 5
— G.729 calls: 2

• ShoreTel Voice Switch 90V – Maximum of 9 Voicemail calls per switch 

— G7.11 calls: 9
— G7.29 calls: 4

• ShoreTel Voice Switch 90BRIV – Maximum of 9 Voicemail calls per switch 

— G.711 calls: 9

— G.729 calls: 4

Call Load

Voicemail Model Switches call load capacity is as follows:

• 5400 BHCC when supporting 90 MGCP IP Phones or 90 SIP Trunks

• 3600 BHCC when supporting 90 SIP IP Phones or 90 SIP Trunks

Compact Flash Memory

Voicemail Model switches store voicemail and Auto Attendant files on compact flash. Flash 
card capacity for V Model Switches is:

• ShoreTel Voice Switch 50V: 1 GB

• ShoreTel Voice Switch 90V: 2 GB

• ShoreTel Voice Switch90 BRIV: 2 GB

Media Support

Voicemail Model Switches support the following media streams:

• G.711

— Music on Hold (MOH): 15 calls
— Backup Auto Attendant (BAA): 50 calls

• G.729

— Music on Hold (MOH): none
— Backup Auto Attendant (BAA): none

SIP support

Voicemail Model Switches support the following SIP media streams:

• G.711 Ringback tone (Hunt Groups and Work Group calls): 50 media streams

• G.729 Ringback tone (Hunt Groups and Work Group calls): no support

C.1.4 ShoreTel 1-U Full Width Voice Switches
The ShoreTel 1-U Full Width Switch family includes three models that support analog, IP, 
SIP, T1, and E1 voice data streams. Full width switch models can be stacked or mounted 
directly into a standard 19-inch equipment rack. These switches are all 1 RU and have an 
RJ21X connector for connection to analog phones and trunks. They also feature redundant 
Ethernet LAN connections for greater availability and reliability. 

ShoreTel 1-U Full Width Voice Switch models include:
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• ShoreTel Voice Switch 120 – also referred to as ShoreTel Voice Switch 120/24 

• ShoreTel Voice Switch 60 – also referred to as ShoreTel Voice Switch 60/12 

• ShoreTel Voice Switch 40 – also referred to as ShoreTel Voice Switch 40/8 

• ShoreTel Voice Switch T1 

• ShoreTel Voice Switch E1 

• ShoreTel Voice Switch 24A 

C.2 Specifications for ShoreTel 1U Half-Width Voice 
Switches

C.2.1 ShoreTel Voice Switch 90
The following sections describe ShoreTel Voice Switch 90 resource capacity, LED behavior, 
and connectors. The ShoreTel Voice Switch 90 is not supported in installations outside the 
U.S. and Canada. Figure C-2 displays the ShoreTel Voice Switch 90 front plate.

Figure C-2 ShoreTel Voice Switch 90 Front Plate

C.2.1.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-8: Eight Loop Start Trunks

— Ports 9-12: Four Extensions or DID Trunks. A single command configures all 
ports as either Extensions or DID trunks.

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

• Make Me Conference Resources: 12 ports

— Ports 1-12

• Maximum IP Phone Resources: 90 devices

— Analog Port Reallocation: 60

— Built-in Resources: 30

Default
Switch

Audio Output Port
(night bell)

Power
LED

Network
LEDs

LAN 2
Connector

RS-232C
Maintentance

Port

RJ-21X
Telco Port

Status
LED

Audio Input Port
(music on hold)

Network
LEDs

LAN 1
Connector
678



Appendix C: ShoreTel Switches System Administration Guide
C.2.1.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 90 has one power LED It indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure. Replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 90 network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.
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This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M:

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 90 has one status LED to provide general information about the 
ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

C.2.1.3 ShoreTel Voice Switch 90 Connectors
The ShoreTel Voice Switch 90 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

— Backup Operator: Extension Port 12

ShoreTel Voice Switch 90 RJ-21X Telephone and Trunk Connector

Table C-1 lists the RJ-21X Ring and Tip pin numbers for the SG 90.
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C.2.2 ShoreTel Voice Switch 90BRI
The following sections describe ShoreTel Voice Switch 90BRI resource capacity, LED 
behavior, and connectors. Figure C-3 displays the ShoreTel Voice Switch 90BRI front plate.

Table C-1 ShoreTel Voice Switch 90 RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

2 Trunk 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

3 Trunk 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

4 Trunk 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

5 Trunk 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

6 Trunk 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

7 Trunk 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

8 Trunk 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension - 
DID

17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension - 
DID

19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension - 
DID

21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension - 
DID

23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate
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Figure C-3 ShoreTel Voice Switch 90BRI Front Plate

C.2.2.1 Switch Capacity

• Analog Circuit Resources

— Ports 9-12: Extensions

• Digital Circuit Resources

— Four BRI Spans, each comprising two channels: Eight channels maximum

• Make Me Conference Resources: 4 ports

— Ports 9-12

• Maximum IP Phone Resources: 90 devices

— Analog Port Reallocation: 20

— Digital Channel Reallocation: 40

— Built-in Resources: 30

C.2.2.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 90BRI has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
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and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 90BRI network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 90BRI has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast (100 msec on/off), at least one port is handling an active call.

• Status LED (Yellow)
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— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow (1 sec. on/off), the switch is not connected (or has lost 
connection) to a ShoreTel server.

— When flashing fast (100 msec on/off), at least one port is handling an active call 
and at least one port is out of service.

• Off: No ports are assigned.

BRI LED

Each BRI connector has two LEDs to indicate port activity. The color and blink pattern of 
the LED indicate the port function:

• LED 1: Off, LED 2 Off – Port not configured in Director

• LED 1: Yellow, LED 2 Off – Port inactive or not connected

• LED 1: Off, LED 2 Off – Layer 1 active. Layer 2 not established

• LED 1: Off, LED 2 Green – Layer 1 active. Layer 2 active.

• LED 1: Off, LED 2 Green flashing – Call in progress (Layer 1, Layer 2, and Layer 3 
active).

C.2.2.3 ShoreTel Voice Switch 90BRI Connectors
The ShoreTel Voice Switch 90BRI voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

• 4 RJ-45 T1 telco port 

ShoreTel Voice Switch 90BRI RJ-21X Telephone and Trunk Connector

Table C-2 lists the RJ-21X Ring and Tip pin numbers for the SG 90BRI

Table C-2 ShoreTel Voice Switch 90BRI RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

– 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

– 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

– 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue
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C.2.3 ShoreTel Voice Switch 50
The following sections describe ShoreTel Voice Switch 50 resource capacity, LED behavior, 
and connectors. The ShoreTel Voice Switch 50 is not supported in installations outside the 
U.S. and Canada. Figure C-4 displays the ShoreTel Voice Switch 50 faceplate.

– 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension 21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-2 ShoreTel Voice Switch 90BRI RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color
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Figure C-4 ShoreTel Voice Switch 50 Front Plate

C.2.3.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-4: Four Loop Start Trunks

— Ports 11-12: Two Extensions or DID Trunks. A single command configures all 
ports as either Extensions or DID trunks.

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

• Make Me Conference Resources: six ports

— Ports 1-4, 11-12

• Maximum IP Phone Resources: 50 devices

— Analog Port Reallocation: 30

— Built-in Resources: 20

C.2.3.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 50 has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.
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— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 50 network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 50 has one status LED to provide general information about the 
ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.
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— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

C.2.3.3 ShoreTel Voice Switch 50 Connectors
The ShoreTel Voice Switch 50 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

— Backup Operator: Extension Port 12

ShoreTel Voice Switch 50 RJ-21X Telephone and Trunk Connector

Table C-3 lists the RJ-21X Ring and Tip pin numbers for the SG 50.

Table C-3 ShoreTel Voice Switch 50 RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

2 Trunk 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

3 Trunk 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

4 Trunk 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue
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C.2.4 ShoreTel Voice Switch 30
The following sections describe ShoreTel Voice Switch 30 resource capacity, LED behavior, 
and connectors. The ShoreTel Voice Switch 30 is not supported in installations outside the 
U.S. and Canada. Figure C-5 displays the ShoreTel Voice Switch 30 front plate.

Figure C-5 ShoreTel Voice Switch 30 Front Plate

C.2.4.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-2: Two Loop Start Trunks

9 Extension - 
DID

17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension - 
DID

19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension - 
DID

21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension - 
DID

23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-3 ShoreTel Voice Switch 50 RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

Default
Switch

Audio Output Port
(night bell)

Power
LED

Network
LEDs

LAN 2
Connector

RS-232C
Maintentance

Port

RJ-21X
Telco Port

Status
LED

Audio Input Port
(music on hold)

Network
LEDs

LAN 1
Connector
ShoreTel 12.2 689



System Administration Guide Appendix C: ShoreTel Switches
— Ports 11-12: Two Extensions or DID Trunks. A single command configures all 
ports as either Extensions or DID trunks.

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

• Make Me Conference Resources: none

• Maximum IP Phone Resources: none

— Analog Port Reallocation: 20

— Built-in Resources: 10

C.2.4.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 30 has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure. Replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 30 network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity. 
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When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M:

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 30 has one status LED to provide general information about the 
ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

C.2.4.3 ShoreTel Voice Switch 30 Connectors
The ShoreTel Voice Switch 30 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

— Backup Operator: Extension Port 12
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ShoreTel Voice Switch 30 RJ-21X Telephone and Trunk Connector

Table C-4 lists the RJ-21X Ring and Tip pin numbers for the SG 30.

C.2.5 ShoreTel Voice Switch 30BRI
The following sections describe ShoreTel Voice Switch 30BRI resource capacity, LED 
behavior, and connectors. Figure C-6 displays the ShoreTel Voice Switch 30BRI front plate.

Table C-4 ShoreTel Voice Switch 30 RJ-21X Telephone and Trunk Connector 
Pins

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

2 Trunk 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

– 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

– 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

– 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

– 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension - 
DID

21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension - 
DID

23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate
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Figure C-6 ShoreTel Voice Switch 30BRI Front Plate

C.2.5.1 Switch Capacity

• Analog Circuit Resources

— Ports 11-12: Extensions

• Digital Circuit Resources

— One BRI Span comprising two channels: two channels maximum

• Make Me Conference Resource: None

• Maximum IP Phone Resources: 30 devices

— Analog Port Reallocation: 10

— Digital Channel Reallocation: 10

— Built-in Resources: 10

C.2.5.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 30BRI has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
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to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 30BRI network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 30BRI has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast (100 msec on/off), at least one port is handling an active call.
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• Status LED (Yellow)

— When on steady, no ports have active calls, and at least one port is out of service.

— When flashing slow (1 sec. on/off), the switch is not connected (or has lost 
connection) to a ShoreTel server.

— When flashing fast (100 msec on/off), at least one port is handling an active call 
and at least one port is out of service.

• Off: No ports are assigned.

BRI LED

Each BRI connector has two LEDs to indicate port activity. The color and blink pattern of 
the LED indicate the port function:

• LED 1: Off, LED 2 Off – Port not configured in Director

• LED 1: Yellow, LED 2 Off – Port inactive or not connected

• LED 1: Off, LED 2 Off – Layer 1 active. Layer 2 not established

• LED 1: Off, LED 2 Green – Layer 1 active. Layer 2 active.

• LED 1: Off, LED 2 Green flashing – Call in progress (Layer 1, Layer 2, and Layer 3 
active).

C.2.5.3 ShoreTel Voice Switch 30BRI Connectors
The ShoreTel Voice Switch 30BRI voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

• 4 RJ-45 T1 telco port 

ShoreTel Voice Switch 30BRI RJ-21X Telephone and Trunk Connector

Table C-5 lists the RJ-21X Ring and Tip pin numbers for the SG 30BRI.

Table C-5 ShoreTel Voice Switch 30BRI RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

– 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

– 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

– 5 Slate/White 30 White/Slate
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C.2.6 ShoreTel Voice Switch 220T1
The following sections describe ShoreTel Voice Switch 220T1 resource capacity, LED 
behavior, and connectors. The ShoreTel Voice Switch 220T1 is not supported in 
installations outside the U.S. and Canada. Figure C-7 displays the ShoreTel Voice Switch 
220T1 front plate.

– 6 Blue/Red 31 Red/Blue

– 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension 21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-5 ShoreTel Voice Switch 30BRI RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color
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Figure C-7 ShoreTel Voice Switch 220T1 Front Plate

C.2.6.1 Switch Capacity

• Digital Circuit Resources: 24 channels maximum

— One T1 circuit, 24 channels per circuit: 24 channels maximum

• Make Me Conference Resource: None

• Maximum IP Phone Resources: 220

— Digital Channel Reallocation: 120

— Built-in Resources: 100

C.2.6.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 220T1 has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
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the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 220T1 network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

TheShoreTel Voice Switch 220T1 has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.
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— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

Monitor and Telco LEDs

The Monitor and Telco LEDs indicate line coding, network framing, and loopback status. 
These LEDs are color coded—green, yellow, and red. The Monitor and Telco LED 
descriptions follow.

Telco and Monitor LED alarms and errors are logged as switch events in ShoreTel Director’s 
event log.

• Line Coding: This LED indicates line coding status, as follows:

— When green, the line coding signal is good. 

— When yellow, bipolar violations are being received at one-second intervals.

— When red, a loss of signal (LOS) has occurred.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

• Framing: This LED indicates network framing status, as follows:

— When green, the T1/E1 signal is in frame; the signal is synchronized.

— When yellow, a yellow alarm has been received from the Central Office.

— When flashing yellow, the frame-bit error rate has exceeded its limits. A small 
number of frame-bit errors (>1 per million) have occurred; this state will take up 
to 10 minutes to clear.

— When flashing fast yellow, a series of frame-bit errors (>1 per 1000) occurred.

— When red, the T1/E1 signal is out-of-frame (OOF). The received signal cannot 
be framed to the Extended Superframe (ESF) or D4 format.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

C.2.6.3 ShoreTel Voice Switch 220T1 Connectors
The ShoreTel Voice Switch 220T1 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-45 T1 telco port 

• 1 RJ-45 T1 monitor port for connecting test equipment
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C.2.7 ShoreTel Voice Switch 220T1A
The following sections describe ShoreTel Voice Switch 220T1A resource capacity, LED 
behavior, and connectors. The ShoreTel Voice Switch 220T1A is not supported in 
installations outside the U.S. and Canada. Figure C-8 displays the ShoreTel Voice Switch 
220T1A front plate.

Figure C-8 ShoreTel Voice Switch 220T1A Front Plate

C.2.7.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-2: Two Loop Start Trunks

— Ports 9-12: Four Extensions or DID Trunks. A single command configures all 
ports as either Extensions or DID trunks.

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

• Digital Circuit Resources: 24 channels maximum

— One T1 circuit, 24 channels per circuit

• Make Me Conference Resource: Six ports

— Ports 1-2, 9-12

• Maximum IP Phone Resources: 220 devices

— Analog Channel Reallocation: 30

— Digital Channel Reallocation: 120

— Built-in Resources: 70

C.2.7.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 220T1A has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing
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— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 220T1A network LEDs (LAN1 and LAN2) show network 
activity and indicate the speed at which the switch is communicating with the network.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.
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Status LED

The ShoreTel Voice Switch 220T1A has one status LED to provide general information 
about the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast (100 msec on/off), at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow (1 sec. on/off), the switch is not connected (or has lost 
connection) to a ShoreTel server.

— When flashing fast (100 msec on/off), at least one port is handling an active call 
and at least one port is out of service.

• Off: No ports are assigned.

Monitor and Telco LEDs

The Monitor and Telco LEDs indicate line coding, network framing, and loopback status. 
These LEDs are color coded—green, yellow, and red. The Monitor and Telco LED 
descriptions follow.

Telco and Monitor LED alarms and errors are logged as switch events in ShoreTel Director’s 
event log.

• Line Coding: This LED indicates line coding status, as follows:

— When green, the line coding signal is good. 

— When yellow, bipolar violations (BPV) are received at one second intervals.

— When red, a loss of signal (LOS) has occurred.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

• Framing: This LED indicates network framing status, as follows:

— When green, the T1/E1 signal is in frame; the signal is synchronized.

— When yellow, a yellow alarm has been received from the Central Office.

— When flashing yellow, the frame-bit error rate has exceeded its limits.

— When flashing slow yellow, a small number of frame-bit errors (>1 per million) 
have occurred; this state will take up to 10 minutes to clear.

— When flashing fast yellow, a series of frame-bit errors (> 1 per 1000) have 
occurred.

— When red, the T1/E1 signal is out-of-frame (OOF). The received signal cannot 
be framed to the Extended Superframe (ESF) or D4 format.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.
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C.2.7.3 ShoreTel Voice Switch 220T1A Connectors
The ShoreTel Voice Switch 220T1A voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-45 T1 telco port 

• 1 RJ-45 T1 monitor port for connecting test equipment

ShoreTel Voice Switch 220T1A RJ-21X Telephone and Trunk Connector

Table C-6 lists the RJ-21X Ring and Tip pin numbers for the SG 220T1A.

Table C-6 ShoreTel Voice Switch 220T1A RJ-21X Telephone and Trunk 
Connector Pins

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

2 Trunk 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

– 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

– 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension 21 Blue/Violet 46 Violet/Blue
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C.2.8 ShoreTel Voice Switch 220E1
The following sections describe ShoreTel Voice Switch 220E1 resource capacity, LED 
behavior, and connectors. Figure C-9 displays the ShoreTel Voice Switch 220E1 front plate.

Figure C-9 ShoreTel Voice Switch 220E1 Front Plate

C.2.8.1 Switch Capacity

• Digital Circuit Resources: 30 channels maximum

— One E1 circuit, 30 channels per circuit

• Make Me Conference Resource: none

• Maximum IP Phone Resources: 220

— Digital Channel Reallocation: 150

— Built-in Resources: 70

C.2.8.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 220E1 has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

– 22 Orange/Violet 47 Violet/Orange

12 Extension 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-6 ShoreTel Voice Switch 220T1A RJ-21X Telephone and Trunk 
Connector Pins (Continued)

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color
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— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 220E1 network LEDs (LAN1 and LAN2) indicate network 
activity and the speed at which the switch is communicating with the network.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.
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Status LED

The ShoreTel Voice Switch 220E1 has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

Monitor and Telco LEDs

The Monitor and Telco LEDs indicate line coding, network framing, and loopback status. 
These LEDs are color coded—green, yellow, and red. The Monitor and Telco LED 
descriptions follow.

Telco and Monitor LED alarms and errors are logged as switch events in ShoreTel Director’s 
event log.

• Line Coding: This LED indicates line coding status, as follows:

— When green, the line coding signal is good. 

— When yellow, bipolar violations (BPV) are being received at one second 
intervals.

— When red, a loss of signal (LOS) has occurred.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

• Framing: This LED indicates network framing status, as follows:

— When green, the T1/E1 signal is in frame; the signal is synchronized.

— When yellow, a yellow alarm has been received from the Central Office.

— When flashing yellow, the frame-bit error rate has exceeded its limits.

— When flashing slow yellow, a small number of frame-bit errors (10e-6) have 
occurred; this state will take up to 10 minutes to clear.

— When flashing fast yellow, a series of frame-bit errors (10e-3) have occurred.

— When red, the T1/E1 signal is out-of-frame (OOF). The received signal cannot 
be framed to the Extended Superframe (ESF) or D4 format.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.
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C.2.8.3 ShoreTel Voice Switch 220E1 Connectors
The ShoreTel Voice Switch 220E1 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-45 T1 telco port 

• 1 RJ-45 T1 monitor port for connecting test equipment

C.2.9 ShoreTel Voice Switch T1k
This section describe ShoreTel Voice Switch T1k resource capacity, LED behavior, and 
connectors. The only countries where the ShoreTel Voice Switch T1k is supported are the 
U.S. and Canada. Figure C-10 displays the ShoreTel Voice Switch T1k front plate.

Figure C-10 ShoreTel Voice Switch T1k Front Plate

C.2.9.1 Switch Capacity

• Digital Circuit Resources: 24 channels maximum

— One T1 circuit, 24 channels per circuit

• Make Me Conference Resource: None

• Maximum IP Phone Resources: None

C.2.9.2 LED Descriptions

Power LED

The ShoreTel Voice Switch T1k has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.
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• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch T1k network LEDs (LAN1 and LAN2) indicates that the 
network is active and the speed at which the switch is communicating with the network.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.
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Status LED

The ShoreTel Voice Switch T1k has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports have active calls, and at least one port is out of service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

Monitor and Telco LEDs

The Monitor and Telco LEDs indicate line coding, network framing, and loopback status. 
These LEDs are color coded—green, yellow, and red. The Monitor and Telco LED 
descriptions follow.

Telco and Monitor LED alarms and errors are logged as switch events in ShoreTel Director’s 
event log.

• Line Coding: This LED indicates line coding status, as follows:

— When green, the line coding signal is good. 

— When yellow, bipolar violations (BPV) are being received at one second 
intervals.

— When red, a loss of signal (LOS) has occurred.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

• Framing: This LED indicates network framing status, as follows:

— When green, the T1/E1 signal is in frame; the signal is synchronized.

— When yellow, a yellow alarm has been received from the Central Office.

— When flashing yellow, the frame-bit error rate has exceeded its limits. A small 
number of frame-bit errors (>1 per million) have occurred; this state will take up 
to 10 minutes to clear.

— When flashing fast yellow, a series of frame-bit errors (>1 per 1000) have 
occurred.

— When red, the T1/E1 signal is out-of-frame (OOF). The received signal cannot 
be framed to the Extended Superframe (ESF) or D4 format.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.
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C.2.9.3 ShoreTel Voice Switch T1k Connectors
The ShoreTel Voice Switch T1k voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-45 T1 telco port 

• 1 RJ-45 T1 monitor port for connecting test equipment

C.2.10 ShoreTel Voice Switch E1k
This section describes ShoreTel Voice Switch E1k resource capacity, LED behavior, and 
connectors. The only countries where the ShoreTel Voice Switch E1k is supported are the 
U.S. and Canada. Figure C-11 displays the ShoreTel Voice Switch E1k front plate.

Figure C-11 ShoreTel Voice Switch E1k Front Plate

C.2.10.1 Switch Capacity

• Digital Circuit Resources: 30 channels maximum

— One E1 circuit, 30 channels per circuit

• Make Me Conference Resource: None

• Maximum IP Phone Resources: None

C.2.10.2 LED Descriptions

Power LED

The ShoreTel Voice Switch E1k has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.
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• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch E1k network LEDs (LAN1 and LAN2) show network activity 
and indicate the speed at which the switch is communicating with the network.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.
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Status LED

The ShoreTel Voice Switch E1k has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.
— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports have active calls, and at least one port is out of service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

Monitor and Telco LEDs

The Monitor and Telco LEDs indicate line coding, network framing, and loopback status. 
These LEDs are color coded—green, yellow, and red. The Monitor and Telco LED 
descriptions follow.

Telco and Monitor LED alarms and errors are logged as switch events in ShoreTel Director’s 
event log.

• Line Coding: This LED indicates line coding status, as follows:

— When green, the line coding signal is good. 

— When yellow, bipolar violations (BPV) are being received at one second 
intervals.

— When red, a loss of signal (LOS) has occurred.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

• Framing: This LED indicates network framing status, as follows:

— When green, the E1 signal is in frame; the signal is synchronized.

— When yellow, a yellow alarm has been received from the Central Office.

— When flashing yellow, the frame-bit error rate has exceeded its limits. A small 
number of frame-bit errors (>1 per million) have occurred; this state will take up 
to 10 minutes to clear.

— When flashing fast yellow, a series of frame-bit errors (>1 per 1000) have 
occurred.

— When red, the T1/E1 signal is out-of-frame (OOF). The received signal cannot 
be framed to the Extended Superframe (ESF) or D4 format.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

C.2.10.3 ShoreTel Voice Switch E1k Connectors
The ShoreTel Voice Switch E1k voice switch contains the following components:
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• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-45 T1 telco port 

• 1 RJ-45 T1 monitor port for connecting test equipment
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C.3 Specifications for ShoreTel Voice Model Switches

C.3.1 ShoreTel Voice Switch 90V
This section describes ShoreTel Voice Switch 90V resource capacity, LED behavior, and 
connectors. The ShoreTel Voice Switch 90V is not supported in installations outside the 
U.S. and Canada. Figure C-12 displays the ShoreTel Voice Switch 90V front plate.

Figure C-12 ShoreTel Voice Switch 90V Front Plate

C.3.1.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-8: Eight Loop Start Trunks

— Ports 9-12: Four Extensions or DID Trunks. A single command configures all 
ports as either Extensions or DID trunks.

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

• Make Me Conference Resources: 12 ports

— Ports 1-12

• Maximum IP Phone Resources: 90 devices

— Analog Port Reallocation: 60

— Built-in Resources: 30

C.3.1.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 90V has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.
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• Flashing:

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure. Replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 90V network LEDs (LAN1 and LAN2) shows network activity 
and indicate the speed at which the switch is communicating with the network.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M:

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.
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Status LED

The ShoreTel Voice Switch 90V has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

C.3.1.3 ShoreTel Voice Switch 90V Connectors
The ShoreTel Voice Switch 90V voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

— Backup Operator: Extension Port 12

ShoreTel Voice Switch 90V RJ-21X Telephone and Trunk Connector

Table C-7 lists the RJ-21X Ring and Tip pin numbers for the ShoreTel Voice Switch 90V

Table C-7 ShoreTel Voice Switch 90V RJ-21X Telephone and Trunk Connector 
Pins

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

2 Trunk 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

3 Trunk 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

4 Trunk 7 Orange/Red 32 Red/Orange
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C.3.2 ShoreTel Voice Switch 90BRIV
This section describes ShoreTel Voice Switch 90BRIV resource capacity, LED behavior, and 
connectors. Figure C-13 displays the ShoreTel Voice Switch 90BRIV front plate.

– 8 Green/Red 33 Red/Green

5 Trunk 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

6 Trunk 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

7 Trunk 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

8 Trunk 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension - DID 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension - DID 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension - DID 21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension - DID 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-7 ShoreTel Voice Switch 90V RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color
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Figure C-13 ShoreTel Voice Switch 90BRIV Front Plate

C.3.2.1 Switch Capacity

• Analog Circuit Resources

— Ports 9-12: Extensions

• Digital Circuit Resources

— Four BRI Spans, each comprising two channels: Eight channels maximum

• Make Me Conference Resources: 4 ports

— Ports 9-12

• Maximum IP Phone Resources: 90 devices

— Analog Port Reallocation: 20

— Digital Channel Reallocation: 40

— Built-in Resources: 30

C.3.2.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 90BRIV has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.
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— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 90BRIV network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity.

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 90BRIV has one status LED to provide general information 
about the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.
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— When flashing fast (100 msec on/off), at least one port is handling an active call.

• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow (1 sec. on/off), the switch is not connected (or has lost 
connection) to a ShoreTel server.

— When flashing fast (100 msec on/off), at least one port is handling an active call 
and at least one port is out of service.

• Off: No ports are assigned.

BRI LED

Each BRI connector has two LEDs to indicate port activity. The color and blink pattern of 
the LED indicate the port function:

• LED 1: Off, LED 2 Off – Port not configured in Director

• LED 1: Yellow, LED 2 Off – Port inactive or not connected

• LED 1: Off, LED 2 Off – Layer 1 active. Layer 2 not established

• LED 1: Off, LED 2 Green – Layer 1 active. Layer 2 active.

• LED 1: Off, LED 2 Green flashing – Call in progress (Layer 1, Layer 2, and Layer 3 
active).

C.3.2.3 ShoreTel Voice Switch 90BRIV Connectors
The ShoreTel Voice Switch 90BRIV voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

• 4 RJ-45 T1 telco port 

ShoreTel Voice Switch 90BRIV RJ-21X Telephone and Trunk Connector

Table C-8 lists the RJ-21X Ring and Tip pin numbers for the SG 90BRIV.

Table C-8 ShoreTel Voice Switch 90BRIV RJ-21X Telephone and Trunk 
Connector Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

– 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

– 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown
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C.3.3 ShoreTel Voice Switch 50V
This section describes ShoreTel Voice Switch 50V resource capacity, LED behavior, and 
connectors. The ShoreTel Voice Switch 50V is not supported in installations outside the 
U.S. and Canada. Figure C-14 displays the ShoreTel Voice Switch 50V front plate.

– 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

– 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension 21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-8 ShoreTel Voice Switch 90BRIV RJ-21X Telephone and Trunk 
Connector Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color
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Figure C-14 ShoreTel Voice Switch 50V Front Plate

C.3.3.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-4: Four Loop Start Trunks

— Ports 11-12: Two Extensions or DID Trunks. A single command configures all 
ports as either Extensions or DID trunks.

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

• Make Me Conference Resources: six ports

— Ports 1-4, 11-12

• Maximum IP Phone Resources: 50 devices

— Analog Port Reallocation: 30

— Built-in Resources: 20

C.3.3.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 50V has one power LED, which indicates the following: 

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
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to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsk/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsk/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The ShoreTel Voice Switch 50V network LEDs (LAN1 and LAN2) indicate the speed at 
which the switch is communicating with the network and whether there is network 
activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), the switch is connected to an Ethernet network.

— When off, the switch cannot detect an Ethernet network.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Status LED

The ShoreTel Voice Switch 50V has one status LED to provide general information about 
the ports. The color and blink pattern of the LED indicate the port function:

• Status LED (Green)

— When on steady, no ports are handling active calls.

— When flashing fast, at least one port is handling an active call.
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• Status LED (Yellow)

— When on steady, no ports are handling active calls and at least one port is out of 
service.

— When flashing slow, the switch is not connected (or has lost connection) to a 
ShoreTel server.

— When flashing fast, at least one port is handling an active call and at least one 
port is out of service.

• Off: No ports are assigned.

C.3.3.3 ShoreTel Voice Switch 50V Connectors
The ShoreTel Voice Switch 50V voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 1 to Extension Port 12

— Backup Operator: Extension Port 12

ShoreTel Voice Switch 50V RJ-21X Telephone and Trunk Connector

Table C-9 lists the RJ-21X Ring and Tip pin numbers for the SG 50V.

Table C-9 ShoreTel Voice Switch 50V RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

2 Trunk 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

3 Trunk 5 Slate/White 30 White/Slate

– 6 Blue/Red 31 Red/Blue

4 Trunk 7 Orange/Red 32 Red/Orange

– 8 Green/Red 33 Red/Green

– 9 Brown/Red 34 Red/Brown

– 10 Slate/Red 35 Red/Slate

– 11 Blue/Black 36 Black/Blue

– 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green
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C.4 Specification for ShoreTel 1U Full-Width Voice 
Switches

C.4.1 ShoreTel Voice Switch 120
This section describes ShoreTel Voice Switch 120 resource capacity, LED behavior, and 
connectors. The ShoreTel Voice Switch 120 is not supported in installations outside the 
U.S. and Canada. Figure C-15 displays the ShoreTel Voice Switch 120 front plate.

The ShoreTel Voice Switch 120 is often referred to as the ShoreTel 120/24 (SG 120/24).

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

9 Extension - 
DID

17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

10 Extension - 
DID

19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

11 Extension - 
DID

21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

12 Extension - 
DID

23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-9 ShoreTel Voice Switch 50V RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color
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Figure C-15 ShoreTel Voice Switch 120 Front Plate

C.4.1.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-8: Eight Loop Start Trunks, DID Trunks, or Extensions

— Ports 9-24: Sixteen Extensions.

— Power Failure Transfer Unit: Trunk Port 8 to Extension Port 9

• Make Me Conference Resource: 24 Ports

— Ports 1-24

• Maximum IP Phone Resources: 120 devices

— Analog Port Reallocation: 120

C.4.1.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 120 has one power LED, which indicates the following:

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

ShoreGear-120/24
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— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsa/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsa/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Switch Port LEDs

The ShoreTel Voice Switch 120 has 24 telephone/trunk port LEDs. The color of the LED 
indicates the port function:

• Green when the port is a telephone port. 

• Yellow when the port is a trunk port.

• Off indicates the port is reserved for IP phones, for conferencing, or is unconfigured.

The following describes the switch port LED behavior and meaning:

• Telephone Port LEDs (Green)

— When on steady, the port is configured as a telephone port and the telephone is 
idle.

— When flashing with ring cadence, the telephone is ringing.

— When flashing slowly, the telephone is off hook.

— When flashing fast, the port is in use (call in progress).

• Trunk Port LED (Yellow): 

— When on steady, the port is configured as a trunk port and the trunk is idle.

— When flashing slowly, the trunk is off hook.

— When flashing fast, the trunk is in use (call in progress).

• Port LED Alternating Green/Yellow: The port is out of service. The LED periodically 
alternates green/yellow or yellow/green. The color of the LED between alternating 
colors indicates the port type: green for phone and yellow for trunk.

• Off (IP phone): When the LED is off, the port is reserved for IP phones, for 
conferencing, or is unconfigured. 

Network LEDs

The network LEDs (LAN1 and LAN2) indicate the speed at which the switch is 
communicating with the network and whether there is network activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.
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The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), heavy network activity is detected.

— When off, the switch has no power.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

C.4.1.3 ShoreTel Voice Switch 120 Connectors
The ShoreTel Voice Switch 120 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-11 connector for connecting an analog phone (extension 9)

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 8 to Extension Port 9

— Backup Operator: Extension Port 9

ShoreTel Voice Switch 120 RJ-21X Telephone and Trunk Connector

Table C-10 lists the RJ-21X Ring and Tip pin numbers for the SG 120I.

Table C-10 ShoreTel Voice Switch 120 RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk, DID, 
Extension

1 Blue/White 26 White/Blue

2 Trunk, DID, 
Extension

2 Orange/White 27 White/Orange

3 Trunk, DID, 
Extension

3 Green/White 28 White/Green

4 Trunk, DID, 
Extension

4 Brown/White 29 White/Brown
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C.4.2 ShoreTel Voice Switch 24A
This section describes ShoreTel Voice Switch 24A resource capacity, LED behavior, and 
connectors. The ShoreTel Voice Switch 24A is not supported in installations outside the 
U.S. and Canada. Figure C-16 displays the ShoreTel Voice Switch 24A front plate.

5 Trunk, DID, 
Extension

5 Slate/White 30 White/Slate

6 Trunk, DID, 
Extension

6 Blue/Red 31 Red/Blue

7 Trunk, DID, 
Extension

7 Orange/Red 32 Red/Orange

8 Trunk, DID, 
Extension

8 Green/Red 33 Red/Green

9 Extension 9 Brown/Red 34 Red/Brown

10 Extension 10 Slate/Red 35 Red/Slate

11 Extension 11 Blue/Black 36 Black/Blue

12 Extension 12 Orange/Black 37 Black/Orange

13 Extension 13 Green/Black 38 Black/Green

14 Extension 14 Brown/Black 39 Black/Brown

15 Extension 15 Slate/Black 40 Black/Slate

16 Extension 16 Blue/Yellow 41 Yellow/Blue

17 Extension 17 Orange/Yellow 42 Yellow/Orange

18 Extension 18 Green/Yellow 43 Yellow/Green

19 Extension 19 Brown/Yellow 44 Yellow/Brown

20 Extension 20 Slate/Yellow 45 Yellow/Slate

21 Extension 21 Blue/Violet 46 Violet/Blue

22 Extension 22 Orange/Violet 47 Violet/Orange

23 Extension 23 Green/Violet 48 Violet/Green

24 Extension 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-10 ShoreTel Voice Switch 120 RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color
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Figure C-16 ShoreTel Voice Switch 24A Front Plate

C.4.2.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-24: Twenty four extensions

• Make Me Conference Resource: 24 Ports

— Ports 1-24

• Maximum IP Phone Resources: None

C.4.2.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 24A has one power LED, which indicates the following:

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. Hardware failed; replace the 
unit and submit a Return Material Authorization (RMA) to ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsa/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsa/vxworks.

ShoreGear-24A

Default
Switch

Audio Output Port
(night bell)

Power
LED

RS-232C
Maintentance

Port

RJ-21X Telco
Port

Audio Input Port
(music on hold)

Network
LEDs

LAN
Connectors

Analog Phone RJ-11

Switch Port
LEDs
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— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Switch Port LEDs

The ShoreTel Voice Switch 24A has 24 telephone/trunk port LEDs. The color of the LED 
indicates the port function:

• Green when the port is a telephone port. 

• Yellow when the port is a trunk port.

• Off indicates the port is reserved for IP phones, for conferencing, or is unconfigured.

The following describes the switch port LED behavior and meaning:

• Telephone Port LEDs (Green)

— When on steady, the port is configured as a telephone port and the telephone is 
idle.

— When flashing with ring cadence, the telephone is ringing.

— When flashing slowly, the telephone is off hook.

— When flashing fast, the port is in use (call in progress).

• Trunk Port LED (Yellow): 

— When on steady, the port is configured as a trunk port and the trunk is idle.

— When flashing slowly, the trunk is off hook.

— When flashing fast, the trunk is in use (call in progress).

• Port LED Alternating Green/Yellow: The port is out of service. The LED periodically 
alternates green/yellow or yellow/green. The color of the LED between alternating 
colors indicates the port type: green for phone and yellow for trunk.

• Off (IP phone): When the LED is off, the port is reserved for IP phones, for 
conferencing, or is unconfigured. 

Network LEDs

The network LEDs (LAN1 and LAN2) indicate the speed at which the switch is 
communicating with the network and whether there is network activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), heavy network activity is detected.
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— When off, the switch has no power.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

C.4.2.3 ShoreTel Voice Switch 24A Connectors
The ShoreTel Voice Switch 24A voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-11 connector for connecting an analog phone (extension 9)

• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

ShoreTel Voice Switch 24A RJ-21X Telephone and Trunk Connector

Table C-11 lists the RJ-21X Ring and Tip pin numbers for the SG 24AI.

Table C-11 ShoreTel Voice Switch 24A RJ-21X Telephone and Trunk Connector 
Pins

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color

1 Extension 1 Blue/White 26 White/Blue

2 Extension 2 Orange/White 27 White/Orange

3 Extension 3 Green/White 28 White/Green

4 Extension 4 Brown/White 29 White/Brown

5 Extension 5 Slate/White 30 White/Slate

6 Extension 6 Blue/Red 31 Red/Blue

7 Extension 7 Orange/Red 32 Red/Orange

8 Extension 8 Green/Red 33 Red/Green

9 Extension 9 Brown/Red 34 Red/Brown

10 Extension 10 Slate/Red 35 Red/Slate

11 Extension 11 Blue/Black 36 Black/Blue

12 Extension 12 Orange/Black 37 Black/Orange

13 Extension 13 Green/Black 38 Black/Green

14 Extension 14 Brown/Black 39 Black/Brown

15 Extension 15 Slate/Black 40 Black/Slate
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C.4.3 ShoreTel Voice Switch 60
The following sections describe ShoreTel Voice Switch 60 resource capacity, LED behavior, 
and connectors. The ShoreTel Voice Switch 60 is not supported in installations outside the 
U.S. and Canada. Figure C-17 displays the ShoreTel Voice Switch 60 front plate.

The ShoreTel Voice Switch 60 is often referred to as the ShoreTel 60/12 (SG 60/12).

Figure C-17 ShoreTel Voice Switch 60 Front Plate

C.4.3.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-8: Eight Loop Start Trunks, DID Trunks, or Extensions

— Ports 9-12: Four Extensions.

— Backup Operator: Extension Port 9

— Power Failure Transfer Unit: Trunk Port 8 to Extension Port 9

16 Extension 16 Blue/Yellow 41 Yellow/Blue

17 Extension 17 Orange/Yellow 42 Yellow/Orange

18 Extension 18 Green/Yellow 43 Yellow/Green

19 Extension 19 Brown/Yellow 44 Yellow/Brown

20 Extension 20 Slate/Yellow 45 Yellow/Slate

21 Extension 21 Blue/Violet 46 Violet/Blue

22 Extension 22 Orange/Violet 47 Violet/Orange

23 Extension 23 Green/Violet 48 Violet/Green

24 Extension 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-11 ShoreTel Voice Switch 24A RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color

ShoreGear-60/12

Default
Switch

Audio Output Port
(night bell)

Power
LED

RS-232C
Maintentance

Port

RJ-21X Telco
Port

Audio Input Port
(music on hold)

Network
LEDs

LAN
Connectors

Analog Phone RJ-11

Switch Port
LEDs
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• Make Me Conference Resource: 12 ports

— Ports 1-12

• Maximum IP Phone Resources: 60 devices

— Analog Port Reallocation: 60

C.4.3.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 60 has one power LED, which indicates the following:

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. Hardware has failed; replace 
the unit and submit a Return Material Authorization (RMA) to ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsa/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsa/vxworks. 

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Switch Port LEDs

The ShoreTel Voice Switch 60 has 12 telephone/trunk port LEDs. The color of the LED 
indicates the port function:

• Green when the port is a telephone port. 

• Yellow when the port is a trunk port.

• Off indicates the port is reserved for IP phones, for conferencing, or is unconfigured.

The following describes the switch port LED behavior and meaning:

• Telephone Port LEDs (Green)
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— When on steady, the port is configured as a telephone port and the telephone is 
idle.

— When flashing with ring cadence, the telephone is ringing.

— When flashing slowly, the telephone is off hook.

— When flashing fast, the port is in use (call in progress).

• Trunk Port LED (Yellow)

— When on steady, the port is configured as a trunk port and the trunk is idle.

— When flashing slowly, the trunk is off hook.

— When flashing fast, the trunk is in use (call in progress).

• Port LED Alternating Green/Yellow: The port is out of service. The LED periodically 
alternates green/yellow or yellow/green. The LED color between alternating colors 
indicates the port type: green for phone and yellow for trunk.

• Off (IP phone): When the LED is off, the port is reserved for IP phones, for 
conferencing, or is unconfigured. 

Network LEDs

The network LEDs (LAN1 and LAN2) indicate the speed at which the switch is 
communicating with the network and whether there is network activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), heavy network activity is detected.

— When off, the switch has no power.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

C.4.3.3 ShoreTel Voice Switch 60 Connectors
ShoreTel Voice Switch 60 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-11 connector for connecting an analog phone (extension 9)
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• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 8 to Extension Port 9

— Backup Operator: Extension Port 9

ShoreTel Voice Switch 60 RJ-21X Telephone and Trunk Connector

Table C-12 lists the RJ-21X Ring and Tip pin numbers for the SG 60.

Table C-12 ShoreTel Voice Switch 60 RJ-21X Telephone and Trunk Connector 
Pins

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

1 Trunk, DID, 
Extension

1 Blue/White 26 White/Blue

2 Trunk, DID, 
Extension

2 Orange/White 27 White/Orange

3 Trunk, DID, 
Extension

3 Green/White 28 White/Green

4 Trunk, DID, 
Extension

4 Brown/White 29 White/Brown

5 Trunk, DID, 
Extension

5 Slate/White 30 White/Slate

6 Trunk, DID, 
Extension

6 Blue/Red 31 Red/Blue

7 Trunk, DID, 
Extension

7 Orange/Red 32 Red/Orange

8 Trunk, DID, 
Extension

8 Green/Red 33 Red/Green

9 Extension 9 Brown/Red 34 Red/Brown

10 Extension 10 Slate/Red 35 Red/Slate

11 Extension 11 Blue/Black 36 Black/Blue

12 Extension 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

– 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

– 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

– 21 Blue/Violet 46 Violet/Blue
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C.4.4 ShoreTel Voice Switch 40
The following sections describe ShoreTel Voice Switch 40 resource capacity, LED behavior, 
and connectors. The ShoreTel Voice Switch 40 is not supported in installations outside the 
U.S. and Canada. Figure C-18 displays the ShoreTel Voice Switch 40 front plate.

The ShoreTel Voice Switch 40 is often referred to as the ShoreTel 40/8 (SG 40/8).

Figure C-18 ShoreTel Voice Switch 40 Front Plate

C.4.4.1 Switch Capacity

• Analog Circuit Resources

— Ports 1-2: Two Loop Start Trunks, DID Trunks, or Extensions

— Ports 3-4: Two Loop Start Trunks.

— Ports 5-8: Four Extensions

— Power Failure Transfer Unit: Trunk Port 4 to Extension Port 5

• Make Me Conference Resource: eight ports

— Ports 1-8

• Maximum IP Phone Resources: 40 devices

— Analog Port Reallocation: 40

– 22 Orange/Violet 47 Violet/Orange

– 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate

Table C-12 ShoreTel Voice Switch 60 RJ-21X Telephone and Trunk Connector 
Pins (Continued)

Port Type
Ring Tip

Pin # Cable Color Pin # Cable Color

ShoreGear-40/8

Default
Switch

Audio Output Port
(night bell)

Power
LED

RS-232C
Maintentance

Port

RJ-21X Telco
Port

Audio Input Port
(music on hold)

Network
LEDs

LAN
Connectors

Analog Phone RJ-11

Switch Port
LEDs
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C.4.4.2 LED Descriptions

Power LED

The ShoreTel Voice Switch 40 has one power LED, which indicates the following:

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. This indicates a hardware 
failure; replace the unit and submit a Return Material Authorization (RMA) to 
ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory might be corrupted. Go to the Quick 
Look page to ensure that the system is running properly.

— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds. You 
can use BOOTP or DHCP to tell the switch where the files are. If you are using 
BOOTP, set the BOOTP server to the IP address of the ShoreTel server, and set 
the boot file to /tsa/vxworks. If you are using a DHCP server that supports 
options 66 and 67, set option 66 to the ShoreTel server’s IP address, and set 
option 67 to /tsa/vxworks.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Switch Port LEDs

The ShoreTel Voice Switch 40 has 8 telephone/trunk port LEDs. The color of the LED 
indicates the port function:

• Green when the port is a telephone port. 

• Yellow when the port is a trunk port.

• Off indicates the port is reserved for IP phones, for conferencing, or is unconfigured.

The following describes the switch port LED behavior and meaning.

• Telephone Port LEDs (Green)

— When on steady, the port is configured as a telephone port and the telephone is 
idle.

— When flashing with ring cadence, the telephone is ringing.
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— When flashing slowly, the telephone is off hook.

— When flashing fast, the port is in use (call in progress).

• Trunk Port LED (Yellow)

— When on steady, the port is configured as a trunk port and the trunk is idle.

— When flashing slowly, the trunk is off hook.

— When flashing fast, the trunk is in use (call in progress).

• Port LED Alternating Green/Yellow: The port is out of service. The LED periodically 
alternates green/yellow or yellow/green. The color of the LED between alternating 
colors indicates the port type: green for phone and yellow for trunk.

• Off (IP phone): When the LED is off, the port is reserved for IP phones, for 
conferencing, or is unconfigured. 

Network LEDs

The network LEDs (LAN1 and LAN2) indicate the speed at which the switch is 
communicating with the network and whether there is network activity. 

When both LAN connectors are connected into a redundant network configuration, one 
network port is active while the other is in standby mode. If one LAN connection fails, the 
switch activates the other port.

The network LED descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), heavy network activity is detected.

— When off, network activity is not detected.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

C.4.4.3 ShoreTel Voice Switch 40 Connectors
The ShoreTel Voice Switch 40 voice switch contains the following components:

• 1 3.5 mm mono connector for audio input (music on hold)

• 1 3.5 mm mono connector for audio output (overhead paging and night bell)

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-11 connector for connecting an analog phone (extension 9)
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• 1 RJ-21X male connector for mass termination of the telephone/trunk ports

— Power Failure Transfer Unit: Trunk Port 4 to Extension Port 5

— Backup Operator: Extension Port 5

ShoreTel Voice Switch 40 RJ-21X Telephone and Trunk Connector

Table C-13 lists the RJ-21X Ring and Tip pin numbers for the SG 40I.

Table C-13 ShoreTel Voice Switch 40 RJ-21X Telephone and Trunk Connector 
Pins

Port Type

Ring Tip

Pin # Cable Color Pin # Cable Color

– 1 Blue/White 26 White/Blue

– 2 Orange/White 27 White/Orange

– 3 Green/White 28 White/Green

– 4 Brown/White 29 White/Brown

1 Trunk, DID, 
Extension

5 Slate/White 30 White/Slate

2 Trunk, DID, 
Extension

6 Blue/Red 31 Red/Blue

3 Trunk 7 Orange/Red 32 Red/Orange

4 Trunk 8 Green/Red 33 Red/Green

5 Extension 9 Brown/Red 34 Red/Brown

6 Extension 10 Slate/Red 35 Red/Slate

7 Extension 11 Blue/Black 36 Black/Blue

8 Extension 12 Orange/Black 37 Black/Orange

– 13 Green/Black 38 Black/Green

– 14 Brown/Black 39 Black/Brown

– 15 Slate/Black 40 Black/Slate

– 16 Blue/Yellow 41 Yellow/Blue

– 17 Orange/Yellow 42 Yellow/Orange

– 18 Green/Yellow 43 Yellow/Green

– 19 Brown/Yellow 44 Yellow/Brown

– 20 Slate/Yellow 45 Yellow/Slate

– 21 Blue/Violet 46 Violet/Blue

– 22 Orange/Violet 47 Violet/Orange

– 23 Green/Violet 48 Violet/Green

– 24 Brown/Violet 49 Violet/Brown

– 25 Slate/Violet 50 Violet/Slate
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C.4.5 ShoreTel Voice Switch T1 and ShoreTel Voice Switch E1
The following sections describe ShoreTel Voice Switch T1 and ShoreTel Voice Switch E1 
resource capacity, LED behavior, and connectors. The ShoreTel Voice Switch T1 is not 
supported in installations outside the U.S. and Canada. Figure C-19 displays the ShoreTel 
Voice Switch T1 front plate. The ShoreTel Voice Switch E1 front plate is identical to the 
ShoreTel Voice Switch T1 except for the E1 labeling.

Figure C-19 ShoreTel Voice Switch T1 Front Plate

The ShoreTel Voice Switch T1 provides higher-density trunking to the central office using 
CAS or PRI signaling. It can also be used as a gateway to legacy PBX systems.

A ShoreTel Voice Switch E1 provides higher-density trunking to the central office using PRI 
signaling. It can also be used as a gateway to legacy PBX systems.

C.4.5.1 Switch Capacity

• Digital Circuit Resources

— ShoreTel Voice Switch T1 – One T1 circuit, 24 channels per circuit: 24 
channels maximum

— ShoreTel Voice Switch E1 – One E1 circuit, 30 channels per circuit: 30 
channels maximum

• Make Me Conference Resources: None

• Maximum IP Phone Resources: None

C.4.5.2 LED Descriptions

Power LED

The ShoreTel Voice Switch T1 and ShoreTel Voice Switch E1 voice switches have one power 
LED, which indicates the following:

• On: The switch is operating normally.

• Off: The switch has no power.

• Flashing:

— 2 flashes—The switch failed its internal self-test. Hardware failed; replace the 
unit and submit a Return Material Authorization (RMA) to ShoreTel, Inc.

— 3 flashes—Booting via FTP. Flash memory may be corrupted. Go to the Quick 
Look page to make sure that the system is running properly.

ShoreGear-T1

Default
Switch

Power
LED

RS-232C
Maintentance

Port

Network
LEDs

LAN
Connectors

T1 Monitor Port
(RJ-48C)

T1 Port
(RJ-48C)
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— 4 flashes—The IP address is unavailable. DHCP and BOOTP did not respond to 
the IP address request, and the IP address is not available in nonvolatile memory 
to continue boot process. The switch will automatically reboot in five seconds 
and try again. Check the BOOTP/DHCP server and the network configuration to 
ensure that the voice switch is receiving a valid IP address.

— 5 flashes—The operating system is not available. The switch is booting from 
FTP but cannot find the boot files. It automatically reboots in five seconds.

— 6 flashes—Using a previously stored IP address. A BOOTP/DHCP transaction 
was attempted, but the BOOTP/DHCP server did not respond. The switch 
continues to use the IP address stored in nonvolatile memory until it receives a 
valid response. If the switch receives a response that provides a different IP 
address, it reboots using the new IP address. If the switch receives a response that 
matches the IP address stored in nonvolatile memory, it continues operation, and 
the power LED stops flashing. If the problem persists, check the BOOTP/DHCP 
server and network configuration.

Network LEDs

The network LEDs (LAN1 and LAN2) indicate the speed at which the switch is 
communicating with the network and whether there is network activity. The network LED 
descriptions are as follows:

• Link/Activity: When lit, this LED indicates that the switch is connected to an 
Ethernet network. This LED indicates network activity, as follows:

— When flashing, network activity is detected.

— When on (not flashing), heavy network activity is detected.

— When off, network activity is not detected.

This LED is not directly related to any switch’s individual network activity. For 
example, if three switches are connected to the same hub and one switch’s Traffic 
LED shows activity, the other switches will indicate the same activity.

• 100M

— When green, the switch is connected to a 100BaseT network.

— When off, the switch is connected to a 10BaseT network.

Monitor and Telco LEDs

The Monitor and Telco LEDs indicate line coding, network framing, and loopback status. 
These LEDs are color coded—green, yellow, and red. The Monitor and Telco LED 
descriptions follow.

Telco and Monitor LED alarms and errors are logged as switch events in ShoreTel Director’s 
event log.

• Line Coding: This LED indicates line coding status, as follows:

— When green, the line coding signal is good. 

— When yellow, bipolar violations (BPV) are being received at one second 
intervals.

— When red, a loss of signal (LOS) has occurred.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.
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• Framing: This LED indicates network framing status, as follows:

— When green, the T1/E1 signal is in frame; the signal is synchronized.

— When yellow, a yellow alarm has been received from the Central Office.

— When flashing yellow, the frame-bit error rate has exceeded its limits.

— When flashing slow yellow, a small number of frame-bit errors (>1 per million) 
have occurred; this state will take up to 10 minutes to clear.

— When flashing fast yellow, a series of frame-bit errors (>1 per 1000) have 
occurred.

— When red, the T1/E1 signal is out-of-frame (OOF). The received signal cannot 
be framed to the Extended Superframe (ESF) or D4 format.

— When flashing red, loopback is active (local or CO).

— When off, the switch has no power.

ShoreTel Voice Switch T1 and ShoreTel Voice Switch E1 Connectors

The ShoreTel Voice Switch T1 and ShoreTel Voice Switch E1 voice switches contain the 
following components:

• 1 DB-9 female connector for maintenance 

• 2 RJ-45 connectors for the LAN interface

• 1 RJ-45 T1 telco port 

• 1 RJ-45 T1 monitor port for connecting test equipment
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Centralized Dial Number (DN)

ShoreTel supports Centralized Dial Numbers (DN). Centralized DN guarantees the data 
integrity for DN references within the system. When administrators delete a particular DN, 
Centralized DN checks all the references to that DN across the system. Depending upon the 
significance of references to the DN to be deleted, the system either allows the deletion by 
removing all the DN references or prevents the deletion by prompting administrator with a 
message indicating the referenced DN and that it cannot be deleted.

To delete non-significant references together with the DN eliminates the unnecessary pop-
up messages when administrators delete a unwanted DN. It makes smoother and easier DN 
management for administrator. Table D-1 provide information about the centralized dial 
number table as it relates to the ShoreTel system.

Table D-1 Centralized Dial Numbers (DN) Table

Deleting an Extension System Behavior

Hunt Group -------------------------------------------------------------------
-

• Backup Extension deletion not available

• CF destination - call stack full delete silently

• CF destination - no answer delete silently

Members delete silently

Escalation Profile -------------------------------------------------------------------
-

• Automatic Message Forwarding delete silently

• Escalation Step (Notification 
Number)

delete silently

Find Me -------------------------------------------------------------------
-

• Primary destination delete silently

• Backup destination delete silently

Users -------------------------------------------------------------------
-

• Mailbox for Recorded Calls delete silently

• Delayed Ringdown delete silently 

Programmable Button -------------------------------------------------------------------
-

• Toolbars delete silently 
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User Call Handling Modes -------------------------------------------------------------------
-

• Always Destination: set to DN Type =4

• Busy Destination set to DN Type =4

• No Answer Destination set to DN Type =4

• Personal Assistant delete silently 

Extension List -------------------------------------------------------------------
-

• User Ext List delete silently

User Call Handling Modes Defaults -------------------------------------------------------------------
-

• Always Destination: set to DN Type =4

• Busy Destination set to DN Type =4

• No Answer Destination set to DN Type =4

• Personal Assistant delete silently

• Call Handling Modes Delegation delete silently

Bridge Call Appearance (BCA) -------------------------------------------------------------------
-

• Backup Extension delete silently

• Call Stack Full delete silently

• No Answer delete silently

System Dist Lists delete silently

WorkGroup delete silently

• Backup Extension set to DN Type =4

• Call Handling Modes Work Group 
Assistant

delete silently

• Work Group Assistant delete silently

• Members (Work Group Agents) manual deletion required

• Queue Handling Steps (Operation) manual deletion required

• Over Flow DN (Queue Handling 
Steps

manual deletion required

Route Point -------------------------------------------------------------------
-

• Call Handling Modes set to DN Type =4

• Assistant delete silently

AA Menu -------------------------------------------------------------------
-

• Extension in Steps manual deletion required

• Group Paging delete silently

• Pickup Group delete silently

Table D-1 Centralized Dial Numbers (DN) Table (Continued)

Deleting an Extension System Behavior
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AMIS -------------------------------------------------------------------
-

• Delivery Number no impact

• Callback Number no impact

CoST/ClassofService -------------------------------------------------------------------
-

• Directed Pagin delete silently

• Barge In delete silently

• Record Other's Calls delete silently

• Silent Monitor delete silently

Table D-1 Centralized Dial Numbers (DN) Table (Continued)

Deleting an Extension System Behavior
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802.1x A component of IEEE 802.1 group of networking protocols that addresses port-
based Network Access Control. It provides an authentication mechanism for devices 
attaching to a LAN port to either establish a point-to-point connection or prevent the 
device from accessing the port if authentication fails. 802.1x is based on the Extensible 
Authentication Protocol (EAP).

ACD see Automatic Call Distributor

Active Directory (AD) Active Directory is a Microsoft technology that provides various 
network services, including LDAP-style directory services and authentication, for 
Windows environments. Administrators to assign policies, deploy software, and apply 
critical updates to an organization from a single Active Directory database.

Active Call Handling Mode The active call handling mode is the CHM that is designated 
to specify the current method of handling a user’s inbound calls. One mode is always 
active for each user. The active CHM is selected manually by the user or changes 
automatically based on the user’s schedule.

AD see Active Directory

Administrator, System The IT professional responsible for installing, configuring, and 
maintaining a ShoreTel system.

Advanced Encryption Standard (AES) Advanced Encryption Standard is a United States 
Encryption standard defined in Federal Information Processing Standard (FIPS) 192, 
published in Nov. 2001. AES is a symmetric block cipher which can process fixed 128-
bit data blocks, using 128, 192 or 256-bit keys.

AES see Advanced Encryption Standard

All Trunks Busy The condition where a user is cannot complete a call because no trunks 
are available. The system denotes an all trunks busy condition with a fast-busy tone.

Announced Find Me Announced Find Me is an option where the identity of an inbound 
caller is provided to the Find Me call recipient. Inbound callers may be required to 
record their spoken name before the call is connected.

Automatic Call Distributor (ACD) An Automatic Call Distributor is a system that 
distributes inbound calls to members, or agents, of the system.

Auto Find Me Auto Find Me is a Find Me option where a call recipient can program the 
system immediately forward inbound call without requiring the caller to press “1”.

Automated Attendant (Auto-Attendant) A program that answers and handles inbound 
calls without human intervention. Auto attendants typically provide menu-driven 
options through which callers can obtain information, perform tasks, or connect to a 
requested extension.

Automated Call Handling A method of managing inbound calls that relies on Call 
Handling Modes to specify a destination or resolution for calls on the basis of the user’s 
schedule or status.

Available DID numbers DID numbers within a range that are not assigned to a user or 
entity within the context of that range.
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DID number availability within a range does not consider DNIS assignments. Numbers 
assigned as a DNIS number are still enumerated as available within a DID range; 
attempts to assign these DID numbers will be unsuccessful.

Barge In Barge In is a ShoreTel function that allows a user to enter another user’s active 
call. The initiator can listen and speak to all other call participants. A Telephony Class 
of Service sets Barge In rights.

BCA see Bridged Call Appearance

BOOTP (or Boot Protocol or Bootstrap Protocol) A network protocol used by 
network clients to obtain an IP address from a configuration server. BOOTP is typically 
used when a computer or system is starting up.

Bounced Call A bounced calls is a parked call that is returned to the extension that 
parked the call because is was not picked up within a specified period.

Bridged Call Appearance (BCA) A Bridged Call Appearance is an extension that is 
shared among multiple users. A BCA is characterized by an extension number and its 
call stack depth. The extension number defines the method of contacting BCA users. 
The call stack depth specifies the number of call that can simultaneously reside on the 
BCA.

Bridged Call Appearance Monitor The Bridged Call Appearance Monitor is a ShoreTel 
Communicator window that displays all Bridged Call Appearances for which the user's 
extension can access through all devices assigned to the user. The Bridged Call 
Appearance Monitor is only available through Operator ShoreTel Communicator.

Call Appearance A VoIP data structure that supports one voice call session.

Call Detail Record (CDR) A Call Detail Record (CDR) is a data record containing 
statistics of a call that passed through a pbx or telephone exchange.

Information provided by a CDR includes the number of the originating party, the 
number of the recipient, the time that the call started, and the duration of the call. 
ShortTel CDRs contain additional information.

Call Handling A predetermined method of servicing inbound calls. ShoreTel supports 
Automated Call Handling and Personalized Call Handling.

Call Handling Mode (CHM) A call handling mode is a ShoreTel variable that defines a 
method of handling specified inbound calls. Each user is assigned five call handling 
modes, one of which is active and determines the user’s current call handling method. 
See Active Call Handling Mode.

The five call handling modes assigned to each user are named Standard, In a Meeting, 
Extended Absence, Out of Office, and Custom.

Call Handling Rule A call handling rule is the base unit of a Call Routing Plan that 
consists of a condition and action. When a call handling rule is active and the 
condition is satisfied, the action specifies method by which the ShoreTel system 
handles the user’s call.

Call History A set of call records for an end user. Each call history record provides 
information about one call including type, direction, time, duration, disposition, and 
identity of the other party. Users view their call history through ShoreTel 
Communicator or Mobile ShoreTel Communicator.

ShoreTel Communicator (client application) ShoreTel Communicator is the ShoreTel 
client application that manages a user’s calls, voice mail, and personal system settings 
through a graphical user interface.
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ShoreTel Communicator (switch) ShoreTel Communicator is a ShoreTel Voice Switch 
module that handles MGCP information from the IP phones to which the switch is 
assigned.

This hardware module is not directly related to the ShoreTel Communicator client 
application.

Call Notification A set of features that inform the user of the arrival of a new call, such as 
ringing the telephone or playing a sound on the workstation speakers.

Call Routing A method of delivering calls to destinations based on a situation or system 
status. Call routing can also refer to the automatic delivery of an incoming call to a 
particular extension, such as in DID or dedicated CO lines.

Call Routing Plan The Call Routing Plan is the Personal Call Handling component that 
contains of rules that specifies a user’s call handling method. The plan prioritizes a list 
of enabled Call Handling Rules.

Call Stack The ShoreTel extension component that manages an entity’s call appearances. 
The size defines the maximum number of calls – including active and held calls – that 
an extension can handle simultaneously.

Call Waiting Usually for single-line telephones, a feature that lets a second call arrive to 
the line by delivering a call-waiting tone to the user and a ring-back to the caller.

Call Waiting Tone The tone that is presented to a user with call waiting when a second 
call arrives.

CallerID A technique for transmitting the calling party’s telephone number and 
(optionally) name to equipment enabled to handle this feature; also called CLI in 
Europe.

Caller’s Emergency Service Identification (CESID) The extension that a switch sends 
to a Public Safety Answering Point (PSAP). A CESID identifies the location of callers 
who require emergency 911 services.

CDR see Call Detail Record

CDR Database A CDR database contains all CDRs generated by a ShoreTel system over a 
specified period of time. The CDR database is maintained on the Main Server.

Central Office (CO) The building where the telephone company’s telephone switching 
equipment that services the local area is located.

Centrex A name for advanced telephone services provided by the local telephone 
company. It usually requires a connection to a special telephone system but provides 
services such as voice mail and call forwarding.

CESID see Caller’s Emergency Service Identification.

CHM See Call Handling Mode.

Class of Service (CoS or COS) A class of service grants permission to a specified set of 
features and privileges. Users assigned to a class of service can access the specified 
features and privileges. ShoreTel defines three types of service classes: telephony 
features, call permissions, and voice mail permissions.

CO See Central Office.

CO Line See Trunk.

Codec A codec is a device or program that encodes and decodes a digital data stream or 
signal. Codecs encode a data stream or signal for transmission, storage or encryption 
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and decode it for viewing or editing. Codecs are typically used in video conferencing 
and streaming media applications.

Conference Three or more parties joined together in a single call, such that each party can 
hear and be heard by the others.

Coordinate Location Based Services data point that identifies a specific location in terms 
of longitude, latitude, and elevation. See Location Based Services.

CoS or COS See Class of Service.

Current Call Handling Mode see Active Call Handling Mode.

DBImport DBImport is a ShoreTel utility that uses the contents of a CSV file to update the 
ShoreTel user database. DBImport.exe adds, deletes, and modifies user account records 
based on the CSV file contents.

DHCP See Dynamic Host Configuration Protocol.

Dial Number (DN) Dial Number – the number dialed by a user.

Dialed Number Identification Service (DNIS) A service from Telcos that lets an 
enterprise determine which telephone number was dialed by a customer.

DID see Direct Inward Dialing

DID Range A DID range is a list of consecutive DID numbers assigned to a Trunk Group. 
Ranges assigned to a trunk group cannot overlap. A DID number can be assigned to 
multiple trunk groups.

Differentiated Services Differentiated Services is a computer networking architecture 
that specifies a method for managing network traffic and providing Quality of Service 
(QoS) guarantees on IP networks. 

Differentiated Services can provide low-latency, guaranteed service for critical network 
traffic (voice or video) while providing simple best-effort traffic guarantees to less 
critical services (web traffic or file transfers).

Differentiated Services Code Point (DSCP) Differentiated Services Code Point is a 6-
bit value, contained in the 8-bit DiffServ/ToS field of the IP packet header, that indicates 
the data traffic Per-Hop Behavior (PHB).

DN see dial number.

DNIS see Dialed Number Identification Service.  

DSCP see Differentiated Services Code Point. 

DTMF See Dual-Tone Multi-Frequency.

Dynamic Host Configuration Protocol (DHCP) A protocol for downloading network 
information (such as IP addresses) to client workstations.

Dual-Tone Multi-Frequency (DTMF) A signalling method used by telephones to send 
information to an exchange. Pressing a key on the phone's keypad sends two 
simultaneous tones to the exchange, which are then decoded to determine the pressed 
key. Also known as Touch Tone.

Explicit Authentication Explicit Authentication is an LDAP process where an 
application prompts users for credentials when they log into a network, then verifies 
those credentials through a call to the LDAP server.
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Extension Assignment Extension Assignment is a ShoreTel user feature that forwards 
calls to a designated device – either a system IP phone device or a remote telephone 
connected to the PSTN. Extension Assignment requires administrative authorization. 

Extension Monitor Extension Monitor is a ShoreTel function that provides a user access 
to another user's extension. In addition to viewing extension activity, the monitoring 
user can answer calls and perform other actions on calls at that extension. Extension 
monitoring is facilitated through ShoreTel Communicator and IP Phone Programmable 
buttons.

Failback Failback is the process of restoring a server, system, component, or network to 
the original, pre-failover state. See failover.

Failover Failover is the action of automatically transferring operations to a redundant or 
standby server, system, component, or network to continue normal operation after the 
base device fails. The failover process initiates without human intervention and 
typically without warning.

Find Me Find Me is a call handling feature that allows callers who are routed to a user's 
voice mailbox to contact the user at alternate devices by pressing “1” while listening to 
the voice mail greeting. See Auto Find Me and Announced Find Me.

Foreign Exchange Office (FXO) An FXO interface connects to the public switched 
telephone network (PSTN) central office and is the interface offered on a standard 
telephone. An FXO interface is used for trunks, tie lines, or connections to a PSTN CO 
or PBX that does not support E&M signaling (when local telecommunications 
authority permits).

Foreign Exchange Station (FXS) An FXS interface supplies ring, voltage and dial tone 
for basic telephone equipment, keysets, and PBXs. The FXO interface is useful for off-
premises station applications.

Frequency Shift Key (FSK) A modulation technique used with low-speed modems; also 
used with CallerID and message-waiting lamp indicators.

FSK See Frequency Shift Key.

FXO See Foreign Exchange Office.

FXS See Foreign Exchange Station.

Global Positioning System The Global Positioning System (GPS) uses a constellation of 
24 and 32 satellites that transmit microwave signals to GPS receivers, which they use to 
determine their current location, the time, and their velocity. GPS usually requires line 
of sight access between the transmitter and the device.

GPS see Global Positioning System

Hold (on Hold) A active call whose conversation is suspended. Calls on hold remain on 
the user’s.

IM see Instant Messaging

Instant Messaging (IM) Instant Messaging is the real-time transmission of text between 
at least two parties.

Internet Telephony Service Provider (ITSP) An Internet Telephony Service Provider are 
vendors that offer Internet data services for making telephone calls.

IP Phone Configuration Switch In each ShoreTel installation, one switch is responsible 
for assigning, to each IP phone, a switch that performs ShoreTel Communicator 
activities.
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IP Phone Failover IP Phone Failover is a ShoreTel feature that continues a voice call after 
the ShoreTel IP Phone loses communication with the its ShoreTel Communicator 
switch.

When IP Phone Failover is implemented, ShoreTel IP Phones are configured to send a 
signal to their ShoreTel Voice Switch every four minutes and to expect an 
acknowledgment from the switch. When a phone does not receive the return signal, it 
connects to another switch located at the same site.

IP Phone Keep Alive A signal that voice switches send to the IP phones for which they 
provide ShoreTel Communicator services. The system considers phones that 
acknowledge the signal are The signal is also referred to as a heartbeat.

ITSP see Internet Telephony Service Provider

LBS see Location based service.

LDAP see Lightweight Directory Access Protocol.

LDAPExport LDAPExport is a ShoreTel utility that exports AD directory information to a 
CSV file, whose contents can be imported to a ShoreTel user database. LDAPExport was 
introduced in ShoreTel to support AD Integration.

Lightweight Directory Access Protocol (LDAP) Lightweight Directory Access Protocol 
is an application protocol for querying and modifying directory services running over 
TCP/IP.

Line See Trunk.

LLDP-MED An enhancement to the basic LLDP protocol that addresses the discovery of 
endpoints by networks supporting LLDP.

Location based service Location based service (LBS) is a component feature that 
receives data identifying the position of the device in terms of latitude, longitude, and 
altitude. Data reception methods include GPS access and through Mobile Cell device 
service transmitters.

MCM location based services does not use altitude to specify the location of the device.

Loop Start One of the mechanisms used to signal the telephone system that the calling 
party wants to make a call. Loop start is a completion of the circuit using a set load 
between the two wires (tip and ring).

Message Notification A set of features that inform the user that a new message has 
arrived in his or her voice mailbox, such as lighting the call-waiting lamp, paging the 
user, or dialing a telephone number.

MOH See Music on Hold.

Monitor Extension Extension monitoring is a ShoreTel feature that permits a user to 
view another user’s extension status and answer inbound or held calls to that 
extension.

Music on Hold (MOH) Background music heard when callers are put on hold, letting 
them know they are still connected. Most telephone systems have the ability to connect 
to any sound-producing device—for example, a radio, a cassette, or a CD player.

MySQL MySQL is a relational database management system. that runs as a server 
providing multi-user access to a number of databases. MySQL is owned and sponsored 
by a single for-profit firm, the Swedish company MySQL AB, which is a subsidiary of 
Sun Microsystems. The project's source code is available under terms of the GNU 
General Public License, as well as under a variety of proprietary agreements.
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MySQL is officially pronounced My S Q L, not My sequel. This adheres to the official 
ANSI pronunciation.

ODBC The Open Database Connectivity specification provides a standard software API 
method for using database management systems (DBMS). The designers of ODBC 
aimed to make it independent of programming languages, database systems, and 
operating systems.

ODBC Connectors Drivers that provide connectivity to the MySQL server for client 
programs. There are currently five MySQL Connectors – Connector/ODBC, Connector/
NET, Connector/J, Connector/MXJ, Connector/PHP.

Off Hook The operating state of a communications link in which transmissions are 
enabled either for network signaling, voice communications, or data communications.

The act of seizing the line or channel is referred to as going off hook.

Off System Extensions Off System Extensions are ShoreTel extensions that, when dialed, 
route calls from the trunk group to which they are associated. A ShoreTel system 
typically uses Off System Extensions to connect with a legacy PBX system.

On Hook The operating state of a telecommunications link in which transmissions are 
disabled and then end instrument (phone) presents an open circuit to the link. The 
link is responsive to ringing signals during on-hook conditions.

The act of releasing the line or channel is referred to as going on hook.

Operator The person who monitors the telephone system and transfers calls to the 
appropriate extensions.

Parking a Call Parking a call places a call on hold on another extension’s.

PBX See Private Branch Exchange.

Per-Hop Behavior Per-Hop behaviors define packet forwarding properties associated with 
a class of traffic. Different PHBs may be defined to offer low-loss, low-latency 
forwarding properties or best-effort forwarding properties. 

Personalized Call Handling Personalized Call Handling is a ShoreTel feature that 
defines flexible handling methods for inbound calls. Calls are filtered and managed on 
the basis caller identity, time or date or receipt, end user status, and caller identity.

Physical Extension A common internal extension with an assigned physical port and 
telephone.

Presence Presence is a feature that identifies and distributes the availability of system 
users and other personal contacts. ShoreTel defines two types of Presence: IM presence 
and telephony presence.

Private Branch Exchange (PBX) A term used by telephone companies to indicate 
equipment that is located on the customer’s premises and that can route telephone 
calls.

Programmable ShoreTel Communicator Toolbar Buttons Programmable Toolbar 
buttons is a ShoreTel Communicator feature that provides access to ShoreTel call 
management functions. Each User Interface button is programmed by the 
administrator to perform a specific function when clicked and contains text that 
provides status of the function.

Programmable IP Phone Buttons Programmable IP Phone buttons is a ShoreTel IP 
Phone feature that provides access to ShoreTel call management functions. Each button 
is programmed by the user or administrator to perform a specific function when 
pushed and contains an LED indicator that displays status of the function.
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PSTN See Public Switched Telephone Network.

Public Switched Telephone Network (PSTN) Another name for the public telephone 
network.

QoS A traffic engineering term that refers to resource reservation control by providing 
different priorities to different applications, users, or data flows to guarantee a 
performance level for a data flow.

QuickDial Field A QuickDial field is a data entry field requesting contact information for 
a system user, extension, or external contact. Upon the entry of alphanumeric 
characters, the field expands vertically to display all possible valid entries, filtered by 
the input. Users fill the field by selecting one of the options with the cursor.

Real-time Transport Control Protocol (RTCP) Real-time Transport Control Protocol, 
defined in RFC 3550, is a sister protocol of the Real-time Transport Protocol (RTP) that 
provides out-of-band control information for an RTP flow. It accompanies RTP in the 
delivery and packaging of multimedia data, but does not transport any data itself. It is 
used periodically to transmit control packets to participants in a streaming multimedia 
session, primarily to provide feedback on the quality of service being provided by RTP 
media stream.

Real-time Transport Protocol (RTP) Real-time Transport Protocol defines a standardized 
packet format for delivering audio and video over the Internet. RTP is described by 
IETF RFC 3550.

Ring See Tip and Ring.

Ringback Tone The audible signal given to the caller by the telephone company (or 
telephone system) to indicate that the remote telephone is ringing.

Ringdown A ringdown circuit consists of predefined devices at the circuit endpoints and 
is configured to ring a recipient device immediately after an initiating device goes off 
hook. Ringdown calls are completed without dialing or any other signaling other than 
the initiating device going off hook.

RTCP see Real-time Transport Control Protocol.

RTP see Real-time Transport Protocol.

SDP see Session Description Protocol.

Secure Real-Time Transport Protocol (SRTP) Secure Real-Time Transport Protocol 
defines a profile for providing encryption, message authentication and integrity, and 
replay protection to RTP data streams.

Session Description Protocol (SDP) Session Description Protocol is a format for 
describing streaming media initialization parameters. The IETF published a revised 
specification as an IETF Proposed Standard as RFC 4566 in July 2006. SDP is intended 
for describing multimedia communication sessions for the purposes of session 
announcement, session invitation, and other forms of multimedia session initiation. 
SDP does not provide the content of the media form itself but simply provides a 
negotiation between two end points to allow them to agree on a media type and format. 

Session Initiated Protocol (SIP) Session Initiation Protocol is a signalling protocol that is 
typically used for setting up and tearing down multimedia communication sessions 
including voice and video calls. SIP also supports video conferencing, streaming 
multimedia distribution, instant messaging, and presence information.

Silent Monitor Silent Monitor is a ShoreTel function that allows a user to listen to another 
user’s call without being heard by any of the call participants. When a call is monitored, 
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external callers may hear a monitor tone; system users are not signaled. A Telephony 
Class of Service sets Silent Monitoring rights.

Single Sign On (SSO) Single Sign On (SSO) is an LDAP process where applications 
automatically authenticate LDAP users that are logged into the network domain 
through their current network credentials. Such users logged into the network are not 
prompted to re-enter their credentials.

SIP see Session Initiated Protocol.

SIP Extensions SIP Extensions are ShoreTel extension provide calling services through 
SIP devices. By default, ShoreTel extensions support MGCP devices.

SIP Trunk A SIP trunk is an ITSP service that supports business VoIP sessions to 
endpoints outside of an enterprise network through the connection that accesses the 
Internet.

Site A site is a ShoreTel data structure that is identified by a geographic location and 
characterized by transmission capabilities, device extensions, and other parameters 
required by ShoreTel devices. Switches, servers, users, and other ShoreTel entities are 
associated with a site.

SRTP see Secure Real-Time Transport Protocol.

SSO see Single Sign On.

Stutter Tone An intermittent dial tone provided by the telephone system (as opposed to 
the usual constant dial tone); sometimes used to indicate to the user that there are 
messages in his or her voice mailbox or that a feature (such as call forwarding) is 
enabled.

System Database The ShoreTel system database is the data structure that retains system 
operational information concerning user accounts, system architecture, switches, 
servers, sites, and status. Changes made through ShoreTel Director are stored in the 
system database.

T-1 A digital transmission link with a capacity of 1.554 Mbps. A T-1 trunk can normally 
handle 24 voice conversations, each digitized at 64 Kbps. T-1 lines are used for 
connecting networks across remote distances.

TAPI See Telephony Application Programming Interface.

Telephony Application Programming Interface (TAPI) A telephony software 
interface included in Microsoft Windows operating system that supports the 
incorporation of telephony control by other applications.

Tip and Ring Telephony terms for the two wires of an ordinary telephone wire. Tip is the 
ground side (positive) and Ring is the battery side (negative) of the phone circuit.

ToS An eight-bit field in the IP Packet Header, previously referred to as Type of Service, 
that is used to accommodate applications that require real-time data streaming, as 
specified by RFC 3168. The ToS fields contains a six-bit Differentiated Services Code 
Point and a two-bit Explicit Congestion Notification field.

Trunk Sometimes used synonymously with line or CO line. Traditionally, a trunk from the 
telephone company connects to a PBX only, and not to a telephone, whereas a line from 
the telephone company connects to a telephone. For documentation purposes, either 
term can be used when referring to voice connections from the telephone company.

Trunk Hunt Group A term sometimes used to indicate a group of telephone lines 
configured by the telephone company to rotate incoming calls among all the lines in 
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search of the next available one. In this way, a company can give out one main number, 
and all calls to that number will hunt for the next available line or trunk.

Unparking a Call Unparking a call is the retrieval of a parked call to the extension that 
parked the call.

Waypoint A known location specified by coordinates, associated with a coverage area 
(radius), and identified by a descriptive label.

Whisper Page Whisper Page is a ShoreTel client feature that allows a user to interrupt an 
active call and speak with an internal user. The other call party and the initiator are not 
connected – they cannot hear or speak with each other. A Telephony Class of Service 
sets Whisper Page rights.

Workgroup Workgroups is a ShoreTel entity that performs ACD functions for inbound 
calls. Calls are routed to a workgroup through an extension which, in turn, routes them 
to workgroup agents. Each workgroup is assigned an extension, mailbox, and other 
parameter settings.

Workstation A personal computer (PC) or similar computer.
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